## Contents

**Preface**
- Motion 2 Documentation and Resources
- Onscreen Help
- Additional Resources

**Chapter 1**
- Getting To Know Motion
  - About Motion Graphics
  - About the Motion Workspace
  - The Toolbar
  - The Canvas
  - The Project Pane
  - The Timing Pane
  - The Utility Window
  - The Dashboard
  - Preferences
  - Menus

**Chapter 2**
- Creating and Managing Projects
  - Creating New Projects
  - Managing Projects
  - Editing Project Properties
  - Browsing Media Files in Motion
  - File Types Supported by Motion
  - Adding Media to Your Project
  - Managing Objects in Your Project
  - Deleting Objects From a Project
  - Exchanging Media in a Project
  - Object Media Tab Parameters
  - Using Media in the Library
  - Organizing Layers and Objects in Motion
  - Customizing and Creating New Templates
Chapter 3 217 Basic Compositing
219 Layer and Object Order
221 Object and Layer Transforms in the Canvas
243 Editing Opacity and Blending
269 Drop Shadows

Chapter 4 273 Using the Timeline
274 Getting Familiar With the Timeline
282 Working in the Timeline
293 Editing Objects in the Timeline
306 Working in the Ruler
312 Adding Markers

Chapter 5 317 Using Behaviors
320 Browsing for Behaviors
321 Applying and Removing Behaviors
329 Customizing Behaviors
331 Working With Behaviors
335 Changing the Timing of Behaviors
341 Animating Behavior Parameters
343 Saving and Sharing Custom Behaviors
344 Behavior Descriptions
392 Behavior Examples

Chapter 6 401 Keyframes and Curves
405 Animating in the Canvas
409 Animating With the Dashboard
414 Animating Using the Inspector
419 Animating in the Timeline
424 Animating in the Keyframe Editor
446 Animating On the Fly

Chapter 7 453 Using Text
454 Using Text in Motion
456 Setting Object Duration Preferences
457 Working With Text
464 About Fonts
468 Using the Text Tools
473 Editing Text in the Inspector
524 Using Text Animation and Text Sequence Behaviors
556 Using Other Behaviors With Text Objects
559 Animating Text With Keyframes
560 Using LiveFonts
Chapter 8  Working With Particles
565 The Anatomy of a Particle System
569 Using Particle Systems
585 Creating Graphics and Animations for Particle Systems
586 Advanced Particle System Controls
610 Animating Objects in Particle Systems
610 Using Behaviors With Particle Systems
612 Applying Filters to Particle Systems
613 Particle System Examples
619 Saving Custom Particle Effects to the Library

Chapter 9  Using the Replicator
621 The Anatomy of the Replicator
627 Using the Replicator
645 Advanced Replicator Controls
673 Animating Replicator Parameters
681 Using the Sequence Replicator Behavior
696 Using Behaviors With Replicators
698 Applying Filters to Replicators
699 Saving Custom Replicators to the Library

Chapter 10  Using Filters
701 About Filters
701 Working With Filters
702 An Introduction to Filters
709 Working With Filters
785 Tiling Filters
793 Working With Third-Party Filters

Chapter 11  Working With Generators
795 About Generators

Chapter 12  Using Shapes and Masks
819 The Difference Between Shapes and Masks
820 Shape and Mask Drawing Tools
835 Illustrating Using the Shape Tools
847 Animating Shapes
851 Masking Objects to Create Transparency
865 Applying Image Masks to an Object
869 Using Masks to Aid Keying Effects
873 Manipulating Alpha Channels Using Filters
**Chapter 13**  
877  **Working With Audio**  
878  Audio Files in Motion Projects  
887  Working With Audio Tracks  
894  Keyframing Level and Pan Changes  
897  Using Soundtrack Pro With Motion  
898  Exporting Audio

**Chapter 14**  
899  **Exporting Motion Projects**  
900  Exporting Your Project  
901  Using Export Presets  
905  Setting Export Options  
909  Exporting With Compressor  
912  Exporting an Audio File

**Appendix A**  
913  **Keyboard Shortcuts**  
913  General Interface Commands  
915  Motion Menu  
915  File Menu  
916  Edit Menu  
917  Mark Menu  
919  Object Menu  
920  View Menu  
922  Window Menu  
923  Help Menu  
923  Audio Editor  
923  Audio Tab  
924  Canvas  
933  Dashboard  
933  File Browser  
934  Inspector  
934  Keyframe Editor  
934  Layers  
935  Library  
936  Media Tab  
936  Timeline  
938  Keyframing Commands  
939  Shape and Mask Commands  
939  Toolbar

**Appendix B**  
941  **Video and File Formats**  
941  Supported File Formats  
944  Standard Definition vs. High Definition Video Formats  
948  Popular Video Codecs for File Exchange
950  What Is Field Order?
951  Using Square or Nonsquare Pixels When Creating Graphics
953  Differences in Color Between Computer and Video Graphics
953  Using Fonts and Creating Line Art for Video
953  Scaling Imported High-Resolution Graphics
954  Creating Graphics for HD Projects

Appendix C  955  Integration With Final Cut Pro
955  Using a Motion Project in Final Cut Pro
957  Using Final Cut Pro Clips and Sequences in Motion

Appendix D  961  Using Gestures

Index  973
Motion 2 Documentation and Resources

Motion is an exciting new motion graphics application that lets you create content for broadcast and video. Discover all the resources you can use to help you learn this versatile application.

This user manual provides a detailed description of the features in Motion and how to use them to create compelling visual projects.

In addition to this document, your software comes with the printed book, Motion Getting Started, which is an introduction to Motion's major features, including examples and tips. It is recommended that you start by reading through Motion Getting Started to familiarize yourself with the basics of working in Motion.

Onscreen Help
The Motion Help menu allows you to access information about every aspect of the application directly onscreen while you are working in Motion, including the Motion 2 User Manual, Late-Breaking News, the Motion website, and so on.

The items in the Help menu are described below.

To access the Motion User Manual and other help:
- In Motion, choose Help, then choose an item from the list.

User Manual
The Motion 2 User Manual is a comprehensive document that contains detailed information about all features in the application.

When the user manual is first opened, the Motion 2 User Manual access page appears. The Preview drawer on the side contains a list of links that allow you to locate specific information in the user manual. Click on any bookmark in the drawer to begin exploring the user manual.
Links in the body of the access page provide an additional way to locate important help and other documentation tools to assist you in learning and using Motion. Most of these links are also available directly from the Help menu:

- Late-Breaking News
- New Features
- Getting Started
- Tutorials
- Motion Support
- Motion on the Web
- Apple Training Centers
- Feedback

This link takes you directly to the Motion feedback page, where you can provide Apple with your valuable insights, suggestions, and feedback about your experience with working in Motion.

**Accessing the Motion User Manual Contents**

Once you have chosen Motion User Manual from the Help menu, use the following guidelines to navigate the extensive document.

To access the contents of the *Motion 2 User Manual*:

- In Preview (the application that displays the manual), click the Drawer button on the toolbar to display the contents of the user manual.

Among the useful sections included in the Preview drawer list are the following:

- Keyboard Shortcuts
  This item takes you to an appendix containing a comprehensive list of keyboard commands available in Motion. Getting familiar with these shortcuts can dramatically increase your productivity when working in Motion.

- Using Gestures
  This item takes you to an appendix that explains how to use a Wacom graphics tablet and pen as an input device in Motion. “Gestures” are pen-tool shortcuts that allow you to navigate and perform various tasks without a keyboard or mouse.

- Index
  This item takes you to the user manual index—a comprehensive list of controls, features, and functions within Motion. Each entry is a hyperlink that takes you directly to the page in the user manual where that feature is described. Additionally, common motion graphics tasks and terminology are listed to aid you in learning about specific tasks.

You can also type keywords into the Search field at the top of the Preview drawer to quickly find specific information in the user manual.
Because Motion is a creative tool, documentation can only go so far in describing its potential. The Motion 2 User Manual provides a detailed description of the Motion interface, features, and functionality, and introduces you to the built-in templates and resources to give you a sense of the versatility of the product. In the end, you are limited only by your own imagination. The best way to learn all that Motion has to offer is to jump in and start exploring with the documentation at your fingertips.

Late-Breaking News
The Late-Breaking News document contains information about issues with third-party hardware and software, and known bugs. It also contains information about any new features or changes to the software that occurred after the Motion 2 User Manual was completed. It is highly recommended that you review this document in order to be completely up-to-date on the functionality of the software.

New Features
This option opens a PDF version of the New Features in Motion 2 document, which briefly describes what’s new in the latest version of Motion, as well as where to find detailed information about those features in the user manual. This document is identical to the printed New Features in Motion 2 found in the Motion box.

Motion Getting Started
This option opens a PDF version of the Motion Getting Started book, which provides an overview of the application and its workflow. This is identical to the printed Motion Getting Started book found in the Motion box.

Tutorials
This option opens the PDF-format Motion 2 Tutorials. The tutorials are step-by-step lessons that walk you through the basic workflow and interface elements of Motion.

Show Welcome
This option opens the Welcome Screen in the Motion application, which offers access to web-based QuickTime tours of Motion, as well as a library of professionally designed Motion project templates.

Motion Support
This option opens your web browser and takes you directly to the Motion support page on the Apple website.

Motion on the Web
This option opens your web browser and takes you directly to the Motion product page on the Apple website.

Apple Training Centers
This option takes you to the Apple Training Centers webpage, where you can find information about Apple-authorized training centers in your area.
Create Support Profile
This option generates a special file describing the technical details about your computer such as processor speed, video card specifications, and so on. This file is used only by authorized Apple technical support technicians.

Additional Resources
For additional information about Motion, use the resources listed below.

Motion on the Web
You can visit the Motion website for general information and updates as well as the latest news on Motion.

To go to the Motion website, do one of the following:
- In Motion, choose Help > Motion on the Web.
- Open your Internet browser, then enter http://www.apple.com/motion.

There are a variety of forums, discussion boards, educational resources, and marketing materials pertaining to Motion on the web.

Apple Service and Support Website
You can visit the support website for software updates and answers to the most frequently asked questions regarding Motion. Additionally, you can find product specifications, reference documentation, and Apple and third-party technical articles.

To go to the Motion support web page, do one of the following:
- Choose Help > Motion Support.
- Open your Internet browser, then enter http://www.apple.com/support/motion.

Other Apple Websites
Apple provides a wide array of information that can enhance your experience working with Apple products such as Motion.

http://www.apple.com
Start at the Apple main home page to find the latest information about Apple products.

http://www.apple.com/quicktime
QuickTime is the Apple industry-standard technology for handling video, sound, animation, graphics, text, music, and 360-degree virtual reality (VR) scenes. QuickTime provides a high level of performance, compatibility, and quality for delivering digital video. Go to the QuickTime website for information on the types of media supported, a tour of the QuickTime interface, specifications, and more.
http://www.apple.com/creative
This website provides news, information, and other resources on seminars, events, and third-party tools used in digital video, design and print, music and audio, web publishing, and the media arts.

http://www.apple.com/education
Look here for resources, stories, and information about projects developed by users in education using Apple software, including Motion.

http://store.apple.com
Go here to buy software, hardware, and accessories direct from Apple. You can also find special promotions and deals that include third-party hardware and software products.
Getting To Know Motion

This chapter introduces you to the basic concepts of motion graphics and the Motion interface. It also describes how to work with all of the basic tools you need to get started.

Motion is a behavior-driven motion graphics application that can be used for a wide variety of projects, including titles, broadcast graphics, and simulations.

If you have not yet read the Motion Getting Started book, you are encouraged to explore that guide to get a quick introduction to the major functions and capabilities of Motion. It is also suggested that you take the time to work through the tutorials, to get a hands-on introduction to working in Motion.

This chapter provides an introduction to motion graphics and the Motion workspace, and how to navigate and use common tools and controls.

About Motion Graphics

Motion graphics is a type of visual effects work most commonly associated with title sequences and show openers, bumpers and interstitials, and interface design like DVD menus. It is also frequently used in technical settings for simulations of moving systems such as traffic patterns or scientific models.

Motion graphics usually incorporates multiple objects onscreen simultaneously and is typically governed by design considerations and a strong sense of visual impact. Sophisticated motion graphics artists often combine traditional layout and design techniques with tools borrowed from special effects work such as keying, masking, compositing, and particle systems to create dynamic moving designs. The tools commonly used for motion graphics fall into several categories.
Design Tools
Graphic designers have been using software to facilitate their work for many years. Motion has incorporated many of the most valuable tools commonly found in layout and design applications, including guides, alignment, and direct manipulation for positioning, transforming, and distorting objects. It also contains some of the most flexible and sophisticated tools for creating and handling text elements. This is especially important because text is such a critical component of motion graphics design.

Timing Tools
The principal difference between traditional design and motion graphics is that motion graphics is time based. This means that you are concerned with creating a well-composed and readable layout, and you must also manipulate that layout over the duration of the show. Motion provides a Timeline that contains tools usually found in a video editing application (such as trimming, markers, slipping, and snapping) to allow you to hone and compose the temporal aspects of your project.

Motion also supports audio files, including basic audio mixing, so you can create a soundtrack for your project and make timing decisions based upon the audio as well as visual components. Furthermore, you can animate objects, filters, behaviors, and other elements to create elegant and precise compositions.

Compositing
Any time you have more than one object onscreen simultaneously, you must employ some version of compositing to combine the elements. This might mean moving the objects onscreen so they don’t overlap, adjusting the objects’ opacities so they are partly visible, or incorporating blend modes that mix the overlapping images in a variety of ways. Compositing is fundamental to motion graphics work. Fortunately, Motion makes it easier than ever before, allowing you to control layer and object order, group and lock objects, and apply more than 25 different blending options to create unique effects.

Special Effects Tools
You can further enhance your motion graphics projects by employing many of the same tools used in movies to combine dinosaurs with live actors, sink luxury liners in the ocean, or create space battles. Motion provides many of these tools such as keying (isolating an object shot against a solid colored background), masking (to hide wires or other objects that should not be seen in the final image), and particle systems (to simulate natural phenomena such as smoke, fire, and water). In fact, Motion can be used to create special effects shots like these, but its real power is in integrating these tools with the design and editing tools described above.
Unique Tools
As the field of motion graphics design has evolved, the tool sets in the most common applications have grown, but Motion takes a completely fresh approach to the task. It incorporates the cutting edge of software design and takes advantage of the latest powerful Apple hardware. And while it does include the tools and techniques artists have grown accustomed to, it also incorporates a streamlined, mode-less interface and a new set of tools called behaviors that make previously complex (or near-impossible) procedures as simple as drag and drop. A tool called the replicator creates a customizable pattern from copies of an object, quickly creating complex design effects that would take hours to build in other applications.

Behaviors
The Motion behaviors simplify the most common tasks such as scaling, fading, and moving objects. They also allow you to create complex interactions between objects with behaviors such as Edge Collision (making objects bounce off of one another) or Attractor (which gives one object a gravitational pull on surrounding objects). And because text is such a critical element of motion graphics work, Motion includes several behaviors specifically designed for text elements that treat individual letters uniquely while simultaneously affecting the entire object as a whole.

The Dashboard
One of the things that can bog down an otherwise fluid motion graphics experience is having to stop and hunt for the location of a particular setting. Motion uses a special floating window called the Dashboard to provide at-your-fingertips access to your most frequently used parameters. The Dashboard changes dynamically, depending on what is selected. The Dashboard also provides access to unique visual controls for some of the behaviors.

The Dashboard also allows you to quickly add Parameter behaviors to the parameters of the selected object. To add a Parameter behavior, Control-click a parameter in the Dashboard, then choose a Parameter behavior from the shortcut menu. For more information about Parameter behaviors, see “Applying Parameter Behaviors” on page 326.

Real-Time Feedback
Finally, one of the strengths of Motion is that with the right hardware configuration, nearly every effect and adjustment you make can be viewed in real time. This means that you can watch how the various elements of your composition interact as you adjust them. Not only does this mean less waiting time while the computer converts your various clicks and drags into a watchable movie, it means that you can interact with your creation in a more fluid and engaging way. Rather than making a set of assumptions and then waiting to see how they turn out, you can now see how your ideas work immediately, and make adjustments on the fly.
This turns the act of designing a motion graphics sequence into an act of exploration and discovery, which is the way most artists prefer to create. Motion provides not just a new set of brushes for the motion graphics artist, but a whole new type of work environment.

**Keyboard Shortcuts**

If you have a three-button mouse connected to your computer, you can right-click to access the same controls specified by the `Control`-click commands in the user documentation. If you are working on a PowerBook G4, keep in mind that some keyboard shortcuts require you to use the `Function` key (`fn`—next to the `Control` key) in conjunction with the keys specified in the user documentation. For more information about keyboard shortcuts in Motion, see Appendix A, “Keyboard Shortcuts.”

**About the Motion Workspace**

When you open Motion, the workspace fills your entire monitor, but the interface is actually made up of several independent windows. The sizes and arrangements of these windows are flexible to allow for the varying needs of different projects. There are additional panes and windows that can be displayed along with the default set.
The Utility Window
When you open Motion, the Utility window appears on the left side of the screen and contains the File Browser from which you can add files to your project. The Utility window also has tabs to display the Library, which contains all of the effects, templates, and other goodies that come with Motion, and the Inspector, where you can manipulate individual settings for those effects.

The Canvas
The majority of your screen is occupied by your main work area, the Canvas. This is similar to the document window in many other applications. It is here that you arrange and lay out the objects that comprise your composite. Adding objects and effects to your project is as simple as dragging them from the Utility window to the Canvas.
When you want to watch your project play back, the transport controls at the bottom of the window allow you to play at regular speed or frame by frame. The mini-Timeline lies just above the transport controls and below the main body of the window. This control provides a view of where selected objects in the Canvas begin and end in time.

The Canvas also contains two additional panes that are hidden in the default view.

**The Project Pane**

The Project pane contains three tabs, each of which provides access to different aspects of your project. The Layers tab displays the hierarchy of layers and objects in your project. The Media tab shows all the files imported into your project whether or not they appear in the Canvas. The Audio tab provides access to, and control of, any audio objects in your project. All of these tabs are covered in more detail later in the chapter.
The Timing Pane
The Timing pane also has three tabs, each to control a different aspect of your project. The Timeline is a broad overview of all the objects and effects and how they are laid out over time. The Keyframe Editor displays the animation graphs for parameters and effects, and the Audio Editor provides access to the level and pan controls for the audio components of your project.

Window Arrangements
Different workflows require different sets of windows to be visible and in different sizes. For example, when designing a layout for your composition, the bigger the Canvas, the better. However, when tweaking or finessing an animated effect, you may want more room dedicated to the Timing pane and the Inspector. Fortunately, Motion allows you to switch between different layouts quickly and even save your own custom layouts.

Preset Layouts
Motion provides three preset window arrangements, called layouts. These layouts distribute the application’s windows in varying ways to accommodate different workflows.

To choose a preset window layout:
- Choose Window > Layouts, then choose a layout from the submenu.
Standard layout: This layout displays the Utility window on the left and the Canvas on the right.

Alternate layout: This layout displays two Utility windows on the left, the top one containing the Inspector and the bottom one containing the File Browser and Library. The Canvas fills the remainder of the screen to the right.

Cinema layout: The Cinema layout also displays two Utility windows. The left side contains the File Browser and Library and the right contains the Inspector. The Canvas is in the middle with both the Project pane and the Timing pane displayed. This layout is only available if you are using an Apple Cinema Display.
Basic Window Controls
In addition to choosing from the preset arrangements, you can manually arrange your windows, resize them, or minimize them to the Dock.

To move a window:
- Drag a window by the title bar to the new location.

To resize a window:
- Drag the resize control in the lower-right corner of the window to resize it to the desired size.

To simultaneously resize adjacent windows:
- Drag the boundary between the two windows (the black line along the edge of the window). The pointer changes its shape over the boundary, indicating you can drag from there.

To minimize a window to the Dock:
- Click the minimize button in the title bar. You can also double-click the title bar of the Canvas to minimize it to the Dock.

Note: The Utility window cannot be minimized.

To close a window, do one of the following:
- Click the close button.
- Press Command+W in an active window.
Tabs
Motion uses tabbed windows to provide convenient access to multiple windows at once. You can switch between windows simply by clicking the appropriate tab. In addition, you can drag any tab out of its docked position to show the tabbed window in its own separate window. You can also drag a tab into another window. This lets you view multiple tabbed windows from the same group at one time. For example, you can drag the Inspector tab to a new location so that you can view the Library and the Inspector windows simultaneously.

To detach a tab:
- Drag the tab out of its docked position to any new location.
When you release the mouse button, the tab becomes its own window, and you can use all standard window controls, such as closing, minimizing, and resizing.

To reattach a tab:
- Drag the tab at the top of the window back to its original location. For example, drag the Inspector tab back to its original group of tabs, and release the mouse button.
The tab is reattached.

To show or hide a tab:
- In the Window menu, choose the name of the tab you want to show or hide. For example, choose Window > Timeline to show or hide the Timeline tab. You can also choose Keyframe Editor or Audio Editor to show or hide those tabs.
If the tab is detached from the Timeline area, click the close button. This closes the window, and it does not reappear as a tab. To display the window again, use the Window menu, and choose the appropriate command to show the window you want.

To reorder tabs:
- Drag a tab left or right in the tab area to reorder the tabs.

Swapping the Project Pane and Canvas
Similar to changing tab order, you can also change whether the Project pane appears to the left of the Canvas (default), or to the right. This can be especially useful when working with multiple monitors. For example, if the Canvas occupies the entire left monitor and your Utility windows are on the right monitor, moving the Project pane to the right side of the Canvas would make it closer to the Utility windows.

To move the project pane to the opposite side of the Canvas:
- Choose Window > Layouts > Swap Project Pane and Canvas.
Saving Custom Layouts

Once you have the windows arranged to your liking, you can save your screen layout with a relevant title so you can switch back to it later. This makes it easy to set up layouts that help you perform certain tasks. For example, you might set up one layout that is good for editing curves, while another layout has an expanded Timeline for editing keyframes. You can switch between layouts in the Layouts submenu, and you can delete and duplicate layouts in the Manage Layouts window.

When you save a layout, you save the following items:

- Window positions (size and location)
- Column orders (in the Project pane)
- Project pane position (left or right)

Note: Tab order, Timeline display options, and Canvas display options are not saved in the custom layout.

To save a layout:

1. Organize the windows on your screen the way you want.
2. Choose Window > Save Current Layout.
   The Create Window Layout dialog appears.
3. Type the name you want to use to save the layout, then click Save.
   The layout is saved and now appears in the Layouts submenu.
You can also create a new custom layout (based on the current state) by clicking the Add (+) button in the Manage Layouts dialog.

To switch to a saved custom layout:
- Choose Windows > Layouts, then choose the custom layout from the submenu.

To delete a saved layout:
1. Choose Window > Manage Layouts.
   The Manage Layouts dialog opens.
2. Select the layout you want to delete.
3. Click the Delete (−) button to remove the item from the list.
4. Click the Done button.

To duplicate a layout:
1. Choose Window > Manage Layouts.
   The Manage Layouts dialog opens.
2. Select the layout you want to duplicate.
3. Click the Duplicate button.
   A duplicate of the layout is added to the list. The word “copy” is appended to the name.
4. Click the Done button.

To rename a layout in the list:
1. Choose Window > Manage Layouts.
   The Manage Layouts dialog opens.
2. Double-click the layout you want to rename in the list.
   The name changes to a value field.
3. Type the new name in the value field.
4. Click the Done button.
Full Screen Mode

Motion has an option to cover your entire monitor with the Canvas. This is helpful for watching playback of your project without the distraction of the software interface. In this mode, all of the tools and controls that affect the Canvas remain active, though you have to rely on keyboard shortcuts and shortcut menus (Control-click) to change from one tool or control to another. You can access the menu bar by positioning your pointer at the top of the screen where the menu normally is.

To switch into Full Screen mode, do one of the following:

- Choose View > Full Screen Mode.
- Press F8.

To return to normal view, do one of the following:

- Choose View > Full Screen Mode again.
- Press F8 again.

The Toolbar

Motion’s Toolbar is located at the top of the Canvas. The default set of controls provides access to all of the tools you need for manipulating objects in the Canvas and elsewhere in the application. There are tools that create new text and shape objects as well as particle systems and masks. There are also icons to apply filters and behaviors. Finally, there are icons to show and hide the various windows and panes of the Motion interface such as the Timeline, Dashboard, and others.

Tool Groups

Tools are grouped in different ways. Several tools have multiple modes or options, such as Shape tools which can be either a rectangle or a circle. The Circle tool is hidden until you click and hold the Rectangle tool. Tools with additional states are indicated with a tiny downward arrow on the lower-right corner of the tool.
Tools are also grouped into categories of use. The first set of tools is called the View set because they deal with changing the view and manipulation method in the Canvas. The second category is called Create, and contains tools that add new content to the project such as text and shapes. The Mask category contains tools that add a mask to an existing object.

Controls can also be grouped through the use of separators. For example, Interface icons appear on the right side of the Toolbar. These hide and show the various panes, tabs, and windows that comprise the Motion interface. They are grouped through the use of a separator bar.

The following table itemizes each of the tools in the default tool set broken up into groups. The first group is the View set. The first eight tools are all hidden under the first button. Once any tool in that set is selected, you can switch between the tools by pressing the Tab key. Press Shift+Tab to cycle through the tools in the reverse order.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select/Transform Tool (arrow)</td>
<td>S (Tab cycles through tools.)</td>
<td>The default tool is the Select/Transform tool. This tool selects and moves objects in the Canvas. You can scale objects by dragging their corner points or rotate an object by dragging its center point.</td>
</tr>
<tr>
<td></td>
<td>Adjust Anchor Point Tool</td>
<td>S (Tab cycles through tools.)</td>
<td>Changes the point around which an object scales or rotates. To use it, drag the current anchor point to a new position.</td>
</tr>
<tr>
<td></td>
<td>Adjust Shear Tool</td>
<td>S (Tab cycles through tools.)</td>
<td>Distorts an object by moving two adjacent corners at the same time, leaving the other two corners locked into place.</td>
</tr>
<tr>
<td></td>
<td>Adjust Drop Shadow Tool</td>
<td>S (Tab cycles through tools.)</td>
<td>Changes the direction and offset of an object’s drop shadow. This tool never moves the object itself.</td>
</tr>
<tr>
<td></td>
<td>Adjust Four Corner Tool</td>
<td>S (Tab cycles through tools.)</td>
<td>Allows you to distort an object by moving one of the corner points, leaving the other three corners locked into place. The image is stretched and distorted to fit the shape you create.</td>
</tr>
<tr>
<td></td>
<td>Adjust Crop Tool</td>
<td>S (Tab cycles through tools.)</td>
<td>Allows you to hide portions of an image by dragging the edge or corner of the object.</td>
</tr>
<tr>
<td></td>
<td>Adjust Control Points Tool</td>
<td>S (Tab cycles through tools.)</td>
<td>Allows you to modify points and Bezier handles for masks, shapes, and motion paths.</td>
</tr>
<tr>
<td></td>
<td>Adjust Item Tool</td>
<td>S (Tab cycles through tools.)</td>
<td>Allows you to modify special controls such as the center point of a Circle Blur, or the shape of a particle emitter or replicator, or the start and end points of a gradient.</td>
</tr>
</tbody>
</table>

Chapter 1  Getting To Know Motion
The second group of tools is the Create set. These are tools that generate new objects. You can modify the attributes for the newly created objects in the Inspector.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pan Tool</td>
<td>H</td>
<td>Allows you to drag your view of the Canvas in different directions. The Pan tool never moves individual objects. To reset the pan, double-click the Pan tool. To pan the Canvas without selecting the Pan tool, press the Space bar and drag in the Canvas.</td>
</tr>
<tr>
<td></td>
<td>Zoom Tool</td>
<td>Z</td>
<td>Allows you to zoom in and out on the Canvas. Click the point in the Canvas that you want to zoom around and drag to the left to zoom in on that point or drag right to zoom out around that spot. To reset the zoom, double-click the Zoom tool. To zoom into a specific area of the Canvas, press Command+Space bar and drag an area of the Canvas. While still pressing the keys, click to zoom in to the Canvas in 50 percent increments of the current zoom level. Press Command+Option+Space bar and click in the Canvas to zoom out in 50 percent increments.</td>
</tr>
</tbody>
</table>

The second group of tools is the Create set. These are tools that generate new objects. You can modify the attributes for the newly created objects in the Inspector.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tool name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Rectangle Tool</td>
<td>R</td>
<td>Creates a new rectangular-shape object in the Canvas. Click at the position where you want one corner to appear and drag to the position of the opposite corner. Pressing Shift while you drag constrains the object to a square.</td>
</tr>
<tr>
<td></td>
<td>Circle Tool</td>
<td>C</td>
<td>Creates a new circle-shape object in the Canvas. Click at the position where one edge of the circle should begin and drag toward the opposite edge. Pressing Shift while you drag constrains the shape to a circle.</td>
</tr>
<tr>
<td></td>
<td>Bezier Tool</td>
<td>B Toggles Bezier/ B-Spline</td>
<td>Creates a new freeform shape with Bezier point vertices. To create a shape, click repeatedly in the Canvas to add points to your shape. To close the shape, click the first point of the shape or press C. To create an open-ended shape, double-click the last point.</td>
</tr>
</tbody>
</table>
The third set, the Mask tools, can only be accessed when another object is selected. Using a Mask tool creates a new mask that hides portions of the selected object. The area inside the mask remains visible. Masks have their own set of controls available in the Inspector.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Keyboard Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Rectangle Mask Tool" /></td>
<td><strong>Option+R</strong></td>
<td>Creates a new rectangular mask in the Canvas. Click at the position where you want one corner to appear and drag to the position of the opposite corner. Pressing Shift while you drag constrains the mask to a square.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Circle Mask Tool" /></td>
<td><strong>Option+C</strong></td>
<td>Creates a new circular mask in the Canvas. Click at the position where one edge of the mask should begin and drag toward the opposite edge. Pressing the Shift key while dragging constrains the mask to a circle.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Bezier Mask Tool" /></td>
<td><strong>Option+B</strong></td>
<td>Creates a new freeform mask with Bezier point vertices. To create a mask, click repeatedly in the Canvas to add points to your mask. To close the mask, click the first point of the mask or press C. To create an open-ended mask, double-click the last point.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="B-Spline Mask Tool" /></td>
<td><strong>Option+B</strong></td>
<td>Creates a new freeform mask with B-Spline vertices. To create a mask, click repeatedly in the Canvas to add points to your mask. To close the mask, click the first point of the shape or press C. To create an open-ended shape, double-click the last point.</td>
<td></td>
</tr>
</tbody>
</table>

Chapter 1  Getting To Know Motion
On the right side of the Toolbar, the first four icons make up the Effects controls. These are special controls providing instant access to the most common effects. Since these controls apply effects to existing objects, they are not available unless an object is selected.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Icon name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Add Behavior</td>
<td>Activates a pop-up menu of behaviors. Choosing an item from the menu applies that behavior to the selected object(s).</td>
</tr>
<tr>
<td>🌟</td>
<td>Add Filter</td>
<td>Activates a pop-up menu of filters. Choosing an item from the menu applies that filter to the selected object.</td>
</tr>
<tr>
<td>🌟</td>
<td>Make Particles</td>
<td>Uses the selected object as the source for a particle cell. The originally selected object is disabled. Controls for the particle system appear in the Inspector. Some controls also appear in the Dashboard. When the Adjust Item tool is selected, onscreen controls are available for the particle emitter.</td>
</tr>
<tr>
<td>🌟</td>
<td>Replicate</td>
<td>Uses the selected object as a source cell for the replicator. The originally selected object is disabled. Controls for the replicator system appear in the Inspector. Some controls also appear in the Dashboard. When the Adjust Item tool is selected, the replicator onscreen controls are available.</td>
</tr>
</tbody>
</table>

The Interface icons on the far right of the Toolbar provide access to the main elements of the Motion interface. Click any of these icons to show or hide the corresponding window, tab, or pane.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Icon name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Show/Hide Dashboard</td>
<td>F7, D</td>
<td>Toggles display of the Dashboard.</td>
</tr>
<tr>
<td>🌟</td>
<td>Show/Hide File Browser</td>
<td>Command+1</td>
<td>Toggles display of the File Browser. Hides and shows the Utility window if the File Browser is the only open tab.</td>
</tr>
<tr>
<td>🌟</td>
<td>Show/Hide Library</td>
<td>Command+2</td>
<td>Toggles display of the Library. Hides and shows the Utility window if the Library is the only open tab.</td>
</tr>
<tr>
<td>🌟</td>
<td>Show/Hide Inspector</td>
<td>Command+3</td>
<td>Toggles display of the Inspector. Hides and shows the Utility window if the Inspector is the only open tab.</td>
</tr>
<tr>
<td>🌟</td>
<td>Show/Hide Project Pane</td>
<td>F5</td>
<td>Toggles display of the Project pane.</td>
</tr>
<tr>
<td>🌟</td>
<td>Show/Hide Timing Pane</td>
<td>F6</td>
<td>Toggles display of the Timing pane.</td>
</tr>
</tbody>
</table>
Customizing the Toolbar
You have many options for personalizing the Toolbar. You can change which controls appear on the Toolbar as well as the order in which they appear. You can put spaces and separators between them to group them to your liking. You can view all of the controls as icons, icons with a text description, or just as text.

To add controls to the Toolbar:
1. Do one of the following to display the Customize Toolbar sheet:
   - Choose View > Customize Toolbar.
   - Control-click the Toolbar, then choose Customize Toolbar from the shortcut menu.
2. Drag the buttons or icons you want to add to the position of your choice in the Toolbar.
3. Click the Done button to close the sheet.

To remove an item from the Toolbar:
- Control-click the button or icon you want to remove, then choose Remove Item from the shortcut menu.

You can also remove items from the Toolbar when the Customize Toolbar sheet is open by dragging the objects away from the Toolbar and releasing the mouse button. A “poof” appears to indicate that the button has been removed.

Spaces and Separators
In addition to adding and arranging controls in the Toolbar, you can add spaces, flexible spaces, and separators to arrange and group the contents of your Toolbar.

Separator: A separator adds a dotted vertical line between two controls. The separator has no function other than as an organizational tool. The default layout uses a separator between the Effects controls and the Interface controls.

Space: A space adds a single icon’s width of space between other controls.

Flexible Space: A flexible space distributes controls evenly across the Toolbar. It takes up as much or as little space as needed to fill the empty parts of the bar. The default layout has a flexible space between the Mask buttons and the Effects controls.
Additional Buttons and Icons
The Customize Toolbar sheet provides access to additional icons that are not present in the default set.

Customize: Opens the Customize Toolbar sheet.

Colors: Opens the Colors window.

Fonts: Opens the Mac OS X Font panel. There is also a font browser within the Motion Library. For more information, see “Using the Library Font Browser” on page 464.

Layers: Shows or hides the Layers tab in the Project pane.

Media: Shows or hides the Media tab in the Project pane.

Audio: Shows or hides the Audio tab in the Project pane.

Timeline: Shows or hides the Timeline in the Timing pane.

Keyframe Editor: Shows or hides the Keyframe Editor in the Timing pane.
Audio Editor: Shows or hides the Audio Editor in the Timing pane.

Template Browser: Opens the Template Browser.

For more information on using the Template Browser, see “Creating New Projects From Templates” on page 141.

External Video: When you have an additional monitor connected to your system, clicking this icon automatically sends output to the external monitor. Clicking it again turns off output to the additional monitor. Without using this icon, you must choose Motion > Preferences (or press Command+,) and change the Output settings. This button has two states, depending on whether External Video is turned on or off.

Changing the Icon View
The Toolbar controls can be viewed as icons, text, or both. By default, both names and icons are displayed. Once you get familiar with the icons, you can choose to hide the names to save desktop space. Alternately, go with just the names to save the most space.

To change the view in the Toolbar, do one of the following:
• Control-click the Toolbar, then choose an option from the shortcut menu.
• Chose an option from the Show pop-up menu in the lower-left corner of the Customize Toolbar sheet.

Hiding the Toolbar
Once you get familiar with the common controls and the keyboard shortcuts, you may want to hide the Toolbar altogether to simplify the interface and provide more room for the Canvas.

To hide the Toolbar, do one of the following:
• Click the roll-up button in the upper-right corner of the Canvas.
• Choose View > Hide Toolbar.
• Press Command+Option+T.

If the Toolbar is currently hidden, these same controls all show the Toolbar instead of hiding it.

The Canvas
The centerpiece of the Motion workspace is the Canvas. Whatever you see in the Canvas reflects exactly what you get when you export or output your project. However, this window is not just a place to view the results of your work; this is where you modify and arrange the elements of your project.
You can directly manipulate the items in the Canvas to modify their physical attributes such as position, scale, and rotation, or use familiar drag-and-drop techniques to apply behaviors or filters directly to the items in the Canvas. See “Using Behaviors” on page 317, and “Using Filters” on page 701 to learn more about how to use these features.

The Status Bar
A Status Bar appears at the top of the Canvas below the Toolbar and provides information about your project. There are three types of information that can be displayed: Color, Coordinates, and Frame Rate.
**Color**

Some motion graphics projects may require you to match or align different colors in your project. The Status Bar can provide visual and numerical information on the color of the pixel currently under the pointer. No clicking is necessary—as you move the pointer, the Status Bar updates.

To display the current pixel color in the Status Bar:
- **Control-click** the Status Bar, then choose Color from the shortcut menu.

This allows you to see the exact color values of the examined pixel. You can view the color numerically in one of three formats:

**RGB:** The red, green, and blue components of the color are represented in values from 0–255.

**RGB (percent):** The red, green, and blue components of the color are represented in values from 1–100.

**HSV:** The hue is represented from 1–360, and the saturation and value (luminance) are represented in values from 1–100.

To choose between viewing color in RGB, RGB (percent), and HSV:
- **Control-click** the Status Bar, then choose the color space you want.

*Note:* Color must be enabled in the Status Bar to choose a color space.

**Coordinates**

For precision placement of objects in the Canvas, it may be helpful to know the exact pixel position of the pointer at any given time. The Status Bar can display this information in an X and Y coordinate system (Cartesian). The center point of the Canvas is 0,0.

To display the current pointer position in the Status Bar:
- **Control-click** the Status Bar, then choose Coordinates from the shortcut menu.

**Frame Rate**

Part of the way Motion plays your project back in real time is by lowering the frame rate when the sequence is too complex to render at full speed. You can monitor the current frame rate in the Status Bar. It is measured in frames per second (fps).
Note: This number only appears while the project is playing.

To monitor the project’s playback frame rate:
- Control-click the Status Bar, then choose Frame Rate from the shortcut menu.

You can also turn the Status Bar items on and off in the Appearance Preferences pane. To display Motion Preferences, choose Motion > Preferences.

Canvas View Options
The Canvas is a versatile workspace with many options to optimize the workflow for different types of projects. For example, there are rulers, grids, and guides to help with alignment and arrangement of objects.

There are also a number of controls for viewing a single color channel in the Canvas. You can use these to examine objects’ alpha channels, or to manipulate effects that only affect a single color channel.

You can also set options to speed up playback by reducing image quality so you can watch even complex projects at high frame rates while you’re constructing the projects. This allows you to rough out your composition quickly. Certain effects that severely impact rendering time, such as motion blur and field rendering, can also be turned off temporarily.
There are four pop-up menus at the right side of the Status Bar that provide access to these settings: Zoom Level, Resolution, Channels, and View and Overlay Options.

**Zoom Level**

You can zoom in on the Canvas to allow precision alignment and placement of objects, and you can zoom out to get a sense of the big picture or to see the path of a moving object. The Zoom Level pop-up menu offers several different default zoom levels. You can also use the dynamic zoom modes to quickly zoom in or out of the Canvas, or to zoom specific areas of the Canvas.

Zooming the Canvas does not actually change the size of the images in your project. It merely changes the current view of the entire window.

**To zoom in or out on the Canvas:**

- Choose a zoom level from the Zoom Level pop-up menu.
  
  Numbers above 100 percent zoom in on the object (making it appear bigger) and numbers below 100 percent zoom out beyond the viewable area.

To use the dynamic zoom mode:

- Press `Command+Space bar`, then drag diagonally in the Canvas. The zoom occurs around the spot clicked in the Canvas.

---

**Chapter 1  Getting To Know Motion**
To zoom in and out of a specific area of the Canvas:

- Press Command+Space bar, then drag the area of the Canvas you want to zoom. While still pressing the keys, click the mouse to zoom in 50 percent increments of the current zoom level. Press Command+Option+Space bar, and click to zoom out in 50 percent increments of the current zoom level.

**Note:** To pan the Canvas without selecting the Pan tool, press the Space bar and drag in the Canvas.

**To reset the Canvas Zoom level:**

- In the Toolbar, double-click the Zoom tool.

**To reset the Canvas Pan:**

- In the Toolbar, double-click the Pan tool.

**Fit In Window:** This option automatically zooms the Canvas so that the entire viewable area of the project fills the window.

**Resolution**

If you have a complex project that is causing your computer to play at a very low frame rate, you can lower the resolution of the Canvas to reduce the strain on the processor. This frees you from waiting for the image to be rendered at full resolution each time you make an adjustment.

**Full:** Displays the Canvas at full resolution.

**Half:** Displays the Canvas at half resolution.

**Third:** Displays the Canvas at one-third resolution.

**Quarter:** Displays the Canvas at one-quarter resolution.

**To change the Canvas resolution:**

- Choose the amount of image reduction you want from the Resolution pop-up menu.

**Channels**

The Channels pop-up menu controls which color channels are displayed in the Canvas.

**Note:** To see results in most cases, the Background Color parameter in the Project Properties (Command+J) must be set to 0 percent. By default, this parameter is set to 100 percent. This also affects Alpha, Inverted Alpha, and Overlay.

**Color:** Shows the image just as it would appear on a video monitor. Visible objects appear in natural color and transparent areas reveal the background color as set in the Project Properties. This is black by default. (To learn how to change the Canvas background color, see “Background” on page 115.)
Transparent: Shows the background area of the Canvas as transparent. A checkerboard pattern appears where no images block the background.

Alpha Overlay: Displays the image in normal color, but adds a red highlight over transparent areas of the image.

RGB Only: Displays the normal mix of red, green, and blue channels but transparent areas (including semi-transparent areas) are treated as opaque.

Red: Displays only the red channel as a range of black to white.

Green: Displays only the green channel as a range of black to white.

Blue: Displays only the blue channel as a range of black to white.

Alpha: Displays the alpha (transparency) channel of the objects in the Canvas.

Inverted Alpha: This setting displays an inverted view of the alpha (transparency) channel.

**View and Overlay Options**

This pop-up menu provides access to the various types of guides and controls that can be viewed in the Canvas. It also has controls to globally turn off some render-intensive functions, such as motion blur, to accelerate Canvas playback.

Show Overlays: Turns the display of all overlays on and off in the Canvas. This setting must be on in order to view any of the other overlay items (grids, guides, and so on). When Show Overlays is active, a checkmark appears beside the menu item.

**Note:** You can also choose View > Show Overlays (or press Command+/).

Rulers: Turns display of the rulers along the edge of the Canvas on and off. You can specify where the rulers appear in the Canvas section of Motion Preferences. For more information on using rulers, see “Using the Canvas Rulers” on page 43.

Grid: Turns a grid display on and off over the Canvas. You can set the spacing and color of the grid in the Canvas section of Motion Preferences.

Guides: Turns display of manually created guides on and off. Guides can only be created if rulers are also displayed. You can change the color of the guides in the Canvas section of Motion Preferences.

Dynamic Guides: Turns display of automatic Dynamic Guides on and off. These guides appear when dragging an object past edges of other objects. You can change the color of the Dynamic Guides in the Canvas section of Motion Preferences.

Safe Zones: Turns display of the Title and Action Safe guides on and off. By default, these guides are set at 80 percent and 90 percent. You can change these settings and the color of the guides in the Canvas section of Motion Preferences.
Film Zone: Turns display of the film aspect ratio guides on and off. This can be helpful if you are creating a project for videotape that is to be transferred to film. You can change the size of the guides as well as their color in the Canvas section of Motion Preferences.

Handles: Turns display of object handles in the Canvas on and off. Viewing object handles is necessary to perform transformations of objects. Handles only appear on selected objects. Handles must be turned on to view either lines or animation paths.

Lines: Turns display of the lines that outline an object on and off. These lines only appear when handles are turned on. If handles are not displayed, the Lines command has no effect.

Animation Path: Turns animation paths on and off. These editable paths indicate the route that animated objects travel along. If no object is animated, this command does not appear to have any effect. If handles are not displayed, the Animation Path command has no effect. Animation paths created by behaviors are not editable.

Correct for Aspect Ratio: Applies an artificial distortion of the Canvas in projects with nonsquare pixels. When the setting is on, the computer monitor simulates what a TV monitor would display. When the setting is off, projects with nonsquare pixels appear stretched. This is because computer monitors have square pixels. This setting does not modify the actual output of the project.

Preview for Float Bit Depth: When working in float space, turning this setting off drops the preview in the Canvas to 8-bit. Since working in float space drastically increases processing time, turn this setting off to speed your workflow. This setting does not modify the actual output of the project.

Note: For more information on float space, see “About Bit Depth” on page 144.

Field Rendering: Turning this setting off disables field rendering, which is required for smooth motion playback on a TV monitor. Field rendering nearly doubles rendering time, so disabling this may result in a dramatic performance improvement.

When this setting is turned on and you are using a default export preset (such as DV NTSC Movie), your project is exported with field rendering. This is because export presets are exported with “Use current project and canvas settings” turned on by default. When this is turned on, whatever is enabled in the View menu is also exported. This is controlled in the Export Options dialog.

Note: When opening a Motion project in another application such as Final Cut Pro or DVD Studio Pro, this setting does not control whether field rendering is applied or not. This is controlled in the Project Properties dialog (press Command-J). When Field Order is set to anything other than None, field rendering is used in the other application, regardless of the Field Rendering status in the View menu.
To override the current project settings for field rendering on export:
1. Choose File > Export.
2. Optional: Select a name and location for the saved file.
3. In the Save As sheet, click the Options button next to the Kind parameter.
4. In the Output tab of the Export Options dialog, turn off “Use current project and canvas settings.”

The “Use field rendering” and “Use motion blur” checkboxes become available.
When “Use field rendering” is turned on, the project is exported with field rendering regardless of the Field Rendering status in the View menu.

Motion Blur: Turning this setting off disables the preview of motion blur in the Canvas. This may result in a dramatic performance improvement. When using a default export preset, this setting affects the actual output of your project. All export presets are exported with the current project settings enabled.

When this setting is turned on and you are using a default export preset (such as DV NTSC Movie), your project is exported with motion blur. This is because export presets are exported with “Use current project and canvas settings” turned on by default. When this is turned on, whatever is enabled in the View menu is also exported. This is controlled in the Export Options dialog.

Note: When opening a Motion project in another application such as Final Cut Pro, this setting also controls whether motion blur is applied or not.

To override the current project settings for motion blur on export:
1. Choose File > Export.
2. Optional: Select a name and location for the saved file.
3. In the Save As sheet, click the Options button next to the Kind parameter.
4. In the Output tab of the Export Options dialog, turn off “Use current project and canvas settings.”

The “Use field rendering” and “Use motion blur” checkboxes become available.
When “Use motion blur” is turned on, the project is exported with motion blur regardless of the Motion Blur status in the View menu.

Using the Canvas Rulers
Using rulers in the Canvas can help you compose or align the elements of your project, as well as snap objects to the rulers.

To turn on rulers:
- In the View pop-up menu, enable Rulers. When enabled, a checkmark appears next to the item in the pop-up menu.
By default, rulers appear along the left and top sides of the Canvas. You can change the location of the rulers in the Canvas section of the Motion Preferences.

**To add a horizontal or vertical guide to the Canvas:**
1. In the Toolbar, click the Select/Transform tool (or press S).
2. Click in the gray area of the horizontal or vertical ruler, and drag into the Canvas. As you drag, the value of the guide is displayed in the Canvas.

   ![](image)

   The ruler units are in pixels, with the 0,0 point in the center of the Canvas.
3. When the guide is in the location you want, release the mouse button.

**To simultaneously add a horizontal and vertical ruler to the Canvas:**
1. In the Toolbar, click the Select/Transform tool (or press S).
2. Drag from the corner in which the rulers meet into the Canvas.
3. When the guides are in the location you want, release the mouse button.

**To remove a guide from the Canvas:**
1. In the Toolbar, click the Select/Transform tool (or press S), then drag the guide off the Canvas.

**To change the location of the rulers:**
1. Choose Motion > Preferences.
2. In the Canvas pane, choose a ruler layout from the Ruler Location pop-up.
To change the color of the guides:
1 Choose Motion > Preferences.
2 In the Canvas section, click the Guide Color color well, then select a color.

**Playing Your Project**
Use the transport controls at the bottom of the Canvas to play your project and see how it looks over time. You can set playback to loop as well as set playback to begin and end on certain frames in your project. You can also turn audio on and off.

**Play/Pause:** Starts and stops playback. The keyboard shortcut is the Space bar.

**Loop playback:** Controls whether playback loops indefinitely, or whether playback stops when the end of the play range is reached. The keyboard shortcut is Shift+L.

**Play from start:** Plays from the play range In point to the play range Out point. This allows you to watch just a portion of the entire project. To learn how to define the In and Out points, see “Defining the Play Range” on page 308.

**Go to start of project:** This button automatically returns your playhead to the beginning of the project. The keyboard shortcut is Home.

**Go to end of project:** Automatically moves the playhead to the end of the project. The keyboard shortcut is End.

**Go to previous frame:** Moves the playhead backward by one frame. Clicking the button (or holding down the shortcut key) rewinds the project one frame at a time. The keyboard shortcut is Left Arrow (or Page Up).

**Go to next frame:** Advances the playhead by one frame. Clicking the button (or holding down the shortcut key) advances the project one frame at a time. The keyboard shortcut is Right Arrow (or Page Down).

**Play/Mute audio:** Turns audio playback on or off.

**Note:** Turning audio off may improve your playback performance.

**Record:** Enables or disables animation recording. When recording is enabled, any action you make, such as moving an object or adjusting a slider, adds keyframes.
Note: When “Record keyframes on animated parameters only” is turned on in the Recording Options dialog, keyframes are added only to parameters that are already animated. For more information, see “Recording Keyframes on Animated Parameters Only” on page 451.

RAM Preview

When you play your project, Motion performs complex calculations to represent the objects and effects that appear in each frame. This is called rendering. The project plays back as quickly as possible up to the frame rate specified in the Project Properties dialog. With a very complex project, the frame rate may be significantly reduced, making it difficult to see how the project looks when it is played at full frame rate.

You can render parts of your project and store the frames in RAM. This lets you play back your project and see it play at full frame rate. This is called RAM Preview. You can choose to render the play range, a selection, or the entire project (All). As the frames are rendered, a progress dialog appears and shows which frame is being rendered, how many more frames remain, and an approximation of the time remaining.

You can interrupt the RAM Preview by clicking the Stop button. The section that has already been rendered is stored in RAM.

Note: Since different sections of the project can be of differing complexities, the Time remaining value may be somewhat inaccurate.

To RAM Preview your entire project:

- Choose Mark > RAM Preview > All.

The RAM Preview dialog appears, and displays a progress bar. When the RAM Preview is completed, the dialog closes.
When a section of your project is currently stored in RAM, the Timeline and the mini-
Timeline turn green to indicate which frames are stored.

**RAM Previewing Regions**

Previewing large sections of your project using RAM Preview requires large quantities
of RAM to store the frames. You may not have enough RAM to store all of the frames
you want to preview. You can restrict which frames are rendered either by choosing to
preview the play range or a selection. Using RAM Preview on a selection renders all
visible layers in the project from the first frame of the selection until the last.

**To RAM Preview the play range:**

- Choose Mark > RAM Preview > Play Range.

  The RAM Preview dialog appears, and displays a progress bar. When the RAM Preview is
  completed, the dialog closes.

**To RAM Preview a selection:**

1. In the Timeline, **Command+Option**-drag the region you want to preview.

   A light blue band appears over the selected frames.

   For more information on regions, see "**Working With Regions**" on page 309.

2. Choose Mark > RAM Preview > Selection.

   The RAM Preview dialog appears. When the RAM Preview is completed, the dialog
   closes.
**Note:** Working in float has no effect on your RAM Preview. Although the project is rendered in float, the preview is down-converted to 8-bit for display on your monitor.

**Clearing the RAM Preview**
You can manually delete the RAM Preview to make room for a new RAM Preview or to free up RAM for other operations.

To clear the RAM Preview:
- Choose Mark > RAM Preview > Clear RAM Preview.

**The Mini-Timeline**
The mini-Timeline lies just above the transport controls and below the body of the Canvas. This control provides an at-a-glance look at where selected objects fit into your overall project. The mini-Timeline also has a playhead to indicate which frame you are viewing as well as In and Out markers to identify the play range. The width of the mini-Timeline represents the entire duration of the project.

You can drag the playhead through the mini-Timeline to scrub your project, or to jump quickly to a particular point in time. You can also change the play range or object In and Out points by dragging the In and Out markers to the position you want. When you drag an In or Out point, the playhead temporarily moves along with the mouse. This allows you to see the frame where your In or Out point will be set. When you release the mouse button, the playhead snaps back to its previous position.

Project markers set in the Timeline are indicated in the mini-Timeline by a thin, green line.

**Note:** Object or layer markers do not appear in the mini-Timeline.

**Editing in the Mini-Timeline**
You can perform many nonlinear editing functions right in the mini-Timeline. You can drag objects from the Utility window directly to the mini-Timeline. You can also move, trim, and slip objects to change which portion of the clip appears at which point in time. For more information on editing functions such as Move, Trim, and Slip, see “Editing Objects in the Timeline” on page 293.
To add an object to the mini-Timeline:
1 Drag the object from the File Browser to the mini-Timeline.  
   As you drag, a tooltip appears to indicate the frame where your edit will take place.
2 When you reach the desired frame, release the mouse button.  
   The object is added to the project beginning at that frame.

You can also add multiple objects to the mini-Timeline at once. You can choose to add the objects sequentially (one after another) or as a composite (all at the same point in time).

If the Timeline contains project markers, you can snap the imported object to a marker. As you drag the object over the mini-Timeline, a black bar appears at the snap point.

To add multiple objects to the mini-Timeline:
1 Drag the objects from the File Browser to the mini-Timeline.  
   As you drag, a tooltip appears to indicate the frame where your edit will take place.
2 When you reach the desired frame, pause the pointer.  
   A drop menu appears.
3 Choose the desired edit type from the drop menu, then release the mouse button.
To move an object in time:
1 Select the object you want to move.
   The object appears in the mini-Timeline.
2 In the mini-Timeline, drag the object to the left or right to reposition it in time.
   A tooltip appears to indicate the new In and Out point of the object, as well as the
   amount of change from the previous position.
3 When you reach the position you want, release the mouse button.

To shorten or lengthen an object:
1 Select the object to display it in the mini-Timeline.
2 Position the pointer over the beginning or ending edge of the object.
   The pointer changes to a Trim pointer.
3 Drag the edge of the object to change its duration.
   A tooltip appears to indicate the new In or Out point and the amount of change that
   your edit is causing.

   Note: You cannot trim an object to be longer than the amount of frames available in
   the corresponding media file.

To slip an object in the mini-Timeline:
1 Select the object you want to modify.
2 Position the pointer over the body of the clip in the mini-Timeline and press the
   Option key.
   The pointer changes to a Slip pointer.
3 Drag the clip to the left or right to use a later or earlier part of the clip.
A tooltip appears to indicate the new In and Out points.

![Image of timeline showing In and Out points]

**Note:** You cannot slip a clip unless it has been trimmed first. For more information, see “Slipping Objects” on page 296.

**To snap the playhead to a project marker in the mini-Timeline:**
- Press Shift and drag the playhead in the mini-Timeline.

**Timecode and Current Frame Fields**
There are two timecode fields at the bottom of the Canvas, to the left and right of the transport controls. The field to the left is the Current Frame field which shows the frame or timecode number where the playhead is positioned. You can change the playhead position by changing the number in the Current Frame field.

![Current Frame field]

The field to the right is the Project Duration field. This field indicates the length of your current project. You can modify the duration of the project by changing the number in this field.

![Project Duration field]

Both fields can be modified in multiple ways and can be displayed either as incremental frame numbers or as eight-digit timecode numbers.

**To change the current frame or duration:**
- Click the field, type a new number into the field, and then press Tab or Return to confirm your entry.
To increase or decrease the current frame or duration one frame at a time:

- Click the increment or decrement arrow for the field you want to change.

Note: You can also move the playhead forward and backward one frame at a time by pressing **Left Arrow** (or **Page Up**) to decrease, and **Right Arrow** (or **Page Down**) to increase.

To change the duration in seconds, minutes, or hours, type the following in the **Project Duration** field:

- To set the duration in seconds, type the number of seconds followed by "." (period). For example, to create a 10-second project, type `10.` in the field, then press **Return**.

- To set the duration in minutes, type the number of minutes followed by `..` (two periods). For example, to create a 10-minute project, type `10..` in the field, then press **Return**.

- To set the duration in hours, type the number of hours followed by `...` (three periods). For example, to create a 1-hour project, type `1...` in the field, then press **Return**.

This procedure works in timecode as well as frames.

To move ahead or back in seconds, minutes, or hours, type the following in the **Current Frame** field:

- To move forward in seconds, type `+` (plus), then type the number of seconds you want to move forward, and then type `.` (period). For example, to move 2 seconds ahead, type `+2.` in the field, then press **Return**. To move ahead in minutes, type two periods after the number, and to move ahead in hours, type three periods after the number.

- To move backward in seconds, type `−` (minus), then type the number of seconds you want to move backward, and then type `.` (period). For example, to move 2 seconds backward, type `−2.` in the field, then press **Return**. To move backward in minutes, type two periods after the number, and to move backward in hours, type three periods after the number.

To move the playhead to a specific frame:

- With the Canvas or Project pane active, type the desired timecode or frame number into the Current Frame field. Press **Return** to confirm your entry.

To move forward a specific number of frames:

- Type `+` (plus) followed by the number of frames you want to move forward.

Chapter 1  Getting To Know Motion
To move backward a specific number of frames:
- Type “–” (minus) followed by the number of frames you want to move backward.

To modify the current frame or duration dynamically:
- Click the center area of the field (where the numbers are), then drag to the left to increase the value, or to the right to decrease the value.

Dragging the Current Frame field in this way is equivalent to dragging the playhead through the mini-Timeline.

To switch between timecode and frame numbers, do one of the following:
- Click the Current Frame icon directly to the left of the Current Frame field.
- Click the Duration icon directly to the left of the Project Duration field.

Clicking either icon switches between frame and timecode view for all controls in all open projects.

**Counting Time**

Motion offers two different ways of looking at the frame numbers for your project. You can view the time as incremental frames, starting at 1 or 0 and continuing indefinitely. Or, you can view the time in the video-standard, eight-digit timecode system, which runs like a clock from 00:00:00:00 to 23:59:59:29. The first two digits represent the hours; the second two, the minutes; the third two, the seconds; and the final two, the frames, as in HH:MM:SS:FF.

Some formats of timecode also skip numbers in order to accommodate the inexact frame rates of certain video formats.

Both frames and timecode have advantages, depending mainly on the format with which you are originating and finishing. For example, if you are designing a title sequence for a 35mm film that must be exactly 720 frames, it is easier to set your counters to frames.

If you are building a television spot that is going to be laid onto a videotape or broadcast, you would probably benefit from setting your counters to timecode, so that the frame numbers correspond with the numbers on the videotape.

**The Project Pane**

Once you begin building more complex projects, you may need to view the components of your project in a list. You can view and modify the hierarchy of layers and objects, including grouping objects and changing layer order. You can turn certain objects and effects on and off to temporarily simplify your composition. You can view and modify the media files associated with the objects in your project. You can also modify certain attributes of the objects, such as opacity, blend mode, and audio levels.
All of this can be accomplished in the Project pane, which is ordinarily to the left of the Canvas.

To display the Project pane, do one of the following:

- Drag the divider bar on the left edge of the Canvas.
- Click the Project icon in the Toolbar.
- Press F5.

You can also switch the arrangement of the windows so the Project pane appears on the right side of the Canvas.

To switch the sides of the Canvas and Project panes:

- Choose Window > Layouts > Swap Project Pane and Canvas.

The Project pane contains three tabs: Layers, Media, and Audio. Each of these tabs allows you to view the elements of your project in a list view.

**The Layers Tab**
The Layers tab provides an overview of all the objects, effects, and masks currently used in your project. The hierarchy of items in the list illustrates which objects are above or below other objects in the Canvas. Objects reside within layers, and masks, behaviors, and effects are listed beneath the objects to which they are applied. In these cases, the sub-objects are indented in the list.
To display the Layers tab, do one of the following:

- Click the Project Pane icon in the Toolbar.
- Choose Window > Layers.
- Press Command+4.
- If the Project pane is not already visible, click the Layers tab at the top of the pane.

The information is displayed in a column view and there are many controls to let you customize the view while you are working. You can resize or rearrange the columns and you can hide certain columns and display others that are not visible in the default set.

**On:** Contains an activation checkbox to turn the visibility of the object on or off. When the object visibility is turned off, you can still modify the object's parameters and manipulate its onscreen controls.

**Preview:** Contains a thumbnail of the object or mask.

**Name:** Identifies the object by name. To edit the name, double-click the text area of a selected object.
**Lock:** Lets you lock an object to prevent any changes from affecting that object. Locking a layer prevents changes to all objects within that layer. This column may also include a Link icon when an object has a corresponding audio element.

To display additional columns, click the Show Columns button at the right of the column headers. A pop-up menu appears containing three items: Preview, Opacity, and Blend.

Checkmarks in the pop-up menu identify which columns are currently displayed. By default, only the Preview column is checked. Choose the other items to add them to the Layers tab view. Choosing a checked item hides it from view.

**Opacity:** Displays the current opacity (transparency) of the object. You can adjust the slider to change the object’s opacity.

**Blend Mode:** Displays the object’s current blend mode. Click the pop-up menu to choose a new blend mode for that object. For more on blend modes, see “Using Blend Modes” on page 249.

Chapter 1  Getting To Know Motion
Editing Columns
Any window that contains columns of data can be reorganized to suit your needs. You can change the order in which columns appear as well as the size of the cells. For example, in the Layers tab, you may want the Preview column to appear to the right of the Name column instead of to its left. You can also sort the items in the column by type of file.

To reorder columns:
1. Click the column header you want to move.
   The pointer changes to a fist.
2. Drag the column left or right to the new position.
   Motion lets you resize columns in several ways. You can adjust the width of a column, or you can change the height of all cells in the columns at once, including any icons and text inside the cells.

To adjust column width:
1. In the cell at the top of the column, position the pointer over the vertical line at the right side of the column.
   The column adjust pointer appears.
2. Drag left or right until the column is the width you want.

To adjust cell height:
1. Position the pointer over any horizontal line until the row adjust pointer appears.
2. Drag up or down to decrease or increase the height of all cells.
   Icons and thumbnails resize themselves as you make the adjustment.
   You can also drag the scale slider at the bottom of the window. Drag left to decrease the size, and right to increase the size of the cells.
To sort the items in a column by type of file:

- Click the column header.

<table>
<thead>
<tr>
<th>Item</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickTime Audio</td>
<td>00:01:13.3</td>
</tr>
<tr>
<td>Still Image</td>
<td>00:00:00.01</td>
</tr>
<tr>
<td>Still Image</td>
<td>00:00:00.01</td>
</tr>
<tr>
<td>QuickTime Audio</td>
<td>00:01:13.3</td>
</tr>
<tr>
<td>QuickTime Movie</td>
<td>00:00:10:01</td>
</tr>
</tbody>
</table>

Note: Sorting does not work in the Layers tab or Timeline.

The objects are sorted in the column and a small arrow appears indicating the direction of the sort.

To reverse the direction of the sort:

- Click the header of the column that contains the small arrow.

The arrow points in the opposite direction, and the data is sorted in reverse order.

Adding and Removing Layers

The Layers tab has controls to add new layers and to remove existing objects from the project.

To create a new layer in the Layers list:

- Click the Add (+) button in the upper-left corner of the tab.

A new empty layer is added at the top of the list.

To remove an object from the Layers list:

1. Select the object you want to remove.
2. Click the Delete (−) button in the upper-left corner of the tab.

The object is removed.

Note: This action removes the object from the Canvas as well.
Filtering the Layers List View
As your project becomes more complex, you may want to temporarily hide certain objects from view. This allows you to focus on one or more objects without the distraction of all the other objects in your list. You can perform this sort of filtering by using the Search field in the upper-right corner of the tab.

Once you begin typing in the Search field, the Layers list hides any objects that do not contain the text you type. Hidden objects continue to appear in the Canvas.

To filter the Layers list:
- Type the name of the object(s) you want to view in the Search field. All other objects are temporarily hidden.

To stop filtering and return to the complete list:
- Click the Clear button inside the Search field.

The Search field is cleared and the Layers list returns to the unfiltered view.

Hiding and Showing Effect Objects
Masks, behaviors, and filters can be turned on and off in the Layers list by using the buttons at the bottom-right corner of the Layers tab.

Note: Hiding the effect object does not disable it from view in the Canvas nor prevent you from modifying the object’s parameters or manipulating its onscreen controls.

To display masks in the Layers tab:
- Click the Show Masks button.
Click the button again to hide the masks.

To display behaviors in the Layers tab:
- Click the Show Behaviors button.
Click the button again to hide the behaviors.
To display filters in the Layers tab:

- Click the Show Filters button.

Click the button again to hide the filters.

**Turning Effects On and Off**

When certain effects are applied to an object, icons appear in the Name column for that item. This lets you know that such an effect is applied, especially if you have the effect objects hidden. There are icons for masks, filters, and behaviors. Additionally, these icons let you toggle the effects on and off in the Canvas.

*Note:* You can also Control-click the icons in the Layers tab or Timeline Layer list to display a list of the applied effects.

**To turn masks off for an object:**

- Click the Masks icon for the object you want to change.

A red slash appears over the icon and the effect is temporarily turned off.

**To turn behaviors off for an object:**

- Click the Behaviors icon for the object you want to change.

A red slash appears over the icon and the effect is temporarily turned off.

**To turn filters off for an object:**

- Click the Filters icon for the object you want to change.

A red slash appears over the icon and the effect is temporarily turned off.

For each of these controls, clicking the icon again turns the effect back on.

**Additional Options**

Quite a few additional features are available in the Layers tab, which you can find in the shortcut menu that appears when you Control-click objects in the list. These operations apply to the selected object or objects.

**Cut:** Removes the object and places it on the Clipboard.
Copy: Copies the object to the Clipboard.
Paste: Places the contents of the Clipboard in the current location.
Duplicate: Creates an identical object to the selection.
Delete: Removes the selected object.
Group: Places the selected objects into a group. (For more on working with groups see “Grouping and Ungrouping Objects” on page 202.)
Ungroup: Restores the components to their ungrouped state if the selection contains a group.
Active: Turns the object on or off. This is equivalent to clicking the activation checkbox in the On column.
Blend Mode: Sets the blend mode for the selected object. This is equivalent to setting a value in the Blend column.
Reveal Source Media: Opens the Media tab and highlights the media file associated with the selected clip.

The Media Tab
The second tab in the Project pane contains a complete list of media in your project. Unlike the Layers tab, the Media tab may contain items that are not used in your Canvas. Also, if you’ve used a single object repeatedly, the Media tab may only show one version of that object. Effects, generators, and other objects created within Motion (such as masks, shapes, or text objects) do not appear in the Media tab.

To display the Media tab, do one of the following:
- Choose Window > Media.
- Press Command+5.
- If the Project pane is already visible, click the Media tab at the top of the pane.

The Media tab provides a great deal of technical information about the media associated with the objects in your project. This data is displayed in the columns for each object.

Preview: Shows a thumbnail of the media.
Name: Contains the name of the media. Media names are not editable because they refer to the actual names of the files on disk.

Chapter 1  Getting To Know Motion
Kind: Identifies the type of media, including QuickTime movie, still image, QuickTime audio, or PDF. See “Video and File Formats” on page 941 for a list of supported codecs and file types.

Duration: Displays the duration of the media in either frames or timecode.

Frame Size: Displays the native size of the image in pixels. The numbers represent width and height. This column remains blank for audio only objects.

Compressor: Displays the type of compression used in the clip, if any. This is also sometimes referred to as a codec.

Depth: Displays the number of colors (bit depth) of the object. Any item listed as Millions of Colors + indicates that the media contains an alpha channel in addition to the RGB data.

Vid Rate: Displays the original frames per second of the media. Sequences are listed at the current project frame rate and still images display no Vid Rate.

Data Rate: Displays the number of bytes per second at which the media file plays.

Aud Rate: Displays the sample rate in the audio track, measured in kilohertz (kHz).

Aud Format: Displays the bits per sample (usually 8 or 16) and the number of channels (usually mono or stereo) of the audio track.

File Size: Displays the overall file size of the media on disk.

File Created: Displays the creation date of the media.

File Modified: Displays the last date on which the media was modified.

**Hiding Columns**

You can choose which of the columns are displayed by clicking the Show Columns button at the right of the column headers.

Items in the list with a checkmark are currently displayed in the Media tab. Items with no checkmark are currently hidden.
To hide a column:

- Click the Show Columns button at the right of the column headers, then choose the item you want to hide from the pop-up menu.

**Editing Columns**

Any window that contains columns of data can be reorganized to suit your needs. You can change the order in which columns appear, as well as the size of the cells. For example, in the Media tab, you may want the Frame Size column to appear before the Name column. For specific instructions on how to edit columns, see “Editing Columns” on page 57.

**Adding and Removing Media**

The Media tab has controls to add new files and to remove existing objects from the project.

**To add a file to the Media tab:**

1. Click the Add (+) button in the upper-left corner of the tab.
   
   The Import Files dialog appears.

2. Navigate to the file you want to add to your project, then select the file.

3. Click Import.

   The file is added to the Media tab.

   **Note:** Objects added directly to the Media tab are not added to the Canvas.

**To remove an object from the Media tab:**

1. Select the object you want to remove.

2. Click the Delete (−) button in the upper-left corner of the tab.

   The media is removed. If the media is used in the Canvas, an alert appears asking you to confirm that you want to remove the objects.

**Filtering the Media Tab**

As your project becomes more complex, you may want to temporarily hide certain objects from view. This allows you to focus on one or more objects without the distraction of all the other objects in your list. You can perform this sort of filtering by using the Search field in the upper-right corner of the tab. For instructions on how to filter the Media tab, see “Filtering the Layers List View” on page 59.

**Additional Options**

Quite a few additional features are available in the Media tab, which you can find in the shortcut menu that appears when you Control-click objects in the list. The actions in this menu apply to the selected object or objects.

**Open in Viewer:** Opens the selected item in the Viewer window. This is equivalent to double-clicking an object in the File Browser.
Open In QuickTime Player: Opens the selected item in the QuickTime Player application.

Reveal in Finder: Switches out of Motion, and opens a Finder window where the Media file resides on disk.

Reconnect Media: Opens the reconnect media sheet where you can assign a new source file on disk to correspond to the Media file in Motion.

Cut: Removes the object and places it on the Clipboard.

Copy: Copies the object to the Clipboard.

Paste: Places the contents of the Clipboard in the current location.

Duplicate: Creates a new object identical to the selection.

Delete: Removes the selected object.

The Audio Tab
The Audio tab lists all of the objects in your project that contain audio. You can modify the levels of the individual objects or modify the overall audio level of the project. For more information on working with audio in Motion, see “Working With Audio” on page 877.

To display the Audio tab, do one of the following:
- Choose Window > Audio.
- Press Command+6.
- If the Project pane is already visible, click the Audio tab at the top of the pane.
The Audio tab contains a number of columns with both display and editable information about the audio components of your project.

**On:** Contains an activation checkbox to turn the audio for the object on or off.

**Name:** Identifies the object by name. To edit the name, double-click the text area of a selected object. This column also contains a slider and value field to control the volume of the object. Numbers in the value field are measured in decibels (dB).

**Status:** Contains Mute and Solo buttons to control audio playback for the object. When the Mute button is active, all sound from that object is removed from the mix. When the button is released, audio from the object plays back based on the level slider in the Name column.

When the Solo button is active, other non-soloed audio elements do not play. This allows you to temporarily play a single item without hearing the other objects in the mix. You can solo more than one object. This allows you to hear just the soloed objects rather than the entire mix.

**Pan:** Displays the left-right balance of the sound. You can modify the Pan parameter by dragging the slider to the right or left or by entering a numerical pan value. Negative numbers move panning to the left, positive numbers move panning to the right.

**Lock:** Allows you to lock an object to prevent any changes from affecting that object. This column also may include a Link icon when an object has a corresponding video element.

**Editing Columns**
You can control which columns are displayed by clicking the Show Columns button to the right of the column headers. Clicking that button opens a pop-up menu with a list of columns. Items in the list with a checkmark are displayed in the window. Items without a checkmark are hidden. You can also edit the arrangement and size of the columns. For more on how to hide and show columns, see “Hiding Columns” on page 62. For instructions on how to edit columns, see “Editing Columns” on page 63.

**Adding and Removing Audio Files**
The Audio tab has controls to add new files and to remove existing files from the project.

**To add an audio file to the project:**
1. Click the Add (+) button in the upper-left corner of the tab.
   The Import Files dialog appears.
2 Navigate to the file you want to import, then select the file.
3 Click OK.
   The file is added to the Audio tab.

   **To remove a file from the Audio tab:**
1 Select the file you want to remove.
2 Click the Delete (–) button in the upper-left corner of the tab.
   The object is removed.

   *Note:* This action removes the file from the project.

**Filtering the Audio Tab**
As your project becomes more complex, you may want to temporarily hide certain audio files from view. This allows you to focus on one or more files without the distraction of all the other files in your list. You can perform this sort of filtering by using the Search field in the upper-right corner of the tab. For instructions on how to filter your view, see “Filtering the Layers List View” on page 59.

**Additional Options**
Quite a few additional features are available in the Audio tab, accessible through the shortcut menu that appears when you `Control`-click files in the list.

**Cut:** Removes the file and places it on the Clipboard.

**Copy:** Copies the file to the Clipboard.

**Paste:** Places the contents of the Clipboard in the current location.

**Duplicate:** This creates a new file identical to the selection.

**Delete:** Removes the selected file.

**Active:** Turns the file on and off. This is equivalent to clicking the activation checkbox in the On column.

**Mute:** Sets the selected item to be muted. This is equivalent to clicking the Mute button in the Status column.

**Solo:** Sets the selected item to Solo. This is equivalent to clicking the Solo button in the Status column.

**Reveal Source Media:** Opens the Media tab and highlights the media file associated with the selected clip.
The Timing Pane

At some point in most projects, you will want to view the contents of your composition represented as a graph over time. This may be to compare when two objects appear or disappear, or when an effect begins or changes. You may want to add or remove objects in your project at a particular point in time, to observe or modify how different parameters of different effects occur. You may also want to view your audio waveforms to allow visual events to synchronize with your soundtrack.

All of this can be accomplished in the Timing pane, which appears at the bottom of the Canvas.

To display the Timing pane, do one of the following:

- Drag the divider bar on the bottom edge of the Canvas.
- Click the Timing icon in the upper-right corner of the Canvas.
- Press F6.

The Timing pane contains three tabs: Timeline, Keyframe Editor, and Audio Editor. Each of these allows you to view the elements of your project stretched out over time.
The Timeline
The Timeline is the most general of the Timing tabs. It can display not only the visual objects in your project, but also the audio objects and effects such as masks, behaviors, filters, and keyframes. For more information on using the Timeline, see “Using the Timeline” on page 273.

To display the Timeline tab, do one of the following:
- Choose Window > Timeline:
- Press Command+7.
- If the Timing pane is already visible, click the Timeline tab at the top of the pane.

The Timeline Layer List
The left side of the Timeline is nearly identical to the Layers tab in the Project pane. Objects appear in their layer hierarchy categorized into layers and groups. The three columns are identical to the columns in the Layers list.

Activation checkbox: The checkbox to the left of each object turns the visibility of the object on and off.

Name: Contains the text description of the object. Double-click the text to modify the name of an object.
Lock: The third column contains the Lock control which prevents any changes from affecting the object. This column also contains the Link icon for objects with both audio and picture components.

Note: Changes made in the Timeline Layer list also change the Layers list in the Project pane and vice versa.

Effects Controls
When certain effects are applied to an object, icons appear in the Name column for that item. There is an icon for masks, filters, and behaviors. These icons control the visibility of those effects in the Canvas.

To turn masks off for an object:
- Click the Masks icon in the Timeline Layer list.
  A red slash appears over the icon and the effect is temporarily turned off.

To turn behaviors off for an object:
- Click the Behaviors icon in the Timeline Layer list.
  A red slash appears over the icon and the effect is temporarily turned off.

To turn filters off for an object:
- Click the Filters icon in the Timeline Layer list.
  A red slash appears over the icon and the effect is temporarily turned off.

For all three of these controls, clicking the icon again turns the effect back on.
Display Options
As with the Layers tab, you can choose to show or hide effects such as masks, filters, and behaviors. Additionally, the Timeline lets you display keyframes. You can also choose to display audio objects and, if audio objects are displayed, you can hide visual objects. All of these display options are controlled by the row of buttons in the lower-left corner of the Timeline.

Masks, behaviors, and filters can be displayed as objects in the Timeline, just as they are displayed in the Layers tab. Showing or hiding effects in the list does not control whether the effect appears in the Canvas.

To show masks in the Timeline:
- Click the Show/Hide Masks button.

To show behaviors in the Timeline:
- Click the Show/Hide Behaviors button.

To show filters in the Timeline:
- Click the Show/Hide Filters button.

Click any of these buttons again to hide those objects.

When keyframes are shown, each track gets a little taller, and the bottom section is used to show any keyframes that exist for the object.

To show keyframes in the Timeline:
- Click the Show/Hide Keyframes button.

Click the button again to hide the keyframes.
Audio files appear in a separate section from visual objects. You can move the divider between the audio and video sections of the Timeline to show more or less of each section.

To show audio files:
- Click the Show/Hide Audio button in the lower-left corner of the Timeline.
  
  Click the button again to hide audio files.

To hide video objects:
- Click the Show/Hide Layers button in the lower-left corner of the Timeline.
  
  Note: You cannot hide video objects unless audio files are currently visible. This is to prevent the Timeline from becoming completely empty.

To move the divider bar between audio and video tracks:
- Position the pointer over the divider bar, then drag the bar up or down to expand or contract the track section.

You can adjust the height of the tracks in the Timeline to provide more or less vertical space. You can also expand the size of the Layer list.

To adjust track height:
1. Position the pointer over any horizontal line, until the row adjust pointer appears.

2. Drag up or down to decrease or increase the height of all tracks.
   
   The tracks expand or contract as you make the adjustment.
You can also use the track height control at the bottom of the tab. Click the track size indicator to set the tracks to that height.

To change the width of the Timeline Layer list:
1 Position the pointer over the rightmost edge of the Timeline Layer list.
   The pointer changes to the column adjust pointer.

2 Drag left or right to resize the Layer list.

Adding and Removing Layers
The Timeline has controls to add new layers and to remove existing objects from the project.

To create a new layer in the Timeline:
- Click the New Layer button (+) in the upper-left corner of the tab.
   A new empty layer is added at the top of the list.

To remove an object from the Timeline:
1 Select the object you want to remove.
2 Click the Delete button (–) in the upper-left corner of the tab.
   The object is removed.

Note: This action removes the object from the Canvas as well.

Using the Current Frame Field
Next to the New Layer button (+) and the Delete button (–), the Timeline also contains a Current Frame field that can be used to navigate your project.

To move the playhead to a new time, do one of the following:
- Double-click the Current Frame field, then type a frame number.
- Drag the Current Frame value slider to the left or right to advance or rewind.
- With the Timeline active, type the timecode or frame number where you want to move the playhead. Press Return to jump to that frame.

To move forward a specific number of frames:
- Type “+” (plus) and then the number of frames you want to move forward.

To move backward a specific number of frames:
- Type “−” (minus) and then the number of frames you want to move backward.
The Track Area

The main part of the Timeline, to the right of the Layer list, is the track area. Objects in your project are each represented by a colored bar. Different colors represent different types of objects. For example, behaviors and filters are purple and audio objects are green. For a complete table of colors, see "Getting Familiar With the Timeline" on page 274.

Layer tracks differ from individual object tracks in two ways. First, there is an overview bar in addition to the area that represents the objects within the layer. Secondly, for areas where more than one object overlaps within a layer, the Layer track displays a special indicator that identifies how many objects appear within that section. Effects objects such as masks, behaviors, and filters are not counted in that total.

You can collapse a layer track so the tracks for the individual objects within the layer are temporarily hidden.
To collapse or expand a layer:
- Click the disclosure triangle to the left of the layer name in the Timeline Layer list.

A variety of editing tasks can be done in the Timeline, including moving, trimming, and slipping. For more information on how to perform editing in the Timeline, see “Editing Objects in the Timeline” on page 293.

The Timeline Ruler
At the top of the track area is the ruler that provides a gauge for the positions and durations of the objects in your project.

The ruler can contain indicators to help mark important frames or sections of the project such as the playhead, play range indicators (also called In and Out points), and markers. The ruler can be viewed in frames or timecode.

To change the ruler view format:
- Control-click the ruler, then choose Display Frames or Display Timecode from the shortcut menu.

The playhead tracks the frame currently visible in the Canvas. You can drag the playhead or reposition it using the transport controls described in “Playing Your Project” on page 45. The playhead in the Timeline and the playhead in the mini-Timeline are linked. Moving one automatically moves the other.

The play range indicators limit the area of the project to be played. For more on setting and using the play range, see “Defining the Play Range” on page 308.
Markers can be added to your project to identify an important frame or range of frames. For more on creating and using markers, see “Adding Markers” on page 312.

**Zooming in the Timeline**

As you get familiar with using the Timeline, you will find yourself wanting to focus on an individual edit point one second, and the next, you’ll want to see the overview of your whole project. Fortunately, you can quickly zoom in and out on the Timeline using a variety of different tools.

The bottom of the Timeline contains a Zoom slider and a Zoom/Scroll control.

To zoom the Timeline using the Zoom slider:

- Click the thumb of the Zoom slider and drag left to zoom in, and right to zoom out.
  The Timeline updates as you drag.

To zoom the Timeline using the Zoom/Scroll control:

- Click the edge of the scroll bar thumb and drag it away from the center to zoom out and toward the center to zoom in.
  The Timeline updates as you drag.

You can also automatically zoom the Timeline to include the entire duration of your project or just the play range as defined by the play range indicators (In and Out points).

To zoom the Timeline to fit the entire project, do one of the following:

- Double-click the Zoom Time View button to the right of the ruler.
- Choose View > Zoom Time View > To Project.
- **Control**-click the ruler, then choose Zoom to Project from the shortcut menu.

To zoom the Timeline to fit the play range, do one of the following:

- Click the Zoom Time View button to the right of the ruler.
- Choose View > Zoom Time View > To Play Range.
- **Control**-click the ruler, then choose Zoom to Play Range from the shortcut menu.
The Zoom Time View button toggles between the Zoom to Play Range and Zoom to Project settings. If no play range is established, choosing Zoom to Play Range performs a Zoom to Project.

**Changing the Track Display**
The tracks in Motion can be displayed in a variety of ways to satisfy different working styles. You can set your tracks to be viewed as Name Only, Name Plus Thumbnail, and Filmstrip.

![Track Display Options]

**To change the Timeline track display:**
1. Choose Motion > Preferences (Command+,) to open Motion Preferences.
2. Click the Appearance icon to switch to the Appearance pane.
3. In the Timeline section, set the Timebar Display pop-up menu to the setting you want.

*Note:* When the Timebar Display is set to Filmstrip, your processing time is increased.

**The Keyframe Editor**
The Keyframe Editor is where you can view and modify the individual attributes of filters, behaviors, and other effects over time. Each parameter can be displayed as a curve showing how the value changes over time. You can manipulate the points within that curve (called *keyframes*) to create a variety of powerful effects. For more information on using the Keyframe Editor, see “Keyframes and Curves” on page 401.
To display the Keyframe Editor, do one of the following:

- Choose Window > Keyframe Editor.
- Press Command+8.
- If the Timing pane is already visible, click the Keyframe Editor tab at the top of the pane.

The Parameter List

The left side of the Keyframe Editor contains a list of parameters. You can choose which parameters are displayed in the list and set keyframing functions in the Animation menu. You can also create custom sets of parameters. This allows you to focus on certain parameters at a time. For more information on creating and viewing parameter sets, see “Custom Parameter Sets” on page 430.

Use the Show pop-up menu to select what is displayed in the Keyframe Editor. The Show options include:

- **All**: This option displays all parameters for the currently selected object in the list, whether or not the parameters are animated.
- **Animated**: This option displays only the animated parameters and curves for the currently-selected object. This is the default setting.
- **Active**: This option shows only the parameters currently being modified. When this option is selected, nothing appears in the Keyframe Editor unless you are actively modifying an object (in the Canvas, Inspector, or Dashboard). For example, when Active is selected and you are moving an object around in the Canvas, the X and Y Position parameters and curves are displayed.

The Parameter list is divided into four columns.

**Activation checkbox**: This checkbox, to the left of each parameter, toggles the display of that parameter on and off in the keyframe graph. Clicking the checkbox next to the object name turns all of the parameters for that object on or off.
Name: Lists the name of the object and its parameters.

Value: Displays the value for the current playhead position for that parameter. You can drag in the value field to set new keyframe values, or double-click in the field and type a new value. For more information, see “Keyframes and Curves” on page 401.

Animation menu: The last column contains a pop-up menu to control animation and keyframing attributes for that parameter. The menu items are listed below.

- Enable/Disable Animation: Remains dim until keyframing is applied to the channel, either by using the Record button or by directly adding a keyframe. Once the channel is animated, the menu item is automatically renamed to Disable Animation. Activating it at that point hides the keyframes you have set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation restores the channel to its last keyframed state.
- Reset Parameter: Removes all keyframes and settings for this parameter. The parameter value is restored to its default value.
- Add Keyframe: Adds a keyframe at the current frame. If your playhead is positioned on a frame where a keyframe has already been added, this menu item is dimmed.
- Delete Keyframe: Deletes the current keyframe. The Delete keyframe command is only available if the playhead is positioned on a frame where a keyframe already exists.
- Previous Keyframe: Moves the playhead to the previous keyframe for this parameter. The Previous Keyframe command is only available if a keyframe exists earlier in the project.
- Next Keyframe: Moves the playhead to the next keyframe for this parameter. The Next Keyframe command is only available if a keyframe exists later in the project.
- Interpolation: Sets the type of curve for the parameter. See the table in the section called “Modifying Curves” on page 437, for examples of the different interpolation methods.
- Before First Keyframe: Defines what happens between the first keyframe and the beginning of the clip. See “Extrapolation” on page 441 for examples of the different extrapolation methods.
- After Last Keyframe: Defines what happens between the last keyframe and the end of the clip.
- Lock/Unlock Parameter: Locks the parameter to prevent changes. When a parameter is locked, neither keyframes nor curves are adjustable.
- Reduce Keyframes: Applies a “thinning” algorithm to the keyframes for the selected parameter. This reduces the number of keyframes in a parameter while attempting to maintain a similar curve shape.
Animation Menu States
Depending on the current condition of the parameter, the Animation menu displays a different icon. The following table shows the Animation menu icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>No Keyframes</td>
<td>The parameter has no associated keyframes.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Keyframing Active</td>
<td>Keyframing is active on this parameter but the playhead is not currently positioned on a keyframe.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Current Keyframe</td>
<td>The playhead is currently positioned on a keyframe for this parameter.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Behavior Applied</td>
<td>This parameter is being controlled by a behavior, as opposed to a keyframe.</td>
</tr>
</tbody>
</table>

The Keyframe Graph
The remainder of the window contains the keyframe graph. This area contains all of the curves and keyframes for the selected parameters. Each parameter is represented in its own color. Keyframes appear as diamonds and curves appear as solid lines. Areas before the first keyframe and after the last keyframe are represented by dotted lines. Selected parameters appear in white.

You can manipulate keyframes directly by dragging them in the graph. Moving keyframes left and right changes their position in time, while dragging them up and down changes their values. You can also double-click a keyframe, type a value into the Value field, and then press Return to change its value. For more information on manipulating keyframes and curves in the graph, see “Modifying Keyframes” on page 433, and “Modifying Curves” on page 437.
The Ruler
At the top of the keyframe graph is a ruler which provides a gauge for the positions and durations of the keyframes and curves. The ruler is identical to the one in the Timeline. For more information on working with the ruler, see “The Timeline Ruler” on page 74.

Zooming in the Keyframe Editor
As you get familiar with using the Keyframe Editor, you may want to switch between focusing on an individual keyframe or curve and seeing the overview of your whole project. Fortunately, you can quickly zoom in and out on the Keyframe Editor using a variety of different tools.

The bottom of the Keyframe Editor contains a Zoom slider and a Zoom/Scroll control.

To zoom the Keyframe Editor using the Zoom slider:
- Click the thumb of the Zoom slider and drag left to zoom in or right to zoom out. The Keyframe Editor updates as you drag.

To zoom the Keyframe Editor using the Zoom/Scroll control:
- Drag the edge of the scroll bar thumb away from the center to zoom out and toward the center to zoom in. The Keyframe Editor updates as you drag.

You can also automatically zoom the Keyframe Editor to include the entire duration of your project or just the play range as defined by the Play Range indicators (In and Out points).

To zoom the Keyframe Editor to fit the entire project, do one of the following:
- Choose View > Zoom Time View > To Project.
- Control-click the ruler, then choose Zoom to Project from the shortcut menu.

To zoom the Keyframe Editor to fit the play range, do one of the following:
- Choose View > Zoom Time View > To Play Range.
- Control-click the ruler, then choose Zoom to Play Range from the shortcut menu.
Control Buttons
In the lower-left corner of the Keyframe Editor, four buttons provide additional control over the Keyframe Editor window: Snapping, “Show audio waveform,” “Fit curves,” and “Clear curve list.”

Snapping: When snapping is enabled, keyframes snap to other keyframes, markers, grid points, and other snappable items.

Show audio waveform: Turns on the display of audio waveforms for the selected object.

Fit curves: Automatically scales the graph vertically and in time to include all visible keyframes and curves.

Clear curve list: Empties the parameter list. This control is only active for custom curve sets.

Auto scale: Use the Auto scale mode to continuously stretch the graph vertically to fit all of the curves in view.

To turn on automatic scaling:
• Click the Auto scale button just below the right edge of the ruler.
The Audio Editor
The Audio Editor provides a view of your audio elements over time. You can view and modify the level and pan information for the audio files in your project. You can also view the audio waveforms of your objects. In many ways, the Audio Editor is simply a specialized Keyframe Editor just for audio. For more on using the Audio Editor, see “Working With Audio” on page 877.

To display the Audio Editor, do one of the following:
- Choose Window > Audio Editor.
- Press Command+9.
- If the Timing pane is already visible, click the Audio Editor tab at the top of the pane.

Audio Editor Controls
The left side of the Audio Editor contains four rows of controls for the audio object currently in view. The top row controls playback, the second row controls the In and Out points of audio clips, the third row controls the selected object’s level, and the fourth row controls its pan settings.
Playback Controls
The playback controls in the Audio Editor do not control playback in the Canvas. This allows you to listen to the audio component of your project without being distracted by (or slowed down by) the visual component.

Jump to start: Moves the playhead to the beginning of the audio clip or to the beginning of the marked region (if the Use Marked Region button is on).

Play/Pause: Starts and stops playback in the Audio Editor.

Use marked region: Restricts playback to the play range for the selected audio file.

Current Frame: Indicates the current playhead position in the Audio Editor. You can also use this field to change the current frame.

To change the playhead position, do one of the following:
- Drag the center of the Current Frame field. Dragging to the right advances and dragging to the left rewinds.
- Click the increment or decrement arrows at the side of the Current Frame field to move forward or backward by one frame.
- Click the Current Frame field, then type a new number into the value field.

Play Range Controls
The second row provides two controls to set the In and Out points for the audio file. Changing a file’s In or Out point in the Audio Editor is reflected in the Timeline as well.

To change the object start time, do one of the following:
- Drag the center of the In control. Dragging to the right advances, and dragging to the left rewinds.
- Click the increment or decrement arrows at the side of the In control to move forward or backward by one frame.
- Click the In field and type a new number into the value field.
To change the object end time, do one of the following:

- Drag the center of the Out control. Dragging to the right advances, and dragging to the left rewinds.
- Click the increment or decrement arrows at the side of the Out control to move forward or backward by one frame.
- Click the Out field and type a new number into the value field.

**Level Control**
The third row contains controls to adjust and keyframe the selected file’s level.

**Activation checkbox:** This checkbox at the left of the row turns the level curve on and off. It does not disable existing level settings or prevent you from making new settings.

**Level slider:** Controls the level (volume) of the object. If the playhead is currently positioned on a keyframe, the slider controls the level of that keyframe. If the playhead is not on a keyframe, the slider adjusts the entire curve.

**Level value field:** Indicates the level value at the playhead position. You can modify the value by adjusting this control instead of using the slider for more precise values.

**Animation menu:** Appears to the right of the value field and is similar to the one found in the Keyframe Editor. The menu is represented by different icons depending on the current state of the parameter. For a table describing the different icons, see “Animation Menu States” on page 79. The commands within the Animation menu are listed below:

- **Enable/Disable Animation:** Turns keyframing on and off for this parameter. Once keyframes are added, choosing Disable Animation does not delete the keyframes, it just globally hides their effect.
- **Reset Parameter:** Removes any keyframes and restores the parameter to its default value.
- **Add Keyframe:** Adds a new keyframe at the current playhead position.
- **Delete Keyframe:** Deletes a keyframe at the current playhead position, if one exists.
- **Previous Keyframe:** Moves the playhead to the first keyframe to the left of the current playhead position.
- **Next Keyframe:** Moves the playhead to the first keyframe to the right of the current playhead position.
- **Show in Keyframe Editor:** Displays the audio parameters in the Keyframe Editor and brings that tab to the front.
The Pan Control
The fourth row contains controls to adjust and animate the selected file’s pan setting (left-right balance).

Activation checkbox: Turns the keyframe graph on and off. It does not disable existing pan settings or prevent you from making new settings.

Pan slider: Controls the left-right balance of the object. If the playhead is currently positioned on a keyframe, the slider controls the pan setting of that keyframe. If the playhead is not on a keyframe, the slider adjusts the entire pan curve.

Pan value field: Displays the pan value at the playhead position. Negative numbers move panning to the left, while positive numbers move panning to the right. When the value is zero, the balance is split evenly between left and right. You can modify the value by adjusting this control instead of using the slider for more precise control.

Animation menu: Appears to the right of the value field and is similar to the menu found in the Keyframe Editor. The menu is represented by different icons depending on the current state of the parameter. For a chart describing the different options, see “Animation Menu States” on page 79.

Level Meters
Audio level meters appear to the right side of the Audio Editor controls. There are two vertical bars that show the level at the current playhead position. The left bar shows the levels for the left audio channel and the right bar shows the levels for the right audio channel. As you play, the meters change to indicate the changing audio level.

Peak indicators appear at the top of the meters. These small lights illuminate red when the volume exceeds acceptable levels (called peaking). They remain red for a short time after the peak occurs.
The Audio Editor Keyframe Graph
The remainder of the window contains the keyframe graph. This area contains the curves and keyframes for the level and pan of the selected object. Keyframes appear as diamonds, and curves appear as solid lines. Areas before the first keyframe and after the last keyframe are represented with dotted lines. The waveform of the selected object is displayed behind the curves.

At the top of the graph a green bar shows the duration of the audio file. As you change the file’s In and Out points, the bar shrinks or expands to show the new duration.

You can manipulate keyframes by dragging them in the graph. Moving them left and right changes their position in time, while dragging them up and down changes their value. Since audio keyframes work exactly the same as keyframes for other parameters, you can learn more about working with audio keyframes in “Adding and Editing Keyframes” on page 895.

The Ruler
At the top of the Audio Editor graph is a ruler that provides a gauge for the positions and durations of the level and pan keyframes and curves. The ruler in the Audio Editor shows different time than the rulers in the Timeline and Keyframe Editor. This ruler shows the time for the selected audio object rather than for the whole project.

The ruler can contain indicators to help mark important frames or sections of the project such as the playhead, play range indicators (also called In and Out points), and markers. The ruler can be viewed in either frames or timecode.

To change the ruler view format:
- Control-click the ruler, then choose Display Frames or Display Timecode from the shortcut menu.
Markers can be added to your project to identify an important frame or range of frames. For more information on creating and using markers, see “Adding Markers” on page 312.

**Note:** The playhead in the Audio Editor is not the same as the playhead in the Timeline and the Canvas. The Audio Editor playhead shows the position within the selected object rather than the position within the entire project.

**Zooming in the Audio Editor**
You may want to zoom in or out in the Audio Editor just as you do with the Timeline or Keyframe Editor.

The bottom of the Audio Editor contains a Zoom slider and a Zoom/Scroll control.

**To zoom the Audio Editor using the Zoom slider:**
- Click the thumb of the Zoom slider and drag left to zoom in and right to zoom out. The Audio Editor updates as you drag.

**To zoom the Audio Editor using the Zoom/Scroll control:**
- Click the edge of the scroll bar thumb and drag it away from the center to zoom out and toward the center to zoom in.

The Audio Editor updates as you drag.

**Audio Scrubbing**
You can choose whether or not you want to hear the audio play when you drag the playhead through the ruler in the Audio Editor. This is called *audio scrubbing*. To turn audio scrubbing on or off, click the control in the lower-left corner of the Audio Editor.

**The Utility Window**
The Utility window is where you locate and organize the media, effects, and parameters that go along with your project. This includes sorting through the media on your disk, browsing all of the effects, presets, templates, and other content that is created within the application, and viewing and manipulating all of the parameters that control how your objects and effects behave.

The Utility Window has three tabs: The File Browser, the Library, and the Inspector. In the default window layout, all three of these tabs reside in a Utility window on the left side of the Canvas. If you choose the Cinema layout, two Utility windows are displayed, one to the left of the Canvas, containing the File Browser and Library, and one on the right side of the Canvas, containing the Inspector.
The File Browser
The File Browser is a view of all of the files on your computer. Navigating the File Browser is similar to navigating a window in the Finder. You can drag items directly from the File Browser into your project.

The Preview Area
The top area of the File Browser contains a preview of the selected object. The Preview area contains both a visual preview, complete with a Play button to show the multiple frames of moving footage, and text information about the object such as the filename, media type, file size, and frame rate.

Note: Audio files contain a text description but no image preview.

To play a preview of a file on disk:
1. Select the file in the File Browser.
2. The preview starts playing.

Note: If you do not want items to play automatically in the Preview area when you click them (in the File Browser or Library), you can turn off the “Play items automatically on a single click” checkbox in the General pane of Motion Preferences.

To import an object displayed in the preview area:
1. Select the file in the File Browser.
2. Click the Import button in the Preview area.

The file is added to the Layers tab, Timeline, and Media tab in your project.

Note: For a larger preview, you can double-click any file listed in the File Browser. This opens the Viewer window where you can preview the object at its native size.
The Sidebar
The middle section of the File Browser contains navigational controls as well as a list of servers, drives, and folders available on your computer.

Clicking a drive or folder in the Sidebar displays its contents in the file stack below. Above the list of drive and folder icons in the Sidebar are several controls to navigate and sort the contents of the window.

Forward and Back buttons: Step backward and forward through the folders most recently viewed. This works similarly to the Forward and Back buttons in the Finder.

Path: Displays the file system hierarchy (folders inside of folders) for the currently viewed folder.

Icon View and List View buttons: Controls the view of the file stack. Click the left button to set the display to icon view. Click the right button to set the view to list view.

Search: Filters the contents of the file stack to include only objects whose names contain the text you type into the Search field.

Note: Folders are not filtered out.

To clear the Search field:
- Click the Clear button in the body of the search field.

The File Stack
The bottom section of the File Browser shows the contents of the folder selected in the Sidebar or the contents of a subfolder.
You can **Control**-click an object in the File Browser stack to display a shortcut menu. For most items, the following options are available in the menu:

**Open in Viewer**: This option opens the file in a Viewer window.

**Open in QuickTime Player**: This option opens the file in a QuickTime window.

**Reveal in Finder**: This option displays the location of the file in the Finder.

**Rename**: This option turns the name of the file into an active text field so you can rename the file.

**Move to Trash**: This option moves the object into the Trash.

To view the contents of a folder displayed in the file stack, do one of the following:

- Double-click the folder.
- Select the folder, then press **Return**.

The contents of the folder replace the current file stack view.

To return to a previously viewed folder, do one of the following:

- Click the Back button directly beneath the Preview area.
- Choose a new folder from the Path pop-up menu directly beneath the Preview area.
- Press **Command**+Up Arrow.

To rename a folder or file, do one of the following:

- **Control**-click the file or folder, then choose Rename from the shortcut menu. When the text field becomes active, type the new name, then press **Return**.
- In the stack, click the name of the folder or file once to select it, then click it again to activate the text field. Type the new name, then press **Return**.

**Warning**: Renaming folders or files from within the File Browser renames the item on your hard disk or network. If projects are using files from the originally named folder, Motion may list the footage as missing.

To delete a folder or file, do one of the following:

- In the stack, **Control**-click the file, then choose Move to Trash from the shortcut menu.
- Drag the file from the stack to the Trash icon in the Dock.

**Warning**: Deleting folders or files from within the Motion File Browser removes the files from your hard drive or network and places the files in your Trash.
Organizing Your Files
You can organize the files and folders displayed in the File Browser just as you manipulate files in the Finder. You can move objects in and out of folders and create new folders. All of the changes you make to your file structure from within Motion are reflected in the Finder.

To create a new folder:
- Click the “Create new folder” button at the bottom of the window.

To move a file into a folder:
- Drag the file onto the folder icon.
  The object is moved inside that folder.

Icon View and List View
The file stack can be displayed in icon view or list view. Each view is useful for different situations. There are certain options that only affect the icon view (such as icon size) and certain options that only affect list view (such as sorting by columns).

To view the File Browser in icon view:
- Click the Icon View button near the Path pop-up menu above the Sidebar.

To view the File Browser in list view:
- Click the List View button near the Path pop-up menu above the Sidebar.
In icon view, you can control the size of the icons using the Size slider at the bottom of the window.

To change the icon size:
- Drag the icon size slider. Dragging to the right enlarges the icons while dragging to the left shrinks them.

In list view, the contents of the selected folder are displayed as a series of columns. The columns are Name, Date, Size, Duration, and Kind.

You may need to expand the width of the Utility window to see all of the columns.

**Sorting Columns**
You can sort the list by any of the columns. This can be helpful if you are looking for a particular file and you know the approximate size or modification date.

To sort the File Browser list:
- Click the header for the column by which you want to sort.
  The column header darkens and the contents of the window are sorted by that column.

**Collapsing Animations**
Frequently, animated sequences may be delivered as a series of sequentially numbered still images. Motion can save you time by allowing you to import these sequences as a single object where each image becomes a sequential frame in a movie.
To import a series of numbered still images as a single object:

1. Click the “Show collapsed image sequences” button.
   This changes the view in the File Browser to see the multiple items collapsed into a single object.

2. Drag the object from the File Browser to the Canvas, Layers tab, Timeline, or Media tab.
   
   Note: Images from digital cameras are often numbered sequentially but are not part of an animation sequence. You may want to turn off this option to import a single still image from a digital camera.

The Library
The second tab in the Utility window is called the Library. This is similar to the File Browser but rather than showing the files on your disk, it shows all of the effects, content, generators, and fonts available from within Motion.

The contents of the Library can be expanded by adding certain plug-ins, fonts, and files such as gradient or particle presets that become available from Apple or from third-party vendors in the future. You can also expand the Library by saving versions of existing effects.

The Library is divided into three sections. The top section is the Preview area, the middle section is the Sidebar, and the bottom section is the file stack where the actual effects and other objects are displayed.

The Library Preview
The Preview area contains a visual preview, which has a Play button to show the multiple frames of moving footage, previews of filters, behaviors, generators, particle emitters, and so on. The Preview area also contains text information for the selected object, such as a description of the behavior, filter, or generator. The Library preview is almost identical to the File Browser preview, but instead of an Import button, it has an Apply button.

Note: When certain particle emitters are selected in the stack, an animated preview of the selected particle emitter plays in the Preview area. While it is playing, you can drag the pointer around in the Preview area to see how the particle looks while in motion.
To play a preview of an effect such as a generator:
- Click the object you want to preview.
  The preview starts playing.

To apply an effect:
1 Select the object to which you want to apply the effect.
2 Select the effect in the Library.
3 Click the Apply button in the Preview area.
  The effect is added to the object.
  You can also drag the effect from the Library directly to the object.

The Sidebar
The middle section of the Library contains navigational controls as well as a list of folders of effect types available in Motion.

Clicking a folder in the Sidebar displays its contents in the file stack below. Above the list of drive and folder icons in the Sidebar are several controls to navigate and sort the contents of the window.

Forward and Back buttons: Step backward and forward through the folders most recently viewed. These work similarly to the Forward and Back buttons in a web browser.

Path: Displays the file system hierarchy (folders inside of folders) for the currently viewed folder.

View as icons/View as list: Controls the view of the file stack. Click the left button to set the display to icon view. Click the right button to set the view to list view.
Search: Filters the contents of the file stack to include only those objects whose names contain the text you type into the Search field.

Note: Folders containing no matches are filtered out.

To clear the Search field:
- Click the Clear button in the body of the Search field.

Library Content
The Library contains all of the effects, presets, fonts, and other content available within Motion. These are grouped into categories which are listed on the left of the Sidebar. Choose any of these items to display a list of subcategories on the right. The Library also contains two additional categories—Music and Photos—which provide quick access to your iTunes and iPhoto libraries.

Behaviors: Contains Basic Motion, Parameter, Particles, Replicators, Simulation, Text Animation, and Text Sequence behaviors. Different kinds of behaviors can only be applied to specific types of objects. For example, Text Animation and Text Sequence behaviors can only be applied to text objects. For more on how to apply behaviors, see “Applying and Removing Behaviors” on page 321.

Filters: Contains all of the built-in filter effects divided into individual subcategories. Most filters can be applied to any object in your project.

3rd Party Filters: Contains all of the filters that work within Motion but are manufactured by third-party vendors.

Generators: Contains a selection of checkerboards, noise patterns, and other computer-generated elements for use in your projects. Generators are added to a project like other objects.

Particle Emitters: Contains a selection of preset particle systems organized into subcategories. Particle presets are added to a project like other objects.

Replicators: Contains a selection of preset replicators organized into subcategories. Replicator presets are added to a project like other objects.

Shapes: Contains a collection of preset shape objects.

Gradients: Contains a selection of preset gradients. These can be applied to any object where the fill or outline can contain a gradient.

Fonts: Contains all of the fonts available on your system. It includes both TrueType and Type 1 fonts. These can be applied only to text objects. For more information on changing fonts in this browser, see “Changing Fonts” on page 466.

LiveFonts: Contains all of the LiveFonts currently installed on your computer. These can be applied only to text objects.
Text Styles: Contains a collection of preset type styles that can be applied to text objects.

Music: This Library category allows you to browse for and import audio files directly from your iTunes library. The Music subcategories include the library and any playlists created in iTunes. The contents of each playlist appear in the file stack. When displayed in list view, the Music category shows the Name, Artist, Album, Duration, and Size information created in iTunes.

Note: Rights-protected AAC files cannot be imported into Motion and do not appear in the file stack. This includes all music purchased from the iTunes store.

Photos: This Library category allows you to browse for and import image files directly from your iPhoto library. The Photos subcategories include the library and any albums created in iPhoto. The contents of each album appear in the file stack.

Note: When importing large-scale images into Motion, you have the option to import the files as is, to scale the images to the size of the Canvas, or to change the resolution of the images to fit the Canvas. For more information, see “Using High Resolution Still Images” on page 165.

Content: Contains individual elements used in the templates and other presets.

Favorites: As you make custom versions of any type of effect, you can store them in the Favorites folder. You can also add shortcuts to frequently used items. By default, this folder is empty.

Favorites Menu: This is another category of favorites. Items stored in this folder appear in the Favorites menu in the menu bar.

The File Stack
The bottom section of the Library shows the contents of the folder selected in the Sidebar, or the contents of a subfolder.

To view the contents of a folder displayed in the file stack, do one of the following:

- Double-click the folder.
- Select the folder, then press Return.

The contents of the folder replace the current file stack view.

To return to a previously viewed folder, do one of the following:

- Click the Back button directly beneath the Preview area.
- Choose a new folder from the Path pop-up menu directly beneath the Preview area.
- Press Command+Up Arrow.
Organizing Your Effects
You can organize the effects and folders displayed in the Library just as you manipulate files in the Finder. You can move objects in and out of folders, create new folders, and even delete some files or folders.

Note: You cannot modify the objects and folders that are built in to Motion.

To create a new folder:
• Click the “Create new folder” button at the bottom of the window.

Icon View and List View
The file stack can be displayed in icon view or list view.

To view the Library in icon view:
• Click the Icon View button near the Path pop-up menu above the Sidebar.

To view the Library in list view:
• Click the List View button near the Path pop-up menu above the Sidebar.

In icon view, you can control the size of the icons using the Size slider at the bottom of the window.

To change the icon size:
• Drag the icon size slider. Dragging to the right enlarges the icons, while dragging to the left shrinks them.
The Inspector
Every effect in Motion, from behaviors to particle systems to gradients, is controlled by a collection of parameters that modify the various attributes for that effect. For example, a Blur filter has an amount slider that controls how much blur is applied.

Some parameters are controlled with sliders, some with dials or pop-up menus. In fact, there are thousands of parameters using 11 types of controls. All of them are accessed in the Inspector.

Even objects without applied effects have many parameters that you can modify to alter the nature of the object and how it appears in your project. These include the object’s scale, opacity, and position onscreen, as well as more obscure attributes such as its pixel aspect ratio or field order.

The Inspector contains four tabs, each of which contains a set of parameters for the selected object. The first three tabs, Properties, Behaviors, and Filters, are present for any selected object. The fourth tab, generically called the Object tab, changes its name and contents depending on the type of object selected.

Types of Controls
There are 11 different types of controls that may appear in the Inspector. Each one provides you the opportunity to change the value of a parameter in a special way. Since different types of objects and effects require different parameters, varied sets of controls to appear in the Inspector depending on what is selected. The following table describes the various types of controls and how to use them.
<table>
<thead>
<tr>
<th>Control</th>
<th>Control type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slider</td>
<td>Slider</td>
<td>Perhaps the most basic type of control, dragging the thumb of a slider changes the value of the parameter. Typically, dragging to the right increases the value and dragging to the left decreases the value. An example of a parameter that uses a slider is Scale. You can Option-click to the left or right of the slider marker to decrease or increase by a value of 1.</td>
</tr>
<tr>
<td>Value slider</td>
<td>Value slider</td>
<td>A special type of slider that includes the numerical value of the parameter in the control. Dragging the middle area (where the number is) works just like an ordinary slider; dragging to the right increases the value and dragging to the left decreases the value. Some parameters allow you to increase or decrease the value indefinitely. Additionally, you can click the increment or decrement arrow to change the value one step at a time. You can double-click the number itself to convert the slider into a value field so you can type a specific number directly into the control. An example of a parameter that uses a value slider is Position. Note: When a value slider or value field is active (highlighted), press Tab to move to the next field.</td>
</tr>
<tr>
<td>Dial</td>
<td>Dial</td>
<td>This control is used for values based on angles or degrees. Rotate the dial by dragging it in a clockwise or counter-clockwise motion. A parameter that uses a dial is Rotation.</td>
</tr>
<tr>
<td>Value field</td>
<td>Value field</td>
<td>This control allows direct entry of text to set the value of the parameter. An example of a parameter that uses a value field is the Text Entry field.</td>
</tr>
<tr>
<td>Pop-up menu</td>
<td>Pop-up menu</td>
<td>A menu with preset values. Click the menu and choose the value you want. An example of a pop-up menu is Throw Increment.</td>
</tr>
<tr>
<td>Value list</td>
<td>Value list</td>
<td>Another type of pop-up menu. You can click the arrow to the right of the field to display preset values or you can type a value directly into the value field. An example of a value list is Typeface.</td>
</tr>
<tr>
<td>Activation checkbox</td>
<td>Activation checkbox</td>
<td>An on/off toggle for a parameter. An example of an Activation checkbox is Preserve Opacity.</td>
</tr>
</tbody>
</table>
In addition to the common parameter control types listed above, there are several other controls that are widely used within the Inspector tab.

**Reset button:** Automatically restores the parameter value (or in some cases, an entire set of parameters) back to its default value.
Library Presets: Some parameter settings such as Gradients and Type Styles are so complex that they are commonly stored in presets. Whenever you see the Style Preset pop-up menu, you can save that particular parameter (or set of parameters) into a preset in the Library.

![Style Preset pop-up menu](image)

For example, the Text Style pane has a Style Preset pop-up menu at the top of the parameter list that allows you to save styles, formats, or both. This allows you to save all of the settings in the window. In some cases, you can also use this menu to load an existing preset.

To save a preset:
1. Set the parameter values to the settings that you want to save.
2. Choose Save from the Style Preset pop-up menu.
   A dialog appears.
3. Type a name for the preset you want to save, then click Save.

   The preset is now stored in the Library in the appropriate category. It appears when you click the Style Preset pop-up menu in this and future projects until you manually delete it in the Finder.

To load an existing preset:
- Choose the preset you want from the Style Preset pop-up menu.

   The current parameter settings are replaced by the settings in the preset.

Animation menu: Most parameters can be animated. This means that you can assign specific values to certain frames (keyframes) so the parameter value changes over time. Any parameter that can be animated has an Animation menu to the right of the parameter settings.

![Animation menu](image)

Depending on the current condition of the parameter, the Animation menu displays a different icon. For a table indicating the possible states, see “Animation Menu States” on page 79.
Click the Animation menu to display a pop-up menu filled with animation controls.

Enable/Disable Animation: Remains unavailable until keyframing is applied to the parameter, either by using the Record button or by adding a keyframe. Once the parameter is animated, the menu item is automatically renamed Disable Animation. Activating it at that point effectively hides the keyframes you have set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation restores the channel to its last keyframed state.

Reset Parameter: Removes all keyframes and settings for this parameter. The parameter value is reset to its default value.

Add Keyframe: Adds a keyframe at the current frame. If the playhead is positioned on a frame where a keyframe has already been added, this menu item is dimmed.

Note: You can use a keyboard shortcut to quickly add a keyframe by pressing Control+K. A keyframe is automatically added to the last modified parameter of the object.

Delete Keyframe: Deletes the current keyframe. The Delete Keyframe command is only available if the playhead is positioned on a frame where a keyframe already exists.

Previous Keyframe: Moves the playhead to the previous keyframe for this parameter. The Previous Keyframe command is only available if a keyframe exists earlier in the project.

Next Keyframe: Moves the playhead to the next keyframe for this parameter. The Next Keyframe command is only available if a keyframe exists later in the project.

Show In Keyframe Editor: Opens the Keyframe Editor if it is not displayed and displays the graph for the parameter you are modifying.
Inspector Tabs
The parameters in the Inspector are grouped into four categories.

Properties: This tab contains basic attributes about the selected object, such as Transformation (position, scale, rotation, and so on), Blending (opacity, blend mode, and so on), Drop Shadow controls, Crop Controls, and the object's In and Out points.

Behaviors: Whenever a behavior is applied to an object, the parameters associated with that behavior appear in the Behaviors tab. Multiple behaviors are grouped by the behavior name.

Filters: Whenever a filter is applied to an object, the parameters associated with that filter appear in the Filters tab. Multiple filters are grouped by the filter name.

Object: The Object tab changes its contents and title depending on what type of object is selected. The different types of objects are described below:

- Layer: Appears when a layer is the selected object. The tab contains the Fixed Resolution parameters, which allow you to manually define the size of a layer. By default, Fixed Resolution is disabled and the size of the layer is determined by the objects within that layer. For more information, see “Fixing the Size of a Layer” on page 204.

  Note: When enabled, the Fixed Resolution parameter crops the layer to the size specified in the Fixed Width and Fixed Height parameters around the anchor point of the layer.

- Media: Appears when an object is selected in the Media tab. These parameters deal mostly with attributes of the file on disk or how the file is interpreted by Motion. Because multiple objects can point to a single media file, the Inspector Media tab contains a list of linked objects including the name of the layer where they exist. Making changes in this tab affects all objects that refer to the selected media file. For more information on working with media parameters, see “Object Media Tab Parameters” on page 185.

- Text: Appears when a text object is selected and contains all of the controls that affect the text object. It is divided into three panes: Format, Style, and Layout.

  - Format: Contains standard type controls such as font, size, tracking, kerning, and so on. It also contains a large text entry box called the Text Editor where you can edit the actual contents of the text.

  - Style: Controls the color, texture, and similar attributes for the typeface, outline, glow, and drop shadow. Each of these sections is grouped and can be turned on or off by clicking the activation checkbox next to the category name.

  - Layout: Contains paragraph style controls such as justification, alignment, and line spacing (leading). This pane also contains controls to create a type-on effect or to modify text path options. For more information on working with text parameters, see “Using Text” on page 453.
• **Mask**: Appears when a mask object is selected. The only keyframeable attribute is the Feather (softness) parameter, but you can also control the mask type and how multiple masks interact by setting the Mask Blend Mode. For more on working with mask attributes, see “Mask Parameters” on page 854.

• **Shape**: Appears when a shape object is selected. Controls include the shape type, fill and outline colors, and textures. For more on working with shape attributes, see “Using Shapes and Masks” on page 819.

• **Emitter**: Appears when a particle emitter is selected. It controls all aspects of the emitter such as the emitter shape, angle, and range. It also provides access to cell controls. For emitters with multiple cells, these controls affect all cells. For more information on using particles, see “Working With Particles” on page 565.

• **Particle Cell**: Appears when a particle cell object is selected. Particle cell objects can only be selected in the Layers tab or Timeline Layer list. This tab contains attributes such as birth rate, speed, angle, and color.

• **Replicator**: Appears when a replicator is the selected object. Replicator objects can only be selected in the Layers tab or Timeline Layer list. This tab contains attributes such as replicator shape, pattern, size, and cell controls. For more information on using the Replicator, see “Using the Replicator” on page 621.

• **Generators**: Displays the parameters and attributes of the selected generator (for example, the colors and number of bars in a checkerboard). The specific parameters listed depend on the specific generator that is selected. For more information on generators, see “Working With Generators” on page 795.

**Locking the Inspector**

The Inspector typically changes dynamically based on the selection in the Canvas. However, sometimes you want to select another object while you continue looking at the parameters for the current object. When you lock the Inspector, it does not change based on your selection.

To lock the Inspector, do one of the following:

- Click the Lock icon in the upper-right corner of the Preview area of the Inspector.

- Choose Window > Create Locked Inspector.

This creates a new Inspector window showing the parameters of the currently selected object. The main Inspector window continually updates to reflect whatever object is selected.
The Dashboard

The Dashboard is one of the most versatile and handy tools in the Motion interface. It is a dynamically updating floating window that puts the most common controls for any selected object within easy reach.

The Dashboard also contains special controls for certain types of effects such as Basic Motion behaviors and particle systems. These unique controls allow you to set multiple parameters simultaneously and in an intuitive way.

For example, the Particle Emitter Dashboard contains a single control that lets you set the shape, angle, and range of the particle system simultaneously. You can read more about specific Dashboard controls in the chapters for the corresponding effects.

Note: It is easier to enter a specific value for a slider parameter in the Inspector’s value fields. Also, you can Option-click to the left or right of the Inspector’s slider to decrease or increase by a value of 1. Option-clicking the value slider increases or decreases by .01.
Choosing Control Sets

The Dashboard can show a variety of controls, even for a single object. For example, if you had a shape with an applied blur filter and a Throw behavior, the Dashboard could conceivably show either the shape controls, the blur controls, or the Throw controls. In fact, it shows all three. You can choose between which set of controls to view in the Dashboard using the pop-up menu in the title bar. Also, pressing D cycles through all control sets for the selected object.

When an object with multiple effects is selected, the Dashboard title bar displays a downward-facing arrow to the right of the name. Clicking the arrow displays a pop-up menu that lists all of the possible Dashboards that can be displayed for the selected object.

To switch between Dashboards on a selected item, do one of the following:

- Click the downward arrow in the Dashboard title bar, then choose the Dashboard you want to view from the pop-up menu.
- Press D to cycle through all Dashboards for the selected object.

Most of the time, the Dashboard displays a subset of the parameters visible in the Inspector for the selected object. If you are working in the Dashboard, you can quickly jump to the corresponding Inspector to access the remainder of the controls for that object.

Chapter 1  Getting To Know Motion
To jump to the Inspector from the Dashboard:

- Click the Inspector icon (‘i’) in the upper-right corner of the Dashboard.

The Inspector appears and the tab corresponding to the Dashboard controls is brought to the front.

Preferences

Motion Preferences allow you to customize your workspace, tailor the interface for different types of projects, and define the presets for new projects and for exporting finished movies. There are seven different sets of controls that group the various settings into categories.

General

The General Preferences pane contains settings that apply globally to all aspects of Motion.

Startup

Choose the first thing Motion does when opened. Choose an item from the pop-up menu.
**Open Last Project(s):** Any projects that were open when the program was last quit are reopened. This allows a continuity of work across sessions.

**Create New Project:** This command opens a new empty project. If a default preset has not been chosen, the Preset selection dialog appears.

**Show Welcome Screen:** This is the default setting. Upon startup, you are presented with four options: To see a Quick Tour of the application, open the Template Browser, Start with a New Project, or Begin with a Tutorial.

**Browse Templates:** This option takes you directly to the Template Browser. For more information on working with templates, see “Creating New Projects From Templates” on page 141.

**Interface**
This section allows you to set some general options for the interface.

**Drop Menu Delay:** This setting determines how long you must wait before the drop menu appears when dragging to the Timeline, mini-Timeline, Layers tab, or Canvas. The drop menu provides additional choices for editing and importing objects into the project.

**Show Tooltips:** This checkbox turns tooltips on and off across the application. Tooltips provide explanatory information such as names and basic usage techniques. They appear when you pause the pointer over tools and controls.

**File Browser & Library**
These settings affect how the Utility window displays the contents of the File Browser and Library.

**Display Folders:** This setting lets you choose between listing folders alphabetically within the list of objects or grouped together at the end of the list after all non-folder objects.

**Show preview icons:** This checkbox turns preview icons on and off in the Utility window. For example, when turned on, the first frame of a QuickTime movie is displayed. When turned off, the Finder QuickTime icon is displayed.

**Play Items Automatically on Single Click:** This checkbox controls whether the Preview area automatically plays the contents of the item selected in the file stack.

**Memory & Cache**
This setting controls the amount of your computer’s memory you want to allocate to Motion. The larger the percentage, the less memory that is available for other applications.
LiveFonts
These settings determine how LiveFonts are cached (stored) by Motion.

Cache intermediate LiveFont sizes: This checkbox enables or disables caching of LiveFont data. This option is on by default, as it improves performance if you frequently use LiveFonts.

Cache Path: If you choose to cache your LiveFont data, you can choose where you want to save it. Since this cache can grow quite large, it is advised that you set this to a drive other than your primary system drive.

Delete LiveFont Cache: Over time, this cache can grow to take up many gigabytes of disk space. To recover this space, you can delete the cache by clicking this button.

Content Library & Templates
When installing, Motion allows you to install its content library, templates, and tutorial media in a location other than where the application is installed. This setting allows you to point to a folder on your system or network that contains the Motion content library, templates, and tutorial media. This also allows multiple users on a network to share a single, centralized folder.

3rd Party Plug-ins
Motion can read third-party After Effects-compatible plug-ins. This setting allows you to point to a folder where such plug-ins are located on your disk.

Appearance
This pane contains settings that control visual elements of the Motion interface.

Dashboard
The Dashboard is a semi-transparent window that floats above the other windows on your screen. You can set the opacity (transparency) of the window in this section.
**Thumbnail Preview**

The thumbnails that appear in the Utility window can provide helpful information about the objects selected in that window. For objects that are partially transparent, you can set the background that appears behind the image. Choose from either Checkerboard or Color.

**Checkerboard:** This is the default setting. It displays a checkerboard pattern where transparent pixels appear.

**Color:** This setting displays a solid color where transparent pixels appear.

**To change the background color:**

1. Choose Color from the Background pop-up menu.
2. Control-click the color well next to the pop-up menu, then choose a color from the color picker.

The selected color becomes the background color for the thumbnail previews.

**Timeline**

This setting lets you choose how to display the bars that appear in the Timeline to represent your objects. You can choose from Name, Name Plus Thumbnail, and Filmstrip.

**Name:** The object bars in the Timeline display the object name only.

**Name Plus Thumbnail:** This setting is the default. Object bars in the Timeline display an icon representing the first frame of the object followed by the name of the object.

**Filmstrip:** Object bars in the Timeline are displayed as a continuous strip of frames. The name text does not appear. For an example of the different states, see “Changing the Track Display” on page 76.

**Status Bar**

The Status Bar is the area above the Canvas and below the Toolbar. You can choose to display three different types of information in this area: Color, Coordinates, and Frame Rate. You can also choose from three different methods of representing the color data.

**Color:** This setting displays the color value of the pixel currently under the pointer. Colors are displayed in the format chosen in the Display Color As setting.

**Coordinates:** This setting displays the X and Y coordinates of the current pointer position.

**Frame rate:** This setting displays the frame rate of the project during playback. Nothing is displayed unless the project is playing.
Display Color As: Choose among three styles for displaying the color data.

- **RGB**: This setting displays the red, green, and blue values of each pixel in ranges of 0–255.
- **RGB (percent)**: This setting displays the red, green, and blue values of each pixel in ranges of 1–100.
- **HSV**: This setting displays the color as hue, saturation, and value (brightness) where hue is a value from 1–360, and saturation and value are ranged from 1–100.

**Project**
The Project Preferences pane contains settings such as timing, display, and playback options.

**Default Settings**
These controls determine default values for newly created projects. To change these settings for a specific project, modify similar settings in the Project Properties dialog (choose Edit > Project Properties).
**Project Duration**: Sets the default duration for new projects. You can type a number into the value field in either frames or seconds by choosing from the pop-up menu.

**Background Color**: Sets the color and opacity of the background for the project. This color is rendered into the final movie when you output your project. By default, the background color opacity is set to 0 percent.

**To change the background color**:

1. Control-click the color well, then use the Colors window to select a new color. The selected color becomes the background color.

2. Adjust the slider to the right of the color well to change the opacity of the background.

**Time Display**

These settings control how the time counters across the application are displayed.

**Display Time As**: You can make one of two choices:

- **Frames**: Displays all counters as incrementing frame numbers.
- **Timecode**: Displays all counters as eight-digit timecode numbers.

**Frame Numbering**: This lets you choose whether frame counts begin at zero or one.

**Still Images & Objects**

These settings control the default duration, placement, and size of still images and imported objects, as well as objects created in Motion, such as text, shapes, and masks.

**Default Object Duration**: You can specify the duration of still images, generators, and other objects that lack an inherent duration in one of two ways:

- **Use project duration**: All objects are the same duration as the project.
- **Use custom duration**: Objects are the duration you set here.

You can set the time in frames or in seconds.

**Create Objects At**: When you drag objects to the Canvas, the Layers tab, or the Timeline Layer list, they can either be added to the project at the current playhead position or they can be added at the first frame of the project. This setting also applies to objects created within Motion, such as text or shapes.

**Large Stills**: When importing large still images, set this preference to instruct Motion to import the file at its original size, to change the resolution of the image to fit the Canvas size, or to scale the image down to fit the Canvas size.

- **Do Nothing**: Imports the image at its original size.
- **Scale to Canvas size**: Imports and scales the image to fit the project size while maintaining its aspect ratio.
- **Down-Res to Canvas Size**: This setting changes the resolution of the imported image so that the image fits the project size while maintaining its aspect ratio.
Note: For more information on the differences between the Large Still options, see “Using High Resolution Still Images” on page 165.

Playback Control
These settings control how Motion plays back your project.

Time View Updating: When the Timing pane is visible, you can set the view to automatically move along with your project’s playback. Make one of the following choices from the pop-up menu:

- **Don’t update**: The Timing pane does not change as you play (improves performance).
- **Jump by pages**: As the playhead reaches the end of the current view, the window jumps forward. The playhead crosses the screen again, and so on.
- **Scroll continuously**: The playhead remains static and the Timing pane scrolls by behind it.

If Audio Sync is Lost: Motion always attempts to keep audio and video playback locked in sync, but if the project is too complex to play both audio and video smoothly, one or the other must be compromised. You can choose to either Skip video frames or Pause audio playback.

Limit playback speed to project frame rate: Motion plays back your project as fast as possible based on the complexity of the effects and the strength of your computer. When this box is checked, playback rate never exceeds the frame rate of your project. This means you can watch your project play back at the same frame rate as your outputted movie. When the box is unchecked, playback rate is only limited by your processor power and may play much faster than the project frame rate.

Loop audio while scrubbing: When this checkbox is on, the audio for the frames where you drag the playhead repeats. When the checkbox is turned off, the audio for those frames plays only once.

Autosave
These settings control how frequently projects are automatically saved, as well as the location of the saved files. Saved projects are time and date stamped.

**Use Autosave vault**: Instructs Motion to store auto-saved projects to the location specified in the Autosave Vault Folder parameter.

**Save a copy every**: Specifies how often, in minutes, a project is saved.

**Keep at most**: Tells Motion how many versions of the auto-saved project to store in the vault.

**Maximum**: Tells Motion the maximum number of different auto-saved projects to store in the vault.
To store auto-saved projects in a specific location:
1 Choose Motion > Preferences (or press Command+,).
2 Click Project.
3 In the Autosave group, turn on Use Autosave vault.
   By default, the Autosave Vault folder is located in a folder called Motion Documents in your Documents folder in your home directory.

To set a new location for the Autosave vault:
- Click Choose and select a new location in the sheet.

To revert to an auto-saved project:
1 Choose File > Restore From Autosave.

The Restore Project sheet appears.
2 Choose a saved project from the pop-up menu.
Canvas

This pane contains settings to customize your Canvas view.

### Background

This setting allows you to choose a color for the background of your Canvas—the color outside of the project boundaries. This color is not exported with your project, but only acts as a guide for helping identify transparent and colored objects.

To change the background color of the Canvas:
- **Control**-click the Canvas Color well, then choose a color from the pop-up color palette. The selected color becomes the background color for the Canvas.

### Alignment

These settings control the color and display of the optional grid, rulers, and guides that appear in the Canvas. Grids, guides, and rulers can be turned on and off in the View menu at the upper-right corner of the Canvas.

- **Grid Spacing**: This slider sets the width for the grid in pixels.
- **Grid Color**: This color well sets the color of the grid lines.
- **Guide Color**: This color well sets the color of guides.
- **Dynamic Guide Color**: This color well sets the color for Dynamic Guides.
**Ruler Location**: This pop-up menu sets the position of the ruler in the Canvas. Choose from Top Left, Bottom Left, Top Right, or Bottom Right.

**Safe Zone**
Safe Zones are special guides to help you avoid putting objects in areas of the screen that might not appear correctly on consumer television sets. Objects that appear outside the Action Safe region may be cut off. The area outside the Title Safe region may have distortions that make text hard to read. The Safe Zone guides can be turned on or off in the View menu at the upper-right corner of the Canvas.

**Action Safe Region**: Sets the percentage of the Canvas where the Action Safe guide box appears.

**Title Safe Region**: Sets the percentage of the Canvas where the Title Safe guide box appears.

**Safe Zone Color**: Sets the color of the Safe Zone guide boxes.

**Film Zone**
When producing output to be used for both television and film, it may be helpful to see the area of the TV frame that will be cut off when it is converted to film. The Film Zone settings allow you to display a guide that identifies the aspect ratio of the film gauge you are working in. Turn Film Zone guides on and off in the Canvas View menu.

**Aspect Ratio**: This pop-up menu sets the guide size to match one of the standard aspect ratios, or lets you enter a custom value.

- To choose an existing aspect ratio:
  - Choose a setting from the pop-up menu.

- To create a custom aspect ratio:
  - Type a number representing the screen width (based on a height of 1) into the value field to the right of the pop-up menu.

**Film Zone Color**: Sets the color of the Film Zone guide boxes.

**Snapping**
Objects in the Canvas automatically snap to other objects when you drag them around. This setting determines whether the objects snap to objects’ center points, edges, or both centers and edges.
Output
The Output Preferences pane tells Motion to render the contents of the Canvas out to a video deck or monitor connected to your computer via FireWire or another port.

![Output Preferences pane](image)

External Video
These settings control how Motion plays your project directly to a video deck or monitor connected to your computer.

Video Output: Set this pop-up menu to match the type of device connected to the monitor. When this is set to anything other than None, Motion outputs a new frame to the externally connected video monitor every time you release the mouse button (if the Canvas has changed). If no deck or video monitor is connected, the menu is set to None. If you have two computer displays, one can be used to view the Motion interface and the Finder while the other can be used as a dedicated video monitor using a cinema display as an external monitor. The following external video monitoring choices are available:

- **Digital Cinema Desktop Preview**: The video is not scaled unless it is too large to fit on the display. If the video signal is larger than the display, it is scaled to fit on the display.
  - **Pros**: The video always maintains proper aspect ratio and does not exhibit scaling artifacts due to magnification.
  - **Cons**: Some formats, especially SD formats, may look very small when displayed on large computer displays.

- **Digital Cinema Desktop Preview – Full Screen**: The video is scaled to fit the display in at least one dimension. If the aspect ratio of the video signal and the computer display do not match, the video on the display is letterboxed (black on top and bottom) or pillarboxed (black on sides) as necessary.
  - **Pros**: This format gives you the biggest picture possible and maintains the proper aspect ratio.
  - **Cons**: Scaling artifacts may be noticeable when viewed up close.

- **Digital Cinema Desktop Preview – Raw**: This mode shows the video data with as little processing as possible. This can be useful for engineering evaluations of the image. No scaling is done whatsoever.
  - **Pros**: More accurate assessments of video quality can be made.
  - **Cons**: Not useful for general viewing. No scaling or pixel aspect ratio adjustments are made, even when the video is larger than the display.
Note: For example, a 720p frame (1280 x 720) showing in raw mode on an 800 x 600 display only shows 800 x 600 of the image.

To view Motion video output on a computer display connected to your computer:

1. Choose Motion> Preferences.
2. In the Output settings, choose one of the display options from the Video Output pop-up menu.

Options: When a Video Output module is turned on, the Options button becomes active. For monitors connected via FireWire, there is no need to adjust the options. For monitors connected via third-party hardware, the options may have applicable settings.

Update during playback: Plays the project out to the external video monitor while the project plays back in the Canvas. This option severely degrades performance.

Update dynamically on parameter change: Sends a new video frame out to the external video as you adjust parameters (instead of only after releasing the mouse button). This option may severely degrade performance.

Video Output in Motion
If you're creating work that is intended to be viewed on a TV monitor (such as broadcast design or DVD menus), it's imperative that you see your design on such a monitor before finalizing your Motion project. While you can do a great deal of layout and color adjustments on your computer screen, you might be surprised how different things may look when they appear on a TV screen.

First, whether you're working in NTSC (the American and Japanese TV standard) or PAL/SECAM (the European TV standard), colors are going to look quite different from the way they look on your computer monitor. (NTSC has been affectionately referred to as Never Twice the Same Color.)

Furthermore, TV signals are interlaced, meaning that the vertical resolution is cut in half and displayed at twice the rate. This can mean that thin horizontal lines in your design (such as font serifs) may buzz or flicker when played back on a TV screen.

Fortunately, Motion allows you to view the contents of your Canvas directly on a TV monitor that is connected to your computer. You can connect a monitor to your computer using a FireWire device such as a DV camcorder or deck, or by using a third party video capture card. For accurate results, you should use a professional grade monitor with calibration controls.
Presets

The Presets Preferences pane contains presets for both project settings and export settings. In this pane, you can choose defaults, as well as create, modify, and delete settings. The default project preset determines the settings assigned when you create a new project. You can change any of these settings while you are working by opening the Project Properties window (choose Edit > Project Properties).

Show: This pop-up menu sets whether you are looking at and modifying presets for new projects or presets for exporting.

Preset list: Below the Show menu, the current list of presets appears. The checkbox to the left of each name identifies the default preset. Check a different box to select a new preset. The column on the right shows which presets are locked. Locked presets cannot be modified. You can duplicate a locked preset and edit the copy.

Summary box: To the right of the Preset list, the Summary box displays details of the currently selected preset.

Create new documents using default: When this checkbox is turned on, creating a new project automatically uses the default project preset. When this checkbox is unchecked, creating a new project displays the Select Project Preset dialog so you can choose a preset for the new project.

Add New Preset: Click the Add button (+) to display the Project Preset Editor dialog and create a new preset.

Remove Preset: To remove a preset, select the preset you want to remove and click the Delete button (−).

Duplicate: To duplicate a preset, select the preset you want to duplicate, then click Duplicate.
Editing Presets
To make changes to a preset, click the Edit button to open the Project Preset Editor and enter the changes in that window. Locked presets cannot be edited. If you attempt to edit one, a duplicate copy is made and your edits are applied to the duplicate.

To open the Project Preset Editor, do one of the following:
- Double-click an unlocked preset in the Preset list.
- Select an item in the Preset list and click the Edit button.

The Project Preset Editor
When you double-click a project preset, the Project Preset Editor dialog appears. This is where you edit the contents of project presets.

Name:
Contains the name for the preset.

Description:
This field contains descriptive text to identify the preset. This text appears in the Summary box in the Preset Preferences pane.

Width and Height:
These fields set the frame size for the preset.

Pixel Aspect Ratio:
Sets the pixel aspect ratio for the preset. This should match the type of media with which you are working.

Field Order:
Sets the field order for your project. DV projects typically use the Lower First setting.

Frame Rate:
Sets the frame rate for your preset. Click the list arrow to display common rates or type your own custom value.

Note: When you double-click a default preset, an alert sheet appears stating that the selected preset cannot be modified. Click OK to create an editable copy of the preset.
The Export Options Dialog
When you double-click an export preset, the Export Options dialog opens. This is where you edit the contents of the export presets.

Name: This editable field contains the name for the preset.

Description: Contains descriptive text to identify the preset. This text appears in the Summary box in the Preset Preferences pane.

Beneath the Name and Description fields, there are two tabs, Video/Audio and Output. To the right of the tabs, a summary box displays the details of settings from the two tabs.

Video/Audio Tab
The Video/Audio tab contains the following controls:

Kind: Choose from QuickTime Movie, Still Image, or Image Sequence.

Note: Audio options are only available for QuickTime movies.

Compressor: Depending on the Kind setting, different compressor types are available.

Quality: For some compressors, you can set a quality setting. If the control is dimmed, that compressor type does not offer variable quality.

Start number: For image sequences, you can set a starting frame number. Each file generated in the image sequence has an incrementing number.
Add spaces: When generating image sequences, clicking the Add Spaces checkbox causes extra spaces to be added to the filenames to ensure that the sequence of files is read in proper order by some other applications.

Advanced: The Advanced button is only active for QuickTime movies. Clicking this button opens the standard compression settings dialog. In most cases, you should not need to make any changes in this dialog.

Sample rate: Sets the audio sample rate for your exported movie. For best results, set this to be the same sample rate as the source audio in your project.

Advanced: The Advanced button opens the standard Sound Settings dialog. In most cases, you should not need to make any changes in this dialog.

Output Tab
The Output tab contains the following controls:

Use current project and canvas settings: When this is checked, this setting overrides the contents of this dialog with the current settings in your project. This allows one export preset to be used with multiple project presets. When this setting is turned off, you can create specific settings for the export preset.

Resolution: You can specify the output size to be relative to the project’s frame size (Full, Half, Third, or Quarter) or choose Custom and type a specific number into the width and height value fields.

Color: Choose whether the exported items include the color data only, color data plus alpha channel (transparency), or just the alpha channel data.

Note: Some compressor types do not support alpha channels.

Premultiply alpha: When this box is checked, semi-transparent pixels in your output are mixed with the project background color (set in Project Properties).

Use field rendering: When this box is checked, the output always renders individual fields regardless of the setting in the Canvas View menu. When not checked, frames are rendered whole, regardless of the setting in the Canvas View menu.

Use motion blur: When this box is checked, motion blur is applied to moving objects regardless of the setting in the Canvas View menu. When not checked, no motion blur is applied.
Gestures
The Gestures Preferences pane contains settings pertaining to using a tablet to control Motion.

You cannot turn on gestures in Motion unless you have a tablet attached to your computer and the Handwriting Recognition is turned on in the Ink preferences in System Preferences. For convenience, you can open Ink Preferences directly from the Gestures Preferences pane by clicking the Open Ink Preferences button.

For more information on using gestures, see “Using Gestures” on page 961.

Input
These settings control how Motion knows when your pen movements should be interpreted as gestures.

Input Method: Lets you choose between observing the settings in your Mac OS Preferences and your Wacom Preferences or using gestures only when a trigger is enabled.

When you set the input to require a trigger, your pen and tablet act as a mouse until you press one of the buttons on the pen or press a modifier key. This indicates that you are entering a gesture. Releasing the button or key returns the pen to normal mouse state.

Trigger: Sets which trigger method to be used: Pen Button 1, Pen Button 2, or the Control key on your keyboard.

Allow gestures in the air: Lets you trigger gestures without pressing the tip of the pen on the tablet. This option is only available when a trigger is used to activate gestures.
Menus

The Motion menu bar provides access to nearly every control in the application. Many menu items are context sensitive, so they are dimmed when the command cannot be performed based on the current state of the program or what is selected. This section serves as a reference guide for all menus.

Many of these commands have shortcut keys that perform the same command from the keyboard. These shortcuts are listed in parentheses after the description.

The Application Menu

The first menu contains general functions to control the application, modify the preferences, and access the Apple website. It also provides access to system level services.

About Motion: Opens the About Box where you can find the version of Motion you are running, the registration information, and other important credits.

Preferences: Opens Motion Preferences. See “Preferences” on page 107 for detailed description of the settings in that window.

Provide Motion Feedback: Opens a web page where you can send comments to Apple about Motion.

Register Motion: Connects you to the Apple website where you can register your copy of Motion. Registered users receive information about updates, new tutorials, and other useful information.

Services: This is a system menu item that provides access to commands that work across different applications. See Mac OS X Help for more information about this submenu.

Hide Motion: Hides all Motion windows. The application is still running in the background. You can bring it back to the front by clicking the Motion icon in the Dock (Command+H).

Hide Others: Hides windows from all applications other than Motion (Option+Command+H).

Show All: Shows all windows from all applications currently running.

Quit Motion: Stops the application from running. You are prompted to save any open documents (Command+Q).
The File Menu
This menu contains functions and commands that deal with files on your disk that are
associated with Motion.

New: Creates a new Motion document (Command+N).

Open: Opens a dialog from which you can choose a Motion project to open
(Command+O).

Open Template: Displays the Template Browser, from which you can choose one of the
built-in templates that come bundled with Motion (Shift+Command+O).

The Open Recent Submenu
This submenu lists the ten most recently opened files. This allows you quick access to
the projects you have been working on recently. You can clear the list by choosing
Clear Menu from the bottom of the submenu.

Close: Closes the currently selected window. If the Canvas is the currently selected
window, and the project has not been saved, Motion asks you to save the project
before closing the window (Command+W). Press Option+Command+W to close all
windows.

Save: Stores the current state of the selected project to disk (Command+S). Press
Option+Command+S to save all open projects.

Save As: Saves the current state of the selected project with a new name
(Shift+Command+S).

Save As Template: Saves the current project as a template. For more information on
working with templates, see “Creating New Projects From Templates” on page 141.

Revert: Restores the selected project to the last saved state. All of the work done since
the last save is lost. Use caution; you cannot undo this operation.

Revert from Autosave: Displays a sheet from which you can choose a project saved to
the Autosave Vault.

Import: Opens the Import Files dialog and lets you choose a file from disk to import
into your project (Command+I).

Import as Project: Displays the Import File as Project dialog. The file you choose is
automatically placed it into the Canvas of a newly created project. If multiple items are
selected, they are all placed in the same project (Shift+Command+I).

Export: Displays the Export sheet so you can output your current project to a file on
disk. For more information on the various Export settings, see “Exporting Motion
Projects” on page 899 (Command+E).
**Export using Compressor:** Outputs your current project to a file on disk using Compressor to make MPEG 2, MPEG 4, or other files for web, DVD, or other computer-based delivery (\texttt{Shift+Command+E}).

**Reconnect Media:** When an object in your project refers to a file on disk that has been moved or modified, this command allows you to reestablish that link. This menu item is not active unless an object that has lost its reference file is selected.

**Page Setup:** Displays the standard system Page Setup sheet where you can set paper size and orientation for printing (\texttt{Shift+Command+P}).

**Print:** Displays the standard system Print sheet, from which you can print the contents of the Canvas (\texttt{Command+P}).

**The Edit Menu**
This menu contains familiar commands such as Undo, Cut, Copy, and Paste and also contains commands to select and delete objects, modify project properties, and control the Motion spelling checker.

**Undo:** This command is usually followed by the name of the last command performed such as Undo Move or Undo Rotation Change. Choosing this menu item restores the project to the state before that action was taken. You can undo up to 99 actions. If the menu item is dimmed, you cannot undo (\texttt{Command+Z}).

**Redo:** This command is usually followed by the name of the last command performed such as Redo Move or Redo Rotation Change. It is only active if one or more actions have been undone. Choosing this menu item performs the exact action that was just undone (\texttt{Shift+Command+Z}).

**Cut:** Removes the selection and stores it on the clipboard so it can be pasted later (\texttt{Command+X}).

**Copy:** Copies the selection and stores it on the clipboard so it can be pasted later (\texttt{Command+C}).

**Paste:** Adds the current Clipboard selection to the project based on the current selection. This command is not available if nothing is on the Clipboard or if the contents of the Clipboard cannot be pasted on the current selection. (For example, text cannot be pasted onto a keyframe.) (\texttt{Command+V})

**Paste Special:** Gives you the choice to paste the contents of the Clipboard by Inserting (pushing existing objects out of the way) or Exchanging the contents with the selected object (\texttt{Option+Command+V}).

**Duplicate:** Makes a copy of the current selection, and immediately adds it to the project (\texttt{Command+D}).
Delete: Removes the current selected object. In the Timeline, Delete leaves a gap where the object was (Delete).

Ripple Delete: Removes the selected object and closes the gap left behind (in the Timeline) (Shift+Delete).

Insert Time: Adds blank space into the Timeline. You can only use Insert Time after selecting a time range in the Timeline ruler. For more information on time ranges, see “Defining the Play Range” on page 308.

Split: Breaks an object into two objects, each on its own Timeline track. The split occurs at the current playhead position. If no object is selected, or the playhead is not positioned over a selected object, this menu item is dimmed.

Select All: Selects all objects in the project (Command+A).

Deselect All: Releases any selection (Shift+Command+A).

Project Properties: Opens the Project Properties dialog where you can change the settings for the current project. For details of the Project Properties dialog, see “Editing Project Properties” on page 157 (Command+J).

The Spelling Submenu
This submenu contains the spell checking controls. These commands are only active when a body of text is selected. For more on using the spelling checker, see “Adding Text With the Text Editor” on page 471.

Spelling: Opens the Spelling dialog where you can search through the selected text object for spelling errors (Command+:).

Check Spelling: Turns the spelling checker on for the currently selected text (Command+;).

Check Spelling As You Type: This command turns automatic spelling checking on and off. When active, a checkmark appears next to the menu item. This command only functions on text in the Text Editor, not the Canvas.

Special Characters: This command is part of Mac OS X. It opens the Character Palette which provides access to non-typical text characters like bullets and crosses. It can only be used in Motion when typing in a text object.

The Mark Menu
This menu contains commands to set the beginning and end points of your objects, add markers to the Timeline, navigate through your project, and control animation of effects.
Mark In: This command does two different things. If no object is selected, it sets the beginning frame of the play range to the current playhead position. If an object is selected, it trims the In point for that object to the current playhead frame (I).

Mark Out: This command does two different things. If no object is selected, it sets the ending frame of the play range to the current playhead position. If an object is selected, it trims the Out point for that object to the current playhead position (O).

Move Selected In Point: This command moves the selected object(s) so the In point aligns with the current playhead position (I).

Move Selected Out Point: This command moves the selected object(s) so the Out point aligns with the current playhead position (O).

The Markers Submenu
This submenu contains all of the controls for creating, modifying, and deleting markers. For more on using markers, see “Adding Markers” on page 312.

Add Marker: Adds a marker at the current playhead frame. If an object is selected, an object marker is added. If no object is selected, a project marker is added (Press M or ` to add an object marker, or Shift+M to add a global marker).

Edit Marker: Opens the Edit Marker dialog where you can set a marker’s name, color, duration, and comment. A marker must be selected for this menu item to be active (Option+Command+M).

Delete Marker: Removes the selected marker from the project.

Delete All Markers: Removes all markers from the selected object. If no object is selected it deletes all Project markers.

Mark Play Range In: Sets the play range In point to the location of the playhead (Option+Command+I).

Mark Play Range Out: Sets the play range Out point to the location of the playhead (Option+Command+O).

Reset Play Range: Moves the play range In and Out points to the first and last frame of the project (Option+X).

Play: Starts playback of the project (Space bar).

Loop Playback: Turns looping on and off. When looping is enabled, playback automatically repeats from the beginning of the play range after the end is reached (Shift+L).

Record Animation: Turns keyframe recording on and off. For more information on recording animation, see “Animating in the Canvas” on page 405 (A).
Recording Options: Opens the Recording Options dialog where you can set the granularity of keyframe recording.

The Go to Submenu
This submenu contains all of the different commands to navigate to a particular frame within your project. All of these commands move your playhead to a new location.

Project Start: Moves the playhead to the first frame of the project (Home).

Project End: Moves the playhead to the last frame of the project (End).

Play Range Start: Moves the playhead to the project In point (Shift+Home).

Play Range End: Moves the playhead to the project Out point (Shift+End).

Previous Frame: Moves the playhead backward by one frame (Left Arrow).

Next Frame: Moves the playhead forward by one frame (Right Arrow).

10 Frames Back: Moves the playhead backward ten frames (Shift+Left Arrow).

10 Frames Forward: Moves the playhead forward ten frames (Shift+Right Arrow).

Previous Keyframe: Moves the playhead to the previous keyframe in the project (Option+K).

Next Keyframe: Moves the playhead to the next keyframe in the project (Shift+K).

Previous Marker: Moves the playhead to the closest marker earlier in time (Option+Command+Left Arrow).

Next Marker: Moves the playhead to the closest marker later in time (Option+Command+Right Arrow).

Selection In Point: Moves the playhead to the first frame of the selected object (Shift+I).

Selection Out Point: Moves the playhead to the last frame of the selected object (Shift+O).

The RAM Preview Submenu
This submenu contains commands to play back your project in real time, by temporarily storing the frames in a RAM buffer. For more on how and when to use the RAM Preview functions, see “RAM Preview” on page 46.

Play Range: Renders the area between the project In and Out points and stores the frames in RAM. Once the frames are stored, the region plays back at full speed (Command+R).
Selection: Renders the range of time occupied by the selected objects and stores the frames in RAM. Once the frames are stored, the region plays back at full speed (Option+Command+R).

All: Renders the entire project and stores the frames in RAM. Once the frames are stored, the region plays back at full speed (Shift+Option+Command+R).

Clear RAM Preview: Clears the RAM cache.

The Object Menu
This menu contains all of the commands for manipulating layers and objects within Motion. This includes their placement in the layer hierarchy and physical alignment in the Canvas.

New Layer: Adds a new empty layer to the project (Shift+Command+N).

Bring to Front: Moves the selected object to the top of the Layers list so it is on top of objects on lower layers (Command+}).

Send to Back: Moves the selected object to the bottom of the Layers list so other objects are above it (Command+{).

Bring Forward: Moves the selected object upwards in the Layers list by one object (Command+]).

Send Backward: Moves the selected objects downwards in the Layers list by one object (Command+[).

The Alignment Submenu
This menu contains all of the commands for aligning and distributing multiple objects within the Canvas. For more on arranging objects within the Canvas, see “Using Object Alignment Commands” on page 228.

Align Left Edges: Moves the selected objects so that their left edges line up with the leftmost edge in the selection.

Align Right Edges: Moves the selected objects so that their right edges line up with the rightmost edge in the selection.

Align Top Edges: Moves the selected objects so that their top edges line up with the topmost edge in the selection.

Align Bottom Edges: Moves the selected objects so that their bottom edges line up with the bottommost edge in the selection.

Align Horizontal Centers: Lines up the selected objects on their horizontal center points.
**Align Vertical Centers:** Lines up the selected objects on their vertical center points.

**Distribute Lefts:** Spreads the selected objects evenly between the leftmost and rightmost objects based on their left edges.

**Distribute Rights:** Spreads the selected objects evenly between the leftmost and rightmost objects based on their right edges.

**Distribute Tops:** Spreads the selected objects evenly between the topmost and bottommost objects based on their top edges.

**Distribute Bottoms:** Spreads the selected objects evenly between the topmost and bottommost objects based on their bottom edges.

**Distribute Horizontal Centers:** Spreads the selected objects evenly between the leftmost and rightmost objects based on their horizontal center points.

**Distribute Vertical Centers:** Spreads the selected objects evenly between the topmost and bottommost objects based on their vertical center points.

**Group:** Combines the selected objects into a layer (*Shift+Command+G*).

**Ungroup:** Removes the grouping so you can manipulate the objects individually (*Option+Command+G*).

**Active:** Toggles whether or not an object is active. When an object is not active, it doesn’t appear in the Canvas and doesn’t appear in the final output. When the selected item is active, the menu item has a checkmark beside it (*Control+T*).

**Solo:** Soloing an object hides all other objects in the project. When the selected item is soloed, the menu item has a checkmark beside it (*Control+S*).

**Note:** You can also *Control*-click an object in the Layers tab and choose Solo from the shortcut menu.

**Lock:** Locking an object prevents any changes from affecting that object. When the selected item is locked, the menu item has a checkmark beside it (*Control+L*).

**The Unsol o Submenu**
This submenu lets you turn a soloed object back to its normal state. There are three choices: Video Only (*Control+Shift+S*), Audio Only, or Video and Audio. This menu item is only available when a currently soloed object is selected.

**The Blend Mode Submenu**
This submenu sets the blend mode for the selected object. An object can only have one blend mode set at a time. The current setting is indicated with a checkmark beside the menu item. For examples of the various blend modes, see “Using Blend Modes” on page 249.
Add Image Mask: Adds a mask to the selected object (Shift+Command+M).

Convert to Keyframes: This command can only be chosen when the selected object(s) have behaviors applied. All behaviors are reproduced as keyframes on the parameters that they affect (Command+K).

Make Particles: Uses the selected object as a cell source for a new particle emitter (E).

Replicate: Replicates the selected object (L).

Reveal Source Media: Opens the Media tab and highlights the item that corresponds with the selected item in the Canvas or Timeline. The Inspector is also updated to reveal the properties of the source media (Shift+F).

The Favorites Menu
The Favorites menu remains empty until you create your own favorite effects. Once you have created favorites and stored them in the Favorites Menu folder in the Library tab, they appear in the Favorites menu, grouped by type.

Show Favorites Menu Items: Opens the library and displays the Favorites Menu folder.

The View Menu
The View menu contains commands for controlling the Motion interface. Most of these items affect the Canvas, but some also apply to the Timeline and other panes.

Zoom In: Zooms into the Canvas (Command+=).

Zoom Out: Zooms out of the Canvas (Command+-).

The Zoom Level Submenu
This submenu lets you set a particular zoom level.

Fit in Window: Automatically zooms your Canvas in or out to fit the entire active area in the window (Shift+Z).

The Zoom Time View Submenu
This submenu allows you to automatically zoom the contents of the Timeline.

To Project: Zooms your Timeline so the entire duration of the project fills the window.

To Play Range: Zooms your Timeline so the area between the project In and Out points fills the window.

Full Screen Mode: Fills your entire monitor with the Canvas (with the Timing and Project panes hidden). In this mode, you can do all normal Canvas operations including playback. To leave Full Screen mode, choose the menu item again (F8).

External Video: Sends output to an external video monitor (Command+F1 or F12).
Correct for Aspect Ratio: Adjusts the display of the Canvas to simulate the non-square pixels that appear on a TV monitor.

Preview for Float Bit Depth: When working in float space, turning this setting off drops the preview in the Canvas to 8-bit. Since working in float space drastically increases processing time, turn this setting off to speed your workflow. This setting does not modify the actual output of the project.

**The Channels Submenu**

This submenu sets the Canvas to display individual color or transparency channels. Current settings are indicated with a checkmark beside the item in the menu.

**Color:** Shows the image just as it would appear on a video monitor. Visible objects appear in natural color and transparent areas reveal the background color as set in the Project Properties. This is black by default. (To learn how to change the Canvas background color, see “Background” on page 115.)

**Transparent:** Shows the background area of the Canvas as transparent. A checkerboard pattern appears where no images block the background.

**Alpha Overlay:** Displays the image in normal color, but adds a red highlight over transparent areas of the image.

**RGB Only:** Displays the normal mix of red green and blue channels but transparent areas (including semi-transparent areas) are treated as opaque.

**Red:** Sets the Canvas to display only the red channel as a range of black to white (Shift+R).

**Green:** Sets the Canvas to display only the green channel as a range of black to white (Shift+G).

**Blue:** Sets the Canvas to display only the blue channel as a range of black to white (Shift+B).

**Alpha:** Sets the Canvas to display the alpha (transparency) channel of the objects in the Canvas (Shift+A).

**Inverted Alpha:** Sets the Canvas to display an inverted view of the alpha (transparency) channel (Option+Shift+A).

**Toggle Current and Alpha:** Switches back and forth between viewing the current state and just the alpha channel (V).

The **Resolution Submenu**

This submenu sets the quality level of the Canvas. Reducing the resolution improves playback performance. Choose from Full, Half, Third, and Quarter resolution. Each lower setting further degrades the image. The current setting is indicated with a checkmark beside the menu item.
Field Rendering: Turns off field rendering to improve performance. When field rendering is enabled, a checkmark appears beside the menu item (Option+F).

Motion Blur: Turns off motion blur rendering to improve performance. When motion blur rendering is enabled, a checkmark appears beside the menu item (Option+M).

Show Rulers: Turns display of rulers in the Canvas on and off. When rulers are visible, a checkmark appears beside the menu item (Shift+Command+R).

The Guides Submenu
This submenu lets you control the guides in the Canvas.

Lock Guides: Causes all guides to be fixed in their current position. This prevents you from accidentally moving a guide instead of moving an object (Option+Command+;).

Unlock Guides: Releases guides to be manually manipulated.

Clear Guides: Removes all guides from the Canvas.

Add Vertical Guide: Adds a vertical guide to the Canvas.

Add Horizontal Guide: Adds a horizontal guide to the Canvas.

The Overlays Submenu
This submenu turns the various indicators, guides and grids in the Canvas on and off.

Grid: Turns the display of a grid on and off. You can customize the grid in Canvas pane of Motion Preferences. When the grid is displayed, a checkmark appears beside the menu item (Command+‘).

Guides: Turns the display of guides on and off. When guides are visible, a checkmark appears beside the menu item (Command+‘).

Dynamic Guides: Turns Dynamic Guides on and off. Dynamic Guides are the lines that appear when you drag one item into alignment with another object. When Dynamic Guides are enabled, a checkmark appears beside the menu item (Shift+Command+‘).

Safe Zones: Turns the display of title and action safe borders on and off. You can customize the safe zones in the Canvas pane of Motion Preferences. When safe zones are displayed, a checkmark appears beside the menu item (‘).

Film Zones: Turns display of film-based aspect ratio borders on and off. You can customize the film zones in the Canvas pane of Motion Preferences. When film zones are displayed, a checkmark appears beside the menu item (Shift+‘).

Handles: Turns the display of object handles in the Canvas on and off. The handles are the corner points that let you manipulate an object. When handles are displayed, a checkmark appears beside the menu item.
Lines: Turns the display of object border lines on and off. Handles must also be turned on in order to view lines. When lines are displayed, a checkmark appears beside the menu item.

Animation Path: Turns display of animation paths on and off. Animation paths are the lines that show where an object moves in the Canvas. Handles must also be turned on in order to view animation paths. When animation paths are displayed, a checkmark appears beside the menu item.

Show Overlays: Turns the display of all overlays on and off in the Canvas. This setting must be on in order to view any of the other overlay items (grids, guides, and so on). When Show Overlays is active, a checkmark appears beside the menu item (Command+/).

Snap: Turns object snapping on and off in the Canvas. Snapping automatically aligns objects as you drag them. When snap is enabled, a checkmark appears beside the menu item (N).

Show/Hide Fonts: Displays (or hides) the Font dialog for selecting fonts and font attributes (Command+T).

Show/Hide Colors: Displays (or hides) the Colors window for selecting colors (Shift+Command+C).

Show/Hide Toolbar: Toggles display of the Toolbar. This is equivalent to clicking the Roll-up button at the upper-right corner of the Canvas (Option+Command+T).

Customize Toolbar: Opens the Customize Toolbar sheet.

The Window Menu
This menu contains controls to show and hide all of the windows, panes, and tabs in the Motion interface. You can also choose and manage window layout sets.

Minimize: Shrinks the active window to the Dock. This is equivalent to clicking the Minimize button at the upper left of the window (Command+M).

Zoom: Resizes the active window to maximize desktop real estate. Toggles between full screen and the previously saved non-full screen state.

Save Current Layout: Stores the current window arrangement. Choosing this option requires you to name the layout you want to save. The new layout appears in the Layouts Submenu.

Manage Layouts: Opens the Manage Layouts dialog where you can add, delete, and modify custom window layouts.
The Layouts Submenu
This submenu is where you can choose from existing window layouts. Choose one of
the layouts from the submenu to rearrange your windows to that pre-saved state. For
more on managing window layouts, see “Window Arrangements” on page 21.

Create Locked Inspector: Creates a new Inspector window that doesn’t update based
on selection. This way you can have two (or more) inspectors to compare parameters
across multiple objects.

The Show Inspector Submenu
This submenu provides direct access to any of the four tabs in the Inspector window.
Choose from Properties (F1), Behaviors (F2), Filters (F3), and Object (F4). The object tab
changes depending on what type of object is selected.

Show/Hide Project Pane: Toggles the display of the Project pane (F5).

Show/Hide Timing Pane: Toggles the display of the Timing pane (F6).

Show/Hide Dashboard: Toggles the display of the Dashboard (F7).

File Browser: Toggles the display of the File Browser. If the Utility window is not
present, then one is created. If the File Browser is the only tab in the Utility window,
this command closes the window (Command+1).

Library: Toggles the display of the Library. If the Utility window is not present, then
one is created. If the Library is the only tab in the Utility window, this command closes the window (Command+2).

Inspector: Toggles the display of the Inspector. If no Utility window is present, one is
created. If the Inspector is the only tab in the Utility window, this command closes the window (Command+3).

Layers: Toggles the display of the Layers tab. If the Project pane is not visible, this
command causes it to appear. If Layers is the only tab in the Project pane, this
command closes the pane (Command+4).

Media: Toggles the display of the Media tab. If the Project pane is not visible, this
command causes it to appear. If Media is the only tab in the Project pane, this
command closes the pane (Command+5).

Audio: Toggles the display of the Audio tab. If the Project pane is not visible, this
command causes it to appear. If Audio is the only tab in the Project pane, this
command closes the pane (Command+6).

Timeline: Toggles the display of the Timeline. If the Timing pane is not visible, this
command causes it to appear. If the Timeline is the only tab in the Timing pane, this
command closes the pane (Command+7).
**Keyframe Editor:** Toggles the display of the Keyframe Editor. If the Timing pane is not visible, this command causes it to appear. If the Keyframe Editor is the only tab in the Timing pane, this command closes the pane (Command+8).

**Audio Editor:** Toggles the display of the Audio Editor. If the Timing pane is not visible, this command causes it to appear. If the Audio Editor is the only tab in the Timing pane, this command closes the pane (Command+9).

**Bring All to Front:** If any Motion windows are hidden behind windows from other applications, this command moves them to the front.

**Open Project List:** All open projects appear at the bottom of the Window menu. Choosing an item from this list brings that project’s Canvas to the front.

**The Help Menu**
The Help menu provides access to resources for learning more about Motion.

**Motion User Manual:** Opens the Motion 2 User Manual in PDF format.

**Late-Breaking News:** Opens a file containing any last minute changes to the documentation that may affect your use of the software.

**New Features:** Opens the New Features in Motion 2 document in PDF format.

**Getting Started:** Opens the Motion Getting Started book in PDF format.

**Tutorials:** Opens the Motion 2 Tutorials in PDF format.

**Show Welcome:** Displays the Welcome Screen that appears on startup and provides options to take a quick tour of Motion, create a new project from scratch or from a template, or view the tutorials.

**Motion Support:** Opens a web page that contains up-to-date technical support information about Motion.

**Motion on the Web:** Opens a web link to the Apple Motion online community. This site contains additional tutorials, training resources, information about product updates, and other information.

**Apple Training Centers:** Opens a link to the Apple Training Centers webpage, where you can find information about Apple-authorized training in your area.

**Create Support Profile:** Generates a special file describing the technical details about your workstation such as processor speed, video card specifications, and so on. This file is only used by authorized Apple technical support technicians.
Creating and Managing Projects

Learn how to create, save, and manage project files. In addition, learn how different kinds of objects are put together inside a project to create a composition.

A project file consists of a single composition that you are working on. Project files contain objects, which are linked references to source media files on disk, but they contain no media themselves. Project files simply house information about how a composition is assembled, what media files on disk are used, and what effects from the Library have been applied. They also contain any shapes, masks, and text objects that you create.

Creating New Projects
Before you can do anything in Motion, you first need to create a new project. Depending on the type of project you are working on, there are three ways to do this. You can base your composition on one of the supplied templates, you can create a new blank project using one of the available project presets, or you can create a new project using your own custom settings if you need an unusual frame size or frame rate.

Motion is resolution independent, meaning that it supports projects using a wide range of frame sizes and frame rates. Using Motion, you can create small movies for streaming on the web, standard- and high-definition movies for broadcast, or even film resolution files for film output. Regardless of the resolution at which you're working, Motion works exactly the same, although high-resolution projects using large media files may have higher memory and graphics card requirements than projects with smaller resolutions.

Important: Motion is hardware dependent. This means that the type of graphics card installed on your system dictates performance and the maximum file size that you can import into Motion. For most recommended cards, the file-size limit is 2 K. For more information, visit the Motion website at http://www.apple.com/motion.
Each project has a single group of project properties that define the duration of the project, the size of the Canvas, the frame rate of playback, and other details that affect how your composition is formatted. Later, when you have finished your project and you’re ready to export it, the project properties you select define the media file that is created. Although you can change these settings at any time, it’s best to choose the settings that match your final planned output format.

Regardless of your project settings, Motion still allows you to add nearly any kind of media file supported by QuickTime to your project. Furthermore, you’re free to mix media files with different properties in the same project. For example, you can combine video clips of different frame sizes with graphics files. In the end, the file you output uses the frame size and frame rate specified by the project properties.

**When Motion First Opens**

The first time you open Motion, a Welcome Screen presents you with two ways to create a new project. You can click Start with a Template to open the Template Browser, or you can click Start with a New Project to create a new blank project file.

By default, this screen always appears when you open Motion. If you don’t want to see this screen at startup, you can uncheck the “Show the Welcome Screen at startup” checkbox at the bottom, or you can choose a different startup option from the At Startup pop-up menu in the General pane of Motion Preferences. You can choose from the following options:

**Open Last Project(s):** Automatically opens the last project(s) you worked on, whenever Motion is opened.
**Create New Project:** Opens the Select Project Preset window, allowing you to pick a preset to use to create a new, blank project file. If a default project preset is set, this window does not appear.

**Show Welcome Screen:** Shows the Welcome Screen every time Motion is opened.

**Browse Templates:** Opens the Template Browser, allowing you to pick a template to use.

To display the Welcome Screen once you have dismissed it, choose Help > Show Welcome (or press Command+0).

For more information about options available in Motion Preferences, see “Preferences” on page 107.

**Creating New Projects From Templates**
The easiest way to create a new project in Motion is to open one of the existing templates and customize it for your own purposes. Motion templates are simply pre-made projects, available from the Template Browser, that are set up for easy customization. Motion comes with a variety of royalty-free templates that you can use and customize. Each template contains pre-made graphics, text objects, and backgrounds that you can use as is, or exchange with your own custom objects to make the design your own.

Eventually, you can extend this collection by creating your own templates of frequently used layouts. For example, if you regularly create titles and graphics sequences for a television series, you can create a group of templates for the show that contains layouts for every motion graphics shot you need. For future shows, you can then open these existing templates and customize them with updated text and graphics, without needing to recreate each layout from scratch.

The templates that come with Motion are available in NTSC and PAL resolutions. All templates are organized into collections, which are groups of templates assembled along a common theme.

**To create a new project from a template:**
1. To open the Template Browser, do one of the following:
   - When Motion first opens, click Start with a Template.
   - If Motion is already open, choose File > Open Template (or press Shift+Command+O).
2 When the Template Browser appears, use the Show pop-up menu to see templates that have been optimized for a specific video format, including NTSC, PAL or HD. (You can also choose to show All formats, or Other formats.)

3 The collection list shows all templates of the selected type. Click a template collection to display its contents at the right.

4 Click an individual template to see a preview of it in the preview area, along with additional information including its resolution, duration, and frame rate.

5 To create a new project from the selected template, click Open Template.

   A new project is created using the objects contained in that template. You can then customize the project by editing the text objects or exchanging the graphic elements it uses with your own. The changes you make to projects created using templates are not saved back to the source template file.

   For more information about using, modifying, and creating templates, see “Customizing and Creating New Templates” on page 211.

Creating Blank Projects From Project Presets

If you're creating a new project from scratch, but the final result is going to conform to one of the common standards for web delivery, broadcast, or film output, you can use one of the project presets that ships with Motion. Unlike a template, choosing a preset only defines the essential properties of the project, such as the frame size and frame rate. The resulting project is completely empty, ready for you to add your own objects.
Since you can have as many open project files in Motion as the amount of RAM in your computer supports, you can create a new project at any time without having to close projects that are already open.

**To create a new project:**


2. Choose a preset from the pop-up menu, then click OK.

A new project window is created. It is not saved to disk until you choose a save command from the File menu. For more information on saving project files, see “Saving Projects” on page 152.

**Note:** If you have already set a default preset, Motion will open a new project window at that resolution, bypassing the Select Project Preset dialog.

**Creating Blank Projects With Custom Settings**

If none of the available presets meet your needs, you can create a new project with custom project settings from the same window.

**To create a new project with custom project settings:**


   **Note:** If you have already set a default preset, hold down the Option key and choose File > New From Preset (or press Option+Command+N).

2. Choose Custom from the bottom of the Preset pop-up menu, then click OK.

   The Project Properties dialog appears.

3. Choose the appropriate settings in the General and Render Settings tabs, then click OK.

   A new project window is created using the settings you specified.
The General Tab
The General tab allows you to define the most essential properties of the project you’re creating. By choosing different parameters, you can accommodate nearly any video or film format you need to output to. These properties are the default settings used when you export your project to create the final output file.

Preset: The Preset pop-up menu appears at the top of the General tab. You can choose an existing preset to base your new preset on, changing any necessary parameters to better suit your needs.

Width and Height: Define both the size of the Canvas and the default output resolution of your project. Frame size is usually defined by the video format you plan on outputting to. For example, NTSC DV format video is 720 x 480, whereas PAL DV format video has a frame size of 720 x 576.

Bit Depth: Sets the bit depth of the project to one of the following:
  - 8-Bit (Integer)
  - 16-Bit Float
  - 32-Bit Float

Note: When working in float space, you can quickly change the preview in the Canvas to 8 bit to speed your workflow, by turning off Preview Float Bit Depth in the View pop-up menu. The View pop-up menu is located in the upper-right corner of the Canvas (below the Timing icon). This setting does not modify the actual output of the project.

About Bit Depth
When working with images, an increase in bits-per-pixel for those images means more color information becomes available. A one-bit-per-pixel bitmap image is comprised of purely black or white image pixels (no shades of gray).
A grayscale image comprises image pixels with 256 levels of gray. Each pixel requires 8 bits to represent the 256 shades of gray. Therefore, the bit depth of a grayscale image is 8 \((2^8 = 256)\).

An RGB image can comprise image pixels with 256 shades of each of the primary colors—red, green, and blue. In this case, there are \(2^8 (256)\) shades of each color component. This creates more than 16.7 million possible colors \((256 \times 256 \times 256 > 16.7\) million). The bit depth of an RGB image can be 24 (8 bits for each color), and the bit depth of an RGBA image (red, green, blue, and an alpha channel) can be 32 (8 bits for each color + alpha channel). The bit depth of an alpha channel describes the transparency of each pixel. Although these images are 24- and 32-bit, such color images are often referred to as 8-bit (because of the 8 bits per channel).

**Note:** An RGB image does not necessarily imply 8 bits per pixel.

Motion’s bit depth setting is bits-per-channel. In an 8-bit Motion project, the 256 levels of color are represented on an integer scale of 0-255 (where 0 represents black and 255 represents white). All of your operations are clamped within that 0-255 range. Although 16.7 million is a lot of colors, it is often helpful to have more “space” in which to work. This is where *float* comes into play. In Motion, you can work in 8-bit, 16-bit float, or 32-bit float. When working in float, the number of values between 0-1 is increased (float values can denote fractional values). Also, float values can be less than 0 or greater than 1. This means that the color shades are subdivided into an enormous amount of intermediate colors—incredibly small increments of color can be represented in 16-bit float, and even finer increments in 32-bit float. This is often referred to as *float space*. Floating-point calculations are more accurate than those made in non-float space.

The bit depth of your source footage will often determine the bit depth of your project. Even if your source footage is 8-bit, you may want to work in a project with a higher bit depth to achieve better results. When you increase the bit depth of your project, you are not introducing any new color information to the original images. However, operations such as keying, color correction, applying blur or other filters with high parameter values, or creating graphics that require very smooth color gradients can benefit from the new number of possible color levels.

**Important:** There is a price for working in higher bit depths, however. And that price is paid in processing time. Remember also that because Motion is hardware dependent, most systems have a limitation on the size of imported files. For more information on the required hardware, visit the Motion website at [http://www.apple.com/motion](http://www.apple.com/motion).
**Pixel Aspect Ratio:** Defines whether the project is created using square or nonsquare pixels. Computer displays, film, and high-definition video use square pixels, while standard-definition video uses nonsquare pixels. Choose Square for projects intended for the web, high-definition projects, and film, or one of the nonsquare pixel ratios corresponding to each international standard-definition broadcast standard. A field to the right of this pop-up menu displays the numerical aspect ratio, in case you need to manually change it.

**Field Order:** When working with interlaced video, choose the field order you plan on using for eventual output from this pop-up menu. This should match the field order of the device being used to output the resulting QuickTime file to video. When working with progressive-scan video or film, choose None.

**Frame Rate:** Choose a frame rate (in frames per second) that matches the format you’ll eventually be outputting to. For example, film is 24 fps, PAL video is 25 fps, and NTSC video is 29.97 fps. Additional frame rates are available for different video formats.

**Duration:** Allows you to enter the total duration available in your project’s Timeline. A pop-up menu allows you to define the duration with either a timecode value based on the currently selected frame rate, a frame count, or in seconds. The default value is 900 frames, or 30 seconds.

**Start Timecode:** When you export your project as a QuickTime movie, this value defines the starting timecode value of the timecode track it’s created with.

**Background Color:** Defines the color that appears in the Canvas if no other graphic or QuickTime object is present. If the Background Opacity is set to 0 percent and you export your project with a premultiplied alpha channel, the color you select here is the color with which the alpha channel is premultiplied.

**Note:** If you intend to export your project with a premultiplied alpha channel, be aware that most alpha channels are rendered against either white or black.

**Background Opacity:** A slider that adjusts the opacity of the background. Setting this value to 100 percent makes the background completely solid—no transparency appears in the resulting image when it is exported. Setting this value to 0 renders the background completely transparent when the project is exported with an alpha channel.

**Project Description:** A field into which you can enter a brief description of the project. It may also be useful to call out significant characteristics of that particular preset such as frame size or frame rate.

For more information about commonly used frame sizes, frame rates, interlacing, and other project setting information, see “Video and File Formats” on page 941.
The Render Settings Tab
The Render Settings tab contains parameters that affect how Motion renders the objects and animation in your project. These settings can affect how your project looks when exported.

Motion Blur: Simulates the effect a camera’s mechanical shutter has on a frame of film or video when either the camera or its subject is moving. In Motion, motion blur affects objects in your project that are animated using behaviors or keyframes. This allows you to create more natural-looking motion in your project, even though the animation is artificially created. As with a camera, faster objects have more blur, whereas slower objects have less.

Important: Unlike Final Cut Express HD or Final Cut Pro, the motion blur created by these parameters does not affect motion that occurs within a QuickTime movie file or an image sequence. It only affects animated objects.

The motion blur section has two parameters:

- **Samples**: The number of sub-frames rendered per frame, where 1 frame is 360 degrees. Higher Samples values result in a higher-quality motion blur effect, but are more processor intensive. The default Samples value is 8. The maximum possible value is 256.
The following image shows a shape that has been keyframed to move quickly across the Canvas horizontally.

In the next image, Motion Blur is enabled and Samples is set to the default value of 8.

Note: When using larger Shutter Angle values, it may be necessary to increase the Samples value to eliminate unwanted artifacts.

- **Shutter Angle**: Defines the size of the motion blur that appears for animated objects. Increasing the shutter angle increases the number of frames over which the shutter is open.

  In the above image, the Shutter Angle is set to the default of 360 degrees, which represents 1 frame. In the following image, Shutter Angle is set to 600 degrees.

**Anti-aliasing Method**: There are different mathematical models for how to make objects appear to scale and move smoothly. This setting lets you choose which method Motion uses.

- **None**: No algorithm is used. Images render more quickly, but may have jagged edges or ringing artifacts.
- **Normal**: The default method, Normal is a fairly quick way to render high-quality transformation effects.
- **Best**: This method is slower, but it produces the smoothest results. Best is the recommended setting for projects that include thin lines.

Once you’ve set the motion blur parameters you want to use in your project, you need to turn on motion blur separately.

**To turn motion blur on or off in a project, do one of the following:**
- Choose View > Motion Blur.
- Choose Motion Blur from the View pop-up menu that appears above the Canvas.
Creating, Editing, and Deleting Presets

If you commonly create projects using custom settings that don't match any of the available presets, you can create a new preset with these settings for future use. Presets are created, modified, and deleted in the Presets pane of Motion Preferences.

To create a new custom preset:
1. Choose Motion > Preferences (or press Command+,).
2. In the Presets pane, choose Project Presets from the Show pop-up menu.
3. Click the Add Preset button (+) beneath the presets list.
   The Project Preset Editor dialog appears.
4. In the Project Preset Editor dialog, do the following:

   - In the Name field, type a descriptive name for the preset.
   - Enter a brief description of what that preset is for. It may also be useful to call out significant characteristics of that particular preset, such as frame size and frame rate.
• Enter a frame size into the Width and Height fields.
• Choose a Pixel Aspect Ratio, Field Order, and Frame Rate from the corresponding pop-up menus.

5 Click OK.

6 If you’re done creating new project presets, close the Preferences window.

Note: For more information on industry-standard frame sizes, pixel aspect ratios, field order, and frame rates, see “Video and File Formats” on page 941.

To choose a custom preset to be the new default, do one of the following:
• In the Presets pane of Motion Preferences, click the checkbox to the left of the preset you want to be the default for all newly created projects.
• Choose File > New to display the Select Project Preset dialog. Choose a project preset from the Preset pop-up menu, then click Set as Default.

You can also edit existing presets. This allows you to update a preset you’ve already created, or to make a new preset by customizing an existing one with similar settings.

To duplicate an existing preset prior to editing it:
1 In Motion Preferences, select a preset in the Presets pane.
2 Click Duplicate.

The duplicated preset appears underneath the original preset.

To edit an existing preset:
1 In Motion Preferences, select a preset in the Presets pane.
2 Click Edit.
3 When the Project Preset Editor dialog appears, make any necessary changes, then click OK.

Note: You cannot edit or delete locked project presets.

To delete a custom preset:
1 In Motion Preferences, select a preset in the Presets pane.
2 Click the Delete Preset button (-) underneath the presets list.

To lock a preset:
1 In Motion Preferences, select a preset in the Presets pane.
2 Toggle the lock icon to the right of the preset name to lock or unlock that preset.

Locked presets cannot be deleted.

Note: You cannot unlock a preset that is built into Motion. When the lock is clicked, an alert appears stating that selected preset cannot be modified. To create a copy of the preset that you can customize, click OK.
Moving Presets Between Computers
Each preset you create is saved as a separate file. If you’ve created one or more custom presets that you rely on, you may want to move them to other computers you use that have Motion installed. All user-created presets are stored in the Home/Library/Application Support/Motion/Presets/Project folder.

To copy a project preset to another computer:
- Copy your custom preset files to that computer’s Home/Library/Application Support/Motion/Presets/Project folder.

Managing Projects
When you work on a project in Motion, it’s important to be organized. This includes keeping careful track of your project files, saving often, and maintaining regular backups. The idea is to make sure that nothing gets accidentally misplaced or deleted, and that you don’t lose work by losing your valuable digital resources. Motion also autosaves projects that can be retrieved at any time.

Saving Projects
As with any application, it’s a wise practice to save early and often as you work on your project. This way, you don’t lose work due to unforeseen circumstances such as a blackout occurring just as you were about to finish your latest animated masterpiece.

Besides preserving your work for future use, Motion’s save commands can be used in other ways to manage the development of your project. For example, if you’re happy with your current composition, but you want to create a variation of what you’ve done, you can use the Save As command to save a copy of the current project. You can then freely alter this duplicate, leaving your original project alone in case you don’t like your changes.

You can also use the Save As command as an archival tool, saving individually named copies of your project periodically over the course of its creation. This serves two purposes. First, it ensures that you have duplicates of your project file, protecting you from inadvertently misplacing your only copy and losing days of work. Second, it also gives you a way to go back to previous versions of your composition, in the event that you or your client want to make a change based on an earlier point in that project’s development.

To save a project:
   If the project has not already been saved, the Save As sheet drops down from the title bar.
2. Type a name into the Save As field, choose a location on your hard drive to save the file, then click Save.
   Note: If the project has already been saved, the project file is simply updated.
To save a duplicate of a project:
1. Choose File > Save As (or press Shift+Command+S).
   The Save As sheet drops down from the title bar.
2. Type a new name into the Save As field, choose a location on your hard drive, then click Save.

   **Important:** When using the Save As command, it's important to use a name that is different from the name of any previously saved versions of the same project. Otherwise, you run the risk of overwriting a previous version of this project file that you want to keep. You'll be warned if this happens.

To save all open projects:
1. Press Option, then choose File > Save All (or press Command+Option+S).
2. If all open project files have already been saved, the Save All command simply updates them. If any open project has not been saved, enter a name in its Save As field, then click Save.

   **Note:** The Save All command only appears when you press Option while opening the File menu.

**Using Autosave**
Motion automatically saves backups of your project in a folder on your hard drive. In the Project pane of Motion Preferences, you can specify how frequently projects are automatically saved, as well as the location of the saved files. Saved projects are time- and date-stamped.

**Use Autosave Vault:** Instructs Motion to store autosaved projects to the location specified in the Autosave Vault Folder parameter.

**Save a copy every:** Specifies how often, in minutes, a project is saved.

**Keep at most:** Tells Motion how many versions of the autosaved project to store in the vault.

**Maximum of:** Tells Motion the maximum number of different autosaved projects to store in the vault.

To store autosaved projects in a specific location:
1. Choose Motion > Preferences (or press Command+,).
2. Click Project.
3. In the Autosave group, turn on Use Autosave Vault.

   By default, the **Autosave Vault** folder is located in a folder called **Motion Projects** in your **Documents** folder in your home directory.
To set a new location for the Autosave vault:
- Click Choose and select a new location in the sheet.

To revert to an autosaved project:
1. Choose File > Restore From Autosave.
   The Restore Project sheet appears.
2. Choose a saved project from the pop-up menu.

**Reverting Projects**
The Revert command discards all changes you’ve made to a project since the last time you saved it. The Revert command is especially useful as a tool for trying out numerous changes in your project. You can save your project in the state you like it, then make all the changes you want. If you don’t like the result, use the Revert command to immediately go back to the way it was before.

*Note:* You can also use Motion’s unlimited undo feature to achieve the same purpose in incremental steps. For more information on the Undo command, see “The Edit Menu” on page 126.

To revert a project to the last saved version:
- Choose File > Revert.

**Opening and Closing Projects**
You can open one or more previously saved project files either in the Finder or from within Motion. You can have as many projects open at the same time as the amount of RAM in your computer can support. Your computer’s RAM is divided up among the operating system, any other applications that are currently open, and all currently open documents. If, at any point, you notice a decrease in performance because you’ve run out of RAM, simply quit one or more other applications, or close one or more open projects to free up RAM for the remaining open projects.
To open one or more project files in the Finder, do one of the following:

- Double-click a Motion project file. Motion automatically opens with that project.
- Select one or more Motion project files, then drag them onto the Motion application icon either in the Applications folder or in the Dock, if you’ve placed one there.
- Select one or more Motion project files, then choose File > Open (or press Command+O) in the Finder.
- Select one or more Motion project files, Control-click one of them, then choose Open from the shortcut menu.

Motion automatically starts and opens all selected projects.

To open a project file from within Motion using the Open command:

1. Choose File > Open (or press Command+O).
   The Open dialog appears.
2. In the Open dialog, navigate to the project file you want, then click Open.

To open a project file from within the Motion File Browser:

1. In the File Browser, navigate to the project file you want and then select the file.
2. Do one of the following:
   - Double-click the project file.
   - In the Preview area, click the Import button.

The project opens in a new Canvas.

Opening Recent Projects

Every project you open in Motion is automatically added to the Open Recent submenu in the File menu. You can choose a project from a list of projects that you’ve worked on recently from this submenu. Motion keeps the names of the previous projects you’ve worked on in the Open Recent submenu.

To open a recent project:

- From the File menu, choose a project’s filename from the Open Recent submenu.

If the Open Recent submenu becomes too crowded, you can clear it out.
To clear the Open Recent submenu:

- Choose File > Open Recent > Clear Menu.

Managing Multiple Open Projects

Each open project is self-contained in its own window, and each has its own Layers, Media, Audio, Timeline, Keyframe, and Audio Editor tabs.

You can use the Exposé All Windows command to see all open project windows at once. For more information on how to use Exposé, see Mac Help, available in the Finder Help menu.

Closing Projects

You can close projects either one at a time, or all at once. You close projects by closing their project window (the window containing the Canvas).

To close a single project, do one of the following:

- Press Control+W to close the currently selected window.
- Click the Canvas window’s close button.

To close all open projects, do one of the following:

- Press Command+Option+W.
- Option-click the close button.

Note: Depending on the version, Option-clicking the close button to close all open projects may not work on your current operating system.

Moving and Archiving Motion Project Files

If you want to move a Motion project file to another computer, you must also move all the media that the project uses along with it, including all QuickTime, still image, and audio files. In addition, if your project uses any third-party Motion plug-ins or nonstandard fonts or LiveFonts, you need to make sure that those are also installed on the computer you’re moving the project to, or they’ll be unavailable to your project.

Similarly, when you’re finished with a project and you want to archive it, it’s a good idea to archive not just the project file, but also all media used (especially media that wasn’t captured from a device-controllable video or audio source), graphics, fonts, custom behaviors, filters, or third-party add-ons used by that project. In the event you want to restore the project for later revisions, you’ll have everything you need to get started quickly. If you have a recordable CD or DVD drive, backing up your media is easy. For more information on copying files to a recordable CD or DVD disc, see Mac Help in the Finder Help menu.
Note: If you move a project to another computer, its media may go offline even though you've moved its media files along with it. For more information on how to relink media files to your project, see “Online vs. Offline Media” on page 181.

Archiving QuickTime Video
If you use QuickTime video clips in a Motion project that you want to archive for long-term storage, whether or not you also archive the video clips themselves depends on how they were captured. For example, if you captured your video using a device-controllable camcorder or deck with Final Cut Express HD or Final Cut Pro, archiving the video clips you used may be unnecessary. This is because you can always recapture them from the original source tapes using the Final Cut project file you logged them with. In this case, it's a good idea to back up the Final Cut Express HD or Final Cut Pro project file along with your Motion project file.

If you captured your video without device control, or if the video was captured by someone else and you no longer have the ability to recapture the clips exactly as they appear in your project, it's probably a good idea to back up these clips along with the rest of the graphics files, audio files, and fonts you used in your project.

Editing Project Properties
Even though every project starts out with a preset group of project properties, you can change them at any time, even after you've added objects.

To edit the properties of an existing project:

2. In the Project Properties dialog, change any necessary parameters, then click OK.

For more information on the parameters available in the Project Properties dialog, see “The General Tab” on page 144, and “The Render Settings Tab” on page 147.

Most changes made to a project’s properties are fairly transparent, and have no visual effect on the project itself. The main exception is a change made to the project’s frame size.

Changing the Frame Size of a Project
When you change the frame size of a project (in Project Properties) that already has objects within it, you essentially change the size of the Canvas. This adds to, or reduces, the amount of room available to lay out the objects in your project.
It’s important to understand that changing the size of the Canvas in no way changes the size or position of any objects already placed within it. Furthermore, since the coordinate system used by Motion uses 0, 0 as the center of the frame, all objects remain arranged in their current positions relative to the center of the frame as the edge of the frame shrinks toward the center. This may result in objects being cut off as the frame shrinks past their edges. In the following example, a project with a frame size of 720 x 480 is reduced to 320 x 240.

![Original frame size (720 x 480) Reduced frame size (320 x 240)](image)

**Note:** Since Motion is resolution independent, it’s not usually necessary to change your project’s frame size. You can output your projects at any size, regardless of the current frame size, by changing the options in Motion’s export dialogs. For example, if you’re building a project with a frame size for standard-definition broadcast, you can still export a half-resolution version of your project to post on the web simply by exporting to the necessary size.

**Browsing Media Files in Motion**

This section describes how to browse the media files you want to use in your Motion project. As with project files, it’s important to make sure that the source media you’re using is organized in a way that makes sense and is easy to keep track of. Centralizing source media that’s only used in one project can be helpful, as is carefully organizing media that is shared by more than one project.

You use the File Browser to navigate every volume connected to your computer for media files to add to your Motion project. While similar to a Finder window, the File Browser has many custom controls specific to Motion that allow you to quickly locate and preview files you might want to use.

**Note:** You can also browse for and import files directly from your iTunes and iPhoto libraries from within the Motion Library. For more information, see “Adding iTunes and iPhoto Files From the Library” on page 178.
Navigation Controls in the File Browser

File Browser Sidebar: This area of the File Browser displays all the hard disks and removable media currently connected to your computer. You can also access networked volumes. Additional icons allow you to access commonly used folders in your home folder such as the Desktop, Documents, Movies, Music, and Pictures folders.
File stack: Located beneath the File Browser Sidebar, the file stack displays all the files and folders within the currently selected disk in the Sidebar. Clicking a folder opens its contents into the file stack, replacing the previously displayed contents. You can navigate up and down the current folder hierarchy using the Back and Forward buttons and the Path pop-up menu. The file stack can be toggled between list view and icon view.

Preview area: Displays a preview of the currently selected file in the file stack. If a movie is selected, the Play button allows you to play through the clip. Information about the clip being previewed appears to the right of the thumbnail preview.

Back and Forward buttons: These buttons allow you to navigate the current folder hierarchy in the file stack. Clicking the left arrow moves you to the next folder up in the hierarchy. Repeatedly clicking the left arrow eventually moves you up to the topmost level of the browser to the last item you selected, such as the Desktop, a partition, or your home folder. Clicking the right arrow takes you back down into any folders you were previously in. If you have never opened any folders within the currently open folder in the file stack, the right arrow is dimmed.

Path pop-up menu: Displays the current folder hierarchy as a list, with the currently open folder at the top, and each enclosing folder appearing underneath. “Computer” appears at the bottom, which is the topmost directory of all disks connected to your computer.

Search field: The Search field filters the file stack for the search terms you’ve entered.

Controls for Customizing the File Browser

File Browser divider: Dragging this divider up and down allows you to reallocate space between the File Browser Sidebar and the file stack. Shrinking the Sidebar also shrinks each displayed icon, down to a certain point.

Icon view: A button that sets the file stack to display each file and folder as an icon. Image and movie files are represented by a thumbnail image, while folders are represented by a folder icon. All icons in the stack are arranged into a grid, the size of which is defined by the Scale slider at the bottom of the File Browser.

List view: A button that sets the file stack to display each file and folder as a hierarchical list. A thumbnail of each file and folder appears to the left of each file and folder name within the Name column. To the right, several additional columns display information for the date, size, duration, and kind of each file. The contents of the file stack can be sorted by any single column by clicking that column’s header. Clicking the same header twice reverses the sort order, from ascending to descending, or vice versa.
Folders in this list can be opened hierarchically, using the disclosure triangle to the left of each folder’s icon, or they can be double-clicked to replace the current contents of the file stack with the contents of that folder.

**Icon view**

**List view**

**Scale slider:** When in icon view, this slider enlarges or reduces the size of all icons displayed in the file stack. The current scale size affects how many icons can be simultaneously viewed within the current area of the file stack. The file stack can be enlarged with the File Browser divider.

**Collapse Image Sequences:** Image sequences are movie clips that have been saved as individual image files, one for each frame of film or video. Clicking this button allows you to view properly named image sequence files as a single image sequence file. In the event that you’re viewing image files that have numbered filenames that aren’t actually an image sequence (such as images captured with a digital camera that you’ve imported from an iPhoto directory), you can turn this control off to see each individual image file separately.

**New Folder button:** Allows you to create a new folder within the currently displayed location in the file stack. These new folders are created in the Finder, and allow you to reorganize media files on disk from within Motion.

**Note:** To delete a folder from the File Browser, select the folder, then press Command+Delete.
Different Methods of Browsing, Searching, and Previewing Files

This section contains procedures you can use to look for and preview files using the controls in the File Browser.

To browse the contents of a disk, do one of the following:
- Click the disk’s icon in the File Browser Sidebar.
- Press the Up and Down Arrow keys to move up and down the Sidebar list.

To browse the file stack in icon view, do one of the following:
- Double-click a folder in the file stack to open its contents into the file stack.
- Click an icon in the file stack, then press the arrow keys to change the selected folder.

To open the currently selected folder, press Return.

To browse the file stack in list view, do one of the following:
- Double-click a folder in the file stack to open its contents into the file stack.
- Click the disclosure triangle to the left of a folder’s icon to open its contents into a hierarchical list.
- Click a list item, then press the Up and Down Arrow keys to navigate the list.
- Press the Right Arrow to open the selected folder into hierarchical view—this has the same effect as clicking a folder’s disclosure triangle. Press the Left Arrow to close a folder that’s been opened hierarchically.
- Press the Return key to open a folder’s contents into the file stack.

To navigate the current file path hierarchy, do one of the following:
- Click the Forward button to move to the previously opened folder.
- Click the Back button to move to the last previously opened folder down the current folder hierarchy.
- Choose a folder in the current hierarchy from the Path pop-up menu.

To sort the file stack in list view:
- Click the header of any information column to sort by that category. Click the same column a second time to reverse the sort order, from ascending to descending, or vice versa.

To search for a file:
- Type a search term in the Search field. The file stack immediately updates with files that contain the search term anywhere within their filenames. Only disks or folders currently displayed in the file stack are searched. Character case is ignored.

For example, typing “flag” in the Search field might result in the following filenames appearing in the file stack: “Dutch Flag.tif, flagAnimation.mov, flagellum.tif, Iron Flag.m4a.”
To clear the search results:
- Click the Clear button at the far right of the Search field to restore the contents of the file stack to the previously selected file path.

To preview a file:
- Select any supported media file in the file stack. The Preview area updates with a thumbnail and additional text information about that file. If “Play items automatically on a single click” is turned on in the General pane of Motion Preferences, an animated preview of movie clips and image sequences begins playing.

To preview a file at full size:
- Double-click a file in the file stack to open it into its own Viewer window, complete with playback controls.

About Networked Disks and Removable Media
You should be careful when adding media files from a remote server to your project. Although the File Browser Sidebar allows you to easily access the contents of disks on other computers on your network, doing so only places a link to that file in your project. The actual media file remains on the remote disk where you found it. As a result, whenever that remote disk becomes unavailable, the corresponding object in your project goes offline. Furthermore, depending on the speed of your network, you may experience performance issues when using media files on other computers. Ideally, you should copy all media files you want to use in your project onto a disk that's physically connected to your computer, both to ensure the file's future availability, and to guarantee playback performance. If you do use media from a networked hard drive, make sure it's one that is always mounted on your system, and that you have a high-performance network.

This is especially true for media from removable disks, such as CD-ROM, DVD-ROM, and removable hard drives that are frequently disconnected from your computer. Always copy media files from such media to your local hard drive so that the media doesn't become unavailable when the media is ejected or disconnected.

File Types Supported by Motion
Motion can use the most popular multimedia file formats supported by QuickTime. These formats can be broken down into the following categories:
- QuickTime movies
- Image sequences
- Still image files
- Layered Photoshop files
- PDF files
- Audio files
QuickTime Movies
Motion supports QuickTime movies using any codec currently installed on your computer. Examples of QuickTime movies you can import include clips captured with Final Cut Express HD or Final Cut Pro, stock footage from a CD-ROM or DVD collection, or computer-generated animation from a 3D animation package.

While you can import movies that use nearly any codec, it’s inadvisable to use highly compressed clips in your projects if you can avoid it. Clips that are excessively compressed may display undesirable visual artifacts. Fortunately, QuickTime comes with many codecs that are ideal for moving uncompressed or minimally compressed video files between applications, including but not limited to: Uncompressed 8- and 10-bit 4:2:2, Pixlet, None, Animation, Apple M-JPEG A and B, Apple DVCPRO-50, and Apple DV/DVCPRO.

Many of these codecs support alpha channels, which define areas of transparency within the clip. If a particular QuickTime clip has an alpha channel, Motion automatically uses it in your project.

Mixing Different Kinds of QuickTime Files
You can freely combine clips that are compressed with different codecs in the same project. Furthermore, you can also combine clips that have different frame sizes, pixel aspect ratios, and interlacing. To learn more about alpha channels, interlacing, pixel aspect ratio, frame rates, and frame sizes, see “Video and File Formats” on page 941.

Warning: Mixing clips with different frame rates may result in undesirable motion artifacts.

Importing Movies From Final Cut Express or Final Cut Pro
Unlike Final Cut Express HD or Final Cut Pro, Motion processes video in RGB color space. Video clips that have been captured in YCrCb color space are treated as RGB clips when imported into a Motion project.

Still Images
You can import still image files using virtually every popular still image format in use, including but not limited to: SGI, Photoshop, BMP, PICT, JPEG, TIFF, TGA, and JPEG-2. Like video clips, you can mix still image files with differing frame sizes and pixel aspect ratios. When you create or modify an image in a graphics editor such as Photoshop, it’s a good idea to keep in mind the frame size and pixel aspect ratio of your project to ensure that the graphics you create are appropriate for your project. For more information, see “Video and File Formats” on page 941.

Chapter 2  Creating and Managing Projects
Using High Resolution Still Images
A common and effective use of still images in motion graphics work is the animation of high resolution files. The DPI of image files as defined in programs like Photoshop does not apply to video, as the dimensions of each imported still image are defined simply by the number of pixels. If the current dimensions of an image are larger than the frame size of your project, the image appears to be much larger, and by default it appears to be “zoomed in” to its maximum size. You can change the scale of the image to shrink it down to fit within the project’s frame size, but you can also animate the scale to zoom into or out of the image, or animate the image’s position to pan around within it, creating all kinds of motion-control effects.

Because Motion is graphics-card dependent, you may have different file-size import limitations. When importing an image that is too large, an alert sheet appears which states “This media is too large to render at full resolution, and will be shown at a lower quality.” Click OK to import the image at a lower quality. For more information, visit the Motion site at http://www.apple.com/Motion.

When importing large still images, you can set a preference that tells Motion to import the file at its original size, to change the resolution of the image to fit the Canvas size, or to scale the image down to fit the Canvas size.

To set the large still image import preference:
1. Choose Motion > Preferences ( or press Command+,,) .
2. In the Still Images & Objects group of the Project Preferences, choose a setting from the Large Stills pop-up menu.

Do Nothing: Imports the image at its original size.
In the following example, an 1146 x 756 image is imported into an NTSC D1 project (720 x 486) with Do Nothing selected in the Preferences. The image is much larger than the Canvas.

**Scale to Canvas Size:** Imports and scales the image to fit the project size while maintaining its aspect ratio.

In the following example, a 760 x 1150 JPEG image is imported into an NTSC D1 project with Scale to Canvas Size selected in the Preferences.
The image is scaled—the equivalent of using the Transform tool to scale down the image in the Canvas while pressing Shift. To observe that the image is merely transformed and has not changed resolution, select the image file in the Media tab of the Project pane, and then display the Media tab Inspector. The Fixed Width and Fixed Height parameters display the resolution of the original file.

The image is scaled to fit the largest X or Y value of the image to that of the Canvas. In the following example, a 1142 x 757 JPEG image is imported into an NTSC D1 project.

**Down-Res to Canvas Size:** This setting changes the resolution of the imported image so that the image fits the project size while maintaining its aspect ratio.
Note: The Down-Res to Canvas Size option is the best choice for optimizing your process time. When you use Scale to Canvas Size, Motion must calculate the scale at each frame.

In the following example, a 760 x 1141 JPEG image is imported into an NTSC D1 project with Down-Res to Canvas Size selected in the Preferences.

The image looks identical to an image that is scaled on import. However, its resolution has been changed so that the image fits the Canvas. To observe that the resolution of the image has changed, select the image file in the Media tab of the Project pane, and then display the Media tab Inspector. The Fixed Width and Fixed Height parameters display the new resolution of the imported image.
Still Image Duration
When you first import a still image into your project, it assumes a duration equal to the current duration of your project. Increasing the duration of your project does not automatically increase the duration of an image that's already been imported. Still images have infinite duration in Motion, so you can stretch them out in the Timeline to be as long as you need. For more information about working with objects in the Timeline, see “Using the Timeline” on page 273.

Image Sequences
Numbered image sequences store video clips as individual still image files. Each image file has a number in the filename that indicates where it fits into the sequence. In a film clip that's been digitally scanned, each file represents a single frame. In a video clip that's been converted to an image sequence, each file contains both fields of a single video frame, with the upper and lower lines of the image saved together. Image sequences use the same variety of file formats as still image files. Some of the most popular formats for saving image sequences are: SGI, BMP, JPEG, TIFF, and TGA. Like still image formats, many of these support alpha channels, which are automatically used by Motion.

Because image sequences have been around for so long (before QuickTime, they were the only way to store video on a computer), they remain the lowest-common-denominator file format for exchanging video across many different editing and compositing applications. While QuickTime is increasingly used to exchange video clips between platforms, image sequences are still in common use, especially in film compositing.

As with QuickTime video clips, you can mix image sequences of different formats, using different frame sizes, pixel aspect ratios, frame rates, and interlacing. For more information, see “Video and File Formats” on page 941.

Important: Any imported image sequence must contain three or more digits of padding, for example, imagename.0001.tif.

Collapsing Image Sequences
The “Show collapsed image sequences” button at the bottom of the File Browser allows you to display image sequences as a single object, rather than as the collection of individual files that exist on your disk. Image sequences that you import into your project in this way are treated as single objects everywhere they appear in your project.
**Note:** You can turn this feature off in case you have numbered image files that aren’t supposed to be used as an image sequence. For example, pictures taken with digital cameras often have numbered filenames that can be mistaken for an image sequence.

**Layered Photoshop Files**
You can also import layered Photoshop files. Many motion graphics professionals create layouts in Photoshop, where they paint and manipulate all the graphical elements they’ll use to create a static composition. Once that’s done, the resulting layered file can be imported into Motion to be animated, along with other imported and Motion-generated objects, to create the final project.

When importing Photoshop files, you can choose to import:
- All the layers merged together as a single object
- All layers as individual objects, nested together within a single layer
- An individual layer as a single object

When importing all layers as individual objects, Motion creates a new layer in the Layers tab and Timeline, and nests each layer of the Photoshop file as an individual object within that Motion layer. Each resulting object retains the position, opacity, and blend mode of the original Photoshop layer. Furthermore, Photoshop text layers are imported, but appear in Motion as non-editable bitmap graphics.

**Incompatible Effects**
The following Photoshop effects are not currently imported into Motion:
- Layer effects
- Layer masks
- Adjustment layers
- Paths
- Shapes

**Note:** Motion does not support Photoshop layer sets.

For more information on how to import layered Photoshop files, see “Adding Layered Photoshop Files to a Project” on page 177.

**PDF Files**
The PDF file format is a PostScript-based document format that accommodates PostScript-based graphics and text, as well as bitmap graphics. Areas of transparency within a PDF file are also transparent within Motion.

PDF files are capable of storing PostScript-based illustrations. Unlike graphics file formats such as TIFF and JPEG, which save images as a collection of pixels at a given resolution that are divided into Red, Green, and Blue channels, PostScript-based illustrations are saved as mathematical descriptions of how the artwork is drawn. As a result, PDF files using PostScript-based artwork and text have infinite resolution.
The practical difference between bitmap files and PostScript-based files is that scaling a bitmap beyond 100 percent results in the image progressively softening the more you increase its size. PostScript-based illustrations remain sharp and clear no matter how large or how small you scale them.

When importing a PDF file, its size is relative to the original page size of the file. As a result, even small graphics may have a large frame size, with a lot of empty space surrounding the graphic. When exporting a graphic as a PDF file for use in Motion, you may want to scale the graphic up to fit more closely within the page, or reduce the page size in the source application’s Page Preferences to more closely fit around the graphic.

**Fixing the Resolution of a PDF Object**

Although PDF files have unlimited resolution, large PDF objects can consume a lot of video memory, which could potentially limit Motion’s performance. To avoid this, you have the option of limiting the resolution of each PDF image used in your project in order to save video memory. By using the fixed resolution parameters, the files only need to be rendered once. This allows for faster performance.

If you decide to fix the resolution of a PDF file, the width and height values you assign should be equal to the largest scale at which you plan on using that object in your project. For example, you might add a PDF of a map to your project with the intent to scale it up to zoom into a particular country. To conserve video memory, you can set the Fixed Width and Fixed Height parameters to the maximum size of the zoomed in image. If at first you don’t assign enough resolution, the Fixed Width and Fixed Height parameters can be changed at any time.

The fixed resolution parameters for PDF objects can be adjusted in the Media tab of the Inspector. Select the PDF object in the Media tab of the Project pane to activate the Media tab of the Inspector.

**Fixed Resolution**: A checkbox that fixes the resolution of a PDF object in the Media tab to the size specified in the Fixed Width and Fixed Height parameters.

**Fixed Width**: A slider that sets the maximum horizontal resolution to which a PDF object can be smoothly scaled.

**Fixed Height**: A slider that sets the maximum vertical resolution to which a PDF object can be smoothly scaled.
Mixed Content Within PDF Files
Although PDF files can simultaneously contain PostScript-based art, PostScript text, and bitmapped graphics, all of these types of image data do not scale the same. PostScript-based art and text scale smoothly, but bitmapped graphics that are embedded in a PDF file are subject to the same scaling issues as any other bitmapped graphics format. As a result, they may soften if scaled larger than their original size.

Note: Form objects, buttons, and JavaScript objects that are present in an imported PDF file do not appear in Motion.

Multi-Page PDF Files
You can import multi-page PDF files. When you do, an additional parameter called Page Number appears in the Properties tab when the PDF object is selected. A slider appears and allows you to set which page is displayed in the Canvas. This parameter can be animated to display different pages over time.

Important: Multi-layered PDF files are not currently supported. To import a multi-layered illustration, export each layer as a separate PDF file, and import these as a nested group of objects within a single layer in Motion.
More About Alpha Channels

Ordinary video clips and image files have three channels of information, one each for the red, green, and blue channels. Many video and image file formats also support an alpha channel, which contains additional information that defines areas of transparency. An alpha channel is a grayscale channel, where white represents areas of 100 percent opacity (solid), gray regions represent partially opaque areas, and black represents 0 percent opacity (transparent).

When you import a QuickTime movie or an image file into your project, its alpha channel is immediately recognized by Motion. The alpha channel is then used to composite that object against any other objects that are behind it.

There are two different ways of embedding alpha channel information into files, and Motion attempts to automatically determine which type of alpha channel a particular object uses:

- **Straight**: Straight alpha channels are kept completely separate from the red, green, and blue channels of an image. Media files using straight alpha channels appear perfectly fine when used in a composition, but they may look odd when viewed in another application. Translucent effects such as volumetric lighting, or lens flares in a computer generated image, may appear distorted until the clip is used in a composition.

- **Premultiplied**: This type of alpha channel is multiplied with the clip's red, green, and blue channels. As a result, objects with premultiplied alpha channels always look correct, even with translucent lighting effects, because the entire image is precomposed against a solid color. Most commonly, premultiplied alpha channels are multiplied against black or white, but Motion can also resolve alpha channels that have been premultiplied against other colors.

The only time it really matters which kind of alpha channel an object has is when Motion doesn’t correctly determine it. If an object’s alpha channel has been set to Straight in the Media tab when it’s really premultiplied, it may appear fringed with the premultiplied color around its edges. If this happens, you can select the problematic clip in the Media tab of the Project pane, and change its Alpha Type parameter in the Media tab of the Inspector.

Audio Files

You can import different audio file formats into your project, including but not limited to: WAV, AIFF, .cdda, MP3, and AAC. Although Motion is not necessarily intended to be a full-featured audio editing and mixing environment such as GarageBand, Soundtrack Pro, or Logic, you can import music clips, dialogue, and sound effects to use in your projects. If you import a QuickTime file with mono or stereo tracks of audio, the video appears in the Timeline, while the audio appears in the Audio Editor.
From within Motion, you can select an audio file and open Soundtrack Pro to modify the audio file. Once saved in Soundtrack Pro, the file is automatically updated in Motion. For more information, see “Using Soundtrack Pro With Motion” on page 897.

You can freely import audio clips with different sample rates and bit depths. When you do, Motion resamples any audio tracks that need it to the sample rate and bit depth currently in use by your computer. The default is 16-bit, 44.1 kHz float for the built-in audio interface. If you use a third-party audio interface, audio is remixed to the sample rate and bit depth used by that device.

You can import audio files with sample rates up to 192 kHz, and with bit depths up to 32 bits. Mono and stereo files are supported. Multi-channel audio files are also supported.

Motion supports as many layers of audio as you want to use in the Audio Editor, although mixing many audio tracks together may affect playback performance. In the Audio Editor, you use the same tools and commands to edit audio objects as you use in the Timeline Layer list. Each audio layer also has individual settings for level and pan, so that you can mix a group of tracks together for stereo output.

For more information about file formats supported by Motion, see “Video and File Formats” on page 941. For more information on using audio in Motion, see “Working With Audio” on page 877.

A seamless way to browse for and import music from your iTunes library is to use the Music category in the Motion Library. For more information, see “Adding iTunes and iPhoto Files From the Library” on page 178.

Note: You cannot import rights-managed AAC files, such as those purchased from the iTunes Music Store.

Adding Media to Your Project

Once you've created a new project, the next step is to add media files to your composition. All media types—movie clips, still images, audio files, or other objects appearing in the Motion Library—are added to your project using the same methods.

Note: Layered Photoshop files have additional import options available from the drop menu. For more information, see “Adding Layered Photoshop Files to a Project” on page 177.

The Link Between Motion Objects and Media Files

Prior to learning how to add media to your Motion project, it’s important to understand the correspondence between objects and source media. Every time you add a file to your project, you create a link between the object you see in the Canvas and its corresponding media file on disk.
Unlike applications such as iMovie HD, where sections you remove from clips are also deleted from disk, Motion is a nondestructive application. This means that any changes you make to media objects in a Motion project aren’t actually applied to the media files they’re linked to.

Because of this link, whenever you add a file to your project, you need to make sure it remains available on your hard disk for as long as you’re working on that project. If you move, delete, or rename media files that correspond to objects in a Motion project, those objects become “offline.” Offline objects appear as checkered rectangles that occupy the entire bounding box of the object.

If this happens, it’s easy to reconnect the offline objects in your project with new copies of the media you lost, assuming those files are still available. For more information, see “Online vs. Offline Media” on page 181.

Selecting Files in the File Browser
You can add files to a project using either the File Browser or the Import command in the File menu. In most cases, the File Browser is more convenient, and gives you more control over how the resulting objects appear in your project.

Prior to adding files, you must first select them in the File Browser. You can add files to a project either individually or in groups.

To select files in the File Browser:
1. Open the File Browser.
2. Select one or more files by doing one of the following:
   • Click a single object.
   • Press Shift or Command, then click each object you want to select.
   • Press Shift or Command, then click any selected object to deselect it.
In list view, click to the left of any object's thumbnail, then drag up or down to select multiple consecutive objects.

In list view, press Shift and use the Up and Down Arrow keys to add objects to the current selection.

Adding Files to Your Project
The following procedures apply to adding every file type compatible with Motion.

Note: Although iTunes and iPhoto files can be added using the File Browser as described below, it is recommended that you use the Music and Photo categories within the Motion Library. Using the Library allows you to browse for files using the playlist or photo album features available within iTunes and iPhoto. For more information, see “Adding iTunes and iPhoto Files From the Library” on page 178.

To add one or more files to a project in a new layer:
1 If the Create Objects At setting in the Project pane of Motion Preferences is set to “Current frame,” move the playhead to the frame in the Timeline where you want the first frame of the file to start.

Note: If the Create Objects At setting is set to “Start of project,” this step is unnecessary as imported files are always placed at frame 1.

2 Select one or more objects in the File Browser.

3 Do one of the following:
   • Drag the selected files into the Canvas, placing them at any position.
   • Click the Import button to add the selected files to the center of the Canvas.
   • Drag the selected files into the blank bottom area of the Layers tab.
   • Drag the selected files into the blank bottom area of the Timeline.
   • Choose File > Import (or press Command+I), select one or more files in the Import Files dialog, then click Open.

A new layer is created at the top of the Layers tab, and all files appear as objects nested within it. Each new object’s start time in the Timeline is set to the position of the playhead in step 1.

To add one or more files to an existing layer:
1 If the Create Objects At setting in the Project pane of Motion Preferences is set to “Current frame,” move the playhead to the frame in the Timeline where you want the first frame of the file to start.

Note: If the Create Objects At setting is set to “Start of project,” this step is unnecessary as imported files are always placed at frame 1.

2 Open the File Browser and Layers tab.

3 Select one or more files in the File Browser.
4 To nest the selected files underneath an existing layer, do one of the following:

- Drag the selected files on top of any layer in the Layers tab.
  The objects appear at the top of the group of objects nested within that layer.
- Drag the selected files between any objects that are already nested in a layer.
  A position indicator shows the new position that the objects occupy when you release the mouse button.
- Drag the selected files into the Timeline, placing them between any objects that are already nested underneath an existing layer.

**Note:** For more information on editing objects into the Timeline, see "Using the Timeline" on page 273.

Once a file has been added to a project, it appears as an object in the Canvas, Timeline, Layers, and Media tabs. Each new object’s start time in the Timeline is set to the position of the playhead in step 1.

You can also add files to your project without having them appear in the composition by dragging a file directly into the Media tab. This allows you to add objects you might want to use in the future without actually placing them in your composition.

**To add one or more files to a project without using them in the composition:**

1 Open the Media tab.
2 Drag one or more files from the File Browser into the Media tab.
   The resulting objects don’t appear in the Canvas, Layers tab, or Timeline.

**Adding Layered Photoshop Files to a Project**

You can add a layered Photoshop file to your project by dragging it to the Canvas, Layers tab, or Timeline, using the Import button, or by using the Import command. Using the Import button (in the Preview area) results in all layers of the Photoshop file being collapsed into a single object, by default. To maintain the layers of the imported file as separate objects, you need to use the drop menu or the File > Import command.

**To control how a layered Photoshop file is added to your project using the drop menu:**

1 Drag a layered Photoshop file from the File Browser into the Canvas, Layers tab, or Timeline.
2 Before releasing the mouse button, pause until the Canvas drop menu appears.
   This menu presents different commands for importing the layered file.
3 Drag the file over the command you want in the drop menu, and when the menu item is highlighted, release the mouse button.
   The layers of the Photoshop file are added using the command you choose.
Import Merged Layers: All layers of the Photoshop file are collapsed into a single object.

Import All Layers: A new layer is created and nested within the currently selected layer. Each layer of the Photoshop file appears as an individual object nested within this layer.

You can also import individual layers from the Photoshop file. Each layer in the selected Photoshop file appears as a separate item in the drop menu. Selecting an individual layer adds only that particular layer to your project, where it appears as a single object.

Note: When a Photoshop file contains more layers than can be displayed in the drop menu, the Choose Layer option appears in the drop menu. Once Choose Layer is chosen, use the Pick Layer to Import dialog to select which layer to import.

To control how a layered Photoshop file is added to your project using the Import command:
1. Choose File > Import.
2. Select the file you want to import, then click Import.
   The Pick Layer to Import dialog appears.
3. Choose a command from the Layer Name pop-up menu.

- Merged Layers: All layers of the Photoshop file are collapsed into a single object.
- All Layers: A new layer is created and nested within the currently selected layer. Each layer of the Photoshop file appears as an individual object nested within this layer.
- Individual layers: Each layer in the selected Photoshop file appears as a separate item in the drop menu. Selecting an individual layer adds only that particular layer to your project, where it appears as a single object.

Adding iTunes and iPhoto Files From the Library
You can add files from your iTunes and iPhoto libraries to a project via the Motion Library. This is very convenient, as the iTunes library and playlists and iPhoto albums appear in the Library subcategories.

Note: Although a connected iPod appears in the File Browser as a hard disk, you can only browse for and import iPod files that are stored as data. Music transferred to the iPod via iTunes cannot be imported into Motion.

To add an audio file from iTunes:
1. In the Library, select the Music category.
   The iTunes library and playlists appear. By default, All is selected (the iTunes library).
2. With All selected or by selecting a playlist, select an audio file from the stack.
   Note: When displayed in list view, the Music category shows information created in iTunes, such as the Name, Artist, Album, Duration, and Size of the file.
3. Do one of the following:
   • In the Preview area, click Apply.
   • Drag the audio file to the Canvas, Project pane, or audio area of the Timeline (not the Audio Editor).

Note: Rights-protected AAC files cannot be imported into Motion and do not appear in the file stack. This includes all music purchased from the iTunes store.

For more information on working with audio files, see “Working With Audio” on page 877.

To add a file from iPhoto:
1. In the Library, select the Photos category.
   The iPhoto albums appear. By default, All is selected (the iPhoto library).
2. With All selected or by selecting an album, select a file from the stack.
   Note: When displayed in list view, the Photos category shows information created in iPhoto, such as the Name and Size of the file.
3. Do one of the following:
   • In the Preview area, click Apply.
   • Drag the file to the Canvas, Layers tab, or Timeline.

Note: When importing large-scale images into Motion, you have the option to import the files as is, to scale the images to the size of the Canvas, or to change the resolution of the image to fit the Canvas. For more information, see “Using High Resolution Still Images” on page 165.

Managing Objects in Your Project
When you add a file to your project, a corresponding object appears in the Canvas, Layers tab, and Timeline. Once added, you can duplicate any object in the Canvas, Layers tab, and Timeline to create as many copies as you need. Each copy you create has individual parameters in the Inspector, which gives you the freedom to individually modify and animate each duplicate object as necessary.

The Relationship Between Objects in the Layers and Media Tabs
Every file you add to your project creates a new corresponding object in the Media tab, even if it’s identical to other files you have already added. This means that if you drag the same file into your project five times from the File Browser, five corresponding objects are created in the Media tab.

On the other hand, if you duplicate an object that’s already in your project, a relationship is maintained between that instance of the object and the previously existing object in the Media tab. No new object is created.
You Only Need to Add Files From the File Browser Once

If you need more copies of an object in your project, either duplicate them directly in the Canvas using the Duplicate command, or drag an object from the Media tab to the Canvas or Timeline to create a new corresponding instance of that object.

By ensuring that all duplicates you make of an object have a relationship to the corresponding object in the Media tab, it becomes easier to manage them using the object’s Media tab parameters in the Inspector. These parameters define an object’s essential media properties, including the frame rate, pixel aspect ratio, interlacing, and alpha channel parameters. There are also additional parameters that allow you to define each object’s end condition, reversal, cropping, and timing. Each object’s parameters affect all instances of that object that have a relationship to the corresponding object in the Media tab, so changing an object’s parameters simultaneously updates every object in your project that corresponds to it.

For more information on each object’s Media tab parameters, see “Object Media Tab Parameters” on page 185.

Seeing the Relationships Between Objects

There are two object parameters where you can see the relationship between objects in the Layers tab and objects in the Media tab.

- The Media parameter appears in the Properties tab of the Inspector whenever you select an object in the Layers tab. The Media parameter is an image well that displays the source media in the Media tab to which the currently selected object corresponds.
- The Linked Objects list appears in the Media tab of the Inspector whenever you select an object in the Media tab. This list displays all objects in the Layers tab that correspond to the selected source media. Changing an object’s name in the Layers tab automatically updates the name that appears in the Linked Objects list.

Using the Reveal Source Media Command

A fast way to find any object’s source media in the Media tab is to use the Reveal Source Media command.

To reveal an object’s source media in the Media tab, do one of the following:

- Control-click an object in the Canvas, Layers tab, or Timeline, then choose Reveal Source Media from the shortcut menu.
- Select the object, then choose Object > Reveal Source Media (or press Shift+F).

The Inspector opens and displays the Media tab. At the same time, the Media tab in the Project pane opens. The source media is selected, and its Media tab parameters are exposed in the Inspector.
Online vs. Offline Media
As mentioned earlier, adding an object to a Motion project creates a link between the object in your project and its corresponding media file on disk. When you delete, move, or rename files on disk that are linked to objects in Motion, those files go offline, meaning that they’re temporarily unavailable to your project. This can also happen if you give someone a project file without also providing them with the source media it uses.

When you first open a project file with media that is unavailable, a Missing Items sheet appears listing all the media files that can’t be found. Assuming the media has been moved to another folder or disk instead of being deleted, you have the option to search every disk connected to your computer to find them. If you know the location of the missing media, you can display a manual reconnection sheet to navigate directly to the files without having to search.

To reconnect the media files in this list using Search:
1. Click Search.
   Motion attempts to automatically find the first missing file in the list. If it is found, a sheet appears with the missing media file selected.
2. Click Open to reconnect the media.
3. If a file has been renamed, you’ll have to find it manually. Navigate to the renamed file’s location, select it, then click Open.
   If more than one of the missing media files appears in the same folder, all files are automatically reconnected.
To cancel an active search:

1 Click Cancel.

The manual reconnection sheet is displayed.

2 In the sheet, navigate to the file's location, then click Open.

To reconnect the media files in this list using Reconnect:

1 Click Reconnect.

2 In the manual reconnection sheet, navigate to the file’s location, then click Open.

If an object in your project file is offline and you do not immediately reconnect it upon opening the project, it appears as a checkered rectangle that occupies the entire bounding box of the object.

If you do not immediately reconnect an offline object, you can still save changes to the project and even close it again, and reconnect the offline objects later. You can reconnect these offline objects at any time.

To reconnect an object in a project with its source media on disk:

1 Open the Media tab in the Project pane.

2 Select the offline object you want to reconnect.

3 Open the Inspector, then click the Media tab.
4 Click the Replace Media File button that appears underneath the Linked Objects parameter.

Motion attempts to automatically find the first missing file in the list. If it is found, a file sheet appears with the missing media file selected.

5 Click Open to reconnect it.

*Note:* You can also use the File > Reconnect Media command.

The offline object comes online, and the original graphic appears. If more than one missing media file appears in the same folder, all files are automatically reconnected.

---

### Deleting Objects From a Project

There are two ways you can delete an object in Motion. You can delete a single instance of an object from the composition by deleting it in the Layers tab, Timeline, or Canvas. This removes it from use, but leaves its source media in the Media tab untouched. If other instances of that object appear in your project, those are also left alone.

You can also delete the object that appears in the Media tab. Doing this also removes all corresponding instances of that object in your project.

**To delete one or more objects from a project:**

1 Select one or more objects by doing one of the following:
   - To delete a single object, select it in the Layers tab, the Timeline, or the Canvas.
   - To delete multiple objects, **Shift**-click the objects.

   *Note:* In the Layers tab or Timeline, you can **Command**-click to select non-contiguous objects.

2 To delete the selected objects, do one of the following:
   - Choose Edit > Delete.
   - Press Delete.

   The objects are deleted from your project, but their corresponding source media files on disk remain untouched.

**To delete all objects that correspond to a single object in the Media tab:**

1 Open the Media tab, then select the source media you want to delete.

2 Do one of the following:
   - Choose Edit > Delete.
   - Press the Delete key.

   A dialog appears and prompts you to confirm the deletion.

3 Click Delete.
Exchanging Media in a Project

You can exchange any object in your project with a different object in the File Browser or Library. This breaks that object’s original source file link and creates a new link to the file you’re exchanging. When you exchange an object’s source media, the object in your project retains all of its Property tab parameter values (including the Position, Scale, and Opacity parameters), selected blend mode, nested filters and behaviors, masks, and keyframes.

The exchange operation allows you to replace objects in your project even after you’ve modified and animated them. If you’re unhappy with a particular element of your composition, exchange it with a new one.

**Important:** You can only exchange objects that are linked to media files on disk. You cannot exchange Motion-generated objects such as particle systems, generators, or text objects.

This operation allows you to use temporary objects in your project until the finished object is available. For example, if you’re expecting artwork from another artist that’s not yet available, you can use a temporary graphic with the same dimensions, and then exchange it when the final artwork becomes available.

This operation is extremely useful for customizing projects created using templates. For more information, see “Customizing Projects Created With Templates” on page 211.

**Note:** You can only exchange individual objects in the Layers tab. It is not possible to exchange objects in the Media tab.

**To exchange an object in your project in the Layers tab:**

1. Drag an object from the File Browser onto an object in the Layers tab.
2. When the curved pointer appears, release the mouse button.

The original object in the Layers tab is replaced by the new object.
To replace an object in the Media tab:
1. Select the object you want to replace in the Media tab.
2. In the Inspector, click the Media tab.
3. Click Replace Media File.
4. In the “Choose replacement for” dialog, navigate to the file you want to use to replace
   the current source media.
5. Click Open.

The new object replaces the current object in the Media tab along with all instances of
the object in your project.

Object Media Tab Parameters
When you select an object in the Media tab of the Project pane, the Inspector displays
a Media tab that contains the properties defining how the object appears in Motion.
This includes parameters such as the type of alpha channel used, pixel aspect ratio,
field order, and so on. All of these parameters can be edited, which changes the way
that object is displayed and composited in your project.

While Motion makes an effort to correctly interpret how objects you add to your
project should appear, sometimes it isn’t possible to correctly identify how a source
media file should be treated. Make sure that each object you add to your project has
the correct settings in its Media tab so you can successfully mix and match objects with
different pixel aspect ratios, alpha channel types, and frame rates.

Since Motion is a nondestructive application, changes made to these parameters are
not applied to the source media files on disk. They simply affect how objects are drawn
within Motion.

Object Parameters in the Media Tab
The following parameters let you control the objects in the Media tab, which also
affects all the instances of the object in the project.

Alpha Type: An object’s alpha channel contains information that defines areas of
transparency in the image or movie. When you import a QuickTime movie or an image
file, its alpha channel is immediately recognized by Motion. There are six different ways
to embed alpha channel information into files, which correspond to the four options in
this pop-up menu. Motion automatically assigns one of these options based on an
analysis of the object when it is imported, but you can override this if necessary.

The six commands in this pop-up menu are:
• None/Ignore: The default setting for objects with no alpha channel. This option also
  allows you to ignore an object’s existing alpha channel, so that the entire object is
  solid.
• **Straight**: Straight alpha channels are kept completely separate from the red, green, and blue channels of an image. Media files using straight alpha channels appear perfectly fine when used in a composition, but they may look odd when viewed in another application. Translucent effects such as volumetric lighting or lens flares in a computer-generated image may appear distorted until the clip is used in a composition. If Straight is chosen, but you see a black, white, or colored fringe around the object, this parameter is incorrectly set and should be changed to one of the Premultiplied options, depending on the color of the fringe.

• **Premultiplied-Black**: This type of alpha channel is multiplied with the clip’s red, green, and blue channels. As a result, objects with premultiplied alpha channels always look correct, even with translucent lighting effects, because the entire image is precomposited against a solid color. This option interprets alpha channels that have been precomposited against black.

• **Premultiplied-White**: This option interprets alpha channels that have been precomposited against white.

• **Premultiplied-Color**: This option interprets files that have been precomposited against another color.

• **Guess Alpha Type**: This option forces Motion to analyze the file in an attempt to automatically figure out what kind of alpha channel it uses. If you’re unsure, use this setting.

**Note**: PDF files with transparent backgrounds do not have the Alpha Type or Invert Alpha parameters.

**Invert Alpha**: Ordinarily, an alpha channel is a grayscale channel, where white represents areas of 100 percent opacity (solid), gray regions represent partially opaque areas, and black represents 0 percent opacity (transparent). If an alpha channel has been incorrectly generated in reverse, this checkbox inverts it.

**Pixel Aspect Ratio**: Defines whether the object was created using square or nonsquare pixels. In general, objects created for computer display, film, and high-definition video use square pixels, while objects created for standard-definition video formats use nonsquare pixels. A text field to the right of this pop-up menu displays the numeric aspect ratio, in case you need to manually change the ratio. By correctly identifying each object you add to your project, you can mix and match both kinds of media.
Field Order: When importing interlaced video, choose the field order with which the clips were captured. This should match the field order of the device used for capture. The interlacing is either Upper (Odd) or Lower (Even). If you choose incorrectly, you’ll notice immediately upon playback that the video appears to “stutter,” because the order of fields is accidentally reversed. When this happens, simply choose the opposite field order setting in this pop-up menu. Clips that were shot using a progressive scan video camera or on film have no interlacing, and should be set to None. By correctly identifying each object in your project, you can freely mix and match clips with a different field order.

Frame Rate: Choose a frame rate in frames per second that matches the clip’s native rate. For example, film is 24 fps, PAL video is 25 fps, and NTSC video is 29.97 fps. Additional frame rates are available for different video formats. If the frame rate you require is not listed, you can type a number in the text field to the right of the pop-up menu.

Note: Project frame rates are determined by the project preset. To edit a preset or to create a new preset, choose Motion > Preferences and use the options in the Presets pane.

If you change a clip’s frame rate, you can choose From File at the bottom of the Frame Rate pop-up menu to change this parameter to the clip’s original frame rate.

Note: While you can freely mix clips using different frame rates, clips playing at a frame rate that’s different from that of the project may not play smoothly.

End Condition: Short movie objects can be looped to extend their duration by setting one of four end conditions in this pop-up menu.

Important: You must extend the object’s duration in the Timeline for the End Condition setting to have any effect.

• None: The default setting. The object’s duration in your project is equal to the duration of its source media file on disk.
• Loop: Allows you to extend the duration of a video object in the Timeline to any length. When the last frame of the media file on disk is reached, the clip loops back to the first frame and plays again. This can cause a jump in the clip’s apparent playback unless the clip was designed to be looped seamlessly.
• Ping-Pong: Allows you to extend the duration of a video object. When the last frame of the media file on disk is reached, the next iteration of clip playback is reversed. If you set a clip of a ball rolling on the floor to loop with the Ping-Pong option, it would appear to roll forward, then backward, then forward again for the duration of the object. This allows you to extend the duration of certain video clips more smoothly than with the Loop setting.
• Hold: This option doesn’t loop playback of the video object. Instead, the object’s duration is extended by freezing the last frame of the media file on disk for whatever duration you decide to extend the object by.
**Note:** For information on creating a freeze frame, see “Creating a Freeze or Hold Frame” on page 300.

**Reverse:** Reverses the playback of video objects.

**Crop:** A multidimensional parameter that defines a number of pixels to be cropped from each of an object’s four sides, relative to the outer edge of the bounding box that surrounds that object. Cropping an object in the Media tab also crops all instances of that object that appear in your project. A similar Crop parameter appearing for objects in the Layers tab allows you to individually crop each instance of that object. For more information, see “Parameters in the Properties Tab” on page 241.

**Timing:** The Timing parameters define an object’s duration, including the start and end points relative to the clip’s media file on disk, and its total duration in frames. Adjusting these parameters for an object in the Media tab defines the maximum duration available to each instance of that object in your project, limiting how much of that clip is available for use in the Timeline. This can be useful for trimming off frames that you know you never want to use to avoid accidentally trimming them back in. Also, trimming a clip here changes the effect that setting an End Condition has on a clip. Similar timing parameters for each instance of that object in the Layers tab allow you to individually set the duration and In and Out points of each instance of that object that appears in the Timeline.

- **Start:** Defines the starting frame of that object relative to the first frame of its media file on disk.
- **End:** Defines the ending frame of that object relative to the last frame of its media file on disk.
- **Duration:** Defines the total number of frames used by that object, as modified by the start and end points. Adjusting this value also changes the End parameter.

**Linked Objects:** This list displays all objects that appear in the Layers tab that have a relationship to that object. Two columns display the name of each layer containing an instance of the source media, along with the object’s name. Changing an object’s name in the Layers tab automatically updates the name that appears in the corresponding object’s Linked Objects list.

**Replace Media File button:** This button allows you to relink an object in your project to another source file on disk. This feature is primarily useful for relinking offline objects, but it can also be used to substitute the media used by an object in your project with other media. It also lets you replace one object with another, along with all instances of that object in your project.

**Summary:** A separate pane that lists the properties of the media file on disk that’s linked to the selected object.
Using Media in the Library

Motion ships with a collection of media and effects objects that you can use in your projects. The Library shares many controls and window panes with the File Browser. Both tabs are designed for the navigation of media that you want to add to your project. In general, all the controls work identically to those found in the File Browser, but the organization of listed media is different.

The Library Sidebar is replaced by a two-column pane. The left column displays all the categories of media and effects that are available in the Library. When you select a category, subcategories appear in the right column. Selecting a subcategory displays all the media or effects objects within the subcategory in the Library stack below.

The next sections describe the available categories in the Library.

Behaviors and Filters

Behaviors and filters are applied directly to objects that have already been added to your project. They do not exist on their own. Instead, they must be attached to an object or layer to have an effect. Both behaviors and filters can be customized after they’ve been added to a project, and customized versions can be stored in the Library for future use.

For more information about behaviors, see “Using Behaviors” on page 317. For more information about filters, see “Using Filters” on page 701.

Third-Party Filters

If you’ve installed third-party filters on your computer, they appear in this category, ready for use.

Generators

Generators are user-customizable computer-generated objects that can be used to create a variety of graphic elements. When you add a generator to your project, it automatically adapts to the frame size and frame rate of the project. Generators also have infinite duration, so they can play as long as necessary.
Generators have all the property parameters belonging to other objects. Properties specific to each generator also appear in the Generator tab of the Inspector whenever a generator is selected. You can also save customized versions of generators in the Library for future use.

For more information about the generators available in Motion, see “Working With Generators” on page 795.

**Particle Emitters**
Several categories of pre-made particle emitters let you quickly add effects ranging from simulations of smoke, fire, and explosives, to animated abstract textures that you can use in different ways. All of Motion's pre-made particle systems can be customized once you add them to your project.

For more information about using particle systems, see “Working With Particles” on page 565.

**Replicators**
Several categories of pre-made replicators let you quickly add background, transitional, or other types of animated patterns. All of Motion's pre-made replicators can be customized once you add them to your project.

For more information about using the replicator, see “Using the Replicator” on page 621.

**Shapes**
This category contains pre-made shapes that you can use either as visual elements or as image masks. Each shape is a Bezier shape, and can be further customized using Motion's shape editing tools. For more information about editing shapes and masks, see “Using Shapes and Masks” on page 819.

**Gradients**
The Gradients category contains gradient presets that you can use in the Gradient Editor found in particle system emitters and cells, as well as in text objects and shapes. Motion comes with a collection of gradient presets, but you can also save your own custom gradients created with any gradient editor.

**Fonts and LiveFonts**
Fonts and LiveFonts that are installed on your computer appear in these categories. Fonts are organized into subcategories based on the categories of fonts you define in the Font Book application. For more information about Font Book, see Mac Help in the Finder Help menu.
You can use the font categories to preview the fonts that are available on your computer. You can also drag fonts and LiveFonts onto text objects to change the typeface they use. For more information about using fonts with text objects, see “Using the Library Font Browser” on page 464.

**Text Styles**
Text styles are presets that can be applied to text objects in your project to instantly change their style parameters. These style parameters include face, outline, glow, and drop shadow parameters. Dragging a text style onto a text object instantly applies that style to the text.

For more information on text styles, see “Editing Text Style” on page 478.

**Music and Photos**
These categories allow you to browse for and import audio files directly from your iTunes library and image files directly from your iPhoto library. The Music subcategories that appear in the Motion Library are playlists created in iTunes. The Photos subcategories are albums created in iPhoto. The contents of each library, album, or playlist appear in the file stack.

For more information on importing iPhoto or iTunes files, see “Adding iTunes and iPhoto Files From the Library” on page 178.

**Content**
Motion ships with a collection of pre-made graphics and Motion-generated objects that appear in the Content category. These objects are used in the particle emitter presets and templates that are included with Motion. Most of the subcategories in this section are collections of objects used to make the templates included with Motion. The one exception is the Particle Images subcategory, which comprises particle cell sources used to generate the particle emitter presets included with Motion.

By default, the content files that ship with Motion are stored in the `Users/Shared/Motion/Library/Content` folder when you install Motion. During installation, you can select an alternate location to install the Motion content. Custom Motion-generated objects that you place into the Library are saved in the `Home/Library/Application Support/Motion/Library/Content` folder.

**Note:** Dragging a media object into the Content category leaves its corresponding file on disk in its original location. For this reason, it's recommended you centralize all media you plan on importing into the Library for future use into a dedicated and predictable location on disk, to prevent accidentally moving, renaming, or deleting those files.
Favorites and the Favorites Menu

It's easy to customize the behaviors, filters, particle systems, gradients, and generators used in Motion to create your own effects. These customized objects are saved into their corresponding categories. The Favorites category provides a place to put objects—built-in or custom-made—that you frequently use. You can also place frequently used media files into the Favorites, such as PDF or TIFF files. Objects you put in the Favorites category are available to every project you create in Motion.

Objects you place in the Favorites Menu folder appear in the Favorites menu, for even faster access. When you choose an item from the Favorites menu, that item is placed into the currently selected layer, positioned at the center of the Canvas. Objects you put in the Favorites Menu are available to every project in Motion.

Whenever you drag an object into the Favorites or Favorites Menu, that object appears both in the Favorites category and in the corresponding object category to which it belongs. For example, placing a particle emitter into the Favorites category also puts that emitter into the Particle Emitters category. Favorites filters also appear in the Filters category, shapes also appear in the Shapes category, and so on.

Objects that are dragged into the Favorites and Favorites Menu categories are saved into the `Home/Library/Application Support/Motion/Library/Favorites` and `/Favorites Menu` directories, respectively.

Note: Objects placed into subcategories that correspond to a folder in the `Users/Shared/Motion/Library/Favorites` folder are shared among all user accounts on that computer.

Adding Your Own Content to the Library

You can add your own customized versions of generators, filters, behaviors, and gradients to categories in the Library. Furthermore, if you work on one or more programs that frequently recycle the same graphics elements, or if you have a library of graphics that you use regularly, you can add these media files to the Favorites category. Content you put into the Library is available to every project in Motion.

To add Motion-generated objects to a Content category:

- Drag an object to the Favorites folder in the Library Category list or subcategory list, or directly into the Library stack.

Important: Each category except the Favorites and Favorites Menu is filtered by the type of object it represents. For example, you can place a user-customized filter in the Filters category, but you cannot put a filter into the Behaviors category.

You can also place media from disk into the Favorites category.
To add a media object to the Favorites category:
- Drag a media object from the Layers or Media tab, or from the File Browser, into the Favorites folder in the Library.

When adding your own content, you can create additional folders to add subcategories that appear in the subcategory column.

To create a new subcategory within any category:
1. Open the Library and select a category.
2. Click the New Folder button (+) at the bottom of the Library.
3. Rename the new folder to suit your needs.

This new folder appears in the subcategory column whenever that category is selected.

To remove objects or folders from a Content category:
- Select an object or folder in the Library stack, then do one of the following:
  - Choose Edit > Delete.
  - Press Command+Delete.

When Library Media Becomes Unavailable
As with any other object used in a Motion project, Library media used by a project must be present and installed on the current computer for those objects to appear correctly in Motion. If someone gives you a project file and you don’t have the same filters, fonts, or LiveFonts that they do, a warning appears when you open the project that lists the items that are unavailable.

You can either close the project and install the necessary files on your computer, or go ahead and open the file. The following list outlines what happens when you open a project file without having the necessary media:

**Missing Content:** Missing content is treated like any other missing media object. The objects go offline, and you have the option to reconnect them at any time.

**Missing Filters:** When one or more filters are missing, objects in your project that use those filters appear with a placeholder that shows which filter is missing. This gives you the opportunity to reinstall the filter at a later point.

**Missing Fonts:** When fonts are missing, the text objects that use those fonts default to Geneva as a temporary substitute. Missing international fonts substitute the default system font for that language.

**Missing LiveFonts:** When LiveFonts are missing, the previously used LiveFont is replaced by another LiveFont installed on your computer.
Organizing Layers and Objects in Motion

Motion projects are made up of a hierarchy of layers and objects. Understanding how to manage this hierarchy is central to learning how to assemble a new project.

Objects are the smallest unit of media in Motion. Each QuickTime file and graphics file you use in a Motion project is represented by an object in the Canvas, Layers and Media tabs, and Timeline.

Objects are always nested inside layers. Nesting is an extremely important concept in Motion. Nesting refers to the process of placing one object or layer inside another. Objects or layers that are nested inside other layers appear indented in the Layers list in the Layers tab and the Timeline Layer list.
Any layer can contain multiple objects nested inside it. A layer can also contain other layers nested inside it. In this way, you can construct complex hierarchies of nested layers and objects, with each nested group of objects subordinate to the layer that contains it, and that nested layer subordinate to the layer that contains it, up until the topmost layer.

One of the goals of organizing the objects and layers in a project is to group objects that you want to work together as a unit. This is because animation and effects that are applied to the topmost layer in a hierarchy of layers and objects also affect all objects nested within that hierarchy. By nesting a group of objects that you want to animate together inside a single layer, you can save time by animating just the enclosing layer, instead of animating each object individually.

For example, when you select a layer that has three objects nested within it, the entire group of objects is selected as a single unit.
Moving the selection in the Canvas moves all three objects simultaneously.

Regardless of how they’re nested, individual objects can always be animated independently. Subordinate layers can also be animated independently, although such animation and effects also affect all objects or layers that are nested underneath.

The following example shows how you might create a hierarchy of layers and objects to prepare for the animation of a human figure. Each component of the figure is a separate graphics object. For example, the arm is made up of hand, forearm, and upper arm objects. Each object that is connected to another object is placed in a layer that’s nested inside that object’s layer. For the arm, the hand is nested inside the forearm’s layer, which is nested inside the upper arm’s layer.
Note: In this example, each object’s anchor point has been moved to the appropriate axis of rotation for that object. For more information about changing an object’s anchor point, see “Changing an Object’s Anchor Point” on page 234.

Both arms and both legs are also made up of a hierarchy of nested body parts. It then follows that these nested groups of objects, which connect to the torso, are themselves nested inside the Mannequin layer. When you collapse the arm and leg hierarchies, you can see the following simplified hierarchy.

![Grouping objects to simplify a project](image)

Chapter 2  Creating and Managing Projects
With all of these objects organized this way, animating the figure becomes easy. For example, if you want to move the entire arm at once, you only need to select the Left Arm layer, regardless of how many objects are nested within it.

Selecting the Left Arm layer selects all objects within it.

Then, rotate the selection in the Canvas. Every object nested within that layer rotates as a single item.
Another example of how you might make use of the object/layer hierarchy can be seen through the application of filters and behaviors. If you apply a filter to a single object within a layer, it affects only that object. All other objects within the layer remain unaffected.

However, if you apply the same filter directly to the layer, all objects that are nested within that layer are affected by the filter, as if they were a single object.

**The Background of Your Project**

Two parameters in the Project Properties dialog affect the background color, and how it appears when it’s exported out of Motion.

**Background Color:** The color that appears in the Canvas if no other graphic or QuickTime object is present. If the Background Opacity is set to 0 percent and you export your project with a premultiplied alpha channel, the color you select here is the color the alpha channel is premultiplied with.
Note: If you intend to export your project with a premultiplied alpha channel, be aware that most alpha channels are rendered against either white or black.

Background Opacity: A slider that adjusts the opacity of the background. Setting this value to 100 percent makes the background completely solid—no transparency appears in the resulting image when it is exported. Setting this value to 0 renders the background completely transparent when the project is exported with an alpha channel.

Selecting Objects and Layers in the Layers Tab
In order to reorganize objects and layers in a project, you must first select which ones you want to move. This section covers the many methods you can use to select objects in the Layers tab.

To select a single object or layer:
- Click an object in the Layers tab.
  This deselects all other selected objects.
  Note: Selecting a layer does not also select the objects nested underneath it. However, operations performed on a selected layer also affect objects nested within it.

To select multiple contiguous objects or layers, do one of the following:
- Shift-click any two objects in the Layers list.
  This selects both objects, and also all objects in between.
- Click to the left of any object's thumbnail icon and drag up or down to select multiple objects.

To select or deselect multiple noncontiguous objects or layers, do one of the following:
- Command-click any unselected object to add it to the selection.
- Command-click any selected object to deselect it.

To select all objects or layers in the Layers tab, do one of the following:
- Choose Edit > Select All (or press Command+A).
- Click the first object in the list, then Shift-click the last object in the list.

To deselect all objects or layers in the Layers tab:
- Choose Edit > Deselect All (or press Shift+Command+A).

Reorganizing Objects in the Layers Tab
The order in which objects and layers appear in the Layers tab helps to determine the layout of your entire project. The order of objects and layers determines which objects appear to be in front, and which are in back. You can change the ordering of one or more objects in the Canvas, or you can change the ordering of nested groups of objects or layers in the Layers tab.
To move an object up or down within a layer:

1. In the Layers list, click anywhere on the object or layer row, and hold the mouse button down.

2. Drag the object or layer up or down in the list.

   A position indicator appears to show the new position the selection occupies when you release the mouse button.

   Note: You can also use the Bring and Send commands in the Object menu to move objects up and down in the nested hierarchy within any layer. This is especially useful when working with selected objects directly in the Canvas. For more information, see “Layer Arrangement Commands in the Object Menu” on page 219.

If you want to organize the objects in your project into multiple layers, you can create new, empty layers at any time.

To create a new, empty layer, do one of the following:

- Click the New Layer button (+) at the top of the Layers tab.
- Choose Object > New Layer (or press Shift+Command+N).

New layers always appear at the top of the Layers tab, and are numbered incrementally based on the number of layers you've created so far.

When you have more than one layer, you can move objects back and forth between them, changing their nested relationship in your project.

To move an object from one layer to another:

1. Select one or more objects.

2. Do one of the following:
   - Drag the selected objects to a new position underneath another layer.
     A position indicator appears to show the new position the selection occupies when you release the mouse button. If you drag the selected objects within a nested layer, the length of the position indicator shows which position the selection occupies within the layer hierarchy.
   - Select one or more objects, choose Edit > Cut (or press Command+X), then select the layer you want to paste it into, and choose Edit > Paste (or press Command+V).

You can also copy an object from one layer to another.

To copy an object from one layer to another, do one of the following:

- Option-drag one or more selected objects from one layer to another.
- Select one or more objects, choose Edit > Copy (or press Command+C), then select the layer you want to paste it into, and choose Edit > Paste (or press Command+V).
Nesting Layers Inside Other Layers

In addition to nesting objects inside layers, you can also nest layers inside other layers. You might do this if you’re creating an object hierarchy to control the relationship of one group of objects to another, or if you’re grouping layers to which you want to apply a single set of behaviors and filters.

Nesting a layer works the same as nesting an object.

To move a layer inside another layer:
1 Select one or more layers.
2 Do one of the following:
   • Drag the selected layers onto another layer.
   • Drag the selected layers to a new position underneath another layer.
   • Select one or more layers, choose Edit > Cut (or press Command+X), then select the layer you want to paste it into, and choose Edit > Paste (or press Command+V).

Grouping and Ungrouping Objects

You can also nest objects together within a new layer using the Group command. You can group objects that appear within the same layer, or you can group layers that are all nested at the same level relative to the hierarchy of your project. You cannot group layers that appear at different levels.

To group selected objects together, nesting them in a new layer:
1 Select all the objects or layers that you want to group together.
2 Choose Object > Group (or press Shift+Command+G).

A new layer is created, which is numbered incrementally based on the number of layers you’ve created so far. The objects or layers you selected are nested within it.

Groups of nested objects or layers can also be ungrouped, which deletes the containing layer and moves all objects and layers within it up the layer hierarchy.
To ungroup nested objects:
1 Select the layer containing the nested objects or layers you want to ungroup.
2 Choose Object > Ungroup (or press Option+Command+G).

Note: You cannot ungroup layers that are already at the top of the Layers list hierarchy.

Showing and Hiding Layers and Objects
Objects and layers appearing in the Layers tab can be hidden in order to make them invisible in the Canvas without removing them from your composition. For example, if you’ve placed a large object into your project and it’s in the way of some other objects you want to move or rotate, you can simply hide it. You can also hide objects you’re not sure you want to keep in your project, while preserving their placement in case you want to use them later.

If you hide a layer, you also hide all objects and layers that are nested within it. Hidden objects and layers are not rendered when your project is exported.

To show or hide one or more selected objects, do one of the following:
- Click the checkbox to the left of a single object or layer in the Layers tab or Timeline.
- Choose Object > Active (or press Control+T) to toggle the objects on or off.
- Control-click an object or layer, then choose Active from the shortcut menu.
Note: If you hide one or more objects within a layer, the enclosing layer’s Activation checkbox shows a dash, instead of a checkmark, to show that its objects are only partially visible.

You can "solo" an object or layer in order to hide all other objects in the project. This can be useful when you want to isolate a single object in the Canvas to animate or manipulate without interfering with other objects in your composition.

To solo a layer:
1 Select one or more objects or layers to solo.
2 Choose Object > Solo (or press Control+S).

Note: You can also Control-click an object in the Layers tab, then choose Solo from the shortcut menu.

All other objects or layers are deactivated. When the selected item is soloed, the menu item has a checkmark beside it.

Fixing the Size of a Layer
By default, the size of a layer is determined by the objects within that layer. Since animated objects often grow in size, a layer can become quite large. In the Layer tab of the Inspector, you can constrain the size of the layer to a certain width and height.
The project shown in the following image contains a particle system. Notice that the animated particles, although not visible once they move off the Canvas, make the layer very large.

When you want to apply filters to objects that are growing in size, it is recommended to apply those filters to the objects' enclosing layer. When filters are applied to very large layers, or large layers are used as the source object for other objects, processing time is slowed. You can crop the size of a layer that contains growing objects using the Fixed Resolution parameter, located in the Layer tab of the Inspector.
**Note:** The Layer tab (that contains the Fixed Resolution parameter) is only accessible when a layer is selected in the project.

When Fixed Resolution is turned on, objects that are in the layer but are outside of the Canvas are cropped to the size of the layer defined in the parameter.

When enabled, the Fixed Resolution parameter crops the layer to the size specified in the Fixed Width and Fixed Height parameters around the anchor point of the layer. This means that if the layer’s anchor point is offset, the cropping may not occur around the edges of the Canvas, and objects may become cut off.

To set the resolution of a layer:
1. In the Layers tab (or the Timeline Layer list), select the layer.
2. In the Inspector (press **Command+3**), click the Layer tab.
3. Turn on the Fixed Resolution checkbox.

By default, the layer’s resolution is set to the project size.

4. To define a resolution other than the project, adjust the Fixed Width and Fixed Height parameters.

*Note:* When an object within a fixed resolution layer is selected, the bounding box around the object appears at its original size, unaffected by the containing layer’s resolution.

**Locking Layers and Objects**

Once you’ve finished making adjustments to a particular object or layer, you can lock it to prevent accidental modification. Locked objects cannot be moved, and their parameters cannot be altered or animated. Animation and behaviors that were applied to the object prior to being locked still play. Locking a layer also locks all objects and layers nested within it.

To lock objects or layers, do one of the following:

- Click the object’s lock icon in the Layers tab.

- Select one or more objects or layers, then choose Object > Lock (or press `Control+L`).
The locked object’s bounding box in the Canvas turns red to indicate that it’s locked.

Collapsing and Uncollapsing Layer Hierarchies

Layers and objects in the Layers tab appear in a hierarchy that shows which objects are nested inside which layers. Nested objects and layers appear underneath and indented to the right of the layer they’re nested within.

To make the Layers list easier to manage, you can collapse all objects that appear nested within a single layer using that layer’s disclosure triangle. Collapsed layers appear as a single line in the list, and can be moved or nested like any other object. Each layer’s thumbnail displays a preview of the entire composite within, making it easy to see what’s nested inside.

To open or collapse a single layer, do one of the following:

- Click the disclosure triangle to the left of that layer’s name and icon.
- Press the Up and Down Arrow keys to navigate up and down the Layers list, then press the Right Arrow key to open a layer, or the Left Arrow key to collapse it.

Renaming Layers

You can rename the layers and objects that appear in the Layers tab to further organize your media and make each layer and object’s purpose easier to identify. When you rename an object, the original name of the source media file on disk remains unchanged. Also, changing an object’s name in the Layers tab does not change the name of its corresponding object in the Media tab. You cannot change the name of an object in the Media tab.
To rename a layer or object:
1  Double-click the name of the layer or object you want to rename.
2  When the name is highlighted, type a new name.
3  When you're finished, press Return to accept the new name.
   The new name is also automatically accepted when you click another object or layer.

**Note:** Once you change an object's name in Motion, there is no automatic way to change it back to what it was originally except for the undo command.

### Searching for Layers and Objects
If it's difficult to find a single object or layer in a large project, you can use the Search field at the top of the Layers, Media, and Audio tabs. It is similar to the Search field in the File Browser, and allows you to search for all objects or layers with a name containing the search term you enter.

**To find a layer or object by name in the Layers tab:**
- Type a search term in the Search field.
  
  As soon as you begin typing, all objects and layers with names that don’t contain the search term anywhere within are hidden from view, leaving only a list of objects and layers that match.

**To clear the search results:**
- Click the Clear button at the far right of the Search field to restore the full contents of the Layers, Media, or Audio tab.

**Note:** Layers and objects that are hidden as the result of a search operation are not disabled in the Canvas, and they are not prevented from rendering during export.

In addition to searching for objects by name, you can find any object’s source media in the Media tab using the Reveal Source Media command.

**To reveal an object’s source media in the Media tab, do one of the following:**
- Control-click an object in the Canvas, Layers tab, or Timeline, then choose Reveal Source Media from the shortcut menu.
- Select the object, then choose Object > Reveal Source Media (or press Shift+F).
  
  The Media tab and Inspector both open. The “master” object is selected, and its Media tab parameters are exposed in the Inspector.
Sorting Layers and Objects in the Media Tab
The Media tab contains 13 columns that provide information about each object in your project.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Displays a thumbnail of the media object.</td>
</tr>
<tr>
<td>Name</td>
<td>The filename of the source media on disk that the object is linked to. If you change the name of corresponding linked objects in the Layers tab, this name doesn't change.</td>
</tr>
<tr>
<td>Kind</td>
<td>The type of file, whether it's a still image, QuickTime movie, image sequence, or audio file</td>
</tr>
<tr>
<td>Duration</td>
<td>The total duration of the object, in frames or timecode, depending on which is displayed in the Timeline</td>
</tr>
<tr>
<td>Frame Size</td>
<td>The frame size of the object, in pixels</td>
</tr>
<tr>
<td>Compressor</td>
<td>If the item is a QuickTime movie, the codec used. If it's a still image, the method of compression that's applied based on the file type</td>
</tr>
<tr>
<td>Depth</td>
<td>The color depth of the image</td>
</tr>
<tr>
<td>Vid Rate</td>
<td>The frame rate of the object, in frames per second</td>
</tr>
<tr>
<td>Data Rate</td>
<td>The data rate at which a QuickTime movie is compressed</td>
</tr>
<tr>
<td>Aud Rate</td>
<td>For audio files and QuickTime movies, the sample rate of the audio</td>
</tr>
<tr>
<td>Aud Format</td>
<td>For audio files and QuickTime movies, the bit depth of the audio</td>
</tr>
<tr>
<td>File Size</td>
<td>The size of the source media file on disk</td>
</tr>
<tr>
<td>File Created</td>
<td>The file creation date of the source media file on disk. This is a useful parameter to use for file management.</td>
</tr>
<tr>
<td>File Modified</td>
<td>The file modification date of the source media file on disk.</td>
</tr>
</tbody>
</table>

You can customize the Media tab to show, hide, or rearrange any of these columns to suit your needs. You can also resize the thumbnails displayed for each object.
To show or hide a column:
- Click the Show Columns button (>), then check or uncheck the columns you want to show or hide in the pop-up menu.

To move a column to the right or left:
- Drag any column header to the right or left to move it.

To increase or decrease the size of each object’s thumbnail, do one of the following:
- Use the scale slider at the bottom of the Media tab.
- Drag the separator between the rows of objects.

Customizing and Creating New Templates

Motion comes with a collection of templates that are ready for you to customize for your own use. In addition, it’s also easy to create your own templates.

Customizing Projects Created With Templates

When you first create a new project file from a template, it’s an exact duplicate of the original template. There’s nothing special about template-based projects, and they can be edited and modified just like any other project. There are a few specific methods you’ll probably use to customize template-based projects for your use.

Keep in mind that most templates, especially ones you create yourself, are intended to simplify the process of creating titles and graphics for recurring projects. Examples include titles and lower thirds for news and interview programs, graphics for magazine shows, and any repeating program that requires titles with a consistent look that must be updated from show to show. Well-designed templates allow you to simply exchange key graphics objects and edit the text to update them for the next show in the series.

Changes you make to new projects created from templates have no effect on the original templates.
Exchanging Objects

The easiest way to customize a template-based project is to exchange the objects used in the template with your own objects, either from the File Browser or the Library. When you exchange an object, the new object appears in your project with the same parameter values used by the previous object. In addition, any filters, masks, behaviors, or keyframed parameters that were applied to the original object remain applied to the exchanged object.

Although there are several layers named Replace Here in various templates, the objects within the layers should be replaced—not the layers themselves.

Note: To quickly find all objects to be replaced in a template, type “replace” in the Layers tab Search field and press Return. The Replace objects are displayed in the Layers tab.

For more information about exchanging objects, see “Exchanging Media in a Project” on page 184.

Customizing Text Objects

Text objects can be easily updated using the Text tool. Editing a text object does nothing to change the format, style, or layout of the text. Furthermore, simple edits made to text objects have no effect on filters, masks, behaviors, or keyframed parameters that are applied to that object.

For more information on editing text objects, see “Working With Text” on page 457.

Modifying Behaviors and Keyframes

Objects in template-based projects are animated using a combination of behaviors and keyframed parameters. These can be edited at any time to customize the motion of the objects. For more information on modifying behaviors, see “Customizing Behaviors” on page 329. For more information on modifying keyframes, see “Modifying Keyframes” on page 433.

Using Objects, Behaviors, and Keyframes From Templates

Occasionally, you may find that you want to use a keyframed parameter or behavior from a template in a project of your own. You can always create a new template-based project, select the keyframes or behaviors you want to use, copy them, and paste them into your own project.

All the graphics objects used by the templates also appear in the Content category of the Library, within the Template Media subcategory. If there’s a particular graphic you want to use, you can find it in the Library.
Creating New Templates
In addition to using and customizing the templates that ship with Motion, you can also build your own templates from scratch. Template files contain everything that ordinary projects do, including media objects, text objects, shapes, generators, behaviors, and filters, in any combination.

You can create custom templates for commonly used shots that you regularly create. For example, if you make titles for a news program, you can create templates for the opening title, interstitial graphics, bumpers, and whatever other repetitious shots you regularly create. Once saved as a template, you can quickly load the necessary template and, instead of having to create a new title from scratch, simply customize it with new dates, title text, and exchanged graphics and movies to reflect the requirements of each new program.

Templates are simply Motion files that are saved in a special way. To create a new template, create the layout you need just like with any other Motion project. In preparation for using the layout as a template, you should keep the following things in mind:

Give some thought to naming objects in the Layers list
The names you give to the layers and objects in your template should indicate each object’s function. For example, you might name the text objects in a titling template “Main Title,” “Starring,” “Guest Star,” and so on. If you use visual elements in the template’s composition, describe their purpose, such as “Background Texture,” “Divider,” “Main Title Background,” and so on. This way, when someone else wants to customize your template, it’s easy to see what they’re supposed to do with it.

Create multiple projects for each resolution you require
If you regularly create projects for a variety of formats, it saves time to create a version of your project for each resolution you need in advance. When you save the project as a template, you can specify its format to help you browse for it later.

Consolidate the media you are using
Unless you selected an alternate installation location when you installed Motion, the built-in templates are stored in the /Users/Shared/Motion/Templates folder. Customized templates are saved into the Home/Library/Application Support/Motion/Templates folder, but any media used by that template remains in its original location on disk. If you move, rename, or delete any media file used by a template, that object goes offline in all projects created with that template.

To avoid this, it is recommended that you move all media files you plan on using to a central folder on disk prior to importing them into the project file you’ll be saving as a template. This helps to ensure that those media files are not lost.
Tip: If you plan to share custom templates with other users, it is recommended that you copy your custom templates folder to that computer’s Home/Library/Application Support/Motion/ folder.

Note: In the General section of the Motion Preferences (press Command+,), you can direct Motion to the folder on your system or network that contains the content and templates. This also allows multiple users on a network to share a single, centralized folder.

To save a project as a template:
1 Choose File > Save as Template.
2 When the save sheet appears, type a name for the template.
3 In the Collection pop-up menu, choose a collection in which to store your template.
   Note: You cannot save into one of the system collections.
4 If you want to create a new collection to add your new template to, click New Collection, then type a name in the New Collection dialog, then click Create.
5 Choose the format that your template conforms to from the Format pop-up menu.
6 If you want your template to play a preview when it appears in the Template Browser, turn on Create QuickTime Preview.
7 Click Save.

Your new template is saved into the collection you selected. Customized templates are saved into Home/Library/Application Support/Motion/Templates, in a folder that corresponds to the name of the collection you’ve selected.

Note: Unless you selected an alternate installation location when you first installed Motion, the templates that shipped with Motion appear in the Users/Shared/Motion/Templates folder by default.

Organizing Templates in the Template Browser
You can use the Template Browser to select and organize your templates, if necessary. All templates are organized into categories. You can add, delete, and rename categories directly in the Template Browser.

To add a category in the Template Browser:
1 Choose File > Open Template.
2 Click New Collection.
3 Enter a name for the collection into the sheet at the top of the Template Browser.
4 Click Create.

The new category appears in the Collection column at the left.
To delete a category in the Template Browser:
1 Choose File > Open Template.
2 Select a category in the Collection column.
3 Press Delete.
   An alert message appears and prompts you to confirm the deletion.
4 Click Delete in the sheet.
   The directory on your disk corresponding to that category is placed in the Trash, but not deleted. Any template files in that category’s directory are also placed in the Trash.

To rename a category:
1 Choose File > Open Template.
2 Select a category.
3 Click the category’s name.
4 When the name is selected, enter a new name, then press Return.
   Both that category, and its corresponding folder on disk, are renamed.

To delete individual templates from the Template Browser:
1 Choose File > Open Template.
2 Select a template.
3 Press Delete.
   A sheet drops down and prompts you to confirm the deletion.
4 Click Delete in the sheet.
Basic Compositing

The most fundamental part of compositing involves arranging the visual elements in your composition by moving, rotating, scaling, and adjusting the transparency of each object in your project.

Compositing is the process of combining at least two images to produce an integrated final result. The process can be as simple as placing text over an image, or as complex as combining live actors with drooling space aliens that shoot laser beams from their eyes. Motion graphics artists move multiple objects simultaneously onscreen using a strong sense of visual design. Motion graphics artists typically use techniques such as changing layer and object order, transforming the physical properties of objects (such as scale), object opacity and blend mode settings, applying filters to objects, and creating text and shapes. Motion graphics projects often combine layout and design techniques with techniques borrowed from special effects work such as keying, masking, color correction, and creating particle systems.

Once you import the objects you need for your project, the first step is to arrange the objects within the Canvas to come up with the general design of your piece. Even before you animate anything, you should decide what size each object should be, where everything should be positioned, if any objects need to be rotated to fit where they need to be, and so on. You can also make more extreme manipulations to create other effects. For example, you could corner-pin an object to provide the illusion of 3D perspective, or crop out unwanted parts of a particular object.
You can use different transform modes, each of which allow you to perform basic compositing tasks such as moving, rotating, scaling, shearing, corner-pinning, cropping, changing an object’s anchor point, and editing drop shadows. When you switch among the transform modes, different handles appear over the selected objects in the Canvas. Drag these handles to perform the selected transform action.

Additional controls in the Dashboard let you change each selected object’s opacity, blend mode, and drop shadow settings.

The onscreen controls and the Dashboard controls all correspond to parameters that appear in the Properties tab of the Inspector. Each parameter corresponds to a different Canvas control, and adjustments made in the Canvas are simultaneously updated in the Inspector. For example, if you’re in Transform mode and you change an object’s scale by dragging its corner handles in the Canvas, the object’s Scale parameter is updated in the Properties tab of the Inspector.
When you begin to lay out a composition, it’s a good idea to start by creating a static layout of your project that represents how it looks at the beginning, end, or at a particular moment in time. In addition to manipulating the geometry of objects in your project, you can also alter their opacity. This gives you additional control over how overlapping elements of your layout merge together. Blend modes provide further control over the appearance of overlapping objects, accentuating or stylizing the colors of the topmost objects based on the objects underneath.

After an initial layout is created, you can animate any of the objects you’ve added to set your project in motion. For more information about animating objects and their properties, see “Animation in Motion” on page 402.

Layer and Object Order
As discussed in Chapter 2, “Creating and Managing Projects,” the order in which objects and layers appear in the Layers tab and Timeline determines which objects appear in front of others in the Canvas. Before you use any of the transforms described in this chapter, you should first arrange the objects and layers in your project so that they appear in the proper order.

Layer Arrangement Commands in the Object Menu
In addition to rearranging object order in the Layers tab, you can also move objects to the front or push them behind other objects using commands in the Object menu. One example of when this is useful is when you want to quickly move an object to the front while you’re working in the Canvas. Rather than open the Layers tab, you can simply use one of the commands in the Object menu.

The layer arrangement commands can be used with either objects, layers, or layers that are nested within another layer. Reordering a layer reorders all objects that are nested within that layer.

**Note:** You cannot use the reorder commands to move objects out of the layer they’re nested within.
**Bring to Front**: Puts the selected object in front of all other objects within the same layer by moving it to the top of the nested group of objects in the Layers tab and Canvas.

![Before](image1) ![After](image2)

Before using Bring to Front on lion

**Send to Back**: Puts the selected object behind all other objects within the same layer by moving it to the bottom of the nested group of objects in the Layers tab and Canvas.

![Before](image3) ![After](image4)

Before using Send to Back on leopard

**Bring Forward**: Moves the selected object up one level in the hierarchy of objects nested within the same layer in the Layers tab and Canvas, moving it closer to the front in the Canvas.

**Send Backward**: Moves the selected object down one level in the hierarchy of objects nested within that layer in the Layers tab and Canvas, moving it closer to the back in the Canvas.
Bringing and Sending Nonconsecutive Selections
If you select multiple nonconsecutive objects, both move up or down the object hierarchy together, relative to their original positions in the list.

Object and Layer Transforms in the Canvas
Transforms are operations that you perform on objects, such as moving, resizing, or rotating. Object transforms can be performed either directly using object handles in the Canvas, or by changing the object’s parameters in the Properties tab of the Inspector. In general, the controls in the Canvas give you a more hands-on method of working, while the individual parameter controls in the Properties tab are better suited for subtle adjustments requiring greater numerical precision. For some operations, you can even use the keyboard.

Selecting Objects to Transform
Before you can transform objects and layers, you must first select what you want to transform in the Canvas, Layers tab, or Timeline. Selecting a layer or object in one place also selects it in the others.

When an object is selected in the Canvas, it is surrounded by a bounding box with handles corresponding to the currently selected transform mode. These handles allow you to transform each selected object.

To select a single object in the Canvas:

- Click any object in the Canvas.

To select multiple objects in the Canvas, or to add objects to a selection, do one of the following:

- Drag a selection box over all the objects you want to select.
- Press Shift and click all the objects you want to select.
- To add objects to a selection, press Shift, then drag a selection box over objects you want to add to the selection.
To deselect one of multiple selected objects in the Canvas, do one of the following:

- Shift-click an object you want to deselect.
  All other selected objects remain selected.

- Press Shift or Command, then drag a selection box over one or more objects you want to deselect.

To select all objects in the Canvas, do one of the following:

- Choose Edit > Select All.

- Press Command+A.

To deselect all objects in the Canvas, do one of the following:

- Choose Edit > Deselect All.

- Press Shift+Command+A.

From time to time, an object may become hidden behind another object. The best way to select a hidden object is to select it in the Layers tab or Timeline. When you do so, the object's bounding box and transform controls appear in the Canvas, even if the object is completely obscured.

Note: When an inactive object is selected, you also see only the bounding box for that object.

For more information on how to select objects and layers in the Layers tab, see “Selecting Objects and Layers in the Layers Tab” on page 200.
Rules for Transforming Selected Objects and Layers
The way you transform selected objects depends on how many objects are selected.

Transforming a Single Object
If you select a single object, the changes you make only affect that one object. All unselected objects remain unaffected. For example, if you select a single object, transform handles appear around that one object.

Transforming Multiple Objects
If you select multiple objects in the Canvas, changes made to one object are simultaneously made to all others. Each transform occurs around each object’s own anchor point, so the effect is the same as if you made the same transform to each individual object’s handles, one after another.
**Transforming a Layer**

If you select an entire layer, all objects and layers that are nested within it are treated as a single object. One set of transform handles appears on a bounding box that encompasses every object within that layer. All object transforms occur around a single anchor point belonging to the layer.

**Using Transforms**

Transforms allow you to arrange and manipulate objects spatially within the Canvas. Transforms are so named because they allow you to transform objects and layers in your project by moving, scaling, rotating, shearing, corner-pinning, and cropping them. Each of these operations can be performed in one of two ways—using graphical handles in the Canvas, or using each object’s parameter controls in the Inspector.

This section describes the use of the graphical controls in the Canvas, as they provide the most intuitive and hands-on method of arranging the objects in your project. For more information about each transform’s corresponding parameter and its numerical values, see “Object Geometry Controls in the Inspector” on page 240.
Switching Among Canvas Transform Tools
Before you transform an object, you should make sure that the pointer is set to the correct transform tool. These tools can be selected from the Toolbar.

All object controls perform the transform associated with the selected tool. For example, in the default Transform mode, the corner handles change the selected object’s size. In Crop mode, however, the corner handles crop the edges of the object.

Note: With the exception of the Adjust Drop Shadow tool, you can reposition objects in the Canvas regardless of the selected transform tool. For example, if the Pivot transform tool is selected, click anywhere in the object—except on the pivot point—and drag to move the object.

The six main transform tools are:

Transform: Scale and rotate selected objects.

Adjust Anchor Point: Offset the anchor point used for all object transforms.

Adjust Shear: Tilt objects, either horizontally or vertically.

Adjust Drop Shadow: Manipulate object drop shadows directly in the Canvas.

Adjust Four Corner: Stretch an object into different polygonal shapes.

Adjust Crop: Cut off pixels from any of the object’s four edges.
The Adjust Control Points tool is available when a shape or mask is selected, and is used to adjust a Bezier or B-Spline control point. The Adjust Item tool is available when the selected item has additional onscreen controls, such as a filter or a gradient generator.

To switch among Canvas transform modes, do one of the following:

- Click the Select/Transform tool in the Toolbar, then choose a transform tool from the pop-up menu.
- Press Tab. Pressing Tab repeatedly cycles the Canvas through each of the transform modes in order.

**Note:** Press Shift+Tab to cycle through the transform modes in reverse.

- Control-click any object in the Canvas, then choose a transform mode from the shortcut menu.
Chapter 3  Basic Compositing

Moving Objects in the Canvas
The simplest thing you can do to start arranging the objects in your project is to move them around. With the exception of the Adjust Drop Shadow tool, all transform tools let you reposition objects, so this is the one operation you can perform regardless of the currently selected transform tool.

The easiest way to reposition an object is to drag it around within the Canvas. If you want to make more precise adjustments to an object’s position, you can also change the numerical values of an object’s X and Y Position parameters in the Properties tab of the Inspector. For more information on object properties, see “Parameters in the Properties Tab” on page 241.

You can move objects anywhere within the frame defined by the Canvas, but you can also drag objects past the edge of the frame. When you move an object past the edge of the frame, it becomes invisible, although you can still manipulate it using its bounding box.

Note: The bounding box that indicates the position of objects located offscreen only appears when those objects are selected.

Using Canvas Compositional Aids
When you’re arranging objects directly in the Canvas, take advantage of various compositional aids to help you. For example, if you are working on a piece for broadcast or film, turn on the safe zones in the Canvas to avoid putting objects past the title- or action-safe boundaries. A grid and ruler can also be enabled to provide a useful reference, and Dynamic Guides can be turned on to help you align objects with more precision than by simply looking at them.

Furthermore, snapping can be toggled on and off to help you position objects relative to the center and edges of the Canvas, either with or without the other guides enabled.

Note: Press Command while you manipulate an object to temporarily disable snapping, allowing the object to move freely.

For more information about enabling various Canvas options to help you lay out your composition, see “View and Overlay Options” on page 41.
One example of when it’s necessary to move an object past the edge of the frame is when you plan on animating an object so that it flies onscreen. Prior to animating it, you need to move it to a position offscreen to achieve this effect.

To move one or more objects in the Canvas:
1 Select one or more objects.
2 Do one of the following:
   • Drag an object to another location. If more than one object is selected, dragging one of the currently selected objects moves all of them.
   • Press Command, then press Right Arrow, Left Arrow, Up Arrow, or Down Arrow to reposition the selected objects one pixel at a time.
   • Press Command+Shift, then press Right Arrow or Left Arrow to reposition the selection ten pixels at a time.

*Note:* When repositioning very small objects, it may be necessary to zoom into the Canvas to get a better view.

*Note:* If you press Up Arrow or Down Arrow while working in the Canvas, it moves the selection to the next object up or down in the Layers tab.

To clone an object:
• Select the object you want to clone, then press Option and drag the object.

**Using Object Alignment Commands**
Several commands in the Object menu let you reposition any number of simultaneously selected objects to align with one another in various ways. These commands make it easy to quickly organize a jumble of objects into an even layout without having to manually line up each individual object.

![Before using alignment commands](image1.png) ![After using alignment commands](image2.png)

In each operation, the left, right, top, and bottom of the selected objects are defined by the bounding box that surrounds each individual object, and the position of the anchor point is ignored.

Each of these commands affects the Position parameter of each object.
Align Left Edges: Objects are moved horizontally so that their left edges line up with the leftmost object in the selection.

Align Right Edges: Objects are moved horizontally so that their right edges line up with the rightmost object in the selection.

Align Top Edges: Objects are moved vertically so that their tops line up with the topmost object in the selection.

Align Bottom Edges: Objects are moved vertically so that their bottoms line up with the bottommost object in the selection.

Align Horizontal Centers: Objects are moved horizontally so that their centers line up along the center point between the leftmost and rightmost objects in the selection.

Align Vertical Centers: Objects are moved vertically so that their centers line up along the center point between the topmost and bottommost objects in the selection.

Distribute Lefts: Objects are moved horizontally so that the left sides of all objects are evenly distributed, from right to left, between the leftmost and rightmost objects in the selection.

Distribute Rights: Objects are moved horizontally so that the right sides of all objects are evenly distributed, from right to left, between the leftmost and rightmost objects in the selection.

Distribute Tops: Objects are moved vertically so that the tops of all objects are evenly distributed, from top to bottom, between the topmost and bottommost objects in the selection.

Distribute Bottoms: Objects are moved vertically so that the bottoms of all objects are evenly distributed, from top to bottom, between the topmost and bottommost objects in the selection.

Distribute Horizontal Centers: Objects are moved horizontally so that the centers of all objects are evenly distributed, from left to right, between the leftmost and rightmost objects in the selection.

Distribute Vertical Centers: Objects are moved vertically so that the centers of all objects are evenly distributed, from top to bottom, between the topmost and bottommost objects in the selection.
**Canvas Transform Controls**

The transform controls do double-duty, allowing you to both resize (scale) and rotate an object within a single mode.

![Diagram of transform controls](image)

**Scaling**

Eight handles appear around the edge of an object’s bounding box that allow you to resize it. By default, the width and height of an object are not locked together when using these scaling handles. This means that the aspect ratio of an object can be freely changed. (The aspect ratio of an object is the ratio of its width to its height.) An object’s aspect ratio can be preserved as you scale it by pressing **Shift** while you use these controls. Changes made to the scale of an object are applied to the Scale parameter in the Properties tab of the Inspector.

**To resize the height and width of an object in the Canvas independently:**

1. Click the Select/Transform tool, then choose the Transform tool from the Select/Transform tools pop-up menu.

   **Note:** You can also **Control**-click the object, then choose Transform from the shortcut menu.
Do one of the following:

- Drag any of the corners to resize the object’s width and height at the same time. By default, you can resize the width and height independently, by any amount.

- Press *Shift*, then drag any of the corners to resize the object while locking its width and height together, maintaining the object’s current aspect ratio.
• Drag the top or bottom scale handle to limit scale changes to the object’s height, or drag the left or right scale handle to limit scale changes to the object’s width.

Limiting scale changes to the object’s width using the left scale handles

• Press Option while you use any scale handle to resize an object around its anchor point, instead of by the opposing handle.

Resizing with the Option key  Resizing without the Option key
As you drag the scale handles, an info box appears and shows you the new width and height percentages and the amount by which the object is changing. This amount is represented by a delta symbol.

While resizing an object, the scale handles snap to the original width and height of the image. Press Command to temporarily suspend snapping.

**Note:** Scaling the width or height of an object by a negative value reverses the image, flipping its direction.

**Rotating**
Another handle allows you to rotate the image around its anchor point. For animation purposes, Motion keeps track of the number of times you’ve rotated the object, and stores this value in that object’s Rotation parameter in the Properties tab of the Inspector.

**To rotate an object in the Canvas:**
1. Click the Select/Transform tool, then choose the Transform tool from the pop-up menu.
   **Note:** The Transform mode is the default mode when Motion opens.
2. Do one of the following:
   • Drag the rotation handle to rotate the object.
   • Press Shift while you drag the rotation handle to constrain the angle of the selected object to 45 degree increments as it rotates.
As you drag the rotation handle, the original angle of the object is indicated by a small circle that appears on a larger circle surrounding the object’s anchor point. Additionally, an info box appears showing you the new angle of rotation, and the delta of change between the object’s former angle and the angle you’ve dragged it to.

**Changing an Object’s Anchor Point**

You can move any object’s anchor point, changing the way in which different geometric transforms are performed. Objects rotate around the anchor point, but the anchor point also affects shearing and resizing operations.

For example, the default anchor point for any object is the center of the bounding box that defines its edges. If you rotate an object, it rotates around this central anchor point.
If you move an object’s anchor point, however, it no longer rotates around its own center, but instead rotates around the new anchor point.

This not only affects the rotation of an object, but any moving and scaling operations performed upon that object as well. Changes made to an object’s anchor point are stored in the Anchor Point parameter of the Properties tab in the Inspector.

**To change the anchor point of an object in the Canvas:**

1. Click the Select/Transform tool, then choose the Adjust Anchor Point tool from the pop-up menu.

The object’s anchor point appears as a round target surrounded by four arrows.

2. Drag the anchor point to a new position.

As you drag the anchor point, a line stretches from the default position of the anchor point to its new position. Additionally, an info box appears and shows you the anchor point’s new coordinates on top, and the delta (amount of change) between the anchor point’s new and old positions.

**Note:** If the anchor point is close to the center or edges of the object, it snaps to that location.
Shearing Objects
The shear handles can be used to slant an object, either horizontally or vertically. This is an isometric operation, so it doesn’t necessarily provide a realistic perspective effect. When you shear an object, this change is stored in that object’s Shear parameter, which can be seen in the Properties tab of the Inspector.

To shear an object in the Canvas:
1 Click the Select/Transform tool, then choose the Adjust Shear tool from the pop-up menu.
2 Drag one of the four shear handles to slant the object. The top and bottom controls angle the object horizontally, while the left and right controls angle the object vertically.
Adjusting the Drop Shadow of an Object
Once an object’s drop shadow is enabled, the onscreen drop shadow control points can be used to change the blur, angle, and distance of an object’s drop shadow.

To adjust the drop shadow of an object in the Canvas:
1 In the object’s Dashboard or Properties tab, make sure Drop Shadow is turned on.
2 Click the Select/Transform tool, then choose the Adjust Drop Shadow tool from the pop-up menu.
3 Drag one of the four corner handles to adjust the blur of the drop shadow. Drag within the shadow’s bounding box to adjust the distance and angle of the drop shadow.

For more information on working with drop shadows, see “Drop Shadows” on page 269.
**Corner-Pinning Objects**

You can stretch an object into different polygonal shapes using the Four Corner controls. This allows you to create false perspective effects, as well as to simulate 3D effects and placement within your composition.

To corner-pin an object in the Canvas:

1. Click the Select/Transform tool, then choose the Adjust Four Corner tool from the pop-up menu.

2. Drag each of the four corner handles to stretch the object into the shape you want.

   *Note:* Just as you can with the Scale handles, you can reverse the corner handles to flip the image. However, changing the angle of any one corner more than 180 degrees can produce unexpected results.

After you have corner-pinned an object, you can quickly revert back to the object’s original shape by turning off the object’s Four Corner checkbox in the Properties tab of the Inspector. This resets the shape of the object without resetting the corner-pinning shape you defined in the Four Corner parameter of the Properties tab.
Cropping Objects
Cropping allows you to chop off each of the four edges of an object to eliminate parts you don't want to see in your composition. Common examples of objects you'd want to crop are video clips with a black line along the right or left edge because of the video format, or with vignetting around the edges because of a wide-angle lens. You can use the crop operation to cut these undesirable artifacts out when using them in your composition. You could also crop an object to isolate a single element of the image, so long as that element can be adequately cut out with a simple rectangular shape.

Note: If you need to isolate a more irregularly shaped object, or you want to create a border of a particular shape, see “Using Shapes and Masks” on page 819 for more information.

To crop an object in the Canvas:
1 Click the Select/Transform tool, then choose the Adjust Crop tool from the pop-up menu.
2 Drag one of the eight handles around the edge of the object to crop it:
   • Drag the top, left, right, or bottom handle to only crop that side.
• Drag one of the four corner handles to crop both corresponding sides simultaneously.
• Press Shift while you drag to constrain corner edge cropping to the aspect ratio of the object.

**Note:** If an object is corner-pinned, you can no longer enable the Crop mode in the Canvas (onscreen controls). You can still crop a corner-pinned object by adjusting its Crop parameter settings in the Properties tab of the Inspector.

**Adjusting Control Points**
You can modify a shape or mask directly in the Canvas. Once a shape or mask is drawn, the Adjust Control Points tool is automatically selected.

**To modify a shape's control points in the Canvas:**
1 Once the shape or mask is created, click the Select/Transform tool, and then choose the Adjust Control Points tool from the pop-up menu.

**Note:** You can also double-click the shape, or Control-click the object, then choose Edit Points from the shortcut menu to enter the Adjust Control Points mode.

The object's control points become active.

2 Drag the points to modify the shape of the object.

For more information on working with shapes and masks, see "Using Shapes and Masks" on page 819.

**Object Geometry Controls in the Inspector**
Layers and objects have the same geometric parameters in the Properties tab of the Inspector. Manipulating a Canvas transform control also changes the corresponding parameter in the Properties tab of the Inspector. If you want to transform an object more precisely than the onscreen controls allow, you can change that parameter's value directly.

When you select a single object and open the Properties tab of the Inspector, the object's parameters are displayed. Making changes to the values in the Properties tab affects the selected object. If more than one object is selected in the Canvas, Timeline, or Layers tab, the parameter values displayed in the Properties tab of the Inspector are blank. Adjusting any parameter control affects every selected object equally.

**To modify parameter values, do one of the following:**
• Select a parameter value field, type a new number, then press Return.
• Drag a parameter’s slider.
• If the parameter has a graphical control, such as a slider or dial, you can adjust it.

• To reset a parameter to its default state, either click its reset button, or choose Reset Parameter from the parameter’s Animation menu.

For more information on how to use the above controls, see “Types of Controls” on page 98.

Parameters in the Properties Tab
The Properties tab displays the following parameters for most objects and layers:

Position: Defines the X (horizontal) and Y (vertical) position of each object.

The coordinate system used by Motion specifies the center of the Canvas as 0,0 regardless of the frame size of the project. Moving an object to the left subtracts from the X value, while moving to the right adds to the X value. Similarly, moving an object up adds to the Y value, and moving an object down subtracts from the Y value.

Note: This is identical to the coordinate system used by Final Cut Pro HD and Final Cut Express HD, but different from that used by Shake, in which 0,0 defines the upper-left corner of the compositional area.

Each object’s position is centered on its anchor point. Offsetting the anchor point also offsets the position of the object relative to the X and Y position values you have set.

Rotation: Controls a one-dimensional value representing the number of degrees of rotation. A positive value rotates the object counter-clockwise. A negative value rotates the object clockwise.

Rotating an object beyond 360 degrees results in multiple rotations when the Rotation parameter is animated.

Scale: Controls the percentage representing the object’s scale, relative to its original size. By default, the horizontal and vertical scale of an object is locked together at the object’s original aspect ratio—all of which is represented by a single percentage. Click the disclosure triangle to display independent percentages for the X and Y scale of the object.
**Note:** Setting an object’s scale to a negative value flips the object.

**Shear:** Defines the X and Y shear of the object. An object with no shear has X and Y shear values of 0. Positive values shear in one direction, while negative values shear in the other.

**Anchor Point:** Defines the X and Y position of the anchor point relative to the center of the object. Coordinates of 0,0 center the anchor point in the bounding box defining the outer edge of the object.

**Opacity:** Defines the transparency of the object. For more information, see “Editing Opacity and Blending” on page 243.

**Blend Mode:** Sets the Blend Mode of the object. For more information, see “Editing Opacity and Blending” on page 243.

**Preserve Opacity:** When this checkbox is turned on, the object appears only where another object is visible below it in the composite. The object uses the opacity value of the object below it. For more information, see “The Preserve Opacity Option” on page 247.

**Drop Shadow:** Turns the drop shadow of an object on and off. For more information about working with drop shadows, see “Drop Shadows” on page 269.

**Four Corner:** Turns corner-pinning on and off. If an object has been corner-pinned and this checkbox is turned off, the object resumes its original shape, although the corner-pinning coordinates are maintained. Turning the checkbox back on re-enables the corner-pinning effect specified by the Four Corner coordinate parameters.

Click the disclosure triangle to display four two-dimensional parameters that define the polygonal transform of a corner-pinned object. Individual parameters for the Bottom Left, Bottom Right, Top Right, and Top Left corners of the bounding box that surrounds an object have individual X and Y coordinates.
Crop: Turns cropping on and off. If an object has been cropped and this checkbox is turned off, the object resumes its original size, although the cropping values are maintained. Turning the checkbox back on re-enables the cropping effect specified by the crop parameters.

Click the disclosure triangle to display four crop parameters. Each defines the number of pixels to be cropped from each of the object's four sides, relative to the outer edge of the bounding box that surrounds it. These parameters are similar to the crop parameters that appear when an object is selected in the Media tab, except that cropping an object in the Layers tab only crops the currently selected instance of that object in your project. Duplicates of that object remain untouched. If you want to crop all instances of the object simultaneously, use the Crop parameter on the object in the Media tab. For more information, see “Object Parameters in the Media Tab” on page 185.

Timing: Available when the selected object is an imported audio, video, still image, or image sequence, this parameter controls the In and Out points of the object. You can also use the mini-Timeline and Timeline to adjust the In and Out points of an object.

Editing Opacity and Blending
The opacity and blending controls for each object appear both in the Properties tab of the Inspector, and in the default Dashboard for any selected object.

Opacity
By layering together objects with varying opacities, you can merge them together in ways not otherwise possible. For example, if you have two full-screen background images that you want to use together, you can set the opacity of the object in front to 50 percent, allowing the object in back to show through.

![Image in front](image_in_front.png)  ![Image in back](image_in_back.png)  ![Front image at 50% opacity](front_image_50 opacity.png)

You can overlap as many objects as you want, and by varying their opacities, selectively reveal objects in the back.
To change an object's opacity, do one of the following:

- Adjust the Opacity slider or value slider in the Properties tab.
- Adjust the Opacity slider in the Dashboard.

**Blend Modes**

While the Opacity parameter simply defines a uniform level of transparency for an object, the blend modes allow you many more creative options to control how the overlapping images interact, based on the colors in each object. By default, each object’s blend mode is set to Normal, so that changes to an object’s opacity uniformly affect every part of the image equally.

Blend modes can create transparency in an object regardless of the setting of its opacity parameter. This is because the pixels of an image with a selected blend mode are combined with the pixels of any objects lying immediately below it in the Canvas. For example, if you overlapped two objects, then turned the blend mode of the top one to Screen, the darker areas of the screened image become transparent, while the lighter areas remain more solid, resulting in the following image:

![Example Image](image.png)

*Important:* The transparency created by the Subtract through Exclusion blend modes only affects how an object combines with overlapping objects underneath. These blend modes do nothing to affect an object’s alpha channel. For information about blend modes that do affect an object’s alpha channel, see “Blend Modes That Manipulate Alpha Channels” on page 266.
Each blend mode combines objects in different ways. For example, setting the top object’s blend mode to Multiply yields the opposite result, as the darker areas of the image remain solid, and the lighter areas become transparent.

Blend modes only affect the combination of an object with the objects below it. Any objects appearing above have no effect on this interaction, even if the object is transparent. In the following example, the text objects on the top level have no effect on the blended images below.
In cases where a stack of overlapping objects appears, each with a different blend mode, the bottommost pair of objects is combined first, and that combination then interacts with the next object up, and so on until all overlapping objects have been combined for the final image. In this case, each object with a specified blend mode only interacts with the image below it, whether that image is a single object or a pair of objects that have been blended together.

Each of Motion's blend modes works in conjunction with the Opacity parameter to alter the interaction between the foreground and background objects. Adjusting an object's opacity lessens the blending effect that is assigned to it, even as it reduces that object's visibility. This allows you to customize any blend mode to better suit your needs.

Blend modes only affect overlapping objects, and have no interaction with your project's background color. If you specify a blend mode for an object that doesn't overlap anything, that object remains as it was before.

To change a selected object's blend mode, do one of the following:
- Choose an option from the Blend Mode pop-up menu in the Dashboard.
- Choose an option from the Blend Mode pop-up menu in the Properties tab.
- Choose Object > Blend Mode, then choose an option from the submenu.
- Display the Blend Mode column in the Layers tab, then choose an option from an object's Blend Mode pop-up menu.
- Control-click an object in the Canvas, then choose an option from the Blend Mode submenu in the shortcut menu.
- Control-click an object in the Layers tab or Timeline Layer list, then choose an option from the Blend Mode submenu in the shortcut menu.
The Preserve Opacity Option

The Preserve Opacity checkbox allows you to limit an object’s visibility to areas of the Canvas where it overlaps nontransparent regions of other objects. For example, you might place two overlapping objects into your project, as shown below:

If you turn on Preserve Opacity for the Dolphin object on top, the result is this:

The only area of the Dolphin object that is visible is the area that overlaps the sea life picture object underneath. At first, this may not appear to be very exciting, but the Preserve Opacity checkbox can be used in combination with the opacity and blend mode to create some very interesting effects.

Note: The object with the enabled Preserve Opacity takes the opacity value of the object beneath it in the composite stack.
Preserve Opacity is an easy way to selectively reveal part of an object. In this example, by setting the blend mode of the top color wash layer to Exclusion, you get the resulting image:

By turning on Preserve Opacity for the color wash layer on top, only the overlapping parts are displayed, and the superimposed image only affects the Dolphin layer.

To turn on Preserve Opacity:
- Turn on an object’s Preserve Opacity checkbox in the Properties tab.
Using Blend Modes
Each of the available blend modes presents a different method for combining two or more images together. Blend modes work in addition to an object’s alpha channel and opacity parameter.

How Blend Modes Affect Images
To understand the descriptions of each blend mode in this section, it's important to understand that blend modes mix colors from overlapping images together based on the brightness values within each color channel in an image. Every image consists of red, green, blue, and alpha channels. Each individual channel contains a range of brightness values that define the intensity of each pixel in the image that uses some of that color.

The effect that each blend mode has on objects that overlap in the Canvas depends on the range of color values within each object. The red, green, and blue channels within each overlapping pixel are mathematically combined to yield the final image.

These value ranges can be described as blacks, midrange values, or whites. These regions are loosely illustrated by the chart below.

<table>
<thead>
<tr>
<th>Blacks</th>
<th>Midrange color values</th>
<th>Whites</th>
</tr>
</thead>
</table>

For example, the Multiply blend mode renders color values that fall into the white areas of an image transparent, while the black areas of the image are left alone. All midrange color values become translucent, with colors falling into the lighter end of the scale becoming more transparent than the colors that fall into the darker end of the scale.

Layer Blend Modes
Blend modes work differently depending on whether they’re used with layers or objects. In particular, the Combine blend mode is only available for layers.
**Combine**

When a layer is set to Combine, each object is individually blended with all objects and layers that appear underneath it in the Layers tab. In this example, the Swirls object is set to Stencil Luma, and the Fishes object is set to Add.

With the enclosing layer set to Combine, the Swirls object stencils all other objects underneath it, including the Gradient object in the bottom layer. The result is that all objects are stenciled against the background color. The Fishes object is likewise added to the combined stack of objects.
Normal
When a layer is set to Normal, the objects nested within can only be blended with one another. Objects nested within that layer do not blend with objects in other layers beneath it in the Layers list.

In this example, the Fishes and Swirls objects in the topmost layer are only blended with themselves when the topmost layer is set to Normal.

The Gradient object in the bottom layer is left unaffected, although the transparency in the top layer caused by the combination of the Add and Stencil Luma blend modes reveals it in the background.
Other Blend Modes
When you set a layer to any of the other available blend modes, each object nested within that layer is blended according to its blend mode. The resulting image is then blended with the layers underneath, according to the selected blend mode for that layer. In this example, the topmost layer is set to Multiply.

As a result, the combination of the Added Fishes and the Stenciled Swirls objects is multiplied with the Gradient object in the bottommost layer.
Object Blend Modes
The following section describes how blend modes affect individual objects. All blend modes are presented in the order in which they appear in the Blend Mode pop-up menu.

About the Examples in This Section
Most of the examples in this section are created using the following two reference images. The resulting "Mondrian Monkey" illustrates how differently the color values from each image interact when using each blend mode. When examining the results, pay particular attention to the white and black areas of the colored squares, as well as the highlights and shadows in the monkey. These show you how each blend mode treats the whites and blacks in an image.

The other brighter and darker colors serve to illustrate each blend mode’s handling of overlapping midrange color values. The yellow, gray, orange, and blue squares, in particular, all have very different color and luminance values that contrast sharply from example to example.

Important: Depending on the blend mode, layer ordering may or may not be important. Certain blend modes behave differently depending on which image is on top.

Normal
The default for objects. The only transparency in an object set to Normal is caused by its Opacity parameter, or by an alpha channel that is assigned to it.

Subtract
Subtract darkens all overlapping colors. Whites in the foreground image go black, while whites in the background image invert overlapping color values in the foreground image, creating a negative effect.

Blacks in the foreground image become transparent, while blacks in the background image are preserved.
Overlapping midrange color values are darkened based on the color of the background image. In areas where the background is lighter than the foreground, the background image is darkened. In areas where the background is darker than the foreground, the colors are inverted.

The order of two objects affected by the Subtract blend mode is important.

**Darken**

Darken emphasizes the darkest parts of each overlapping image. Whites in either image allow the overlapping image to show through completely. Lighter midrange color values become increasingly translucent in favor of the overlapping image, while darker midrange color values below that threshold remain solid, retaining more detail.

The order of two objects affected by the Darken blend mode does not matter.
Suggested uses: The Darken blend mode is useful for using one image to texturize another selectively, based on its darker areas. You can also use Screen, Color Burn, and Linear Burn for variations on this effect.

Multiply
Like Darken, Multiply emphasizes the darkest parts of each overlapping image, except that midrange color values from both images are mixed together more evenly. Progressively lighter regions of overlapping images become increasingly translucent, allowing whichever image is darker to show through. Whites in either image allow the overlapping image to show through completely. Blacks from both images are preserved in the resulting image.

The order of objects affected by the Multiply blend mode does not matter.

Suggested uses: The Multiply blend mode is particularly useful in situations where you want to knock out the white areas of a foreground image, and blend the rest of the image with the colors in the background. For example, if you superimpose a scanned sheet of handwritten text over a background image using the Multiply blend mode, the resulting image becomes textured with the darker parts of the foreground.
**Color Burn**
Color Burn intensifies the dark areas in each image. Whites in the background image replace the foreground image, while whites in the foreground image become transparent. Midrange color values in the background image allow midrange color values in the foreground image to show through.

Lighter midrange color values in the background image allow more of the foreground image to show through. Darker midrange values in all visible overlapping areas are then mixed together, resulting in intensified color effects.

The order of two objects affected by the Color Burn blend mode is important.

**Linear Burn**
Similar to Multiply, except that darker overlapping midrange color values are intensified, like Color Burn. Progressively lighter color values in overlapping images become increasingly translucent, allowing darker colors to show through. Whites in either image allow the overlapping image to show through completely.

The order of two objects affected by the Linear Burn blend mode does not matter.
Add
Add emphasizes the whites in each overlapping image, and lightens all other overlapping colors. The color values in every overlapping pixel are added together. The result is that all overlapping midrange color values are lightened. Blacks from either image are transparent, while whites in either image are preserved.

The order of two objects affected by the Add blend mode does not matter.

Suggested uses: The Add blend mode is useful for using one image to selectively texturize another, based on its lighter areas such as highlights. You can also use Lighten, Screen, Color Dodge, and Linear Dodge to create variations of this effect.
**Lighten**

Lighten emphasizes the lightest parts of each overlapping image. Every pixel in each image is compared, and the lightest pixel from either image is preserved, so that the final image consists of a dithered combination of the lightest pixels from each image. Whites in both images show through in the resulting image.

The order of two objects affected by the Lighten blend mode does not matter.

---

**Screen**

Like Lighten, Screen also emphasizes the lightest parts of each overlapping image, except that the midrange color values of both images are mixed together more evenly.

Blacks in either image allow the overlapping image to show through completely. Darker midrange values underneath a certain threshold allow more of the overlapping image to show. Whites from both images show through in the resulting image.

The order of two objects affected by the Screen blend mode does not matter.
**Suggested uses:** The Screen blend mode is especially useful for knocking out the blacks behind a foreground subject, instead of using a Luma Key. It's mainly useful when you want the rest of the foreground subject to be mixed with the background image as well, based on its brightness. It's good for glow and lighting effects, and for simulating reflections. You can also use the Add, Lighten, and Color Dodge blend modes to create variations of this effect.

**Color Dodge**
Whites in either the foreground or background image are preserved in the final image. Blacks in the background image replace the foreground image, while blacks in the foreground image become transparent.

Midrange color values in the background image allow midrange color values in the foreground image to show through. Darker values in the background image allow more of the foreground image to show through. All overlapping midrange color values are mixed together, resulting in interesting color mixes.

Reversing the two overlapping images results in subtle differences in how the overlapping midrange color values are mixed together.
**Linear Dodge**
Similar to Screen, except that lighter midrange color values in overlapping regions become intensified. Blacks in either image allow the overlapping image to show through completely. Whites from both images show through in the resulting image.

The order of two objects affected by the Linear Dodge blend mode does not matter.

**Overlay**
Whites and blacks in the foreground image become translucent, and interact with the color values of the background image causing intensified contrast. Whites and blacks in the background image, on the other hand, replace the foreground image.

Overlapping midrange values are mixed together differently depending on the brightness of the background color values. Lighter background midrange values are mixed by screening. Darker background midrange values, on the other hand, are mixed together by multiplying.

The visible result is that darker color values in the background image intensify the foreground image, while lighter color values in the background image wash out overlapping areas in the foreground image.

The order of two objects affected by the Overlay blend mode is important.
**Suggested uses:** The Overlay blend mode is particularly useful for combining areas of vivid color in two images.

![Images showing Overlay blend mode effect]

**Soft Light**

Soft Light is similar to the Overlay blend mode. Whites and blacks in the foreground image become translucent, but interact with the color values of the background image. Whites and blacks in the background image, on the other hand, replace the foreground image. All overlapping midrange color values are mixed together, creating a more even tinting effect than the Overlay blend mode.

The order of two objects affected by the Soft Light blend mode is important.

![Images showing Soft Light blend mode effect]

**Suggested uses:** The Soft Light blend mode is useful for softly tinting a background image by mixing it with the colors in a foreground image.

![Images showing Soft Light blend mode effect]
**Hard Light**
Whites and blacks in the foreground image block the background image. Whites and blacks in the background image, on the other hand, interact with overlapping midrange color values in the foreground image.

Overlapping midrange color values are mixed together differently depending on the brightness of the background color values. Lighter background midrange values are mixed by screening. Darker background midrange values, on the other hand, are mixed together by multiplying.

The visible result is that darker color values in the background image intensify the foreground image, while lighter color values in the background image wash out overlapping areas in the foreground image.

The order of two objects affected by the Hard Light blend mode is important.

**Vivid Light**
Vivid Light is similar to the Hard Light blend mode, with two exceptions. The first is that midrange color values are mixed together more intensely. The second is that whites and blacks from either overlapping image are preserved in the end result.

*Note:* Some dithering may result in overlapping areas of solid white and solid black.

Overlapping midrange color values are mixed together differently depending on the brightness of the background color values. Lighter midrange values become washed out, while the contrast of darker midrange color values is increased. The overall effect is more pronounced than with the Hard Light blend mode.
Reversing the two overlapping images results in subtle differences in how the overlapping midrange color values are mixed together.

**Linear Light**
Linear Light is similar to the Hard Light blend mode, except that overlapping midrange color values are mixed together with higher contrast. Whites and blacks in the foreground image block the background image. Whites and blacks in the background image, on the other hand, interact with overlapping midrange color values in the foreground image.

Overlapping midrange color values are mixed together. Lighter background colors brighten the foreground image, while darker colors darken it.

The order of two objects affected by the Linear Light blend mode is important.
Pin Light

Pin Light is similar to the Hard Light blend mode, except that overlapping midrange color values are mixed together differently based on their color value. Whites and blacks in the foreground image block the background image. Whites and blacks in the background image, on the other hand, interact with overlapping midrange color values in the foreground image.

The methods used by the Pin Light blend mode to mix two images are somewhat complex. Overlapping midrange color values are treated differently depending on which of the four regions of the luminance chart they fall into.

- Lighter and darker areas of the foreground image falling close to the whites and blacks are preserved.
- Areas of the foreground image falling near the center of the midrange are tinted by the background color.
- Darker areas of the foreground image in between the blacks and center of the midrange are lightened.
- Lighter areas of the foreground image in between the whites and the center of the midrange are darkened.

The end result may appear alternately tinted or solarized, depending on the lightness or darkness of the overlapping values. This blend mode lends itself to more abstract effects.

The order of two objects affected by the Pin Light blend mode is important.

Boxes object on top

Monkey object on top
**Hard Mix**

Hard Mix is similar to the Hard Light blend mode, except that the saturation of overlapping midrange color values is intensified, resulting in extremely high-contrast images. Whites and blacks are preserved.

While the order of two objects doesn’t affect the overall look of two images blended using the Hard Mix blend mode, there may be subtle differences.

![Example of Hard Mix blend mode](image)

**Difference**

Similar to the Subtract blend mode, except that areas of the image that would be severely darkened by the Subtract blend mode are colorized differently.

The order of two objects affected by the Difference blend mode does not matter.

![Example of Difference blend mode](image)
**Exclusion**

Similar to the Difference blend mode, except that the resulting image is lighter overall. Overlapping areas with lighter color values are lightened, while darker overlapping color values become transparent.

The order of two objects affected by the Exclusion blend mode does not matter.

---

**Blend Modes That Manipulate Alpha Channels**

The Stencil and Silhouette blend modes let you use a single object’s alpha channel or luma values to isolate regions of background objects and layers.

*Note:* Similar effects can be accomplished using shape and image masks. In addition, masks may provide you with a greater degree of control, depending on your needs. For more information, see "Using Shapes and Masks" on page 819.

Stencil modes crop out all nonoverlapping parts of objects underneath the object used as the stencil. Silhouette modes do the opposite, punching holes in overlapping objects underneath in the shape of the object used as the silhouette.

**Stencil Alpha**

The Stencil Alpha blend mode uses the alpha channel of the affected layer to crop out all nonoverlapping parts of objects and layers underneath it in the Layers list.
**Stencil Luma**
The Stencil Luma blend mode does the same thing as the Stencil Alpha blend mode, but uses the affected layer’s luma value to define transparency. Stencil Luma is useful if the object you want to use for cropping has no alpha channel of its own.

**Silhouette Alpha**
Silhouette Alpha is the reverse of the Stencil Alpha blend mode, and is useful for cutting holes in objects underneath.

**Silhouette Luma**
Silhouette Luma is the reverse of Stencil Luma.
Behind
The Behind blend mode forces the object to appear behind all other objects and layers, regardless of its position in the Layers tab and Timeline.

If multiple objects or layers are set to Behind, they appear behind all other layers that are not set to Behind, in the order in which they appear in the Layers tab.

Alpha Add
The Alpha Add blend mode works similarly to the Add blend mode, but instead of adding the color channels of overlapping objects, it adds their alpha channels together. Try using this blend mode instead of Motion's default method of alpha channel compositing for a different treatment of overlapping areas of translucency.

Premultiplied Mix
The Premultiplied Mix blend mode is intended for compositing images that are premultiplied, such as those generated by 3D modeling and rendering software. Premultiplied Mix is useful for images with translucent lighting effects such as lens flares, volumetric lighting, fog and haze effects, and so on.

Limiting the Effect of Stencil and Silhouette Blend Modes
Whenever you use the Stencil or Silhouette blend modes in a layer that is set to the Combine blend mode, the resulting effect carries down through every object in every layer that lies underneath it in the Layers list. This is powerful, but not very useful, since it prevents you from placing a background layer to fill the transparent area.

You can limit the Stencil or Silhouette blend mode's effect to only those objects that are within the same enclosing layer by setting the layer's blend mode to anything other than Combine.

For example, if you set the enclosing layer of the two objects in the Silhouette Alpha example to Normal, then add a layer underneath containing additional objects, those objects show through the transparent areas created by the Silhouetted layer.
The Premultiplied Mix blend mode performs an unpremultiply composite—the foreground image is assumed to be premultiplied. Artifacts may appear as a result of unpremultiplying pixels whose RGB and alpha values are very small (resulting in pixels with values of 255). In some cases, the hardware performs bilinear filtering and then the blend mode unpremultiplies the alpha.

**Drop Shadows**

A drop shadow, by default, is a dark, translucent, offset shape that falls behind an object, as if a light was shining on the object. Drop shadows are the same size as the object to which they're applied, although blurring a drop shadow may enlarge it somewhat.

They create the illusion of depth, with the result that the foreground object seems to pop out at the viewer. For this reason, drop shadows are frequently used to create the impression of space between two overlapping layers.
Drop shadows also darken overlapping regions of background objects. A good example of when to use this is when you place text over a background that might obscure it. By adding a drop shadow, you can make a foreground text object easier to read.

It’s easy to add a drop shadow to any object, since each object has individual drop shadow parameters in the Inspector and Dashboard. Once activated, drop shadows can also be manipulated directly in the Canvas.

**Important:** Text objects have additional drop shadow parameters, located in the Style pane of the Text tab. For more information about text object drop shadows, see “Adding a Drop Shadow” on page 508.

### Adjusting Drop Shadows in the Canvas
You can interactively modify an object’s drop shadow using the Dashboard or the onscreen controls.

**Drop Shadow Controls in the Dashboard**
Whenever you select an object in the Canvas, the Dashboard displays three drop shadow parameters.

- **Drop Shadow**: A checkbox that lets you toggle any object’s drop shadow on or off.
- **Opacity**: Lets you set how transparent the drop shadow is.
- **Blur**: Lets you adjust how soft the drop shadow is.
**Note:** When you select a text object, these parameters are not displayed in the Dashboard.

**The Adjust Drop Shadow Transform Tool**
Selecting the Adjust Drop Shadow transform tool in the Toolbar provides additional onscreen controls for selected objects with drop shadows that are turned on.

![Drop shadow blur handles](image)
![Drop shadow position bounding box](image)

Four handles at each corner allow you to increase or decrease the blur of the drop shadow. Dragging anywhere within the drop shadow’s bounding box allows you to simultaneously change the shadow’s angle and distance.

**To increase or decrease a drop shadow’s blur:**
1. Click the Select/Transform tool, then choose the Adjust Drop Shadow tool from the pop-up menu.
2. Drag one of the four corner handles in to decrease a shadow’s blur, or out to increase it.

**To move an object’s drop shadow:**
1. Click the Select/Transform tool, then choose the Adjust Drop Shadow tool from the pop-up menu.
2. Drag anywhere within the shadow’s bounding box to move it around.

**Drop Shadow Parameters in the Properties Tab**
In addition to the Canvas and Dashboard drop shadow controls, each object has individual drop shadow parameters in the Properties tab.

Use the checkbox to toggle any object’s drop shadow on or off.

- **Color:** Sets the drop shadow’s color. This color is black, by default.
- **Opacity:** Sets the drop shadow’s transparency.
- **Blur:** Specifies how soft the drop shadow is.
**Distance:** Sets how close or far an object’s drop shadow is to the object. The farther away a drop shadow is, the more distance there appears to be between the object and anything behind it in the composition.

**Angle:** Lets you change the direction the drop shadow falls along. Changing the Angle of the drop shadow changes the apparent direction of the light casting the shadow.
Using the Timeline

Arrange and edit the assets in your project with flexibility and ease in the Timeline. View your objects spread out over layers and tracks.

The Timeline shows all the objects in your project and provides a “big picture” look at how your project is arranged over time. You can organize your objects to begin and end on the frames you choose. You can also align multiple effects so that they occur simultaneously. You can control objects’ durations and even perform common trim operations to edit the objects as you would in a video editing program.

Additional controls let you manipulate masks, filters, behaviors, keyframes, and audio elements along with your visual footage. The Timeline ruler provides an exact reference for managing timing and synchronizing effects. You can lock tracks to prevent changes, temporarily hide an object from view, and manage links between audio and video.

Although you can perform many types of effects without ever using the Timeline, it is an essential tool when you want to manipulate the timing of the contents of your project. Motion integrates many of the features ordinarily reserved for non-linear editing software seamlessly into the compositing workflow.
The Timeline is not displayed by default in the Standard Layout. It can be viewed by displaying the Timing pane.

To display the Timing pane, do one of the following:

- Click the Timing icon (in the upper-right corner of the Toolbar).

- Drag the divider beneath the Play button in the transport controls upward.

- Choose Window > Layouts > Cinema.

- Press F6.

Cinema Layout moves the Inspector to the right side of the interface and displays the Track list in the Project pane.

*Note:* To change interface layouts, choose Window > Layouts, then choose Standard, Alternate, or Cinema. You can also create and save your own layout arrangements. See “Window Arrangements” on page 21 for more information on layouts.

If the Timing pane is already displayed, you may need to click the Timeline tab to bring it to the front.

**Getting Familiar With the Timeline**

The Timeline consists of the Layer list on the left and a track area on the right. Each object in your project appears as a colored bar, on its own horizontal track, arranged in a hierarchy identical to the Layers list in the Project pane. This allows you to quickly see each object’s place in time, as well as its relative position and duration.

You can determine the type of each object based on its appearance. Different types include layers, visual objects (such as video clips or still images), filters, behaviors, audio objects, and keyframes. Each is displayed in different colors as described below.
When you select an object, the color changes to a darker shade and the name of the object turns white. When the Timeline is in Filmstrip mode, the filmstrip frames are highlighted with a white border. See “Specifying the Track Display” on page 281 for more information on how to set different Timeline view modes.

<table>
<thead>
<tr>
<th>Item</th>
<th>How it appears</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer</td>
<td></td>
<td>A blue bar. When a layer contains multiple objects, it displays three lines and a value indicating the number of items for that section of the layer.</td>
</tr>
<tr>
<td>Image Objects</td>
<td>dolphins</td>
<td>A blue bar appears for image objects.</td>
</tr>
<tr>
<td>Masks</td>
<td>Circle Mask</td>
<td>A gray bar appears for mask objects.</td>
</tr>
<tr>
<td>Behaviors and Filters</td>
<td>Spin</td>
<td>A thin purple bar appears for filters and behaviors.</td>
</tr>
<tr>
<td>Keyframes</td>
<td>dolphins</td>
<td>Blue diamonds appear in a thin bar beneath the object that is keyframed.</td>
</tr>
<tr>
<td>Audio</td>
<td></td>
<td>A green bar appears for audio items, and displays the audio waveform.</td>
</tr>
</tbody>
</table>
Timeline Layer List
The Timeline Layer list mirrors the Layers list in the Project pane and displays your project tracks and objects and their stacking order. Behaviors, filters, and masks applied to a layer or object can also be displayed. In the Timeline Layer list, you can reorder layers and objects. This change is immediately reflected in the Layers list in the Project pane. You can also lock tracks to prevent further editing on those tracks and disable entire tracks to omit them from view in the Canvas.

Object Names
You can rename any object in Motion. This can be helpful if you are using more than one version of an asset, or if you want to categorize things into named layers. Also, masks, shapes, generators, and other content you generate within Motion are created with generic names. Renaming them allows you to better manage and keep track of them while you work.

To rename an object:
1 Double-click the name of the object.
2 Type a new name in the editable text field.
3 Press Return or Tab.

Although Motion allows you to rename objects you import from your disk, changing the object's name in the Timeline Layer list does not modify the name of the file on disk. This allows you to use one source clip multiple times and name each instance uniquely inside Motion.
Enabling Timeline Tracks
To the left of each track in the Timeline Layer list is an activation checkbox that turns that track on and off. When a track is turned off (disabled), it is ignored in the Canvas. Not only can you turn video or audio objects on and off, but you can also disable or enable effects such as masks, filters, and behaviors.

To turn visibility for an object on or off:
- Click the checkbox at the left edge of the track you want to control.

When the box is checked, visibility is on, and when the box is unchecked, visibility is off. Additionally, when a track is disabled, the entire track is dimmed in the Timeline.

Managing the Layer List
Motion allows you to collapse and expand different parts of your Layer list to show more or less data to accommodate different working styles. Individual objects with masks, generators, or filters can be collapsed to hide those effects bars. Furthermore, whole layers can be collapsed to hide all of the objects contained within them.

When an object or effect is collapsed in this manner, it still appears in the Canvas window. Unlike enabling or disabling tracks, collapsing and expanding the Timeline Layer list is only an organizational tool to help manage the view of the Timeline.

To collapse or expand an object in the Timeline:
- Click the disclosure triangle to the left of the object name. If no disclosure triangle is present, that object cannot be collapsed or expanded any further.
Adding and Deleting Layers
Motion allows you to add and delete layers directly in the Timeline Layer list. When a new layer is added, it always appears at the top of the list.

To add a layer:
• Click the New Layer button (+).

You can also add a layer by dragging a new item into your project.

To delete a layer:
1 Select the layer you want to delete.
2 Click the Delete button (-).

You can use the Delete button to remove individual tracks in addition to layers. You can also Control-click the layer, then choose Delete from the shortcut menu.

Locking Tracks
Occasionally, you may want to prevent changes to a particular item. The lock icon at the right edge of the Timeline Layer list allows you to lock an object and prevent any changes from affecting that object. An object that is locked in the Timeline also appears locked in the Layers list in the Project pane. You can also lock a mask, filter, or behavior.

When an item is locked, the bounding box in the Canvas turns from white to red. The time bar for a locked object appears with a cross-hatched pattern in the Timeline.

Locked tracks still appear in the Canvas and are included in your final output. Although you cannot make changes to a locked object, you can still copy or duplicate that object or change the object's layer order.

To lock a track:
• Click the lock icon at the right edge of the Timeline Layer list.
Audio-Video Links
Ordinarily, objects that contain both audio and video are linked together so that they always remain in sync. This link is represented by an icon in the Timeline Layer list.

Objects that are linked are always edited together in the Timeline. Operations such as cut, copy, paste, and split also affect both audio and video. However, if you ever want to break that relationship so that you can move or edit the audio or video without the other tagging along, you can disable that link and move either object freely. Beware that this may result in your audio and video playing out of sync.

To manipulate audio and video elements separately:
1. Click the link icon to the right of the object name for either the video or audio element.
2. Move, trim, or slip the audio or video bar.

The link icon also appears in the Layers list in the Project pane.

Timeline View Options
The lower-left corner of the Timeline contains several controls to customize what elements appear in the Timeline.

Audio tracks are displayed in a separate partition in the Timeline. You can resize the partitions by dragging the divider bar for each partition.
Using the Timeline

Zooming in the Timeline

You can zoom in and out in the Timeline using either the Zoom/Scroll control or the Zoom slider. Each lets you zoom in and out of the Timeline horizontally, showing more or less time in the Timeline window. As you zoom in, you can see greater detail, which lets you place objects with greater precision. As you move the Zoom slider, the Timeline remains centered on your current frame.

<table>
<thead>
<tr>
<th>Button</th>
<th>Button name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show/Hide Layers" /></td>
<td>Show/Hide Layers</td>
<td>Displays all video layers and objects.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Audio" /></td>
<td>Show/Hide Audio</td>
<td>Displays audio tracks. The waveforms appear on the audio tracks.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Keyframes" /></td>
<td>Show/Hide Keyframes</td>
<td>Displays keyframes for all tracks. Keyframes appear as blue diamonds (white when selected).</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Masks" /></td>
<td>Show/Hide Masks</td>
<td>Displays mask tracks for objects that have masks applied.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Behaviors" /></td>
<td>Show/Hide Behaviors</td>
<td>Displays behavior tracks for objects that have behaviors applied.</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Filters" /></td>
<td>Show/Hide Filters</td>
<td>Displays filter tracks for objects that have filters applied.</td>
</tr>
<tr>
<td><img src="image" alt="Set Timeline Row Size" /></td>
<td>Set Timeline Row Size</td>
<td>Click one of the “Set timeline row size” buttons to select a track size. To manually resize a track, position the pointer over the layer divider and drag the pointer up to create a smaller track, or down to create a larger track.</td>
</tr>
</tbody>
</table>

Zooming in the Timeline

You can zoom in and out in the Timeline using either the Zoom/Scroll control or the Zoom slider. Each lets you zoom in and out of the Timeline horizontally, showing more or less time in the Timeline window. As you zoom in, you can see greater detail, which lets you place objects with greater precision. As you move the Zoom slider, the Timeline remains centered on your current frame.

The Zoom/Scroll control appears at the bottom of the Timeline window and lets you scroll through your project when you drag the thumb left or right. It also lets you zoom in and out in your Timeline. It can help you navigate your project more quickly because it provides an overview of your Timeline at a glance. The width of the control represents the entire duration of your project, and the width of the thumb identifies the currently viewed segment.

If you drag the left side of the thumb, it gets longer by zooming out and encompassing the part of your Timeline to the left of your current view (earlier in time). Dragging it to the right zooms in, excluding that part of the Timeline. Dragging the right handle expands or contracts the other side. The Timeline playhead is always visible to provide a reference point for which segment of your Timeline is currently being viewed.

Chapter 4  Using the Timeline
To zoom in or out of the Timeline:

- Drag the thumb at either end of the Zoom scroll control. Drag toward the center of the Timeline to zoom in. Drag away from the center to zoom out.

Normally, the center of the current view remains fixed as you zoom in or out. If you press Shift while dragging one end of the Zoom scroll control, the opposite end remains locked in position and allows you to zoom in or out on the edge of the current view.

Adjusting the Height of the Timeline Tracks

In addition to zooming in and out in the Timeline, you can adjust the height of the tracks. Audio and video tracks may be resized separately. Some tracks, such as filters or behaviors, do not resize at all.

To adjust the height of the tracks, do one of the following:

- Drag the divider line between two layers in the Timeline Layer list. When the pointer changes to an adjust pointer, drag up to decrease the vertical size of the tracks; drag down to increase the size.

- Click one of the “Set timeline row size” buttons.

Specifying the Track Display

You can choose several different ways to display the objects within the tracks in the Timeline. You can display just the name of the object in the track, which makes the track thin, and is the easiest way to see many tracks at a time. You can choose to show the name and a thumbnail image of the object, which provides quick visual feedback and lets you identify exactly what each object is. You can also display tracks as a filmstrip, which shows a series of thumbnails, and lets you see where changes occur in a movie object. When you modify the track display setting, it changes the display for image and mask tracks in the Timeline.

To specify the track display:

1. Choose Motion > Preferences to display the Preferences window.
2. Click the Appearance icon.
3. In the Timeline section, click the Timebar Display pop-up menu, then choose the item you want.
4. Click the close box to close the Preferences window.

The bars are displayed according to your choice.
Note: When the Timebar Display is set to Filmstrip, your processing time is increased. When a filter is applied to an object, the result of the filter is displayed in the filmstrip.

Working in the Timeline
The Timeline is one of the most flexible and valuable elements of the Motion interface. This is where you can control all of the timing aspects of your project. Whether you need to line up multiple objects to begin or end together, or if you want to change which portion of a clip is used, or lengthen or shorten a particular object, the Timeline provides the tools you need.

You can add images and clips to your project using the Timeline just as you add files to the Layers list or the Canvas. You can drag objects into the Timeline Layer list, or drag them directly into the Timeline tracks. Dragging files into the Timeline tracks provides additional editing options such as compositing, inserting, overwriting, and replacing clips.

This section describes all of these functions, as well as how to add, delete, and reorder layers.

Adding Objects to the Timeline
When you add a new object to the Timeline, a drop menu appears and lets you choose how it should be incorporated into the project. You have the option to composite the new object over the existing objects, insert the new object into an existing object’s track, overwrite an existing object, or exchange the media of an existing object.
Depending on where in the Timeline you drop the object, you see different options. If you drag to a layer track, you can choose Composite, Insert, or Overwrite. If you drag to one of the objects within a layer, you get the additional choice of Exchange. The new object can appear above or below an existing object; where you release the mouse button determines placement of the new object.

**Note:** You can only use the Exchange option to exchange the same type of media. For example, the Exchange option is not available when you drag a generator or shape from the Library onto an image sequence.

If you are dropping multiple objects, you can choose Composite or Sequential from the drop menu. Sequential imports objects one after the other.

**Note:** If you release the mouse button before the drop menu appears, the default choice of Composite is applied. This means that the new object appears on top of other objects in the Canvas.

**Composite**
When you choose Composite, the new object is added to a new track within the active layer and all objects remain onscreen simultaneously.
Insert
When you choose Insert, Motion leaves the existing object in the track, but pushes it forward in time to make room for the new item. For example, if you insert a five-frame movie into a layer containing an existing object, the new movie is added to the Timeline at whichever frame you drop it, pushing the remaining frames of the original movie out five frames.

If you insert an object midway through an existing object, the existing object is split into two objects, each on its own track.

Overwrite
The Overwrite option deletes the existing object, overwriting it with your new object.

If the new object is shorter than the one currently in the layer, the Overwrite option splits the existing layer and deletes only the frames where the new object appears.
**Exchange**

Exchange is a variant of the Overwrite option, but instead of dropping the entire duration of the new object into the project, the duration of the existing object is used.

For example, if you drag a 30-second clip over a 5-second clip, choosing Exchange swaps the existing 5 seconds with the first 5 seconds of the longer clip.

Similarly, if you try to exchange a 10-second clip with one that lasts only 5 seconds, the first 5 seconds are replaced, and the remaining 5 seconds would remain.

The Exchange option transfers any filters, behaviors, and keyframes from the original object onto the new object.

**Sequential**

This drop menu option is only available when you are dropping multiple objects into the Timeline. Sequential drops objects one after another in the Timeline. For more information, see “Adding Multiple Clips to the Timeline” on page 286.

**To composite an object:**

1. Drag an object from the Library or Media tab into the Timeline tracks area. As you drag, a tooltip appears at the pointer to tell you the frame number at which you are located.
2. When you reach the frame where you want the new object to start, position the pointer over the object you want as the background, and keep the mouse button pressed until the drop menu appears.
3. Choose Composite from the drop menu.
   
   The new object is composited into the project.

**To insert an object:**

1. Drag an object from the Library or Media tab into the Timeline tracks area. As you drag, a tooltip appears at the pointer to tell you the frame number at which you are located.
2. When you reach the frame where you want the new object to start, keep the mouse button pressed until the drop menu appears.
3. Choose Insert from the drop menu.
   
   The new object is inserted into the track, breaking the original bar into two, and pushing the frames after the insertion further out in time.
To overwrite an object:
1 Drag an object from the Library or Media tab into the Timeline tracks area. As you drag, a tooltip appears to tell you the frame number at which you are located.
2 When you reach the frame where you want to the new object to start, keep the mouse button pressed until the drop menu appears.
3 Choose Overwrite from the drop menu.
   The frames of the new object replace the frames of the original object. If the original object contained more frames than the new one, the old object is split into two objects and the additional frames remain.

To exchange an object:
1 Drag an object from the Library or Media tab into the Timeline tracks area. As you drag, a tooltip appears to tell you the frame number at which you are located.
2 When you reach the object you want to exchange, keep the mouse button pressed until the drop menu appears.
3 Choose Exchange from the drop menu.
   The old object is replaced by the new object.

Adding Multiple Clips to the Timeline
When you drag more than one item to the Timeline, the objects appear on their own tracks above any existing objects. This is equivalent to performing a composite edit with a single object. A drop menu lets you choose whether the additional objects should be stacked up as a composite, or whether they should appear one after another (sequentially).

To add multiple objects as a composite:
1 **Shift**-select the files you want in the Library or Media tab, and drag them to the Timeline.
2 When you reach the frame where you want the new objects to start, keep the mouse button pressed until the drop menu appears.
3 Choose Composite from the drop menu.
The multiple clips are all edited into the project at the same point in time, each on its own track.

Alternately, you can drop the multiple objects into the Timeline Layer list. This always performs a composite edit. Also, if you release the mouse button before the drop menu appears, a composite edit is applied.

**To add multiple objects sequentially:**
1. **Command**-select the files you want in the File Browser, Library, or Media tab, then drag them to the Timeline.
2. When you reach the frame where you want the new objects to start, keep the mouse button pressed until the drop menu appears.
3. Choose Sequential from the drop menu.

The multiple clips are edited into the project, one after another, each on their own track.

**Setting Drag and Drop Preferences**
You can set preferences that specify where an item is dropped when you add it to the Timeline Layer list. You can choose between dropping items at the start of the project or at the current playhead position. You can also set the delay time before the drop menu appears.

**To specify where new objects appear in the Timeline:**
1. Choose Motion > Preferences.
   The Preferences window appears.
2. Click the Project icon.
   The Project preferences appear in the window.
3. In the Still Images & Objects section, click the appropriate button to choose to create objects at “Current frame” or “Start of project.”

   **Note:** The Create Objects At preference only applies when you drag items to the Timeline Layer list, the Layers list of the Project pane, or directly into the Canvas. Clips dropped on a specific frame within the Timeline always appear at that exact location.

**To set the drop menu delay preference:**
1. Choose Motion > Preferences.
   The Preferences window appears.
2. Click the General icon to switch to General preferences.
3. In the Interface section, adjust the Drop Menu Delay slider to set the delay pause for the drop menu.
Adding to the Timeline Layer List
You can drag an image from the File Browser or Media tab into the Timeline Layer list, which lets you add the new object to an existing layer, replace an existing object, or create a new layer.

To add an object to an existing layer:
1 Drag an object from the File Browser, Library, or Media tab, and position the pointer over the Layer list.
   • If you position the pointer over a Layer, the track is highlighted with a black border.
   • If you position the pointer between object tracks within a layer, the position indicator appears.
2 Release the mouse button to add the object to the layer.
The new object is placed on top of other existing objects in the layer, or in between the objects where you dragged it.

To replace an object in an existing layer:
1 Drag an object from the File Browser, Library, or Media tab, and position the pointer over the object that you want to replace.
A black highlight box appears around the object.
2 Release the mouse button.
The new object replaces the old one.

To create a new layer on top of existing layers:
1 Drag an object from the File Browser, Library, or Media tab into the Timeline Layer list, at the upper edge of the top layer, and keep the mouse button pressed until a position indicator appears.
2 Release the mouse button.
A new layer is created on top of other existing layers in the hierarchy or "stack" of layers.

To create a new layer below existing layers:
1 Drag an object from the File Browser, Library, or Media tab into the Timeline Layer list, below the lower edge of the bottom layer, and keep the mouse button pressed until a position indicator appears.
2 Release the mouse button.

A new layer is created below other existing layers in the hierarchy or "stack" of layers.

Managing Track Order
The Timeline Layer list provides you with the tools to control layer and object order. In Motion, the topmost track in the list appears on top of other layers in the Canvas. This means you may need to rearrange the order of objects in your project to get the effects you want.

To rearrange objects within a layer:
1 Click the icon in the Timeline Layer list for the object you want to move.
2 Drag it to the position you want between the other tracks.
3 When the position indicator appears in the location you want, release the mouse button.

The tracks are reordered.
To move an object from one layer to another existing layer:

1. Drag the object icon in the Timeline Layer list over another layer. A black border highlights the layer.

2. Release the mouse button.

The object moves into the selected layer and is placed above any existing objects within that layer.

You can also drag an object to a specific place in the new layer by dragging it in between existing tracks in the new layer. Motion's layers are "spring-loaded," which means that when they are collapsed, dragging an object onto them causes them to temporarily expand, just like folders in the Finder.

To drop an object inside a collapsed layer:

1. Drag the object onto the collapsed layer in the Layer list.

2. Position the pointer over the name of the layer until the layer springs open.

3. Release the mouse button when the object is at the desired location within the layer.
Nesting Layers

To help organize large groups of objects or to create certain kinds of special effects, you can place one layer inside of another. This gives you the flexibility to create a layer containing multiple objects, and then treat that entire layer as a single object within another layer. You could go further and take that “parent” layer, combine it with some other layers, and treat that group as a single element, and so on. This is called nesting or grouping.

There are many reasons why you might choose to nest your layers. It allows you to simplify your composite, grouping objects and layers into fewer containers. It also allows you to manipulate a group of objects as one. For example, you could take the individual letters of your title (each animated on its own) and use nesting to animate the group of them across the screen. You can also use grouping to create complex particle systems. You can nest several objects into a layer, and use the entire layer as the emitter cell. For more on particle systems, see “Working With Particles” on page 565.

Note: You cannot group objects from different layers.

To place one layer inside another:
1 Drag the layer icon in the Timeline Layer list onto the layer inside which you want to nest it.
   A black border highlights the destination layer.
2 Release the mouse button.
   The first layer is now nested inside the second layer.
You can also select the objects you want to nest and choose Object > Group (or press Shift+Command+G).
Note: There is no limit to the number of layers you can create within layers.

To return a nested layer to its original state:
• Select the grouped layer, then choose Object > Ungroup (or press Option+Command+G).
   The layer is restored into individual objects. Any layer within another layer can be ungrouped.

To remove a layer from within a nest:
1 Click the layer icon in the Layer list.
2 Drag the layer out of the existing parent layer to the area above the highest track.
   The position indicator appears.
3 Release the mouse button.
   The layer is restored to primary layer status.
To delete a layer or object track:
1 Select the layer or object in the Layer list.
2 Press Delete.

You can also Control-click an object, then choose Delete from the shortcut menu.

All of the operations just described can also be performed with multiple tracks. For example, rather than just moving one object from Layer 1 to Layer 3, you can select two or three objects within Layer 1 and move them all at once.

To select more than one object or layer track:
- Command-click each of the tracks in the Layer list that you want to include in your selection.

Splitting Tracks
Occasionally you may want to divide a single object into multiple objects. You might do this if you want an effect to apply to a portion of a clip and ignore another part, or you might want an object to change layer order midway through, to create the effect that objects are moving in 3D space. Splitting tracks allows you to turn one object into multiple pieces and then manipulate each segment of the object on its own track.

To split an object track:
1 Select the bar or track in the Layer list for the object you want to split.
2 Place the playhead on the frame where you want the split to occur.
3 Choose Edit > Split.

The object is broken into two pieces, each positioned on its own track.
Editing Objects in the Timeline

During the process of designing and implementing a motion graphics project, you place objects in the Timeline and Canvas, move them forward or backward in time, and trim them to match the timing of other objects in your project.

Motion has several features that help you modify the objects in the Timeline. You can arrange your objects to begin and end at designated frames, and to begin and end at the best frames within the clip. You can also use powerful alignment and timing tools, such as snapping and markers. When displayed, you can also modify keyframes in the Timeline. This section describes the various ways you can perform these actions in the Timeline.

Motion uses the terms move, trim, and slip to describe the different ways of editing Timeline objects.

**Move:** Changes the location of an object without affecting its content or duration.

**Trim:** Changes the duration of an object without affecting its location or content.

**Slip:** Changes the content of an object without affecting its location or duration.

**Moving Objects**

Move an object when you want it to begin and end at a different point in the project.

**To move an object:**

- In the Timeline, click an object bar and drag left or right to move it in time.

A tooltip appears that identifies the new In and Out points of the clip as you drag, so you can drag it to the frame you want. The Delta symbol (Δ) indicates the number of frames you are moving.

![Timeline object moving](image)

**To move an object and snap to neighboring items:**

- Press Shift as you drag the item in the Timeline.

Snap-to lines appear and the edges of the clip automatically line up precisely with these lines.
Moving Objects to the Playhead
You can move an object to a new location in the Timeline by using the Move Selected In (or Out) Point. This command automatically shifts the position of the selected object to the current playhead position. This command can be used to move and align multiple objects in one operation.

To move an object to the playhead:
1. Select the object you want to move.
2. Place the playhead where you want the object moved to.
3. Choose Mark > Move Selected In Point (or press {) to align the object’s beginning to the playhead or choose Mark > Move Selected Out Point (or press }) to align the end of the object to the playhead position.

Trimming Objects
Trim an object when you want to shorten or lengthen it. You can shorten or lengthen either the beginning or end of the object by dragging from the left or right edge of the object bar in the Timeline (the In and Out points).

You can also trim a clip by using the menu items and corresponding keyboard shortcuts to change an object’s In and Out point. This allows you to trim multiple objects simultaneously as well as make trimming changes on-the-fly while your project is playing back.

You can only lengthen an object if there are existing unused frames in the source media. When you click a clip, unused frames temporarily appear beyond the boundaries of the object in a lighter color. If there is no room outside of the currently used portion of the clip, no unused frames appear and you cannot lengthen the object.
**Note:** If you need to extend an object and the source material doesn't have enough frames, one option is to alter the object's End Condition to hold, loop, or ping pong. This extends the length of the object indefinitely. For more information on the End Condition parameter, see page 187.

**To trim a clip:**
1. Move the pointer to one end of the clip you want to trim.
   The pointer changes to a Trim pointer.
2. Drag the end of the bar until it reaches the frame where you want the clip to start or end.
   As you drag, a tooltip shows the new In or Out point, and the new duration of the clip.

**To trim an object and snap to neighboring items:**
- Press **Shift** as you drag the edge of the item in the Timeline.
  Snap-to lines appear, and the edge of the clip you are dragging automatically lines up precisely with these lines.

**To change an object's In or Out point:**
1. Select the object you want to trim.
2. Place the playhead on the frame where you want the new In or Out point.
3. Choose Mark > Mark In (or press **I**) to set a new In point or choose Mark > Mark Out (or press **O**) to change the Out point.
To trim multiple objects at the same time:

1. Select the objects you want to trim.
2. Place the playhead at the In or Out position you want.
3. Choose Mark > Mark In (or press I) or Mark > Mark Out (or press O) to set a new In or Out point.

All selected objects are trimmed to the new point.

**Note:** If one of the objects doesn’t have enough media to complete the trim, it moves as far as it can toward the desired point.

**Slipping Objects**

Slip an object when you want to use a different section of your clip, but you don’t want to change the object’s duration or where it appears in the Timeline. Slipping is only possible after you have trimmed a clip.

For example, if you had a shot of a door opening that was 3 seconds long and you trimmed it down to only 1 second, you could use the Slip function to select which one second to use: the first second as the door leaves the jamb, the next second where it is flying open, or the last second where it bangs against the wall.

**Note:** You can only slip an object as far as the existing unused frames in the source media.

**To slip an object:**

1. Press Option so the pointer turns into the Slip pointer.
2. Drag the middle part of the object’s bar left or right.

Dragging to the right replaces the frames with a section from later in the source material, while dragging to the left uses frames from earlier in the clip.
Deleting Objects
Removing objects from your project can be just as important as adding them. Motion provides three ways to remove an object.

Delete: Removes the object and leaves a gap in the Timeline where it was.

Ripple Delete: Removes the object and closes up the gap left behind in one step. If the objects are within a layer, the layer is split into two layers.

Cut: Deletes the object leaving the gap, and copies the object to the Clipboard for later pasting.

To delete an object:
1. Select the object you want to delete.
2. Choose Edit > Delete (or press Delete).

To ripple delete an object:
1. Select the object you want to delete.
2. Choose Edit > Ripple Delete (or press Command+Delete).
To cut an object:
1 Select an object you want to delete.
2 Choose Edit > Cut from the menu bar (or press Command+X).

You can also Control-click the object, then choose Cut from the shortcut menu.

Copy and Paste
Just like in other applications, in addition to cutting, you can also copy an object, which leaves the object in place, but copies it to the Clipboard for later pasting.

When you paste an object, it is placed at the position of the playhead.

If a layer is selected, the object is pasted into that layer above all other objects. If no layer is selected, a new layer is created for the pasted object (as illustrated above).

Change the active layer by clicking the Timeline Layer list. Pasting multiple objects retains the relative object and layer order of the Clipboard contents. New layers and tracks may be added to accommodate the paste operation.

Objects with filters behaviors, keyframes, and other effects retain those effects when cut, copied, and pasted.

To copy an object to the Clipboard:
1 Select the object(s) you want to copy.
2 Choose Edit > Copy (or press Command+C).

To paste an object:
1 Select the layer where you want the object pasted.
2 Position the playhead at the desired time position.
3 Choose Edit > Paste (or press Command+V).
Paste Special
In addition to ordinary pasting, Motion lets you paste as an insert, overwrite or exchange edit. These three commands appear in the Paste Special dialog. Paste special can also be used with regions to perform a special type of paste. For more information, see “Paste Into” on page 310.

Insert: Pastes the Clipboard contents into the project, pushing existing objects farther down in time.

Overwrite: Pastes the Clipboard contents into the project, deleting any existing objects at the same point in time.

Exchange: Replaces the selected object in the project with the Clipboard contents.

To paste an object as an insert:
1 Select the layer where you want the object pasted.
2 Position the playhead at the desired time position.
3 Choose Edit > Paste Special (or press Option+Command+V).
   The Paste Special dialog appears.
4 Select “Insert into time region.”
5 Click OK to confirm your edit.

To paste an object as an Overwrite:
1 Select the layer where you want the object pasted.
2 Position the playhead at the desired time position.
3 Choose Edit > Paste Special (or press Option+Command+V).
   The Paste Special dialog appears.
4 Select “Overwrite into time region.”
5 Click OK to confirm your edit.

To paste an object as an Exchange:
1 Select the layer where you want the object pasted.
2 Position the playhead at the desired time position.
3 Choose Edit > Paste Special (or press Option+Command+V).
   The Paste Special dialog appears.
4 Select “Exchange media with existing object.”
5 Click OK to confirm your edit.
Creating a Freeze or Hold Frame

Although there are no controls in the Timeline for holding or freezing a frame, you can create a freeze frame by using the Scrub filter.

For information on using the Scrub filter to create a freeze frame, see “Scrub” on page 791.

Displaying and Modifying Keyframes in the Timeline

You can move or delete keyframes that are displayed in the Timeline. From the Timeline pane, you can also choose to display the animation curve for a selected keyframe in the Keyframe Editor.

To display keyframes in the Timeline:
- At the bottom of the Timeline Layer list, click the Show/Hide Keyframes button.

When the button appears dark gray, it is enabled. The keyframes appear below the layer and object tracks. In the following image, the 5-sided star object has three keyframes. The keyframes appear below the layer that contains the object.

To move a keyframe’s position in time:
- Drag the keyframe to the left or right.

*Note*: Moving the keyframe in the Timeline only modifies its position in time. To directly modify the value of a keyframe, use the Keyframe Editor. For more information on the Keyframe Editor, see “Keyframes and Curves” on page 401.

To delete a keyframe or group of selected keyframes:
1. Select the keyframe or keyframes that you want to delete.
2. Control-click one of the selected keyframes, then choose Delete Keyframes from the shortcut menu.

To delete all keyframes:
- Control-click a keyframe, then choose Delete All Keyframes from the shortcut menu.
To display an animation curve in the Keyframe Editor:

- **Control**-click a keyframe on the track, then choose Show in Keyframe Editor from the shortcut menu.

The Keyframe Editor is displayed, the animation curve appears, and a new, untitled curve set is created. For more information on curve sets, see “Filtering Controls” on page 429.

**Editing in the Layer Track**

In addition to the ability to edit individual objects within layers, Motion allows you to do a variety of editing tasks directly in the Layer track, even if that track is collapsed. This allows you to collapse your tracks and do many of the functions typically limited to a dedicated nonlinear editor such as Final Cut Pro.

Ordinarily the layer bar indicates the name of the object if there is only one object and the number of composited items for areas where more than one object overlap.

**Moving Objects in the Layer Track**

Motion lets you move objects within a layer depending on where you click. You can move all of the objects within the layer as a single object by clicking the thin blue layer bar at the top of the layer track. If you click an area where only one clip exists, you move just that item. If you click an area where multiple objects overlap, dragging moves all of the overlapping items.

**To move an entire layer as a single object:**

1. Click the thin blue layer bar at the top of the layer track.

The layer can be collapsed or expanded.
2 Drag to the right or left to move the entire layer in time.

To move a single object within a layer:
1 Click the area of the layer track where the one clip is visible.
   That clip is highlighted in the layer track.
2 Drag the section left or right to move the object within the layer forward or backward in time.

Moving Objects Shortcut
In the Timeline, you can quickly move an object forward or backward a specific number of frames, or to a specific frame.
To move an object to a specific frame:

1 In the Timeline, select the object you want to move, then type the number of the frame (or timecode) where you want to move the object.

A value field appears that displays the number you typed.

2 Press Return.

The object's In point moves to the specified frame number.

To move an object a specific number of frames, do one of the following:

- To move the object forward a specific number of frames, select the object, type a + (plus) followed by the number of the frames you want to move, and then press Return.

- To move the object backward a specific number of frames, select the object, type a – (minus) followed by the number of the frames you want to move, and then press Return.

To move overlapping objects within a layer:

1 Click the area of the layer track where the overlap is indicated.

The selected area may exceed the overlapping region if an object extends beyond the overlap.

2 Drag the section to move all of the objects at once.

You can also use the shortcut menu to select any one of the overlapping objects in order to edit that object directly. This is one way that you can manipulate individual objects within a layer without having to expand the layer.
To edit one item in an overlapping area of a layer:

1. **Control**-click the overlapping area of the layer, then choose the object you want to manipulate from the shortcut menu.

   The boundaries of that one object are highlighted in the layer track.

2. Move, trim, or slip the object independently from the other objects in the layer.

**Trimming Objects in the Layer Track**

Trimming the edges of the layer track automatically trims the edges of the objects within the layer. If there is only one object, trimming the layer bar simply trims that object. If there is more than one object lined up with the edge of the layer, trimming the layer automatically trims all of those objects.

You cannot trim the edges of composited sections within the body of the layer track.
Disconnected the Layer Track From its Contents
You can modify the layer bar to be longer or shorter than the contents of the layer. For example, you might shorten a layer track to hide a section of the objects within it. Objects that extend beyond the boundaries of the layer bar (the thin blue bar at the top of the layer track) are not displayed in the Canvas.

To change the length of the layer independently from the objects within it:
- Press Command, then drag the edge of the layer track.

Only the thin blue layer bar is trimmed.

Note: Once you manually change the length of the layer bar, it is no longer automatically updated as you add or modify the objects within it. To restore automatic updating, realign the layer bar with the right edge of the last clip in the layer.

You can use this same technique to trim an object without automatically changing the duration of masks, filters, or other applied effects.

To trim an object without changing applied effects:
- Press Command while you drag the edge of the object.

Slipping Objects in the Layer Track
In addition to moving and trimming, you can slip certain objects directly in the layer bar. Any portion of the layer that only contains one object can be slipped. Areas where more than one object overlap cannot be slipped without expanding the layer and directly manipulating the individual objects.
To slip an object in the layer track:
1 **Option**-click an area of the layer where the object is located.
2 Drag to the right or left to use an earlier or later portion of the media without moving the position or duration of the object.

You can only slip an object if there are unused frames in the source media associated with that clip. For more information on slipping, see "Slipping Objects" on page 296.

**Working in the Ruler**
You can perform several types of functions using the ruler area of the Timeline. You can move the playback head to a specific frame to view the project at a specific time. You can also set In and Out points so that playback occurs only within the specified frames. In addition, you can select a range of frames, so that you can delete, cut, or paste into the selected frames.

**Navigating in the Timeline**
Motion provides many different controls for navigating the Timeline. You can directly drag the playhead to “scrub” through your project as quickly or slowly as you want, or you can jump to a specific frame. Additionally, you can automatically jump to object boundaries, markers, and other important indicators in the Timeline.

**To move the playhead to a new time, do one of the following:**
- Double-click the Current Frame field, type a frame number, then press Return.
- Drag the Current Frame value slider to the left or right to advance or rewind.
- Drag the playhead to the frame you want.
- Click the ruler at the frame number where you want to move the playhead.
- With the Canvas or Project pane active, type the timecode or frame number where you want to move the playhead. The new frame number appears in the Current Frame field in the Canvas. Press Return to jump to that frame.
- With the Timeline active, type the timecode or frame number where you want to move the playhead. The new frame number appears in the Timeline's Current Frame field. Press Return to jump to that frame.

**To move forward a specific number of frames:**
- Type “+” (plus) and then the number of frames you want to move forward.
To move backward a specific number of frames:

- Type “–” (minus) and then the number of frames you want to move backward.

To move ahead or back in seconds, minutes, or hours, type the following in the Current Frame field:

- To move forward in seconds, type a “+” (plus), then the number of seconds you want to move forward, and then type a “.” (period). For example, to move 2 seconds ahead, type +2. in the field, then press Return. To move ahead in minutes, type two periods after the number, and to move ahead in hours, type three periods after the number.

- To move backward in seconds, type a “–” (minus), then the number of seconds you want to move backward, and then type a “.” (period). For example, to move 2 seconds backward, type –2. in the field, then press Return. To move backward in minutes, type two periods after the number, and to move backward in hours, type three periods after the number.

To play back your project:

- Press the Space bar.

To move forward or backward one frame at a time, do one of the following:

- Click the “Go to next frame” or “Go to previous frame” button in the transport controls.

- Choose Mark > Go to > Previous Frame or Next Frame.

- Press the Left Arrow key to move backward or Right Arrow to move forward.

To move forward or backward ten frames at a time, do one of the following:

- Choose Mark > Go to > 10 Frames Back or 10 Frames Forward.

- Press the Shift key, then press Left or Right Arrow.

To jump directly to the beginning of the project, do one of the following:

- Click the “Go to start of project” button in the transport controls.

- Choose Mark > Go to > Project Start.

- Press Home.

To jump directly to the end of your project, do one of the following:

- Click the “Go to end of project” button in the transport controls.

- Choose Mark > Go to > Project End.

- Press End.

To jump to the next keyframe, do one of the following:

- With the animated object selected, press Shift+K.

- Choose Mark > Go to > Next Keyframe.
To jump to the previous keyframe, do one of the following:

- With the animated object selected, press Option+K.
- Choose Mark > Go to > Previous Keyframe.

For information on displaying keyframes in the Timeline, see “Timeline View Options” on page 279.

In addition to simply moving to new positions in the ruler, you can navigate directly to objects within the Timeline, such as objects, markers, and keyframes. For more information on markers, see “Adding Markers” on page 312. For more information on keyframes, see “Keyframes and Curves” on page 401.

To jump directly to the beginning or end of an object in the Timeline:

1. Select the object you want to navigate to.
2. Do one of the following:
   - Choose Mark > Go to > Selection In Point or Selection Out Point.
   - Press Shift+I (for the In point) or Shift+O (for the Out point).

Defining the Play Range

Ordinarily, clicking the Play button plays your project from the first frame until the last. However, you can change the area of your project Motion plays by modifying the In and Out points in the Timeline ruler. You might do this to focus on a particular section as you fine-tune your project or make other changes to it. Once you're done focusing on that section, you can reset the In and Out points to the beginning and end of your project.

To customize the playback In point, do one of the following:

- In the ruler, drag the In point marker from the left edge of the ruler to the frame where you want to set the In point. As you drag, the playhead also moves with your pointer. When you release the mouse button, the playhead snaps back to its previous position.
- Choose Mark > Mark Play Range In in the menu bar.
- Press Command+Option+I.

Note: Before you choose the menu item or keyboard shortcut, be sure that no objects are selected in the Timeline. If an object is selected, any command modifies the objects instead of changing the playback markers.
To customize the playback Out point, do one of the following:
- In the ruler, drag the Out point marker from the right edge of the ruler to the frame where you want to set the Out point.
- Choose Mark > Mark Play Range Out.
- Press Command+Option+O.

To reset playback In and Out points, do one of the following:
- Choose Mark > Reset Play Range.
- Press Option+X.
  The In and Out points reset themselves to the beginning and end of the project.

To navigate to playback In and Out points, do one of the following:
- Choose Mark > Go to > Play Range Start or Play Range End.
- Press Shift+Home (In point) or Shift+End (Out point).

Working With Regions
Sometimes you may want to make changes to a range of frames, known as a region. You might do this to cut or copy a section of time to remove it or move it to a new position in your project. Regions do not have to align with object edges in the Timeline. You can create a region that begins midway through an object or one that includes empty frames beyond the edges of objects.

To select a range of frames:
- Command+Option-drag in the Timeline.
  A light blue band appears over the selected frames.

To expand or contract a region:
- Position the pointer at either edge of a region to modify its end point. Click to the right to make it longer or to the left to make it shorter.

Selected regions ordinarily apply to all tracks in your Timeline. However, sometimes you only want to select one or more tracks. This allows you to make complex selections across multiple layers and tracks.
To move a region:
- Position the pointer over the region, then drag to move the region.

![Region move example]

To deselect tracks from a selection range:
- **Command**-click the track you want to deselect.

Once you have defined your selection range, you can delete the section or ripple delete the section (to delete it and close the resulting gap). You can cut or copy the section to move it to the Clipboard so you can paste it somewhere else.

**Note:** Pasting a region does not paste at the current playhead location. To quickly move the pasted region to the playhead location, press the **Shift** key while you drag the pasted object. As you approach the current playhead location, it snaps into place.

You can also paste into a region, which fills the existing region with the contents of the Clipboard.

**Paste Into**
Regions are also useful for performing a special type of paste command called **paste into**. You can define a region and paste objects into that region. You have three choices for how the paste into is performed. You can insert, pushing the existing region down in time, overwrite the existing contents of the region, or exchange the existing objects with the Clipboard contents. In all of these cases, the pasted objects never exceed the duration of the region they are pasted into.

To paste into a region:
1. Select the object that you want to copy to the Clipboard to be pasted.
2. Press `Command+C` to copy or `Command+X` to cut your selection.
3 `Command+Option`-drag to select a region of the Timeline.

4 Choose Edit > Paste Special.
   The Paste Special dialog appears.

5 Select either Insert, Overwrite, or Exchange.

6 Click OK to close the dialog.
   The Clipboard contents are pasted into the region using the method you specified. For more information on the different editing types, see “Adding Objects to the Timeline” on page 282.

**Inserting Time**
You can select a region in order to add blank playback time into your project. For example, you might want to add some black frames between two objects, or put some frames in as a placeholder for a clip you don’t yet have. This is called *inserting time*.

**To insert time into a project:**
1 `Command+Option`-drag in the ruler. Drag as wide an area as you want to insert.

2 Choose Edit > Insert Time.
   The number of frames in the region is added to the project, beginning at the end of the selected region and pushing any existing objects further out in time.

**Project Duration**
Motion projects default to ten seconds in length. You can change this duration to match the needs of your project. To learn how to change the default project duration, see “The General Tab” on page 144.
To change the project duration, do one of the following:
- Drag in the Project Duration field in the lower-right corner of the Canvas. Dragging to the right extends the length and dragging to the left shortens it.
- Click the Project Duration field and type a number into the value field.
- Choose Edit > Project Properties and change the value of the Project Duration field in the dialog.

Note: You can click the stopwatch button to switch between viewing the Project Duration field in frames or timecode.

Adding Markers
A marker is a visual reference point in the Timeline that identifies a specific frame. You can add as many markers as you want in the Timeline ruler while playing the project, or when the playhead is stopped.

Use markers to:
- Add a visual reference to a track
- Add a visual reference to a project marker in the mini-Timeline
- Align other tracks, objects, or keyframes to an important point in time
- Add notes about a particular area in your project

You can assign different colors to different types or markers and create marker groups. For example, use green to label all audio markers or gold to identify all temporary object markers.

You can add three types of markers: project markers, layer markers, and object markers. Project markers are fixed to a specific timecode value in the ruler. Layer markers are attached to a layer and move around as you move the layer. Object markers are affixed to the specific object to which they are applied.

![Image of markers](image-url)
Note: Project markers are indicated in the mini-Timeline by a fine green line. For more information on the mini-Timeline, see “The Mini-Timeline” on page 48.

To add a project marker:
1 Place the playhead on the exact frame where you want the marker to appear.
2 Check that no objects are selected, then do one of the following:
   • Choose Edit > Markers > Add Marker.
   • Press M.
A green marker is added in the gray bar above the Timeline ruler.

Alternately, you can double-click in the gray marker bar above the ruler in the Timeline or Control-click in the gray bar, then choose Add Marker from the shortcut menu.

Note: You can also press Shift+M to add a project marker at the playhead position, whether or not an object is selected.

To add a layer marker:
1 Place the playhead on the exact frame where you want the marker to appear.
2 Select the layer where you want to add the marker, then do one of the following:
   • Choose Edit > Markers > Add Marker.
   • Press M.
A red marker is added to the layer bar.

In this way, you can add markers while playing your project. The markers appear at the frame where the playhead is at the time you press the M key.
To add an object marker:
1 Place the playhead on the exact frame where you want the marker to appear.
2 Select the object where you want to add the marker, then do one of the following:
   • Choose Edit > Markers > Add Marker.
   • Press M.
A red marker is added to the object.

In this way, you can add markers while playing your project. The markers appear at the frame where the playhead is at the time you press the M key.

To move a marker:
• Drag the marker left or right to a new location.

To delete a marker, do one of the following:
• Drag the marker vertically out of the area where it resides, then release the mouse button.
  The marker disappears with a “poof.”
• Double-click the marker, then click the Delete marker in the Edit Marker dialog.
• Position the playhead over the marker, select the layer or object (for layer or object markers), then choose Mark > Markers > Delete.
• Control-click the marker, then choose Delete Marker from the shortcut menu.

Deleting All Markers
In addition to deleting one individual marker, you can delete all markers from your project in one step. This deletes either project markers or all markers in a selected layer or object.

To delete all project markers only:
1 Choose Edit > Deselect All (or press Shift+Command+A).
2 Choose Edit > Markers > Delete All Markers.

To delete all layer or object markers:
1 Select the layer or object containing the markers you want to delete.
2 Choose Edit > Markers > Delete All Markers.

Editing Marker Information
You can edit the information for a marker, including its name, starting frame, duration, and color. You can also add comments to the marker. Comments show up as a tooltip when the pointer is paused over the marker.
To edit marker information:

1. Open the Edit Marker dialog by doing one of the following:
   - Double-click a marker to display the Edit Marker dialog.
   - Choose Edit > Markers > Edit.
   - Control-click the Marker, then choose Edit Markers from the shortcut menu.

2. Type a name in Name field.

3. Type a number in the Start field.
   The marker moves to the frame number you enter.

4. Type a value in the Duration field to specify the range of frames for the marker.

5. Type text in the Comment field.
   This comment appears as a tooltip when you pause the pointer over project markers.

6. Click the color pop-up menu to display a list of eight possible colors, and choose the color you want for the marker.

7. Click OK to accept your changes.
Navigating With Markers

You can jump from your current playhead position to a nearby project marker either forward or backward.

To jump to the next marker:

- Control-click the gray marker bar above the ruler in the Timeline, then choose Next Marker from the shortcut menu.

The playhead automatically jumps to the position of the next project marker.

You can also choose Mark > Go To > Next Marker or press Option+Command+Up Arrow.

To jump to the previous marker:

- Control-click the gray marker bar above the ruler in the Timeline, then choose Previous Marker from the shortcut menu.

The playhead automatically jumps to the position of the previous project marker.

You can also choose Mark > Go To > Previous Marker or press Option+Command+Down Arrow.

You can also navigate to previous and next markers from within the Edit Marker dialog. In that case, the dialog remains open and the contents are replaced with the information for the next marker.
Using Behaviors

You can use behaviors to animate objects using simple, graphical controls. With behaviors, you can create basic motion effects or complex simulated interactions between multiple objects quickly and easily.

You can add behaviors to objects or properties in a project to create animated effects without needing to create or adjust keyframes. Drag a behavior onto an object and it is automatically animated based on the type of behavior you applied. You can customize behavior parameters in the Dashboard or in the Behaviors tab of the Inspector to change a behavior's effect.

Behaviors are designed to be flexible, and can be combined with one another to create all kinds of effects. Using behaviors, motion graphics design becomes interactive, allowing you to create complex motion effects and simulated object interactions very quickly.

Behaviors can also be used to animate nearly any individual object, particle system emitter, filter, and generator parameter. This allows you to quickly create animated backgrounds, dynamic filter effects, and incredibly complex particle systems, all using a few simple controls.

There are six different kinds of behaviors in Motion.

- **Basic Motion behaviors** are among the simplest behaviors. They animate specific parameters of the object to which they are applied. Some affect position while others affect scale or rotation. Examples include Fade In/Fade Out, Spin, and Throw.
- **Parameter behaviors** can be applied to any object parameter, and their effects are limited to just that parameter. The same Parameter behavior can be added to different parameters, resulting in completely different effects. For example, you can apply the Oscillate behavior to the opacity of an object to make it fade in and out, or you can apply it to the rotation of an object to make it rock back and forth. You can also apply Parameter behaviors to filter parameters, generator parameters, the parameters of particle systems, or even the parameters of other behaviors. Examples include Oscillate, Randomize, and Reverse.
• **Particles behaviors** are specifically designed to be applied to an Emitter object or cells within particle systems. These behaviors affect how individual particles are animated over the duration of their life. For more information on using particle behaviors, see “The Particles Behavior Category” on page 611.

• **Replicator behaviors** are specifically designed to be applied to a replicator object or cells within the replicator. These behaviors affect how the replicator cell parameters are animated over their pattern. For example, you can create an animation that travels over the replicator pattern in which each cell goes from 0 percent opacity to 100 percent. For more information on using replicator behaviors, see “Using the Sequence Replicator Behavior” on page 681.

• **Simulation behaviors** perform one of two tasks. Some Simulation behaviors, such as Gravity, animate the parameters of an object in a way that simulates a real-world phenomenon. Other Simulation behaviors, such as Attractor and Repel, affect the parameters of one or more objects surrounding the object to which they’re applied. These behaviors allow you to create some very sophisticated interactions among multiple objects in your project with a minimum of adjustments. As with the Basic Motion behaviors, Simulation behaviors also affect specific object parameters. Examples include Attractor, Gravity, and Repel.

• **Text behaviors** animate the parameters of text objects to create various animated effects. Examples include Scroll Up, which causes text to move vertically for scrolling titles or credits, and Type On, which reveals a text object letter by letter. For more information on how to use text behaviors, see “Text Animation Behaviors” on page 525 and “Text Sequence Behaviors” on page 548.
For an introduction to how to use behaviors, see “Applying and Removing Behaviors” on page 321. For more detailed information on how to manipulate behaviors in a project, see “Working With Behaviors” on page 331. For detailed information on all the behaviors available in Motion, see “Behavior Descriptions” on page 344.

**Behaviors vs. Keyframes**

It’s important to understand that behaviors do not add keyframes to the objects or parameters to which they’re applied. Instead, behaviors automatically generate a range of values which are then applied to an object’s parameters, animating it over the duration of that behavior. Changing the parameters of a behavior alters the range of values that behavior generates.

Keyframes, on the other hand, apply specific values directly to a parameter. When you create two or more keyframes with different values in a parameter in the Keyframe Editor, you animate that parameter from the first keyframed value to the last.

By design, behaviors are most useful for creating generalized, ongoing motion effects. They’re also extremely useful for creating animated effects that might be too complex or time-consuming to keyframe manually. Keyframing, in turn, may be more useful for creating specific animated effects where the parameter you’re adjusting is required to hit a specific value at a specific time.
Browsing for Behaviors

All available behaviors appear in the Library tab. Selecting the Behaviors category in the category pane of the Sidebar reveals the seven behavior subcategories. Selecting a subcategory reveals all behaviors of that type in the Library stack pane.

When you select a behavior in the Library stack, a short description and preview of it appear in the Preview area.

Note: To help you understand how each behavior works, the animated behavior previews provide hints in the form of animation paths and color coding. While most previews are self-explanatory, the Parameter previews show before/after examples of the behavior’s effect on an animated object, with the gear graphic turning red to show the object after the behavior takes effect. For Simulation behaviors, the red gear graphic shows which object in a group has the selected behavior applied to it.
Applying and Removing Behaviors

The way you apply a behavior depends on what kind of behavior it is. Some behaviors are applied directly to objects in the Canvas, while others must be applied specifically to individual object parameters in the Inspector.

Where Behaviors Appear

When you apply a behavior to an object, it appears nested underneath that object in the Layers tab and the Timeline.
New behaviors you apply to an object appear above other behaviors that were applied previously.

A Behaviors icon also appears to the right of the layer or object name in the Layers tab and Timeline. Clicking this icon enables and disables all behaviors that have been applied to that layer or object.

**Note:** Behaviors can be hidden from view in the Layers tab using the Show Behaviors button. For more information, see “Hiding and Showing Effect Objects” on page 59.

**Behavior paths**

When certain behaviors are applied to an object, a behavior path appears and displays the projected path of the object over time. Unlike animation paths created using keyframes or the path created by the Motion Path behavior, the behavior paths cannot be edited. To show or hide all types of paths, use the View pop-up menu in the Toolbar.
Behavior Effects in the Keyframe Editor

If you open the Keyframe Editor and look at a parameter that is affected by one or more behaviors, you see a non-editable curve that represents the behavior’s effect on that parameter. The non-editable curve appears in addition to that parameter’s editable curve, which can be used to keyframe that parameter.

For more information on combining behaviors and keyframes, see “Combining Behaviors With Keyframes” on page 338.

Applying and Removing Basic Motion, Particles, Replicator, Simulation, and Text Behaviors

You apply these kinds of behaviors directly to objects in the Canvas, Layers tab, or Timeline. Some behaviors automatically animate specific parameters of the object to which they’re applied. For example, the Throw behavior affects only an object’s Position parameter, and the Grow/Shrink behavior affects only an object’s Scale parameter. Other behaviors animate the parameters of other objects surrounding the one you applied the behavior to. For example, the Attractor behavior causes other objects to move toward the affected object by animating their Position parameter.

Important: Text, Particles, and Replicator behaviors should only be applied to their namesake objects.

Note: With the exception of the Custom behavior, Parameter behaviors are applied to a parameter of an object (such as position) rather than to the object itself, and are applied in a different way. For more information, see “Applying Parameter Behaviors” on page 326.
To apply a behavior to an object, do one of the following:

- Drag a Basic Motion, Particles, Replicator, Simulation, or Text behavior from the Library to an appropriate object in the Canvas, Layers tab, or Timeline Layer list.

- Select an object in the Canvas, Layers tab, or Timeline, then click the Add Behavior icon in the Toolbar and choose the behavior you want.

- Select an object in the Canvas, Layers tab, or Timeline, then select a behavior from the Library stack and click Apply in the Preview area.

To apply a behavior to multiple objects:

1. Select all of the objects to which you want to apply the behavior.

In the Layers tab, Canvas, or Timeline, **Shift**-click to select a contiguous set of objects, or **Command**-click to select individual, noncontiguous objects.
2 Do one of the following:
   • In the Toolbar, click the Add Behavior icon, then choose a behavior from one of the submenus.
   • Select a behavior in the Library, then click Apply in the Preview area.

3 Play the project to see the animated effect in action.

   **Note:** Not all behaviors automatically create motion on an object. Some behaviors, such as Throw, require you to set the throw velocity (in the Dashboard or in the Inspector) before the object is “thrown.” Other behaviors, such as Orbit Around, require a source object to be specified for that object to move around.

When a behavior is applied to an object, the object parameters affected by that behavior are automatically animated based on the behavior's default settings. For example, if you apply the Gravity behavior to an object in the Canvas, then play the project, that object's position is animated and it moves down, according to the Gravity behavior's default setting.

   **Note:** You can also apply behaviors directly to layers in the Layers tab or Timeline. Depending on the applied behavior, all objects nested within that layer are either affected as if they were a single object or as individual elements. You can often change this result by adjusting the Affect or Affect Object parameter.

   **Tip:** If you do not see the expected result when applying behaviors to objects, try turning the Affect Objects parameter on or off, or selecting a different option from the Affect pop-up menu. These parameters determine whether the entire object (such as a layer) or its components (such as the child objects nested within that layer) are affected by the behavior and how an object interacts with surrounding objects, respectively.

   **Note:** The Affect Objects checkbox only appears in the Inspector when the Throw and Spin behaviors, or the Simulation behaviors, are applied to an object that contains multiple objects, such as a layer, particle emitter, or text.

**Removing Behaviors**

Since behaviors don't add keyframes, removing a behavior instantly eliminates its animated effect. All types of behaviors are removed in the same way.

**To remove a behavior from an object:**

1 Select a behavior in the Layers tab, Timeline, Behaviors tab, or pop-up menu in the title bar of the Dashboard.

2 Do one of the following:
   • Choose Edit > Delete.
   • Control-click the behavior in the Layers tab or Timeline, then choose Delete from the shortcut menu.
   • Press Delete.
Applying Parameter Behaviors

Parameter behaviors are applied differently than the other types of behaviors. While all other behaviors are applied directly to an object and affect specific parameters of that object, Parameter behaviors are applied to an object’s parameter. This also includes the parameters of filters, emitters and cells in particle systems, and other behaviors that have been applied to an object. In a simple comparison, a Throw behavior is applied to an object and that object travels across the Canvas. If an Oscillate Parameter behavior is applied to the Position parameter of an object, that object moves back and forth across the Canvas.

A Parameter behavior’s effect on an object depends on the parameter to which it is applied. For example, if you apply the Randomize parameter behavior to an object’s Position parameter, that object drifts around the screen when the project is played. Applying the Randomize parameter behavior to an object’s Scale parameter makes the object randomly grow and shrink.

To apply a Parameter behavior to an object’s specific parameter:

1. Select an object to which you want to apply the Parameter behavior.
2. Do one of the following:
   - Control-click a parameter in the Inspector, then choose a Parameter behavior from the shortcut menu.
   - Control-click a parameter in the Dashboard, then choose a Parameter behavior from the shortcut menu.

Once a Parameter behavior is applied to a parameter, the Inspector automatically switches to the Behaviors tab.

Note: If you save a Parameter behavior as a favorite, the parameter to which it was applied is saved along with the rest of that behavior’s settings. As a result, it can be applied like any other behavior and that parameter is automatically affected.
Chapter 5  Using Behaviors

Where Parameter Behaviors Appear
When any behavior is applied to an object in your project, a Behaviors icon (a gear) appears in the Animation menu to the right of the affected parameter in the Properties, Behaviors, or Filters tab where it’s applied. This shows you that a behavior is influencing that parameter. A Behaviors icon also appears in the Animation menu of each affected parameter in the Keyframe Editor.

The Parameter behaviors also have their own Dashboards. You can use the Dashboard to quickly change the parameter to which the Parameter behavior is assigned.
Like other behaviors, Parameter behaviors appear nested underneath the objects to which they’re applied in the Layers tab and the Timeline, along with any other behaviors that have been applied to that object.

Opening a parameter’s Animation menu in the Inspector displays the names of all the behaviors currently applied to that parameter. Choosing one automatically opens that object’s Behaviors tab.
Reassigning a Parameter Behavior to Another Parameter

Once you apply a Parameter behavior, it remains assigned to that parameter unless you reassign it. This is possible using the Apply To pop-up menu, located at the bottom of the Parameter behavior controls in the Behaviors tab or in the Dashboard.

The Apply To pop-up menu displays all of the properties available for the object to which the behavior is applied. If an object has other behaviors or filters applied to it, those parameters also appear within submenus of the Apply To pop-up menu.

To reassign a Parameter behavior to another parameter in the Dashboard:
1. In the Layers tab, Timeline, or Behaviors tab of the Inspector, select the Parameter behavior you want to reassign.
2. In the Dashboard, choose a new parameter from the Apply To (“Go”) pop-up menu.

The Parameter behavior is applied to the newly chosen parameter and the Apply To field is updated to reflect the new assignment. In the Inspector, the Behaviors icon now appears next to the new parameter.

To reassign a Parameter behavior to another parameter in the Inspector:
1. Select the object with the Parameter behavior you want to reassign.
2. Open the Behaviors tab in the Inspector.
3. Choose a new parameter from the Apply To (“Go”) pop-up menu.

Customizing Behaviors

Each behavior has a subset of parameters that appear in the Dashboard. In addition, all behavior parameters appear in the Behaviors tab of the Inspector. Both the Dashboard and the Behaviors tab reference the same parameters, so changing a parameter in one automatically changes the same parameter in the other.
Customizing Parameters in the Dashboard

In general, the parameters that appear in the Dashboard are the most essential ones for modifying that behavior’s effect. Frequently, the controls available in a behavior’s Dashboard are also more descriptive and easier to use than those in the Behaviors tab, although the Behaviors tab may contain more controls. For example, compare the controls for the Fade In/Fade Out behavior in the Behaviors tab to those available in the Dashboard:

As you can see, the controls in the Dashboard consolidate two of the parameters available in the Behaviors tab into a single, graphical control. There are times, however, when it may be more desirable to use a behavior’s individual parameters to finesse the effect you’re trying to achieve with greater detail.

To display the Dashboard for a behavior:
1. Select an object with a behavior applied to it.
2. Do one of the following:
   • Select the behavior you want to modify in the Layers tab, Timeline, or Behaviors tab.
   • Control-click an object in the Canvas, then choose a behavior from the Behaviors submenu in the shortcut menu.
3. Make adjustments to the behavior using the controls in the Dashboard.

   Note: If the Dashboard doesn’t appear, you may need to choose Window > Show Dashboard (or press F7).

To switch among behaviors in the Dashboard, do one of the following:
• Click the disclosure triangle in the title bar of the Dashboard to open a pop-up menu that displays all of the behaviors and filters that are applied to that object. Choose a behavior from this list to display its parameters in the Dashboard.
• Select an object in the Canvas, then press D to cycle among all of the available Dashboard controls for that object.

Customizing Parameters in the Behaviors Tab of the Inspector

The Behaviors tab of the Inspector displays every behavior that’s applied to the selected object. A disclosure triangle to the left of each behavior’s name reveals all of that behavior’s parameters. Unlike the Dashboard, the Behaviors tab displays every parameter for a behavior.
To display the Behaviors tab:
1 Select an object with a behavior applied to it.
2 Open the Inspector, then click the Behaviors tab.

All of the behaviors applied to that object appear in the tab.

Working With Behaviors
This section describes how to enable, rename, lock, duplicate, move, and reorganize behaviors in your project. These procedures apply to every type of behavior.

Enabling, Renaming, and Locking Behaviors
When you apply a behavior to an object, it appears in three different places—the Layers tab, the Timeline, and the Behaviors tab of the Inspector.

While the Behaviors tab in the Inspector contains all of the editable parameters for a behavior that's been applied to an object, the Layers tab and Timeline have several controls for each behavior.

Activation checkbox: Turns each individual behavior on or off. Behaviors that are turned off have no effect on the object to which they're applied.

Name: Double-click this field to rename the behavior.

Lock: Click the lock control to lock or unlock a behavior. You cannot modify the parameters of a locked behavior.

Enable/disable behaviors control: A Behaviors icon (a gear) appears to the right of the name of each object with one or more behaviors applied to it. Clicking this icon toggles all behaviors applied to that object on and off.
**Note:** Control-clicking this icon opens a shortcut menu that displays all the behaviors that are applied to that object. Choose a behavior from this menu to display it in the Inspector.

![Activation checkbox](image1)

- **Activation checkbox:** Enables/disables behaviors.
- **Name:** Displays the name of the behavior.
- **Enable/disable behaviors:** Controls the visibility of behaviors.

**Show Behaviors button:** Appears at the bottom of the Layers tab and Timeline, and lets you show or hide all behaviors. This button neither enables or disables behaviors that have been applied to objects in your project; it only controls their visibility.

![Show Behaviors button](image2)

**Copying, Pasting, and Moving Behaviors**

After you have added behaviors to an object, there are a number of ways you can copy and move them among the other objects in the Timeline or Layers tab.

Behaviors can be cut, copied, and pasted like any other object in Motion. When you cut or copy a behavior in the Timeline or Layers tab, you also copy the current state of all that behavior’s parameters.

**To cut or copy a behavior:**

1. Select a behavior.
2 Do one of the following:
   • Choose Edit > Cut (or press Command+X) to remove the behavior and place it on the Clipboard.
   • Choose Edit > Copy (or press Command+C) to leave the behavior there, and copy it to the Clipboard.

To paste a behavior:
1 Select an object into which you want to paste the behavior.
2 Choose Edit > Paste (or press Command+V).

The cut or copied behavior is applied to the selected object, with all its parameter settings intact.

You can also move a behavior from one object to another in the Layers tab or Timeline Layer list by simply dragging it.

To move a behavior from one object to another:
• In the Layers tab or Timeline Layer list, drag a parameter behavior from one object and drop it on top of another.

Note: If you move a parameter behavior to another object, it is applied to the same parameter it affected in the previous object—as long as the corresponding parameter exists. If the parameter does not exist, the parameter assignment (Apply To field) is set to none.

You can also duplicate a behavior in place.

To duplicate a behavior:
1 Select the behavior you want to duplicate.
2 Do one of the following:
   • Choose Edit > Duplicate (or press Command+D).
   • Control-click the behavior you want to duplicate, then choose Duplicate from the shortcut menu.
You can also duplicate a behavior and apply the duplicate to another object in the Layers list or Timeline Layer list.

**To drag a duplicate of a behavior to another object:**
1. Press *Option*, then click the behavior you want to duplicate.
2. Drag the behavior to the object you want to apply its duplicate to.
3. Release the mouse button.

The duplicated behavior is applied to the second object.

When you duplicate an object, you also duplicate all behaviors that have been applied to it. This way, if you're creating a project with a number of objects that all need to use the same behavior, you can simply apply that behavior to the first instance of that object, and then duplicate that object as many times as necessary.

**Applying Multiple Behaviors to an Object**
There is no limit to the number of behaviors you can add to an object. When multiple behaviors are applied to a single object, they all work together to create a final animated effect.

Since each behavior applies a value to a specific parameter, the values generated by all behaviors that affect the same parameters are combined to create the end result. For example, applying the Throw, Spin, and Gravity behaviors to a single object results in the combined result of the Throw and Gravity behaviors affecting the position of the object, and the Spin behavior affecting its rotation.

**Reordering Behaviors**
When you apply a number of behaviors to a single object, they all appear nested beneath that object in the Timeline and Layers tab. You can change the order in which they are applied. While the effects of most behaviors on a parameter are additive, this is useful more as an organizational tool than as a way to change the animated effect created by the behaviors. One notable exception to this is the Stop behavior. It suspends the activity of all behaviors appearing beneath it that affect the same parameter, while not affecting any behaviors above it.
To reorder a behavior:

1. In the Inspector, Timeline, or Layers tab, select the behavior you want to reorder.
2. Drag it up or down in the list of nested behaviors applied to the same object. A position indicator shows where the behavior appears when you release the mouse button.
3. When the position indicator is in the correct position, release the mouse button.

Changing the Timing of Behaviors

You can change a behavior’s timing to control when it starts, how long it lasts, and when it stops. There are several ways to do this. You can use the Stop parameter behavior to suspend one or more behavior’s effects on a single parameter. You can also trim each behavior in the Timeline. Finally, you can change some behaviors’ Start Offset parameter to delay their beginning, and their End Offset to end the behavior prior to the end of the object to which they are applied. This includes the Fade In/Fade Out, Grow/Shrink, and Motion Path behaviors.

Using the Stop Behavior

The easiest way to control behavior timing is to use the Stop parameter behavior. The Stop behavior halts the animation occurring in any one parameter, whether it’s due to keyframes in the Keyframe Editor, or behaviors that have been applied to that object.

To stop a parameter from animating with the Stop parameter:

1. Select an object, then open the Properties tab in the Inspector.
2. If the Create Objects At preference is set to Current Frame, move the playhead to the frame where you want animation to stop.
3. Control-click the parameter you want to stop, then choose Stop from the shortcut menu.
4. Open the Inspector and click the Behaviors tab to reveal the Stop behavior’s Apply To parameter, then choose a parameter to stop.

The Stop behavior halts the animation of all behaviors that affect the selected parameter of that object. To control when animation affecting that parameter is stopped, trim the stop behavior in the Timeline. For more information on trimming behaviors, see the next section on page 336.
For more information about applying Parameter behaviors, see “Applying Parameter Behaviors” on page 326.

**Trimming Behaviors**

When you apply a behavior to an object, the duration of the behavior in the Timeline defaults to the duration of the object to which it's applied.

A behavior’s duration can be modified to limit the duration of its effect. For example, if you apply the Spin behavior to an object, by default that object spins around for its entire duration. If you trim the Out point of the Spin behavior, the spinning stops at the new position of the Out point.

To change the duration of a behavior in the Timeline:

1. Move the pointer to the In or Out point of any behavior in the Timeline.
2. When the pointer changes to the Trim pointer, do one of the following:
   - Drag the In point to delay the beginning of the behavior’s effect.
   - Drag the Out point to end the behavior’s effect prior to the end of the object.

   **Note:** When you drag the In or Out point of a behavior, a tooltip appears and displays the new location and duration of the In or Out point.
Since behaviors do not add keyframes to the objects to which they're applied, trimming the Out point of a behavior usually resets the object to its original state for times beyond the duration of the behavior. For many behaviors, using the Stop behavior to pause the object’s animation is a better method to use than trimming its Out point. Another way to stop a behavior’s effect and leave the affected object in the transformed state is to adjust a behavior’s Start and End Offset parameters. See “Changing the Offset of Parameter Behaviors” on page 337 for more information.

**Note:** The Spin and Throw behaviors leave the object at the transformed state after the last frame of the trimmed behavior for the object’s remaining duration.

### Moving Behaviors in Time

In addition to changing a behavior’s duration, you can also move its position in the Timeline relative to the object it’s nested under. This lets you set the frame at which that behavior begins to take effect.

**To move a behavior in the Timeline:**

1. Click anywhere within the middle of a behavior’s bar in the Timeline.
2. Drag the behavior to the left or right to move it to another position in the Timeline.

As you move the bar, a tooltip appears and displays the new In and Out points for the behavior. It also displays the delta value, which shows the number of frames you have moved the bar.

### Changing the Offset of Parameter Behaviors

Parameter behaviors have two additional parameters, Start Offset and End Offset, which are used to change the frame where a parameter behavior’s effect begins and ends.

The Start Offset parameter has a slider that lets you delay the beginning of the behavior’s effect, relative to the first frame of its position in the Timeline. You can adjust this parameter to make the parameter behavior start later.

The End Offset parameter lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, lets you freeze the behavior’s effect on the object for its remaining duration.
Combining Behaviors With Keyframes

Any object can have both behaviors and keyframes applied to it simultaneously. When this happens, the values generated by the behavior and the keyframed values that are applied to the parameter itself are combined to yield the final value for that parameter. This lets you combine the automatic convenience of behaviors with the direct control of keyframing to achieve your final result.

For example, if you apply the Random Motion behavior to an object, that object might weave around onscreen with a completely random animation path similar to the following:

If you turn the Random Motion behavior off temporarily and create an animation path using keyframes, you can create a completely predictable and smooth movement.

Keyframed animation path
You can combine the two by turning the Random Motion behavior back on, with the end result being an animation path that follows the general direction you want, but that has enough random variation in it to make it interesting.

While this example shows how you can combine behaviors and keyframes to create animation paths, you can combine behaviors and keyframes for any parameter.

**Combining Behaviors and Keyframes in the Keyframe Editor**

When you display a parameter that's affected by a behavior in the Keyframe Editor, two curves appear for that parameter. An uneditable curve in the background displays the parameter as it's affected by the behavior. There are no keyframes over this first curve. Superimposed over it is the parameter's editable curve.
You can keyframe a parameter either before or after applying a behavior to the object that affects it. When you keyframe a parameter that is already affected by a behavior, the value of the keyframed curve is combined with the value generated by the behavior at each frame, which either raises or lowers the resulting value displayed by the background curve. The background curve doesn’t just display the behavior’s animated values, it displays the sum of all values affecting that parameter.

Raising or lowering a keyframe in the Keyframe Editor also raises or lowers the background curve, since it’s modifying the values generated by the behavior.

**Important:** The value displayed in the Inspector for the affected parameter reflects the final combined result of both keyframes and behaviors that are applied to that parameter. Editing a parameter’s values directly in the Inspector only results in changes made to the underlying parameter value, whether keyframed or not. This parameter value is then combined with the behavior’s effect, yielding a final value that may differ from the value you entered.
For more information on how to use keyframes in the Keyframe Editor, see Chapter 6, “Keyframes and Curves,” on page 401.

**Note:** When you combine keyframes with multiple behaviors, the results can appear to be unpredictable, depending on the combination of behaviors that are applied.

You can convert the behaviors that are applied to all parameters of an object into keyframes. Converting behaviors that have already been combined with keyframes turns the sum of all behaviors and keyframes affecting that parameter into a thinned series of keyframes. This results in a final animation curve that closely replicates the shape of the background curve that appeared in the Keyframe Editor. These keyframes can then be edited directly in the Keyframe Editor.

For more information on converting behaviors into keyframes, see “Converting Behaviors to Keyframes” on page 343.

**Animating Behavior Parameters**
You can animate most behavior parameters in order to change the parameter's effect over time. You can animate behavior parameters using parameter behaviors, or by keyframing them in the Keyframe Editor.
Applying Parameter Behaviors to a Behavior

You can animate a behavior’s parameter by applying a parameter behavior. For example, you could apply the Oscillate parameter behavior to an Orbit Around behavior’s Drag parameter and adjust the Start and End values to increase from 0 to 8 over time. This results in the orbit of the object slowly decaying, causing the object to fall toward the center of the orbit.

For more information about adding parameter behaviors, see “Applying Parameter Behaviors” on page 326.

Keyframing Behaviors

If you need more control when animating a behavior’s parameters, you can use keyframes. For example, you can keyframe the Drag parameter of the Orbit Around behavior to grow and shrink the object’s orbit many times, creating a much more complex animation path. Keyframing this animation path manually would be very difficult, but by keyframing a single parameter within a single behavior, you can create this effect with ease.
For more information about keyframing parameters, see "Animating Behaviors" on page 412.

**Converting Behaviors to Keyframes**

If necessary, you can bake all the behaviors that have been applied to an object into keyframes using the Convert to Keyframes command in the Object menu. When you use the Convert to Keyframes command on an object in your project, all behaviors that are applied to that object are converted to keyframes. The keyframes are applied to the individual parameters the behaviors originally affected.

When behaviors that are applied to other objects affect the object being converted (for example, the Attractor or Repel behavior), their effect is baked into the object's resulting keyframes value. The original behaviors remain applied to the other objects, but the resulting effect is not doubled up as a result of the keyframes combining with the behavior.

**To convert behaviors to keyframes:**

1. Select an object that has behaviors you want to convert.
2. Choose Object > Convert to Keyframes (or press Command+K).
   A sheet drops down and prompts you to confirm the conversion to keyframes.
3. Click Convert.

   All behaviors are converted into keyframes, which appear in the Keyframe Editor.

   **Note:** You cannot selectively convert individual behaviors. The Convert to Keyframes command converts all behaviors that are applied to an object at once.

**Saving and Sharing Custom Behaviors**

If you customize a behavior and you want to save it for future use, you can drag it to the Favorites folder in the Library. Once a behavior is placed into the Library, it can be applied to objects like any other behavior in the Library.

**To save a behavior to the Library:**

1. Open the Library and select the Behaviors, Favorites, or Favorites Menu category.
2. Drag the customized behavior you want to save from the Layers tab, Timeline, or Inspector into the stack at the bottom of the Library.

   **Note:** For organizational purposes, you may find it useful to create a new folder of your own in the Favorites or Favorites Menu category to contain your customized behaviors. All custom behaviors appear in the Behaviors category, regardless of whether they were dragged into the Favorites or Favorites Menu category.

When you save a customized behavior, it's saved in the *Users/User Directory/Library/Application Support/Motion/Library/* folder.
Moving Behaviors Among Different Computers
Each customized behavior you drag into the Library is saved as a separate file in the
Motion folder of the Application Support directory. For example, if you saved a custom
behavior named My Motion Path in the Favorites folder of the Library, it would appear
in the Users/Users Directory/Library/Application Support/Motion/Library/Favorites folder
with the following icon.

If you've created one or more custom behaviors that you rely upon, you may want to
move them to other computers that have Motion installed.

To copy a custom behavior to another computer:
1 Quit Motion.
2 Copy one or more Motion custom preset files to that computer's Users/Users Directory/
   Library/Application Support/Motion/Library/ folder.
3 Restart Motion.

Behavior Descriptions
This section explains the parameters that are available for each behavior in Motion,
presented by category.

Basic Motion Behaviors
Basic Motion behaviors animate specific parameters of the object to which they are
applied. Some affect position, while others affect scale, rotation, or opacity.

Fade In/Fade Out
Lets you dissolve into and out of any object. The Fade In/Fade Out behavior affects the
opacity of the object to which it's applied, fading from 0 percent opacity to 100 percent
opacity at the beginning of the clip, and then back to 0 percent opacity at the end. You
can eliminate the fade in or out by setting the duration of either to 0 frames.

Note: This behavior is multiplicative. This means that the Fade In and Fade Out
parameters are multiplied by the object's current opacity to produce the resulting level
of transparency.
The Fade In/Fade Out behavior is useful for introducing and removing images you’re animating in the middle of a project. For example, you could apply the Fade In/Fade Out behavior to text objects moving slowly across the screen to make them fade into existence, and then fade away at the end of their duration.

### Dashboard control

The Dashboard lets you control the Fade In and Fade Out durations, equivalent to the Fade In Time and Fade Out Time parameters in the Behaviors tab of the Inspector. Drag anywhere within the shaded area of the Fade In or the Fade Out ramp to adjust their durations.

**Note:** You can extend the durations of the Fade In or Fade Out past the limits of the graphical Dashboard control.

### Parameters in the Inspector

**Fade In Time:** A slider defining the duration, in frames, over which the object fades in from 0 to 100 percent opacity from the first frame of the object. A duration of 0 frames results in a straight cut into the object, making it appear instantly.

**Fade Out Time:** A slider defining the duration, in frames, over which the object fades out from 100 to 0 percent opacity from the last frame of the object. A duration of 0 frames results in a straight cut away from the object, making it disappear instantly.

**Start Offset:** A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter value is measured in frames.

**End Offset:** A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Use this slider to offset the end of the Fade Out effect from the end of the object.
Grow/Shrink
Use the Grow/Shrink behavior to animate the scale of an object, enlarging or reducing its size over time at a speed defined by either the Scale Rate or Scale To parameter. The Grow/Shrink effect always begins at the object’s original size at the first frame of the behavior.

Tip: To scale particles over their lifetime, use the Scale Over Life particle behavior. For more information, see “The Particles Behavior Category” on page 611.

Note: The vertical and horizontal growth rates can be set to independent values, for asymmetrical effects.

The Grow/Shrink behavior is a good one to use with high resolution graphics to zoom into an image, such as a map or photograph. You can also combine this behavior with the Throw or Wind behavior to pan across the image while zooming into it.

It can also be used to emphasize or de-emphasize images in your project. You can enlarge objects to make them the center of attention, or shrink an object while introducing another to move the viewer’s eye to the new element.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Scale</td>
</tr>
</tbody>
</table>

Dashboard control
The Grow/Shrink Dashboard consists of two rectangular regions. The first, a rectangle with a dotted line, represents the original size of the object. The second is a solid rectangle that represents the relative growth rate, and can be resized by dragging any of the borders. Enlarge the box to grow the target object, or reduce the box to shrink it. A slider to the right lets you adjust the scale of the Dashboard controls, increasing or decreasing the effect the controls have over the object.
Parameters in the Inspector

Increment: This pop-up menu lets you choose how the behavior’s effect progresses over its duration in the Timeline. There are two options:

• Continuous Rate: This command uses the Scale Rate parameter to grow or shrink the object by a steady number of pixels per second.
• Ramp to Final Value: This command grows or shrinks the object from its original size to the specified percentage plus the original scale in the Scale To parameter. If the behavior is shortened in the Timeline, the Grow/Shrink effect goes faster.

Scale Rate/Scale To: Depending on the command chosen in the Increment pop-up menu, the Scale Rate or Scale To parameter defines the speed and magnitude of the effect. This parameter can be opened into X and Y subparameters by clicking the disclosure triangle to the left. This lets you adjust the horizontal or vertical scale independently.

Curvature: This parameter lets you adjust the acceleration with which this behavior transitions from the original to the final size. Higher Curvature values result in an easing into and out of the effect, where the object slowly starts to change size, and this change gradually speeds up as the behavior continues. Curvature does not affect the overall duration of the effect since that is defined by the length of the behavior in the Timeline, minus the End Offset.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Use this slider to offset the end of the Grow/Shrink effect from the end of the object.
Motion Path
The Motion Path behavior lets you create a motion path for an object to follow. When you first apply the Motion Path behavior to an object, it defaults to a straight line defined by two points at the beginning and end of the motion path. The first point on the path is the position of the object in the Canvas at the first frame of the behavior. You can double-click or Option-click anywhere on the path to add Bezier points, which allow you to reshape the motion path by creating curves.

When you play the project, the object moves along the assigned path. The speed at which the target object travels is defined by the duration of the behavior, minus the End Offset parameter. Speed is also affected by the Speed parameter, which lets you modify the object’s velocity—adding acceleration and deceleration at the beginning and end of the behavior, for example. You can also create a custom preset defining how the object travels along the path.

The Motion Path behavior is an easy way to create predictable motion without having to use the Keyframe Editor. It’s also a great way to create reusable motion paths that you can save in the Library for future use.

Note: For more information on manipulating Bezier curves, see “Editing Bezier Curve Control Points” on page 832.

Affects Parameters affected
Object Position

Dashboard control
The Dashboard lets you set the Speed control using a pop-up menu, with options for Constant, Ease In, Ease Out, Ease Both, Ping-Pong, Accelerate, Decelerate, and Custom. When you choose Custom from the menu, the Custom Speed parameter is also available.
Additional onscreen controls

The motion path you create in the Canvas can be adjusted by adding points to the default motion path and by using the Bezier controls attached to each point to adjust each curve. For more information about creating and adjusting Bezier curves, see “Editing Bezier Curve Control Points” on page 832.

Parameters in the Inspector

**Speed:** Lets you set how the object moves from the first to the last point in the motion path. There are eight choices:

- **Constant:** The object moves at a steady speed from the first to the last point on the motion path.
- **Ease In:** The object starts at a slow speed, then reaches and maintains a steady speed through the last point on the motion path.
- **Ease Out:** The object starts at a steady speed, then slows down as it gradually decelerates to a stop at the last point of the motion path.
- **Ease Both:** The object slowly accelerates from the first point on the motion path, and then slows down as it gradually decelerates to a stop at the last point of the motion path.
- **Ping-Pong:** The object moves twice as fast along the path until it reaches the last point on the path, then it moves backward and stops at the first point on the path.
- **Accelerate:** The object moves along the path with increasing speed.
- **Decelerate:** The object moves along the path with decreasing speed.
- **Custom:** Custom allows you to define the movement of the object along its path by setting keyframes for the object’s speed from 0 to 100 percent. In other words, you determine the position of the object along the path in time.

**Custom Speed:** This parameter becomes available when Speed is set to Custom. You can modify the Custom Speed velocity curve in the Keyframe Editor. You can keyframe custom values to make an object, for example, travel forward to a specific percentage of the path, then backward, then forward, and so on, before it reaches the end of the animation.

**Note:** If you change the Speed parameter to a preset (such as Constant) after creating a custom speed, the custom velocity channel is ignored but remains intact.

To use the Custom Speed parameter:

1. In the Inspector or Dashboard, choose Custom from the Speed pop-up menu. The Custom Speed parameter becomes available. By default, a keyframe is set at the first and last points of the behavior to create an animation of 0 percent to 100 percent, where at 0 the object is at the beginning of the path, and at 100 the object is at the end of the path. This the same velocity used with the Constant preset.

2. Enable Record (press A).
3 Move the playhead to the position you want to create a keyframe, then enter a value in the Custom Speed field.
   
   For example, a value of 90 moves the object 90 percent of the way through the motion path.

4 Continue moving the playhead and adding keyframes to obtain the result you want.

   End Offset: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the object reach the end of the motion curve before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the object at the end of the motion path for the remaining duration of the object. Trimming the end of the behavior speeds up the object.

Related behaviors
   “Gravity,” “Random Motion,” “Throw,” “Wind”

Snap Alignment to Motion
   This behavior aligns the rotation of an object to match all changes made to its position along an animation path. This behavior is meant to be combined with behaviors that animate the position of an object, or with a keyframed animation path you create yourself.

   Before

   After, with Snap Alignment to Motion applied to arrow

For example, if you have a graphic of a fish to which you’ve applied the Motion Path behavior, you can add the Snap Alignment to Motion behavior to make the fish point in the direction it is moving.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Rotation</td>
</tr>
</tbody>
</table>
Dashboard control
The Dashboard has a pop-up menu to control the axis used to adjust the object's alignment, and a checkbox to let you invert the axis.

Parameters in the Inspector

Axis: A pop-up menu that lets you specify whether the object aligns itself on its horizontal or vertical axis.

Invert Axis: If the object is aligning on the correct axis, but appears backwards, this checkbox flips the object so that it faces the proper direction.

Related behaviors
“Align To Motion”

Spin
Apply the Spin behavior to animate the rotation of an object, spinning it either clockwise or counter-clockwise. If you trim the end of the Spin behavior to be shorter than the duration of the object to which it's applied, it remains at the angle of the last frame of the behavior, as long as there are no other behaviors or keyframes affecting that object's Rotation parameter.

Uses for Spin are fairly obvious, but another way to use the Spin behavior is with objects that have an off-center anchor point. Since objects rotate around the anchor point, if you change an object's anchor point before you apply a Spin behavior to it, you can quickly change the look of the motion you create. For more information on changing an object's anchor point, see “Changing an Object’s Anchor Point” on page 234.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Rotation</td>
</tr>
</tbody>
</table>

Dashboard control
The Spin behavior’s Dashboard control is a ring. Drag anywhere within the ring to manipulate an arrow that indicates the direction the object spins. Adjust the length of the arrow to change the speed at which the spinning occurs. The arrowhead indicates the object's final angle once the spinning effect is finished.
**Note:** You can spin the arrow around the ring multiple times to rotate the object faster.

Parameters in the Inspector

**Affect Objects:** This parameter appears when Spin is applied to a layer or object (such as a particle emitter or text) that contains multiple objects. When this checkbox is turned on (default), each object within the parent object rotates as an individual object. When this checkbox is turned off, the entire layer or object spins.

**Increment:** This pop-up menu lets you choose how the behavior’s effect progresses over its duration in the Timeline. There are two choices:

- **Continuous Rate:** This command uses the Spin Rate parameter to spin the object by a steady number of degrees per second.
- **Ramp to Final Value:** This command spins the object for the number of degrees specified in the Spin To parameter over the behavior’s duration in the Timeline.

**Spin Rate/Spin To:** A dial controlling the speed at which the object spins. The Spin Rate defines a continuous rate of spin in degrees per second. Spin To defines a number of degrees to spin over that object’s duration. Negative values result in clockwise motion, while positive values result in counter-clockwise motion.

**Throw**

The Throw behavior is the simplest way of setting an object in motion. Controls let you adjust the speed and direction of a single force that’s exerted on the object at the first frame of the behavior. After this initial force is applied, the object continues drifting in a straight line at the same speed, for the duration of the Throw behavior.

A simple example of using the Throw behavior is to send a series of offscreen text objects moving across the screen. When used in conjunction with other behaviors such as Grow/Shrink and Fade In/Fade Out, you can create sophisticated moving titles without keyframing a single parameter.
The Throw behavior is also useful when you're moving an object through a simulation. For example, you might move the object past other objects that have Attractor or Repel behaviors applied to them. Since the Throw behavior only applies a single force to move the target object at the initial frame of the behavior, any other behaviors that interact with the target object have greater influence over its motion.

**Important:** The Throw behavior does not apply a continuous force, nor can you create changes in direction or speed, since this behavior cannot be keyframed. If you need to create keyframed changes in direction or speed, use the Wind behavior. If you need to create a more complex animation path, use the Motion Path behavior.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Position</td>
</tr>
</tbody>
</table>

**Dashboard control**
The Dashboard lets you specify the direction and speed of the Throw behavior by dragging an arrow within a circular region. The direction of the arrow defines the direction of movement, and the length of the arrow defines speed. A slider to the right lets you adjust the scale of the Dashboard control, increasing or decreasing the effect the control has over the object.

Press the **Shift** key while dragging the arrow to constrain it to 45 degree angles. Press the **Command** key to change the arrow’s direction without affecting its length.

**Note:** The maximum speed you can define with the Dashboard is not the maximum possible speed. Higher values can be entered into the Continuous Rate or Ramp to Final Value parameter in the Behaviors tab of the Inspector.
Parameters in the Inspector

Affect Objects: This parameter appears when Throw is applied to a layer or object (such as a particle emitter or text) that contains multiple objects. When this checkbox is turned on (default), each object within the parent object moves as an individual object. When this checkbox is turned off, the entire layer or object moves.

Increment: This pop-up menu lets you choose how the behavior’s effect progresses over its duration in the Timeline. There are two choices:

- Continuous Rate: This command sets the speed of the object at a steady number of pixels per second, specified in the Throw Velocity parameter.

  Note: If the Canvas is displaying a nonsquare pixel image, the vertical rate is in pixels per second, and the horizontal rate is the perceptual equivalent.

- Ramp to Final Value: This command moves the object from its original position to the specified distance (in pixels) in the Throw Distance parameter.

Throw Velocity/Throw Distance: When the Increment pop-up menu is set to Continuous Rate, the Throw Velocity parameter appears, which lets you set a continuous speed for the object to move. When the Increment pop-up menu is set to Ramp to Final Value, the Throw Distance parameter appears, which sets a total distance (in pixels) for the object to travel over its duration.

Related behaviors
“Motion Path,” “Gravity,” “Random Motion,” “Wind”

Parameter Behaviors
These behaviors can be applied to any object parameter that can be animated, and their effects are limited to just that parameter. The same parameter behavior can be added to different parameters, resulting in completely different effects. For example, you can apply the Oscillate behavior to the opacity of an object to make it fade in and out, or you can apply it to the rotation of an object to make it rock back and forth. You can also apply parameter behaviors to filter parameters, generator parameters, the parameters of particle systems, or even the parameters of other behaviors. Examples include Oscillate, Randomize, and Reverse.

Average
This behavior smooths the transition from one value to another caused by keyframes and behaviors that are applied to a parameter. Use the Average behavior to smooth out animated effects. Averaged motion moves more fluidly, while averaged changes to parameters such as Opacity and to filter parameters appear to happen more gradually. Use the Window Size parameter to adjust the amount by which to smooth the affected parameter.
Tip: The Average behavior can be used to smooth out the sequence of values generated by a Randomize behavior.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
<td>Any</td>
</tr>
</tbody>
</table>

Dashboard control
The Dashboard lets you adjust the Window Size parameter and change the parameter assignment.

Parameters in the Inspector

Window Size: A slider lets you adjust the amount of smoothing to apply to the affected parameter by specifying the number of adjacent frames to average together. Higher values apply more smoothing by averaging a wider range of values, resulting in more fluid animation. Lower values average a narrower range of values, and apply less smoothing with values that are closer to the original.

Apply To: The Apply To pop-up menu shows the parameter being affected, and can be used to reassign the behavior to another parameter.

Related behaviors
“Negate,” “Reverse”

Custom
The Custom behavior allows you to make your own behaviors by creating a set of parameters, then keyframing them to create the type of animation you want to apply to an object. By saving custom behaviors you create in the Library, you can create your own collection of behaviors to suit your needs.

Prior to creating a Custom behavior, you must first add the Custom behavior to an object in the Canvas. The Custom behavior is added to an object like all other non-Parameter behaviors in Motion.

Note: Although the Custom behavior is a Parameter behavior, it does not appear in the list when you Control-click a parameter.

To add a Custom behavior to an object, do one of the following:

- Select the object to which you want to add a Custom behavior, click the Add Behavior icon in the Toolbar, then choose Parameter > Custom from the pop-up menu.
- In the Library, select the Behaviors category, select the Parameter subcategory, select Custom, then drag it to the object in the Canvas, Layers tab, or Timeline.

The Custom behavior is applied to the object. The behavior has no effect until you add a parameter to the behavior.
To add a parameter you want to animate in a Custom behavior:

- Choose a parameter you want to add to the Custom parameter list from the Add Parameter pop-up menu. This menu contains every animateable parameter.

Afterwards, that parameter appears in the Behaviors tab, nested underneath the Custom behavior.

Once you've added all the parameters you want to animate in your Custom behavior, you can keyframe them in the Keyframe Editor to create whatever animated effect you require. For more information on keyframing parameters to create animation, see “Animating Behaviors” on page 412.

To remove a parameter from the Custom parameter list:

- Choose the parameter you want to remove from the Remove Parameter list.

That parameter no longer appears in the Custom parameter list. Any keyframes that were applied to that parameter are deleted.
Once you have animated all the parameters you added, you can save the Custom behavior into the Library for future use. For more information about saving Custom behaviors to the Library, see “Saving and Sharing Custom Behaviors” on page 343.

When you apply a Custom behavior that you’ve saved in the Library to an object in a project, its keyframed animation is scaled to the duration of the object to which it’s applied. This means that no matter how long the original Custom behavior was, you can apply it to any object, and the animated effect speeds up or slows down to accommodate the new object’s duration.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
<td>Any</td>
</tr>
</tbody>
</table>

**Dashboard control**

There are no Dashboard controls for this behavior.

**Controls in the Inspector**

Unlike other behaviors, the Custom behavior doesn’t start out with any parameters in the Behaviors tab. Instead, a pair of pop-up menus allows you to add and remove any parameters you want to use.

<table>
<thead>
<tr>
<th>Property</th>
<th>Behaviors</th>
<th>Filters</th>
<th>Shapes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Custom</td>
<td>Add</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Parameter</td>
<td>Remove</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Add Parameter:** The Add Parameter pop-up menu allows you to add parameters that you want to keyframe to create custom animation. Choose a parameter from this menu to add it to the Custom parameter list for keyframing.

**Remove Parameter:** The Remove Parameter pop-up menu lists all the parameters you’ve added to the current Custom behavior. Choose a parameter from this menu to remove it from the Custom parameter list, along with any keyframes that are applied to that parameter.

**MIDI**

The MIDI behavior allows you to edit and animate object parameters using standard MIDI devices, such as a synthesizer. For the true motion graphics mixmaster.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
<td>Any</td>
</tr>
</tbody>
</table>
Dashboard control
The Dashboard controls allow you to adjust the Control Type, ID, Value, Scale, and parameter assignment.

Parameters in the Inspector

Control Type: Specifies the mode of the MIDI controller. The three available control types are:
- **Note:** This mode is displayed when the control is a keyboard key on the MIDI device.
- **Controller:** This mode is displayed when the control is a knob, dial, key, slider, or foot pedal on the MIDI device.
- **Learning:** This mode is used to “teach” Motion what control (such as a knob, dial, or key) you want to use on the MIDI device to manipulate the parameter to which the MIDI behavior is applied. When in Learning mode, the first knob, dial or key that you adjust on the MIDI device is set as the control.
  
  **Note:** When the MIDI behavior is first applied, Learning is the default control type.

ID: Displays the identification number of the MIDI control (such as a knob, dial, or key) that you are manipulating.

Value: When manipulating the control, displays the standard MIDI value between 0 and 1.

Scale: Increasing the Scale value multiplies the Value parameter in the MIDI behavior. This means that when Scale is increased, the MIDI control has a larger range of value and a greater effect on the parameter it's controlling. For example, when using a knob to adjust an object's rotation, the default rotation value range (when Scale is set to 1) for a full turn of the knob may only be 30 percent. When the Scale value is increased to 13, the rotation value of a full turn of the knob is increased to 370 degrees.

Apply To: The Apply To pop-up menu (parameter assignment control) shows the parameter being affected, and can be used to reassign the behavior to another parameter.

Related behaviors
None

The MIDI behavior is applied in the same way as all other Parameter behaviors. In the following examples, the MIDI parameter behavior is used to adjust an object’s opacity and rotation.

**Note:** This behavior can only be used if you have a MIDI device correctly connected to your computer.
To use the MIDI parameter behavior to adjust an object’s opacity:

1. Select an object, then select the Opacity parameter in the Properties tab of the Inspector.

2. Control-click the parameter, then choose MIDI from the shortcut menu.

   The MIDI parameters are displayed in the Behaviors tab. By default, Control Type is set to Learning.

   ![MIDI parameter behavior settings](image)

   Like all other Parameter behaviors, the Apply To field displays the parameter to which the behavior is applied.

3. On your MIDI device, tweak the control (such as the knob, dial, or key) that you want to use as the controller for the Opacity parameter.

   **Note:** When in Learning mode, the first control adjusted on the MIDI device is set as the control. To reset the selected controller, choose Learning from the Control Type pop-up menu, and adjust another control on the MIDI device.

   The identification number of the MIDI control is displayed in the ID field. The value range of the control is 0 to 1. Because an object’s opacity can only fall between 0 (completely transparent) to 100 (completely opaque), the default MIDI values are sufficient to adjust the parameter.

To use the MIDI parameter behavior to adjust an object’s rotation:

1. Select an object, then select the Rotation parameter in the Properties tab of the Inspector.

2. Control-click the parameter, then choose MIDI from the shortcut menu.

3. On your MIDI device, tweak the control (knob, dial, key, etc.) that you want to use as the controller for the Rotation parameter.

   As mentioned above, the default Value range is 0 to 1. Because the Rotation value of an object can be much larger, you can use the Scale parameter to multiply the Value range.

4. To give the control more sensitivity, increase the Scale value.
Negate
Inverts the value of each keyframe and behavior effect in the parameter to which it’s applied by multiplying the parameter by −1. The Negate behavior basically flips each parameter value to its opposite. Animation paths are flipped, rotation is reversed, and any effect’s parameter is changed to its opposite.

For example, applying the Negate behavior to the Position parameter of an object with an animation path applied results in the animation path moving to the opposite quadrant of the Canvas.

Note: If you want to reverse the motion taking place on an animation path, rather than flipping the shape of the animation path itself, use the Reverse parameter behavior.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
<td>Any</td>
</tr>
</tbody>
</table>

Dashboard control
The Dashboard control allows you to change the parameter assignment.

Parameters in the Inspector

Apply To: The Apply To pop-up menu shows the parameter being affected, and can be used to reassign the behavior to another parameter.

Related behaviors
“Averge,” “Reverse”

Oscillate
The Oscillate behavior animates a parameter by cycling it between two different values. You can customize how wide apart the high and low values are, as well as the number of oscillations per minute. The Oscillate behavior can create all kinds of cyclical effects. For example, if you apply the Oscillate behavior to the rotation property of an object, it will begin to rock back and forth. This happens because the rotation property cycles back and forth between the original rotation value plus and minus the Amplitude value that’s set in the Oscillate behavior.
Applying the Oscillate behavior to the X value of the Scale parameter instead causes the width of the object to cycle, and it repeatedly stretches and compresses for the duration of the behavior.

The Oscillate behavior is additive, meaning that the value generated by this behavior is added to the original value of the parameter to which it's applied.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
<td>Any</td>
</tr>
</tbody>
</table>

**Dashboard control**

The Dashboard lets you adjust the Phase, Amplitude, Speed, and parameter assignment of the Oscillate behavior.

**Parameters in the Inspector**

**Phase**: A slider that lets you adjust the point of the specified oscillation the behavior starts at. This parameter allows you to put multiple objects with identical Oscillate behaviors out of phase with one another so that they don’t all look the same.

**Amplitude**: A slider that lets you adjust the maximum values that the parameter oscillates between. The parameter swings between the amplitude value, and the negative of the amplitude value. Higher values result in more extreme swings from the beginning to the ending of each oscillation.

**Speed**: A slider that lets you adjust the speed at which the oscillation occurs, in oscillations per minute. Higher values result in faster oscillations.

**Start Offset**: A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is in frames.

**End Offset**: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior resets the object to its original parameters.

**Apply To**: The Apply To pop-up menu shows the parameter being affected, and can be used to reassign the behavior to another parameter.

**Related behaviors**

“Ramp,” “Rate”
Ramp
The Ramp behavior lets you create a gradual transition in any parameter that can be animated, from the Start Value to the End Value. The speed of the transition is defined by the length of the Ramp behavior in the Timeline, and by the behavior’s end value. Additional parameters allow you to define how the transition occurs, whether it’s at a single continuous speed, or whether it accelerates over time.

Ramp is a versatile behavior. If you apply it to the Scale property, it works like the Grow/Shrink behavior. If you apply it to the opacity property, you can fade an object in or out in different ways. Although you can use the Ramp behavior to mimic other Motion behaviors, it can be applied to any parameter you want.

Note: This behavior is additive, meaning that the value it generates is added to the original value of the parameter to which it’s applied.

For example, suppose you’re animating different segments of a bar graph, and each segment needs to grow until it reaches a specific length. (Hint—this can be done by assigning a subtracting mask to each bar object, and animating the position of each bar’s mask to slowly reveal each bar over time.)

Once you’ve arranged the different bars with their masks in the Canvas, you can apply Ramp behaviors to the X values of each mask to easily move each mask off to the side, giving the illusion that each bar is growing. Set the End Value parameter of each Ramp behavior to the length you want each bar to reach, and you’re done!

---

**Fish vs. Cats**

Before | After using Ramp behaviors to move the masks

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
<td>Any</td>
</tr>
</tbody>
</table>

**Dashboard control**
The Dashboard lets you adjust the Ramp’s Start Value, End Value, Curvature, and parameter assignment.
Parameters in the Inspector

Start Value: The value that's added to the parameter at the first frame of the Ramp behavior.

End Value: The value the Ramp behavior reaches at the last frame of the behavior. Over the life of the behavior, the parameter the Ramp behavior is applied to makes a transition from the Start Value to the End Value plus the original value.

Curvature: This parameter lets you ease the acceleration with which the Ramp behavior transitions from the Start Value to the End Value. Higher Curvature values result in an Ease In/Ease Out effect, where the value slowly begins the transition, gradually speeds up as the behavior continues, then gradually slows down to a stop as it reaches the end. Curvature does not affect the overall duration of the effect, since that is defined by the length of the behavior in the Timeline.

Start Offset: A slider that lets you delay the beginning of the behavior's effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is in frames.

End Offset: A slider that lets you offset the end of the behavior's effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the end of the effect for the remaining duration of the object. Trimming the end of the behavior resets the object to its original parameter.

Apply To: The Apply To pop-up menu shows the parameter being affected, and can be used to reassign the behavior to another parameter.

Related behaviors
“Oscillate,” “Rate”

Randomize
Creates a continuous sequence of randomly increasing and decreasing values, based on the parameters defining the range and type of values that are generated.

Although the values created with this behavior are random, they're actually predetermined by the parameter settings you've chosen. As long as you don't change the parameters, the frame-by-frame values created by this behavior remain the same. If you don't like the values that were randomly generated, click the Generate button in the Behaviors tab in the Inspector to pick a new random seed number. This number is used to generate a new sequence of values.

Chapter 5  Using Behaviors
The Apply Mode parameter determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Randomize behavior to modify a parameter’s preexisting values.

The Randomize behavior is useful for creating jittery effects, such as twitchy rotation, flickering opacity, and other effects requiring rapid and varied changes over time that would be time consuming to keyframe. The Randomize behavior can be modified with other behaviors, such as Average and Negate, to exercise further control over the values being generated.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
<td>Any</td>
</tr>
</tbody>
</table>

**Dashboard control**
The Dashboard has controls for Amount, Multiplier, Frequency, Noisiness, Link (for multidimensional parameters), Start Offset, End Offset, and parameter assignment.

**Parameters in the Inspector**

**Amount/Multiplier:** This parameter is set to Amount when the Apply Mode is set to Add, Subtract, or Add and Subtract; and is set to Multiplier when the Apply Mode is set to Multiply. This parameter defines the maximum value the Randomize behavior will generate.

**Apply Mode:** A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Randomize behavior to modify a parameter’s preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

**Frequency:** A slider that lets you adjust the amount of random variation per second. Higher values will generate faster variations, whereas lower values will generate slower variations.

**Noisiness:** Adds an additional overlay of random variance to the Frequency you’ve set. Higher Noisiness values result in more erratic variations in the affected parameter.

**Link:** This parameter appears when you apply this behavior to a multidimensional parameter (for example, Position or Scale consists of X and Y values). Turn this checkbox on to keep the behavior’s effect on each value proportional.

**Affect Objects:** This parameter only appears when the Randomize behavior is applied to a replicator. When Affect Objects is turned on, each object has a different random behavior. When turned off, each object undergoes the same animation.
Random Seed: A button that lets you pick a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.

Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is in frames.

End Offset: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the last random value generated by this behavior for the remaining duration of the object. Trimming the end of the behavior resets the parameter to its original value.

Related behaviors
“Random Motion,” “Wriggle”

Rate
This behavior increases a parameter’s value over time, with the rate of increase determined by the Rate slider. Unlike the Ramp behavior, this behavior has no end value; it simply continues to increase or decrease the parameter it’s applied to until the end of the parameter.

Note: To use the Rate parameter to decrease a parameter over time, enter a negative value into the Rate parameter.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
<td>Any</td>
</tr>
</tbody>
</table>

Dashboard control
The Dashboard has controls for Rate, Curvature, and parameter assignment.

Parameters in the Inspector

Rate: A value slider that lets you set a rate of increase over time for the affected parameter. Measured in percentage increase per second.

Curvature: This parameter lets you ease the acceleration with which the Rate behavior transitions from the Start Value to the End Value. Higher Curvature values result in an Ease In/Ease Out effect, where the value slowly begins the transition, gradually speeds up as the behavior continues, then gradually slows down to a stop as it reaches the end. Curvature does not affect the overall duration of the effect, since that is defined by the length of the behavior in the Timeline.
End Offset: A slider that lets you offset the end of the behavior’s effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the last random value generated by this behavior for the remaining duration of the object. Trimming the end of the behavior resets the parameter to its original value.

Apply To: The Apply To pop-up menu shows the parameter being affected, and can be used to reassign the behavior to another parameter.

Related behaviors
“Oscillate,” “Ramp”

Reverse
Unlike the Negate behavior, which inverts the value of the parameter to which it’s applied, the Reverse behavior reverses the direction of any animation that affects a parameter, whether it’s caused by behaviors or keyframes. For example, when you apply the Reverse behavior to path animation that begins at the left and moves to the right, the animation path won’t move, but the object will instead begin at the right and move to the left. The Reverse behavior basically switches the beginning and ending points of animated objects.

Dashboard control
The Dashboard control allows you to change the parameter assignment.

Parameters in the Inspector
Apply To: The Apply To pop-up menu shows the parameter being affected, and can be used to reassign the behavior to another parameter.

Related behaviors
“Average,” “Negate”

Stop
The Stop behavior suspends the animation of all behaviors that meet all of the following criteria:
• Are below it in the Layers tab
• That also affect the parameter it’s applied to
• That are active at its In point in the Timeline

Each behavior’s effect on the object is frozen at the first frame of the Stop behavior in the Timeline. Keyframes that are applied to that parameter cease to have any effect for the duration of the Stop behavior in the Timeline.
If the Stop behavior is shorter than the object to which it’s applied, all keyframes and behaviors affecting that channel immediately take effect after the last frame of the Stop behavior. For more information on using the Stop behavior, see “Using the Stop Behavior” on page 335.

### Dashboard control

The Dashboard control allows you to change the parameter assignment.

#### Parameters in the Inspector

- **Apply To**: The Apply To pop-up menu shows the parameter being stopped, and can be used to reassign the Stop behavior to another parameter.

- **Wriggle**: This behavior works similarly to the Randomize behavior, but with a slower effect.

### Affects

<table>
<thead>
<tr>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual parameter</td>
</tr>
<tr>
<td>Any</td>
</tr>
</tbody>
</table>

### Dashboard control

The Dashboard has controls for Amount, Multiplier, Frequency, Wriggle Offset, Noisiness, Link (for multidimensional parameters), Start Offset, End Offset, and parameter assignment.

#### Parameters in the Inspector

- **Amount/Multiplier**: This parameter is set to Amount when the Apply Mode is set to Add, Subtract, Add and Subtract, and Multiplier when the Apply Mode is set to Multiply. This parameter defines the maximum value the Wriggle behavior will generate.

- **Apply Mode**: A pop-up menu that determines how values generated by this behavior are combined with other behaviors and keyframes that affect the same parameter. This provides you with different ways of using a Wriggle behavior to modify a parameter’s preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

- **Frequency**: A slider that lets you adjust the amount of random variation per second. Higher values will generate faster variations, whereas lower values will generate slower variations.

- **Wriggle Offset**: A slider that allows you to offset the sequence of random values when you want to apply the same Wriggle behavior to multiple objects. By offsetting each object’s version of the Wriggle behavior, you can prevent them from moving in sync.
Noisiness: This slider adds an additional overlay of random variance to the Frequency you've set. Higher Noisiness values result in more erratic variations in the affected parameter.

Link: This parameter appears when you apply this behavior to a two-dimensional parameter, such as Position or Scale, that consists of X and Y values. Turn this checkbox on to keep the behavior's effect on each value proportional.

Affect Objects: This parameter only appears when the Wriggle behavior is applied to a replicator. When Affect Objects is turned on, each object has a different random behavior. When turned off, each object undergoes the same animation.

Random Seed: A button that lets you pick a new random seed number. This number is used to randomly generate new sequences of values, based on the other parameters of this behavior.

Start Offset: A slider that lets you delay the beginning of the behavior's effect relative to the first frame of its position in the Timeline. Adjust this parameter to make the behavior start later. This parameter is measured in frames.

End Offset: A slider that lets you offset the end of the behavior's effect relative to the last frame of its position in the Timeline, in frames. Adjust this parameter to make the behavior stop before the actual end of the behavior in the Timeline. Using this slider to stop the effect, instead of trimming the end of the behavior in the Timeline, freezes the last random value generated by this behavior for the remaining duration of the object. Trimming the end of the behavior resets the parameter to its original value.

Related behaviors
“Random Motion,” “Randomize”

Particles, Replicator, and Text Behaviors
Particles, Replicator, and Text behaviors are designed specifically to be applied to particle emitters or cells, replicator objects or replicator source objects, and text objects. For more information about the Particles behaviors, see “The Particles Behavior Category” on page 611. For more information about Replicator behaviors, see “Using the Sequence Replicator Behavior” on page 681. For more information about Text behaviors, see “Using Text Animation and Text Sequence Behaviors” on page 524.
Simulation Behaviors

These behaviors perform one of two tasks. Some Simulation behaviors, such as Gravity, animate the parameters of an object in a way that simulates a real-world phenomenon. Other Simulation behaviors, such as Attractor and Repel, affect the parameters of one or more objects surrounding the object to which they’re applied. These behaviors allow you to create some very sophisticated interactions among multiple objects in your project with a minimum of adjustments. Like the Basic Motion behaviors, Simulation behaviors also affect specific object parameters. Examples include Attractor, Gravity, and Repel.

Examples of Using Simulation Behaviors

To view examples of working with the different Simulation behaviors, see “Working With Simulation Behaviors” in the “The Playground” section of the Motion Getting Started book.

Important: Several Simulation behavior parameters contain object wells into which target objects used as attractors, repellers, orbiters, and so on, are dragged. Dragging an object to a well may be tricky—be sure to click the object name in the Layers tab and immediately drag the object to the object well (without releasing the mouse button). The behavior must remain active even though you are clicking another object in the Layers tab. If you click the object in the Layers tab and release the mouse button, that object is now selected, and the behavior’s parameters are no longer displayed. This behavior is true of all wells, including mask source and image wells.

Align To Motion

The Align To Motion behavior changes the rotation of an object to match changes made to its direction along an animation path. This behavior is meant to be combined with behaviors that animate the position of an object, or with a keyframed animation path you create yourself.
**Note:** The Align to Motion behavior does not work on objects animated using the Motion Path behavior. Instead, use the Snap Alignment to Motion behavior (in the Basic Motion subcategory).

Unlike the Snap Alignment to Motion behavior, which produces absolute changes in rotation that precisely match changes in direction, Align To Motion has a springy reaction, and creates a more lively effect.

In the above example, the fish travels along the keyframed animation path, but it isn’t actually pointed in the proper direction. Using the Align To Motion behavior, its angle of rotation moves so that it points in the direction of the animation path. By adjusting the Drag parameter, you can make it careen wildly about its anchor point as it goes around curves in the animation path.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Rotation</td>
</tr>
</tbody>
</table>

**Dashboard control**

The Dashboard has controls for Axis, Invert Axis, Spring Tension, and Drag. When applied to a layer or group (such as particles text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

**Parameters in the Inspector**

**Affect Objects:** This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all object within the layer are affected by the behavior together, as if they were a single object.

**Axis:** A pop-up menu that lets you align the target object’s rotation to the X or Y value of its position.
Invert Axis: A checkbox that flips the orientation with which the object aligns itself to the motion.

Spring Tension: A slider that adjusts how quickly the object’s rotation changes to match a change in the object’s direction. Lower values create a delay between a change to an object’s position and its subsequent change in rotation. Higher values create more responsive changes in rotation.

Drag: A slider that adjusts whether or not the change in rotation made by this behavior overshoots the new direction of the object. Low drag values result in springy changes in rotation, where the object rotates back and forth as it overshoots changes in direction. High drag values dampen this effect, making the object’s rotation stick more closely to the changes made in rotation. Higher values also cause the object’s rotation to lag behind the object’s change in position.

Related behaviors
“Snap Alignment to Motion”

Attracted To
This behavior is part of a group of Simulation behaviors that let you create complex animated relationships between two or more objects. These behaviors are extremely powerful, and allow complicated effects to be created with a minimum of steps.

An object with the Attracted To behavior moves toward a single specified object, the object of attraction. Additional parameters allow you to adjust the area of influence that defines how close an object needs to be to move toward the object of attraction, and how strongly it is attracted.

The Drag parameter lets you define whether attracted objects overshoot and bounce about the attracting object, or whether they eventually slow down and stop at the position of the target object.
You can apply two or more Attracted To behaviors to a single object, each with a different object of attraction, to create tug-of-war situations where the object bounces among all the objects it's attracted to.

### Affects

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other objects</td>
<td>Position</td>
</tr>
</tbody>
</table>

### Dashboard control

The Dashboard has an object well you can use to assign an object of attraction, as well as controls for Strength, Falloff Type, Falloff Rate, Influence, and Drag. When applied to a layer or group (such as particles, text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

### Parameters in the Inspector

**Affect Objects:** This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

**Object:** An object well that defines the object of attraction. To set the defined target object, drag the object from the Layers tab to the object well in the Attracted To Dashboard or Inspector. In the Layers tab, you can also drag the target object onto the Attracted To behavior.

**Strength:** A slider defining the speed at which the object moves toward the object of attraction. With a value of 0, the object doesn't move at all. The higher the value, the faster the object moves.

**Falloff Type:** A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- **Linear:** Object attraction falls off in proportion to the object’s distance.
- **Exponential:** The closer an object is within the area of influence, the stronger it’s attracted, and the faster it moves toward the object of attraction.

**Falloff Rate:** When Falloff Type is set to Exponential, object attraction falls off with distance. When Falloff Type is set to Linear (default), the attraction falls off uniformly. This value determines how quickly the force of attraction between objects affected by this behavior falls off. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly.
Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain where they are.

Drag: A slider that can be used to reduce the distance attracted objects overshooot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

Related behaviors
“Attractor,” “Drift Attracted To,” “Drift Attractor,” “Orbit Around,” “Spring,” “Vortex”

Attractor
If you apply an Attractor behavior to an object, other objects that lie within the area of influence move toward it. You can manipulate the strength with which other objects are attracted, as well as the distance required for attraction to begin.

By default, objects overshoot the object of attraction and bounce around, never coming to rest. The Drag parameter lets you adjust this behavior, changing whether attracted objects overshoot and bounce around, or whether they eventually slow down and stop at the position of the target object.

The Attractor behavior can affect all objects in the Canvas that fall within the area of attraction, or you can limit its effect to a specific list of objects, by using the Affect parameter.

The Attractor behavior can also be applied to objects in motion. If you animate the position of the target object to which you’ve applied the Attractor behavior, all other objects in the Canvas continue to be attracted to its new position.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other objects</td>
<td>Position</td>
</tr>
</tbody>
</table>
Dashboard control
The Dashboard has controls for Affect, Strength, Falloff Type, Falloff Rate, Influence, and Drag.

Parameters in the Inspector

Affect: A pop-up menu that limits which objects in your project are affected by the Attractor behavior. There are three options:
- All Objects: All objects in the Canvas are affected by the Attractor behavior.
- Related Objects: The default setting. Only other objects that are within the same layer as the object of attraction are affected.
- Specific Objects: Only objects appearing in the Affected Objects list are affected by the Attractor behavior.
- Affected Objects: A list that appears when Specific Objects is selected in the Affect pop-up menu. Drag objects from the Layers tab into this list to be affected by the Attractor behavior when the Specific Objects option is selected in the Affect pop-up menu. Drag the layer icon of objects in your project from the Layers tab to add them to this list. Objects from any layer in a project can be dragged to the Affected Objects list. To remove an object, select the object in the list and click Remove.

Strength: A slider defining the speed with which attracted objects move toward the target object. With a value of 0, attracted objects don’t move at all. The higher the value, the faster attracted objects move.

Falloff Type: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.
- Linear: Object attraction falls off in proportion to the object's distance.
- Exponential: The closer an object is within the area of influence, the stronger it’s attracted, and the faster it moves toward the object of attraction.

Falloff Rate: This value determines how quickly the force of attraction between objects affected by this behavior falls off. When Falloff Type is set to Exponential, object attraction falls off with distance. When Falloff Type is set to Linear (default), the attraction falls off uniformly. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly.

Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain where they are.
Drag: A slider that can be used to reduce the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

Related behaviors
“Attracted To,” “Drift Attracted To,” “Drift Attractor,” “Orbit Around,” “Spring,” “Vortex”

Drag
This behavior lets you simulate the force of friction on a moving object, slowing it down over time. Applying the Drag behavior is an easy way to decelerate objects with multiple behaviors that create complex motion.

Affects | Parameters affected
---|---
Objects | Position

Dashboard control
The Dashboard lets you adjust the Amount of drag. When applied to a layer or group (such as particles, text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

Parameters in the Inspector

Affect Objects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

Amount: A slider that can be used to slow down an object over time, causing it to eventually come to a stop. Higher Drag values result in the object coming to rest sooner. You can adjust the drag applied to the X and Y values separately. One example of this would be to create a situation where an object’s vertical speed slows down faster than its horizontal speed.

Related behaviors
“Rotational Drag”

Drift Attracted To
Similar to the Attracted To behavior, but by default an object moves toward the object of attraction and comes to rest, rather than overshooting the object of attraction and bouncing around.

Affects | Parameters affected
---|---
Objects | Position
Dashboard control
The Dashboard has an object well you can use to assign an object of attraction, as well as sliders for Strength and Drag. When applied to a layer or group (such as particles, text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

Parameters in the Inspector

Affect Objects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

Object: An object well that defines the object of attraction. To set the defined target object, drag the object from the Layers tab to the object well in the Drift Attracted To Dashboard or Inspector. In the Layers tab, you can also drag the target object onto the Drift Attracted To behavior.

Strength: A slider defining the speed at which the object moves toward the object of attraction. With a value of 0, the object doesn’t move at all. The higher the value, the faster the object moves.

Falloff Type: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.
- Linear: Object attraction falls off in proportion to the object’s distance.
- Exponential: The closer an object is within the area of influence, the stronger it’s attracted, and the faster it moves toward the object of attraction.

Falloff Rate: This value determines how quickly the force of attraction between objects affected by this behavior falls off. When Falloff Type is set to Exponential, object attraction falls off with distance. When Falloff Type is set to Linear (default), the attraction falls off uniformly. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly.

Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain where they are.

Drag: A slider that can be used to reduce the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

Related behaviors
“Attracted To,” “Attractor,” “Drift Attractor,” “Orbit Around,” “Spring,” “Vortex”
Drift Attractor

Similar to the Attractor behavior, but by default objects within the area of influence move toward the object of attraction and come to rest, rather than overshooting the object of attraction and bouncing around.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other objects</td>
<td>Position</td>
</tr>
</tbody>
</table>

Dashboard control

The Dashboard has controls for Affect, Strength, and Drag.

Parameters in the Inspector

**Affect**: A pop-up menu that limits which objects in your project are affected by the Drift Attractor behavior. There are three options:

- **All Objects**: All objects in the Canvas are affected by the Drift Attractor behavior.
- **Related Objects**: The default setting. Only other objects that are within the same layer as the object of attraction are affected.
- **Specific Objects**: Only objects appearing in the Affected Objects list are affected by the Drift Attractor behavior.

- **Affected Objects**: A list that appears when Specific Objects is selected in the Affect pop-up menu. Drag objects from the Layers tab into this list to be affected by the Drift Attractor behavior. Drag the layer icon of objects in your project from the Layers tab to add them to this list. Objects from any layer in a project can be dragged to the Affected Objects list. To remove an object, select the object in the list and click Remove.

**Strength**: A slider defining the speed with which attracted objects move toward the target object. With a value of 0, attracted objects don’t move at all. The higher the value, the faster attracted objects move.

**Falloff Type**: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- **Linear**: Object attraction falls off in proportion to the object’s distance.
- **Exponential**: The closer an object is within the area of influence, the stronger it’s attracted, and the faster it moves toward the object of attraction.

**Falloff Rate**: This value determines how quickly the force of attraction between objects affected by this behavior falls off. When Falloff Type is set to Exponential, object attraction falls off with distance. When Falloff Type is set to Linear (default), the attraction falls off uniformly. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly.
**Influence:** A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain where they are.

**Drag:** A slider that can be used to reduce the distance attracted objects overshoot the object of attraction. Lower Drag values result in the object overshooting the object of attraction, moving past and then careening back around toward the target object again and again. Higher Drag values result in the object coming to rest sooner.

**Related behaviors**
“Attracted To,” “Attractor,” “Drift Attracted To,” “Orbit Around,” “Spring,” “Vortex”

**Edge Collision**
This is a good behavior to use if you’re setting up complex motion simulations and you don’t want your objects exiting the Canvas. Objects with the Edge Collision behavior applied either come to a stop or bounce off after colliding with the edge of the Canvas frame. For example, if you applied the Throw behavior to an object and set the velocity to send the object toward the edge of the frame, then applied Edge Collision, the object would hit the edge of the frame, then bounce off according to the Bounce Strength parameter.

The angle in which the object bounces depends on the angle with which it hits the edge of the frame, while the speed it travels after bouncing is set by the Bounce Strength parameter.

**Important:** With most objects, the Edge Collision behavior uses the bounding box to determine how the object collides with the edge of the Canvas. If you’re using this behavior with an object that has an alpha channel that’s smaller than its bounding box, adjust the Crop parameter in the object’s Properties tab to fit the bounding box as closely as possible to the edge of the image. With particles, text, and layers, only the object’s center is used.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Position</td>
</tr>
</tbody>
</table>

Chapter 5 Using Behaviors
Dashboard control
The Dashboard has controls for Bounce Strength and Active Edges. When applied to a layer or group (such as particles text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

Parameters in the Inspector

Affect Objects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

Bounce Strength: The speed at which objects travel after colliding with an edge. A value of 0 causes objects to come to a complete stop when colliding with an edge that's perpendicular to the direction of motion. Higher values cause an object to move faster after bouncing. This only slows the object in the direction perpendicular to the bounced edge.

Active Edges: Four checkboxes define which Canvas edges are detected by the Edge Collision behavior. You can turn on and off edges in any combination.

Gravity
This behavior causes an object to fall over time. The gravitational acceleration can be increased or decreased, resulting in a change to the rate of fall. Objects affected by the Gravity behavior continue to fall past the bottom edge of the Canvas (unless the Edge Collision behavior has been applied).

The Gravity behavior can be used in conjunction with other behaviors that animate the position of objects to create natural-looking arcs and animation paths that simulate thrown objects falling to the ground. For example, apply the Throw behavior to an object to send it flying through the air, and then apply the Gravity behavior to it to make the object arc up and then fall down past the bottom of the Canvas.
You can also set the Acceleration parameter to a negative value, effectively applying “anti-gravity” to the object and making it fly up.

### Dashboard control
The Dashboard lets you adjust the Acceleration parameter. When applied to a layer or group (such as particles text, or a replicator), the Affect Objects checkbox also appears in the Dashboard.

### Parameters in the Inspector

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Position</td>
</tr>
</tbody>
</table>

**Dashboard control**

When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

**Acceleration:** A slider defining the strength of gravity affecting the target object. The higher this value, the faster the target object falls.

**Related behaviors**

- “Motion Path,” “Random Motion,” “Throw,” “Wind”

**Orbit Around**

Similar to the Attracted To behavior, the Orbit Around behavior’s default parameter settings give the object sufficient initial velocity to orbit around another object in a perfect circle.

**Note:** Behaviors such as Attractor and Repel applied to nearby objects may disrupt an object with the Orbit Around behavior applied to it.
Dashboard control

The Dashboard has an Object well you can use to assign an object of attraction, as well as controls for Strength, Falloff Type, Falloff Rate, Influence, Drag, and Direction. When applied to a layer or group (such as particles text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

Parameters in the Inspector

**Affect Objects**: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

**Object**: An image well that defines the object to orbit around. To set the defined target object, drag the object from the Layers tab to the Object well in the Orbit Around Dashboard or Inspector. In the Layers tab, you can also drag the target object onto the Orbit Around behavior.

**Strength**: A slider defining the speed at which the object moves.

**Falloff Type**: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. The default is Linear.

- **Linear**: Object attraction falls off in proportion to the object's distance.
- **Exponential**: The closer an object is within the area of influence, the stronger it's attracted, and the faster it moves toward the object of attraction.

**Falloff Rate**: This value determines how quickly the force of attraction between objects affected by this behavior falls off. When Falloff Type is set to Exponential, object attraction falls off with distance. When Falloff Type is set to Linear (default), the attraction falls off uniformly. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly.
Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain where they are.

Drag: The default value for Orbit Around is 0, which results in a stable orbit. Any other value causes the orbit to decay and the object to spiral into the object of attraction.

Direction: Reverses the direction of this behavior.

Related behaviors
“Attracted To,” “Attractor,” “Drift Attracted To,” “Drift Attractor,” “Spring,” “Vortex”

Random Motion
If you apply the Random Motion behavior to an object, it animates the position of the object, and makes it move around the Canvas along a random path.

Although the motion created with this behavior is random, it's actually predetermined by the particular group of parameters you've chosen. As long as you don't change the parameters, the animation path created by this behavior remains the same. If you don't like the path that was randomly generated, click the Generate button in either the Dashboard or the Behaviors tab in the Inspector to pick a new random seed number. This number is used to generate a new path.

The Random Motion behavior is useful for quickly creating varied animation paths for large numbers of objects you want to move at the same time. For example, you can create an arrangement of ten objects in the Canvas and apply the Random Motion behavior to all of them.
You can also use the Random Motion behavior to add variation to the animation paths created by other behaviors affecting an object’s position. For example, adding Random Motion to an object with the Orbit Around behavior results in a more erratic animation path, although it still orbits as before.

Dashboard control
The Dashboard has controls for the Amount, Frequency, Noisiness, Drag, and Random Seed parameters. When applied to a layer or group (such as particles text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

Parameters in the Inspector

**Affect Objects:** This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

**Amount:** A slider that determines the speed the object moves by changing the length of the animation path. Higher values result in faster motion and longer animation paths.

**Frequency:** A slider that determines the number of twists and turns in the animation path, which can be seen by the crookedness of the resulting animation path. Higher values create more turns in the animation path. Lower values result in straighter animation paths.
Noisiness: A slider that determines an additional level of jaggedness along the animation path shape defined by the Amount parameter. Higher values result in a more jagged-looking animation path.

Drag: A slider that controls the speed the object moves along the animation path. While the Amount parameter controls the length of the animation path, the Drag parameter shrinks or enlarges the animation path as a whole.

Random Seed: A button that lets you pick a new random seed number. This number is used to randomly generate new animation paths, based on the values you've picked in the other parameters of this behavior.

Related behaviors
“Motion Path,” “Gravity,” “Throw,” “Wind”

Repel
If you apply the Repel behavior to an object, it pushes away all objects within the area of influence in the Canvas. The strength with which objects are pushed away can be increased or decreased, as can the distance repelled objects travel.

You can also specify which objects are affected by this behavior, creating an effect where only specific objects are moved, while others remain still.

The Repel behavior is the opposite of the Attractor behavior, and is part of a group of simulation behaviors that create complex animated relationships between two or more objects.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other objects</td>
<td>Position</td>
</tr>
</tbody>
</table>
Dashboard control
The Dashboard has controls for which objects are affected, Strength, Falloff Type, Falloff Rate, Influence, and Drag.

Parameters in the Inspector

Affect: A pop-up menu that limits which objects in your project are affected by the Repel behavior. There are three options:

- All Objects: All objects in the Canvas are affected by the Repel behavior.
- Related Objects: The default setting. Only other objects that are within the same layer as the repelling object are affected.
- Specific Objects: Only objects appearing in the Affected Objects list are affected by the Repel behavior.

- Affected Objects: A list that appears when Specific Objects is selected in the Affect pop-up menu. Drag objects from the Layers tab into this list to be affected by the Repel behavior. Objects from any layer in a project can be dragged to the Affected Objects list. To remove an object, select the object in the list and click Remove.

Strength: A slider defining the speed with which repelled objects move away from the object. With a value of 0, repelled objects don’t move at all. The higher the value, the faster repelled objects move.

Falloff Type: A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- Linear: Repulsion between objects falls off in proportion to the object’s distance.
- Exponential: The closer an object is within the area of influence, the stronger it’s repelled, and the faster it moves away from the object doing the repelling.

Falloff Rate: This value determines how quickly the force of repulsion between objects affected by this behavior falls off. When Falloff Type is set to Exponential, object attraction falls off with distance. When Falloff Type is set to Linear (default), the attraction falls off uniformly. A low Falloff Rate value results in objects quickly getting up to speed as they move away from the object of repulsion. A high Falloff Rate causes objects to accelerate much more slowly.

Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move away from the object of repulsion. Objects that are outside of the area of influence remain where they are.

Drag: A slider that can be used to reduce the distance repelled objects travel away from the repelling object.

Related behaviors
“Repel From”
Repel From
While the Repel behavior pushes other objects away, the Repel From behavior has the converse effect, making the object it’s applied to move away from a selected object in the Canvas.

Dashboard control
The Dashboard has an image well you can use to assign an object to move away from, as well as controls for Strength, Falloff Type, Falloff Rate, Influence, and Drag. When applied to a layer or group (such as particles text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

Parameters in the Inspector

**Affect Objects:** This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

**Object:** An image well that defines the object to be repelled from.

**Strength:** A slider defining the speed at which the object is repelled. With a value of 0, the object is not repelled at all. The higher the value, the faster the object is repelled.

**Falloff Type:** A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially.

- **Linear:** Repulsion between objects falls off in proportion to the object’s distance.
- **Exponential:** The closer an object is within the area of influence, the stronger it’s repelled, and the faster it moves away from the object doing the repelling.

**Falloff Rate:** This value determines how quickly the force of repulsion between objects affected by this behavior falls off. When Falloff Type is set to Exponential, object attraction falls off with distance. When Falloff Type is set to Linear (default), the attraction falls off uniformly. A low Falloff Rate value results in objects quickly getting up to speed as they move away from the object of repulsion. A high Falloff Rate causes objects to accelerate much more slowly.

**Influence:** A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move away from the object of repulsion. Objects that are outside of the area of influence remain where they are.
Drag: A slider that can be used to reduce the distance the object or objects travel away from the repelling object.

Related behaviors
“Repel”

Rotational Drag
Similar to the Drag behavior, except that it affects Rotation instead of position. Rotational Drag simulates friction affecting objects that are spinning due to keyframed or behavior-driven changes to the Rotation parameter. By setting higher Drag values, you can slow rotational changes to an eventual stop.

Affects

| Object | Rotation |

Dashboard control
The Dashboard lets you control the Amount of drag. When applied to a layer or group (such as particles text, or the replicator), the Affect Objects checkbox also appears in the Dashboard.

Parameters in the Inspector

Affect Objects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

Amount: A slider that can be used to slow down an object’s rotation over time, causing it to eventually come to a stop. Higher Amount values result in the rotation ending sooner.

Related behaviors
“Drag”

Spring
The Spring behavior creates a relationship between two objects, so that an object with the Spring behavior applied to it moves back and forth around a second object. The Attract To parameter defines the object that serves as the target and center of the Spring behavior. Additional parameters let you adjust the speed of the behavior (Spring Tension) and the acceleration of the object at each change in direction (Relaxed Length).
If the Attract To object is at a stop, the resulting motion is fairly simple and the
springing object moves back and forth in a straight line. If the Attract To object is in
motion, the springing object's motion will be much more complex, changing direction
according to the velocity of the Attract To object.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Position</td>
</tr>
</tbody>
</table>

Dashboard control
An image well in the Dashboard lets you set the Attract To object. Two sliders let you
adjust the Spring Tension and Relaxed Length of the Spring effect. A checkbox lets you
turn on the Repel parameter. When applied to a layer or group (such as particles text,
or the replicator), the Affect Objects checkbox also appears in the Dashboard.

Parameters in the Inspector

**Affect Objects**: This parameter appears when this behavior is applied to an object that
contains multiple objects, such as a layer, particle emitter, replicator, or text object.
When this checkbox is turned on, all objects within the parent object are affected
individually. When this checkbox is turned off, all objects within the layer are affected
by the behavior together, as if they were a single object.

**Attract To**: An image well that defines the object of attraction. To set the defined
target object, drag the object from the Layers tab to the Object well in the Spring
Dashboard or Inspector. In the Layers tab, you can also drag the target object onto the
Spring behavior.

**Spring Tension**: A slider that determines how fast the object is pulled toward the
object of attraction.

**Relaxed Length**: The distance from the target object at which object attraction
diminishes to zero. As the springing object's distance increases past this point, the force
of attraction increases proportionally, to bring it back toward the target object.

**Repel**: With this checkbox turned on, when the object gets closer to the object of
attraction than the Relaxed Length value, the objects are pushed apart. When this
checkbox is turned off, no repelling force is applied.

Related behaviors
“Attracted To,” “Attractor,” “Drift Attracted To,” “Drift Attractor,” “Orbit Around,” “Vortex”
Vortex
The opposite of the Orbit Around behavior. While the Orbit Around behavior causes one object to orbit around another target object, the Vortex behavior exerts a force on all objects surrounding the object to which the Vortex behavior is applied.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other objects</td>
<td>Position</td>
</tr>
</tbody>
</table>

Dashboard control
The Dashboard has a pop-up menu that lets you limit the objects affected by this behavior, as well as controls for Strength, Falloff Type, Falloff Rate, Influence, Drag, and Direction.

Parameters in the Inspector

**Affect:** A pop-up menu that limits which objects in your project are affected by the Vortex behavior. There are three options:

- **All Objects:** All objects in the Canvas are affected by the Vortex behavior.
- **Related Objects:** The default setting. Only other objects that are within the same layer as the object of attraction are affected.
- **Specific Objects:** Only objects appearing in the Affected Objects list are affected by the Vortex behavior.
- **Affected Objects:** A list that appears when Specific Objects is selected in the Affect pop-up menu. Drag objects from the Layers tab into this list to be affected by the Vortex behavior when the Specific Objects option is selected in the Affect pop-up menu. Drag the layer icon of objects in your project from the Layers tab to add them to this list. Objects from any layer in a project can be dragged to the Affected Objects list. To remove an object, select the object in the list and click Remove.

**Strength:** A slider defining the speed at which the affected objects move about the object of attraction.

**Falloff Type:** A pop-up menu that determines whether the distance defined by the Influence parameter falls off linearly or exponentially. The default is Linear.

- **Linear:** Object attraction falls off in proportion to the object’s distance.
- **Exponential:** The closer an object is within the area of influence, the stronger it’s attracted, and the faster it moves toward the object of attraction.
Falloff Rate: This value determines how quickly the force of attraction between objects affected by this behavior falls off. When Falloff Type is set to Exponential, object attraction falls off with distance. When Falloff Type is set to Linear (default), the attraction falls off uniformly. A low Falloff Rate value results in objects quickly getting up to speed as they move toward the object of attraction. A high Falloff Rate causes objects to accelerate much more slowly.

Influence: A slider that defines the radius of the circle of influence, in pixels. Objects that fall within the area of influence move toward the object of attraction. Objects that are outside of the area of influence remain where they are.

Drag: The default value for Vortex is 0, which results in a stable vortex. Any other value causes the vortex to decay and the object to spiral into the object of attraction.

Direction: A pop-up menu that lets you set whether objects move around in a clockwise or counter-clockwise direction.

Related behaviors
“Attracted To,” “Attractor,” “Drift Attracted To,” “Drift Attractor,” “Orbit Around,” “Spring”

Wind
Apply the Wind behavior to an object to animate its position, and move it in a specified direction. Unlike the Throw behavior, the velocity specified by the Wind behavior is a continuous force, and its parameters can be keyframed to achieve gradual changes in speed and direction.

The Wind behavior is better than the Throw behavior when you want to vary the speed of the object being animated. You can either apply another behavior (such as Randomize or Ramp) or keyframe the Velocity parameter of the Wind behavior to vary the speed and direction at which the object moves. You cannot make gradual changes in either speed or direction with the Throw behavior.

<table>
<thead>
<tr>
<th>Affects</th>
<th>Parameters affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>Position</td>
</tr>
</tbody>
</table>

Dashboard control
The Dashboard lets you specify the direction and speed of the Wind behavior by dragging an arrow within a circular region. The direction of the arrow defines the direction of movement, and the length of the arrow defines speed. A slider at the right lets you adjust the scale of the Dashboard control, increasing or decreasing the effect the control has over the object.
Note: The maximum speed you can define with the Dashboard is not the maximum speed possible. Higher values can be entered into the Velocity parameter in the Behaviors tab of the Inspector.

Parameters in the Inspector

Affect Objects: This parameter appears when this behavior is applied to an object that contains multiple objects, such as a layer, particle emitter, replicator, or text object. When this checkbox is turned on, all objects within the parent object are affected individually. When this checkbox is turned off, all objects within the layer are affected by the behavior together, as if they were a single object.

Air Thickness: A slider that adjusts how fast the object accelerates when the speed is changed. Lower values (simulating thinner air) have less effect when pushing the object, so it takes longer to get up to speed. Higher values (thicker air) have more effect, and push the object up to speed more quickly.

Velocity: A slider that adjusts the speed at which the simulated air is blowing the object. Higher values result in faster motion.

Related behaviors

“Motion Path,” “Gravity,” “Random Motion,” “Throw”
Behavior Examples
The following two examples illustrate different ways that groups of behaviors can be combined to create different effects.

Example 1: Creating an Animated Title
In this example, multiple behaviors are used to bring up four text objects to create a title. The first three text objects fly in from the sides, while the last text object zooms out from the center of the screen.

Important: This example assumes that the Create Objects At preference in the Project Preferences pane is set to Start of Project, so that newly applied behaviors are placed from the beginning of each object all the way through the end.

To create an animated title sequence:
1. Arrange the first two graphic objects to determine their vertical position in your composition.

2. Select both objects, click the Add Behavior icon in the Toolbar, and choose Basic Motion > Motion Path from the pop-up menu to apply this behavior to both objects at the same time.
3 Select the top object. If necessary, choose the Motion Path behavior from the Dashboard pop-up menu to make its motion path editable. Move the start point of the motion path to the offscreen position where you want it to start, and move the end point to the onscreen position where you want it to stop.

![Diagram of motion path](image)

4 Next, select the bottom object. Choose the Motion Path behavior from the Dashboard pop-up menu to make its motion path editable. Move the start point of the motion path to the offscreen position you want it to start, and move the end point to the onscreen position you want it to stop.

![Diagram of motion path](image)

5 Click the Play button or scrub the playhead in the Timeline or Canvas to see both objects moving onscreen.

Notice that both objects come to an abrupt stop. This is probably not the effect you want, so in the next steps, the Drag behavior is used to slow both objects to a gentle stop.

![Diagram of motion path](image)
6 For each object in the Layers tab, choose its Motion Path behavior from the pop-up menu in the Dashboard title bar, and choose Ease Out from the Speed pop-up menu.

![Motion Path Behavior Settings]

As a result, both objects slow down before gradually coming to a stop.

7 Now, create a text object. This is the object that will fade in and zoom up to fill the screen. Resize this object to the size you want it to be at the beginning of the sequence.

![Text Object]

8 Next, choose the Adjust Anchor Point tool and move the anchor point to the center of the object. This way, when you scale it up with the Grow/Shrink behavior, it will zoom from its center.

![Text Zoomed Out]

9 Select the text object, then click the Add Behavior icon and choose Basic Motion > Grow/Shrink from the pop-up menu.
10. Next, open the Inspector, and click the Behaviors tab. Choose Ramp to Final Value from the Grow/Shrink behavior’s Increment pop-up menu. This enables the Grow/Shrink Dashboard control to adjust the size of the affected object at the last frame of the behavior, so that it doesn’t grow indefinitely.

11. Reposition the text object at the center of the Canvas, move the playhead to the last frame of the animation, and drag the Grow/Shrink control in the Dashboard until the text object reaches its final size.

12. Back in the Behaviors tab of the Inspector, increase the value of the Curvature parameter. This causes the increase in scale to gradually slow to a stop, rather than stopping abruptly.

13. Next, the Fade In/Fade Out behavior is used to fade the text object onscreen. Select the text object, click the Add Behavior icon in the toolbar, then choose Basic Motion > Fade In/Fade Out from the pop-up menu.
14 Drag the left shaded ramp of the Fade In/Fade Out control in the Dashboard to the right to lengthen the fade in effect.

15 Drag the right shaded ramp all the way to the right, until it’s a non-shaded, vertical edge. This eliminates the fade out part of the effect, so that the center text object remains onscreen for the remainder of its duration. The animation is now complete!

Example 2: Creating a Clock Animation
In this example, two parameter behaviors are used to create an animated clock. By arranging the objects and their anchor points properly, each part’s motion can be created quickly and easily using the Rate and Oscillate behaviors.

To create a clock animation:
1 Place the graphics objects constituting the hands, face, and pendulum into the Canvas, arranging them to create the clock. The hands are on top, the face in the middle, and the pendulum should be in the back.
By default, the anchor point is located at the center of each object. Prior to adding behaviors to animate these objects, you need to move the anchor points so that the objects move the way they’re supposed to. In this example, the hands should spin about the center of the clock face, not the center of the hand itself, and the pendulum should swing from its top.

2 Choose the Adjust Anchor Point tool, and move the anchor points of both hand objects and the pendulum object to the area that should appear to be attached to the rest of the clock.

3 Now that the composition is set up to be animated, the only remaining thing to do is to assign behaviors to each of the objects. Select the minute hand object, and open the Properties tab in the Inspector. Control-click the Rotation parameter, then choose Rate from the shortcut menu to apply the Rate parameter behavior.
4. Now, open the Behaviors tab, and set the Rate parameter to \(-49\). This rotates the minute hand clockwise at a continuous rate.

![Rate parameter set to -49](image)

5. Next, select the hour hand object, then open the Properties tab in the Inspector. **Control**-click its Rotation parameter, and choose Rate from the shortcut menu to apply the Rate parameter behavior to this object as well.

6. Again, open the Behaviors tab, but this time set the Rate parameter to \(-4\).

![Rate parameter set to -4](image)

When you play the project at this point, you can see that the hour hand rotates clockwise at a continuous rate along with the minute hand, but much more slowly, replicating the relative movement of both hands.
7 Now it’s time to make the pendulum swing. Select the pendulum object. You should have already adjusted its anchor point to be at the top. This way, the bottom pendulum object will swing properly. Open the Behaviors tab, Control-click the Rotation parameter, but this time choose Oscillate from the shortcut menu to add the Oscillate parameter behavior.

8 Open the Behaviors tab. Reduce the Oscillate behavior’s amplitude to 20 so that the pendulum object doesn’t swing so widely. Then, increase the speed to 50 in keeping with the overall fast-forward motion of the clock. You’re done!
Keyframes and Curves

Whether you want to send clips flying around the screen or animate individual filter settings on the fly, keyframes allow you to modify any parameter over time with extreme precision.

This chapter discusses how to create and edit keyframes in Motion. While behaviors are ideal for instantly adding complex motion or effects to an object, keyframes provide additional precision and flexibility. Keyframes ensure that a particular event happens on the exact frame you choose.

Most common effects utilize some keyframing. Whenever a movement or effect is timed to match a musical beat or a particular word in the soundtrack, a keyframe is the best tool for the job. Furthermore, any effect where multiple objects are affected in a coordinated way is usually the result of keyframing.

What Is Keyframing?
Keyframing is the process of assigning a specific parameter value to an object at a specific point in time. For example, you might want a clip to be scaled to fill the screen exactly five seconds into your project. When you set more than one keyframe, Motion generates the in-between frames, resulting in a smooth change of that parameter over time. This is called interpolation. For example, if you want a title to change from green to blue over time, you would set two keyframes at two different points in time. The first one would define the text’s color as green, and the second keyframe would set the color to blue. Motion automatically makes the frames between those points change smoothly from green to blue.

Motion lets you keyframe parameters such as color values, position, rotation, opacity, and almost every other parameter in the application.
Animation in Motion
There are several different places in Motion where you can create and edit keyframes and the values between them, which are represented by animation curves. For example, you can animate basic properties such as scale, rotation, and screen position by simply manipulating the object directly in the Canvas when the Record button is enabled.

When Record is enabled, a keyframe is created for any parameter that is adjusted. This includes parameters adjusted in the Canvas, Inspector, or Dashboard. In the Recording Options dialog (or press Option+A), you can enable the “Record keyframes on animated parameters only” option, which adds keyframes only to parameters that are already animated (keyframed)—even when Record is enabled. For more information, see “Recording Keyframes on Animated Parameters Only” on page 451.
You can also use the Dashboard and the Inspector to set and modify values for nearly every option in the application. Any time you adjust a slider or other control, you have the option of locking that change to the current frame, thereby setting a keyframe. From that point on, no matter what else you do, that parameter always finds its way to that specific value when playback reaches that frame.
You can also view and modify keyframes in the Timeline by clicking the Show/Hide Keyframes button. Keyframes appear as small blue (or white, when selected) diamonds beneath their parent object.

In the Keyframe Editor, you can see and manipulate a graph for every parameter in the application. Again, keyframes appear as diamonds, and the lines (or curves) connecting the keyframes indicate the values for the interpolated frames.

You can filter the parameter list to show only the channels and keyframes that you are interested in.
Animating in the Canvas

The easiest way to perform basic keyframing is to modify objects directly in the Canvas. The most common effects that you can create with keyframes are changes to Scale, Rotation, and Position. Additional parameters that can be keyframed in the Canvas include Shear, Pivot, Drop Shadow, Crop, and Four Corner. While many of these techniques can also be performed using behaviors, keyframing gives you the added flexibility to set specific values on precise frames.

Ordinarily, when you make transformations to an object in the Canvas, the object remains in the new position or shape for its entire duration. In order to create change in an object over time, you must create keyframes. There are several ways to create keyframes while working in the Canvas.

Using the Record Button

One of the simplest ways to create keyframes is to use the Record button. When Record is enabled, a keyframe is created for any parameter that is adjusted.

**Note:** When Record is enabled, keyframes are created whether you adjust the object onscreen, in the Dashboard, or in the Inspector.

![Record button on](record_button_on.png) ![Record button off](record_button_off.png)

When keyframing (Record) is enabled, the changes that you apply to the object are applied at the current playhead position (viewable in the mini-Timeline at the bottom of the Canvas). A keyframe is automatically added (though no indicator appears). If you move the playhead to a new position and change the shape or position of the object, you create a new keyframe. Motion automatically figures out the shape and position of the object during the frames between the two keyframes you set.

**Important:** When Record is enabled, a red keyframe appears in the center of the selected object. When moving the object in the Canvas, do not click the keyframe in the center of the object as you are actually selecting and repositioning that keyframe instead of the object's current position.

**To scale an object over time using the Record button:**

1. Click the Record button (or press A) to enable keyframe recording. You can also choose Mark > Record Animation.
2. Select an object in the Canvas.
3. Move the playhead to a new time position.
4. Scale the object up or down by dragging a corner handle.
5. Click the Record button (or press A again) to disable keyframe recording.
The object is scaled over the interval you set. In this same way, you can keyframe any of the transformation parameters for your object.

You can also Control-click the object to display the Transform shortcut menu where you can choose to modify the Pivot, Shear, Drop Shadow, Four Corner, and Crop parameters. When set to Transform, you can scale the object by its corners and rotate it by using the center control. For more information on object transformations in the Canvas, see “Object and Layer Transforms in the Canvas” on page 221.

When the Record button is on, each time you move the playhead to a new frame, any change you make to an object automatically generates new keyframes. When animating an object’s position, an animation path is created.
**Note:** To view the animation paths of keyframed objects, ensure Animation Path is selected in the View pop-up menu.

When the Record button is off, changes you make modify the entire animation globally. For example, if an object is keyframed to fly from the lower left to the center of the screen, dragging the object to the right when the Record button is off moves the entire path to the right.

**Note:** If you are positioned on a previously set keyframe, any changes you make modify that individual keyframe rather than the entire curve, regardless of whether the Record button is on or off.

**Applying Movement to a Clip**
Since moving objects onscreen is so fundamental to motion graphics, Motion makes it especially easy.

**To move an object across the screen:**
1. Click the Record button (or press A) to enable record.
2. Place the playhead at the starting frame.
3 Place the object in a starting position.

4 Move the playhead forward.

5 Drag the object to the ending position you want.

6 Click the Record button (or press A) to turn off keyframe recording.

If you play back your project, the object flies from position one to position two over the interval you set. You can see the path the object travels by turning on the Animation Path setting in the View pop-up menu above the Canvas.

**Important:** When Record is enabled, you can choose to only add keyframes to an object’s parameters that are already animated. This option is available in the Recording Options dialog. For more information, see "Recording Keyframes on Animated Parameters Only" on page 451.
Manipulating Animation Paths
When the path is displayed, you can directly manipulate the keyframes to reposition them and change the path that the object follows.

To add keyframes to an animation path:
1 Option-click the path.
   A new point is added.
2 Drag it to the new position.
   You can convert a keyframe into a Bezier point to create a curved path. This can be done either as you create the keyframe, or after the keyframe has been created.

To add a Bezier keyframe to an animation path:
   Option-click the path, then immediately drag away from the point.
   A point is added and a Bezier handle appears.

To change an existing keyframe into a Bezier point:
   Command-click the keyframe and drag away from the point.
   Handles are added to the keyframe.
   Animation path control points are modified in the same manner as shape or mask Bezier points. For more information on manipulating Bezier splines, see “Drawing Masks and Shapes Using Bezier Splines” on page 821.

Animating With the Dashboard
To keyframe the parameters that appear in the Dashboard, you follow the same procedure as keyframing directly in the Canvas. For example, when an object is selected in the Canvas, the Dashboard gives quick access to the object's opacity. If you want to make a custom effect such as a temporary dip to black, you would keyframe the opacity channel.
To animate a clip's opacity:
1. Click the Record button to enable record (or press A).
2. Place the playhead at the frame where you want to begin the fade.
3. Click the Opacity slider handle in the Dashboard.

Even if you don't change the slider's value, clicking it sets a keyframe at that point in time. This way the object remains at its previous opacity from the beginning of the clip until that new keyframe, then begins the interpolation toward the next keyframe.

4. Move the playhead forward to a new time.
5. Change the Opacity value.
6. Move the playhead forward again.
7. Change the Opacity slider again.
8. Click the Record button (or press A) to turn keyframe recording off.

Keyframes at the Beginning and End of the Curve
When you begin adding keyframes, you instruct Motion to automatically modify the in-between frames to interpolate the effect. But what values are used for the frames before the first keyframe and after the last one?

By default, when you add your first keyframe, that same value is extended forward and backward to the beginning and end of the clip (just the same as if you hadn't added a keyframe at all).

Once you add a second keyframe, the effect begins to change over time. But the frames before that first keyframe remain at the value of that first keyframe. Similarly, the frames after the last keyframe hold at that last defined value.

You can override this default behavior to create loops and other patterns by using the Before First Keyframe and After Last Keyframe submenus as described in the "Extrapolation" section later in this chapter.
Animating Filters
In addition to making changes to a clip's basic attributes, keyframing can be used to modify nearly every parameter in the application. When the Record button is activated, any parameter displayed on the Dashboard becomes keyframeable. For example, as you apply filters to objects, the most important parameters are displayed on the Dashboard. Using keyframes, you can animate those parameters. In this way, you can create a shot that grows more blurry over time, or animate the width of a bevel effect.

To animate a filter:
1. Select an object that you want to modify.
2. Apply a filter to the object.
   The Dashboard changes to display the parameters for the filter. For more information on how to apply filters, see “Working With Filters” on page 701.
3. Click the Record button (or press A) to enable record.
4. Place the playhead where you want the effect to begin changing.
5. In the Dashboard, set the parameter slider to the beginning value.
6. Move the playhead to the frame where you want the effect to stop changing.
7 Set the slider to a new value.

8 Click the Record button (or press A) to disable record.

The filter now changes over time to reflect your settings. This same technique can be applied to any parameter in any filter that appears in the Dashboard.

**Animating Behaviors**

In addition to animating filter parameters, you can also animate behaviors. Animating behaviors might appear complicated at first because most of the behaviors are already changing, but combining these features is a powerful way to greatly enhance behaviors’ usefulness. For example, you might want to animate a Random Motion behavior to begin as a subtle random motion and then become increasingly severe as the effect progresses. Or you might want to apply a Gravity behavior, but you don’t want the object to start falling toward the ground until five seconds into the clip. Keyframes allow you to manipulate the specific parameters of each behavior.

**Note:** In Motion, you can bake all the behaviors that have been applied to an object into keyframes using the Convert to Keyframes command in the Object menu. For more information, see “Converting Behaviors to Keyframes” on page 343.

**To animate a behavior:**

1 Select an object in the Canvas.

2 Apply a behavior.

3 Click the Record button (or press A) to enable record.

4 Place the playhead at the frame where you want the effect to begin changing.

5 Using the Dashboard, adjust the behavior’s settings.
6  Move the playhead to a new time position.
7  Adjust the behavior settings again.
8  Click the Record button to disable record (or press A).

**Combining Behaviors and Keyframes**

Since it is possible to add keyframes to an object that may already have a behavior (or many behaviors) applied, it is possible that these two methods could conflict. For example, you might apply a Throw behavior toward the upper left, and at the same time add keyframes that instruct the object to move to the right. Now what?

The way Motion handles this sort of conflict is that the instructions are added together, giving you a combination of the two sets of instructions. In the above example, the object would move toward the upper left, but it won’t get as far, because the keyframes are pushing it in an opposing direction.

The larger the Throw velocity rate, the more it overpowers the keyframes, and vice versa.
Once you get the hang of how it works, you can use this method to enhance and control the effects of behaviors. For example, you could apply a Gravity behavior which causes an object to fall toward the bottom of the frame, but keyframe the object’s position to move across the screen from left to right. In this way, you can create the effect of the object falling as it moves. Or you might apply a Fade In/Fade Out behavior, but use keyframes on the object’s Opacity parameter to limit the maximum opacity to 80 percent. The clip would still fade in and out and you could continue to modify the behavior’s attributes, but the object would never exceed the opacity value set by the keyframes.

One method for handling behaviors and keyframes is to convert behaviors to keyframes. For more information on converting behaviors to keyframes, see “Converting Behaviors to Keyframes” on page 343.

**Animating Using the Inspector**

Although you can animate many attributes using the Dashboard, many other parameters are only accessible in the Inspector. All of the Inspector’s tabs contain keyframeable parameters. In this way, you can animate the position and shape of a mask, the color and styles of a text object, or the various options within the generators. The channels that are keyframeable depend on which object is selected and which effects have been applied to that object.

You can animate channels in the Inspector using the Record button and the mini-Timeline playhead just like you would animate parameters in the Canvas or Dashboard.

**To animate parameters in the Inspector:**

1. Select the object you want to keyframe in the Canvas.
2. Click the Record button (or press A) to enable record.
3. Place the playhead on the frame where you want the effect to begin.
4. Display the Inspector by clicking the tab or rearranging the screen layout to one that includes the Inspector. For more information on layouts, see “Preset Layouts” on page 21.
5 Click the Inspector tab where the parameter you want to modify is located (filters in this example).

![Inspector Tab and Keyframe Options]

6 Set the parameter to the beginning value.

7 Move the playhead to a new position.

8 In the Inspector, change the parameter to a new value.

9 Click the Record button (or press A) again to disable record.

The parameter now changes over time.

The Animation Menu

Animating in the Inspector provides additional options, such as the ability to delete or reset keyframe information. You can also navigate between keyframes in the Inspector. Every keyframeable parameter contains an Animation menu. If a parameter lacks a menu, it cannot be animated.
Enable Animation: This menu item remains unavailable until animation is applied to the channel either by using the Record button or by directly adding a keyframe. Once the channel has at least one keyframe set, the menu item is automatically renamed Disable Animation. Choosing Disable Animation at that point effectively hides the keyframes you have set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation again restores the channel to its last keyframed state.

Reset Parameter: Removes all keyframes and settings for this channel. The parameter value is reset to its default value.

Add Keyframe: Adds a keyframe at the current frame in the project. If the playhead is positioned on a frame where a keyframe has already been added, this menu command is unavailable.

Note: To add a keyframe, you can also position the pointer over the Animation menu and press Option. When the keyframe icon appears next to the point, click to add a keyframe.

Add Keyframe Shortcut
To quickly add a keyframe without accessing the Animation menu in the Inspector, press Control+K. A keyframe is automatically added to the last modified parameter of the object (regardless of the status of the Record button) at the current time.

Delete Keyframe: Deletes the current keyframe. The Delete Keyframe option is only available if the playhead is positioned on a frame where a keyframe already exists.

Previous Keyframe: Moves the playhead to the previous keyframe for this parameter. The Previous Keyframe command is only available if a keyframe exists earlier in the project.

Next Keyframe: Moves the playhead to the next keyframe for this parameter. The Next Keyframe command is only available if a keyframe exists later in the project.

Show in Keyframe Editor: This opens the Keyframe Editor and displays the selected parameter’s keyframes and curves. For more information on working with the Keyframe Editor, see “Animating in the Keyframe Editor” later in this chapter.

To set keyframes using the Animation menu:
1 Enable Record (press A), then move the playhead to the frame where you want to set the first keyframe.
2 Change the value of the parameter you want to keyframe.
3 Click the Animation menu, then choose Add Keyframe.
   A keyframe is added at the current frame.
4 To set another keyframe for the same parameter, move the playhead to the next location and adjust the parameter. A keyframe is automatically added when you change the parameter.

**To navigate to a keyframe:**
1 Click the Animation menu for the parameter containing the keyframe you seek.
2 Choose Previous Keyframe if the desired keyframe is earlier in time than the current time position, or choose Next Keyframe if the desired keyframe is later in time than your current time position.

*Note:* You can also choose Mark > Go To > Previous Keyframe (or press Option+K) or Next Keyframe (or press Shift+K) to move from keyframe to keyframe.

**To delete a keyframe:**
1 Navigate the playhead to the frame where the keyframe is currently set.
2 Click the Animation menu for the parameter you want to change, then choose Delete Keyframe.

*Note:* To delete all of the keyframes for a parameter, choose Reset Parameter from the Animation menu.

**To reset all keyframes for a parameter:**
- Click the Animation menu for the parameter you want to reset, then choose Reset Channel.

All keyframes are removed for that parameter.
Animation Menu States
Depending on whether or not a parameter is currently animated, and whether or not the playhead is positioned on a keyframe, the Animation menu displays a different icon. This provides the ability to determine the status of that parameter at a glance.

The Reset Button
Each parameter set in the Inspector is equipped with a Reset button. A parameter set might be a filter, or it might be a category of effects or transformations, such as Transform, Blending, or other items in the Properties tab.

The Reset button removes all keyframes applied to all of the parameters within the set and restores those parameters to their default state.
Chapter 6  Keyframes and Curves

Animating in the Timeline

When keyframing, it is often very helpful to view your keyframes over time. This lets you line up keyframes with other important timing elements in your project such as edit points, sound cues, markers, and even other keyframes. These functions are available in the Timeline.

In order to view your keyframes in the Timeline, you must first turn on the Show Keyframes option.

**To show keyframes in the Timeline:**
- Click the Show/Hide Keyframes button.
You can identify a keyframe’s value in the shortcut menu. Multiple keyframes on the same frame are all listed in the menu.

To find a keyframe’s value:
- Control-click the keyframe.

A shortcut menu appears. The first items in the list are the keyframe values for any keyframes on that frame.

Note: There is no way to add keyframes in the Timeline.

Modifying Keyframes in the Timeline
When keyframes are visible in the Timeline, you can change their positions in time by dragging them horizontally in the track. This does not modify the keyframe’s parameter value, it just changes the position in time when it occurs.

To move a keyframe in the Timeline:
1 Click the Show/Hide Keyframes button in the Timeline.
2 Identify the object where the keyframe is located.
3 Drag the keyframe to the left or right to move it forward or backward in time.

Although moving a keyframe in time does not change the parameter’s value, it can have a significant effect on the nature of the animation. For example, if you have two keyframes that animate an object from the top of the screen to the bottom over five seconds, moving one of the keyframes forces the animation to occur more slowly (if you drag them farther apart) or more quickly (if you drag them closer together).

Aligning Keyframes With Other Elements
One of the main advantages of manipulating keyframes in the Timeline is the ability to line up a keyframe with another important time marker. For example, you may want to align a filter keyframe applied to one object with an object occurring on another track.

To align a keyframe to another object:
1 Click the Show/Hide Keyframes button in the Timeline.
   Any keyframes in the project become visible.
2 Identify the keyframe you want to move.
**Note:** Control-clicking a keyframe displays a shortcut menu containing the parameter name and value for each keyframe. If more than one keyframe is at the same point in time, the shortcut menu lists all of them.

3 Drag the keyframe until it lines up with the edge of the object. If you press the **Shift** key while you drag, the keyframe snaps to the edges of other objects.

You can use this same technique to align keyframes from one object to keyframes in another object. In this way, you can arrange two objects to both fade in or blur into focus at exactly the same frame. It doesn't matter whether the objects are in the same layer or not.

**To align keyframes across objects:**
1 Click the Show/Hide Keyframes button in the Timeline.
2 Identify the keyframe you want to move.
3 Find the object containing the parallel action.
4 Drag the keyframe in the first object until it lines up with the corresponding keyframe in the second object.

**Aligning Keyframes to Markers**
Other objects in your Timeline can also serve as guides for where to move your keyframes. For example, you may have a music cue or line of narration where you want a particular effect to end or change.
One great way to do this is to use time markers. Simply identify the important frame with a marker and drag the keyframe until it lines up with the marker. Markers create snap points, so pressing Shift while you drag a keyframe makes it snap to markers. To learn more about setting markers, see “Adding Markers” on page 312.

To align a keyframe with a marker:
1. Click the Show/Hide Keyframes button in the Timeline.
2. Identify the keyframe you want to move and drag it to the marker.
3. Press the Shift key while you drag to enable snapping.
   The keyframe snaps to the marker.

Deleting Keyframes in the Timeline
If you ever need to remove a keyframe, or clear all keyframes from a particular object, you can delete keyframes using the shortcut menu in the Timeline.

To delete a keyframe in the Timeline:
1. Click the Show/Hide Keyframes button in the Timeline.
2. Control-click the keyframe you want to delete, then choose Delete Keyframe from the shortcut menu.

To delete all keyframes from an object:
1. Click the Show/Hide Keyframes button in the Timeline.
2. Control-click any keyframe for the object you want to clear, then choose Delete All Keyframes from the shortcut menu.

For more precise control of effects using keyframes, you can use the Keyframe Editor. Any keyframe in the Timeline can be viewed in the Keyframe Editor using the shortcut menu.

To view a keyframe in the Keyframe Editor:
- Control-click the keyframe in the Timeline, then choose Show in Keyframe Editor from the shortcut menu.

   The Keyframe Editor is brought to the front and the keyframe (and the rest of that parameter) is highlighted in the graph.
Trimming Keyframed Effects

When the duration of an effect such as a filter or behavior in the Timeline is changed, keyframes applied to that object are scaled accordingly. This means that an effect keyframed to change over time speeds up or slows down if the object it is applied to is shortened or lengthened.

Changing the duration of an object does not modify keyframes applied to attributes in the Properties or Object tab in the Inspector. Keyframes appear in the area underneath the object bar if you choose to show keyframes in the Timeline.

You can also speed up or slow down a keyframed effect by resizing the effect bar in the Timeline.
You can prevent this automatic resizing by pressing **Command** while resizing an effect object. This changes the overall duration of the effect, but does not alter the speed at which the effect changes as determined by the keyframes.

Pressing **Command** while you resize an object with effects applied trims the object without trimming the effects. This works the same way as trimming a layer without modifying the durations of the component elements.

**Animating in the Keyframe Editor**
Whenever you create two or more keyframes, Motion generates interpolated values for the frames that come between. These are called curves. The Keyframe Editor is the control that allows you to view and make modifications to those curves. This feature provides one of the most sophisticated and powerful ways to modify the objects and effects in your project.
Viewing the curves for your animated parameters gives you another way to understand how your effect is changing over time. The curves are laid out over a graph where you can compare the curves of different parameters. As you get more familiar with “reading” the graphs, you will learn how and why certain effects feel organic or synthetic.

In the Keyframe Editor you can add and delete keyframes, as well as move them in two-dimensional space to modify their values (up-down) and their positions in time (left-right). You can also directly manipulate the curves themselves. Furthermore, you can define a variety of interpolation methods, creating dramatically different types of effects.

For example, in the real world, when objects move, they observe rules of physics, such as inertia and momentum. Motion’s Keyframe Editor allows you to simulate these sorts of effects in your motion graphics.
Check Your Selection
The parameters that are available in the Keyframe Editor depend on which objects are selected in the other windows. If you select one item in the Layers tab, Canvas, or Timeline windows, only parameters for that object are accessible in the Keyframe Editor.

If you want to compare curves from parameters across multiple objects (for example to make two separate objects begin fading in at the same time), you must select both items in the Layers tab or in another window. Then parameters for both objects are listed in the Keyframe Editor.

Additionally, you can modify curves on an entire layer if the layer is selected instead of the objects within it. In this way, you can view or modify keyframe activity that affects all of the objects within the layer as a group.

To display the Keyframe Editor, do one of the following:
- If the Timing pane is already visible, click the Keyframe Editor tab in the Timing pane.
- Choose Window > Keyframe Editor.
- Press Command+8.

Parts of the Window
The Keyframe Editor is made up of a list of parameters on the left and a multifunctional graph on the right.
**Current Frame Field**
This control lets you instantly jump to any frame in your project. Since it is also a value slider, you can drag it to move the playhead to a new frame.

**To move to a frame, do one of the following:**
- Double-click in the value field, type a frame number, then press Return.
  The playhead moves to the specified frame.
- Drag the Current Frame value slider left or right. Dragging to the left moves the playhead earlier in time. Dragging to the right moves it forward in time.

**The Parameter List**
Any keyframeable parameters of your selected items can be displayed in the list on the left side of the window. This includes object properties, filters, and behaviors. By selecting multiple items in the Layers tab or Timeline, you can compare parameters across multiple objects.

**Activation checkbox:** The checkbox on the left determines which parameters are displayed in the graph. Checked parameters are considered “active.”

**Parameter name column:** The second column lists the object name and the parameter names for each object.

**Value column:** The third column displays the parameter value for the frame where the playhead is currently positioned. If the playhead is parked on a keyframe, the field shows the value for that keyframe. If the playhead is not parked on a keyframe, the field shows the value of that parameter at that frame. For more information on changing the values of keyframes, see “Modifying Keyframes” on page 433.

You can click the value to activate the field. When Record is enabled, a keyframe is automatically added if you click the value field at a frame that has no keyframe. To type a value in the field, double-click it.

**Note:** Selecting a keyframe does not display the value of that keyframe, it shows the value for a parameter at the frame where the playhead is currently positioned.

**Animation menu:** The fourth column contains a pop-up menu that mimics the Animation menu found in the Inspector. However, the Animation menu in the Keyframe Editor contains several commands not found in the Inspector.

- **Enable/Disable Animation:** This command remains unavailable until keyframing is applied to the parameter, either by using the Record button or by directly adding a keyframe. Once the parameter has some animation applied, the command is automatically renamed Disable Animation. Activating it at that point effectively hides the keyframes you have set, restoring the parameter to its default value. However, the keyframes are not thrown away. Choosing Enable Animation restores the parameter to its last keyframed state.
• **Reset Parameter:** Removes all keyframes and settings for this parameter. The parameter value is reset to its default value.

• **Add Keyframe:** Adds a keyframe at the current frame in the mini-Timeline. If the playhead is positioned on a frame where a keyframe has already been added, this command is unavailable.

  **Note:** As mentioned in the Animation menu section, you can use a keyboard shortcut to quickly add a keyframe by pressing Control+K. A keyframe is automatically added to the last modified parameter of the object.

• **Delete Keyframe:** Deletes the current keyframe. The Delete keyframe command is only available if the playhead is positioned on a frame where a keyframe already exists.

• **Previous Keyframe:** Moves the playhead to the previous keyframe for this parameter. The Previous Keyframe command is only available if a keyframe exists earlier in the project.

• **Next Keyframe:** Moves the playhead to the next keyframe for this parameter. The Next Keyframe command is only available if a keyframe exists later in the project.

• **Interpolation:** Sets the type of curve for the parameter. See the table in the “Modifying Curves” section later in this chapter for examples of the different interpolation methods. Choose from Constant, Linear, Bezier, Continuous, Ease In or Ease Out.

• **Before First Keyframe:** Defines what happens between the first keyframe and the beginning of the clip. See the table in the “Extrapolation” section later in this chapter for examples of the different extrapolation methods. Choose from Constant, Linear, Ping Pong, Repeat, or Progressive. You can also turn the extrapolation into actual keyframes by choosing Generate Keyframes.

• **After Last Keyframe:** Defines what happens between the last keyframe and the end of the clip. See the table in the “Extrapolation” section later in this chapter for examples of the different extrapolation methods. Choose from Constant, Linear, Ping Pong, Repeat, or Progressive. You can also turn the extrapolation into actual keyframes by choosing Generate Keyframes.

• **Lock/Unlock Parameter:** Locks this parameter from further changes. When a parameter is locked, neither keyframes nor curves are adjustable.

• **Reduce Keyframes:** Applies a thinning algorithm to the keyframes for the chosen parameter. This reduces the number of keyframes in a parameter while attempting to maintain a similar shape to the curve. Increasing the tolerance results in fewer keyframes.
Filtering Controls
Effective use of the Keyframe Editor requires controlling the list of parameters currently on display in the graph area. While you may want quick access to all of the different parameters you may be animating, displaying too many parameters at once makes the graph difficult to read. Motion provides the ability to store sets of parameters to facilitate this management.

The Show Pop-Up Menu
The Show pop-up menu allows you to display three built-in parameter curve sets as well as custom sets you build yourself.

To view all of the parameters for all selected objects:
- Choose All from the Show pop-up menu.

By default, only the animated parameters are active in the graph. Turn individual parameters on and off by clicking the checkbox to show or hide them in the graph. You can choose to display all parameters associated with a particular layer or object by checking or unchecking the checkbox for that layer or object.

To view only parameters that are currently being modified:
- Choose Active from the curve set list pop-up menu.
This option shows only the parameter(s) currently being modified. When this option is selected, nothing appears in the Keyframe Editor unless you are actively modifying an object (in the Canvas, Inspector, or Dashboard). For example, when Active is selected and you are moving an object around in the Canvas, the X and Y Position parameters and curves are displayed.

Alternatively, you can elect to view only the parameters that are currently animated, meaning they already contain one or more keyframes.

To view only parameters with one or more keyframes for a selected object:

- Choose Animated from the Show pop-up menu.

**Custom Parameter Sets**

In addition to using the built-in curve sets, you can make your own. As you create and store custom parameter sets, they appear in the Show pop-up menu so you can switch quickly between them. Deleting, duplicating, and modifying custom sets is done in the Manage Curve Sets dialog.

**To create a new parameter set:**

1. Choose New Curve Set from the Show pop-up menu.
   
   A dialog appears.

2. Type a name for the set, then click OK.

   Once your set has been created, you can choose it from the Show pop-up menu.

   **To add parameters to a custom parameter set, do one of the following:**

   - Drag the parameter from any of the tabs in the Inspector directly into the Keyframe Editor.
Click the Animation menu for that parameter, then choose Show in Keyframe Editor.

The parameter is added to the custom curve set.

*Note:* If Animated is chosen from the Show pop-up menu when you use the Show in Keyframe Editor command from the Animation menu, a new untitled curve set is automatically created.

To delete parameters from a custom set:
- Drag the parameter out of the list. It disappears with a “poof.”

To delete all parameters from a custom set:
- Click the “Clear curve list” button.
To delete a custom parameter set:

1. Choose Manage Curve Sets from the Show pop-up menu. The Manage Curve Sets dialog appears.

2. Select the name of the set you want to delete.

3. Click the Delete (–) button at the top of the dialog. The set is deleted.

4. Click Done to close the dialog.

To duplicate a custom parameter set:

1. Choose Manage Curve Sets from the Show pop-up menu. The Manage Curve Sets dialog appears.

2. Select the name of the set you want to duplicate.

3. Click the Duplicate button at the top of the dialog. The set is duplicated.

4. Double-click the set name in the list, then type a new name for the set.

5. Click Done to close the dialog. The new set now appears in the Show pop-up menu. These sets are saved with the project, so each time you reopen the project, they are available to you. Store as many parameter sets as you like. Once you have a set stored, you can change or delete that set as needed.
The Curve Graph
A graph appears to the right of the parameter list and displays the curves for your selected parameters. The graph has a time ruler at the top and a zoom/scroll control at the bottom that are identical to the corresponding controls in the Timeline. These allow you to identify at what time keyframes appear, as well as see project markers, playback In and Out points, and the playhead. Using the zoom controls at the bottom of the graph, you can zoom in to obtain much more precise control over keyframe positioning and curve shape. For more information on using the zoom/scroll controls, see “Zooming in the Timeline” on page 75.

The body of the graph displays the keyframes and curves of active parameters. Each parameter is a different color, though some colors are duplicated.

Modifying Keyframes
The Keyframe Editor provides an ideal environment for manipulating your keyframes because you can see their values, placement in time, and how the changes you make affect the interpolative curves surrounding your keyframes.

To change the value of a keyframe, do one of the following:
- Click the keyframe you want to modify, and then drag the keyframe along the Y axis (up and down) to change its value. To change its position in time, drag along the X axis (left to right).
- Press the Shift key while dragging to constrain movement to one axis.

When dragging a keyframe in the graph, numbers appear indicating the new position and value of the keyframe. The first number is the frame number and the second number is the value.

When you drag two keyframes closer together along the X axis, the transformation between those values happens more quickly. When you drag keyframes farther apart from each other, the change happens more slowly.
• Double-click the keyframe you want to modify, type the new value into the value field, then press Return.

This changes the value of the keyframe along the Y axis (up and down).

Note: To get out of an active value field without making any changes, press Esc.

• Drag in the value slider in the parameter list.

• Drag to the right to increase the value of the keyframe along the Y axis.
• Drag to the left to decrease the value of the keyframe along the Y axis.
• Press Shift while dragging to change the value in increments of 10.
• Press Option while dragging to change the value in increments of .01.

In addition to modifying existing keyframes, you can add and delete keyframes right in the graph.

To add a keyframe:
1 Press the Option key and move the pointer over the parameter curve you want to modify.

The pointer turns into a plus (+).

2 Click the curve at the frame where you want the keyframe to appear.

3 Drag the keyframe to your preferred value.

Note: You can also add a keyframe at the current playhead position by choosing Add Keyframe from the Animation menu for any parameter, or by double-clicking the curve.
Curves created when new keyframes are added are set to the linear interpolation method. For more information on interpolation methods, see “Modifying Curves” on page 437.

To delete a keyframe, do one of the following:
- Select the keyframe, then press Delete.
  
  **Note:** You can drag to select multiple keyframes.
- Control-click the keyframe, then choose Delete from the shortcut menu.
- Navigate to the keyframe, then choose Delete Keyframe from the Animation menu for that parameter.

To delete all of the keyframes for a parameter:
- Click the Animation menu in the parameter list, then choose Reset Parameter.
  
  **Note:** You can also use the Animation menu in the Inspector.

**Controlling Keyframes**
In addition to deleting keyframes, there are some special settings you can apply to your keyframes to control the shape of your curve. These settings are available in the shortcut menu for keyframes.

To lock or disable a keyframe:
- Control-click the keyframe you want to modify, then choose Lock or Disable from the shortcut menu.

  **Lock:** Prevents any further modification to that keyframe.

  **Disable:** Makes a keyframe temporarily ignored without deleting it.

**Copying and Pasting Keyframes**
Keyframes can be moved from one parameter to another using copy and paste. This can be useful for copying a particular keyframe effect from one object to another, moving a keyframe path earlier or later in the same parameter, or for creating keyframes on one parameter and applying them to another parameter.

To copy keyframes, you must select the keyframes you want to copy.

**Note:** Keyframes can only be pasted to parameters of the same type. For example, you can copy and paste the Opacity keyframes of one object to the Opacity parameter of another object. You cannot copy the Rotation keyframes of an object and paste them to the Opacity parameter of another object.
To select keyframes, do one of the following:

- Drag a selection box around the keyframes you want to select.
- **Shift**-click the keyframes you want to select.

If only the curve (and not the keyframes) appear white, the keyframes are not selected.

Selected keyframes appear white.

Once you have the keyframes selected, you can cut or copy them to move them to the Clipboard.

**To copy selected keyframes:**
- Choose Edit > Copy (or press **Command**+C).

**To cut selected keyframes:**
- Choose Edit > Cut (or press **Command**+X).

To paste your selected keyframes, you must select both the parameter you want to paste to, and the place in time where you want the pasted keyframes to begin.
To paste keyframes:
1 Select the destination parameter in the parameter list.
2 Place the playhead at the point in time where you want the keyframes to begin.
3 Choose Edit > Paste (or press Command+V).

Pasted keyframes may not make an identical-looking curve to the original if the parameter scales are different.

Modifying Curves
Perhaps the most powerful and valuable feature that the Keyframe Editor offers is the ability to make changes to the curves between the keyframes. Of course, manipulating keyframes causes changes in the curves, but Motion gives you tools to control the interpolation and extrapolation of your parameter values themselves.

By using different preset mathematical algorithms or by using manual controls, you can dramatically alter the impact of your effects.

When you set the interpolation for a curve, you select the keyframe you want to modify. The method you choose determines the distribution of values through, into, or out of the selected keyframe.

To set an interpolation method for a keyframe:
1 Select the keyframe you want to affect.
   The keyframe turns white.
2 Control-click the keyframe to display the shortcut menu.
3 Choose an interpolation method from the Interpolation shortcut menu.
To set an interpolation method on a curve segment:

- Control-click the segment, then choose an interpolation method from the Interpolation submenu.

You can set different interpolation methods for different segments of the same curve.

When different interpolation methods are applied to the different segments of an animation curve, the methods that are used in the curve appear with a dash next to their name in the Interpolation submenu (in the Keyframe Editor parameter list). In the following image, all interpolation methods are applied to the selected curve.
The different interpolation methods are described in the table below.

<table>
<thead>
<tr>
<th>Interpolation method</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td><img src="image" alt="Constant example" /></td>
<td>HOLDS THE KEYFRAME AT ITS CURRENT VALUE WHEN APPLIED TO A SEGMENT OR KEYFRAME AND THEN CHANGES SUDDENLY TO THE NEW VALUE WHEN THE NEXT KEYFRAME OCCURS.</td>
</tr>
<tr>
<td>Linear</td>
<td><img src="image" alt="Linear example" /></td>
<td>WHEN APPLIED TO A KEYFRAME, CREATES A UNIFORM DISTRIBUTION OF VALUES THROUGH THE KEYFRAME FROM ITS TWO ADJACENT KEYFRAMES. WHEN APPLIED TO A SEGMENT, CREATES UNIFORM DISTRIBUTION OF VALUES BETWEEN THE TWO POINTS.</td>
</tr>
<tr>
<td>Bezier</td>
<td><img src="image" alt="Bezier example" /></td>
<td>LETS YOU MANIPULATE THE KEYFRAME CURVE MANUALLY BY DRAGGING THE HANDLES. IF MULTIPLE BEZIER KEYFRAMES ARE SELECTED, OR BEZIER IS APPLIED TO THE CURVE SEGMENT, THE HANDLES OF ALL THE SELECTED KEYFRAMES ARE MODIFIED.</td>
</tr>
<tr>
<td>Continuous</td>
<td><img src="image" alt="Continuous example" /></td>
<td>THIS METHOD BEHAVES LIKE BEZIER INTERPOLATION, BUT WITHOUT ACCESS TO THE HANDLES (THEY ARE CALCULATED AUTOMATICALLY). THE PARAMETER BEGINS TO CHANGE GRADUALLY, REACHING ITS MAXIMUM RATE OF ACCELERATION AT THE MIDPOINT, THEN IT TAPERS OFF SLIGHTLY AS IT APPROACHES THE SECOND KEYFRAME. WHEN APPLIED TO A KEYFRAME, THE SEGMENTS BEFORE AND AFTER THE KEYFRAME ARE AFFECTED. WHEN APPLIED TO A CURVE SEGMENT, THE SEGMENT BETWEEN TO THE TWO KEYFRAME IS AFFECTED.</td>
</tr>
<tr>
<td>Ease In</td>
<td><img src="image" alt="Ease In example" /></td>
<td>A TYPE OF REVERSE-INERTIA EFFECT, SO THAT A VALUE CHANGE SLOWS COMING INTO A KEYFRAME. WHEN APPLIED TO A CURVE SEGMENT, THE VALUE CHANGE EASES INTO THE SEGMENT.</td>
</tr>
<tr>
<td>Ease Out</td>
<td><img src="image" alt="Ease Out example" /></td>
<td>CREATES A TYPICAL INERTIA-LIKE LAG, SO THAT A VALUE CHANGE BEGINS MORE SLOWLY COMING OUT OF A KEYFRAME. WHEN APPLIED TO A CURVE SEGMENT, THE VALUE CHANGE EASES OUT OF THE SEGMENT.</td>
</tr>
</tbody>
</table>

Alternatively, you can apply an interpolation method to the entire parameter. In the following example, the Y Position curve (green) is currently set to Bezier.
To change the interpolation method for an entire parameter:

- In the Keyframe Editor, click the Animation menu and choose an method from the Interpolation submenu.

The selected interpolation method (Constant in this example) is applied to the entire curve.

**Convert to Bezier**

Bezier interpolation method is the most flexible, allowing manual modification of the curve. Motion lets you convert any keyframe into a Bezier keyframe quickly and easily.

To convert a keyframe into a Bezier keyframe:

- Command-drag the keyframe.
Bezier handles appear and your mouse movement automatically controls one of the handles.

\[\text{Beziers}\]

**Note:** Command-clicking a Bezier point resets it to Linear interpolation.

To simultaneously modify the handles for more than one control point, Shift-select the points and then adjust the tangents. If there are no tangents on the point, Command-drag the point.

**Extrapolation**

In addition to setting interpolation for the areas between keyframes, you can define how Motion generates the values before the first keyframe and after the last one (extrapolation). When you set a such a method for a parameter, new keyframes are added beyond your original keyframes. This can be helpful when trying to extend the duration of an effect such as a moving background.

**To set the Before First Keyframe for a parameter:**

1. Click the Animation menu for the parameter you want to change.
2 Choose a setting from the Before First Keyframe submenu.

To set the After Last Keyframe setting for a parameter:
1 Click the Animation menu for the parameter you want to change.
2 Choose a setting from the After Last Keyframe submenu.

The following table describes the extrapolation options.

<table>
<thead>
<tr>
<th>Extrapolation method</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant (Default)</td>
<td><img src="constant_example.png" alt="Constant Example" /></td>
<td>The parameter remains at the exact value of the first and last keyframes in the extrapolated area.</td>
</tr>
<tr>
<td>Linear</td>
<td><img src="linear_example.png" alt="Linear Example" /></td>
<td>Extends the curve beyond the first and last keyframes uniformly, along the existing trajectory.</td>
</tr>
<tr>
<td>Repeat</td>
<td><img src="repeat_example.png" alt="Repeat Example" /></td>
<td>Duplicates the curve, applying it again and again.</td>
</tr>
<tr>
<td>Ping Pong</td>
<td>![Ping Pong Example](ping pong_example.png)</td>
<td>Copies the curve and repeats it, alternating forward and backward.</td>
</tr>
<tr>
<td>Progressive</td>
<td><img src="progressive_example.png" alt="Progressive Example" /></td>
<td>Extends the curve by repeating the existing shape of the curve, but rather than returning to the exact same values, it begins again from the existing end value.</td>
</tr>
</tbody>
</table>
Generate Keyframes

Ordinarily the extrapolation occurs without actually creating any new keyframes. This lets you experiment with different methods. However, you can convert an extrapolation method into actual keyframes so you can further manipulate them. This is done using the Generate Keyframes command. You can choose how many of the extrapolation cycles you want converted into keyframes. Cycles after the number you chose are left in the extrapolated state.

To convert extrapolation data into keyframes:
1. In the Animation menu, choose Generate Keyframes from the Before First Keyframe or After Last Keyframe submenu.
The Generate Keyframes dialog appears.

2 Choose the number of cycles you want to be keyframed.
3 Click OK to confirm your selection.

**Control Buttons**
In the Keyframe Editor, three buttons provide additional control over the Keyframe Editor window: Snapping, “Show audio waveform,” and “Fit visible curves in window.”

**Snapping:** When Snapping is enabled, keyframes snap to markers, other keyframes, and other snappable items.
“Show audio waveform”: Turns on display of the audio waveforms for the selected item in the background of the graph. This lets you line up an effect to take place at the same time as an event that occurs in the audio.

“Fit visible curves in window”: Automatically scales the graph vertically to include all of the keyframes of your active parameters.

There are times when the values of your keyframes may exceed the vertical resolution of the graph. For example, as you stretch a keyframe, you can drag it so far that you force the window to scroll.

When you click the Fit Curves button, Motion automatically rescales the graph both vertically and horizontally so that your curve is entirely visible.
The values of your keyframes are not changed.

**Auto-Scaling:** Auto-Scaling mode continuously stretches the graph to fit all of the curves currently in view.

**To turn on automatic scaling:**
- Click the “Auto-scale vertically” button at the right edge of the ruler.

When “Auto-scale vertically” is on, the range of the graph increases to accommodate your entire curve even as you change it. For example, if you drag a keyframe up to increase its value, as you drag past the top of the window, the whole graph is rescaled, rather than scrolled.

This can be disconcerting at first because it might appear that your curve refuses to get bigger even as you drag your keyframe. However, if you watch the zoom/scroll bar at the right side of the window, you can see that the graph is being zoomed vertically to make room for your wider range of values.

**Animating On the Fly**

Another powerful feature that Motion offers is the ability to create animations while your project is playing back. This is similar to how audio engineers adjust sliders for each of their different audio channels while listening to the mix. The next time it is played back, all of those changes are incorporated.

Since so many of Motion’s effects are displayed in real time, for the first time, you can perform a sort of “visual mix” and modify the various parameters of your effects while the project is playing back.
For example, it is not until you see all of the various elements in your project in concert that you can know whether each part is behaving as it should. One object may be fading too slowly and making another element hard to see, or a text element might come and go so quickly that it cannot be read. With keyframing on the fly, you can make adjustments to any slider or parameter in the program while your project is playing. You can also interactively manipulate objects in the Canvas. Then, if you don’t like what you did, rewind and do it again. Each time you alter a parameter, you replace any keyframes previously assigned.

To animate a parameter on the fly using the Inspector or the Dashboard:
1. Click the Record button (or press A) or choose Mark > Record Animation to enable record.
2. Click the Play button or press the Space bar to begin playback.
3. As your program plays back, adjust the parameter slider.
4. Disable Record.

The changes you made are recorded as keyframes for that parameter. You can view them in the Keyframe Editor.

If you don’t like the animation you made, you can delete the keyframes and try again. You can choose Edit > Undo (or press Command+Z) to revert to the state before you began recording your animation, or you can manually delete the keyframes you want to replace.

To delete keyframes, do one of the following:
- Select the keyframe, then press Delete.
- Control-click the keyframe, then choose Delete from the shortcut menu.
- Select the keyframe, then choose Delete from the Animation menu for that parameter.

Note: To delete all of the keyframes for a parameter, choose Reset Parameter from the Animation menu in the Keyframe Editor list or Inspector.
Handmade Motion in the Canvas

One of the most common uses for animating on the fly is to create handmade animation paths. Although you can choose from a variety of curve types, it is very difficult to get the semi-random movement except by sketching with your mouse or pen.

To create a handmade animation path in the Canvas:

1. Enable Record (press A).
2. Click the Play button to begin playback.
3. Select the object you want to manipulate and drag it in the pattern of your choice. Both the position and speed of your movement are recorded and applied to the position keyframes for that object.

You can further manipulate the path either by dragging individual keyframes, or re-recording a new animation path for that object.

Keyframe Thinning

Due to the way keyframing works, if the playhead is at a new frame, and you set a new value for a parameter, a keyframe is added. For animating while the project is playing, this might mean setting a new keyframe on every single frame. This doesn't create a problem until you want to make a change to the curve.
In many cases, the curve created by your animation can be represented using fewer keyframes. Often, this will provide a smoother rate of change and will enable you to take advantage of the various interpolation methods such as Ease In and Ease Out.

You can simplify your keyframes in two ways, either while you are recording them, or afterwards, by simplifying an existing channel.

**Recording Options**
The Recording Options dialog allows you to set the Keyframe Thinning setting, to record only on parameters that are already animated, or to disable recording during playback.

The Keyframe Thinning setting only applies to recording animation while playing back. This setting has no effect on ordinary keyframing.

**To set the Keyframe Thinning setting:**
1. Choose Mark > Recording Options.
   The Recording Options dialog appears.

2. Select Off, Reduced, or Peaks Only.
3. Click OK.
Off: No thinning is applied. Keyframes are applied at every frame where the parameter is changed.

Reduced: Motion eliminates keyframes that can easily be replaced with a simple curve.

Peaks Only: Only keyframes with dramatic value changes are recorded.

Disabling Animation While Playing
If you leave the Record button on, keyframes are added whenever you make adjustments. If you want to restrict keyframing to when the project is not playing, you can disable that feature individually.
To disable animation recording while playing:

1. Choose Mark > Recording Options.
   The Recording Options dialog appears.
2. Turn on “Don’t Record keyframes during playback.”
3. Click OK.

**Recording Keyframes on Animated Parameters Only**

When “Record keyframes on animated parameters only” is turned on, keyframes are added only to parameters that are already animated. For example, if the position of a shape is animated (keyframed) and “Record keyframes on animated parameters only” is enabled, only changes made to the position of that object are keyframed. If you change the color of the object over time, the color changes are not keyframed—even when the Record button is enabled.

*Important:* The Record button must be on when using the “Record keyframes on animated parameters only” option. You can still manually add keyframes, regardless of whether or not Record is enabled, by using the Animation menu in the Inspector or Keyframe Editor list, or by pressing Option+K.

**Tip:** If you are a Final Cut Pro user, it is recommended that you use this option to emulate the workflow with which you are familiar.

**To record keyframes on animated parameters only:**

1. Enable Record (or press A).
2. Choose Mark > Recording Options (or press Option+A).
3. Turn on “Record keyframes on animated parameters only.”
4. Click OK.

Keyframes are now added only when you make changes to parameters that are already animated. To observe how the “Record keyframes on animated parameters only” works, walk through the following brief exercise.

**To see the “Record keyframes on animated parameters only” in action:**

1. Enable Record (press A).
2. Choose Mark > Recording Options, and make sure “Record keyframes on animated parameters only” in the Recording Options dialog is turned off, then click OK.
3. At frame 1 (press Home), draw a shape in the Canvas and move the object into a start position.
   A position keyframe is created.
4. Advance to a different frame and move the object into another position.
   A second position keyframe is created.
5 Choose Mark > Recording Options, and turn on “Record keyframes on animated parameters only” in the Recording Options dialog, then click OK.

6 Go to a frame in between the two position keyframes, and move the shape in the Canvas.

A third position keyframe is added.

7 At frame 1 (Home), click the Fill color well in the shape’s Dashboard, then change the color of the object.

8 Advance to a different frame, then change the color object again.

9 Go to frame 1 and click the Play button (or press the Space bar).

Notice that the position of the object is animated, but the color is not. This is because the shape had position keyframes when “Record keyframes on animated parameters only” was turned on.
Using Text

Text, one of the most essential motion graphics elements and sometime savage beast, has just been taught to “behave” in Motion.

In motion graphics, type has become more than words that provide basic information. Type design has become an art form—a title sequence can set the mood of the film it introduces; a certain combination of typeface and animation style can provide instant recognition of the identity of a broadcast network, or a clever television interstitial can keep a viewer from flipping channels during a commercial break. Just look what the opening title sequence by Friz Freleng for Blake Edwards’ The Pink Panther did—from movie title to movie and television star, with a design and graphics style that holds up even today, nearly 40 years later (with the help of some very smart Henry Mancini theme music). And, who wants to be in the popcorn line when any James Bond movie begins? No one who knows what’s good for them.

Although trends in type design change, the balanced use of type and graphics remains the key to achieving the right effect on the subject of commercials, documentaries, television and film titles, broadcast identification, corporate presentations, or your own personal video projects.

Fresh, funky, classy, cheeky... No matter what style your project requires, Motion provides unique text animation tools that offer immediate results.
Using Text in Motion

Text is added to your project directly in the Canvas—select the Text tool, click in the Canvas, then start typing. Once a text object is created, you can add and edit text in the Canvas or in the Text Editor in the Format pane of the Text Inspector. Once a text object is created, you can put the text on a line or elliptical path, which can be animated.

When text is created, it becomes a text object. Like all other objects in Motion (clips, images, or shapes), text objects can be moved, rotated, scaled, and easily animated using the Basic Motion, Parameter, or Simulation behaviors (such as Throw, Randomize, or Gravity), or by setting keyframes. Text objects can also be used as image mask sources, as well as particle cell sources.

Unlike other objects in Motion, text has two of its own behavior categories: Text Animation and Text Sequence behaviors. The text behaviors create text animation by generating a range of values in the text parameters specific to titling effects. For example, drag the Text Tracking behavior onto a text object, and the text characters gracefully spread out across the Canvas over time without setting any keyframes. You can choose to work with or without keyframes using the Text Sequence or Text Animation behaviors.

Although text has its own special behaviors, you can apply any Basic Motion, Parameter, or Simulation behavior to a text object. For more information on these types of behaviors, see “Using Behaviors” on page 317.

Although behaviors are designed for more free-form graphics, they are an ideal way to interactively test different text treatments without setting keyframes. You can quickly adjust the rate of an applied behavior using the behavior’s Dashboard, while the animation updates in the Canvas. For more control, you can access all of the parameters for a behavior in the Inspector. If your project requires specific timing and positioning of the text objects, you can still use behaviors to test effects, and then create keyframes after you know what you want to do. Or (like many other behaviors), you can create keyframes from the applied text behaviors by using the Convert to Keyframes feature. This allows you to fine-tune the animation created by the text behaviors.

Using behaviors is not required to animate text, however, since you can create your text animation by using traditional keyframing, or by combining both techniques.

**Note:** Although you can apply keyframes and behaviors to a text object, some thought must be given to the effect you are trying to create since this workflow can defeat the purpose of behaviors, as well as yield unexpected results. For more information on combining behaviors and keyframes, see “Using Behaviors” on page 317.
Once you create the perfect text treatment—a customized text behavior or a text object with the perfect gradient colors and glow—you can save the behavior or the text style in the Library for use on another text object or in a future project.

Since text objects are like any other object, you can apply filters to text objects, change the stacking order of text objects within a layer, or move text to another layer. Text can also be easily duplicated or copied from one layer to another. Also like other objects, text object properties such as position, blend modes, and drop shadows can be changed and animated.

Other attributes are unique to text objects, such as face and outline and the ability to change fonts or edit the text of an existing animated text object.

The Motion Library includes ten LiveFonts that can be applied to a text object. LiveFonts are animated fonts that can add a little zing to your project.

**Note:** If you have Final Cut Pro with LiveType installed on your computer, all LiveFonts appear in the Motion Library.
Setting Object Duration Preferences
Before you start any project, it is recommended that you set up Motion Preferences according to your project requirements. When working with text, you can specify that a text object is created at the current frame (the frame where the playhead is at the time you add the text object), or at the start of the project. By default, objects are created at the current frame. You can also specify a default duration for any created object.

Note: This sets the same preferences for all objects created within Motion, including text, shapes, masks, and particle emitters.

To set the object duration preferences:
1 Choose Motion > Preferences (or press Command+,).
2 Click Project.
The Project preferences pane is displayed.
3 In the Still Images & Objects preferences group, set the Default Object Duration preference:
   • To create objects that are the length of the project, select “Use project duration” (the default setting). This means that if you are working in a 300-frame project and you create a text object, the text object is 300 frames.
   Note: If you have Create Objects At set to “Current frame,” and you create a text object at frame 50, the text object exists from frame 50 to frame 300.
   • To create objects that are a specific duration, select “Use custom duration.” Next, enter a value in the text field, then choose Frames or Seconds from the pop-up menu.
   All objects you created will be set to the entered duration by default.
4 Set the Create Objects At preference:
   • To create objects at the frame where the playhead is at the time you create a text object, select “Current frame.”
   A text object is created as soon as you click in the Canvas with the Text tool, regardless of whether you type any text.
To create objects at the start of the project, select “Start of project.” This means that all objects are created at the beginning of the project by default, regardless of where the playhead is when the object is created.

Working With Text
In Motion, you create text directly in the Canvas using the Text tool. Once text has been added to your project, you can easily apply behaviors and filters to the text objects, or animate the text using keyframes. In the Project Preferences, you can set the default duration and location (in time) for a text object.

Creating Text in Your Project
This section describes adding text to your project in the Canvas.

When “Create Objects At” is set to “Start of project” in the Project preferences, added text is created at the first frame of the project and is the duration of the project. For example, if you are working in a 900-frame project and you add a text object, the duration of the text object is 900 frames. To shorten the duration of a text object, shorten the text object in the Timeline. For more information, see “Using the Timeline” on page 273.
To add text in the Canvas:

1. In the Layers list, select the layer to which you want to add text.
   
   **Note:** If no layer is selected, a new layer is created to contain the text object.

2. In the Toolbar, click the Text tool (or press T).

3. Click in the Canvas.
   
   The cursor flashes in the Canvas at the insertion point. Before you enter any text, a “blank” text object is added to the Layers tab and Timeline Layer list, and the Text Dashboard appears.

4. Type the text you want.
   
   The text object appears in the Canvas, the Layers tab, and the Timeline. Once a text object is created, you can select the object like any other object in Motion—in the Canvas, Layers tab, or Timeline.

   **Note:** By default, the text Layout Method is set to Type. The Type layout option creates no margin, so if you enter a long string of text, it extends on a single line beyond the Canvas until you create a manual line break (press Return). This mode is useful for working with short text objects and panning text across the Canvas. For information on changing text layout and setting margins, see “Text Layout Controls” on page 514.

5. When you are done typing, press Esc, or click the Select/Transform tool.
   
   The text object is selected, and like all other selected objects in Motion, appears with a bounding box in the Canvas. The name of the text object in the Layers tab, Timeline Layer list, and Dashboard updates to reflect the entered text.
**Important:** Once you have finished typing your text, be sure to press Esc or select another tool on the Toolbar—do not use a keyboard shortcut. When the Text tool is selected, you are in text-entry mode, so if you press S to select the Select/Transform tool, an “S” is added to your text rather than the tool being changed.

**Text as an Object**

Once created, text becomes an object. Since text objects share most of the characteristics of other objects in Motion, you can use the object onscreen controls—Transform, Anchor Point, Shear, Drop Shadow, Four Corner, and Crop—to transform a selected text object. The onscreen tools are shortcuts to the object controls in the Properties tab of the Inspector. To set specific values, or fine-tune any of the transforms, use the Properties tab in the Inspector.

You can also change the blend mode and opacity of a text object in the Properties tab. Setting the Opacity value in the Properties tab and setting the Opacity value in the Style pane are separate controls that have multiplicative effects. In other words, if Opacity is set to 50 percent in the Properties tab, and then set to 50 percent in the Text Style pane, the resulting opacity for the text object is 25 percent.

For more information on the Properties tab, see “Parameters in the Properties Tab” on page 241.

**Note:** When you make changes to a text object using the onscreen controls or the parameters in the Properties tab of the Inspector, they are applied to the text as an object (such as a clip or image), not as editable text. The controls for editing the text itself are located in the Text tab of the Inspector. Although some object properties are similar to some text Style and Format controls, such as Shear (in the Properties tab) and Slant (in the Format pane of the Text tab), the object properties are independent of the text format controls, and vice versa. For example, if you apply a Slant value of 20 in the Format pane of the Text Inspector, a slant value of 20 is applied to each character in the word, simulating italics. If you apply a Shear value of 20 in the Properties tab of the Inspector (or using the onscreen controls), a shear value of 20 is applied to the object, not the individual text characters.

The next section briefly describes how to transform a text object using the onscreen controls. For detailed information on using the onscreen controls, see “Using Transforms” on page 224.

In addition to moving text objects with the transform tools, you can move text objects up and down in the composite in the Layers tab and Timeline. Just like all other objects in Motion, text objects can also be copied, pasted, duplicated, and deleted. For more information, see “Managing Objects in Your Project” on page 179.
Using the Text Dashboard

The Text Dashboard contains some of the most commonly-adjusted text parameters, such as opacity, type family, and color.

Note: If no Dashboard is present, press D to display the text object Dashboard.

Opacity: By default, the opacity of a text object is set to 100 percent. Use the slider to change the opacity value.

Note: Since a text object is like any other object in Motion, the Properties tab (and Layers tab) also contains controls to change the opacity of the text object. The Opacity controls in the Properties tab of the Inspector are independent of the controls in the Text tab. In the Text tab you have control over the opacity of all text style elements including the Face, Outline, Glow, and Drop Shadow. In the Properties tab, the Opacity control sets the transparency of the whole text object, no matter what style is applied.

Blend Mode: The blend mode of a text object is set to Normal by default. Use the Blend Mode pop-up menu to choose another mode for the selected text object.

Note: The Properties tab (and Layers tab) also contains controls to change the blend mode of the text object. When you change the blend mode of a text object in the Text Dashboard, the blend mode is also changed in the Properties tab and vice versa.
Family: By default, a text object’s font family is set to Geneva (if installed on your system). To change the font of the selected text object, choose a font from the pop-up menu.

Typeface: Choose the type style, such as Bold, Italic, and so on from the Typeface pop-up menu. The available typefaces are specific to the selected font family.

Color: A text object’s color is white by default. Click the color well to display the Colors window and choose another color for the selected text object. You can also Control-click a color well to display the pop-up color picker, then drag in the color spectrum to select a color.

Size: A text object is created at 48 points by default. To change the point size of a text object, drag the Size slider.
Note: The text Size sliders (in the Dashboard and in the Inspector) are limited to 288 points. To set the text to a larger point size, type a number in the Size field in the Format pane of the Text Inspector.

Tracking: Tracking applies a uniform value between each character. Tracking is set to 0 by default. To change the tracking value of a text object, drag the Tracking slider left (for a negative tracking value) or right (for a positive tracking value).

Note: The text Tracking sliders (in the Dashboard and in the Inspector) are limited to 100 points. To set a larger tracking value, type a number in the Tracking field in the Format pane of the Text Inspector.

Line Spacing: When working with multiple lines of text, drag the slider to change the space between lines of text. Dragging to the right (above 0) increases the line spacing and dragging to the left (below 0) creates negative line spacing.

Alignment: Text alignment is set to Left by default. To change alignment, choose Right or Center from the Alignment pop-up menu.

More Text Parameters
The complete group of the text parameters (including those in the Text Dashboard) are located in the Text tab of the Inspector.
To display the Inspector:
1. Select the text object.
2. Do one of the following:
   • Choose Window > Inspector.
   • Click the “i” button on the Dashboard.
   • Press Command+3.

The Inspector contains all text parameters divided into three tabs: Format, Style, and Paragraph. For more information, see “Editing Text in the Inspector” on page 473.

Adding Behaviors and Filters to Text Objects
Behaviors and filters are applied to text objects in the same manner as other objects in Motion. This section provides a quick start to applying behaviors and filters to text objects. For more information on using the Text Animation and Text Sequence behaviors, see “Using Text Animation and Text Sequence Behaviors” on page 524.

To apply a behavior to a text object, do one of the following:
- In the Library, select a behavior, then drag it to the text object in the Canvas, Layers tab, or Timeline.
- Select the text object to which you want to apply a behavior, click the Add Behavior icon in the Toolbar, then choose a behavior from the pop-up menu.

The text object Dashboard is replaced with the behavior Dashboard.

Note: For more information on applying text behaviors, see “Text Animation Behaviors” on page 525 and “Text Sequence Behaviors” on page 548. For more information on other behaviors, see “Using Behaviors” on page 317.

To apply a filter to a text object, do one of the following:
- In the Library, select a filter, then drag it to the text object in the Canvas, Layers tab, or Timeline.
- Select the text object to which you want to apply a filter, click the Add Filter icon in the Toolbar, then choose a filter from the pop-up menu.

Note: For more information on using filters, see “Using Filters” on page 701.
Using the Dashboards

You can display a Dashboard for any object in Motion. To display a Dashboard, select the object, then press D (or F7). The Dashboard that is displayed represents the currently selected object. The parameters contained in a Dashboard depend on the type of object selected. For example, a text object Dashboard displays text-specific parameters, such as Typeface and Line Spacing. A particle emitter Dashboard displays particle-specific controls, such as Birth Rate, Life, and Scale.

As you add effects (behaviors and filters) to an object, the displayed Dashboard changes to the most recently added effect. The Dashboard name is displayed on the top bar of the Dashboard. To cycle forward through the Dashboards of an object, press D repeatedly. To cycle in reverse, press Shift+D. The Dashboards cycle in the order in which the effects are applied.

To jump to a specific Dashboard, click the disclosure triangle next to the Dashboard name, then choose a Dashboard from the list.

About Fonts

Motion uses all supported fonts installed on your Mac OS X system. Mac OS X supported fonts include OpenType, Type1 (or PostScript), and TrueType. All supported fonts installed on your system appear in the font browser in the Library, as well as the Format pane of the Text Inspector. This includes fonts located in:

- Mac OS X disk/Library/Fonts
- Home/Library/Fonts
- Classic System Folder/Fonts

For information on installing fonts, see your system documentation. If you have Final Cut Pro with the LiveType fonts installed, you can use the LiveFonts in Motion. If you do not have Final Cut Pro installed, Motion includes ten LiveFonts. For more information on LiveFonts, see “Using LiveFonts” on page 560.

You can preview and apply the available fonts in the font browser in the Library or in the Format pane of the Text Inspector.

Using the Library Font Browser

The Motion Library includes a font browser that allows you to preview fonts or to change the font of an existing text object.

For information on previewing and changing fonts in the Text Inspector, see “Editing Text Format” on page 474.
Previewing Fonts
You can use the Fonts category in the Library to browse and preview fonts. When a typeface is selected in the Library stack, a preview of the font is displayed in the Preview area of the Library.

To preview a font in the Library:

1. In the Library, click the Fonts category.
2. Click the font subcategory you want to preview.
   
   **Note:** The first subcategory, All Fonts, contains all fonts from the other subcategories. If you are in list view, the font list appears in the stack. If you are in icon view, the font thumbnails appear in the stack. In the images on the following pages, icon view is selected.

3. In the stack, click a font thumbnail or name.
   
   The font is displayed in the Preview area, along with the font name and type.
Changing Fonts

There are two ways to use the Library font browser to change the typeface of a text object. The first method is to drag a font to a text object in the Canvas. The second method is to select a text object, select a typeface in the Library, then click the Apply button in the Preview area.

To change the typeface of a text object by dragging the font to the text:
1. In the Library, click the Fonts category and then the font subcategory.
2. In the stack, click a font.
3. Drag the font onto the text object in the Canvas.

As you drag the font over the text object, a transparent thumbnail of the font appears and the pointer includes the green add pointer (+). When you release the mouse button, the text object is changed to the selected font.

To change the typeface of a text object with the Apply button:
1. Select the text object to which you want to apply a new font.
2. In the Library, click the Fonts category and then the font subcategory.
3. In the stack, click a font.
4 In the Preview area, click Apply.

The text object is changed to the selected font.

Navigating the Font Browser Lists
To quickly locate a font by its name in the font stack, you can type the first letter of the font name in the browser. For particularly unruly font lists (admit it, you have one), you can quickly type the first few letters of the font name to select the font.

To select a font by the first letter of its name:
1 Click a font name or thumbnail in the font stack.
2 Type the first letter of the font name.
   The first font that begins with that letter is selected in the stack.

To select a font by the first few letters of its name:
1 Click a font name or thumbnail in the font stack.
2 Quickly type the first two letters of the font name.
   Note: If you do not type the second letter of the font name quickly, the selection is reset and jumps to the font whose name begins with the second letter entered.

To move through the browser fonts in alphabetical order:
- Drag the scroll bar on the right side of the browser up and down to move through the fonts.

Using the Text Tools
As previously mentioned, text becomes a text object when it is created. There are two ways to edit a text object:
- Like any other object in Motion, text can be edited using the object parameters in the Properties tab in the Inspector, or by using the onscreen controls.
- You can edit the text characters of a text object using the Text parameters in the Text tab of the Inspector or in the Dashboard.
This section discusses the tools that can be used to create and modify text objects. The following interface tools are used to edit text in Motion:

- Toolbar
- Text Dashboards
- Text Inspector

**Note:** When a text object is selected, you can use the standard onscreen controls to move and animate the text object in the Canvas.

**Text Tool and the Toolbar**

The Text tool is located in the Toolbar above the Canvas in the Create group.

**Note:** To customize the Toolbar layout, Control-click in the Toolbar area, then choose Customize Toolbar from the shortcut menu. For more information on the tools and the Toolbar, see "The Toolbar" on page 27.

**Text tool:** Use this tool to create text. Click the Text tool, then click in the Canvas and begin typing. To select characters of a text object, click the Text tool, then drag in the text object.

**Select/Transform tool:** Use this tool to select and transform a text object. Once a text object is created, click the Select/Transform tool (or press Esc) to select the text object. To select an existing text object, click the Select/Transform tool, then click the text object.

**Note:** When the Select/Transform tool is selected, you can double-click a text object to automatically enter text-editing mode.
Adding Text With the Text Tool

Text is added to a project with the Text tool.

To add text to your project, do one of the following:

- Click the Text tool (or press T), click in the Canvas, then begin typing.
- Click the Text tool, then drag in the Canvas to draw a custom margin. Once the margin is drawn, release the mouse button and begin typing.

Once a margin is created and text is entered, you can adjust the size of the margin without affecting the scale of the text.

To adjust margin size without scaling the text, do one of the following:

- With the Text tool selected, drag one of the control points on the text bounding box.
In the Text Inspector, click the Layout pane and adjust the Left, Right, Top, or Bottom Margin values.

To select text characters of a text object, do one of the following:
- Select the Text tool, then drag the text you want to select.
- Click in between two characters, press **Shift**, then press the **Right Arrow** key to add characters to the right of the insertion point to the selection, or press the **Left Arrow** to add characters to the left of the insertion point to the selection.
- Select the Select/Transform tool, then double-click in the text box.

**Adding Text With the Text Editor**

Once you have added a blank text object to your project (click the Text tool in the Canvas), you can enter and edit text in the Text Editor rather than the Canvas. The Text Editor is useful when working with large amounts of text.

To enter text in the Text Editor:
1. Click the Text tool (or press **T**), then click in the Canvas to create a blank text object.
2. In the Text Inspector, click the Format pane.
3 Click in the Text Editor and begin typing.

Note: Since the default text Layout Method is set to Type, when text is entered in the Text Editor, there are no set margins, and the text continues in one line unless you manually enter a line break. For more information on text layout, see “Editing Text Layout” on page 513.

You can also edit existing text objects in the Text Editor, including using the Mac OS X spelling feature.

**To edit existing text using the Text Editor:**

1 Select the text object to be edited.
   The selected text appears in the Text Editor.

2 Make your changes in the Text Editor.
   Changes are immediately reflected in the Canvas.
To use the spelling feature in the Text Editor, do one of the following:

- Click in the Text Editor, then choose an option from the Edit > Spelling submenu.
- Control-click in the Text Editor, then choose a command from the pop-up menu.

Note: The spelling feature is not available when working with text in the Canvas.

Editing Text in the Inspector

All text controls are located in the Text tab of the Inspector. The Text tab is divided into three panes: Format, Style, and Layout. The Format pane contains text basics, such as font, size, and tracking. Text characteristics such as face, outline, and blur are controlled in the Style pane. The Layout pane contains text layout controls, such as margins and justification.

As with all object parameters in Motion, if the parameter can be animated, the Animation menu icon (–) appears next to the parameter in the Inspector.

To reset a parameter to its default settings (including removing keyframes), click the Animation menu, then choose Reset Parameter.

Chapter 7   Using Text
To reset a group of parameters, such as the text Face controls or the Sequence controls of a text behavior, click the Reset button in the Inspector. To reset a single parameter within a group, click the Animation menu, then choose Reset Parameter.

Editing Text Format
The Text Format pane contains the controls for text basics such as font, typeface, size, kerning, and character rotation. Many of the Format parameters can be animated (keyframed).

To show the Text Format pane:
- In the Inspector, click the Text tab, then click the Format button.
Text Format Controls
This section describes the text Format parameters. Of the following Format parameters, Family, Typeface, Size, and Tracking also appear in the Text Dashboard.

Font Type: This parameter provides two methods for font filtering and selection:
• Make a choice from the pop-up menu (set to System Fonts by default) to filter which fonts appear in the Collection and Family lists (see below). You can choose to show System Fonts or LiveFonts (LiveType).
• Click Browse to display the Mac OS X Font panel.

Collections: Displays the available font collections based on what is selected in the Font Type parameter.

Family: Sets the font (the set of characters, letters, and symbols of a single typeface) for the text objects.

To preview different fonts for a text object in the Canvas:
1 Select the text object.
2 In the Text Format pane, click the Family list arrow.
The font family list appears.

3 Drag the pointer in the font list, and scrub up or down to select your font.

As you drag through the font family list, the text changes in the Canvas to the currently selected font.

4 Once you have chosen a font, release the mouse button.

   **Note:** You can also use the scroll bar to move up and down the font list, or the wheel of a three-button mouse.

   **Typeface:** Sets the type style, such as Bold, Condensed, and so on. The available typefaces are specific to the selected font family.

   **Size:** Determines the size of the text. You can enter a value in the value field or use the slider. To change the font size, drag the Size slider left or right. The value of the Size in the Dashboard and the Inspector is limited to 288 points. To create larger text, type a value in the Size value field.

   **Note:** You can also scale the text in the Canvas using the onscreen controls, but this scales the text as an object and is independent of setting type point size in the Format controls.
Tracking: Determines the spacing between the characters of a text object. Tracking applies a uniform value between each character.

Kerning: Adjusts the spacing between individual characters of a text object.

To kern the individual characters in a text object:
1 Click the Text tool (or press T).
2 In the Canvas, position the insertion point (click the mouse button) in between the characters you want to kern, and do one of the following:
   • Use the Kerning slider or value field to set a specific kerning value.
   • Press Control+Right Arrow to increase the space between the characters by one-pixel increments.
   • Press Control+Left Arrow to reduce the space between the characters by one-pixel increments.

To move the insertion point within a text object:
   • Use the Right Arrow and Left Arrow keys to move the insertion point between adjacent characters.
   • To jump to the beginning of a text line, press Command+Left Arrow.
   • To jump to the end of a text line, press Command+Right Arrow.
   • To jump to the beginning of the word, press Option+Left Arrow.
   • To jump to the end of the word, press Option+Right Arrow.
   • To move the insertion point through multiple lines of text (of a single text object), use the Up Arrow and Down Arrow keys.

Baseline: Adjusts the baseline of text characters. The baseline is a horizontal “line” to which the bottom of the characters is aligned.
Slant: Simulates italics by adding a slant value to the characters of a text object.

Scale: Scales the characters of the text object either proportionately in X or in Y. To scale in only X or Y, click the disclosure triangle to enter separate X and Y scale values. In the following image, the text object’s X Scale is set to 50 percent, and the Y Scale is set to 100 percent.

Offset: Offsets the text from its original position (anchor point). Enter a value in the left value slider to offset the text object in X; enter a value in the right value slider to offset the text object in Y. Click the disclosure triangle to view the X and Y position values.

Rotate: Rotates each text character around its base. Drag the dial or enter a value in the value slider to rotate the text characters.

Monospace: When enabled, applies a fixed amount of space between each text character.

All Caps: Sets all text characters to uppercase.

All Caps Size: When All Caps is enabled, sets the size of the uppercase characters based on a percentage of the font point size.

Editing Text Style
Use the Text Style pane to specify the fill of a text object and to adjust its opacity and softness. A text object can be a solid color, an image, or a color gradient. You can also apply outlines and glows, and apply drop shadows to text objects in the Style pane. Most of the style parameters can be animated.

A set of premade text styles is available in the Motion Library. Text styles are modified Style parameters that create a specific “look” for a text object, such as a red glow and gradient, and are applied to text objects like behaviors and filters. You can create custom text styles and save the styles in the Library. For more information, see “Using and Creating Text Styles” on page 509.

To show the Text Style pane:
- In the Inspector, click the Text tab, then click Style.

There are four main groups of controls in the Style pane: Face, Outline, Glow, and Drop Shadow. You can enable or disable all of the styles on a single text object. By default, Outline, Glow, and Drop Shadow are disabled.
Text Face Controls
Use the text Face controls to specify whether the text is a solid color, a color gradient, or a texture. The following section describes the Face parameters. Nearly all of the Face parameters can be animated.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style Preset</td>
<td><img src="image.jpg" alt="Image" /></td>
</tr>
<tr>
<td>Face</td>
<td><img src="image.jpg" alt="Image" /></td>
</tr>
<tr>
<td>Fill with</td>
<td>Color</td>
</tr>
<tr>
<td>Color</td>
<td><img src="image.jpg" alt="Image" /></td>
</tr>
<tr>
<td>Opacity</td>
<td><img src="image.jpg" alt="Image" /></td>
</tr>
<tr>
<td>Blur</td>
<td><img src="image.jpg" alt="Image" /></td>
</tr>
</tbody>
</table>

**Face:** Enables and disables the face (fill) of the text object. Face is enabled by default.

**Fill with:** Click the "Fill with" pop-up menu to set the fill for the text object to Color, Gradient, or Texture.

**Color:** Click the color well to select a color for the text object. Click the Color disclosure triangle to adjust the individual Red, Green, and Blue color channels for the text object.

**Opacity:** Sets the opacity of the text object, regardless of the selected fill option (Color, Gradient, or Texture).

**Blur:** Sets the softness of the text object, regardless of the selected fill option.

Changing the Text Color
You can change the color of a text object using the Colors window, the color well in the text object Dashboard, or the color well in the Style pane in the Text Inspector.

**Note:** To adjust the individual color channels, you must use the Text Inspector.

To set the text color in the Dashboard:
1. Select the text object.
2. If the Dashboard is not displayed, press D.
3 Click the color well, then use the Colors window to set the text color.

![Color picker and Color well](image)

The text object is dynamically updated as you select your color.

*Note:* To select a color from the Canvas (or anything on the desktop), click the color picker in the Colors window, position the picker over the color you want to select, then click. The Colors window is the Mac OS X Colors window.

**To set the text object color in the Inspector:**

1. Select the text object.
2. In the Inspector (press `Command+3`), click the Text tab.
3. Click Style.
4. In the “Fill with” pop-up menu, ensure Color is selected.
5. Click the color well, then use the Colors window to set the text color.
You can also **Control**-click a color well and drag in the pop-up color palette to select a color.

To adjust the individual color channels:
1. In the Inspector, click the Color disclosure triangle to show the channel parameters.
2. Use the sliders or value sliders to adjust the value of each color channel.

*Note:* The text object colors can be animated.

**Applying a Gradient to a Text Object**
In the Inspector, you can apply a gradient fill to a text object. The gradient can be customized and animated using the Gradient Editor.
**Note:** The gradient controls for a text object are nearly equivalent to the gradient controls for shapes and particles, with a few parameter exceptions. For example, the text gradient controls include a dial to specify the direction of a linear gradient. The shape gradient controls include a start and end setting to specify the direction of a linear gradient. For more information on working with gradients and shapes, see "Using Shapes and Masks" on page 819.

In addition to applying a preset text style from the Library, preset gradients from the Library can also be applied to a text object. The gradient presets are located in the Gradients category of the Library. A gradient that you apply to a text object can also be saved in the Library for use in your current or future projects.

**To apply a text object gradient:**

1. Select the text object.
2. In the Inspector (press **Command**+3), click the Text tab.
3. Click Style.
4. Click the “Fill with” pop-up menu, then choose Gradient.

In the Inspector, the Color controls are replaced with the gradient color. The default gradient is red and blue.

In the Canvas, the default gradient is applied to the selected text object.
Applying a Preset Gradient to a Text Object

There are two ways to apply a preset (or saved) gradient from the Library to a text object. The first method is by using the Gradient Preset pop-up menu in the Text Inspector. The second method is to drag a gradient from the Library to a text object.

To apply a preset gradient in the Text Inspector:

1. Make sure a gradient is applied to the text object to which you want to apply a preset gradient.
2. Choose a preset from the Gradient Preset pop-up menu.

The selected gradient is applied to the text object.
To apply a preset gradient from the Library:

1. In the Library, click the Gradients category.
2. In the stack, select a gradient.
   A preview of the selected gradient appears in the Preview area.

3. Do one of the following:
   - Drag the gradient to the text object in the Canvas, Layers tab, or Timeline.
   - Make sure the text object is selected, then click Apply in the Preview area.

Once the default gradient or a preset gradient is applied to a text object, the preset can be edited with the Gradient Editor.
Using the Gradient Editor

Use the Gradient Editor to change the color, color position, number of colors, opacity, and direction of a gradient. The color and opacity of a gradient can be animated.

**Important:** The following sections assume that a text object is selected, and Gradient is chosen from the “Fill with” pop-up menu in the Face parameter group.

In the Gradient Editor, you can add and remove colors, as well as change the position and spread of those colors.

To change gradient colors:

1. Click the Gradient disclosure triangle to show the Gradient Editor.

2. To change the color of a gradient tag, do one of the following:
   - Double-click a gradient color tag.
   - Click a gradient color tag.

The Colors window appears. Use the Colors window to set a new color for the tag.

- Click a gradient color tag.
The color controls for the selected color tag are enabled. In the Color controls, you can either click the color well to show the Colors window, or use the individual color channel controls to set a new color for the tag.

![Color controls](image)

Red gradient color tag is selected

**Note:** Like the color wells, you can Control-click a gradient color tag and drag in the pop-up color palette to select a color.

**To move the position of a color tag:**

1. Click the color tag you want to move.
2. Do one of the following:
   - Drag the color tag left or right.
   - In the Location parameter, use the slider or value slider to enter a specific value. A value of 100 percent is the rightmost position of the gradient, and a value of 0 percent is the leftmost position of the gradient.
To change the spread of a gradient color:
- Drag the small triangle between the color tags to change the location of the spread. The closer the triangle is to a color tag, the sharper the spread between the gradient colors.

The Location parameter is also updated as you move the spread control, indicating its position on the gradient.

To add a color to a gradient:
- Position the pointer in the lower color bar where you want to add the new color, then click.

A new color tag is added to the gradient.

Note: Although the colors and opacity of a gradient can be animated, the number of color and opacity tags cannot.

To remove a color from the gradient:
- Drag the color tag away from the gradient bar.

The color tag is removed, with a “poof.”

Working with gradient opacity
In much the same way as editing gradient colors, you can modify the opacity of a gradient in the Gradient Editor. By default, the opacity of a gradient applied to a text object is 100 percent.

To add an opacity tag:
- Position the pointer in the opacity bar where you want to add the new tag, then click.
A new opacity tag is added to the gradient.

Until the value is adjusted, the gradient opacity is 100 percent.

To change the opacity of a gradient color:
1. In the opacity bar of the Gradient Editor, click an opacity tag.
   The Opacity controls are enabled.

2. Use the slider or value slider to change the value of the opacity.
   The lower the percentage of the opacity, the greater the transparency. The gradient opacity is applied to the area of a gradient, not to a specific color tag.

   The gradient transparency reflects the new opacity values. In the following image, Opacity is set to 0 percent at the right side of the gradient (the light pink color), so the color fades out.

The controls to move, change the spread, or remove an opacity tag are the same as those of the color tags.
Editing color and opacity direction and distribution
You can quickly reverse the direction or evenly distribute the gradient color and opacity tags.

To reverse the gradient color or opacity direction:
- Click the Reverse Tags icon next to the opacity or lower gradient bars.

Once the color Reverse Tags icon is clicked, the color tags are reversed.

To evenly distribute the gradient color or opacity tags:
- Click the Distribute Tags icon next to the opacity or lower gradient bars.

Saving gradient presets
Like text styles, once you have created a gradient, you can save it in the Library.

For more information on the Library text styles, see “Using and Creating Text Styles” on page 509.

To save a gradient in the Library:
1. Select the text object with the gradient you want to save.
2. Choose Save Gradient from the Gradient Preset pop-up menu.
3 In the Save Preset To Library dialog, type the name of the gradient.

![Save Preset To Library dialog]

4 Click Save.

The custom gradient appears in the Gradients category in the Library. Custom presets can be identified in the Library by the small user icon that appears in the lower-right corner of the larger gradient icon. The new gradient also appears in the Gradient Preset pop-up menu.
Like the preset gradients, a preview of the gradient appears in the Preview area when the gradient is selected in the stack.

Applying Parameter Behaviors to Gradients
To create unique gradient effects, you can apply Parameter behaviors to gradient parameters such as Opacity, Location, Start and End points, and Color. This is accomplished in the same manner as applying a Parameter behavior to any other parameter in Motion.

In the following example, a Randomize behavior is applied to the RGB color parameter of one color in a three-color gradient.

To apply a Randomize parameter behavior to a gradient color:
1. In the Inspector, select a color tag in the Gradient Editor.
2. If the Color parameters are not displayed, click the Color disclosure triangle.
3. Select a color channel such as Red (it turns a darker gray when selected), Control-click the parameter, then choose Randomize from the shortcut menu.

The Randomize parameter is applied to the color tag. Next, you must assign the color channel(s) you want to be affected by the behavior.

4. In the Randomize Dashboard or Inspector, choose an option from the Apply To pop-up menu. In this example, choose Styles > Style > Face > Gradient > RGB > RGB2 (for the second color tag in the gradient) > Color > All.

Note: If you were using a shape, you would choose Object > Fill > Gradient > RGB > RGB2 (for the second color tag) > Color > All.

An RGB item appears for every color tag in the gradient, as does an Alpha item for each opacity tag. Because the gradient in this example has three colors, three RGB items appear (RGB1, RGB2, and RGB3). The items are numbered from left to right—RGB1 is the leftmost gradient color; RGB2 is the middle color; and RGB3 is the rightmost color.

The Offset and Middle parameters also appear in the pop-up menu above the Color item. Offset represents the location of the color in the gradient (the Location parameter), and Middle represents the spread of the color between two tags (the small triangle control between the gradient color tags).
**Note:** The Parameter behavior can be applied to any parameter that appears in the Apply To pop-up menu.

5 Click the Play button (or press the Space bar).

6 In the Randomize parameters, do the following:
   - Increase the Amount slider to approximately .5.
   - Decrease the Frequency to approximately 5 so the color changes occur less often.
   - Set Noise to 0 so the color changes are smoother.

When the color tag with the applied Parameter behavior is selected in the Inspector, the Behaviors icon appears next to the color channel parameters. If the Randomize behavior were only applied to the Red channel, the Behaviors icon would only appear next to the Red parameter.

**Using a Texture Fill**
You can use an object—an image, movie, shape, or layer—as the fill for a text object with the Texture option in the Face controls of the Inspector.

The texture parameters respect any filters applied to the source image, but not any transforms applied to the image. For example, if the image used as the source texture has a glow filter applied, the result of the glow filter appears in the texture applied to the text object. If the image used as the source texture has been scaled, moved, or contains applied behaviors, the result of the transforms does not appear in the applied texture.

**To apply a texture to a text object:**
1 Select the text object.
2 In the Inspector (press Command+3), click the Text tab.
3 Click Style.
4 Click the “Fill with” pop-up menu, then choose Texture.

Chapter 7  Using Text
The Color controls are replaced with the Texture controls.

5 Click the Texture disclosure triangle.

![Image well]

By default, no texture is applied to the text object.

6 In the Layers or Media tab (of the Project pane), drag the image you want to use for the texture to the Image well.

![Image well]

The image appears in the well and is applied to the text object.

**Important:** When selecting an image to put into the Image well, be sure to click and drag in one movement. If you click the image and release the mouse button, the image is selected and its Inspector appears. This also applies to the Image well for masks.
To replace a texture:
1. Select the text object and display the expanded Texture controls.
2. In the Layers or Media tab, drag the image you want to use to replace the existing texture to the Image well.

The new image appears in the well and is applied to the text object.

Note: When footage is replaced in the Layers tab or Media tab, and that footage is used as a texture source, the texture is replaced for the text object with the new footage.

To remove a texture, do one of the following:
- Click the Texture parameter Reset button.
- Drag the image out of the well, then release the mouse button. Poof!
Editing a Texture

If you are using an image sequence or movie as the texture source of a text object, you can specify the start frame for the texture, or choose to hold a single frame for the texture. You can also adjust the position of a texture that is applied to a text object so that it is offset in the text object, but not repositioned in your project. If an image used as a texture is cut off in a text object, you can specify the edge behavior of the texture.

Frame: When using a movie or an image sequence as the texture source, use the slider or value sliders to specify the start frame for the texture.

Hold Frame: When using a movie or an image sequence as the texture source, turn on Hold Frame to freeze the frame specified in the Frame parameter. The selected frame is used as the texture for the text object’s total duration.

Offset: Drag or enter a number in the Offset value sliders to specify the X and Y values of the position of the source texture (relative to the text object).

To change the position of a texture:

- In the Texture controls, do one of the following:
  - Press Command, then drag in the Image well.
    The image moves in the well and is offset in the text object in the Canvas.
  - Adjust the Offset values. The left value slider represents the X position values; the right value slider represents the Y position values. Click the disclosure triangle to display the labeled X and Y value sliders.

Wrap Mode: Use the Wrap Mode pop-up menu to specify how the edge of a texture is treated when the texture is offset and appears cut off in the text object or is too small to fill the text object to which it is applied.

- None: As the default wrap mode, the texture remains transparent beyond the edge of the source image.
- Repeat: Similar to tiling behavior, the texture source is repeated beyond the edge of the source image.
• **Mirror**: Beyond the edge of the source image, the texture source is reflected like in a mirror—duplicated, tiled, and alternately reversed to encompass the full width and height of the text object.

**Animating a Texture**
You can set keyframes for the offset values of the texture source to create a moving element within your text object. In the following example, an image of a leopard lying in the grass is used as the texture source for the text “leopard.”

![Original text object prior to texture](image1) ![Image used as texture source](image2)

**To animate the texture offset:**
1. Apply a texture to the text object.
   For instructions on how to apply a texture to a text object, see “Using a Texture Fill” on page 492.
2. Go to the frame where you want the texture animation to begin.
3. Enable Record (press A).

![Record button](image3)

**Note:** Keep in mind that when Record is enabled, a keyframe is created for any change you make to an object in your project.
4. To position the texture, do one of the following:
• Press Command, then drag in the Image well.

• Use the Offset sliders or value sliders to enter an offset value.

The image within the text moves, and a keyframe is created in the Offset parameters.

5 Go to the next frame where you want to set a keyframe.
6 Move the texture to the new position.

![Repositioned text object texture](image)

7 Go to frame 1 (or the start frame of your animation) and play the clip. The texture offset is animated.

8 Disable Record.

**Note:** You can also use the Animation menu in the Inspector to manually set keyframes without enabling Record. For more information, see "Keyframes and Curves" on page 401.
Applying a Texture to Text Characters vs. Applying a Texture to a Text Object

When you apply an image (or object) as the texture for a text object, the texture is applied to each character in the text object. To use the image as a continual texture throughout a text object, use the text as a mask.

Using an Object With Behaviors and Filters as a Texture Source

You can use an object (image, movie, image sequence, shape, or layer) that has applied behaviors and filters as the texture source for a text object. If the object has active filters, the result of the filters is respected in the texture source. In other words, you can see the result of the filters in the texture. If the object has active behaviors or transforms, the behaviors and transforms are ignored—only the image appears as the texture. Use the following guidelines when using objects as texture sources.

When using an object with an applied filter as a texture source:

• To use the object with the effect of the filter, use the steps in “Using a Texture Fill” on page 492.
• If the object is an image or image sequence, you can use the object without the effect of the filters by dragging the image from the Media tab to the Texture Image well, rather than from the Layers tab.
• To use an object without the effect of the applied filter, make a copy of the object in the Layers tab, remove the filters from the object, then turn the object off. You can then drag the object from the Layers tab to the Image well.

When using an object with an applied behavior or active transforms (for example, rotate) as a texture source:

• Use the steps in “Using a Texture Fill” on page 492. The effects of the behavior or transforms are ignored.

Applying a Texture to Text Characters vs. Applying a Texture to a Text Object

When you apply an image (or object) as the texture for a text object, the texture is applied to each character in the text object. To use the image as a continual texture throughout a text object, use the text as a mask.
To use a text object to mask an image:

1. In the Layers tab or Canvas, select the object or layer you want to use as the texture.

2. Choose Object > Add Image Mask (or press Shift+Command+M).
   A blank image mask object is added to the image.

3. Drag the text object that you want to use as a mask to one of the following:
• The Mask Source well in the Image Mask Dashboard

![Image Mask Dashboard](image)

• The Image Mask object in the Layers tab (drop the text object on the Image Mask object in the Layers tab)
• The Image well in the Image Mask tab of the Inspector

The text object masks the image.

For more information, see “Using Shapes and Masks” on page 819.

**Changing Text Opacity**

Use the Opacity slider or value field in the Dashboard or in the Inspector to adjust the opacity of a text object.

**To set the text object opacity in the Dashboard:**

1. Select the text object.
2. Press D to display the Dashboard.
   - The Opacity controls are located at the top of the Dashboard.
3. Drag the Opacity slider.
The text object opacity is dynamically updated as you drag the slider.

To set the opacity in the Inspector:

1. Select the text object.
2. In the Inspector (press Command+3), click the Text tab.
3. Click Style.
4. In the Face controls, drag the Opacity slider or enter an opacity value in the field.

Note: Because a text object is like other objects in Motion, you can also adjust its opacity in the Properties tab. Setting the Opacity value in the Properties tab and setting the Opacity value in the Style pane are separate controls that have multiplicative effects. In other words, if Opacity is set to 50 percent in the Properties tab, then set to 50 percent in the Text Style pane, the result opacity for the text object is 25 percent.
Changing Text Softness

Use the Blur parameter in the Style pane of the Text Inspector to adjust the softness of the text object.

To adjust the softness in the Inspector:
1. Select the text object.
2. In the Inspector (press Command+3), click the Text tab.
3. Click Style.
4. In the Face controls, drag the Blur slider, or enter a blur amount in the value slider.

The text object softness is dynamically updated as you drag the slider.

Text Outline Controls

Use the Outline controls in the Style pane to create text object outlines. You can change the fill of the outline, as well as its opacity, softness, width, and layer order. With the exception of Layer Order, all of the Outline parameters can be animated.

Outline: Enables and disables the outline of the text object. Outline is disabled by default.

Fill with: Make a choice from the “Fill with” pop-up menu to set the fill for the outline. As with the Face controls, you can set the outline fill to Color, Gradient, or Texture.

Color: Click the color well to select a color for the outline. Click the Color disclosure triangle to adjust the individual Red, Green, and Blue color channels.

Opacity: Sets the opacity of the text outline.

Blur: Sets the softness of the text outline.
**Width:** Sets the thickness of the outline.

**Layer Order:** Specifies whether the outline is drawn over or under the text object face.

### Adding a Text Outline
To create a text outline, turn on Outline in the Style pane of the Text Inspector.

#### To create an outline for a text object:
1. Select the text object.
2. In the Inspector (press `Command+3`), click the Text tab.
3. Click Style.
4. In the Outline controls, turn on Outline.
   
   The default outline color is red, with a width of one point.

**Note:** You can display the outline only of a text object by turning off the Face parameters.

### Editing Text Object Outlines
Use the Outline controls to soften the opacity or blur of a text outline, change the width of an outline, or to set and edit the fill of an outline.

#### To change the color of a text outline:
- Click the color well, then select a color from the Colors window.

#### To adjust the opacity of a text outline:
- Use the Opacity slider or value field to change the opacity of the outline.

#### To adjust the blur of a text outline:
- Use the Blur slider or value slider to change the blur of the outline.

#### To change the width of a text outline:
- Use the Width slider or value slider to change the width of the outline.
To set the layer order of a text outline:

- Make a choice from the Layer Order pop-up menu.
  - Choose Under Face to place the outline behind the text face.
  - Choose Over Face to place the outline in front of the text face.

**Note:** The Outline fill controls—Color, Gradient, and Texture—are equivalent to the controls for the Face parameters. For information on using these controls, see “Text Face Controls” on page 479.

**Text Glow Controls**

Use the Glow controls to create a glow in front of or behind a text object. With the exception of Layer Order, all of the Glow parameters can be animated.

- **Glow:** Enables and disables the glow of a text object. Glow is disabled by default.
- **Fill with:** Make a choice from the “Fill with” pop-up menu to set the fill for the glow. As with the Face and Outline controls, you can set the glow fill to Color, Gradient, or Texture.
- **Color:** Click the color well to select a color for the glow. Click the Color disclosure triangle to adjust the individual Red, Green, and Blue color channels.
- **Opacity:** Sets the opacity of the text glow.
- **Blur:** Sets the softness of the text glow.
- **Radius:** Sets the circumference of the glow.
- **Scale:** Sets the size of the glow.
- **Offset:** Offsets the glow in the X or Y position.
- **Layer Order:** Specifies whether the glow is drawn over or under the text object face.
Adding a Text Glow
To create a text glow, enable the Glow parameter in the Style pane of the Text Inspector.

To create a glow for a text object:
1 Select the text object.
2 In the Inspector (press Command+3), then click the Text tab.
3 Click Style.
4 Turn on Glow.

The default glow is yellow, with Scale and Opacity set to 100 percent, and a Radius set to 1.

Note: You can display just the glow of a text object by turning off the Face (and any other active) parameters.

Editing Text Object Glow
Use the Glow controls to soften the opacity or blur of the text glow, change the size of the glow, or to set and edit the fill of a glow.

To change the color of the glow:
- Click the color well and select a color from the Colors window.

To adjust the opacity of the glow:
- Use the Opacity slider or value slider to change the opacity of the glow.

To adjust the blur of the glow:
- Use the Blur slider or value slider to change the softness of the glow.

To adjust the radius of the glow:
- Use the Radius slider or value slider to adjust the radius of the glow.

To adjust the scale of the glow:
- Use the Scale slider or value slider to proportionally scale the glow. To scale in X or Y individually, click the Scale disclosure triangle.
To adjust the position of the glow:
- Use the Offset value sliders to change the position of the glow. The left value slider is X, and the right value slider is Y. To display the individual X or Y offset fields, click the Offset disclosure triangle.

To set the layer order of the glow:
- Make a choice from the Layer Order pop-up menu.
  - Choose Under Face to place the glow behind the text face.
  - Choose Over Face to place the glow in front of the text face.

Note: The Glow fill controls—Color, Gradient, and Texture—are equivalent to the controls for the Face parameters. For information on using these controls, see “Text Face Controls” on page 479.

Creating a Drop Shadow
Use the Drop Shadow controls to create a drop shadow on a text object, and to adjust its color, opacity, offset from the text object, softness, and angle. All of the Drop Shadow parameters can be animated.

Drop Shadow: Enables and disables the drop shadow. Drop Shadow is disabled by default.

Fill with: Make a choice from the “Fill with” pop-up menu to set the fill for the shadow. As with the Face, Outline, and Glow controls, you can set the shadow fill to Color, Gradient, or Texture.

Color: Click the color well to select a color for the shadow. Click the Color disclosure triangle to adjust the individual Red, Green, and Blue color channels.

Opacity: Sets the opacity of the text shadow.

Blur: Sets the softness of the text shadow.

Scale: Sets the size of the shadow.

Distance: Specifies the offset of the shadow from the text object.

Angle: Sets the angle (or direction) of the drop shadow.
Adding a Drop Shadow
To create a text drop shadow, enable the Drop Shadow parameter in the Style pane of the Text Inspector.

To add a drop shadow:
1. Select the text object.
2. In the Inspector (press Command+3), click the Text tab.
3. Click Style.
4. In the Drop Shadow parameters, turn on Drop Shadow.
   The default black drop shadow is applied to the text object.

Adjusting the Drop Shadow Parameters
Use the Drop Shadow controls to change the color or opacity of the shadow and to adjust the softness of the shadow. You can also change the distance the shadow is offset from the text object, and adjust its angle.

To adjust the color of the drop shadow:
- Click the color well and use the Colors window to set a new color.

To adjust the opacity of the drop shadow:
- In the Opacity parameter, drag the slider or use the value slider.

To adjust the softness of the drop shadow:
- Use the Blur slider or value slider to change the softness of the shadow.

To change the scale of the drop shadow:
- Use the Scale slider or value slider to proportionally scale the drop shadow. To scale in X or Y individually, click the Scale disclosure triangle.

To change the distance of the shadow from the text object:
- In the Distance parameter, drag the slider or use the value slider. The distance the shadow is offset is represented in pixels.
To change the angle of the shadow from the text object:

- Drag the Angle dial in a circular motion or use the value slider.

Note: The Shadow fill controls—Color, Gradient, and Texture—are equivalent to the controls for the Face parameters.

Using and Creating Text Styles

The Motion Library contains a set of preset text styles that you can easily apply to text objects in your project. A text style is a group of Style parameters that have been modified and saved in the Library. For example, the Tropical Waters text style includes a gradient fill of the colors of a tropical lagoon and a sheer blue-colored glow that is set over the text face, scaled down, and offset.

You can also customize and save your own text style or format (or both) in the Library as your own text style.

Applying a Text Style

There are two ways to apply a text style to a text object. The first method is to select a style in the Library. The advantage of using the Library to apply a text style is that you can preview the style before it is applied to a text object. The second method is to apply the style in the Text Inspector using the Style Preset pop-up menu. This section discusses both methods.
To apply a text style from the Library:

1. In the Library (press Command+2), select the Text Styles category.
2. Select a style from the stack.

A preview of the style is displayed in the Preview area.

3. Do one of the following:
   - Select the text object to which you want to apply the style, then click the Apply button in the Preview area.
   - Drag the style from the stack to the text object in the Canvas, Layers tab, or Timeline.
The text style is applied to the text object.

To apply a text style from the Text Inspector:
1 Select the text object to which you want to apply a style.
2 In the Style pane of the Text Inspector, click the Style Preset pop-up menu, then choose a style.

The text style is applied to the text object.
Saving a Custom Text Style
Once you have modified parameters in the Style pane (such as Gradient or Glow) or Format pane (such as Tracking or Slant), you can save the style that you have created to the Text Styles category in the Library. These custom styles can then be used and applied just like the preset styles.

Note: Any custom presets that you save to the Library are stored in /Home/Library/Application Support/Motion/Library/Text Styles. The Motion Library is in two places on your computer: The read-only content that is installed with Motion is in the /Users/Shared/Motion folder (unless you selected a custom location when you installed Motion), and all custom content that you create is saved in /Home/Library/Application Support/Motion/Library/<item category>.

To save a modified text style to the Library:
1. Select the text object with the modified parameters you want to save as a style.
2. In the Style pane, click the Style Preset pop-up menu, then choose one of the following:
   • To save a style with only the Style pane parameters, choose Save Style.
   • To save a style with only the Format pane parameters, choose Save Format.
   • To save a style with parameters from both the Style and Format panes, choose Save All.
3. In the Save Preset To Library dialog, type the name of your preset.
4. Click Save.
The custom preset is saved to the Text Styles category in the Library. Custom presets can be identified in the Library by the small user icon that appears in the lower-right corner of the larger text style icon.

**Editing Text Layout**

The Text Layout pane contains controls for type layout, such as setting margins, alignment, justification, and line spacing. You can also create a “typewriter” effect using the Type On parameter in the Layout pane.
To show the Text Layout pane:

- In the Inspector, click the Text tab, then click Layout.

### Text Layout Controls

Use the Text Layout controls to specify general “layout” of your text. These controls allow you to make text flow in a single line, in a paragraph with set margins, or on a path.

**Layout Method:** Specifies whether the text layout is set to Type, Paragraph, or Path. The default Layout Method is Type, which creates a single line of text.

**Alignment:** Sets the alignment of the lines of text. The alignment choices are Left, Center, and Right.

**Justification:** Sets the justification of the lines of text. The justification choices are None, Partial, and Full.

**Line Spacing:** Specifies the distance between each line of text (leading) in point-sized increments. Dragging to the right (above 0) increases the line spacing and dragging to the left (below 0) creates negative line spacing.
**Type On:** This group of controls allows you to create a type on effect, similar to a typewriter. You can keyframe the type on effect to occur forward, backward, or move in both directions.

**Note:** There is also a Text Animation behavior called Type On which creates a forward type on effect without setting any keyframes.

**Creating a Type On Effect**
There are two ways to create a type on text effect: Use the Type On parameters in the Text Layout controls, or apply the Type On behavior (in the Text Animation behavior category). This section discusses using the Type On parameters in the Layout pane. For information on the Type On text behavior, see “Type On” on page 546.

**Type On Controls**
Use the Type On parameters to specify the direction, start and end points, and fade-in control for the type on effect. These parameters must be animated to see the desired effect.

**Start:** Sets the start point of the type on (from the left side) of the text object. When set to the default 0 percent, the text object is fully “typed on.” When set to 100 percent, the text object is fully “typed off.” If the value animates from 0 to 100 over time, the text types off from left to right. If the value animates from 100 to 0, the text types on from right to left.

**End:** Sets the end point of the type on (from the right side) of the text object. When set to the default 100 percent, the text object is fully “typed on.” When set to 0 percent, the text object is fully “typed off.” If the value animates from 100 to 0 over time, the text types off from right to left. If the value animates from 0 to 100, the text types on from left to right.

**Fade In:** When turned on, fades the text characters on or off. When turned off, the text characters pop on as they appear.
Example: Creating a Type On Effect
In this example, a text object is set to type on from right to left.

To create a type on effect:
1 Select the text object.

2 Go to the frame where you want the animation to begin.
3 Enable Record.

4 In the Layout pane, set the End value of the Type On parameters to 0.
   The text disappears (is “typed off”).

   Note: You can also use the Animation menu rather than enabling Record in the
   transport controls. Click the Animation menu icon next to the End parameter, then
   choose Add Keyframe.

5 Go to the frame where you want the animation to end (the type on effect to be
   complete).
6 Set the End value to 100.
7 Play the project.
The text object is typed on.

To create a type on effect in which the text characters “pop” on, turn off Fade In.

**Note:** You can use the Type On parameter when the text Layout Method is set to Type, Paragraph (multiline text object), or Path.

**Tip:** Remember that you can apply Parameter behaviors to nearly any parameter in Motion. For example, to make the text from the above example stutter and flash as it types on, apply the Randomize parameter behavior to the End parameter:

- In the Type On controls of the Layout pane, Control-click the End value, then choose Randomize from the shortcut menu.

  The Behaviors tab appears and displays the Randomize parameters. The text types on more roughly.

- To make the stutter effect more dramatic, adjust the Randomize parameters (such as changing the Apply Mode or increasing the Noisiness parameter).

  For more information on working with Parameter behaviors, see “Applying Parameter Behaviors” on page 326.

**Working With Text on a Path**

You can create text on a line or an ellipse. You can change the shape of a text path, add or remove control points, as well as animate the text along the path. Text on a path can still be edited, such as changing text characters or fonts, tracking, kerning, and so on. Text Style parameters can also be modified on text on a path.

**Path Options**

This group of controls allows you to specify the initial shape of the text path, and to modify the path and the text on that path.
Path Shape: Sets the shape of the path to Line or Loop.

Path Offset: Determines where the text begins on the path. Animate this value to move text along a path. At 0 percent, the first character of the text object is at the left end of the path; at 100 percent, the first character is at the right end of the path.

Inside Path: When the Inside Path checkbox is on, the baseline of text on a loop path is shifted so the text appears inside of the loop.

Align to Path: Aligns the text to the shape of the path. When the checkbox is off, all text characters align vertically, regardless of the shape of the path.

Creating Text on a Path
To create text on a path, the text object is created first. Once the text object is created, the Path option is chosen from the Layout Method pop-up menu in the Layout pane. The Path Options group is used to modify the text on a path.

To create text on a path:
1. Select the text object you want to place on a path.
2. In the Layout pane of the Text Inspector, set Layout Method to Path. The Path Options parameters are active.
3. Select the Text tool (or press T).

   Important: Step 3 is important—the Text tool must be selected in order to view or edit the text path.

The path appears below the text object. The default path is set to Line and contains three control points.
Modifying the Path Shape

Keep in mind that the Text tool must be selected to view and edit the text path. Use the following guidelines to modify the shape of the path:

- Drag a control point to change the shape of the path.

  **Note:** Text path control points are modified in the same way as shape control points. For more information, see “Using Shapes and Masks” on page 819.

- To make the text path a circle, choose Loop from the Path Shape pop-up menu.

The path is converted to a circle.
• **Option**-click or double-click the path to add a control point.
• To remove a control point, select the point, then press **Delete**.

**Editing Text on a Path**

Text on a path can still be edited. This includes changing the Format parameters, such as font, tracking, and kerning, as well as modifying the Style parameters, such as changing the color and opacity (including applying styles or gradients).

When additional text characters are added to a text object that has already been placed on a path, the default path may appear too short. In the following images, the first image shows the original text object placed on a path. The second image shows additional text added to the original text object. Notice that in the second image with the added text characters, the path is shorter than the text object.

![Initial text object placed on path](image1.png)

![Additional characters added to original text object](image2.png)

Footage provided courtesy of National Geographic Television and Film Library

**To extend a text path:**

- With the Text tool selected, drag the last control point toward the end of the text object.
When dragging, press Shift to constrain the path to a straight line. Once a path has been extended, you can add control points for extra control over the shape of the path.

**Animating Text on a Path**

Text can be animated to move across the text path.

**To animate text on a path:**

1. Create the path for the text to travel along.

2. Go to the frame where you want to begin the animation, and enable Record.

   **Note:** Remember that using shortcut keys while in text editing mode may result in adding characters to your text object.

3. In the Layout pane, adjust the Path Offset slider or value slider to the amount you want to move the text on the path.

   A keyframe is added to the Path Offset parameter.
A positive value moves the text toward the right and a negative value moves the text toward the left. You can enter values greater than 100 percent or less than 0 percent in the value slider. A value greater than 100 percent moves the text completely off the path to the right; a value less than 0 percent moves the text off the path to the left. In the following image, the Path Offset is set to 105 percent, so the text object is completely off the right end of the text path.

4 Go to the frame where you want to end the animation (or set the next keyframe).
5 Adjust the Path Offset slider or value slider to reposition the text on the path.
6 Play the project to see the text travel along the text path.

7 Disable Record.

**Working With Text Margins**
By default, the text Layout Method is set to Type. This creates one long string of text until you manually enter a line break. There are several ways to create and adjust text margins, which include using the onscreen controls and the Layout pane in the Text Inspector. You can set a margin for a text object before or after it is created.
Margin Options
This group of controls, which becomes available when the Layout Method is set to Paragraph, sets the size and location of the text margins.

Left, Right, Top, and Bottom Margins: Set the margins for the text layout in the Canvas. The Layout Method must be set to Paragraph to enable the margin parameters.

Creating a Text Margin
You can create a custom margin using the Margin controls in the Layout pane of the Text Inspector, or by drawing a text box in the Canvas.

To create text margins (a custom text box) with the Text tool:
1 Select the Text tool (or press T) and drag a text box in the Canvas.

Note: You can draw a text box (create margins) that extends beyond the edge of the Canvas.
Once you release the mouse button, the insertion point flashes in the text box and you can enter text in the Canvas or the Text Editor in the Format pane. The Layout Method is automatically set to Paragraph.

2 To resize the text margins, ensure the Text tool is selected, then drag a control point on the text box.

Note: You can also resize the margins of the text box using the Margin controls in the Layout pane of the Text Inspector (see step 3 in the following example).

3 Press Esc or click the Select/Transform tool to select the text box and exit text-editing mode.

Note: Do not use the Select/Transform tool to resize the text box margins. If you select a control point of a text box with the Select/Transform tool and resize, the text object is resized, not just the bounding box.

To create text margins in the Inspector:
1 Create a text object.

Note: You also can create a blank text object by clicking the Text tool in the Canvas.

2 In the Layout pane, set Layout Method to Paragraph.

3 Set margin values using the Left, Right, Top, and Bottom Margin parameters.

4 Press Esc or click the Select/Transform tool to select the text box and exit text-editing mode.

Using Text Animation and Text Sequence Behaviors
While you can apply any behavior (Basic Motion, Parameter, or Simulation) in Motion to a text object, text also has its own special behavior categories: Text Animation and Text Sequence behaviors. Text behaviors create animation by applying a range of values to text parameters specific to titling effects—without creating keyframes. By dragging a behavior to a text object in the Canvas, Layers tab, or Timeline, you can easily create a left or right text crawl, scroll, a type on effect, or a tracking animation.
Using the Sequence Text behavior in the Text Animation group, you can create a custom animation that sequences through the characters of a text object using the text Format and Style parameters. For example, you can choose to animate the Scale, Blur, and Opacity parameters of a text object in a given sequence. The sequence can run through the text object from left to right, right to left, or you can create a custom animation for the direction of the sequence. The sequence can also be applied per character, per word, per text object, and so on.

The Text Sequence subcategory includes over 100 sequence behaviors. Each behavior in this category is a preset that uses the parameters of the Sequence Text behavior (in the Text Animation subcategory). For example, the Drop In Random Text Sequence behavior animates the Position parameter so that the text characters drop in vertically in a random order. Although the Text Sequence behaviors are all presets—the parameters are already selected and animated—you can still add, remove, or modify any parameter that is available to the Sequence Text behavior.

You can save a modified behavior to the Library. For more information, see “Saving a Modified Text Behavior to the Library” on page 555.

**Note:** Remember that you can apply any Basic Motion, Parameter, or Simulation behavior to text objects. For more information, see “Using Other Behaviors With Text Objects” on page 556.

**Text Animation Behaviors**

The Text Animation behaviors create basic text crawls, scrolls, type on effects, and tracking animation. This group also includes the powerful Sequence Text behavior, which allows you to create a custom animation that sequences through the characters of a text object using all of the Style parameters and most of the Format parameters.

Text Animation behaviors are applied in the same manner as all other behaviors and filters in Motion—by using the Library or the Add Behavior icon in the Toolbar. As with other behaviors, the Library allows you to see a preview of the behavior before it is applied to a text object. The Add Behavior icon allows you to quickly apply a behavior to a single or multiple text objects.
To apply a Text Animation behavior from the Library:

1. In the Library, select the Behaviors category and then select Text Animation from the Behaviors subcategories.

2. Select a text behavior in the stack.
   
   Like other behaviors in Motion, a preview of the animation plays in the Preview area. Keep in mind that the preview merely represents the default animation of the behavior, which can be modified.

3. Do one of the following:
   
   - Drag the behavior to the text object in the Canvas, Layers tab, or Timeline.
   - Click the Apply button in the Preview area.

The text object Dashboard is replaced with the text behavior Dashboard.
To apply a Text Animation behavior from the Add Behavior icon:
1. Select the text object (or objects) to which you want to apply the behavior.
2. In the Toolbar, click the Add Behavior icon, then choose a Text Animation behavior from the pop-up menu.

Example: Using a Text Animation Behavior
In this section, the Crawl Left behavior is used to illustrate working with the Text Animation behaviors. The guidelines for modifying the Crawl Left behavior also apply to the Crawl Right, Scroll Down, and Scroll Up behaviors.

The Crawl Left behavior scrolls the text object to the left across the Canvas.

To use the Crawl Left behavior:
1. Using one of the above methods, apply the Crawl Left behavior (from the Text Animation subcategory) to the text object.

The behavior animation path appears and displays the projected motion of the text object. The animation path extends from the anchor point of the text object. For example, if the alignment of the text object in the following image was set to Center, the animation path would extend from the anchor point at the center of the text object.

Note: To show and hide animation paths, use the View pop-up menu in the Toolbar.

2. Click Play (or press Space bar).

The text object moves horizontally across the Canvas over the duration of the text object to which it is applied.
Modifying the Crawl Left Behavior

Use the Crawl Left parameters to modify the speed, start offset, and end offset of the crawl. With the exception of parameters added to the Sequence Text behavior, all Text Animation behavior parameters appear in the Dashboard and in the Behaviors tab of the Inspector.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>10.00</td>
</tr>
<tr>
<td>Position Offset</td>
<td>0.00</td>
</tr>
<tr>
<td>End Offset</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Rate:** Increases or decreases the rate of the crawl. By default, Rate is set to 10 (pixels per second). A higher rate increases the speed of the crawl, so the text object travels a greater distance over time; a lower rate slows the crawl.

**Note:** Although the Rate slider value is limited to 100, you can enter a higher value in the value slider.

**Position Offset:** Offsets the start position of the text object. By default, the crawl animation begins at the original position of the text object. To move the text object further to the right at the start of the animation, enter a higher number in the Position Offset field. For example, to move the text object 80 pixels to the right, drag the Position Offset slider to 80 or enter 80 in the value slider.

**Note:** Although the slider value is limited to 100, you can enter a higher value in the Offset value slider.
In the following image, the Crawl Left Rate is set to 200, and the Position Offset set to 80. Since the Rate is increased, the animation path reflects the distance the text object travels over time. Since the Position Offset is set to 80, the position of the text object is shifted by 80 pixels.

End Offset: By default, the text object crawls to the end of the duration of the text object. To stop the crawl 60 frames from the end of the object (or project), for example, drag the End Offset slider to 60 or enter 60 in the value slider.

Note: Although the slider value is limited to 100, you can enter a higher value in the End Offset value slider.

Crawl Right
The Crawl Right behavior scrolls the text object to the right across the Canvas.

Scroll Down
The Scroll Down behavior scrolls the text object downward in the Canvas.

Scroll Up
The Scroll Up behavior scrolls the text object upward in the Canvas.

Note: The Crawl Right, Scroll Down, and Scroll Up behaviors contain the same parameters as the Crawl Left behavior.

Setting the In and Out Points of the Text Animation Behaviors
By default, the animation created by the Text Animation behaviors begins at the first frame of the text object to which they are applied. To offset the start and end points of a Text Animation behavior, set new In and Out points for the behavior. Again, the Crawl Left behavior is used to illustrate setting new In and Out points for the Text Animation behaviors.
To change the In point of the Crawl Left behavior:
1 Select the Crawl Left behavior.

The Crawl Left behavior is selected in the mini-Timeline.

2 Do one of the following:
   • In the mini-Timeline, click the left end (start) of the Crawl Left bar and drag toward the right to the frame where you want the animation to begin.
     As you drag, the new In point, the duration of the object (Crawl Left behavior), and the delta (amount of change) are displayed.

   • In the Timeline, click the left end (start) of the Crawl Left bar and drag toward the right to the frame where you want the animation to begin.

   • Go to the frame where you want to set the new In point, then choose Mark > Mark In (or press I).

The text does not begin crawling until the playhead reaches the new In point.

To change the Out point of the Crawl Left behavior:
1 Select the Crawl Left behavior.

The Crawl Left behavior is selected in the mini-Timeline.

2 Do one of the following:
   • In the mini-Timeline, click the right end (end) of the Crawl Left bar and drag toward the left to the frame where you want the animation to end.
   • In the Timeline, click the right end (end) of the Crawl Left bar and drag toward the left to the frame where you want the animation to end.
   • Position the playhead at the frame where you want to set the new Out point, and choose Mark > Mark Out (or press O).
The text stops crawling when the playhead reaches the end of the Crawl Left behavior bar.

**Sequence Text**
The Sequence Text behavior allows you to select and apply text Format and Style parameters, such as Position, Color, Scale, or Opacity, and animate those parameters in sequence through the characters of a text object. For example, you can create a sequence in which the text characters fall vertically into place as they scale down, fade in, and rotate. The sequence works by moving a selection area, represented by small white lines, through the characters of the text object. You can set the sequence to repeat, change direction, or to randomize. The location of the selection can also be keyframed to customize the direction of the sequence. For example, you can animate the selection to move through half of the text object, return to the beginning of the text object, then move to the end of the object.

**Note:** All of the Text Sequence behaviors (in the Text Sequence subcategory) are presets based on this behavior. This means that each sequence behavior (in the Text Sequence subcategory) contains at least one text parameter that animates through the characters of a text object. The Text Sequence behaviors contain the same controls and are modified in the same manner as the Sequence Text behavior.

Once you have added and modified the Sequence Text behavior, you can save the behavior to the Library. For information on saving a modified behavior to the Library, see “Saving a Modified Text Behavior to the Library” on page 555.

**To apply a parameter to the Sequence Text behavior:**
1. Apply the Sequence Text behavior (from the Text Animation subcategory) to the text object.
In the Canvas, the text object bounding box is replaced with the sequence bounding box.

The Sequence Text Dashboard (press D) also appears and the behavior is added to the text object in the Layers tab and Timeline.

**Important:** Before any animation can occur, you must explicitly add at least one parameter to the behavior from within the Inspector. Until a parameter is added, adjustments made in the Dashboard have no effect.

2 With the Sequence Text behavior selected, display the Behaviors tab in the Inspector.
The upper area of the Sequence Text controls contains the Add and Remove pop-up menus, which are used to select parameters to add to the behavior, or to remove parameters. The second group of parameters are the Sequence controls, which include options for setting the direction of the animation, whether the animation is applied per character, per word, or per text object, and so on.

3 In the Parameter row, click the Add pop-up menu, choose Format, then choose Scale.

4 Set Scale to the largest (or smallest) value you want the text to become in your animation. In this example, the Scale value is set to 350 percent. To enter separate values for the X and Y scale, click the Scale disclosure triangle.

The Scale parameter is added to the behavior and is set to 100 percent by default (which represents the original size of the text object).
Note: Often, you can enter values larger than a parameter’s slider allows by typing in the value slider.

5 Click the Play button (or press the Space bar).

The first character begins at 100 percent, scales up to 350 percent, and then scales back down to 100 percent. The animation sequence moves through the text object.

As the animation sequences through the text object, small white lines travel with the animation. These lines represent selection—whatever is in between the two solid white lines is the current selection, and receives the full effect of the animation. The soft line represents the selection falloff, and “leads” the next character into the animation.

6 Add the Rotation parameter to the Sequence Text behavior. (Click the Add pop-up menu, choose Format, then choose Rotation.)
7 Set Rotation to the largest (or smallest) value you want the text to rotate in your animation. In this example, Rotation is set to 90 degrees.

The first character begins at 0 degrees, rotates to 90 degrees, and then rotates back to 0 degrees.

The animation—which begins at the default value for any added parameter, animates to the value you specify, and resolves back to the default value—cycles completely through each character because the Select parameter is set to Character by default. When Select is set to Word, each word in the text object scales up and down as a single character.

8 Click the Select pop-up menu, then choose All.
All of the text characters begin at 350 percent scale and 90 degrees rotation simultaneously.

**Note:** Make sure that the Map Animation parameter is set to To Entire Object.

9 In the Parameter row, click the Add pop-up menu, choose Face, then choose Opacity.

Set the Opacity to the lowest value you want to use in your animation. In this example, Opacity is set to 0 percent so that the text characters begin completely transparent and fade in to become opaque.

To create a softer transition between each character, you can adjust the Spread parameter.

**To adjust the Spread parameter:**

- In the Behaviors tab, drag the Spread slider (or type a number in the value slider).

This example uses a Spread value of 4.
Modifying the Sequence Text Behavior

Use the Sequence controls to repeat the animation over the duration of the text object, to randomize the order in which the effect is applied to the text characters, to change the direction of the animation, to “soften” the effect between characters, and so on.

Parameter: Use the Add and Remove pop-up menus to add and remove text format and style parameters to the sequence.

Sequence Controls

Contains parameters to modify the way the animation moves through the text object to randomize the animation, to change the direction of the animation, and so on.

Traversal: Sets the action of the sequence behavior to Ramp, Ping Pong, Ease In, Ease Out, Ease In/Out, or Custom.

- **Ramp**: Moves the selection from one end of the text object to the other at a constant speed. The sequence moves in the direction specified in the Direction pop-up menu.
- **Ping Pong**: Moves the selection back and forth from one end of the text object to the other. The sequence moves in the direction specified in the Direction pop-up menu.

*Note:* Loops must be set to a value greater than 1 for the sequence to Ping Pong.

- **Ease In**: The sequence animation (the movement of the selection bars) begins slowly and increases to normal speed as it moves through the text object.
- **Ease Out**: The sequence animation begins at normal speed and slows toward the end of the text object.
- **Ease In/Out**: The sequence animation begins slowly, increases to normal speed as it moves toward the middle of the duration of the text object, and slows as it reaches the end of the text object.
- **Custom**: Allows you to keyframe how the selection moves through the text object. For more information on using Custom, see “Using the Sequence Text Custom Behavior Option” on page 542.

Chapter 7  Using Text
Loops: Use the slider or value slider to set the number of times the animation sequences through the text object over its duration.

Note: Loops is not available when the Traversal parameter is set to Custom.

Random: Turn on this checkbox to randomize the selection of the text sequence. For example, a text sequence (using the Scale parameter) set to Ramp scales the text characters from one end of the text object to the other. When Random is turned on, the characters are scaled in a random order.

Sequence (Scale) moves smoothly through the text characters.  
Sequence with Random turned on randomly scales the text characters.

Footage provided courtesy of National Geographic Television and Film Library

If the Behavior parameter is set to Custom and there is a keyframed animation using the Location parameter, Random respects the keyframe values and randomizes the effect within the values set by the keyframes.

Note: When turned on, Random overrides the Direction parameter.

Random Seed: When you first enable Random, an initial random “seed” is created. If you are not happy with the randomness of the character selection when you first turn on Random, click Generate or enter a value in the field. This creates a new random seed which changes the way the characters are selected. The random variation in the text selection is based on the random seed number displayed in the Generate field.

Note: Generate has no effect unless Random is turned on.

Direction: Sets the direction of the sequence through the text object to travel Left to Right (default) or Right to Left.

Select: Specifies how the values set in the parameters (for example, Opacity set to 0 percent) are applied to the text object. The choices include Character (default), Word, Line, All, and Custom.

- Character: Selects single characters of a text object to be affected by the values set in the applied parameters.
• **Word:** Selects the separate words of a text object to be affected by the values set in the applied parameters.

• **Line:** Selects the separate line of a text object to be affected by the values set in the applied parameters.

• **All:** Selects all characters of a text object to be affected by the values set in the applied parameters.

• **Custom:** Allows you to offset the start and end points of the selection (based on the location of the selection).

**Spread:** Controls the amount of falloff of the selection. To create a softer transition between each character, increase the Spread value.

Footage provided courtesy of National Geographic Television and Film Library
Map Animation: The Map Animation parameter sets the timing of the animation to either “To Entire Object” or “To Selection.” In a basic example, the Scale parameter is added to the Sequence Text behavior. Next, the Scale parameter is keyframed to animate from 100 percent to 250 percent over 10 seconds. With the given example, use the following guidelines to understand the difference between the two Map Animation options.

- **To Entire Object:** Leaves the original animation timing of the sequence across the entire text object untouched, and the selection follows the animation at its current point in time.

  Using the above example, in which Scale animates from 100 percent to 250 percent over 10 seconds, the first character in the text object grows slightly and returns to its original value, the second character grows a little more, the third a little more, and so on until finally the last character grows to the full 250 percent value.
**Important:** You do not need to create an animation (keyframes) to use the “To Entire Object” option.

- **To Selection:** Changes the timing of the original animation to “fit” within the selection. Each selection (by character, word, line, and so on) goes through the entire source animation as the selection moves across the text object.

  Using the same 100 to 250 percent Scale animation example, the first character grows from 100 percent to 250 percent and holds at 250 percent, the second character grows from 100 percent to 250 percent and holds at 250 percent, and so on, until all characters have completed the animation.

  The Text Sequence behavior Drop & Bounce is an example of the To Selection animation mapping.

  **Important:** Using the To Selection option requires a keyframed animation.
Using the Sequence Text Custom Behavior Option
When Behavior is set to Custom, you can create location keyframes to specify where the effect of the sequence is at any given time.

To use the Custom Traversal parameter:
1 Once the Sequence Text behavior is applied to the text object, add the format or style parameters that you want to include in the sequence.

2 Set the values for the added parameters. In this example, the Scale parameter is added and the Y scale value set to 25 percent.

For more information on adding parameters to the Sequence Text behavior, see the steps in “To apply a parameter to the Sequence Text behavior,” above.

3 Choose Custom from the Traversal pop-up menu.
In the Canvas, the first few characters are selected by default, and are affected by the Scale value.

In the Behaviors Inspector, the Location parameter becomes available.

4 Enable Record (press A).

5 At the frame where you want to begin the animation, drag the Location slider (or use the value slider) to set where the sequence begins.

As you drag the slider, the selection bars move through the text characters. Values less than 0 percent select toward the left of the text object (regardless of where the anchor point is); values greater than 100 percent select from the beginning of the text object toward the right.
In the Inspector, a keyframe is added to the Location parameter.

6. Go to the next frame where you want to set a keyframe, and move the Location slider.

7. Repeat step 6 until you have created all of your keyframes.

8. Play the project (press the **Space bar**).

   The selection moves through the text object based on its keyframed locations.

**Text Tracking**

The Text Tracking behavior applies rate of change to the Tracking parameter of the Format pane (in the Text Inspector). Tracking applies a uniform space between each character of a text object.
To use the Text Tracking behavior:

- Apply the Text Tracking behavior (from the Text Animation subcategory) to the text object.

By default, a Tracking value of 2 is applied to the text object.

Once the Text Tracking behavior is applied to a text object, the Behaviors icon appears in the Tracking parameter (in the Format pane of the Text Inspector). As the project plays, the change in tracking value over time is displayed in the Tracking parameter field. The change in value is based on the rate set in the Rate parameter of the Text Tracking behavior.

Note: Just like the Tracking parameter in the Format pane of the Text Inspector, the Text Tracking behavior respects the Alignment setting of the text object. For example, to track from the center of the text outward, the Alignment of the text object must be set to Center. This parameter is located in the text object Dashboard or the Layout pane of the Text Inspector.
Modifying the Tracking Behavior

Use the Tracking parameters to modify the rate and end offset of the character tracking. The identical Tracking behavior parameters appear in the Dashboard and in the Behaviors tab of the Inspector.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>2.00</td>
</tr>
<tr>
<td>End Offset</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Rate:** Controls the rate of the change in tracking values. The higher the rate, the greater the tracking values.

**End Offset:** Use the End Offset parameter to offset the end of the effect of the Tracking behavior. By default, the text characters track to the end of the duration of the text object. For example, to stop the tracking animation 60 frames from the end of the object (or project), drag the End Offset slider to 60 or enter 60 in the value slider.

**Note:** Be sure to use the End Offset parameter to stop the effect of the tracking behavior before the end of the text object (or project) rather than changing the duration of the Tracking behavior in the mini-Timeline or Timeline. If you trim the end of the behavior, the text object snaps back to its default tracking value at the end of the behavior.

**Type On**
The Type On behavior quickly creates a type on effect.

**To use the Type On behavior:**
- Apply the Type On behavior (from the Text Animation subcategory) to the text object. By default, the text "pops" on. To create a softer fade-in effect, enable Fade In in the Type On Dashboard or Inspector.
Since the Type On behavior is applied to the duration of the text object to which it is applied, it takes the duration of the object to complete the type on. You can modify the time it takes the text object to type on in the mini-Timeline or Timeline.

Modifying the Type On Behavior
Use the following guidelines to modify the default Type On behavior. The Type On controls include only a single parameter: Fade In. The identical Type On behavior parameters appear in the Dashboard and the Inspector.

Fade In: When turned on, each text character fades in rather than appearing with the default “pop” effect.

Changing the Speed of the Type On Effect
As mentioned above, the Type On effect occurs over the duration of the object to which it is applied. In other words, if your text object is 300 frames long and you apply the Type On behavior, the last text character is fully typed on at frame 300. You can shorten the duration of the behavior so the type on is completed sooner.

To increase the speed of the type on effect:
1 Select the Type On behavior.
   The Type On behavior is selected in the mini-Timeline and Timeline.
2 Do one of the following:
   • In the mini-Timeline, click the right end (end) of the Type On bar and drag toward the left to the frame where you want the animation to end.
     As you drag, the new In point, the duration of the object (Type On behavior), and the delta (amount of change) are displayed.
   • In the Timeline, click the right end (end) of the Type On bar and drag toward the left to the frame where you want the animation to end.
   • Go to the frame where you want to set the new Out point, then choose Mark > Mark Out (or press O).
     By the time the playhead reaches the end of the new behavior duration bar, the type on effect is complete.
Note: You can also slow the type on effect by extending the behavior beyond the duration of the text object.

Text Sequence Behaviors
The Motion Library includes more than 100 preset Text Sequence behaviors. All of the sequence behaviors are variations on the Sequence Text behavior in the Text Animation subcategory. Although the Text Sequence behaviors are predefined animations, the parameter values can be modified, and other parameters can be added or removed. For example, the Blur Fade In Text Sequence behavior animates the text Blur and Opacity values by default. However, you can add the Scale parameter to the behavior. As with all behaviors, you can save a modified behavior to the Library.

The Text Sequence behaviors are applied to text objects in the same manner as all other behaviors. However, there is one big difference between the Text Sequence behaviors and all other behaviors in Motion: Once added to a text object, the Text Sequence behaviors do not last the duration of the text object. This is because usually—to achieve the desired preset effect—you want the animation to complete in a shorter period of time than over the duration of the text object. The default duration of the behavior can be modified to slow down or speed up the effect of the animation.

Like the Text Animation and other behavior subcategories, clicking a behavior in the Library stack plays the animation in the Preview area.

Example: Using a Text Sequence Behavior
In this section, the Drop In From Left behavior is used to illustrate working with the Text Sequence behaviors. In general, the guidelines for modifying the Drop In From Left behavior also apply to the other sequence behaviors.
Note: Since the sequence behaviors are preset variations of the Sequence Text behavior (in the Text Animation subcategory), the guidelines for modifying the Sequence Text behavior also apply to the Text Sequence behaviors.

Drop In From Left
The Drop In From Left behavior creates an animation in which the text characters fade and drop in vertically from left to right to land in their original position. The parameters included in the behavior are Opacity and Position. The following steps begin at the first frame of the text object.

To use the Drop In From Left behavior:
1 Apply the Drop In From Left behavior (from the Text Sequence subcategory) to the text object.

Since the behavior creates an animation in which the text starts above its original position and drops in, the behavior selection box moves up in the Canvas. Also, the selection bar is located at the left edge of the box because the animation starts at the leftmost text character. This appears and displays the projected motion of the text object.
Once applied, the Drop In From Left behavior appears in the Layers tab and Timeline.

The Dashboard also appears (press F7). Remember that because the sequence behaviors are all preset variations on the Sequence Text behavior, the Drop In From Left Dashboard parameters are identical to the parameters in the Sequence Text behavior (in the Text Animation subcategory).

As with the Sequence Text behavior, the specific text parameters that the behavior uses to create the animation are listed in the Inspector. Since the Drop In From Left behavior uses the Opacity (from the Face controls) and Position (from the Format controls) parameters, those parameters are listed in the Inspector.
Also, because you can apply sequence behaviors to text with applied styles (such as Glow or a Library text style), all of the Style parameters also appear in the Text Sequence behavior parameters. Using the Drop In From Left behavior as an example, if the Glow and Outline are enabled for the text object to which the behavior is applied, the Glow and Outline are also affected by the Opacity preset.

2 Click Play (or press the Space bar).

From left to right, the text characters fade and drop in and land in their original position. As the text animates, the selection box expands to encompass the text characters.
Modifying Text Sequence Behaviors

Use the following guidelines to modify the default Drop In From Left behavior. The difference between the parameters that are displayed in the Dashboard and those displayed in the Inspector is the same as with the Sequence Text behavior (in the Text Animation subcategory): The group of Sequence controls is displayed in the Dashboard; the affected parameters and group of Sequence controls are displayed in the Inspector.

If necessary, use the Drop In From Left parameters to modify the preset animation.

**Format/Position:** Since the Drop In From Left behavior animates the characters of a text object to drop in one at a time (by default), the Position parameter is included in the behavior parameters. The value of the Y Position determines the furthest vertical point from the original position of the text object. The default Y Position value is 200, which means the text animation begins 200 points above the original position of the text object. To change the initial starting position of the text, enter a different number in the Position parameter value sliders.

In the following image, the Y Position value is set to 100, so the text falls a shorter distance (than the default 200 pixels). A value of 100 is also set in the X Position value, so the text falls at an angle rather than completely vertical.

**Face/Opacity:** Since the Drop In From Left behavior animates the opacity of the characters of a text object, the Opacity parameter is included in the behavior parameters. The Opacity value determines the most transparent point in the text animation. The default Opacity value is 0 percent, which means the text animation begins completely transparent and ends at the Opacity value of the original text object. To change transparency of the text, enter a different number in the Opacity parameter value field.
**Note:** You can set different Opacity values for the different text style parameters (Outline, Glow, and Drop Shadow).

**Sequence Controls:** These controls, Behavior, Repeat, Random, and so on, are identical to the Sequence behavior controls. For more information, see “Sequence Text” on page 531.

**Changing the Speed of Text Sequence Behaviors**
With the Drop In From Left behavior selected, notice that the duration of the behavior is much shorter than the duration of the text object to which it is applied. You can see this in the mini-Timeline or the Timeline. By default, the duration of a Text Sequence behavior is 60 frames.

Like the Type On behavior (in the Text Animation subcategory), you slow down or speed up the animation by changing the duration of the behavior.

**To slow the sequence animation:**
1. Select the sequence behavior.
2. Do one of the following:
   - In the mini-Timeline or Timeline, click the right end of the behavior bar and drag toward the right (extend the behavior) to the frame where you want the animation to end.
   - Go to the frame where you want to set the new Out point, then choose Mark > Mark Out (or press O).

**Note:** Conversely, you can speed up the animation by shortening the duration of the behavior.
Adding or Removing Text Sequence Behavior Parameters

Although the Text Sequence behaviors include predetermined parameters, you can add and remove parameters. Parameters are removed and added in the same manner as adding parameters to the Sequence Text (Text Animation) behavior—using the Parameter Add and Remove pop-up menus. The following example continues with the Drop In From Left behavior to illustrate adding parameters to a Text Sequence behavior.

To add a parameter to a sequence behavior:

1. Select the sequence behavior to which you want to add a new parameter.
2. In the Parameter row, choose a parameter from the Add pop-up menu.
The chosen parameter is added to the sequence behavior.

![Scale parameter added to the Drop In From Left behavior](image)

3 Set a value in the new parameter (Scale). In this example, the Scale value is set to 150 percent.

In addition to the text dropping and fading in, the text Scale value begins at 150 percent scale and changes to 100 percent as the characters land in place.

![Text with Scale parameter](image)

4 To remove a parameter, choose a parameter from the Remove pop-up menu.

The chosen parameter is removed from the sequence behavior.

**Saving a Modified Text Behavior to the Library**

As with all modified behaviors, filters, generators, and so on, you can save a modified Text Sequence behavior to the Library. This example continues using the Drop In From Left behavior from the above sections to illustrate saving a modified behavior.
To save a modified behavior to the Library:

1. Select the behavior you want to save.

   **Note:** Although not required, it is recommended that you rename the behavior to a more descriptive name for organizational purposes.

2. In the Library (press **Command+2**), select the location in which you want to store the behavior, such as the Text Sequence subcategory or Jellies category.

3. From the Layers tab or Timeline, drag the behavior to the Library stack. In this example, the behavior is dragged to the Favorites stack. When the green “+” sign and black outline around the stack window appear, release the mouse button.

   The behavior is saved to the Library. A custom behavior is represented by a user icon in the lower-right corner of the Behaviors icon.

**Using Other Behaviors With Text Objects**

Since text objects are like all other objects in Motion, you can apply any Basic Motion, Parameter, or Simulation behavior to text objects. Since the characters of a text object make the object a group, you can create some unique animations using the Simulation behaviors. This section provides a quick introduction to working with nontext behaviors applied to text objects. For more information on using behaviors, see “Using Behaviors” on page 317.
Behaviors are applied to text objects in the same manner as all other objects—by using the Library or the Add Behavior icon in the Toolbar. As mentioned earlier, the Library allows you to see a preview of the behavior before it is applied to a text object. The Add Behavior icon allows you to quickly apply a behavior to a single or multiple text objects.

**To apply a non-text behavior to a text object, do one of the following:**

- In the Library, select the Behaviors category, select a Basic Motion, Parameter, or Simulation subcategory, and drag the desired behavior from the stack to the text object (in the Canvas, Layers tab, or Timeline).
- Select the text object, click the Add Behavior icon, then choose the behavior you want.

In the following example, an animation is created in which the text moves and collides with the edge of the screen. You can set the text to hit the edge as a single object, or have each text character hit the edge one at a time.

**To create a text animation using non-text behaviors:**

1. From the Basic Motion subcategory, apply the Throw behavior to the text object.
2. Adjust the Throw so that the text object moves across the Canvas.
3. From the Simulation subcategory, apply the Edge Collision and Vortex behaviors to the text object.
4. Play the project (press the **Space bar**).
The text characters are swept around the screen in a vortex pattern. If the text characters start to move off the screen, they collide with the edge of the screen.

By default, Related Objects is selected in the Vortex Affect parameter, which means that all objects that share the same layer with the behavior are affected. You can change this to Specific Objects to select which objects are affected, or change it to All Objects.

*Note:* Remember that behaviors often contain parameters for how objects to which the behavior is applied are affected. These controls greatly affect the result of a behavior when it is applied to a text object. For example, if you have text on a loop path and you apply a Spin behavior to the text object, the text characters rotate (rather than the text object as a whole). This is because the Affect Objects checkbox is turned on by default in the Spin parameters. To rotate the text object rather than the individual text characters, turn off the Affect Objects checkbox in the Behaviors tab of the Inspector.

For more information on using behaviors, see “Using Behaviors” on page 317.
Animating Text With Keyframes
You can create keyframes for most of the text parameters. As with all objects in Motion, there are two ways to create keyframes: the Record button in the transport controls or the Animation menu in the Inspector. The following example uses both methods to animate text Tracking and Opacity.

**Note:** Most text behaviors automatically animate the text parameters without creating keyframes. For example, when the Tracking behavior is applied to a text object, the tracking occurs at the rate specified in the behavior. For more information, see “Using Text Animation and Text Sequence Behaviors” on page 524.

**Example: Creating Text Object Tracking and Opacity Keyframes**
The following example animates text to fade in as the tracking animates. You can also create this same effect using the Fade In/Fade Out behavior (in the Basic Motion behavior category) and the Tracking behavior (in the Text Animation behavior category).

**Using Keyframes vs. Using Behaviors**
The text animation method you use (keyframing or behaviors) depends on your project, or more specifically, your timing needs. In general, if you need a very specific action to happen at a specific point in time in your project, use keyframing. For example, if you want a text object to be completely transparent at frame 1, become completely opaque at frame 60, become transparent again at frame 90, and opaque again at frame 120, use keyframing. Keyframes apply specific values to an object’s parameters at certain frames.

If the effect is more general, for example, you want the text to be completely transparent at frame 1, become opaque over frames 60-90, and become transparent by frame 120, use the Fade In/Fade Out behavior. Behaviors generate a range of values that are applied to an object’s parameters.

You can combine keyframing and behaviors on all objects in Motion. For example, if you keyframe text opacity, you can then apply the Tracking behavior to automatically animate the text object tracking, or you can keyframe the Tracking parameter. Keep in mind, however, that if you keyframe the text Opacity parameter, and then apply a Fade In/Fade Out behavior to the text object, unexpected results may occur. For more information on combining behaviors and keyframes, see “Combining Behaviors With Keyframes” on page 338.

**To create text tracking keyframes:**
1. Go to the frame where you want to start the tracking animation.
2. Select the text object.
3. Enable Record (press A).
When enabled, the Record button pulses red and a keyframe is automatically created whenever you change the value of a parameter.

4 In the Format pane of the Text Inspector, enter the first Tracking value.
   Since keyframing is enabled, a Tracking keyframe is created. The lower the Tracking value, the closer the text characters are to each other.
5 Go to the frame where you want to end the tracking animation.
6 Enter the end tracking value.

   **To create text opacity keyframes:**
1 Go to the frame where you want to start the opacity animation.
2 Click Style, and set the first Opacity value.
3 Go to the frame where you want to end the opacity animation.
4 Enter the end Opacity value.
5 Disable Record.

To view the keyframes for a text parameter in the Keyframe Editor, click that parameter’s Animation menu icon, then choose Show in Keyframe Editor. For more information on the Keyframe Editor, see “Animating in the Keyframe Editor” on page 424.

**Using LiveFonts**
The Motion Library includes ten LiveFonts that can be applied to text objects. LiveFonts are complete animated character sets that are a part of the LiveType titling application that is included with Final Cut Pro. If you have Final Cut Pro with LiveType installed on your system, all of the LiveType fonts can be used in Motion.

   **To preview the LiveFonts:**
1 In the Library, click the LiveFonts category.
   The available LiveFonts are listed in the stack.
2 Click a LiveFont in the stack.
   The preview of the animated font plays in the Preview area.
The following image shows the original text object prior to the application of the LiveFont.

To apply a LiveFont to a text object, do one of the following:
- Drag the LiveFont from the Library to the text object in the Canvas, Layers tab, or Timeline.
Depending on the frame where you apply the font, the font may not appear, may appear partially drawn, or may appear complete.

- Select the text object, select the LiveFont in the Library, then click the Apply button in the Preview area.
- Select the text object, select LiveFonts from the Font Type pop-up menu in the Format pane of the Text Inspector, then choose the specific LiveFont from the Family pop-up menu.

### Modifying Applied LiveFonts

Use the following guidelines to modify the default LiveFont animation. The LiveFont parameters only appear in the Format pane of the Text Inspector once a font is applied to a text object.
Since LiveFonts are movies, they are applied with default timing settings. You can modify the timing settings, such as randomness, play direction, start time and so on, using the LiveFont Timing parameters.

**Random:** Drag the slider or use the value slider to apply the LiveFont movie to each character in the text object in a different order. For example, the Freehand font movie draws the characters from the first character to the last. When you apply a Random value, the characters are drawn (the movie plays) in random order.

**Random Seed:** Click Generate or enter a value in the field to create a new random "seed" that changes the way the LiveFont movie is applied to each character. The random variation in the text selection is based on the random seed number displayed in the Generate field.

**Note:** Generate has no effect unless a Random value is set.

**Sequence:** Controls the timing of the sequence. Using the Freehand font as an example, the default Sequence value for the Freehand font is 50 percent, which "draws" (the movie plays) the text characters on one at a time in sequence. When Sequence is set to 0, all characters are drawn at the same time.

**Direction:** Sets the direction of the animation to run From Left, From Right, or Ping Pong.

**Speed:** Allows you to play the LiveFont movie more quickly or slowly based on a percentage of the default speed.
**Play:** Sets the LiveFont movie to play Forward, Backward, or Ping Pong. This is not the same as the Direction parameter. Using the Freehand font as an example, when Play is set to Backward, the text object begins completely drawn and erases (in the direction specified in the Direction parameter).

**Loop:** Sets the number of times the LiveFont movie plays through. The default setting is 1, meaning that the LiveFont plays one time. A value of 3 means that it plays through three times. For example, when the Loop parameter of the Freehand font is set to 3, each character is drawn one time, then disappears, is drawn a second time, then disappears, and is drawn a third time and remains.

**To End:** Loops the movie until the end of the text duration.

**Note:** When To End is enabled, the Loop parameter is ignored.

**Hold First:** Drag the slider or use the value slider to set the delay, in seconds, of the start of the font’s “animation.” For example, when using the Freehand font and Hold First is set to 3, the text does not begin to “draw on” for 3 seconds.

**Note:** The font “animation” varies depending on the LiveFont and can include the drawing on of the font, the moving of highlights around the font, and so on.

**Hold Last:** Drag the slider or use the value slider to set the amount of time, in seconds, that the font stays visible once the movie is completed. For example, when using the Freehand font and Hold Last is set to 0, the text disappears as soon as it is finished drawing.
Working With Particles

Using particle systems, you can simulate real-world effects such as smoke and sparks, or you can bend the rules and create sophisticated abstract textures.

Particle systems allow you to quickly and easily create sophisticated animated effects involving large numbers of automatically animated objects. You can use the included particle effects library to add a pre-made particle system to your composition, or you can create your own custom particle effects using nearly any object in your project. Particle systems in Motion are flexible enough to create many different kinds of effects.
Particle systems use objects, referred to as *cells*, as the “mold” for the particles that are generated by the emitter. You can use nearly any object in Motion as a source for a particle cell, including images, shapes, text, movies, and image sequences. Each particle that is created is essentially a duplicate of the original cell, and is animated according to the parameters for that particle system (a particle cell and emitter) over its lifetime.

The object you use as a particle system’s cell determines how that particle system looks. Particle systems can contain multiple cells, resulting in the release of several types of particles from a single emitter. You’ll find that many of the most sophisticated particle presets are constructed in this way.
The Anatomy of a Particle System

Every particle system is made up of an emitter and one or more cells. Each cell appears inside of the emitter in the Project pane and the Timeline.

The emitter and cells have separate sets of parameters that control the particle system’s behavior. If you imagine that a garden hose is a particle system, the nozzle acts as the emitter, while the water represents the flow of particles. Changing the parameters of the emitter changes the shape from which the particles are emitted and their direction, while changing the cell’s parameters affects each individual particle.

By changing a few parameters, it’s possible to create very different effects using the same cell.
As with any effect in Motion, particle system parameters can be keyframed in order to change a particle effect’s dynamics over time. For example, you can create a path of bubbles that follow an object onscreen by keyframing the emitter’s Position property in the Keyframe Editor.

In addition, you can add behaviors to each cell or to the emitter itself to create even more varied effects (simulation behaviors can be especially effective). Any behavior that you apply to a cell is in turn applied to each particle it generates. This lets you achieve almost limitless variation. Adding behaviors to cells in addition to the particle system’s own parameters is an easy way to create complex, organic motion that would be impossible to accomplish any other way. You can also apply a behavior to another object in your project (an object that is not part of the particle system), such as Repel, and have the particles weave around that object.

Particle Cell Source Objects
Almost any object in Motion can be used as a particle cell source, including shapes, text, images, image sequences, and clips. Transformations that you apply to the source object are respected in the generated cells. For example, if you use a rectangle shape that is sheared and rotated, the particles created using that rectangle as the cell source are sheared and rotated.

If the object used as the cell source for the particle system has applied filters, the effects of the filters are retained in the particles.

Note: Keep in mind that using a movie with applied filters as a particle cell source adversely impacts your computer’s processing performance. For better performance, output your sequence with the filter applied, then import it back into Motion and use the movie as a source.
Using Particle Systems
Despite their sophistication, particle systems are easy to set up and simple to use. This section describes how to use pre-made particle systems from the particle library. Afterward, it explains how to create a simple particle system of your own.

Particle Systems and Layer Sizes
Particle systems often create particles that grow or move off the Canvas before they die. This can make the size of a layer much larger than that of the Canvas. Although the particles are not visible once they move off the Canvas, they are still present in the project and are processed. If you apply a filter to a layer containing growing particles, or use that layer as a source object, it is recommended that you turn on the Fixed Resolution checkbox in the Layer tab of the Inspector (available only when a layer is the selected object). The Fixed Resolution parameter allows you to set the specific width and height of a layer, cropping anything beyond those values. For more information, see “Fixing the Size of a Layer” on page 204.

Using the Particle Library
The easiest way to add a particle system to your project is to use one from the particle library. The particle library is located in the Particle Emitters category of the Library, and is a collection of pre-made particle effects that you can add to your project. There are many types of particle effects to choose from. If you find one that is close to what you need, you can easily customize its parameters after you add it to your project. Particle systems are added to a project exactly like any other object.
To add a particle system from the Library:

1. In the Library, click the Particle Emitters category.
2. Click one of the particle subcategories, such as Nature, Pyro, SciFi, and so on.
3. Select a particle preset in the Library stack.

An animated preview of the selected particle emitter plays in the Preview area. While it is playing, you can drag the pointer around in the Preview area to see how the particle looks while in motion.

**Note:** If the preview does not automatically start playing, click the Play button in the Preview area. To automatically play items selected in the File Browser or Library, choose Motion > Preferences (press \texttt{Command+}), then enable “Play items automatically on a single click” in the File Browser & Library section of the General pane.
When you find a particle preset you want to use, do one of the following:

- Click Apply to add the selected particle system to your project at the center of the Canvas. It is added to the current layer.

  **Note:** If Create Objects At is set to “Start of project” in the Project pane of Motion Preferences, the particle system is added at the first frame.

- Drag the particle system into the Canvas at the position you want it to appear.
- Drag the particle system into a layer in the Layers tab or Timeline Layer list. It appears at the center of the Canvas.
- Drag the particle system to the track area of the Timeline. When you reach the frame where you want the new objects to start, release the mouse button.

The new particle system object appears in your project, composited against any other objects that you've already added.

Once you have added a particle system from the Library, it acts exactly as it appeared in the Preview area. If necessary, you can edit a particle system's Emitter parameters in the Dashboard to tailor it to your own use.

**Note:** You can only modify a particle system after it's been added to a project.

The Dashboard displays a selected particle system's most essential parameters, including the size and number of particles that are created, how long they remain onscreen, how fast they move, and the direction and area in which they travel. Select an individual cell in the Layers tab or Timeline to edit its parameters in the Dashboard.

For more detailed information on using the particle Dashboard, see “Customizing a Particle System Emitter” on page 575. For more comprehensive information on customizing all of a particle system's parameters, see “Advanced Particle System Controls” on page 586.

**Creating a Simple Custom Particle System**

While Motion comes with a wide variety of particle system presets, many times you'll want to create something completely new. Creating a particle system begins by selecting an object in your project to use as a source object for a cell within a new particle emitter.
In any particle system, the emitter is the source of all particles that are created. Particle systems in Motion are very flexible, and you can use any object in your project as a source for a cell in an emitter, including still graphics, animation or video clips, or shape objects created in Motion. The object you select when you create an emitter becomes the first cell in that particle system. Cells are inside of emitters and are used to create the actual particles in that system.

**To create an emitter:**

1. Place an object that you want to use to generate particles into your project. This example uses an image of a simple white circular gradient that was created with an alpha channel.

2. Move the object in the Canvas to the location where you want the center of your particle system to be.
3 Select the object, then do one of the following:

- In the Toolbar, click the Make Particles icon.

- Press E.

Once an emitter is added to the project, the following occurs:

- The Emitter object appears in the Layers tab and is selected.
- The object becomes an emitter source for the new particle cell.
- The original reference object is disabled.

Note: Changes made to the original reference object, such as opacity or shearing, are respected in the particles even after the emitter is created.

- In the Canvas, the emitter bounding box appears, which can be transformed using the onscreen controls.
- The particle appears in the Canvas in the same location as the original object. Although it appears as if the particle is selected, it is actually the bounding box for the emitter.
- The Emitter Dashboard is displayed. If you have hidden the Dashboard, press D.

Note: For projects with a frame rate greater than 30, at times only the bounding box (not the particle cell) may appear at the first frame of your project. Since, by default, particles are generated at 30 particles per second, there is no guarantee that a particle will appear on every frame.

By default, the first frame of a new particle system (with a single source object) has one particle. If you play your project, additional particles are generated and emerge from the center of the emitter.
By default, new cells emit one particle per frame in all directions (for 30 fps projects), and each particle moves 100 pixels per second away from the emitter over a lifetime of 5 seconds (150 frames in a 30-frames-per-second project).

*Note:* The Initial Number parameter in the Emitter or Particle Cell tab allows you to change the default behavior so that a particle system begins with a burst of particles at the first frame. For more information, see “Advanced Particle System Controls” on page 586.

**The Predictability of Particle Systems**

When you create a particle system or modify one of the parameters of an existing particle system, the path of each particle in that system is immediately calculated and predetermined. While the number and motion of particles may seem random, they are actually completely predictable based on that system's parameters. Playing the same particle system twice with the same parameters results in exactly the same particle motion. This means that once you create a particle system that looks right, it is always the same.

**Using Multiple Cells Within a Single Emitter**

When you create a particle system from scratch, you don't have to restrict yourself to using just one cell. You can create a particle system that emits many different kinds of overlapping particles by placing multiple cells inside of a single emitter.

You can add as many cells as you want within a single emitter object. Each cell has its own particle cell parameters which govern how particles from that cell are created. Selecting the different particle source cells displays their own Particle Cell tab in the Inspector. Particle systems with multiple cells generate particles from each cell simultaneously, according to each cell's parameters.

For an example of using multiple cells within a single emitter, see “Example 2: Creating, Animated Pixie Dust” on page 615.
Additional cells can be created by either selecting multiple source objects when initially creating the emitter, or by dragging source objects onto the emitter in the Layers tab.

Note: When multiple source objects are used to create a particle system, the resulting emitter is positioned at the average of the source objects’ position.

Customizing a Particle System Emitter
When you create an emitter, the particle system starts working according to the default parameters in its Emitter and Particle Cell tabs, located in the Inspector. You can use the Emitter Dashboard to easily change the most important of these parameters to suit your needs.

To display the Dashboard for a particle emitter:
- Select the emitter for which you want to display the Dashboard.

The Dashboard appears when you select the emitter. If the Dashboard does not appear, press D.

Emitter Dashboard Parameters
The Dashboard contains the most frequently used emitter controls that are necessary to modify a particle system’s size and shape. These parameters are a subset of those found in the Emitter tab of the Inspector. The Dashboard contains a group of sliders and the Emission control, which provides a visual way to manipulate three different particle system parameters—Emission Range, Emission Angle, and Speed.
For particle systems containing multiple cells, the Emitter Dashboard parameters simultaneously modify the effect of each cell's parameters relative to one another. This means that for a particle system consisting of two cells with different scale values, changing the scale in the Dashboard resizes both cells simultaneously. For example, increasing the scale in the Dashboard by 200 percent does not change the scale of both cells to 200 percent. Instead, it multiplies the scale of each cell by 200 percent, so that both are resized relative to their original scale values.

For this reason, the Dashboard parameters are displayed as percentages, since they represent the percent at which these particle cell parameters are modified (when multiple cells exist). When you modify the parameters of a single cell, the cell parameters are adjusted directly (not in percentages).

![Original particle system](image1)

![Particle system scaled to 200 percent](image2)

**Birth Rate:** A slider defines how many particles are created every second.

**Life:** A slider defines how long each particle remains onscreen (in seconds) before disappearing from existence.

**Scale:** A slider defines the size of each particle, relative to the original size of the cell.

Chapter 8  Working With Particles
**Emission Range:** Two points on the outer ring of the graphical Emission control let you define the range of angles at which particles are generated. In other words, it defines the size of the “slice” of the pie graph that the particles fill when they are generated.

**Emission Angle:** Drag the inside of this section to change the direction in which particles are emitted, inside the area defined by the Emission Range.

**Speed:** Arrows within the Emission Range can be shortened or lengthened to define how quickly particles move away from the emitter.

Use the following modifier keys to more precisely manipulate the graphical Emission control in the Dashboard:

- **Shift** (while adjusting Angle): Restrict angles to 45 degree increments.
- **Shift** (while adjusting Range): Restrict to 22.5 degree increments.
- **Command:** Adjust Angle only.
- **Option:** Adjust Speed only.

**Using the Dashboard to Create a Simple Smoke Effect**

In this example, the controls in the Emitter Dashboard are used to create a smoke effect using the emitter created in the procedure discussed in “Creating a Simple Custom Particle System” on page 571. A Blur object from the Content category in the Library is used as the cell source.

To create a smoke effect using the Emitter Dashboard:

1. Before making adjustments to the selected particle system, it may be helpful to move the playhead forward in the Timeline to a frame where you can see the particle system in full effect. That way, any adjustments you make are readily apparent.
2 The first thing you may notice in this example is that the size of each particle is so big that it's hard to make out any texture in the particle system. With the Emitter Dashboard open, drag the Scale slider to the left to reduce every particle's size so that the individual particles are more textured.

3 In the Dashboard, click anywhere along the outer edge of the Emission control and drag to define a narrow segment that limits the range of the angle at which particles are created (the emission range).

Both points defining the emission range rotate around the center of the Emission control symmetrically, so your initial wedge points to the right. As you adjust the emission range, the particles rearrange themselves in the Canvas so you can see the resulting effect.
4 To make the particles drift upward, click in the middle of the Emission Range segment and drag to rotate the emission angle up and slightly to the right of the center control.

5 As you drag the middle of the Emission Range segment, you can drag toward, or away from, the center of the Emission control to adjust the speed of the particles flying away from the emitter. As you make this adjustment, one or more arrows within the currently defined emission range become longer to indicate a faster speed, or shorter for a slower speed.

6 Drag the Speed arrow so that it is approximately halfway between the center and the edge of the Emission control to create a slowly drifting column of particles.

7 At this point, the particles are all moving in the correct direction, but there aren’t very many of them (there isn’t much of a fire yet). Move the Birth Rate slider to the right, to increase the number of particles created by the emitter.
As you increase the birth rate, more particles are created and a nearly unified column of particles is created, with the particles moving farther apart as they drift away from the emitter.

![Emitter: Smoke](image)

As you can see, a single object can be used to create a credible column of smoke rising gently into the sky.

While the Dashboard controls are quite powerful, the Emitter and Particle Cell tabs in the Inspector have many more parameters you can customize. For more information, see “Advanced Particle System Controls” on page 586.

**Modifying Emitter Properties**

Emitter parameters can be modified in the Properties tab of the Inspector like any other object in Motion. Since particle systems are collections of independently generated objects, these parameters have different effects than they do with other objects.

**Note:** The only parameter that appears for cells in the Properties tab of the Inspector is Timing.
Transform Controls
As a particle system plays, the cells in the system are duplicated, according to the parameters for that system, to create each individual particle. Since all particles emerge relative to the position of the emitter (since the emitter can be a point, a circle, geometry, and so on), changing the emitter's position in the Canvas also changes the position of every particle in that system. This results in the entire particle system being moved at once.

The exception to this is if the emitter's position is animated using a behavior or keyframes. In this case, particles emerging from the emitter's position at each frame continue to move relative to that position, regardless of changes to the emitter's position in subsequent frames. This results in a trail of particles following the path of the emitter.

The Attach to Emitter particle cell parameter modifies this behavior. When set to 0 percent, the particles are completely independent of the emitter. When set to 100 percent, the particles try to keep up with the position of the animated emitter. Depending on any applied behaviors, such as Drag, the particles may not be able to keep up with the emitter.
Modifying an emitter’s other transformation parameters (Rotation, Scale, Shear, and Anchor Point) changes the distribution of particles from that emitter and transforms each individual particle. For example, if you create an emitter, then modify its Shear parameter, the distribution of the emitted particles changes to reflect the new plane of the emitter, and the particles are sheared along the same plane.

![Image: Analog Modulator particle system preset](image1)

![Image: After Shear effect is applied](image2)

**Blending**

Any changes you make to the opacity or blend mode parameters for an emitter are applied to the particle system as a whole—the result of the emitter is blended into the scene. Within the emitter, the particles can be blended additively or normally (using the Additive Blend checkbox). For more information about blend modes, see “Using Blend Modes” on page 249. For more information about the Preserve Opacity setting, see “The Preserve Opacity Option” on page 247.

**Mask and Drop Shadows**

Masks and drop shadows can be applied to particle systems. When the Drop Shadow parameter is enabled for the source object (in the Properties tab in the Inspector), each generated particle appears with a drop shadow. For more information on working with drop shadows, see “Drop Shadows” on page 269.
As shown in the following images, you can apply masks to the cell source object of a particle emitter.

You can also apply masks to the emitter object itself.

For more information on working with masks, see “Masking an Object” on page 851.

**Timing**

Once you create a particle system, its duration can be as long or short as necessary, regardless of the duration of the original objects used to create the particle system. The duration of a particle system is defined by the duration of the emitter object. Changing the In or Out point of an emitter in the Properties tab, Timeline, or mini-Timeline changes the duration of the entire particle system.

By default, particles are generated by every cell in a system over the entire duration of the emitter. The duration of each individually generated particle is defined by the Life parameter of the cell that generated it, and not by the duration of the cell itself.
The duration of the cell actually controls the duration over which new particles are generated. You can change a cell's duration by dragging either its position or its In and Out points in the Timeline. In this way, you can adjust the timing that defines when each cell's particles emerge.

For example, you can create a particle system that simulates an explosion by offsetting the appearance of three different types of particles. First, dense white particles emerge from the center. Half a second later, more diffuse orange particles appear around a larger area. One second after that, small sparks emerge from underneath both of these layers as they fade away.

You can offset a cell in the Timeline or mini-Timeline to start before the emitter. This creates a “preroll” in which the particle simulation starts before the particles are drawn.
For more information on adjusting the timing of layers in the Timeline, see “Using the Timeline” on page 273.

Creating Graphics and Animations for Particle Systems
Creating a new particle system from scratch begins with designing the particles you want it to emit. You can use any image, shape, text, or movie supported by Motion as a source for a cell. This section presents things to keep in mind when you create particle imagery.

Creating Still Image Graphics for Particle Systems
Still images are the easiest to create and result in the fastest emitters. This is often all you need to create a compelling particle system. Here are some guidelines for creating graphics for use as particles.

Graphics Size
If you are unsure what size you want your particles to be, it’s a good idea to make your graphics larger rather than smaller. Increasing the size of particles beyond the size of the original graphic may introduce unwanted artifacts.

Particle Edges
Keep in mind that the quality of the edges of your graphics can be extremely important for creating convincing particles. Soft, translucent edges might look better than hard, over-defined ones.

Object Color
By default, particles are created using the original colors of the image being used as the cell. If necessary, you can tint the emitted particles using the Color Mode parameters in the Emitter and Particle Cell tabs. Choose between tinting all particles by a single color or creating a gradient tint that changes color over time. You can also choose to apply a Library gradient to the particles. Tinting particles applies the tint color uniformly over the entire object.

Create Graphics With an Alpha Channel
Always create graphics that you want to use as cells with predefined alpha channels. For more information on importing files with alpha channels, see “More About Alpha Channels” on page 173.

Creating Animations To Use as Cells
You can also use QuickTime movies as cells. For example, you can create an animation in Motion, render it as a QuickTime movie, and import it into another Motion project to use as a cell. In general, the same recommendations for creating still graphics apply to the creation of animation or video clips you intend to use as cells, but there are additional considerations.
Create Clips That Loop
Particles created from QuickTime clips loop over and over for the duration of each individual particle's life. If the clip you use doesn't loop well, there will be a jump cut at every loop point. Another option is to use very short movies to introduce randomness into the appearance of the particle system.

Use Video Clips With Minimal Compression
Ideally, QuickTime clips to be used as particles should be saved using a high-quality codec, such as Animation or Uncompressed 8- and 10-bit 4:2:2. Other codecs can be used, but they may introduce unwanted artifacts depending on the level of compression used.

There is also an option to use random start frames so that the particles do not all use the same frame of the clip at the same frame in the project, as well as an option to play or not play the clip. For more information, see “Additional Cell Parameters for QuickTime Movies” on page 606.

Advanced Particle System Controls
While the Dashboard provides a fast way to modify a particle system's main parameters, the particle system's Emitter and Particle Cell tabs in the Inspector give you total control over every aspect of that particle system. This includes individual parameters for each cell in a system.

The Difference Between Emitter and Particle Cell Parameters
Emitter and Particle Cell parameters, though closely related, serve different purposes. Emitter parameters control the overall shape and direction of the animated mass of particles generated by the system. Other emitter parameters simultaneously modify the parameters of all cells inside that emitter.

Particle Cell parameters, on the other hand, control the behavior of particles generated from each cell that's inside the particle emitter. For more information, see “Particle Cell Parameters” on page 608.

When only one object is used as a particle cell source, the cell controls appear in the Emitter tab as well as in the Particle Cell tab. Once more than one object is added to a Particle Emitter, all cell controls appear in the Particle Cell tab. To access this tab, the cell must be selected in the Layers tab or Timeline.
Emitter Parameters

Several parameters in the Emitter tab are identical to those found in the Emitter Dashboard, with one difference. While the Emission control in the Emitter Dashboard allows you to manipulate the Range, Angle, and Speed parameters using a single, graphical control, the Emitter tab lists individual controls for each parameter.

Note: There is no way to directly control the animation of individual particles.

Important: The emitter parameters in the Properties and Emitter tabs can be keyframed to change values over time.

Curve Appearance in the Keyframe Editor

The selected object determines what curves appear in the Keyframe Editor (when Animated is selected from the Show pop-up menu in the Keyframe Editor list):

- Select the emitter to display animated emitter parameters such as Position and Rotation in the Properties tab, or Emission Angle and Range in the Emitter tab.
- Select the cell to display animated parameters in the Cell Controls section of the Emitter tab, such as Birth Rate, or Angle.

Note: To manually send an animated parameter to the Keyframe Editor, click the parameter’s Animation menu, then choose Show In Keyframe Editor.

The parameter is displayed in the Keyframe Editor in a new, untitled curve set.
To open a particle system’s Emitter tab:
1 Select an emitter object.
2 In the Inspector, click the Emitter tab.
   The Emitter parameters appear.
   The contents of the Emitter tab are dynamic, and different parameters appear depending on the number of cells in the particle system as well as the emitter shape that’s used.

Single Cell vs. Multi-Cell Emitter Parameters
At first glance, many of the parameters in the Emitter tab appear to mirror identically named parameters in the Particle Cell tab for each cell within that system.
If a particle system has only one source cell, the Emitter tab displays all of the parameters for the cell, as well as the emitter’s own parameters. In this case, you can control every aspect of the particle system directly from this single tab, which saves you from having to go back and forth between the Emitter and Particle Cell tabs.
If a particle system has two or more cells, the Emitter tab looks much different. The list of parameters is much shorter, and the majority of the cell parameters are replaced with a smaller group of master controls.
Changes made using the master controls modify the effect of each cell's parameters relative to the other cells in the system. This means that for a particle system with three cells that have different Scale values, increasing the Scale parameter in the Emitter tab multiplies the Scale value of all three cells by the same percentage. This has the result of increasing or reducing the size of every particle in the system, while keeping the size of each particle relative to one another the same.

For this reason, the master control parameters of multi-cell particle systems appear as percentages, as they represent the percent by which each cell's parameter values are affected.

**Options in the Emitter Shape Parameter**
The first parameter in the Emitter tab is the Shape pop-up menu. The nine options in this pop-up menu significantly alter the distribution of generated particles. When you choose an emitter shape, different Emitter parameters appear that are unique to that shape. For example, when Rectangle is the selected Emitter Shape, the Outline, Tile Fill, and Random Fill options become available in the Pattern options. When Spiral is the selected Emitter Shape, the Pattern options go away and new parameters such as Radius, Number of Arms, and Twists become available. These different parameters provide additional control over the distribution of particles.

**Point:** This is the simplest emitter shape and is the default shape for newly created emitters. It specifies a single point of emission for a particle system. There are no additional parameters for the Point shape.
Line: Particles emerge from a line. Using the onscreen controls (with the Adjust Item tool) or the Inspector, you can specify the length and location of the line. In the Inspector, you can set a specific number of points from which particles emerge. This emitter shape is good for creating sheets of particles that cascade over a wide area. The Line shape displays additional Start Point, End Point, Emit at Points, and Offset parameters.

Rectangle: Particles emerge from a rectangle along its edge, or in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the rectangle. Drag the corners to adjust width and height; drag edges to adjust width or height independently. Depending on the selected Pattern, the Rectangle emitter shape displays additional parameters. In the following image, the Emitter shape fill Pattern is set to Outline.

Use the following modifier keys to more precisely manipulate the corners of the Rectangle onscreen controls:

- **Option**: Adjustments to size are scaled uniformly, with the anchor point remaining fixed.
- **Shift**: Adjustments to size are made proportionally.
Circle: Particles emerge from a circle-shaped emitter. Particles can be emitted in an Outline, Tile Fill, or Random Fill pattern. This emitter shape is good for surrounding an element in a composition with particles that emerge from its edge. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the circle. Depending on the selected Pattern, the Circle emitter shape displays additional parameters. In the following image, the shape's Pattern is set to Outline.

![Circle Emitter Example](image)

Burst: Particles emerge from a burst pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the burst. The Burst shape displays additional Radius, Number of Arms, Emit At Points, and Offset parameters.

![Burst Emitter Example](image)
**Spiral:** Particles emerge from a spiral pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the spiral. The Spiral shape displays additional Radius, Twists, Number of Arms, Emit At Points, and Offset parameters.

![Spiral Image](image)

**Wave:** Particles emerge from a waveform. Using the onscreen controls (with the Adjust Item tool) or the Inspector, you can specify the length and location of the wave. The Wave shape displays additional Start and End Point, Amplitude, Frequency, Phase, Emit At Points, and Offset parameters.

![Wave Image](image)
**Geometry:** Particles emerge from the edge of a shape, defined by a spline object used as the shape source. The Geometry shape displays additional Shape Source, Offset, and Emit at Points parameters.

**Image:** Particles emerge from within an area defined by an image. The image may or may not have an alpha channel. If it does, the shape of the alpha channel can also be used to define the emitter shape. The Image shape displays additional Image Source, Emission Alpha Cutoff, Offset, and Points parameters. Certain Pattern selections also expose additional parameters.

**Emitter-Only Parameters**

The following parameters appear depending on what is selected in the emitter Shape pop-up menu. They apply only to emitters, and affect the overall shape that particle systems take by controlling the flow of particles.

**Offset** (not applicable to Point Emitters, Tile- or Random-Filled Rectangles, Circles, or Images): Offsets either the emitter itself or the particles generated on the shape. For example, when the emitter Shape is a Line, changing the Offset value moves the emitter’s position in the Canvas. When the emitter Shape is a Rectangle and Pattern is set to Outline, changing the Offset value moves the particles along the edge of the shape.
**Pattern** (Rectangle, Circle, Image): Specifies how the particles are generated from the selected pattern. The pattern options are:

- **Outline**: Emits particles along the edge of the shape.
- **Tile Fill**: Emits particles from a tiled pattern of rows and columns within the circle, rectangle, or image. You can specify the number of columns and rows, as well as the Tile Offset.
- **Random Fill**: Emits particles randomly from within the circle, rectangle, or image.

**Size** (Rectangle): Defines the size of the rectangle from which particles are emitted. This parameter is available whether the Pattern is set to Outline, Tile Fill, or Random Fill.

**Note**: The Height is measured in project pixels, however, the Width is measured in square pixels. This is done so that a shape which is numerically square will look square when “Correct for Aspect Ratio” is turned on in the View pop-up menu in the top-right corner of the Canvas.

**Points** (Line, Rectangle, Image, or Circle [Outline or Random Fill], Burst, Spiral, Wave, Geometry): Defines the number of points from which particles are emitted. For Rectangle or Circle shapes, the particles are emitted from evenly-distributed points along the edge of the shape when Outline is selected from the Pattern pop-up menu. When the Adjust Item tool is selected, the points are visible in the Canvas.

**Note**: Using a large number of points slows your computer’s processing time.

**Emit At Points** (Line, Rectangle or Circle [Outline], Burst, Spiral, Wave, Geometry): When turned on, particles emerge from a limited number of points (as defined in the Points parameter). When turned off, particles may emerge from anywhere on the line or edge. When the Adjust Item tool is selected, the points are visible in the Canvas.

**Radius** (Circle, Burst, Spiral): Defines the size of the shape from which particles are emitted.

**Tile Offset** (Rectangle, Circle, Image): This parameter appears when Tile Fill is selected from the Pattern pop-up menu. Values from 0 to 100 percent offset the rows toward the right, and values from 0 to −100 percent offset the rows toward the left. A value of 50 or −50 percent creates a “brickwork” pattern.

**Columns** (Rectangle, Circle, Image): When Tile Fill is selected, this parameter specifies the number of horizontal emitter points on a grid over the selected emitter shape. In the case of an irregular shape (nonrectangular), grid points that fall outside of the shape are ignored.

**Rows** (Rectangle, Circle, Image): When Tile Fill is selected, this parameter specifies the number of vertical emitter points on a grid over the selected emitter shape. In the case of an irregular shape (nonrectangular), grid points that fall outside of the shape are ignored.
Number of Arms (Burst or Spiral): Defines the number of branches from which particles are emitted. The default value is 3.

Twists (Spiral): Defines the number of turns in the spiral. The default value is 0.25.

Amplitude (Wave): Defines half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.

Start Point (Line, Wave): Two sliders that define, in X and Y coordinates, the first point of the line used as the emitter shape.

End Point (Line, Wave): Two sliders that define, in X and Y coordinates, the second point of the line used as the emitter shape.

Shape Source (Geometry): An object that defines the shape of the emitter. Spline objects may be dropped onto this control to assign the desired shape.

Image Source (Image): An object that specifies the image used to define the shape of the emitter. Any image or movie clip can be dropped onto this control to assign the desired shape.

Emission Alpha Cutoff (Image): When the Image Source object contains an alpha channel, this slider defines the minimum opacity value that is necessary to create particles at that point on the source image. For example, when set to 25 percent, particles appear only where the alpha value of the image is equal to or greater than 25 percent opacity. The lower the Emission Alpha Cutoff value, the more particles appear. In order for this parameter to be effective, the alpha channel needs to have areas of varying transparency.

Emission Angle (all shapes): A dial that sets the direction in which particles travel. This parameter works in conjunction with the Emission Range parameter. It is equivalent to one of the functions of the graphical Emission control in the Dashboard. This parameter is unique to the emitter object.
Note: When using an emitter shape other than a point, such as a line, circle, rectangle, spiral, burst, or wave, setting the Emission Angle parameter to 0 degrees restricts the emission of particles to the outside of the shape. Setting the Emission Angle to 180 degrees restricts the emission of particles to the inside of the shape.

Emission Range (all shapes): A dial that restricts the area around the center of each emission point into which particles are generated, in the direction of the Emission Angle. It is equivalent to one of the functions of the graphical Emission control in the Dashboard. This parameter is unique to the emitter object.

Note: When using a line, circle, rectangle, spiral, burst, or wave (but not geometry), setting the Emission Range parameter to 0 degrees keeps particles perpendicular to the emitter when they emerge.

Render Order: A pop-up menu that determines whether new particles are drawn on top of or underneath particles that have already been generated. There are two options:

• Oldest First: New particles appear on top of older particles.
• Oldest Last: New particles appear underneath older particles.

Interleave Particle Cells: Turning this checkbox on mixes particles generated from multiple cells together. Turning this checkbox off layers particles in the same order as the cells that generate them.

Note: This option has no effect with particle systems containing only one cell. Leaving this option off will speed rendering with multiple cells.

Single-Cell Emitter and Particle Cell Parameters
The following parameters apply to the creation and motion of the individual particles generated by each cell within an emitter.
Birth Rate: A slider that defines the birth rate of the cell. In other words, this parameter defines how many particles of this cell emerge from the emitter every second. Higher values create denser particle effects.

Birth Rate Range: A slider that defines an amount of variance in the Birth Rate of generated particles. A value of 0 results in no variance—particles emerge from the emitter at the same rate. A value greater than 0 introduces a variance defined by the the Birth Rate parameter, plus or minus a random value falling within the Birth Rate Range. This parameter is not available if the emitter contains more than one particle cell.

Initial Number: A slider that defines the initial number of particles. This parameter determines how many particles of this cell appear at the first frame of a particle effect. The result is an initial burst of particles that eventually evens out according to the Birth Rate parameter.
Life: A slider that defines the duration of every particle, in seconds. This specifies how long each particle lasts before vanishing from existence. This is similar to how sparks disappear after flying away from a sparkler. Unless the Color Over Life or Opacity Over Life parameters are used to fade each particle out over its life, particles immediately vanish at the end of their lifetimes.

Life Range: A slider that defines an amount of variance in the life of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same lifetime. A value greater than 0 introduces a variance defined by the Life parameter, plus or minus a random value falling within the Life Range. This parameter is not available if the emitter contains more than one particle cell.

Speed: A slider that defines initial speed. This determines how quickly each particle flies away from the emitter. This, in conjunction with the Life and Birth Rate parameters, determines how many particles appear in the Canvas at any given frame. It is equivalent to one of the functions of the graphical Emission control in the Dashboard.

Speed Range: A slider that defines an amount of variance in the speed of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same speed. A value greater than 0 introduces a variance defined by the Speed parameter, plus or minus a predetermined random value falling within the Speed Range. This parameter is not available if the emitter contains more than one particle cell.

Angle: A dial that defines the angle of rotation, in degrees, at which new particles are created. This parameter is not available if the emitter contains more than one particle cell.

Angle Range: A dial that defines an amount of variance in the angle of generated particles. This parameter is not available if the emitter contains more than one particle cell.
Spin: A dial that animates particles in a system by initially spinning each individual particle around its center. Adjustments to this control are in degrees per second. This parameter is not available if the emitter contains more than one particle cell.

Spin Range: A dial that defines an amount of variance in the spin of generated particles. A value of 0 results in no variance—all particles from the selected cell spin at the same rate. A value greater than 0 introduces a variance defined by the Spin parameter, plus or minus a random value falling within the Spin Range. This parameter is not available if the emitter contains more than one particle cell.

Additive Blend: By default, particles are composited together using the “normal” blend mode. Turn on this checkbox to composite all overlapping generated particles together using the Additive blending mode. This occurs in addition to whichever compositing method is already being used. The result is that the brightness of overlapping objects is intensified. This only applies to the particle system itself—the blend mode of the emitter determines how the result of the emitter is blended into the scene. This parameter is not available if the emitter contains more than one particle cell.

Color Mode: A pop-up menu that determines if and how particles are tinted. This parameter is not available if the emitter contains more than one particle cell. There are five options:
• **Original**: Particles are generated using their original colors. When Original is chosen, the Opacity Over Life parameter appears. This parameter is a gradient control that allows you to animate changes to the opacity of particles over their lifetime.

![Image of Original particles]

• **Colorize**: Particles are tinted using the color specified in the Color parameter. Additional Color and Opacity Over Life parameters appear.

![Image of Colorize particles]

• **Over Life**: Particles are tinted based on their age. The Gradient Editor defines the range of color that each particle assumes as it ages, beginning with the leftmost color in the gradient, and progressing through the range of colors until finally reaching the rightmost color at the end of its life. An additional control at the top functions as an Opacity Over Life control.

![Image of Over Life particles with Gradient Editor]

**Note**: For more information on using the gradient controls, see “Using the Gradient Editor” on page 485.
• **Pick From Range:** Particles are tinted at random, with the range of possible colors defined by the Gradient Editor. A point on the gradient is randomly chosen, so the relative sizes of each color region determine the frequency of the color being used.

![Gradient Editor](image)

• **Take Image Color:** When you choose this mode, each new particle’s color is based on the color of the image at the position where the particle was generated. This mode is only available with Image Emitter Shapes.

**Scale:** A slider that defines the scale of every particle of a cell. Click the disclosure triangle next to the Scale parameter to reveal separate X Scaling and Y Scaling subparameters, which can be used to scale the width and height of generated particles separately. This is the initial scale of the particle (compared to the Scale Over Life behavior).

![Scale Comparison](image)

**Note:** When you use an image as a particle cell source and set a low Scale value, it is recommended that you set the Antialiasing Method in Project Preferences to Best. See “Preferences” on page 107 for more information.
Scale Range: A slider that defines an amount of variance in the scale of generated particles. A value of 0 results in no variance—all particles from the selected cell emerge with the same size. A value greater than 0 introduces a variance defined by the Scale parameter, plus or minus a random value falling within the Scale Range. The disclosure triangle of the Scale parameter reveals separate X and Y subparameters, which can be used to set the width and height of the Scale Range separately. This parameter is not available if the emitter contains more than one particle cell.

Attach To Emitter: A slider that determines how closely particles follow the position of a moving emitter. If it is set to zero, particles follow their own path after being emitted, resulting in a trail of particles that trails along the motion path the emitter is following. If it is set to 100, in the absence of other behaviors, all generated particles follow along with the emitter, surrounding it in a moving cloud of particles. This parameter is not available if the emitter contains more than one particle cell.

Show Particles As (single cell emitter/particle cell parameter): You can view particles in one of a variety of preview modes, or as they actually appear. These nonimage modes play more efficiently when viewing a complex particle system and also provide other ways of analyzing particle motion. By default, this parameter is set to Image, which displays each particle as it is supposed to appear. This parameter is not available if the emitter contains more than one particle cell. There are four options from which to choose:
• **Points:** Each particle is represented by a single point. This is the fastest preview mode and is useful for displaying the type and speed of particle motion in a system. When selected, the Point Size parameter is revealed.

• **Lines:** Each particle is represented by a line. This is a good preview mode to use to analyze the vector of each particle’s motion. The length of each line is determined by that particle’s speed, and the angle of each line equals each particle’s direction.
• **Wireframe**: Each particle is represented by a bounding box. Since the bounding boxes are good indicators of each particle’s orientation in the system, this preview mode is useful for evaluating the movements of individual particles. For example, it’s easy to see the angle of rotation for particles that are spinning or following a complex motion path.

![Wireframe Image]

• **Image**: The final particle system effect, as it appears in your final render.

![Image]

**Random Seed**: Although particle systems seem random, they’re actually deterministic. This means that the random variation in each particle system is created based on the number shown here. Unless this seed number is changed, a particle system with the same parameter settings always plays back with the same motion. If you don’t like the current random motion or distribution of the particle system, you can change the seed number by typing a new number or clicking Generate. This changes the random calculations performed for that system. This parameter is not available if the emitter contains more than one particle cell. For more information about the random nature of particle systems, see “The Predictability of Particle Systems” on page 574.

**Particle Source or individual cells**: In particle systems with more than one cell, each cell appears at the bottom of the Emitter tab. Each cell parameter has a checkbox you can use to enable or disable that cell, a name field, and an image well for that object.
Additional Cell Parameters for QuickTime Movies

If you create a particle system using a QuickTime object as a cell, additional parameters appear. These four parameters are:

Animate Image: A checkbox that controls playback. If it’s turned on, it loops the playback of the animation or movie clip used to generate each particle. If it’s turned off, particles are generated using the still frame specified by either the Random Start Frame parameter or the Source Start Frame parameter.

Random Start Frame: A checkbox that introduces variation into animated particles generated from QuickTime objects. If it’s turned on, each newly generated particle begins at a different frame of the animation. Stills are chosen randomly if Animate Image is turned off.

Source Start Frame: Chooses the frame to begin animation, if Animate Image is turned on, or the still frame to display if Play Frames is turned off. This parameter only appears if Random Start Frame is turned off.

Hold Frames: The number of times each frame of the source movie is repeated during playback. The larger the Hold Frames value, the slower your playback.

Hold Frames Range: Varies the number of frames to “hold.” See the Hold Frames parameter description.
Additional Cell Parameters Based on the Selected Color Mode
Each of the options in the Color Mode pop-up menu displays a different set of parameters.

Color: A color well available when the Color Mode is set to Colorize. Use it to specify a color to use to tint the particles. You can also modify each particle’s alpha channel, altering its opacity. This parameter is unique to the cell object. You can either click the color well to choose a color, or open the disclosure triangle and use the Red, Green, Blue, and Alpha channel sliders.

Opacity Over Life: A gradient control that appears when Color Mode is set either to Original or Colorize. Use it to change the opacity of particles based on their age. This gradient control is limited to grayscale values, which are used to represent varying levels of transparency. White represents solid particles, progressively darker levels of gray represent decreasing opacity, and black represents complete transparency. A simple white to black gradient represents a particle that is solid when first generated, but which fades out gradually over its lifetime until finally vanishing at the end. The Opacity Over Life parameter has four controls:
  • Gradient Preset pop-up menu: Gradients from the Library (default or custom) appear in this pop-up menu. Choose a gradient from this menu to load it into the Gradient Editor. None of the default gradients have opacity gradients.
  • Opacity bar: To add a new opacity tag to the gradient, click anywhere within the opacity bar. Click an opacity tag to select it, and then change its value with the Opacity slider. To change the distribution of opacity, drag an opacity tag along the opacity bar, or select an opacity tag and use the Location slider. Change the spread of color between two gradient tags using the spread controls (triangles). To delete a gradient tag, drag it away from the gradient bar until it disappears.
  • Opacity slider: Changes the shade of a selected gradient tag, from 100 (opaque/white) to 0 (transparent/black).
  • Location slider: Changes the location of the selected gradient tag relative to the gradient bar.

Color Over Life: A gradient control that appears when the Color Mode is set to Over Life. Use it to change the color of generated particles based on their age. When born, particles are tinted with the leftmost color in the gradient. Over their lives, their color changes through the range of the gradient, from left to right, until finally reaching the rightmost color at the end of their lives. Similar to the Opacity Over Life parameter, the Color Over Life parameter has five controls:
  • Gradient Preset pop-up menu: Gradients from the Library (default or custom) appear in this pop-up menu. Choose a gradient from this menu to load it into the Gradient Editor.
  • Opacity Gradient control: A gradient control that allows you to change the opacity of generated particles based on their age. All color tags are limited to shades of gray.
• **Color Gradient control:** A gradient control that allows you to tint particles based on their age.

• **Color control:** When a color tag is selected in the Color Gradient control, you can change its color by either clicking the color well and choosing a color using the Colors window, or **Option**-clicking the well and using the pop-up color palette.

• **Opacity slider:** When an opacity tag is selected in the Opacity Gradient control, you can use this slider to change its shade, from 100 (opaque/white) to 0 (transparent/black).

• **Location slider:** Changes the location of the selected gradient tag or spread control relative to the gradient bar.

**Color Range:** A gradient control that appears when the Color Mode is set to Pick From Range. Use it to define a range of colors used to randomly tint new particles. The direction of the gradient colors is not relevant, only the number of colors that appear within the gradient. The Color Range parameter has the same controls as the Color Over Life parameter.

*Note:* For more information on how to use gradient controls, see “Using the Gradient Editor” on page 485.

**Particle Cell Parameters**
Parameters in the Particle Cell tab control the behavior particles generated by the system of this cell, independently of the parameters governing the emitter. In particle systems with multiple cells, each has its own particle cell parameters. This lets you create particle systems made up of many kinds of particles, each with distinctly different behaviors.

**To open a cell’s Particle Cell tab:**
1. Select any cell within an emitter in the Layers tab or Timeline.
2. In the Inspector, click the Particle Cell tab.
The Particle Cell parameters appear.
Animating Objects in Particle Systems
You can animate any emitter or cell parameter in a particle system by using Parameter behaviors or by keyframing them. If you animate emitter-specific parameters such as Emission Angle or Emission Range, the position and distribution of new particles generated by that emitter are animated. All animation occurs relative to the duration of the emitter. This works the same way for cell parameters and emitter parameters. If the parameters are animated, then it only affects how particles are created. It does not affect existing particles.

Animating an emitter's Properties tab parameters is useful for altering the position and geometric distribution of a particle system over time. Keyframing an emitter object's Position parameter moves the source of newly emitted particles without affecting any particles that were generated at previous frames, which creates a trail of particles.

Keyframing an emitter’s Emitter tab parameters is a good way to modify the particle system’s overall characteristics over time, such as increasing or decreasing the size, speed, or lifetime of newly generated particles.

For an example of a keyframed emitter object in a particle system, see “Example 2: Creating Animated Pixie Dust” on page 615. For more information on keyframing parameters in the Curve Editor, see “Keyframes and Curves” on page 401.

Using Behaviors With Particle Systems
You can add behaviors to a particle system's emitter, or to the cells themselves, to quickly achieve sophisticated, organic effects with very little effort.

Applying Behaviors to Emitters
Attaching the Motion Path and Snap Alignment to Motion behaviors to an emitter affects the position of the source of all new generated particles. Throw and Spin affect the position and rotation, respectively, of the emitted particles, unless Affect Objects is turned off.

With all Basic Motion Behaviors, once individual particles emerge, they’re unaffected by changes to the position of the emitter. This means that moving the emitter around the screen using behaviors results in the creation of a trail of particles that behave according to their particle cell parameters.

Note: This effect can be overridden by turning on a cell’s Attach to Emitter parameter.

To apply a behavior to an emitter:
- Drag a behavior from the Library onto an emitter in the Canvas, Layers tab, or Timeline. The behavior is applied to the emitter, which begins to move according to the parameters of the behavior.
Note: Not all behaviors instantly activate an object when applied. For example, when a Throw behavior is applied to an object, the Throw Velocity parameter must be adjusted before the object moves.

Applying Behaviors to Cells
Simulation behaviors that are applied directly to cells are in turn applied to each individual particle generated from that cell. This can result in some extremely complex animations as dozens of particles move according to the behaviors you’ve defined. Behaviors applied to cells have no effect on the position of the emitter. Parameter behaviors on a cell only affect particles when they are created.

To apply a behavior to a cell:

- Drag a behavior from the Library to a cell in the Layers tab or Timeline. The behavior is applied to the cell, and all particles generated from that cell begin to move according to the parameters of the behavior.

Tip: If you do not see your expected result when applying behaviors to particle cells, try turning the Affect Objects parameter on or off, or selecting a different option from the Affect pop-up menu. These parameters determine whether the entire object (such as the particle emitter) or its components (such as the particle cells) are affected by the behavior and how an object interacts with surrounding objects, respectively.

Note: The Affect Objects checkbox only appears in the Inspector when the Throw and Spin behaviors are applied to an object that contains multiple objects, such as a layer, particle emitter, or text.

The Particles Behavior Category
There is one category that contains a behavior specifically for use with the cells or emitter in a particle system. The Particles category contains the Scale Over Life behavior. This behavior lets you grow or shrink the particles in a system over the duration of each particle’s life. It has one main parameter, and three optional parameters that appear depending on the Increment Type option that’s chosen:

Increment Type: Choose which method is used to resize particles generated with a particle effect. There are three options to choose from.

- Rate: Specifies a steady rate at which particles change size over their entire lifetimes. A Scale Rate parameter appears in the Inspector (and becomes available in the Dashboard), allowing you to define how quickly each particle changes size. Positive values grow particles over time, while negative values shrink particles over time.
• **Birth and Death Values**: Specify starting and ending scale percentages that are used to animate each particle's size over its lifetime. Two parameters appear in the Inspector (and become available in the Dashboard) when this option is selected. Scale At Birth determines the initial size of particles when they are first created. Scale At Death determines the size of each particle at the end of its lifetime. The scale amount generated by this behavior for a specific particle at a specific time is multiplied by the pre-existing particle Scale.

• **Custom**: Displays the Custom Scale parameter in the Inspector (and becomes available in the Dashboard), allowing you to set the size of each particle generated by that cell. You can attach a parameter behavior to this parameter to create different animated effects, or keyframe the parameter. The duration of the behavior is treated as the particle's lifetime. For more information on using Parameter behaviors, see “Parameter Behaviors” on page 354.

### Applying Filters to Particle Systems

Filters can only be applied to a particle system's emitter. As a result, filters always affect the entire particle system, including every single cell, as if it was a single object. Individual cells cannot have separate filters applied to them.

For more information on applying filters to objects in your project, see “Using Filters” on page 701. For more information on keyframing particle system parameters, see “Animating Objects in Particle Systems” on page 610.
Particle System Examples
This section presents two examples of how to use particle systems to create very different effects.

Example 1: Creating an Animated Background
This first example describes how to create an animated background using a single still image. By using the parameters available in the Emitter tab, a single image can be turned into a complex animated texture.

To create an animated background from a single image:
1. Drag a file into the Canvas. This example uses a simple graphic with a premultiplied alpha channel.

2. With the new object selected, click the Make Particles icon in the Toolbar to turn it into an emitter (or press E).

The original object is replaced with an emitter, but nothing happens yet because the playhead is at the first frame of the project, and only one particle has been created.

3. In the Emitter tab of the Inspector, choose Circle from the Shape pop-up menu.
4. Choose Tile Fill from the Pattern pop-up menu.
5 Set the Initial Number parameter to 12. This creates a distributed group of particles that partially fills the Canvas.

![Image of distributed particles]

6 To turn the particles into a uniform abstract mass, adjust the following parameters:
   - Set Life to 4.
   - Set Speed to 140.
   - Turn the Spin dial to 60.
   - Turn the Spin Range dial to 15.
   - Turn on Additive Blend.
   - Set Color Mode to Pick From Range.
   - Set Scale to 65 percent.
   - Set Scale Range to 150.
   - Set Random Seed to 10000.

Advance to frame 100. The resulting image now looks like this:

![Image of uniform abstract mass]
7 An additional step might be to apply a filter to the emitter. In this example, adding the Crystallize filter creates an even more abstract effect. You might also consider adjusting the color gradient, or applying color correction to make the background fit more appropriately with your foreground elements.

Example 2: Creating Animated Pixie Dust
This example shows you how to create a particle system that uses two different cells to generate a streak of particles that trails behind another animated object. Using two cells adds more variation to a particle system than can be achieved with a single set of cell parameters.

To create a two cell particle system that leaves a trail:
1 Drag the first image file into the Canvas. This example uses the Flare01.png image from the Particle Images subcategory in the Content Library category. This is a small image of a lens flare against black, with a built-in alpha channel.

2 While the flare object is selected, click the Make Particles icon in the Toolbar to turn it into an emitter (or press E).
The original object is replaced with an emitter, but nothing happens yet because the playhead is at the first frame of the project, and only one particle has been created. Move the playhead forward a few seconds to view the particle system at a frame where more particles have been generated. This allows you to see the particle system in action without having to play it.

3 To create a variety of particles, place one more image into the emitter you just created. The easiest way to do this is to open the Layers tab, and drag each additional file you want to use into the layer containing the emitter. Next, drag the new object either onto the emitter, or below it (but not onto an existing cell, which does a “replace source object”). This example uses the Spark12.png file, also located in the Content folder in the Library.

This results in the following image:
4 To make the particles generated by each different cell mingle together, select the emitter, open the Inspector, and turn on the Interleave Particles parameter.

5 Now, select the Flare01 cell in the Layers tab to adjust its parameters, which automatically appear in the Inspector.

6 Adjust the Scale slider to 10 to reduce the size of the particles generated by this cell.

7 Select the Spark12 cell in the Layers tab (the Inspector automatically updates to show its parameters) and set the scale to 60.

The resulting image should look approximately like this:
8. Next, change the color of the particles generated by the Spark12 cell by doing the following:
   a. Choose Colorize from the Color Mode pop-up menu.
   b. Click the color well in the Color parameter that appears.
   c. Choose a light red color in the Colors window.
   d. Close the Colors window.

   All particles generated by that cell are now red.

9. Use the Opacity Over Life gradient to make this cell’s particles fade out over their life.

10. To make the spark particles spin as they move away, turn the dial in the Spin parameter clockwise, to 60 degrees.


12. Follow the procedure in Step 8 to make these particles light yellow.
To make the particles generated from this cell spin in the opposite direction, turn the dial in the Spin parameter clockwise, to -60.

To create a trail of particles, the emitter needs to be animated to follow the required motion path. Follow the following steps to create a motion path for the particle system.

a. Place the playhead at frame 1.
b. Click the Record button (or press A) to turn on animation recording.
c. Drag the particle system to the lower left corner of the screen.
d. Click the Play button to begin playback.
e. As playback occurs, drag the particle system towards the upper right corner.
f. Stop playback and click the Record button to disable animation recording.

The results should look something like this:

You may want to adjust the Emitter parameters for Birth Rate, Life, and Speed to customize the effect to your liking.

Saving Custom Particle Effects to the Library
Once you have created a particle system that you are particularly proud of, you can save it as a particle preset in the Particles or Favorites folders of the Library for future use. Once you place them in the Library, particle presets can be used just like any other particle preset.
To save a particle system to the particle Library:

1. Open the Library and select either the Particles, Favorites, or Favorites Menu category.
2. Drag the emitter object you want to save into the stack at the bottom of the Library.

Note: For organizational purposes, you may find it useful to create a new folder of your own in the Favorites or Favorites Menu category to store your particle systems.

When you save a particle preset, it’s saved as a file in the Home/Library/Application Support/Motion/Library/Particle Emitters folder. Any custom objects that you used to create that particle system also appear here.

You can copy particle presets you create from this location to give to other Motion users, or you can add particle presets that are given to you to this same folder. Whenever you copy a particle preset file, you should make sure that you also copy any graphics or movie files that it uses as well.
Using the Replicator

The Replicator allows you to easily create patterns of repeating elements that can be quickly animated in mechanical or organic ways.

Patterns of repeating elements are prevalent in various types of motion graphics projects, including television title sequences, news graphics, bumpers, and commercials. This type of graphic—created through the careful duplication of elements, followed by animating those elements with keyframes—is usually very time consuming.

The replicator in Motion is specifically designed to quickly and fluently build such patterns of repeating elements, including video, still images, shapes, or other objects in a Motion project. For example, with very few clicks of your mouse you can create a “video wall” from a QuickTime movie, a spinning pinwheel, or other mesmerizing graphics.

Footage provided courtesy of National Geographic Television and Film Library
Once you have replicated an object, you can quickly change the shape of the pattern and animate its elements by animating the replicator parameters. You can also use behaviors to animate many of the replicator parameters. In addition, the replicator has a special behavior that allows you to animate the pattern’s elements in sequence over the pattern.

The Difference Between the Replicator and a Particle System

Although the replicator and particle systems share many of the same parameters, they are very different tools. While both use objects (shapes, text, images, and so on) as cell sources and generate elements from those cells along or within a shape such as a circle, line, or spiral, the cells are used differently by each tool. A particle system uses the cell source as the “mold” for the particles that are generated by the emitter. As mentioned in Chapter 13, Working With Particles, if you imagine that a garden hose is a particle system, the nozzle acts as the emitter, while the water represents the flow of particles. Particles are animated over time by default—they are born, move away from the emitter, and die. The particle system is not designed for pattern-based replication purposes.

In a replicator, elements are not emitted (they do not have “birth rate,” “life,” or “speed” parameters) like particles. The replicator simply builds a pattern of static copies of a source object in a shape and arrangement that you specify. Although the replicated objects (elements) are static by default, the replicator parameters can be animated. In a simple example, a star object is used as the source and replicated along the outline of a circle. The Offset and Color parameters can be keyframed so the stars travel around the circle while changing color.

The replicator also has a special behavior called Sequence Replicator that allows you to sequence parameters, such as position, scale, and opacity, over the pattern of elements. How the animation moves through the replicator pattern is determined by the build style or origin of the replicator, as well as the parameters of the Sequence Replicator behavior. This behavior works very similarly to the Sequence Text behavior. For more information on using the Sequence Replicator behavior, see "Using the Sequence Replicator Behavior" on page 681.
You can replicate nearly any object in Motion, including images, shapes, text, movies, and image sequences. You cannot replicate a particle emitter or replicator objects. Each element that is created is essentially a duplicate of the source object. Unlike the particles of a particle system, however, the elements are not animated over time by default.

The object you use as the source for a replicator's cells helps determine the look of the replicator pattern. A single replicator can contain multiple source objects, resulting in different cells in the same pattern and arrangement.

The Anatomy of the Replicator
When you replicate an object, two new objects appear in the Layers tab:

- A replicator object that controls the onscreen pattern as a whole.
- A cell object that controls the individual elements in the pattern.

Chapter 9  Using the Replicator
Each cell appears under of the Replicator object in the Layers tab and Timeline Layer list. Once replicated, the source object remains in its original position in the Layers tab. If you clicked Replicate in the Toolbar (or chose Objects > Replicate), the source object is disabled by default. If you dragged the source object to an existing replicator object, the source object remains enabled.

The replicator and cells have separate sets of parameters that control the look of the elements. If you imagine the replicator as the “pattern,” the cells (and their elements) are the “stitches” of that pattern. The pattern is created by selecting a shape on which to arrange the elements. Changing the parameters of the replicator changes the shape on which the elements are arranged, while changing the cell’s parameters affects each individual element in the replicator, such as its angle, color, and scale.
The replicator parameters are dynamic—different parameters appear depending on what shape is selected. For example, when Rectangle is the selected shape, parameters appear that allow you to define the size of the rectangle, the number of rows and columns in the rectangle, as well as the origin of the elements in the rectangle (if the elements are arranged from the center outward, from right to left, and so on). When Spiral is the selected shape, parameters appear that allow you to define the radius of the spiral, the number of twists and arms in the spiral, the number of points (the location on the shape in which the element sits) per arm, as well as the origin of the elements in the spiral (from the center outward, or from the edge inward).
Further, different parameters are also available depending on the selected arrangement for the shape. In the following image, notice that the Columns, Rows, and Tile Offset parameters are replaced with the Points and Offset parameters when the rectangle arrangement is changed from Tile Fill to Outline.

Very different looks can be achieved by changing only a few parameters.

As with any effect in Motion, replicator parameters can be keyframed in order to change a pattern’s dynamics over time. For example, you can create a wave of dots that follow one another across the screen by keyframing the replicator’s Offset parameter.
In addition, you can add behaviors to the replicator or its cells to create even more varied effects (simulation behaviors can be especially effective). Behaviors applied to a replicator or a cell can be applied to each element of the pattern. This lets you achieve almost limitless variation and complexity that would take hours to animate using keyframes. You can also apply a behavior to another object in your project (an object that is not part of the replicator pattern), such as Vortex, and have the pattern elements circumnavigate that object.

**Replicator Source Objects**
Almost any object in Motion can be replicated (used as a cell source), including shapes, text, images, image sequences, and clips.

**Note:** Although you can replicate an object used as the source object for a particle emitter, you cannot replicate a particle emitter itself. You also cannot replicate a replicator object.

Transformations that you apply to the source object are respected in the replicator cells. For example, if you use a rectangle shape that is sheared and rotated as a replicator source object, the replicated elements are sheared and rotated. If the replicated object has applied filters, the effects of the filters are retained in the elements of the replicator pattern.

**Note:** Keep in mind that replicating a movie, especially with applied filters, adversely impacts your computer’s processing performance. For better performance, output your sequence with the filter applied, then import and use the movie as a source.

**Creating Graphics and Animated Clips for the Replicator**
Creating a replicator from scratch begins with designing the graphic you want to replicate. You can use any image, shape, text, or movie supported by Motion as a source for a replicator cell. The guidelines for creating source objects for a particle system also apply to creating source objects for the replicator. For more information, see "Creating Graphics and Animations for Particle Systems" on page 585.

**Using the Replicator**
Although you can use the numerous replicator controls to create incredibly complex, intricate animated patterns, replicating an object in your project can be fast and easy. This section describes how to use pre-made replicators from the Library. The following section explains how to create a simple replicated pattern of your own.
Using the Replicator Library Presets
The easiest way to add a replicator to your project is to use a replicator preset from the Library. Since the Library replicators are pre-made using Motion content, they are for more generalized usage. If you find one that is close to what you need, you can easily customize its parameters after you add it to your project. Library replicators are added to a project exactly like any other object.

For information on replicating your own objects, see “Creating a Simple Custom Replicator Pattern” on page 630.

To use a replicator from the Library:
1 Select the layer to which you want to add the replicator.
2 In the Library, select the Replicator category.
   The Replicator category is divided into subcategories, such as Mattes, Transitions, Backgrounds, and so on.
3 Select a subcategory, then select a replicator object, such as Curved Drops (in the Miscellaneous subcategory).
   An animated preview appears in the Preview area.

   ![Replicator Preview](image)

   *Note:* If the preview does not automatically start playing, click the Play button in the Preview area. To automatically play items selected in the File Browser or Library, choose Motion > Preferences (or press Command+,), then enable “Play items automatically on a single click” in the File Browser & Library section of the General pane.

4 Once you have selected the replicator preset you want to use, do one of the following:
   • Click Apply in the Preview area to add the replicator to the center of the Canvas.
   • Drag the replicator to the Canvas.
   • Drag the replicator to the desired layer in the Layers tab or Timeline.
   • Drag the replicator to the track area of the Timeline. When you reach the frame where you want the new objects to start, release the mouse button.

The replicator preset appears in the project, composited above any objects below it in the Layers tab.
Once you have added a replicator preset from the Library, it acts exactly as it appeared in the Preview area. If necessary, you can edit the replicator parameters in the Dashboard or in the Replicator tab of the Inspector to suit your project. You can also replace the preset source object with one of your own images, clips, shapes, or text objects as the source object for the pattern cells.

**Note:** You can only modify a replicator after it’s been added to a project. Once modified, you can save the replicator in the Library as a custom replicator. For information on saving custom replicators to the Library, see “Saving Custom Replicators to the Library” on page 699.

**To replace a replicator preset’s source image:**

1. In the File Browser or Library, select the file you want to use as the replacement graphic for the replicator preset, then add it to the project.

2. In the Layers tab, drag the object over the replicator cell you want to replace.

3. When the pointer becomes a curved arrow, release the mouse button.

The original source object is replaced with the new object.

The Dashboard displays a selected replicator’s most essential parameters. Blend Mode, Opacity, and Shape always appear in the Dashboard.
As mentioned above, the rest of the controls are dynamic—they appear depending what is selected from the Shape and Arrangement pop-up menus. Select a replicator cell in the Layers tab or Timeline to edit its parameters in the Dashboard. The angle and scale parameters always appear in the Dashboard.

Creating a Simple Custom Replicator Pattern
Creating a custom replicator pattern begins by selecting an object in your project to use as a source object for the cells of a new replicator pattern. An object is replicated in the same manner as making particles—you select the object that you want to replicate, then click the Replicate icon in the Toolbar. By default, a filled rectangular pattern is created from the source object. You can then modify the replicator parameters to suit your project needs.

**Note:** Like all other customized objects in Motion, you can save a replicator to the Library. For more information, see “Saving Custom Replicators to the Library” on page 699.

**To create a pattern from a source object:**
1. Place an object that you want to replicate into your project. This example uses the “5-sided star” object from the Shapes category in the Library. Once added to the project, the star object is scaled to 20 percent.
2 Select the object, then do one of the following:
   • In the Toolbar, click the Replicate icon.
   • Choose Object > Replicate.
   • Press L.

Once an object is replicated, the following occurs:
   • The Replicator object appears in the Layers tab and is selected.

   • The original object (the star shape) becomes the replicator cell.
   • The original source object (the star shape) is disabled.

   Note: Changes made to the original reference object, such as opacity or shearing, are respected in the pattern even after the replicator is created.
• In the Canvas, the replicator bounding box appears, which can be transformed using the onscreen controls.

![Replicator in Canvas](image)

• In the Canvas, the default rectangle pattern appears, in the same location as the source object. The pattern’s elements are created from the replicator cell.
• In the Toolbar, the Adjust Item tool is selected so that you can immediately begin using the replicator’s onscreen controls.

When the Adjust Item tool is selected, dragging the pattern’s outline resizes the replicator. Dragging in the Canvas (not over the outline) repositions the replicator object as a whole.
• The Replicator Dashboard is displayed.

*Note:* If you have hidden the Dashboard, press D.

By default, the patterns created by the replicator are not animated.

**Removing a Replicator**
You can remove a replicator from the Layers tab or Timeline Layer list.

**To remove a replicator:**
• Select the replicator, and press `Delete`.

The original source objects remain in the project.
Using Multiple Source Objects for the Replicator

When you create a replicator pattern from scratch, you don’t have to restrict yourself to using just one cell object. You can create a pattern that includes different elements by placing multiple cells inside of a single replicator.

You can add as many source objects as you want to a single replicator. Each source object becomes a cell in the replicator, and each cell has its own set of parameters. The cell parameters govern the elements in the pattern. When you select a replicator cell in the Layers tab or Timeline Layer list, its parameters are displayed in the Replicator Cell tab in the Inspector.

Additional cells can be created either by selecting multiple source objects when initially creating the replicator, or by dragging source objects to the replicator object in the Layers tab or Timeline Layer list.

The following example uses two shapes as source objects for a single replicator.

To use multiple source objects for a replicator pattern:

1. **Shift**-select the objects you want to replicate. This example uses a white circle shape and a red elliptical shape (both created with the Circle tool).

   ![Replicator Example](image)

   - **Note:** **Command**-click noncontiguous objects that you want to add to the replicator.
2 Do one of the following:
   • In the Toolbar, click the Replicate icon.
   • Choose Object > Replicate (or press L).

The cells of the default rectangle pattern are created from the source objects.

When multiple cells create a replicator pattern, the elements appear at the same points (the location in which the elements appear) on the pattern. The replicator is positioned at the average of the source’s positions.
The elements in the pattern are stacked according to the order they appear in the Layers tab and Timeline Layer list. To change the stacking order of the objects, move the lower cell above the upper cell.

Once the cells are reordered in the Layers tab, the red ellipse element appears above the white circle element in the pattern.

Removing a Source Object From a Replicator

In the Layers tab or Timeline Layer list, you can remove a cell from a replicator that contains multiple cells.

To remove a cell from a replicator:

- In the Layers tab or Timeline Layer list, select the cell you want to remove, and then press Delete.

The original source objects remain in the project.
Customizing a Replicator Using the Dashboard

When a replicator is created from a source object, the pattern is built using the default parameters in the Replicator tab of the Inspector. You can also use the Replicator Dashboard to easily change the most important of these parameters to suit your needs.

To display the Replicator Dashboard:

- In the Layers tab or Timeline Layer list, select the replicator you want to display the Dashboard.

**Note:** If the Dashboard does not appear, choose Window > Show Dashboard (or press F7). You can also press D to show the Dashboard.

Replicator Dashboard Parameters

Like all objects in Motion, the Replicator Dashboard contains frequently used parameters that are necessary to modify the shape and arrangement of the replicator. These parameters are a subset of the parameters found in the Replicator tab of the Inspector. The Dashboard contains a group of sliders and pop-up menus, that provide an easy way change the shape of the pattern, as well as the arrangement of the objects within the pattern. The Dashboard also provides quick access to the Opacity and Blend Mode parameters, which are located in the Properties tab of the Inspector.
For replicators containing multiple cells, the Replicator Dashboard parameters simultaneously modify the cell's parameters.

**Important:** The Opacity, Blend Mode, and Shape parameters always appear in the Replicator Dashboard. The parameters below Shape and Arrangement (available when the selected shape is a Rectangle, Circle, or Image) in the Dashboard are dynamic—they change depending on what is selected from the Shape and Arrangement pop-up menus. For a discussion of all replicator parameters, see “Advanced Replicator Controls” on page 645.

The following section describes the default Replicator Dashboard parameters.

**Opacity:** Defines the opacity of the replicator pattern as a whole. If a replicator contains multiple cells, this setting affects the opacity of all pattern elements.

To individually control the opacity of the elements in a replicator with more than one source object, do one of the following:

- Select the cell and use the Opacity Gradient control (or change Color Mode to Colorize and adjust the Alpha parameter) in the Replicator Cell tab.
- Select the original source object—not the replicator cell itself—and change its opacity in its Dashboard or Properties tab of the Inspector.

**Blend Mode:** A pop-up menu that defines the blend mode of the replicator. Changing this setting affects the pattern as a whole according to the objects composited beneath it in the Layers tab—it does not affect the interaction of elements that may be stacked on one another in a pattern. To affect the blending of elements within a pattern, you can enable Additive Blend in the Replicator tab of the Inspector.

**Note:** For more information on blend modes, see “Blend Modes” on page 244.
**Shape:** A pop-up menu that defines the shape of the replicator. The default shape is Rectangle. The shape options include Line, Rectangle, Circle, Burst, Spiral, Wave, Geometry, and Image.

![Replicator Shape set to Rectangle (default)](image1)
![Replicator Shape set to Circle (Arrangement set to Outline)](image2)
![Replicator Shape set to Spiral](image3)

**Note:** Different parameters are available depending on what is selected from the Shape pop-up menu.

**Arrangement:** A pop-up menu that defines the layout of the elements within the replicator pattern. When the Shape parameter is set to the default Rectangle, the default arrangement is Tile Fill. The Arrangement parameter is available only when Shape is set to Rectangle, Circle, or Image.

Think of the Arrangement parameter as necessary only when you need to specify how elements are arranged in a closed shape (a circle, rectangle, or image). If Shape is set to Line, for example, the elements appear along that line—there is no “space” within which to arrange the pattern’s elements.

![Arrangement set to Tile Fill (default)](image4)
![Arrangement set to Outline](image5)
![Arrangement set to Random Fill](image6)

Different parameters are available depending on what is selected from the Arrangement pop-up menu.
Columns: Defines the number of vertical columns in the pattern. Pattern elements are distributed at points along the columns. This parameter is only available when the selected shape is closed, such as a rectangle, circle, or image, and when the arrangement is set to Tile Fill.

Note: The default Columns value limit is 20. You can set a higher number in the value field in the Replicator tab of the Inspector.

Rows: Defines the number of horizontal rows in the pattern. This parameter is available only when the selected shape is closed, such as a rectangle, circle, or image, and when the Arrangement is set to Tile Fill.

Note: The default Rows value limit is 20. You can set a higher number in the value field in the Replicator tab of the Inspector.

Origin: Specifies how the elements traverse across the pattern from a point of origin. For example, when set to Left, the elements sweep across the rectangle (or image) from left to right. When set to Upper Right, the elements from the upper-right corner point of the shape to the lower-right corner. This parameter is available when the Arrangement is set to Tile Fill or Random Fill.

Modifying a Replicator Using the Properties Tab
Like any other object in Motion, a replicator’s properties (such as position, scale, blend mode, shear, or drop shadow) can be modified in the Properties tab of the Inspector or by using the onscreen transform modes. These properties are separate from the replicator parameters in the Replicator and Replicator Cell tabs, which control the shape and size of the replicator, as well as all aspects of its pattern and cells.

Note: When a replicator cell is selected, only the Timing parameter appears in the Properties tab of the Inspector.

To display the replicator Properties Tab:
- In the Layers tab or Timeline Layer list, select the replicator and then click the Properties tab in the Inspector.
Note: To transform the replicator pattern in the Canvas, you can also use transform tools available in the Toolbar. Once a replicator is selected, you can also press Tab to cycle through the tool modes. The last tool mode is the Adjust Item tool, which can be used to change the size of the replicator shape. For more information on the onscreen transform tools, see the table on page 28.

Position, Rotation, Shear, and Anchor Point
Since all elements are attached to the points of the replicator pattern, changing the replicator’s position, rotation, shear, or anchor point in the Canvas changes every element in the replicator. This results in the entire pattern being transformed at once. Modifying the anchor point moves the point for the entire pattern—it does not change the anchor point for the pattern elements.
**Scale**

Using the Scale parameter resizes the replicator object, affecting the size of the pattern elements. To modify the size of the pattern without changing the size of its elements, use the parameters in the Replicator tab. For example, to enlarge a rectangle replicator without increasing the size of its elements, use the Scale parameter (in the Replicator tab); to lengthen a line replicator, use the Start Point and End Point parameters; to increase the size of a circle replicator, use the Radius parameter.

Original replicator object  |  When replicator object is scaled using the Scale parameter in the Properties tab, the entire pattern and its elements are scaled.  |  When replicator object is scaled using the Replicator size parameters in the Replicator tab, the pattern is scaled, not the cells.

**Blending**

Any changes you make to the opacity or blend mode parameters for a replicator are applied to the replicator as a whole—the result of the replicator pattern is blended into the scene. For more information about blend modes, see “Using Blend Modes” on page 249. For more information about the Preserve Opacity setting, see “The Preserve Opacity Option” on page 247.

**Note:** Within the replicator, the pattern elements can be blended additively or normally (using the Additive Blend checkbox).
Drop Shadow
Drop shadows can be applied to replicators. The drop shadow of the replicator affects objects composited behind the replicator—if the pattern contains overlapping elements, the shadow does not appear on the individual elements. When the Drop Shadow parameter is enabled for the source object (in the Properties tab in the Inspector), overlapping pattern elements appear with a drop shadow.

For more information on working with drop shadows, see “Drop Shadows” on page 269.

Four Corner
The Four Corner controls in the Properties tab allow you to stretch a replicator object into different polygonal shapes by moving one of the corner points, leaving the other three corners locked into place. Adjusting the corners of the replicator affects the entire pattern as a whole.

Cropping
The Crop controls in the Properties tab allow you to hide portions of a replicator pattern. You can also use the onscreen cropping controls by choosing the Adjust Crop tool from the Toolbar, then dragging any of the replicator object’s four edges or corners.

For more information on cropping objects in Motion, see See “Cropping Objects” on page 239.

Timing
Once you create a replicator, its duration can be as long or short as necessary, regardless of the duration of the original source objects used for the pattern cells. The duration of a replicator is defined by the duration of the replicator object. Changing the In or Out points of a replicator in the Properties tab, Timeline, or mini-Timeline changes the duration of the replicator.
While the duration of the source objects has no affect on the replicator, the duration of each cell affects how long the elements created from that cell are visible in the project. You can change a cell’s duration by dragging either its position or its In and Out points in the Timeline. In this way, you can adjust the timing that defines when each cell type appears. For example, you can create a pattern in which three different types of elements appear at different times in the animation by offsetting the cells in the Timeline. In the following image, the arc cells appear first. One second later, the star cells appear. One second after that, the circle cells appear.

**Note:** You can animate the opacity of each cell so that it fades in by keyframing the Opacity parameter in the Replicator tab or the Replicator Cell tab.

For more information on adjusting the timing of layers in the Timeline, see “Using the Timeline” on page 273.

**Using the Adjust Item Tool**

In addition to using the default Select/Transform tool to move the replicator in the Canvas, you can also use the Adjust Item tool. This tool can also be used to resize the shape of a replicator in the Canvas. Dragging the pattern’s shape adjusts the size of the replicator shape. For example, if the shape is a spiral or circle, dragging the shape changes the Radius parameter value. If the shape is a rectangle, dragging a corner or an edge of the rectangle changes the Size parameter value. Dragging in the Canvas (not directly on the shape) repositions the replicator object as a whole.
Applying Masks to the Replicator

As shown in the following images, you can apply masks to the source object of a replicator.

When the masked object is used as the source for a replicator cell, the mask is respected in the pattern cells.

You can also apply masks to the replicator object itself.
When a mask is applied to a replicator, the entire pattern is masked.

Circle mask applied to the replicator object

For more information on working with masks, see “Masking an Object” on page 851.

Advanced Replicator Controls
When a replicator is created from a source object, the default replicator parameters are used, creating a rectangular pattern consisting of five rows and five columns of elements. Although the Dashboard provides a fast way to modify the basic replicator parameters, the Replicator tab in the Inspector gives you total control over every aspect of that pattern. This includes individual parameters for each cell in a pattern (when a single cell source object is used).

To open the Replicator tab:
1 Select a replicator object.
2 In the Inspector, click the Replicator tab.
   The replicator parameters appear.
   The contents of the Replicator tab are dynamic, and different parameters appear depending on the replicator shape that’s used. Also, different parameters appear depending on the Arrangement parameter assigned to closed shapes (such as a rectangle or circle). Further, open shapes (such as Spiral or Burst) can have additional dynamic parameters. For example, when Shuffle Order is turned on for a burst replicator, the Replicate Seed parameter appears.

The Difference Between Replicator and Replicator Cell Parameters
The replicator and replicator cell parameters, though closely related, serve different purposes. Replicator parameters control the overall shape, arrangement, number of cells, offset, stacking order, and origin or build order of cells in the replicator pattern.

Replicator cell parameters control the behavior and appearance of the elements within the replicator pattern. For more information, see “Replicator Cell Parameters” on page 662.
For a replicator with only one cell (one source object), the replicator and replicator cell controls appear in the same Replicator tab. In this case, you can control every aspect of the replicator directly from this single tab, which saves you from having to go back and forth between the Replicator and Replicator Cell tabs. For a replicator with multiple cells, the replicator parameters remain in the Replicator tab and the cell source objects are listed in the lower portion.
Each cell has its own Replicator Cell tab that contains all parameters for that cell. To access the cell parameters, you must select a cell object in the Layers tab or Timeline Layer list (located under the replicator object).

**Replicator Parameters**

The parameters in the Replicator tab give you complete control over every aspect of the pattern created by the selected replicator object. This includes the shape on which the pattern is built and the shape’s related parameters, such as the size of the replicator, how the elements are arranged in the pattern, and so on.

**Options in the Replicator Shape Parameter**

The first parameter in the Replicator tab is the Shape pop-up menu. The eight options in this pop-up menu significantly alter the distribution of the pattern elements. When you choose a replicator shape, different replicator parameters are revealed that are unique to that shape. For example, when Rectangle is selected in the Shape pop-up menu, the Outline, Tile Fill, and Random Fill options become available in the Arrangement pop-up menu. When Spiral is the selected Shape, the Arrangement parameter goes away and new parameters such as Radius, Twists, and Number of Arms become available. These different parameters provide additional control over the pattern.

**Note:** The Shape parameter, as well as the Shuffle Order and Reverse Stacking parameters, are persistent in the Replicator tab (they do not change based on what is selected in another parameter). The Cell Controls in the Replicator tab and the Replicator Cell tab are also persistent.
The following options are available in the Shape pop-up menu:

- **Line**: Elements are positioned on a line. Using the onscreen controls (with the Adjust Item tool) or the Inspector, you can specify the length and location of the line. In the Inspector, you can set a specific number of points on the line—one element is positioned at every point (including the end points of the line). The Line shape displays additional Start Point, End Point, Points, and Offset parameters.

- **Rectangle**: Elements are positioned in a rectangle along its outline, or in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the size and location of the rectangle. Drag the corners to adjust width and height; drag edges to adjust width or height independently. When Rectangle is selected, the Arrangement parameter becomes available. Depending on the selected Arrangement, the Rectangle shape displays additional parameters.
Use the following modifier keys to more precisely manipulate the corners of the Rectangle onscreen controls:

- **Option**: Adjustments to size are scaled uniformly, with the anchor point remaining fixed.
- **Shift**: Adjustments to size are made proportionally.

- **Circle**: Elements are positioned in a circle along its outline, or in a tile or random fill pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the radius and location of the circle. When Circle is selected, the Arrangement parameter becomes available. Depending on the selected Arrangement, the Circle shape displays additional parameters. In the following image, the circle’s Arrangement is set to Outline.
• **Burst:** Elements are positioned in a flare pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the radius and location of the burst. The Burst shape displays additional Radius, Number of Arms, Points Per Arm, Offset, and Origin parameters in the Replicator tab.

![Burst Image]

• **Spiral:** Elements are positioned in a spiral pattern. Using the onscreen controls (with the Adjust Item tool), you can specify the radius and location of the spiral. The Spiral shape displays additional Radius, Twists, Number of Arms, Points Per Arm, and Offset parameters in the Replicator tab.

![Spiral Image]
• **Wave**: Elements are positioned on a waveform. Using the onscreen control (with the Adjust Item tool) or the Inspector, you can specify the length and location of the wave. The Wave shape displays additional Start and End Point, Amplitude, Frequency, Phase, Points, and Offset parameters in the Replicator tab.

![Wave Example](image)

• **Geometry**: Elements are positioned along the edge of a shape, defined by a spline object used as the shape source. The Geometry shape displays additional Shape Source, Points, and Offset parameters in the Replicator tab.

![Geometry Example](image)

For information on using geometry (a shape) as a replicator shape, see “Using Geometry for a Replicator Shape” on page 659.

• **Image**: Elements appear within an area defined by an image or along its border, depending on what is chosen from the Arrangement pop-up menu. The image may or may not have an alpha channel. If it does, the shape of the alpha channel can also be used to define the pattern. When Image is selected, the Arrangement parameter becomes available. Depending on the selected Arrangement, the Image shape displays additional parameters.
For information on using an image as a replicator shape, see “Using an Image for a Replicator Shape” on page 653.

Shape-Specific Parameters
The following parameters appear depending on what is selected in the replicator Shape pop-up menu. They apply only to the replicator shapes, and affect the overall pattern created by the replicator.

Many parameters are shared between all shapes. For example, the Points (or Points Per Arm) parameter is always available for the Line, Burst, Spiral, Wave, Geometry shapes. The Points parameter is also available for the Rectangle, Circle, and Image shapes when Outline or Random Fill is selected in the Arrangement pop-up menu. The following parameter descriptions are divided into shapes that have the most parameters in common.

Note: Keep in mind that just because a parameter is described in a specific section below does not mean that parameter is exclusive to the shapes discussed in that section.

Rectangle, Circle, and Image Shape Parameters
When the selected shape is a Rectangle, Circle, or Image, the following parameters become available:

Arrangement: Specifies the layout of the elements in the selected shape. The arrangement options are:
- Outline: Elements are positioned along the edge of the shape.
- Tile Fill: Elements are positioned in a tiled pattern of rows and columns within the circle, rectangle, or image. You can specify the number of columns and rows, as well as the Tile Offset.
- Random Fill: Positions elements randomly from within circle or rectangle.

Size (Rectangle): Defines the size of the rectangle shape. This parameter is available whether the Rectangle Arrangement is set to Outline, Tile Fill, or Random Fill. When Circle is the selected shape, this parameter becomes Radius.

Note: The Height is measured in pixels, however, the Width is measured in square pixels. This is done so that a shape that is numerically square appears square when “Correct for Aspect Ratio” is turned on in the View pop-up menu in the top-right corner of the Canvas.

Radius (Circle): Defines the size of the circle shape.

Image Source (Image): This parameter, which becomes available when the Shape parameter is set to Image, allows you load an image object as the source for the replicator shape. To set the image source, drag an image from the Layers tab or Timeline Layer list to the Image Source well.
Using an Image for a Replicator Shape
The following section describes how to use an image as the source for a replicator pattern.

To use an image for a replicator shape:

1. Import the image you want to use as the pattern source into your project.
2. In the Replicator tab, choose Image from the Shape pop-up menu. The Image Source well appears in the Inspector and Dashboard.

3. From the Layers tab, drag the image to the Image Source well.
4. When the pointer becomes a curved arrow, release the mouse button. A thumbnail of the image appears in the well and the image is used as the source shape for the replicator.

*Note:* You may want to disable the source image in the Layers tab so it is not visible in your project.
Emission Alpha Cutoff (Image): When the Image Source object contains an alpha channel, this slider defines the minimum opacity value that is necessary to create an element at that point on the source image. For example, when set to 25 percent, elements only appear at points where the alpha value of the image is equal to or greater than 25 percent opacity. The lower the Emission Alpha Cutoff value, the more cells appear. In order for this parameter to be effective, the alpha channel needs to have areas of varying transparency.

Points: Specifies the number of evenly-distributed elements points along the edge of the shape. This parameter is available when the Arrangement is set to Outline or Random Fill.

Offset: Adjusting this value moves the elements along the edge of the shape. This parameter is available when the Arrangement is set to Outline.

Build Style: When the Arrangement is set to Outline, this parameter specifies the direction in which the elements are placed along the edge of the shape. When Arrangement is set to Tile Fill, and Origin is set to either Upper Left, Upper Right, Lower Left, or Lower Right, this parameter specifies how the elements are built over the pattern.

When Arrangement is set to Outline, the Build Style options are:
- Clockwise: Places the elements along the shape in a clockwise direction.
- Counter Clockwise: Places the elements along the shape in a counter clockwise direction.

When the Arrangement is set to Tile Fill, the Build Style options are:
- Across: Builds the elements across the pattern in the direction specified by the Origin parameter.
- By Row: Builds the elements over the pattern by row.
- By Column: Builds the elements over the pattern by column.
The following images show the difference between the Clockwise and Counter Clockwise parameters, using a replicator that applies a gradient over its pattern elements.

**Note:** When the cell Color Mode is set to Over Pattern, a gradient is applied to the elements over the replicator pattern. In this example, the gradient begins yellow, becomes orange in the middle, and becomes red at its end.

Columns: Specifies the number of horizontal element points on a grid over the selected replicator. In the case of an irregular shape (nonrectangular), points that fall outside of the shape are ignored. This parameter is available when the Arrangement parameter is set to Tile Fill.

Rows: Specifies the number of vertical element points on a grid over the selected replicator. In the case of an irregular shape (nonrectangular), points that fall outside of the shape are ignored. This parameter is available when the Arrangement parameter is set to Tile Fill.
**Tile Offset:** Specifies the amount (in percentage points) that the elements are offset from the pattern. Values from 0 to 100 percent offset the rows toward the right, and values from 0 to –100 percent offset the rows toward the left. A value of 50 or –50 percent creates a “brickwork” pattern. This parameter is available when the Arrangement parameter is set to Tile Fill.

![Circle set to Tile Fill](image1)
![Tile Offset set to a value of 20 percent](image2)

**Origin:** Specifies how the elements traverse across the pattern from a point of origin. For example, when set to Left, the elements sweep across the pattern from left to right. When set to Upper Right, the elements traverse from the upper-right corner point of the shape to the lower-right corner. This parameter is available when the Arrangement parameter is set to Tile Fill or Random Fill.

![Origin set to Left](image3)
![Origin set to Upper Right](image4)

When Rectangle or Image is chosen from the Shape pop-up menu, the Origin options are:

- **Upper Left:** The elements originate in the upper-left corner of the pattern and end in the lower-right corner.
- **Upper Right:** The elements originate in the upper-right corner of the pattern and end in the lower-left corner.
• **Lower Left:** The elements originate in the lower-left corner of the pattern and end in the upper-right corner.
• **Lower Right:** The elements originate in the lower-right corner of the pattern and end in the upper-left corner.
• **Center:** The elements originate in the center of the pattern and move outward. This is the default Origin option.
• **Left:** The elements originate at the left side of the pattern and end at the right side.
• **Right:** The elements originate at the right side of the pattern and end at the left side.
• **Top:** The elements originate at the top of the pattern and end at the bottom.
• **Bottom:** The elements originate at the bottom of the pattern and end at the top.

When Circle is chosen from the Shape pop-up menu, the Origin options are:
• **Center:** The elements originate in the center of the pattern and build outward. This is the default Origin option.
• **Edge:** The elements originate along the edge of the pattern and build inward.

Note: The origin parameter also determines where the Sequence Replicator behavior starts its animation. For more information on the Sequence Replicator behavior, see “Using the Sequence Replicator Behavior” on page 681.

**Replicate Seed:** Modifies the Random Fill pattern. Although the result of the Random Fill option from the Arrangement pop-up menu seems random, it’s actually deterministic. This means that the random variation in the pattern is created based on the number shown here. Unless this seed number is changed, a replicator with the same parameter settings and source object always appears the same. If you don’t like the current random fill, you can change the seed number by typing a new number or clicking Generate. This changes the random calculations performed for that pattern. This parameter is also used to randomize the Shuffle Order parameter. For more information on Shuffle Order, see “Other Persistent Parameters” on page 661.
Line and Wave Shape Parameters

When the selected shape is a Line or Wave, the following parameters become available:

Start Point: Two sliders that define, in X and Y coordinates, the first point of the line or wave on which the elements are positioned. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool).

End Point: Two sliders that define, in X and Y coordinates, the second point of the line or wave on which the elements are positioned. You can adjust these values in the Canvas using the onscreen controls (with the Adjust Item tool).

Points: Defines the number of evenly distributed element points on the line or wave. When the Adjust Item tool is selected, the points are visible in the Canvas.

Offset: Adjusting this value moves the elements along the line or wave.

Additional Wave Parameters

Amplitude: Defines half the distance from the highest point to the lowest point in the wave. Higher values result in more extreme waves.

Frequency: Defines the number of waves. The default is value is 1.

Phase: Specifies the location in the pattern where the wave starts.

Burst and Spiral Shape Parameters

When the selected shape is a Burst or Spiral, the following parameters become available:

Radius: Defines the size of the burst or spiral shape.

Number of Arms: Defines the number of branches on which the elements are positioned. The default value is 3.
**Points Per Arm:** Defines the number of element points on each branch of the burst or spiral. When the Adjust Item tool is selected, the points are visible in the Canvas.

**Additional Spiral Parameters**

**Twists:** Defines the number of turns in the spiral. The default value is 0.25. When Number of Arms is set to one, a single spiral is created.

**Geometry Shape Parameters**

When the selected shape is Geometry, the following parameters become available:

**Shape Source:** This parameter, which becomes available when the Shape parameter is set to Geometry, allows you to load a shape as the source for the replicator shape. To set the shape source for the replicator, drag a shape from the Layers tab or Timeline Layer list to the Image Source well.

**Using Geometry for a Replicator Shape**

The following section describes how to use geometry as the source for a replicator pattern.

**To use geometry for a replicator shape:**

1. Import (or draw) the shape you want to use as the pattern source.
2. In the Replicator tab, select Image from the Shape pop-up menu.
The Shape Source well appears in the Inspector and Dashboard.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shape</td>
<td>Geometry</td>
</tr>
<tr>
<td>Shape Source</td>
<td>Shape</td>
</tr>
<tr>
<td>Points</td>
<td>10</td>
</tr>
<tr>
<td>Offset</td>
<td>0%</td>
</tr>
<tr>
<td>Build Style</td>
<td>Counter Clockwise</td>
</tr>
<tr>
<td>Reverse Stacking</td>
<td></td>
</tr>
</tbody>
</table>

3. From the Layers tab, drag the shape to the Shape Source well.

4. When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and the shape is used as the source shape for the replicator.

Note: You may want to disable the source shape object in the Layers tab so it is not visible in your project.

Points: Defines the number of evenly distributed element points around the shape.

Offset: Adjusts the position of the elements along the edge of the shape.

Build Style: Specifies the direction in which the elements are placed along edge of the shape. The options are:

- **Clockwise**: Places the elements along the shape in a clockwise direction.
- **Counter Clockwise**: Places the elements along the shape in a counterclockwise direction.
Other Persistent Parameters
In addition to the Shape parameter, the Shuffle Order and Reverse Stacking parameters also remain available regardless of what is selected in another parameter.

Shuffle Order: When enabled, rearranges the order in which the elements appear. When Shuffle Order is turned on, the Replicate Seed parameter becomes available.

• Replicate Seed: Although the result of turning on the Shuffle Order parameter seems random, it's actually deterministic. This means that the random variation in the element order is based on the number shown here. Unless this seed number is changed, a replicator with the same parameter settings always appears the same. If you don’t like the current random shuffle order, you can change the seed number by typing a new number or clicking Generate. This changes the random calculations performed for that pattern.

Reverse Stacking: Inverts the order in which the elements are stacked. To see the effect of this parameter, elements must be overlapping.
Note: In general, the Cell Controls in the Replicator tab and the Replicator Cell tab are persistent. For more information on the Cell Controls, see “Replicator Cell Parameters” on page 662.

**Animating Replicator Parameters**

Any parameter that contains an Animation menu can be animated. The Animation menu is represented by a small dash at the end of the parameter row. If you have animated the replicator parameters, and you then apply a Simulation behavior, or a Throw or Spin behavior, to the replicator, the keyframes that affect position or rotation are ignored. For more information on applying behaviors to the replicator, see “Using Behaviors With Replicators” on page 696.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shape</td>
<td>rectangle:</td>
</tr>
<tr>
<td>Arrangement</td>
<td>Tile Fill</td>
</tr>
<tr>
<td>Size</td>
<td>Width: 100px Height: 50px</td>
</tr>
<tr>
<td>Columns</td>
<td>5</td>
</tr>
<tr>
<td>Rows</td>
<td>5</td>
</tr>
<tr>
<td>Tile Offset</td>
<td>10%</td>
</tr>
</tbody>
</table>

**Replicator Cell Parameters**

The replicator cell parameters apply to the replicated objects—the elements—created within a replicator. In a replicator with only a single cell, the cell parameters appear in the Replicator tab in the Cell Controls group. In a replicator with multiple cells, each cell has its own Replicator Cell tab that contains all parameters for that cell.

To display the Cell Controls for a single-cell replicator:

1. Select a replicator object.
2. In the Inspector, click the Replicator tab.
The cell parameters appear in the Cell Controls group.
To display the Cell Controls for a multi-cell replicator:

1 In the Layers tab or Timeline Layer list select a cell object (located under a replicator object).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Angle</td>
<td></td>
</tr>
<tr>
<td>Angle</td>
<td>0.0°</td>
</tr>
<tr>
<td>Angle End</td>
<td>0.0°</td>
</tr>
<tr>
<td>Angle Randomness</td>
<td></td>
</tr>
<tr>
<td>Additive Blend</td>
<td></td>
</tr>
<tr>
<td>Color Mode</td>
<td>Original</td>
</tr>
<tr>
<td>Opacity Gradient</td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>100%</td>
</tr>
<tr>
<td>Scale End</td>
<td>100%</td>
</tr>
<tr>
<td>Scale Randomness</td>
<td></td>
</tr>
<tr>
<td>Shear Objects As</td>
<td>Image</td>
</tr>
<tr>
<td>Random Seed</td>
<td>Generate, 18206</td>
</tr>
<tr>
<td>Object Source</td>
<td>Rectangle</td>
</tr>
</tbody>
</table>

**Align Angle:** When enabled, the replicator elements automatically rotate to match the shape on which they are positioned. This parameter is available in all cases but the following: Rectangle, Circle, or Image shapes with Tile Fill or Random Fill.

**Angle:** Specifies (in degrees) the rotation of the replicator elements.
**Angle End:** Specifies (in degrees) the rotation of the replicator elements at the end of the pattern. The angle value of the elements at the end of the pattern equals the Angle value (start) plus the Angle End value. For example, if Angle is set to 0 degrees and Angle End set to 90 degrees, the elements are not rotated at all at their origin, and are rotated by 90 degrees at the end of the pattern.

**Angle Randomness:** Defines an amount of variance in the rotation of the replicator cells. A value of 0 results in no variance—all elements have the same rotational value. A value greater than 0 introduces a variance. The angle for an individual element is defined by the Angle and Angle End parameter, plus or minus a random value falling within the Angle Randomness.

**Additive Blend:** By default, replicator elements are composited together using the "normal" blend mode. Turn on this checkbox to composite all overlapping elements together using the Additive blending mode. This occurs in addition to whichever compositing method is already being used. The result is that the brightness of overlapping objects is intensified. This only applies to the replicator itself—the blend mode of the replicator object determines how the result of the pattern is blended into the scene.

**Color Mode:** Specifies the origin of the color for the replicated elements as Original, Colorize, Color Over Pattern, Pick From Range, and Take Image Color.
- **Original:** Elements are created using the original colors from the source object. When Original is chosen, the Opacity Gradient appears. This parameter is a gradient control that allows you to change the opacity of the replicator elements over the pattern.

![Line replicator with Opacity set to 10 percent at the start of the gradient, and 100 percent at the end of the gradient](image)

- **Colorize:** Elements are tinted using the color specified in the Color parameter. Additional Color and Opacity Gradient parameters appear.

  *Note:* For more information on the Colorize parameters, see “Additional Replicator Cell Parameters Based on the Selected Color Mode” on page 671.
• **Over Pattern**: Elements are tinted based on how they are ordered in the pattern. The Gradient Editor defines the range of color of the pattern, beginning with the leftmost color in the gradient, and progressing through the range of colors until reaching the rightmost color at the end of the pattern. Gradual color changes do not appear in each element, only across the pattern as a whole. An Opacity control also appears above the color gradient.

![Gradient Editor Image]

**Note**: For more information on the Colorize parameters, see “Additional Replicator Cell Parameters Based on the Selected Color Mode” on page 671. For more information on using the gradient controls, see “Using the Gradient Editor” on page 485.

• **Pick From Range**: Elements are tinted at random, with the range of possible colors defined by the Gradient Editor. A point on the gradient is randomly chosen, so the relative sizes of each color region determine the frequency of the color being used.

• **Take Image Color**: Each element’s color is based on the color of the image at the position of the element point. This mode is only available when an image is used as the replicator shape.

![Image Examples]

Chapter 9  Using the Replicator
**Tip:** When using images larger than the Canvas as a replicator shape image source, it is recommended that you enable Down-Res to Canvas Size in Motion Preferences (in the Still Images & Objects section of the Project pane) before importing the images.

**Scale:** Defines the scale of the replicator elements. Click the disclosure triangle next to the Scale parameter to reveal separate X Scaling and Y Scaling subparameters, which can be used to scale the width and height of the elements separately. By default, Scale is set to 100 percent—the size of the replicator elements is equal to the size of the source object.

**Scale End:** Specifies the scale of the replicator cells at the end of the pattern, relative to the Scale value. For example, if Scale is set to 100 percent and Scale End set to 50 percent, the cells are 100 percent at their origin, and half of their size at the end of the pattern.

**Scale Randomness:** Defines an amount of variance in the scale of the replicator elements. A value of 0 results in no variance—all elements in the pattern are the same size. A value greater than 0 introduces a variance. The scale for an individual element is defined by the Scale parameter, plus or minus a random value falling within the Scale and the Scale End. The disclosure triangle of the Scale Randomness parameter reveals separate X and Y subparameters, which can be used to set the width and height of the Scale Randomness separately.

**Show Objects As:** You can display replicator elements in one of a variety of preview modes, or as they actually appear. The non-image modes play more efficiently when viewing a complex replicator pattern. By default, this parameter is set to Image, which displays each element as it is supposed to appear. There are four options from which to choose:

- **Points:** Each element is represented by a single point. This is the fastest preview mode.
• **Point Size:** This parameter appears when Points is selected from the Show Objects As pop-up menu. This allows you to increase the size of the points for easier viewing. In the following image, the Point Size is set to 8.

![Point Size Image]

• **Lines:** This parameter is effective only when the elements of the replicator are animated using Simulation behaviors or the Throw (Basic Motion) behavior. The movement of each pattern element is represented by a line and is useful in analyzing the vector of each element’s motion. The length of each line is determined by that element’s speed, and the angle of each line equals each element’s direction. In the following image, the replicator elements are animated using the Vortex behavior.

![Lines Image]

*Note:* Element movement created by using the Sequence Replicator behavior or by keyframing the replicator parameters is not displayed.
• **Wireframe:** Each pattern element is represented by a bounding box. Since the bounding boxes are good indicators of each element’s orientation in the pattern, this preview mode is useful for evaluating the movements of individual elements. For example, it’s easy to see the angle of rotation for elements that are spinning or following a complex motion path.

• **Image:** Displays the elements as they are supposed to appear in your final render.

*Important:* If the Show Objects As parameter is set to a non-image mode upon exporting the project, the project renders in the selected mode.
Random Seed: Although the result of adjusting the Angle Randomness, Scale Randomness, Pick From Range, Random Start Frame, or Hold Frame Randomness parameters seems random, it’s actually deterministic. This means that the random variation in the pattern is created based on the number shown here. Unless this seed number is changed, a replicator with the same parameter settings always appears the same. If you don’t like the current random scale or angle, you can change the seed number by typing a new number or clicking Generate.

Object Source: The cells of a replicator are listed at the bottom of both the Replicator tab and the Replicator Cell tab. Each cell appears in an image well, and a checkbox allows you to enable or disable that cell (if the replicator has multiple cells).

Additional Replicator Cell Parameters Based on the Selected Color Mode
Each of the options in the Color Mode pop-up menu displays a different set of parameters.

Color: A color well that becomes available when the Color Mode is set to Colorize. Use it to specify a color to use to tint the replicator elements. You can also modify each element’s Alpha value, altering its opacity. This parameter is unique to the cell object. You can either click the color well to choose a color, or open the disclosure triangle and use the Red, Green, Blue, and Alpha channel sliders or value fields.

Opacity Gradient: This gradient control appears when Color Mode is set either to Original or Colorize. Use it to change the opacity of the replicator elements over the pattern. This gradient control is limited to grayscale values, which are used to represent varying levels of transparency. White represents solid elements, progressively darker levels of gray represent decreasing opacity, and black represents complete transparency. A simple white to black gradient represents a pattern that is solid at its origin, but which fades out gradually. The Opacity Gradient has four parameters:

- Gradient Preset pop-up menu: Gradients from the Library (default or custom) appear in this pop-up menu. Choose a gradient from this menu to load it into the Gradient Editor. None of the default gradients have opacity gradients.
- Opacity bar: To add a new opacity tag to the gradient, click anywhere within the opacity bar. Click an opacity tag to select it, and then change its value with the Opacity slider. To change the distribution of opacity, drag an opacity tag along the opacity bar, or select an opacity tag and use the Location slider. Change the spread of color between two gradient tags using the spread controls (triangles). To delete a gradient tag, drag it away from the gradient bar until it disappears.
- Opacity slider: Changes the shade of a selected gradient tag, from 100 (opaque/white) to 0 (transparent/black).
- Location slider: Changes the location of the selected gradient tag relative to the gradient bar.
**Color Gradient:** This gradient control appears when the Color Mode is set to Over Pattern. Use it to change the color of the replicator elements over the pattern. At their origin, elements are tinted with the leftmost color in the gradient. The elements progress through the range of colors until reaching the rightmost color at the end of the pattern. Gradual color changes do not appear in each element, only across the pattern as a whole. Similar to the Opacity Gradient, the Color Gradient control has five parameters:

- **Gradient Preset pop-up menu:** Gradients from the Library (default or custom) appear in this pop-up menu. Choose a gradient from this menu to load it into the Gradient control.
- **Opacity bar:** Use it to change the opacity of the replicator elements over the pattern. All color tags are limited to shades of gray.
- **Color bar:** A gradient control that allows you to tint replicator elements over the pattern.
- **Color control:** When a color tag is selected in the Gradient Editor control, you can change its color by either clicking the color well and choosing a color using the Colors window, or Option-clicking the well and using the pop-up color palette.
- **Opacity slider:** When an opacity tag is selected in the Opacity Gradient control, you can use this slider to change its shade, from 100 (opaque/white) to 0 (transparent/black).
- **Location slider:** Changes the location of the selected gradient tag or spread control relative to the gradient bar.

**Color Range:** A gradient control that appears when the Color Mode is set to Pick From Range. Use it to define a range of colors used to randomly tint pattern elements. The direction of the gradient colors is not relevant, only the number of colors that appear within the gradient. The Color Range parameter has the same controls as the Over Pattern parameter.

For more information on how to use gradient controls, see “*Using the Gradient Editor*” on page 485.

**Additional Cell Parameters for QuickTime Movies**

If you create a replicator pattern using a QuickTime object as the source object for a cell, additional parameters appear. These six parameters are:

**Play Frames:** A checkbox that controls playback. If it’s turned on, it loops the playback of the animation or movie clip used for each element. If it’s turned off, the elements use the still frame specified by either the Random Start Frame parameter or the Source Start Frame parameter.
Random Start Frame: A checkbox that introduces variation into elements using QuickTime objects as their source objects. If it’s turned on, each element in the pattern begins at a different frame of the animation. Stills are chosen randomly if Play Frames is turned off.

Source Start Frame: Chooses the frame to begin animation, if Play Frames is turned on, or the still frame to display if Play Frames is turned off. This parameter only appears if Random Start Frame is turned off.

Source Start Frame Offset: Offsets the start frame chosen in the Source Start Frame parameter over the pattern. At their origin, the elements play the animation from the frame specified in the Source Start Frame parameter. Each step away from the origin advances the start frame by the offset amount. This parameter only appears if Random Start Frame is turned off.

Hold Frames: Sets the number of times each frame of the source movie is repeated during playback. The larger the Hold Frames value, the slower your playback.

Hold Frames Randomness: Varies the number of frames to “hold.”

Animating Replicator Parameters
Most of the replicator and replicator cell parameters can be animated by keyframing them or using Parameter behaviors. If you animate the replicator’s shape-specific parameters such as Radius, Twists, and Offset (of a Spiral replicator), the pattern on which the elements are built is animated, not the elements themselves. To animate the elements of the pattern, you keyframe the parameters in the Cell Controls group (or the Replicator Cell tab).
Keyframing the replicator parameters (or using Parameter behaviors) animates all elements in the replicator symmetrically. To animate the individual elements in sequence over time—without having to create keyframes—use the Sequence Behavior, described in “Using the Sequence Replicator Behavior” on page 681. To animate the replicator using Basic Motion or Simulation behaviors, see “Using Behaviors With Replicators” on page 696.

**Important:** If you apply a Simulation behavior, or a Throw or Spin behavior to a replicator with animated parameters, some of the keyframed parameters are ignored. For more information on using behaviors with the replicator, see “Using Behaviors With Replicators” on page 696.

You can also use keyframes to animate the parameters in a replicator’s Properties tab. Parameters in this tab affect the replicator as a whole, not the individual replicator elements. This can be useful for changing the replicator’s position or rotation over time.

**Example: Creating an Animated Replicator**

The following example demonstrates how quickly you can create attractive, complex animated patterns with minimal effort. An animated replicator is created using a hand-drawn shape as the source object for the replicator’s cell. Once the replicator is created, the Angle and Scale parameters are keyframed, and a Parameter behavior is applied to the Radius parameter.

**To create an animated replicator using keyframes:**

1. Place the object that you want to replicate into your project. This example uses a bow-shaped Bezier shape object that is filled with a custom gradient. (You can also use a shape with the default white fill, and apply a gradient to the replicator elements rather than the original source object.)
**Note:** When a shape that contains a gradient is selected in Adjust Control Points-mode, the onscreen gradient controls also appear in the Canvas (the small “+” controls above and below the shape).

2 In the Layers tab, select the object and click the Replicate icon in the Toolbar (or press L). The default replicator object (rectangle shape with the tile fill arrangement) appears in the Layers tab and in the Canvas. The original source object is disabled.

3 In the Replicator tab of the Inspector, do the following:
   - Select Circle from the Shape pop-up menu.
   - Select Outline from the Arrangement pop-up menu.
   The cells appear in a circle. By default, the circle shape contains five points, and its Radius is set to 200. An element appears at every point on the circle.

   • If necessary, adjust the Radius parameter so that elements are not cut off in the Canvas. In this example, Radius is set to 145.
• Increase the Points value until the elements overlap. An element is created at every point on the shape. In this example, Points is set to 30.

• In the Cell Controls group, turn on Align Angle. Based on the location of the anchor point of the source object, the replicator elements automatically rotate to match the curve of the circle.
• Turn on Additive Blend.
The color values in every overlapping pixel are added together, and all overlapping midrange color values are lightened.

4 Go frame 1 (press Home), and enable Record (press A).
   When Record is enabled, the Record button in the transport controls is red. Keyframes are created for any changes made to an object.

5 In the Replicator tab, click in the Angle value field, type 0, and press Enter to create a keyframe.
   Note: You can create keyframes without using the Record button by positioning the cursor over the Animation menu icon and pressing Option. When a keyframe symbol appears next to the pointer, click to create a keyframe.

6 Set the Scale value to 50 percent.

7 Advance to the end of the project (press End), or to the frame where you want the animation to stop. In this example project, the last frame is 150.
8 Set the Angle value to 240 degrees and the Scale value to 80 percent.

9 Deselect the object (click in a gray area of the Canvas) and play the project (press the Space bar).

The replicator elements rotate and increase in size over time to create a pinwheel.

**Tip:** A simple way to create a new look for a replicator is to move the position of the source object’s anchor point. You can continue to play the project while you adjust the anchor point until you create a look that you like.

**To change the anchor point of a replicator source object:**
1 In the Layers tab, select the source object. Although not required to adjust its anchor point, you can enable the source object so you can see it in the Canvas.

2 In the Toolbar, select the Adjust Anchor Point tool.

**Note:** You can also press Tab to cycle through the onscreen control modes.
3 In the Canvas, move the source object’s anchor point.

The alignment of the elements to the replicator shape (the circle) changes based on the position of the anchor point.

**To animate a replicator parameter using a Parameter behavior:**

1 Continuing with the above example, select the Replicator object in the Layers tab.

*Note:* Remember, you can continue to play back a project while making parameter adjustments.

2 **Control**-click the parameter to which you want to add a Parameter behavior, and choose Oscillate from the shortcut menu.

The size of the replicator oscillates in the Canvas, bringing the elements closer together and further apart through the animation to create yet another look for the replicator pattern. The Oscillate parameters appear in the Behaviors tab, and a Parameter behavior icon appears in the Animation menu of the Radius parameter in the Replicator tab.

3 Adjust the Oscillate parameters, if necessary.

For more information on the Oscillate and other Parameter behaviors, see "Parameter Behaviors" on page 354.

**Displaying Replicator Animation Curves in the Keyframe Editor**

The replicator parameters in the Properties and Replicator tabs can be keyframed to create a change in values over time. There is a difference, however, in what object needs to be selected to show the curves in the Keyframe Editor (when Animated is selected from the Show pop-up menu):

* Select the *replicator object* to display animated replicator parameters such as Position and Rotation in the Properties tab, or Size or Tile Offset (available when the shape is a rectangle) in the Replicator tab.

---

*Chapter 9 Using the Replicator*
• Select the cell object to display animated parameters in the Cell Controls section of the Replicator tab or the Replicator Cell tab, such as Angle or Scale.

**Note:** To manually send any animated parameter to the Keyframe Editor, click the keyframe icon in the Animation menu, and choose Show in Keyframe Editor. The parameter is displayed in the Keyframe Editor in a new, untitled curve set.

For more information on keyframing parameters in the Curve Editor, see “Keyframes and Curves” on page 401.

**Using the Sequence Replicator Behavior**

The replicator also has a special behavior called Sequence Replicator, which allows you to animate the individual elements in sequence over time. This is the only way to animate the elements individually—keyframing the cell parameters or applying other behaviors affects all elements in the pattern uniformly.

The Sequence Replicator is very similar to the Sequence Text behavior, which allows you to animate text parameters in sequence through the characters of a text object. With the Sequence Replicator behavior, you can select and apply replicator cell parameters, such as Position, Color, Scale, Rotation, or Opacity, and animate those parameters in sequence through the elements of a replicator pattern.

The starting point for the sequence animation is based on the replicator’s origin or build style. For example, if a spiral replicator’s Origin parameter is set to Center, the sequence animation begins at the center of the spiral and moves outward; if the Origin of a rectangle replicator with a tile fill is set to Upper Left, and the Build Style is set to Across, the sequence begins with the elements in the upper-left of the pattern, and moves toward the lower-right.

The Sequence Replicator behavior can be applied to the replicator object itself, or to the cells of the replicator. When applied to the different cells of a replicator with multiple cells, different animations can be created for each cell.

Like most other objects in Motion, once you have created a Sequence Replicator behavior, you can save the behavior to the Library.
To apply a Sequence behavior to a replicator, do one of the following:

- In the Layers tab or Timeline Layer list, select the replicator to which you want to apply the Sequence behavior. In the Toolbar, click the Add Behavior icon and choose Replicator > Sequence Replicator.

- In the Library, select the Behaviors category, and then the Replicator subcategory. Drag the Sequence Replicator behavior from the stack to the replicator object in the Layers tab, Canvas, or Timeline Layer list.


At the top of the Sequence Replicator controls in the Inspector are the Parameter pop-up menus, which are used to add parameters to the behavior, or to remove them once they’ve been added. The added parameters determine which properties are animated.

Underneath the Parameter pop-up menus are the Sequence Control parameters, which determine how the added parameters affect the onscreen elements. These controls include options for setting the direction of the animation, whether the animation is applied per element or to the whole pattern, the number of times the animation cycles through the pattern, and so on.

Important: Before any sequencing animation can occur, you must explicitly add at least one parameter to the behavior from within the Inspector or Dashboard, and then set a value for that parameter. Until a parameter is added, adjustments in the Dashboard have no effect.
Adding Parameters to the Sequence Replicator Behavior

In the following example, the Rotation, Opacity, and Scale parameters are added to the Sequence Replicator behavior. The behavior is applied to a replicator with its Shape set to Burst, and its Origin set to Center. This example uses the source object from the “Example: Creating an Animated Replicator” on page 674.

To add and animate Sequence behavior parameters:

1. With the Sequence Replicator behavior selected, display the Behaviors tab in the Inspector.

2. In the Parameter row, do the following:
   a. Choose Rotation from the Add Parameter pop-up menu.
   b. Choose Opacity from the Add Parameter pop-up menu.
   c. Choose Scale from the Add Parameter pop-up menu.

   The added parameters appear above the Add and Remove pop-up menus. No animation occurs until a value is set for the parameters.

   Play the project (press the Space bar) to better see the effects of the sequencing.

3. Set Rotation to the largest (or smallest) value you want the cells to rotate in the animation. In this example, Rotation is set to 160 degrees.
Each element rotates from 0 degrees to 160 degrees over the pattern over the duration of the Sequence Replicator behavior.

![Image of pattern animation](image)

**Note:** If the elements are already rotated (in the Cell Controls), the elements are rotated 160 degrees from their original rotation value.

Each element rotates and pops into place before the next element begins its animation. To soften this effect, increase the Spread value.

1. Increase the Spread value. In this example, Spread is set to 12.

   In addition to creating a more graceful animation, changing the Spread value can also dramatically change the appearance of the pattern.

![Image of pattern with increased spread](image)

2. Set Opacity to the lowest value you want the elements to become in the animation. In this example, Opacity is set to 0.
Each element fades from 100 percent opacity to 0 percent opacity over the pattern over the duration of the Sequence Replicator behavior.

Note: If the elements already contain some transparency, they fade from their original opacity value to 0 percent.

6 Increase the Scale value. In this example, Scale is set to 190 percent.

The animation begins at the original value for any added parameter, then transforms to the value you specify in the Sequence Replicator parameters. The animation begins at the origin of the pattern (set in the Origin or Build Style parameter of the Replicator tab or Dashboard) and moves through to the end of the pattern.
Adjusting the Sequence Control Parameters

Once you have created a sequence animation, you can use the Sequence Control parameters to change the manner in which the sequence moves through the replicator pattern. The following section continues with the project used in the previous examples.

To change the way the sequence moves through the pattern:

1. With the Sequence Replicator behavior selected, display the Behaviors tab in the Inspector.
2. Play the project (press the Space bar) to better see the effects of the sequencing.

By default, Sequencing is set to “To,” which specifies that the animation begins at the original value of the cells and moves to the value set in the Sequence Replicator behavior for that parameter. The starting point for the sequence animation is based on the build or “origin” of the pattern (as defined in the Origin or Build Style parameters in the Replicator parameters). In the example project, the elements begin completely opaque, at 100 percent scale, and with 0 degrees of rotation at the origin of the pattern. As the sequence moves toward the end of the pattern, the elements become completely transparent, are scaled to 190 percent, and rotated 160 degrees.

3. In the Sequencing pop-up menu, choose From.

The animation moves from the value set in the Sequence Replicator behavior to the original value of the cells. This is the opposite of the To Sequencing option.

4. In the Sequencing pop-up menu, choose Through.
The sequence goes *through* a full animation cycle starting at the original value of the cells, moving to the value set in the Sequence Replicator, then returning to the original value of the cells. This is similar to combining the To and From Sequencing options.

5 Choose All from the Unit Size pop-up menu.

The sequence animation affects all replicator elements simultaneously. The default is Object, which applies the sequence animation to the elements of the replicator based on the origin of the pattern.

6 Increase the Loops value to a minimum value of 3.

By default, a sequence animation plays through one time. The value of the Loops parameter defines the number of times the animation repeats over the duration of the replicator object.

7 Choose Ping Pong from the End Condition pop-up menu.

By default, the End Condition parameter is set to Hold, which completes a sequence animation cycle, then starts the cycle again from the beginning. When set to Ping Pong, the animation cycles forward one time, then cycles backward, then forward, and so on.

*Note:* The End Condition parameter has no effect for Loop values less than or equal to 1.

For more information the Sequence Replicator parameters, see “Sequence Replicator Parameters” on page 688.
Modifying the Sequence Replicator Behavior

Use the Sequence Replicator controls to define how the change in cell value animates through the replicator pattern and how many times the animation repeats over the duration of the replicator. You can also use the Sequence Replicator controls to "soften" the effect between pattern elements.

Once you have created and modified a Sequence Replicator behavior, you can save the behavior to the Library.

Sequence Replicator Parameters

Use the following parameters to modify the sequence animation. With the exception of the Add and Remove Parameter pop-up menus, all of the following parameters also appear in the Sequence Replicator Dashboard.

Parameter: Use the Add and Remove Parameter pop-up menus to add and remove replicator cell parameters to the sequence. These parameters are very similar to the cell parameters. Once the parameter is added, set (or keyframe) a value for that parameter. The sequence animation is based on the change in value between these parameters and the original values of the cells. The available parameters are:

- **Rotation**: Specifies (in degrees) the rotation of the replicator elements. You can either rotate the dial or use the value slider.
- **Color**: Specifies a color to use to tint the replicator elements. You can either click the color well to choose a color, or open the disclosure triangle and use the Red, Green, and Blue sliders or value fields. When Color is chosen from the Add pop-up menu, the color well and individual color channel parameters appear.
- **Scale**: Defines the scale of the replicator elements. Click the disclosure triangle next to the Scale parameter to reveal separate X Scaling and Y Scaling subparameters, which can be used to scale the width and height of the cells separately. By default, Scale is set to 100 percent—the size of the replicator cells is equal to the original size defined in the cell parameters.
- **Opacity**: Defines the transparency of the pattern elements.
- **Position**: Defines the offset of the elements from their original position. Click the disclosure triangle next to the Position parameter to reveal separate X Position and Y Position subparameters. For example, to create an animation in which the elements move upward in Y over the replicator pattern, enter a positive value in the Y Position field. In the following images, Y Position is set to 300.
Sequence Control
The Sequence Control section of the Sequence Replicator behavior parameters contains controls that allow you to modify the way the animation moves through the replicator pattern, such as changing the direction of the animation.

Sequencing: Specifies how the sequence animation—the value change from the original parameter value to the value set in the Sequence Replicator parameters—moves through the elements of the pattern. The starting point for the sequence animation is based on the selected Origin or Build Style parameters (in the Replicator parameters). For example, if a line replicator’s Origin parameter is set to End Point, the sequence animation begins at the end of the line and moves toward the start of the line by default. To change the starting point for the sequence animation, change the Origin or Build Style of the pattern in the replicator controls—the Replicator tab or Dashboard. The Sequencing options are:

• To: Specifies that the animation begins at the original value of the cells and moves to the value set in the Sequence Replicator behavior for that parameter. For example, if the original opacity value of a pattern cell is 100 percent, and opacity is set to 0 percent in the Sequence Replicator parameters, the elements begin completely opaque and become completely transparent.

• From: Specifies that the animation moves from the value set in the Sequence Replicator behavior to the original value of the cells. For example, if the original opacity value of a pattern cell is 100 percent, and opacity is set to 0 percent in the Sequence Replicator parameters, the elements begin completely transparent and become completely opaque. This is the opposite of the To Sequencing option.

• Through: Specifies that the sequence goes through a full animation cycle starting at the original value of the cells, moves to the value set in the Sequence Replicator, and then returns to the original value of the cells. For example, if the original opacity value of a pattern cell is 100 percent, and opacity is set to 0 percent in the Sequence Replicator parameters, the elements begin completely opaque, become transparent, and then become completely opaque again.

• Through Inverted: Specifies that the sequence goes through an inverted animation cycle starting from the value set in the Sequence Replicator, moves to the original value of the cells, and then returns to the value set in the Sequence Replicator. For example, if the original opacity value of a pattern cell is 100 percent, and opacity is set to 0 percent in the Sequence Replicator parameters, the elements begin completely transparent, become opaque, and then become completely transparent. This is the opposite of the Through Sequencing option.
- **Custom**: Allows you to use animation originally created in the source object's parameters (except alpha parameters), or to keyframe how the animation moves through the values set in the Sequence Replicator parameters over an individual element. Each element undergoes the same value sequence. When Custom is chosen from the Sequencing pop-up menu, the Source parameter becomes available.

- **Source**: This option is available when Custom is chosen from the Sequencing pop-up menu. The Source options are:
  - **Use Source Animation**: If the source object parameters are keyframed (in the Replicator tab or Dashboard), choose this option to enable the animation created by those keyframes.
  - **Ignore Source Animation**: If the source object parameters are keyframed (in the Replicator tab or Dashboard), choose this option to ignore the animation created by those keyframes.

**Unit Size**: Specifies whether the sequence animation is applied to the replicator pattern as a whole, to its individual elements, or to a keyframed range. The Unit Size options are:
• **Object:** Applies the sequence animation over each element as its own entity. Object is the default setting.

When Unit Size is set to Object, each replicator pattern cell is affected individually.

• **All:** Applies the sequence animation to all replicator elements simultaneously.

When Unit Size is set to All, every replicator pattern cell is affected simultaneously.
• **Custom:** Allows you to specify the percentage of elements in the pattern that are affected by the sequence animation at once. Although you can create keyframes for the Custom option, it is not required in order to affect the sequence. As shown in the following images, the Object and All options allow you to sequence the animation only through the origin or build style of the pattern, or through all pattern elements simultaneously.

![Image of Custom sequence animation]

Unit Size set to Object sequences the animation over the build of the pattern.

Unit Size set to All sequences the animation over all cells simultaneously.

Custom allows you to define an area of elements—based on percentage—that are affected by the sequence.

![Image of Custom sequence animation]

Unit Size set to Custom allows you to define the percentage of cells affected as the sequence moves through the pattern.

When Custom is chosen from the Unit Size pop-up menu, the Start and End parameters become available.

• **Start:** Specifies the offset of the start of the range of elements affected by the sequence animation as it moves over the replicator pattern. In the above image, Start is set to 10 percent.
• **End**: Specifies the end of the range of elements affected by the sequence animation as it moves over the replicator pattern. By default, End is set to 10 percent. In the above image, End is set to 30 percent.

  **Note**: If the Sequencing pop-up menu is set to Custom, the Custom option in the Unit Size parameter has no affect.

**Traversal**: Sets the action of the sequence behavior to Constant Speed, Ease In, Ease Out, Ease In/Out, or Custom.

- **Ramp**: Moves the animation from the origin of the replicator pattern through the end of the pattern at a constant speed. The sequence moves in the direction specified in the replicator parameters, such as the origin or build style.
- **Ease In**: The sequence animation begins slowly and increases to normal speed as it moves through the replicator pattern.
- **Ease Out**: The sequence animation begins at normal speed and slows toward the end of the replicator pattern.
- **Ease In/Out**: The sequence animation begins slowly, increases to normal speed as it moves toward the middle of the duration of the replicator pattern, and slows as it reaches the end of the replicator pattern.
- **Custom**: Allows you to keyframe how the animation moves through the replicator pattern. When Custom is selected from the Traversal pop-up menu, the Location parameter becomes available.
  - **Location**: Defines the location of the pattern where the animation is in effect.

  For more information on using the Custom Traversal option, see “**Using the Sequence Replicator Custom Traversal Option**” on page 694.

**Loops**: Sets the number of times the animation sequences through the replicator pattern over its duration.

  **Note**: Loops is not available when the Traversal parameter is set to Custom.

**End Condition**: Determines how the sequence animation is repeated over the duration of the replicator object. This parameter has no effect for Loop values less than or equal to 1.

  The End Condition options are:

- **Hold**: Completes the sequence animation cycle one time, then starts it over again from the beginning (once the last element in the sequence has completed its animation).
- **Wrap**: Treats the sequence animation as a continuous loop so the spread wraps from the last element in the sequence to the first element.
- **Ping Pong**: Completes the sequence animation cycle forward, then completes the animation backward, then forward, and so on.
Using the Sequence Replicator Custom Traversal Option

When Traversal is set to Custom, you can create location keyframes to specify where the effect of the sequence is at any given time. This allows you to create a sequence animation that travels through a replicator pattern in a unique way. In this example, use the Custom Traversal option to scale the elements around a circle replicator shape by creating keyframes.

To use the Custom Traversal parameter:

1. Once the Sequence Replicator behavior is applied to the replicator object, add the parameters that you want to include in the sequence in the Behaviors tab.

2. Set the values for the added parameters. In this example, the Scale parameter is added and the Scale value set to 200 percent.

For more information on adding parameters to the Sequence Replicator behavior, see “Adding Parameters to the Sequence Replicator Behavior” on page 683.

3. Choose Custom from the Traversal pop-up menu.
The Location parameter becomes available.

4 Enable Record (press A).
5 At the frame where you want to begin the animation, drag the Location slider (or use the value slider) to set where the sequence begins.

As you drag the slider, the sequence moves through the pattern elements. Values displayed in the Location parameter specify where in the pattern the sequence is (in percentage points)—0 representing the origin of the pattern, and 100 percent representing the end of the pattern.

In the Inspector, a keyframe is added to the Location parameter.
6 Go to the next frame where you want to set a keyframe, and move the Location slider.
7 Repeat step 6 until you have created all of your keyframes.
8 Play the project (press the Space bar).

The animation moves through the replicator pattern based on its keyframed locations. In this case, the scale moves erratically back and forth around the circle, rather than in a constant direction.

Using Parameter Behaviors With the Sequence Replicator Behavior
Like all other objects in Motion, you can add Parameter behaviors to the Sequence Replicator parameters to create even more varied, complex effects without keyframing.
To apply a Parameter behavior to a Sequence Replicator behavior:

1. In the Layers tab or Timeline Layer list, select the Sequence Replicator behavior.

2. Control-click the parameter to which you want to add a Parameter behavior, then choose a Parameter behavior from the shortcut menu.

3. The Parameter behavior is added, and appears above the Sequence Replicator behavior in the Behaviors tab. A Parameter behavior icon appears in the Animation menu of the Sequence Replicator parameter.

**Note:** When the Wriggle or Randomize Parameter behavior is added to a Sequence Replicator parameter, an additional Affect Objects parameter is available. This allows each object to have a different random behavior.

For more information on using Parameter behaviors, see “Parameter Behaviors” on page 354.

**Using Behaviors With Replicators**

Like all objects in Motion, you can apply Basic Motion, Parameter, and Simulation behaviors to a replicator object or to its cells.

Only the Throw and Spin behaviors (from the Basic Motion subcategory) can be applied to the replicator cell object. All behaviors from the Basic Motion subcategory can be applied to the replicator object.
As previously noted, the replicator also has a special behavior called Sequence Replicator, which allows you to animate the individual cells in sequence over time. For more information on the Sequence Replicator behavior, see “Using the Sequence Replicator Behavior” on page 681.

For more information on applying Parameter behaviors to the Sequence Replicator behavior, see “Using Parameter Behaviors With the Sequence Replicator Behavior” on page 695.

To apply a behavior to a replicator, do one of the following:

- Drag a behavior from the Library onto a replicator in the Canvas, Layers tab, or Timeline.
- Select the replicator in the Layers tab, Timeline Layer list, or Canvas, click the Add Behavior icon in the Toolbar, then choose a behavior from the shortcut menu.

The behavior is applied to the replicator, which begins to move according to the parameters of the behavior.

Not all behaviors instantly activate an object when applied. For example, when a Throw behavior is applied to an object, the Throw Velocity parameter must be adjusted before the object moves.

For more information on behaviors, see “Using Behaviors” on page 317.

**Special Behavior Considerations**

When Simulation behaviors, as well as the Spin and Throw behaviors, are applied to a replicator that has animated parameters, some of the animation created by the keyframes is ignored. For example, if the Angle parameter in the Cell Controls of the Replicator tab is keyframed so that the pattern elements rotate over time and you apply a Spin behavior—with the Affect Objects checkbox turned on (default)—the elements rotate according to the rate set in the Spin behavior parameters, and ignore the replicator’s Angle keyframes. To rotate the entire replicator object and enable the Angle keyframe animation, turn off Affect Objects in the Spin parameters.

**Simulation Behaviors and Keyframes**

A good rule to keep in mind is that any Simulation behavior, as well as the Throw and Spin behaviors (Basic Motion), applied to a replicator disables all animation that affects the position or rotation of the individual elements.

To return to any keyframed animation that was created before you applied the behavior, simply disable the behaviors. To disable a behavior, turn off its checkbox in the Inspector, Layers tab, or Timeline Layer list.
Remember that behaviors often contain parameters that control how objects are
affected. These controls greatly affect the result of a behavior when it is applied to a
replicator object. For example, if you apply a Spin behavior to a replicator object, all
pattern elements rotate individually (rather than the replicator object as a whole). This
is because the Affect Objects checkbox (which appears when Spin is applied to an
object that contains multiple objects) is turned on by default in the Spin parameters. To
rotate the replicator object rather than the individual elements, turn off the Affect
Objects checkbox in the Behaviors tab of the Inspector or the Dashboard.

Applying Filters to Replicators
Filters can be applied to a replicator object or its source objects. When applied to the
replicator, filters affect the every element of the replicator pattern, as if it was a single
object. When filters are applied to the source objects of a replicator, the effect of the
filter is retained once the object is replicated. Filters cannot, however, be applied to the
individual cells of a replicator.

For more information on applying filters to objects in your project, see “Using Filters”
on page 701.
Saving Custom Replicators to the Library

Once you have created a replicator that makes you particularly happy, you can save it as a replicator preset in the Replicator or Favorites category of the Library for future use. Once you place a custom replicator in the Library, it can be used just like any other replicator preset.

To save a custom replicator to the Library:

1. Open the Library and select either the Replicators, Favorites, or Favorites Menu category.

2. From the Layers tab or Timeline Layer list, drag the replicator object you want to save into the stack at the bottom of the Library.

Note: For organizational purposes, you may find it useful to create a new folder of your own in the Favorites or Favorites Menu category to store your replicators.

When you save a replicator preset, it’s saved as a file in the Home/Library/Application Support/Motion/Library/Replicators folder.

You can copy replicator presets you create from this location to give to other Motion users, or you can add replicator presets that are given to you to this same folder.

Note: Whenever you copy a replicator preset file, you should make sure that you also copy any graphics or movie files that it uses as well.
Using Filters

Filters are an exciting way to spice up any motion graphics project. With the magic of Motion, you can preview and tweak images faster than ever before.

About Filters
The best way to think about filters is as visual fonts. Fonts can help to determine mood or style. Much the same way, the filters you select can shape the character of your project. A sepia tone color correction on an object can make the viewer think of days gone by. You can use a kaleidoscope filter to transform an object into something completely new. A slit-scan filter can provide a window into another world.

When desktop publishing was first introduced, people tended to fill their publications with numerous fonts on a page, simply because they could. And with Motion’s great performance with filters, you might be tempted to do the same. This is what is called a bad idea. The best way to think about filters is as a condiment for your project—not the entree. A handful of thoughtfully-selected and well-executed filters goes much further than a grab bag of every filter in the Library. Not only does a bunch of filters start to affect performance, but they clutter and confuse the look of your project.

To get the best performance from Motion, use a recommended graphics card. For more information, visit the Motion website at http://www.apple.com/motion.

Working With Filters
You add filters to objects in much the same way as behaviors, and you have the same ability to adjust the parameters of the filters over time without having to adjust keyframes.

For more details about working with filters, see “An Introduction to Filters” on page 702.
Filter Types
There are 12 types of filters in Motion, organized alphabetically in the Library.

An Introduction to Filters
In this section, you’ll learn how to quickly add, modify, and delete filters in a project.

Browsing For and Previewing Filters
All installed filters appear in the Library. Select the Filters category to display the 12 filter subcategories. Select a subcategory to show all filters of that type in the stack. Once a filter is selected in the stack, a preview and brief description of the filter appears in the Library Preview area.
To browse for a filter:

1. In the Library, click the Filters category.
   A list of subcategories appears on the right side of the library.

2. Click a filter subcategory.
   A list of filters in that subcategory appears in the stack.

3. Click a filter in the stack to select it.
   A preview and short description of the selected filter appear in the Preview area at the top of the Library.

Applying and Removing Filters
Each filter affects how a specific object is displayed, and is applied directly to objects in the Canvas, Layers tab, or the Timeline.
To apply a filter, do one of the following:

- Drag a filter to an object in the Canvas, Layers tab, or the Timeline.
- Select an object in the Canvas, Layers tab, or Timeline, then select a filter from the Library stack and click Apply in the Preview area.

To remove a filter from an object:
1 Select a filter that's been applied to an object in the Layers tab, Timeline, or Behaviors tab of the Inspector.
2 Do one of the following:
   - Choose Edit > Delete.
   - Press Delete.

To modify a filter on an object:
1 Select a filter that's been applied to an object in the Layers tab, Timeline, or Behaviors tab of the Inspector.
2 Adjust parameters in the Inspector or the Dashboard.

**Applying Multiple Filters to an Object**
You can apply any number of filters to an object in Motion. When multiple filters are applied to a single object, they all work together to create a final look for the object. Multiple filters appear under the object to which they are applied.

![Layers tab](image1.png) ![Timeline tab](image2.png)

**Note:** Remember that the more filters you use in a project, the more you impact the performance of Motion.
Improving Performance With Filters
When applying filters to several different objects in Motion, it is recommended to apply the filters to the objects’ parent layer. Also, when applying filters to very large layers (such as a layer containing a growing particle system), it is recommended to turn on the Fixed Resolution parameter in the Layer tab of the Inspector. When Fixed Resolution is turned on, objects that are in the layer but are outside of the Canvas are cropped to the size of the layer defined in the parameter. The Layer tab is only available when a layer is the selected object. For more information, “Fixing the Size of a Layer” on page 204.

Note: When enabled, the Fixed Resolution parameter crops the layer to the size specified in the Fixed Width and Fixed Height parameters around the anchor point of the layer.

Where Filters Appear
Once you apply a filter, it appears underneath the object to which it is applied in the Layers tab and the Timeline.

The filters also appear in the order in which they are applied in the Filters tab of the Inspector.

When a filter is applied to an object, it is applied with the filter’s default settings. For example, when you apply the Bevel border filter to an object, that object appears with a border with the angle of the light hitting the bevel set to 0 degrees, the width of the bevel set to 0.2, its opacity set to 0.8, and the color of the bevel’s light set to white. See “Bevel” on page 723 for more details.
Adjusting Filters
Filters can be tailored to your specific needs by adjusting their parameters. The parameters can be adjusted in a number of different ways, such as using sliders in the Dashboards, the controls in the Inspector, the onscreen controls, by adding keyframes, or by applying parameter behaviors.

Using the Dashboard
Each filter has a subset of parameters that appear in its Dashboard. All of the controls available for modifying each filter also appear in the Filters tab of the Inspector. Both the Dashboard and the Filters tab reference the same parameters—changing a parameter in one automatically changes that parameter in the other. Frequently, the controls available in a filter’s Dashboard represent the parameters with the exception of the position parameters. For example, compare the controls for the Fisheye filter in the Filters tab to those available in the Dashboard:

Most filter parameters have only a single set of numbers that represent their value. Parameters with a disclosure triangle, however, may have additional numbers that represent a different way of describing the same value. In the case of the Center parameter, the numbers indicated in the value sliders are absolute values, but the X and Y values under the disclosure triangle represent percentages. If the defaults for X and Y are both 0.5, that represents the center of the image. Changing the percentages updates the absolute values in the value sliders.

Adjusting Parameters
Each filter has its own distinct set of parameters. These parameters can be adjusted in one of two places: the Filters tab of the Inspector, or the filter’s Dashboard. As with all parameters in Motion, the Dashboard contains the most essential parameter controls for modifying a filter, whereas the Filters tab in the Inspector contains the filter’s entire list of editable parameters.

Note: Often, the parameters in the Dashboard are equivalent to those in the Inspector.

For more information on accessing the Inspector and Dashboard controls, see “The Inspector” on page 98 and “The Dashboard” on page 105.
In most cases, you interact manually with the parameters of a filter. The following image shows the Filters tab in the Inspector for the Hatched Screen filter. The Hatched Screen filter has six controls: Center, Angle, Scale, Skew, Stretch, and Contrast.

![The Hatched Screen filter in the Inspector](image)

Use the dial, slider, the value slider, or value field to set and enter values for each parameter as you see fit.

**Important:** Although the sliders are limited to a predetermined range of values, using either the value slider or the value field allows you to specify a parameter value outside of the slider’s range. The parameter ranges listed for each filter in this chapter define the slider’s range.

**Using Onscreen Controls**
Some of the filters have onscreen controls that manipulate certain filter parameters, especially position. As you use these controls, the associated parameters will update in the Inspector.

**Keyframing Filter Parameters**
Animating filter parameters is easy. The following section shows two ways to change a filter parameter over time using keyframes.

**To animate filter parameters using Record:**
1. Select the filter you want to animate.
2. Click the Record button (or press A) to enable recording.
3. Go to the frame where you want to add a keyframe.
4. Change the value of the parameter to the desired value.
   - A keyframe is automatically added with the value you select.
5. Go to the next frame where you want a keyframe.
6. Repeat steps 3 and 4 until you are finished.
To animate filter parameters using the Animation menu:

1. Select the filter you want to animate.
2. Go to the frame where you want to add a keyframe.
3. In the Inspector, click the Animation menu for the parameter you want to animate, then choose Add Keyframe from the menu.
4. Change the value of the parameter to the desired value.
5. Go to the next frame where you want a keyframe.
6. Repeat steps 3 and 4 until you are finished.

**Note:** Remember to add a keyframe before adjusting a parameter value.

For more detail on using keyframes and the animation menu, see “The Animation Menu” on page 415.

**Applying Behaviors to Filter Parameters**

Animating filter parameters is easy using Parameter behaviors. For example, if you have an object with an applied Circle Blur filter, you can randomize the amount of blur applied to the object over time.

**To randomize the blur applied to an object:**

1. Select the object with the applied blur filter.
2. In the Inspector, open the Filters tab.
3. Select the Amount parameter.
4 Control-click Amount, then choose Randomize from the shortcut menu.

Adjusting the Amount parameter in Randomize changes the amount of variance between the random values. A small number causes small variations in the random values, and a larger number means larger variations in the values. For more detailed information about the Randomize behavior, see “Randomize” on page 363.

For more detailed information about all of the Parameter behaviors, see “Parameter Behaviors” on page 354.

Working With Filters
This section presents more detailed information about working with filters.

For information about adding filters to and removing filters from objects in Motion, see “An Introduction to Filters” on page 702.

When you apply a filter to an object in your project, it appears in three different places—the Layers tab, the Timeline, and the Filters tab of the Inspector.
Enabling, Renaming, and Locking Filters

While the Filters tab in the Inspector contains all of the editable parameters for any filter that has been applied to an object, the Layers tab and Timeline have three primary controls for each filter that appears.

The following filter controls appear in the Layers tab and Timeline:

Activation checkbox: Turns each individual filter on or off. Filters that are turned off are not rendered.

Name: The name of each filter can be customized by double-clicking the name and typing a new one.

Lock: Click the lock icon to toggle the locked state on and off for the filter.

Copying, Pasting, and Moving Filters

Filters can be easily copied, pasted, and moved like any other object in Motion. There are a number of ways you can move and copy filters among the other objects in the Timeline or Project pane. They can be pasted over other filters, and moved across projects. When you cut or copy a filter in the Timeline or Project pane, you also copy the current state of all that filter’s parameters.

To cut or copy a filter:
1 Select the filter in the Layers tab or Timeline.
2 Do one of the following:
   • To remove a filter, choose Edit > Cut (or press Command+X).
   • To copy the filter, choose Edit > Copy (or press Command+C).

To paste a filter:
1 Select the object to which you want to apply the filter.
2 Choose Edit > Paste (or press Command+V).

The filter is applied with all its parameter settings intact.
Note: Pasting a filter does not paste it at the current playhead location. To quickly move the filter to the playhead location, press the Shift key while you drag the pasted object. As you approach the current playhead location, it snaps into place.

Moving Filters
You can move filters from one object to another.

To move a filter:
- Drag the filter from its current location to the new object to which you want to apply the filter.
Duplicating Filters
You can also duplicate a filter and apply the duplicate to another object.

To duplicate a filter:
- **Option**-drag the filter from its current location to the new object to which you want to apply the filter.

Note: You can also choose Edit > Duplicate (or press Command+D) to duplicate the filter.

Reordering Filters
When multiple filters are applied to a single object, they appear beneath that object in the Timeline or Project pane. You can change the order in which they are applied to the object, to change how they interact.

Some filters yield better results depending on the order in which they are applied. For instance, you wouldn't want to apply a color correction after a blur. This is what is called a bad idea. To get the most accurate color correction, you want to apply it to the source object, not a modified version of the source. The same is true for extracting keys, and just about anything that depends on color information.

To reorder a filter:
1. Select the filter you want to reorder.
2. Click the name of the filter or the icon to the left of the name, then drag it up or down in the Layers list.
   A position indicator shows the new position for the filter when you release the mouse button.
3 Release the mouse button when the position indicator is in the new location.

Changing Filter Timing
Filters appear as a bar in the Timeline and like other duration bars, can be trimmed or moved in time.

Changing a Filter’s Duration
When you apply a filter to an object, the duration of the filter defaults to the length of the object to which it is applied. This can be seen in the Timeline.

Once applied, a filter’s duration can be modified to affect the object over a different amount of time than the object’s duration. For example, applying the Soft Focus filter to an object results in that object being blurred for the entire object’s duration in the Timeline. Changing In and Out points of the Soft Focus filter, however, changes when the blur is applied to the object.

To trim a filter in the Timeline:
1 Position the pointer on the In or Out point (the left or right edge) of the filter you want to trim.
2 When the pointer changes to the Trim pointer, drag the In or Out point to change the duration of the filter.

![Changing a filter's Out point](image)

As you drag, the new In or Out points are displayed. Also displayed is the delta value, which represents the amount of change for the duration.

**Slipping Filters in Time**

In addition to changing a filter's duration, you can also slip its position in the Timeline relative to the object it's nested under. This allows you to set the frame at which a filter begins to take effect.

**To slip a filter in the Timeline:**

- Click anywhere in the middle of a filter in the Timeline, and drag it to the left or right to move its In point to another frame.

The filter is moved and its duration is not affected. While you drag, the new In and Out points are indicated, along with the amount of change (the delta).

![Slipping a filter](image)

**Blur Filters**

Blur filters take many forms in Motion. They can be used practically to simulate the real-world blurring that occurs due to the depth of field in photographed material, or they can be used creatively to make all kinds of designed effects. Motion provides a wide variety of blur filters you can use for any task.
Channel Blur
Gives you control over blurring each color channel of an object. The Channel blur can be applied selectively to each of the different color channels of the object: red, green, blue, and alpha.

Blurring individual channels allows you to create customized glow effects by retaining sharpness in selected channels while softening others.

Parameters in the Inspector
Amount: Sets the radius of the object blur. Values range from 0 (no blur) to 32.
Blur Red: Sets the blur to affect the red channel. Can be turned On or Off.
Blur Green: Sets the blur to affect the green channel. On or Off.
Blur Blue: Sets the blur to affect the blue channel. On or Off.
Blur Alpha: Sets the blur to affect the alpha channel. On or Off.
Horizontal: Sets the percentage of maximum horizontal blur. This is a percentage of the Amount parameter.
Vertical: Sets the percentage of maximum vertical blur.
Crop: Toggles whether or not the image is cropped beyond its original borders.
Dashboard controls
The Dashboard contains all of the same controls as the Inspector.

Circle Blur
Creates a circular blur within an image, specified by a center point which sets the center of the blur effect, and a radius which sets the size of the affected region. The amount of blur within the affected area can also be customized.
This filter is useful for quickly blurring a limited area within an image. For more sophisticated control of the image region to be blurred, try the Compound Blur filter.

![Original image](image1.png) ![Center of circle on the right side of crab](image2.png)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the blur effect.

**Amount:** Sets the amount of the blur. Values range from 0 to 100.

**Radius:** Sets the radius of the circle defining the blurred area. Values range from 0 to 1000.

**Dashboard controls**
The Dashboard contains the Amount and Radius controls.

**Compound Blur**
Blurs an object using the specified channel of a blur map image. You can use any shape, still image, or movie file as the blur map image. You can select any or all of the red, green, blue, alpha, or luminance channels to create the overall shape of the blur.

One of the fastest ways to use this filter is to create a shape object, and trace the subject of the image you want to blur. Then, assign this shape as the Blur Map image, using either its Luminance or Alpha as the map channel to define the blurred area, and turn off the original shape layer in the Layers tab or Timeline to reveal the new blur effect.

When this filter is initially applied, Compound Blur behaves as if there was a black image applied to the Blur Map well, which will not blur any part of the target.

**To add an image to the Blur Map well:**
1. Use the File Browser to find the object you would like to use as a blur map.
2. In the Project pane, click the Media tab.
3. Drag the desired object from the File Browser into the Media tab.
4 In the Filters tab of the Inspector, select the Compound Blur filter.
5 Drag the desired object from the Media tab into the Blur Map image well of the filter.

**Parameters in the Inspector**

**Amount:** Sets the radius of the blur. Values range from 0 (no blur) to 32.

**Blur Map:** An image well that displays a thumbnail of the map chosen.

**Map Channel:** Selects the channel to be blurred. The blur is applied to the red, green, blue, alpha, or luminance channel.

**Invert Map:** Sets whether or not the blur map is inverted.

**Stretch Map:** Sets whether or not the map is stretched.

**Horizontal:** Sets the percentage of maximum horizontal blur.

**Vertical:** Sets the percentage of maximum vertical blur.

**Crop:** Toggles whether or not the blur will be cropped at the object’s original border.

**Dashboard controls**
The Dashboard contains the Amount, Blur Map, and Map Channel controls.

**Defocus**
A more accurate model of the out-of-focus effect that occurs through a real-world camera lens. The Defocus filter blurs an image while creating a controlled glow effect in brighter areas of the image. The resulting object has a lens aperture-shaped structure around the highlights. The shape of the blurred glow around the affected highlights can be customized.

Use this filter when you are trying to blur one image to match video or stills that were shot with a camera. For example, if you have keyed a woman standing in front of a bluescreen, and you intend to place a background image behind her to make it look like she's standing in a valley with mountains in the background, use the Defocus filter instead of a Gaussian Blur to create a realistic depth-of-field effect for the mountains in the distance.

**Parameters in the Inspector**

**Amount:** Sets the radius of the defocus. Values range from 0 (in focus) to 16.

**Gain:** Sets the amount of gain applied to the high luminance areas. Values range from 0.05 to 4.

**Shape:** Sets the shape of the lens aperture. Circle or Polygon.
**Sides:** Sets the number of sides of the lens aperture, if Circle is set to Off. Values range from 3 to 12.

**Rotation:** Sets the angle of rotation of the polygonal lens aperture, if Shape is set to Polygon.

**Aspect Ratio:** Sets the aspect ratio of the lens aperture. Values range from 0 to 2.

**Crop:** Toggles whether or not the blur will be cropped at the object’s original border.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector, with the exception of the Crop checkbox.

**Directional Blur**
Blurs an object out along a specific angle. This filter creates a blurred streaking effect.

**Note:** Remember that the more filters you use in a project, the more you impact the performance of Motion.

---

**A Fun Effect That Can Be Used With All the Blur Filters**
Duplicate the original layer in the Layers tab, then use one of the blend modes to combine the original image with the blurred image. This effect is especially interesting when used with a directional blur, as it creates a different sort of effect than the filters in the Glow category. A similar effect, though without the directional control, can be achieved using the Soft Focus filter, described on page 721.

---

**Parameters in the Inspector**

**Amount:** Sets the radius of the blur. Values range from 0 (no blur) to 32.

**Angle:** Sets the angle of the direction of movement.

**Crop:** Toggles whether or not the blur is cropped at the object’s original boundaries.
Dashboard controls
The Dashboard contains the same controls as the Inspector, with the exception of the Crop checkbox.

Gaussian Blur
The Gaussian blur is the softest blur effect you can apply, and is one of the most frequently used blur effects. By default, it affects the entire image uniformly, although you can control the amount of horizontal and vertical blur independently.

Gaussian blur is entirely appropriate for most motion graphics tasks, and can be animated for a variety of focus-control effects. However, to more accurately simulate camera focus, the Defocus filter may be more appropriate. For more information on the Defocus filter, see “Defocus” on page 717.

Parameters in the Inspector

Amount: Sets the radius of the blur. Values range from 0 (no blur) to 64.

Horizontal: Sets the percentage of the Amount applied in the horizontal direction.

Vertical: Sets the percentage of the Amount applied in the vertical direction.

Crop: Sets whether or not the object is cropped at its original boundaries.

Dashboard controls
The Dashboard contains the same controls as the Inspector, with the exception of the Crop toggle.

Gradient Blur
The Gradient Blur filter allows you to control the blurred region of an image by creating a graduated blur between two points. Point one is the beginning of the blur, and the point at which the image is at its sharpest. Point two is the end of the blur, and the point at which the image is at its blurriest, depending on the value set in the Amount parameter.
Parameters in the Inspector

Point 1: Sets the position of the first point of the gradient.

Point 2: Sets the position of the second point of the gradient.

Amount: Sets the radius of the blur.

Dashboard controls
The Dashboard contains the Amount control.

Prism
Blurs and refracts the image as if seen through a prism, creating a rainbow effect.

Parameters in the Inspector

Amount: Sets the radius of the blur. Values range from 0 to 32.

Angle: Sets the angle of refraction. Values range from 0 to 360 degrees.

Crop: Sets whether or not the object is cropped at its original boundaries.

Dashboard controls
The Dashboard contains the Amount and Angle controls.
Radial Blur
This filter creates a rotational blur centered on a point. The effect is similar to the motion blur you would see if an image was spinning quickly.

Parameters in the Inspector
Center: Sets the position of the center of the radial blur.
Angle: Sets the angle of rotation of the blur.
Subsampling: Sets the number of samples.

Dashboard controls
The Dashboard contains the Angle and Subsampling controls.

Soft Focus
This filter creates an effect that's similar to duplicating an object, using the Screen blend mode to composite it against itself, and then blurring one of the overlapping objects. The advantage of this filter is that you can do this all within a single filter. The Strength parameter controls how much of the blurred image is added back to the original image, while other sliders let you control the overall, horizontal, and vertical amount of blur.

Parameters in the Inspector
Amount: Sets the radius of the blur. Values range from 0 (no blur) to 32.
Strength: Sets the amount of opacity of the blurred composite. Values range from 0 to 1.
Horizontal: Sets the percentage of the maximum horizontal blur.
Vertical: Sets the percentage of the maximum vertical blur.
Crop: Sets whether or not the object is cropped at its original boundaries.
Dashboard controls
The Dashboard contains the Amount and Strength controls.

Variable Blur
A blur which can either include or exclude a circular region, to create a sort of tunnel focus effect. If the inner radius of the circle is larger than the outer radius of the circle, the blur is applied outside of the circle. Otherwise, the blur is applied to the area within the circle.

Parameters in the Inspector
Center: Sets the position of the center of the circle.
Amount: Sets the percentage of the blur.
Inner Radius: Sets the inner radius of the circle.
Outer Radius: Sets the outer radius of the circle.

Dashboard controls
The Dashboard contains the Amount, Inner Radius, and Outer Radius controls.
**Zoom Blur**

This filter creates a blur that simulates a fast camera zoom in to a point.

![Original image](image1) ![Zoom Blur applied](image2)

**Parameters in the Inspector**

- **Amount**: Sets the radius of the blur, ranging from 0 (no blur) to 32.
- **Center**: Sets the position of the center of the blur.
- **Crop**: Toggles whether the object is cropped at its original boundaries.

**Dashboard controls**

The Dashboard contains the Amount control.

**Border Filters**

Border filters allow you to frame objects in a composition in various ways.

**Bevel**

Creates a bevelled border around the edges of an object by superimposing an angled frame over the original image. The simulated direction of reflected light and opacity of the bevel can be adjusted to vary the effect.

**Parameters in the Inspector**

- **Light Angle**: Sets the angle at which the light is hitting the bevel.
- **Bevel Width**: Sets the width of the bevel as a percentage of the area of the object.
- **Opacity**: Sets the opacity of the bevel, ranging from 0 (invisible) to 1.0 (opaque).
- **Light Color**: Picks the color of the light hitting the bevel border. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select colors.

**Dashboard controls**

The Dashboard contains the same controls as the Inspector.
**Simple Border**
Creates a solid color border of variable width around the edges of an object.

**Parameters in the Inspector**

**Size:** Sets the thickness of the border. Values can range from 0 (no border) to 100 pixels.

**Color:** Picks the color of the border. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select the color of the border.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Widescreen**
This filter "letterboxes" an object by masking the object at its top and bottom to simulate a variety of video and film aspect ratios. Because this filter is masking the image, what appears behind the object is either the background color of the project or the object that is beneath the masked object in the composite. You can also add an additional border to the masked image and customize the color and size of the border.

**Note:** Because the Widescreen filter is masking the object to which it is applied, the object is not cropped and retains its original shape.

**Parameters in the Inspector**

**Aspect Ratio:** Sets the aspect ratio of the mask. Values can be selected from the following: 1.66:1, 1.70:1, 1.78:1, 1.85:1, 2.35:1, 2.55:1, and 3.00:1.

**Offset:** Sets the position of the mask relative to the Y center of the object. Values range from -1.0 (the bottom of the object) to 0 (the center of the object) to 1.0 (the top of the object).

**Border Size:** Sets the thickness of the border. Values range from 0 (no border) to 10.

**Note:** The border has no effect on the aspect ratio mask, but merely adds an additional frame within the edge of the image created by the mask.

**Border Color:** Picks the color of the border. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select the color of the border.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.
Color Correction Filters
Color correction filters can be used in a number of ways. You can change a mood by making an object sepia colored, or to make your object stand out by oversaturating it. In addition, they can be used to “fix” a problem with contrast, color, or brightness.

Brightness
Boosts or lowers the uniform brightness of an image by the specified amount.

Although this may seem to be the first filter to use if you want to correct for improper exposure in an image, the drawback of this filter is that it boosts or lowers everything in an image at once. This means that raising the brightness in an image raises it everywhere, including in the shadows. The result is that a brightened image may look washed out.

On the other hand, this filter can come in very handy as a way to modify the edges and effects of shapes, masks, particle systems, and generators.

A better filter for exposure correction is the Gamma filter. For more information, see “Gamma” on page 731.

Parameters in the Inspector

Brightness: Sets the multiplying brightness value applied to the object. Values range from 0 (no brightness, black image) to 5.

Dashboard controls
The Dashboard contains the same Brightness control as the Inspector.

Channel Swap
Substitutes the color value of a color channel with that of either a selected channel, or its inverse. If you select Blue from Red, the value of blue in the object will match the value of red across the entire object. Channel swap can be used in a variety of ways, including simply inverting the alpha channel of an object.
Parameters in the Inspector

Red from: The numerical value of red is replaced by the numerical value of color of the selected channel. Values can be selected from Red (unchanged), Green, Blue, Alpha, Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.

Green from: Sets the value of green to the value of the selected channel. Values can be selected from Red, Green (unchanged), Blue, Alpha, Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.

Blue from: Sets the value of blue to the value of the selected channel. Values can be selected from Red, Green, Blue (unchanged), Alpha, Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.

Alpha from: Sets the value of the alpha to the value of the selected channel. Values can be selected from Red, Green, Blue, Alpha (unchanged), Inverse Red, Inverse Green, Inverse Blue, and Inverse Alpha.

Dashboard controls
The Dashboard contains the same controls as the Inspector.

Color Balance
Color balance generally refers to the overall tint of an image reflecting the color temperature of the primary source of light. For example, sunlight is generally bluer than interior tungsten light, which tends to be more orange. Although most film and video is shot to make sure that the whites in an image are a true neutral white, different film stocks and video color balance settings result in slight tints in the image.

Use this filter to adjust the color balance of an object by boosting or lowering the individual amount of reds, greens, and blues in the shadows, midtones, and highlights of an image. You can use this filter to correct for improper color balance, or to change the color balance in an image for a stylized effect.

Original image

Midtone Blue = 0.20, High Blue = -0.5
Parameters in the Inspector

Shadow Red: Picks the color gain applied to the shadow range of the red color channel. Values range from –1.0 (no color) to 0 (unaltered color) to 1.0 (maximum color).

Shadow Green: Picks the color gain applied to the shadow range of the green color channel.

Shadow Blue: Picks the color gain applied to the shadow range of the blue color channel.

Midtone Red: Picks the color gain applied to the midtone range of the red color channel.

Midtone Green: Picks the color gain applied to the midtone range of the green color channel.

Midtone Blue: Picks the color gain applied to the midtone range of the blue color channel.

Highlight Red: Picks the color gain applied to the highlights of the red color channel.

Highlight Green: Picks the color gain applied to the highlights of the green color channel.

Highlight Blue: Picks the color gain applied to the highlights of the blue color channel.

Dashboard controls
The Dashboard contains the same controls as the Inspector.

Color Reduce
Reduces the full range of color in an image down to two, three, or four colors that you select. Depending on the number of substitute colors you choose in the Reduce To parameter, this filter breaks down the full range of colors in the image into a color range for each Match Color parameter that's available. It then substitutes the selected Replace With color for each interpreted range of color.
If two colors are selected, all color information in the object is reduced to the selected two colors; if three, they are reduced to three; and so on.

Parameters in the Inspector

Smoothness: Sets the smoothness of the transitions between the reduced areas. Values range from 0 (hard edges) to 1 (smooth blending).

Reduce To: Selects the number of colors in the reduced object. Choices are 4 Colors, 3 Colors, or 2 Colors.

Match Color 1: Picks the color of the first selection color for reduction. The color picker can be expanded with the disclosure triangle to reveal Red, Green, Blue, and Alpha sliders for more precise color selection.

Replace With: Picks the color that is substituted for the selection determined by Color 1.

Match Color 2: Picks the color of the second selection color for reduction.

Replace With: Picks the color that is substituted for the selection determined by Color 2.

Match Color 3: Picks the color of the third selection color for reduction. This parameter is used only if Reduce To is set to 3 Colors or 4 Colors.

Replace With: Picks the color that is substituted for the selection determined by Color 3. This parameter is used only if Reduce To is set to 3 Colors or 4 Colors.

Match Color 4: Picks the color of the fourth selection color for reduction. This parameter is used only if Reduce To is set to 4 Colors.

Replace With: Picks the color that is substituted for the selection determined by Color 4. This parameter is used only if Reduce To is set to 4 Colors.

Dashboard controls
The Dashboard contains the same controls as the Inspector.
Colorize
Substitutes the blacks and whites in an image with different colors you select. All other colors in the image are remapped to a duochrome range that falls between these two colors.

Interesting colorized “negative” effects can be achieved by remapping the blacks in an image to a lighter color than the whites.

Original image  Colorize with defaults

Parameters in the Inspector

**Remap Black**: Sets the color that is mapped to black.

**Remap White**: Sets the color that is mapped to white. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select the color.

**Intensity**: Sets the strength of the colorization. Values range from 0 (no colorization) to 1.00.

Dashboard controls
The Dashboard contains the same controls as the Inspector.
Contrast
Adjusts the contrast of an object.

Parameters in the Inspector

Contrast: Sets the amount of contrast to be applied to the object. Values range from 0 (no contrast) to 1 (default contrast) to 2.00.

Pivot: Sets the center point of the contrast curve. Values range from 0 to 1.00.

Dashboard controls
The Dashboard contains the same controls as the Inspector.

Desaturate
Reduces the amount of color in an image by a specified amount. This filter can be used to mute the color in an image, making brighter colors less saturated. It can also be used to completely eliminate the color from an image, turning a color image to a grayscale one.

Parameters in the Inspector

Desaturation: Sets the amount of desaturation. Values range from 0 (no change) to 1.00 (full desaturation).

Luminance Type: Sets how the luminance type is calculated. Values can be selected from the following: NTSC, PAL, Film, Red, Green, and Blue. If NTSC, PAL, or Film is selected, luminance is calculated based on weighting for those standards; if a channel is selected, luminance is calculated using that channel.

Dashboard controls
The Dashboard contains the same controls as the Inspector.
**Equalize**
Remaps the black and white points in an image, resulting in individual adjustments to the contrast in the dark and light parts of an image. The Equalize filter can be used to adjust the overall contrast range of an image, crushing the whites and blacks, or it can be used to create selective washed out or darkened effects.

![Original image](image1) ![Equalize applied](image2)

**Parameters in the Inspector**

**Input Black**: Sets the relative color value used for black. Values range from 0 to 1.0.

**Input White**: Sets the relative color value used for white. Values range from 0 to 1.0.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Gamma**
The Gamma filter adjusts the relative distribution of brightness within the midtones of an image, while leaving the white and black points alone. The perceived result is to brighten and darken the areas of medium brightness within an image, while leaving the highlights and shadows alone. This avoids a washed-out result.

This is one of the most useful filters for correcting poor exposure in images, and should almost always be used first before trying the Brightness filter.

**Parameters in the Inspector**

**Gamma**: Sets the gamma correction. Values range from 0 to 5.

**Dashboard controls**
The Dashboard contains the same control as the Inspector.
Gradient Colorize
Colorizes an image, using color values instead of position to determine the application of the colors in the gradient.

Parameters in the Inspector

Gradient: Selects a gradient preset to be applied to the object, or is used to edit a custom gradient.

Offset: Sets an amount, in degrees, that the color wheel is offset to determine color application. Values start at 0 degrees.

Repeats: Sets the number of times the gradient repeats over the course of its range. Values range from 1 to 32.

Repeat Method: Sets the method by which the gradient is mapped when repeating. Values can be set to either Mirror (default) or Wrap. This parameter only affects the filter when Repeats is set to a number greater than 1.

Map Channel: Sets the channel used to determine how the image is colorized. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

Dashboard controls
The Dashboard contains the same controls as the Inspector, with the exception of the Gradient Editor.
**HSV Adjust**

An alternate method of performing color correction based on the HSV color model. HSV is often used in color picking interfaces, and is employed by the default color wheel method of the Apple Color Picker.

This filter provides controls to adjust the Hue, Saturation, and Value levels in an image, independently. The Hue control is an angular representation of the color values in an image. By rotating the Hue angle, you uniformly remap the colors throughout an image, similar to the effect of turning the hue or phase knob of a broadcast monitor.

The saturation controls the intensity of the color in an image, with a high saturation resulting in vivid color, and a low saturation resulting in a grayscale image with no color at all. The Value slider, on the other hand, adjusts the overall brightness or darkness of all colors in an image, including the blacks and whites in a desaturated image.

**Parameters in the Inspector**

- **Hue**: Sets the angle of adjustment used to set the zero point of the color wheel.
- **Saturation**: Sets the color saturation of the object, ranging from –1.0 (no color information) to 0.0 (unadjusted color) to 3.0.
- **Value**: Sets the intensity adjustment applied to the object, ranging from 0.0 to 2.0.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Invert**

Inverts all color and brightness in an image. This filter can be used to turn a scanned negative image into a properly displayed positive.

![Original image](image1.png) ![Image inverted](image2.png)

**Parameters in the Inspector**
There are no parameters for this filter.
Dashboard controls
There are no controls for this filter in the Dashboard.

Levels
This filter provides controls to remap the white and black points of an image, along with a Gamma control to adjust the midtones, all at once. A histogram provides an analysis of the image that you can use to help you judge the adjustments you want to make.

A powerful option within this filter is the ability to make independent adjustments to the red, green, blue, and alpha channels of an object.

Parameters in the Inspector

Histogram: An analysis of the object. By default, the RGB channels are selected. A pop-up menu can be used to select red, green, blue, or alpha channels individually for viewing.

For each channel parameter (RGB, Red, Green, Blue, Alpha, and Gamma):

Black In: Sets the In point for black, below which values are considered black. The parameter ranges from 0 to 1.

Black Out: Sets the Out point for black, above which values are not considered black.

White In: Sets the In point for white, below which values are considered white.

White Out: Sets the Out point for white, above which values are not considered white.

Gamma: Sets the amount of gamma correction. This parameter ranges from 0 to 5.00.

Dashboard controls
There are no controls for this filter in the Dashboard.

Negative
Simulates the effect of turning an image into a film negative.

There are no parameters for this filter.
Dashboard controls
There are no controls for this filter in the Dashboard.

**Saturate**
Increases or decreases the amount of color in an image by a specified amount. This filter can be used to mute the color in an image, making brighter colors less saturated. It can also be used to completely eliminate the color from an image, turning a color image to a grayscale one.

**Parameters in the Inspector**

**Saturation:** Sets the color saturation of the object, ranging from -1.0 (no color information) to 0.0 (unadjusted color) to 3.0.

Dashboard controls
The Dashboard contains the same control as the Inspector.

**Sepia**
Tints an overall object with a sepia tone. The blacks and whites are remapped to dark and light sepia colors. The amount of tinting can be adjusted, to achieve either a subtle mix of the original and tinted colors, or a completely tinted image.

This filter is good for that “old-time western” look.

**Parameters in the Inspector**

**Intensity:** Sets the amount of sepia tone applied to the object. Values range from 0 (no sepia tone) to 1.00 (100 percent sepia).

Dashboard controls
The Dashboard contains the same control as the Inspector.
**Threshold**
Reduces all colors in an image to a duotone, with the additional ability to limit the range of midtones that are preserved in the image. The result is an extremely high-contrast image that defaults to black and white, although you can reduce the image to any two colors.

![Original image](image1) ![Dark color: black. Light color: white](image2)

**Parameters in the Inspector**

**Threshold:** Sets the threshold of selection for color substitution. Values range from 0 to 1.00. The threshold determines what will be considered light and what will be considered dark areas of the object.

**Smoothness:** Sets the smoothness of transition between the two colors substituted, with values ranging from 0 to 1.00.

**Dark Color:** Picks the color used to represent the dark interpreted areas of the object. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders, for more precise color selection.

**Light Color:** Sets the color used to represent the light interpreted areas of the object.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Tint**
Tints an entire image with a single color. Shadows and highlights are less affected, but all of the midrange colors in the image are gradually replaced with the tint color as the Intensity parameter is increased.

**Parameters in the Inspector**

**Color:** Picks the color that is used to tint the object. The color picker can be expanded with the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Intensity:** Sets the amount of tint applied to the object.
Dashboard controls
The Dashboard contains the same controls as the Inspector.

Distortion Filters
Distortion filters are used to change the basic shapes of your objects, warping, twisting, and pulling them in all directions.

Basic 3D
Allows you to rotate an object on the X, Y, and Z axes, and set its position and perspective.

Parameters in the Inspector

X Rotation: Sets the amount, in degrees, that the object is rotated along the X axis.

Y Rotation: Sets the amount, in degrees, that the object is rotated along the Y axis.

Z Rotation: Sets the amount, in degrees, that the object is rotated along the Z axis.

Distance: Sets the distance the object is pushed away from the Canvas. Values range from 0 to 1.

Perspective: Sets the amount of perspective shift placed on the object. Values range from 0 to 1.

Back Face: An image well to which you can drag an object to use as the "back" side of a rotated object.

Back Face Style: A pop-up menu that contains fit and display options for the object in the Back Face image well:

• Center: Positions the object in the Back Face image well in the center of the rotated object.

• Stretch: Stretches the object in the Back Face image well to the size of the rotated object.

• Transparent: Hides the object in the Back Face image well.


Dashboard controls
The Dashboard contains the same controls as the Inspector.

Black Hole
This filter appears to suck an image into a center point as the value of the Amount parameter increases. The top, bottom, and sides bow in as if being pulled inward.

Parameters in the Inspector

Center: Sets the position of the center of the black hole.

Amount: Sets the amount of force pulling on your object. Values range from 0 (no gravity) to 1000 (the entire object is pulled into the black hole).

Dashboard controls
The Dashboard contains the Amount control.

Bulge
This filter appears to push an image outward, as if something were bulging it out from behind.
Parameters in the Inspector

**Center:** Sets the position of the center of the bulge.

**Amount:** Sets the amount of the bulge. Values range from 0 (no bulge) to 1000.

**Scale:** Sets the direction and scale of the bulge. Values range from –10 (the maximum bulge inwards) to 10 (the maximum bulge outwards).

Dashboard controls
The Dashboard contains the Amount and Scale controls.

**Bump Map**
This filter uses a source object to define a bump pattern which can be used to deform an object, with parameters to control the amount of distortion. You can use any image, movie, or shape as the source object.

When this filter is initially applied, Bump Map behaves as if there were a black image applied to the Map Image well, which does not distort the target image at all.

To learn how to add an object to the Map Image well, see “Compound Blur” on page 716.

Parameters in the Inspector

**Map Image:** An image well that displays a thumbnail of the map chosen.

**Direction:** Sets the angle at which the bump map protrudes.

**Amount:** Sets how far the bump map protrudes. Positive values push upward, negative values push downward.

**Repeat Edges:** Sets whether or not the edges of the object are repeated.

Dashboard controls
The Dashboard contains the Map Image, Direction, and Amount controls.
Disc Warp
Stretches the image outward around a circular region. As the radius of the warping region increases, the image is warped outward with a greater amount of distortion. The color of the resulting disk is determined by the color value of the pixel where the center is placed.

Parameters in the Inspector

Center: Sets the position of the center of the disc.

Radius: Sets the size of the disc. Values range from 0.01 to 1000.

Dashboard controls
The Dashboard contains the Radius control.

Displace
This filter uses an image to define a displacement region within the image, with parameters to control the horizontal and vertical scale of displacement. You can use any image, movie, or shape as the source image.

When this filter is initially applied, Displace behaves as if there were a black image applied to the Map Image well, which does not displace the target.
To learn how to add an object to the Map Image well, see “Compound Blur” on page 716.

Parameters in the Inspector

Map Image: An image well that displays a thumbnail of the map chosen.

Horizontal Scale: Sets the horizontal scaling of the object, ranging from –2.00 to 2.00.

Vertical Scale: Sets the vertical scaling of the object, ranging from –2.00 to 2.00.

Repeat Edges: Toggles whether or not the edges of the object are repeated.

Dashboard controls
The Dashboard contains the Map Image, Horizontal Scale, and Vertical Scale controls.

Droplet
This filter simulates the effect of a drop of liquid falling onto the surface of a pool, with your image displaced as the surface of the pool. This filter is not automatically animated, but animating the Width parameter of this filter creates the effect of the ripples spreading out from the center.
Parameters in the Inspector

**Center:** Sets the position of the center of the droplet effect.

**Radius:** Sets the radius of the droplet effect. Values range from −50 to 950.

**Height:** Sets the height of the droplet ripples. Values range from −50 to 50.

**Width:** Sets the width of the rippling waves from the droplet. Values range from 0 to 100.

Dashboard controls
The Dashboard contains the Radius, Height, and Width controls.

**Earthquake**
Creates an animated displacement effect on an object, adjusting its position as if shaken by an earthquake.

Parameters in the Inspector

**Twist:** Sets the amount the object is rotated as it is displaced. Values range from 0 to 1.

**Horizontal Shake:** Sets the maximum amount the image is displaced horizontally. Values range from 0 to 1.

**Vertical Shake:** Sets the maximum amount the image is displaced vertically. Values range from 0 to 1.

**Motion Blur:** Sets the amount of motion blur applied to the object. Values range from 1 to 8.

Dashboard controls
The Dashboard contains the Twist, Horizontal Shake, Vertical Shake, and Motion Blur controls.
Fisheye
Distorts an object as if it were seen through the view of a fisheye lens. The result is an extremely wide-angle warping effect which is also known as barrel distortion.

You can try using the Fisheye filter with a negative Amount value as an imprecise way to correct for certain types of barrel distortion in images that were shot using a wide-angle lens.

Parameters in the Inspector

Radius: Sets the radius of the fisheye lens effect. Values range from 0 (nothing distorted) to 2 (maximum distortion).

Amount: Sets the amount and nature of the distortion. Values range from –100 (completely concave distortion) to 0 (no distortion) to 100 (completely convex distortion).

Center: Sets the position of the center of the fisheye effect.

Dashboard controls
The Dashboard contains the Radius and Amount controls.

Flop
Reverses an image horizontally, vertically, or in both directions. As opposed to “flip-out,” as practiced by certain fictionalized schools of ninja.

Parameters in the Inspector

Flop: Sets the direction in which the object is flopped. Values can be selected from the following: Horizontal, Vertical, or Both.

Dashboard controls
The Dashboard contains the same control as the Inspector.
Fun House
Simulates the distortion caused by an imperfectly shaped mirror, similar to those in a
carnival fun house.

Parameters in the Inspector

Center: Sets the position of the center of the fun house mirror.

Width: Sets the width of the fun house mirror. Values range from 1 to 1000.

Amount: Sets the amount of distortion of the fun house mirror. Values range from 1 to
100.

Angle: Sets the angle at which the fun house mirror is set.

Dashboard controls
The Dashboard contains the Width, Amount, and Angle controls.

Glass Block
This filter cuts an object into a series of tiles and offsets the portion of the image within
each tile to create a duplicated pattern effect. The number of tiles into which the image
is broken, and the amount that each portion of the image is offset, can be customized.
Parameters in the Inspector

**Center:** Sets the position of the origin of the glass block effect.

**Scale:** Sets the scale of the portions of the duplicated parts. Values range from 0.10 to 10.00.

**Angle:** Sets the angle of offset used to sample the duplicated parts.

**Tile Size:** Sets the size of the glass blocks. Values range from 1 to 1000.

**Dashboard controls**
The Dashboard contains the Scale, Angle, and Tile Size controls.

**Glass Distortion**
Simulates the effect of your object being deformed as it shows through a piece of glass. An image well lets you assign an object to use as the pattern in the glass, using any image, movie, or shape. Other parameters let you control the scale and amount of distortion.

When this filter is initially applied, Glass Distortion behaves as if there were a black image applied to the Map Image well, which will leave the target object unchanged.

To learn how to add an object to the Map Image well, see “Compound Blur” on page 716.

Parameters in the Inspector

**Map Image:** An image well that displays a thumbnail of the image map chosen.

**Center:** Sets the position of the center of the tiling of the glass distortion.

**Scale:** Sets the relative scale of the map image. Values range from 0 to 2.

**Amount:** Sets the amount of offset. Values range from 0 to 2000.

**Softness:** Sets how much blur is applied to the map image. Values range from 0 to 5.

**Dashboard controls**
The Dashboard contains the Scale, Amount, and Softness controls.
**Insect Eye**
Maps a repeating hexagonal distortion pattern to an image, mimicking the POV of an insect.

![Original image](image1) ![Insect Eye applied](image2)

**Parameters in the Inspector**

**Size:** Sets the size of the hexagons. Values range from 8 to 128.

**Refraction:** Sets the amount of refraction applied by each hex. Values range from 0 to 4.

**Border:** Sets the width, in pixels, of the border of each hex. Values range from 0 to 8.

**Border Color:** Picks the color of the border of the hexagons. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders, for more precise color selection.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Mirror**
By default, this filter splits an image in half vertically, and reverses the remaining half to create a reflection. The center point and angle of this split point can be customized. This filter is excellent for recreating the magic of 1980s music videos.

**Parameters in the Inspector**

**Center:** Sets the position of the center of the mirror.

**Angle:** Sets the angle of the mirror’s orientation.

**Dashboard controls**
The Dashboard contains the Angle control.
**Poke**

Pushes the object into the Canvas at a specified point, as if it were poked. This filter is a subtler version of the Black Hole filter, described on page 738.

**Parameters in the Inspector**

**Center:** Sets the position of the center of the poke.

**Radius:** Sets the radius of the poke effect. Values range from 0 (a point) to 1000.

**Scale:** Sets the scale of the distortion. Values range from 0 (no pinching) to 1.

**Dashboard controls**

The Dashboard contains the Radius and Scale controls.

**Refraction**

Creates a glass-distortion effect on an image, with an optional height map.

**Parameters in the Inspector**

**Softness:** Sets the amount of softness applied to the refracted edges. Values range from 0 to 1.
**Refraction:** Sets the amount that the image is refracted. Values range from 0 to 200.

**Height Map:** An image well that displays a thumbnail of the height map chosen. The height map is used to determine the edges along which the image is refracted.

**Map Channel:** Sets the channel which is used to determine how the image is refracted. If a height map is present, the channel is selected from the height map, otherwise the channel is selected from the source object. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Ring Lens**
This filter creates a ring of distortion over the image. The result can be a donut-like bulge in the image.

Parameters in the Inspector

**Center:** Sets the position of the center of the lens.

**Radius:** Sets the radius of the ring. Values range from 0 to 1000.

**Thickness:** Sets the thickness of the ring as a percentage of the radius. Values range from 0 (no thickness) to 1.00 (no hole in the center of the ring lens).

**Refraction:** Sets the amount of refraction of the lens. Values range from −5 to 5.

**Dashboard controls**
The Dashboard contains the Radius, Thickness, and Refraction controls.
Ring Warp
Similar to the Ring Lens, but the image is distorted with multiple concentric rings. The number of rings can be increased or decreased using the Radius and Refraction parameters.

Parameters in the Inspector

Center: Sets the position of the center of the rings.

Radius: Sets the radius of the rings. Values range from 0.01 to 200.

Refraction: Sets the amount of refraction. Values range from 0 to 20.

Dashboard controls
The Dashboard contains the Radius and Refraction controls.

Ripple
Creates animated ripples over the surface of an object. This filter is automatically animated to create an undulating effect on the surface of the affected image. The amplitude can be adjusted to increase or decrease the rippling effect.

Parameters in the Inspector

Center: Sets the position of the origin of the effect.

Amplitude: Sets the width of the waves. Values range from 0 to 100.

Crop: Toggles whether the object is cropped at its original boundaries.

Dashboard controls
The Dashboard contains the Amplitude control.
Scrape
Smears an image along an angle defined by the Rotation parameter. The Scrape effect starts at the center point, and continues to the edge of the object.

Parameters in the Inspector

Center: Sets the position of the center of the scrape.

Rotation: Sets the angle of rotation of the scrape.

Amount: Sets the ramping of the number of pixels spread across the range of the scrape. Values range from 0 (very gradual) to 200 (hard edge).

Dashboard controls
The Dashboard contains the Rotation and Amount controls.

Sphere
Simulates the effect of an image being wrapped around a sphere. This filter can be used to turn an image of a map into an imprecise globe.

Parameters in the Inspector

Center: Sets the position of the center of the sphere.

Radius: Sets the radius of the sphere. Values range from 0 to 1000.

Dashboard controls
The Dashboard contains the Radius control.
**Starburst**
Radiates solid-colored rays out from the center of your object. The colors are derived from pixel values around the selected center point, with the number of colors used determined by the Radius parameter.

Parameters in the Inspector

**Center:** Sets the position of the center of the starburst.

**Radius:** Sets the radius of pixel sampling for ray color determination. Values range from 0.01 to 200.

Dashboard controls
The Dashboard contains the Radius control.

**Stripes**
By default, this filter turns your object into a series of vertical stripes. The angle of generated stripes can be changed using the Angle parameter. The stripe colors are derived from pixel values around the selected center point, with the distribution of colors determined by the Offset parameter.
Parameters in the Inspector

Center: Sets the position of the center of the stripe effect.

Angle: Sets the angle of the stripes.

Offset: Sets the angle of pixel sampling used for sampling pixel color values.

Dashboard controls
The Dashboard contains the Angle and Offset controls.

**Target**
Similar to the Stripes filter, but draws bands of concentric circles outward from the center point value. The target colors are derived from pixel values around the selected center point, with the distribution of colors determined by the Angle parameter.

![Original image](image1.png) ![Target applied](image2.png)

Parameters in the Inspector

Center: Sets the position of the center of the target.

Angle: Sets the angle of the line used to select pixels for the bands of circles in the target.

Dashboard controls
The Dashboard contains the Angle control.

**Twirl**
Twirls an image like a fork twisting a plate of spaghetti. The image appears to stretch from the sides to the center around in a spiral. The amount of spiraling is determined by the Twirl parameter.

Parameters in the Inspector

Amount: Sets the amount of the twirl. Values range from 0 (no twirl) to 1.00 (maximum twirl).
**Twirl:** Sets the angle of twirl.

**Center:** Sets the position of the center of the twirl.

**Crop:** Toggles whether the object is cropped at its original boundaries.

**Dashboard controls**
The Dashboard contains the Amount and Twirl controls.

**Wave**
Distorts the object to simulate waves oscillating across it. The wave filter is not automatically animated, but you can animate the Offset parameter to animate the effect of waves causing the image to undulate.

**Parameters in the Inspector**

**Amplitude:** Sets the amplitude of the waves. Values range from 0 to 100.

**Wavelength:** Sets the length of the waves. Values range from 1 to 100.

**Offset:** Sets the offset of the wave, with values ranging from –500 to 500.

**Vertical:** Toggles whether the waves run vertically or horizontally.

**Repeat Edges:** Toggles whether or not the edges of the object are repeated.

**Dashboard controls**
The Dashboard contains the Amplitude, Wavelength, Offset, and Vertical controls.

**Glow Filters**
Glow filters combine blur with brightness and color effects. The results are automatically recomposited over the original image in many different ways. Glows can be used to simulate film effects, as a method to make your footage more abstract, or used more subtly, as accents to make individual elements in a composition stand out.
Aura
This is a highly stylized filter that adds light or dark halos around well-defined areas of an image. The resulting glow appears solarized, and the underlying image creates outlines that show through the glow effect.

Parameters in the Inspector

**Inner Radius**: Sets the amount the aura is offset from the object. Values range from 0 to 32.

**Outer Radius**: Sets the amount the aura extends from where it starts. Values range from 0 to 32.

**Brightness**: Sets the brightness of the aura. Values range from 0 to 100.

**Crop**: Toggles whether or not the aura is cropped at the original boundaries of the object.

Dashboard controls
The Dashboard contains the Inner Radius, Outer Radius, and Brightness controls.
Bloom
This filter simulates the effect of extremely overexposed highlights on film. Highlights above a certain threshold are blurred, brightened, and recomposed with the original. All unaffected regions of the image interact with the glow effect, but otherwise retain their detail.

Parameters in the Inspector

**Amount**: Sets the amount of the bloom. Values range from 0 (no bloom) to 32.

**Brightness**: Sets the brightness of the bloom. Values range from 0 to 100.

**Threshold**: Sets the luminance threshold at which the bloom starts. Values range from 0 to 100.

**Horizontal**: Sets the distance of the bloom's horizontal offset. Values range from 0 to 100.

**Vertical**: Sets the distance of the bloom's vertical offset. Values range from 0 to 100.

**Crop**: Toggles whether or not the bloom is cropped at the original boundaries of the object.

Dashboard controls
The Dashboard contains the Amount, Brightness, and Threshold controls.
**Dazzle**
This filter adds glowing star-shaped accents to the highlights in an image. This filter can be customized to create anything from subtle highlights to outrageous, colorful flashes of color.

![](https://via.placeholder.com/150)

**Parameters in the Inspector**

**Amount:** Sets the radius of the spikes from the glow of Dazzle. Values range from 0 to 60.

**Angle:** Sets the angle of rotation of the spikes from Dazzle.

**Brightness:** Sets the amount of brightness of the glow of Dazzle. Values range from 0 to 100.

**Threshold:** Sets the luminance threshold of the glow. Values range from 0 to 100.

**Spike Count:** Sets the number of spikes coming off of the glows. Values range from 3 to 10.0.

**Crop:** Toggles whether or not the glowed object is cropped at its original borders.

**Dashboard controls**
The Dashboard contains the Amount, Angle, Brightness, Threshold, and Spike Count controls.
**Gloom**
This filter creates a muted, darker glow. The image is darkened, and areas of fine detail are evened out into larger regions of color. It’s spooky.

![Original image](image1) ![Gloom applied](image2)

**Parameters in the Inspector**

**Radius**: Sets the radius of the gloom. Values range from 0 to 100.

**Amount**: Sets the amount of gloom. Values range from 0 (no gloom) to 2 (maximum gloominess).

**Dashboard controls**
The Dashboard contains the Radius and Amount controls.

**Glow**
The most basic glow filter in this category, which can be customized for a wide variety of effects.

**Parameters in the Inspector**

**Radius**: Sets the radius of the glow. Values range from 0 to 100.

**Opacity**: Sets the opacity of the glow. Values range from 0 to 3.0.

**Threshold**: Sets the luminance threshold at which the glow begins. Values range from 0 to 1.0.

**Softness**: Sets the amount of softness applied to the glow. Values range from 0 to 1.0.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.
**Light Rays**
A glow filter that uses the zoom blur to distribute the resulting glow, instead of a gaussian blur. The effect is that of light rays shining through an object from a specified point.

Parameters in the Inspector

**Amount:** Sets the amount of the light ray effect. Values range from 0 to 200.

**Center:** Sets the position of the center point of the light source.

**Glow:** Sets the brightness multiplier of the light rays. Values range from 0 to 8.

**Expansion:** Sets the length of the light rays. Values range from 0 to 2.

Dashboard controls
The Dashboard contains the Amount and Glow controls.

**Outer Glow**
Adds a glow to the alpha channel of an object. The result is a glow around the outside of an object, while the object’s actual image is unaffected.

Parameters in the Inspector:

**Radius:** Sets the size of the glow. Values range from 0 to 15.

**Brightness:** Sets the brightness of the glow. Values range from 0 to 100.

**Inner Color:** Picks the inner color of the glow. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Outer Color:** Picks the outer color of the glow.

**Range:** Sets the gradient position between the two glow colors. Values range from 0 to 1.0.
Horizontal: Sets the amount of horizontal offset for the glow. Values range from 0 to 100.

Vertical: Sets the amount of vertical offset for the glow. Values range from 0 to 100.

Crop: Toggles whether or not the object is cropped at its original boundaries.

Dashboard controls
The Dashboard contains the Radius, Brightness, Inner Color, Outer Color, and Range controls.

Overdrive
Creates an animated glow effect by compositing numerous glowing tinted duplicates of the original image. Fine detail is lost, and the highlights of the image are emphasized. You can customize the inner glow and outer glow colors.

Parameters in the Inspector

Intensity: Sets the number of samples. Values range from 0 to 32.

Size: Sets the radius of the effect. Values range from 0 to 32.

Rotation: Sets the angle of rotation of the collected offsets. Values range from 0 to 360 degrees.

Inner Glow: Picks the color of the inner part of the glow. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

Outer Glow: Picks the color of the outer part of the glow.

Dashboard controls
The Dashboard contains the same controls as the Inspector, with the exception of Crop.
**Keying Filters**

Keying filters are used to isolate a subject that is surrounded by an area of fairly uniform color or brightness, by generating an alpha channel based on the shape of that area. Keying is most commonly performed on subjects that were shot against a blue- or green-colored background, but keys can also be based on brightness values.

A common example of color keying is the meteorologist on TV. This person is always seen standing in front of an animated map of the weather, but in reality he or she is standing in front of a big greenscreen. As part of the broadcast, the greenscreen is keyed out, and replaced by the map. You can do the same thing in Motion.

**Important:** Keying a foreground subject is not always easy, and it takes time and patience to learn how to use the parameters in each filter to achieve the best effect. Even so, most keys are pulled using more than one tool to do the job. Good compositing artists usually combine one or more masked keying filters, Matte Choker filters, a Spill Suppressor filter, and one or more garbage and holdout masks to isolate a single subject. For more information on techniques you can use to improve a key, see “Performing Multiple Keys on a Single Subject” on page 872.

**Blue Green Screen**

The Blue Green Screen filter is intended for subjects that were shot in front of a bluescreen or greenscreen. This filter renders the blue or green areas of the image transparent, allowing one or more background images to show through.

**Parameters in the Inspector**

- **Key:** Selects one of three keying modes: blue, green, or blue/green difference.
- **Color Level:** Sets the percentage of color purity being keyed. Values range from 0 to 100.
- **Tolerance:** Sets the color tolerance for your key. Values range from 1 to 100.
- **Edge Thin:** Sets the amount of thinning done at the edges of the matte. A positive value erodes the matte edge. Values range from -100 to 100.
- **Invert Matte:** Toggles whether or not the matte is inverted.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Color Key**

This filter can pull a key based on any color you select. Bear in mind that if the color is too close to that of the subject you're trying to isolate, parts of your foreground subject may disappear as well. The resulting effect renders the selected color transparent, allowing a background image to show through.
Chapter 10  Using Filters

Parameters in the Inspector

**Color:** Picks the color for your key. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Tolerance:** Sets the color tolerance for your key. Values range from 0 to 1.

**Invert Matte:** Toggles whether or not the alpha channel of your color key is inverted.

Dashboard controls
The Dashboard contains the same controls as the Inspector.

**Luma Key**
Luma Key pulls a key from your object based on a selected brightness level. This can be effective if you're keying a subject that was shot against a solid white or black background, and exposed so that there are no absolute highlights or shadows within the foreground subject. Despite this, shadows and highlights in the image usually make this a difficult filter with which to pull a perfect key.

Parameters in the Inspector:

**Key Mode:** Sets the mode used to calculate the luminance value of your object. The modes can be selected from the following: Key Out Brighter, Key Out Darker, Key Out Similar, or Key Out Dissimilar.

**Luminance:** Sets the type of luminance that is keyed. The types can be selected from the following: NTSC, PAL, Film, Red, Green, and Blue.

**Threshold:** Sets the threshold of the key. Values range from 0 to 1.

**Tolerance:** Sets the tolerance of the threshold. Values range from 0 to 1.

Dashboard controls
The Dashboard contains the same controls as the Inspector.

**Primatte RT**
The Primatte RT filter is a high-quality keying filter, which renders the blue or green areas of the image transparent, allowing one or more background images to show through.

Parameters in the Inspector

**Output Type:** Sets the output type of the keyer. Select values from the following: Foreground, Background, Processed Foreground, and Matte.
**Backing Color**: Pick the backing color for the matte. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection. In addition, clicking the color well opens the Colors window, which allows you use the color picker to select a color from the object.

**Auto Sample**: Automatically samples the dominant color type in the image to be used for the key. Select Red, Green, or Blue.

**Replacement Color**: Picks the color to be used to fill in pixels in spill and transition areas. The intelligent edge smoothing of the Primatte RT filter can take pixel color values from the background to substitute in spill and transition areas.

**Noise Removal**: Sets the threshold for noise removal. Values range from 0 to 0.94.

**Matte Density**: Sets the density of the matte. Values range from 0 to 1. This value cannot be set to a value lower than Noise Removal.

**Spill Suppression**: Sets the amount of spill suppression applied to the matte. Values range from 0 to 1. This value cannot be set to a value lower than Noise Removal.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**An Example Using Primatte RT**
Getting the basics down of using Primatte RT is easy. Here's an example.

**To do a simple composite using Primatte RT:**

1. Import a background image into your project.
2 Import the foreground image for which a matte needs to be generated.

3 Select the foreground object, and turn off the background to directly observe the filter's effects.

4 Apply the Primatte RT filter to the object.

The Primatte RT filter makes a guess as to the non-subject color you are trying to remove. It makes a guess based on the dominant color present in the image, which may or may not be the color of the background. For example, if the image is a large red object that obscures most of a greenscreen, Primatte RT selects Red as its base sample. In this case, however, Primatte RT correctly guesses that you're trying to key out the blue color. If Primatte RT's guess is incorrect, use the Auto Sample buttons to choose a different color.
Tweaking the Noise Removal parameter can help for blue or greenscreens that have some variance in their color value. Additionally, the darker areas of your object can fool the keyer’s defaults, so in order to get a clean matte you may have to adjust Matte Density so the background doesn’t show through these dark areas. Lastly, Spill Suppression can be used to reduce bluescreen reflections or interactions with the foreground object.

5 Turn on the background layer.

**Spill Suppressor**
Whenever you key an image that was shot against a blue or greenscreen, there’s a good chance that some color reflected off of the screen and illuminated the edge of the foreground subject. This fringing around the edge of the subject is called *spill*, and is usually difficult to eliminate because it’s actually part of the subject you’re trying to preserve. The Spill Suppressor filter deals with this by tinting the keyed color in order to turn it into a neutral tone.

*Note:* The Spill Suppressor may inadvertently tint other areas of the foreground subject in addition to the colored fringe, so adjust its settings with care.

**Parameters in the Inspector**

- **Spill Type:** Sets the type of spill to be suppressed. Select Blue or Green.
- **Amount:** Sets the amount of spill to be suppressed. Values range from 0 to 1.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.
Matte Filters
Matte filters are used to modify mattes.

Matte Choker
This filter increases or decreases the semi-transparent area of an object’s alpha channel by performing a gamma correction (similar to the Gamma color correction filter) to all regions of the alpha channel falling between solid black and solid white. This allows you to widen or narrow the semi-transparent areas within an object, while leaving all 100 percent solid and transparent areas unaffected.

Parameters in the Inspector

Edge Thin: Higher positive edge thin values eat into the alpha channel, eliminating fringing around the edges of translucent areas. Negative values fill in translucent areas, filling in holes and widening the matte into regions of fringing.

Feather: Lower values reduce the amount of translucency in a matte, but this results in harder edges around holes and edges in the alpha channel.

Dashboard controls
The Dashboard contains the Edge Thin and Feather controls.

Set Matte (Obsolete)
This filter lets you apply the alpha channel from one object to another. You can also deploy this filter to use any color or luminance channel from an image as an alpha channel.

Important: This filter is no longer available in Motion. It is present in Motion 1.0 projects that already have it applied. Use Image Mask to duplicate its functionality. See “Applying Image Masks to an Object” on page 865.

Parameters in the Inspector

Matte Source: Lets you set the object to use as a matte.

Matte Channel: Lets you choose which channel of the matte source image to use as a matte. The choices are Red, Green, Blue, Alpha, Luminance, On, and Off.

Invert Matte: Turning this checkbox on inverts the matte effect that is created.

Stretch Matte: Turning this checkbox on stretches the source image to the same size as the object being matted.

Composite Matte: Toggles whether or not the matte being attached adds to the existing matte, or replaces it.

Dashboard controls
The Dashboard contains the same controls as the Inspector.
Sharpen Filters
These filters sharpen images by creating a high contrast overlay that emphasizes edges within the image.

Sharpen
Sharpens an image by enhancing the color contrast around edges within the image.

Parameters in the Inspector
Intensity: Sets the intensity of the sharpening. Values range from 0 to 2.
Amount: Sets the amount of the sharpening. Values range from 0 to 100.

Dashboard controls
The Dashboard contains the Amount and Intensity controls.

Unsharp Mask
Similar to Sharpen, this filter provides many more options to refine and control the amount of sharpening applied to the image.

Parameters in the Inspector
Radius: Sets the amount of the mask's effect. Values range from 0 to 32.
Amount: Sets the amount of the multiplier used to sharpen the object's edges. Values range from 0 to 2.
Threshold: Sets the threshold of luminance difference to be considered as a high contrast range, between 0 and 1.
Horizontal: Sets the horizontal width of the unsharp mask. Values range from 0 to 100.
Vertical: Sets the vertical scale of the unsharp mask. Values range from 0 to 100.

Dashboard controls
The Dashboard contains the Radius, Amount, and Threshold controls.
Stylize Filters
Unlike distortion filters, which warp and deform an image, filters in the stylize subcategory make an image appear as if it was created with a different medium.

Circle Screen
This filter reduces an image to a high-contrast grayscale version of itself. It then screens it using a pattern of concentric circles, simulating a sort of etched screening technique. The image is represented by varying thicknesses in the circular pattern.

Parameters in the Inspector
Center: Sets the position of the center of the circle screen.
Scale: Sets the scale of the circle screen. Values range from 0 to 100.
Contrast: Sets the contrast level. Values range from 0 to 0.99.

Dashboard controls
The Dashboard contains the Scale and Contrast controls.

Color Emboss
This filter traces high-contrast edges in the image with darker versions of the color already in the image. This gives the object the appearance of being stamped into the Canvas, while retaining the colors of the original image. The Direction and amount of Relief can be customized.

Parameters in the Inspector
Direction: Sets the angle of direction of the offset emboss.
Relief: Sets the amount of the offset. Values range from 0 to 3.

Dashboard controls
The Dashboard contains the same controls as the Inspector.
**Crystallize**
This mosaic filter simulates the effect of viewing an image through a pane of glass with irregular facets patterned into it. These facets give an image a crystallized appearance. This filter is automatically animated, and the facets appear to shift and turn according to the value in the Speed parameter. To prevent the facets from moving, set the Speed to zero.

![Original image](image1.png)  ![Crystallize applied](image2.png)

**Parameters in the Inspector**

- **Size**: Sets the size of the facets. The facets range in size from 3 (tiny) to 64 (huge).
- **Speed**: Sets the speed of the animation of the facets. Values range from 0 to 2.
- **Smooth**: Toggles whether facet colors are based on average values in the area they are replacing, or single samples taken from the center of the facet.
- **Feathering**: Sets the amount of feathering that is applied to the edges of the facets. Values range from 0 to 2.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.
**Edge Work**
This filter reduces an image to a high-contrast, grayscale version of itself. The detail in this grayscale image can then be reduced and smoothed using various parameters to create an image that resembles something hand-drawn. Depending on the amount of smoothing you apply, many different effects are possible with this filter.

![Original image][1] ![Edge Work applied][2]

**Parameters in the Inspector**

- **Radius**: Sets the radius of transition between light and dark areas. Values range from 0 to 100.
- **Blur**: Sets the amount the image should be blurred before edge detection. Values range from 0 to 3.5.
- **Amount**: Sets the amount of contrast between light and dark areas. Values range from 0 to 30.
- **Smoothness**: Sets the smoothness of the edge lining, ranging from 0 to 5.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.
**Edges**

An edge detection filter that examines the luminance of an image to derive the high contrast borders between different regions of brightness. These edges are then traced, and all other detail is replaced by black. The amount of eliminated detail depends on the value of the Intensity parameter. The colors of the resulting highlights are intensified variants of the colors from the original image.

![Original image](image1.png) ![Edges applied](image2.png)

**Parameters in the Inspector**

**Intensity:** Sets the intensity of the edges. Values range from 0 to 50.

**Dashboard controls**

The Dashboard contains the Intensity control.

**Extrude**

Gives an object with an alpha channel simulated depth, by creating a “front” and “back” side, then offsets them and extrudes the edges so they connect.

![Original image](image3.png) ![Extrude applied](image4.png)
Parameters in the Inspector

**Front**: Sets the position of the center point of the front face of the object. Values are coordinates.

**Front Size**: Sets the size of the front object, as a proportion of its original size. Values range from 0 to 2.

**Back**: Sets the position of the center point of the back face of the object. Values are coordinates.

**Back Size**: Sets the size of the back object, as a proportion of its original size. Values range from 0 to 2.

**Face Brightness**: Sets a brightness level applied to the face of the object. Values range from 0 to 2.

**Front Brightness**: Sets a brightness level applied to the front of the object. Values range from 0 to 2.

**Back Brightness**: Sets a brightness level applied to the back of the object. Values range from 0 to 2.

**Side Method**: Selects the method used to extrude the sides of the object. Shading or Gradient can be selected.

**Gradient**: Selects a gradient preset to be applied to the object, or is used to edit a custom gradient.

**Dashboard controls**
The Dashboard contains all of the same controls as the Inspector, with the exception of the Gradient control.
**Halftone**
This filter reduces an image to a black and white version of itself, simulating the halftone screening method for print, in which the shadows and highlights of an image are recreated using patterns of small and large dots.

![Original image](image1) ![Halftone applied](image2)

**Parameters in the Inspector**
- **Center**: Sets the position of the center of the halftone dots.
- **Angle**: Sets the angle of the alignment of the dots.
- **Scale**: Sets the scale of the halftone dots. Values range from 2 to 100.
- **Contrast**: Sets the amount of contrast between the lightest and darkest dots. Values range from 0 to 0.99.

**Dashboard controls**
The Dashboard contains the Angle, Scale, and Contrast controls.

**Hatched Screen**
This filter reduces an image to a black and white version of itself, simulating a halftone pen-and-ink method of shading an image, in which the shadows and highlights of an image are recreated using hatched patterns of lines.

**Parameters in the Inspector**
- **Center**: Sets the position of the center of the hatched screen.
- **Angle**: Sets the angle of the hatched screen.
- **Scale**: Sets the scale of the hatched screen. Values range from 1 to 100.
- **Skew**: Sets the amount of skew of the hatched screen. Values range from –3 to 3.
- **Stretch**: Sets the amount of skew of the hatched screen. Values range from –2 to 2.
**Contrast:** Sets the relative amount of contrast between light and dark areas. Values range from 0 to 0.99.

**Dashboard controls**
The Dashboard contains the Angle, Scale, Skew, Stretch, and Contrast controls.

**Highpass**
This filter emphasizes areas of detail in an image, and stylizes the colors in the resulting image to create a psychedelic display.

![Original image](image1) ![Highpass applied](image2)

**Parameters in the Inspector**

**Radius:** Sets the amount of variance of detail to consider. Values range from 0 (entire range of color) to 100 (only the most detailed portions).

**Amount:** Sets the amount of emphasis. Values range from 0 to 30.

**Dashboard controls**
The Dashboard contains the Radius and Amount controls.

**Indent**
Creates a shiny, bump-mapped appearance on an image, with raised and flat areas.

![Original image](image3) ![Indent applied](image4)
Parameters in the Inspector

**Softness**: Sets the softness of the transition between the flat and raised areas. Values range from 0 to 1.

**Brightness**: Sets the level of brightness of the object. Values range from 0 to 10.

**Ambient**: Sets the amount of ambient light hitting the object. Values range from 0 to 1.

**Highlight Brightness**: Sets the amount of brightness applied to the highlights of the object. Values range between 0 and 100.

**Highlight Sharpness**: Sets the degree of sharpness applied to the highlights of the object. Values range between 1 and 100.

**Light Rotation**: Sets the angle, in degrees, at which the ambient light hits the object.

**Depth**: Sets the amount of depth between the flat and raised areas. Values range between 0 and 20.

**Height Map**: An image well that displays a thumbnail of the height map chosen. If present, the height map is used to determine the flat and raised areas of the object.

**Map Channel**: Sets the channel from the object that is used to determine the flat and raised areas of the image. If a height map is present, the channel is selected from the height map. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Lens Flare**
Lens flares result from a bright light source pointed right at a lens, refracting off multiple elements in the lens assembly of a camera. This filter allows you to add a simulated lens flare to an object.
This filter can be used to simulate a bright light source in the picture.

Parameters in the Inspector

Center: Sets the position of the center of the lens flare.

Size: Sets the radius of the ring of the lens flare. Values range from 0 to 400.

Intensity: Sets the intensity of the lens flare. Values range from 0 to 4.

Falloff: Sets how fast the lens flare falls off. Values range from 0 to 10.

Color: Picks the color of the lens flare. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

Outer Color: Picks the outer color of the lens flare.

Ring Color: Picks the color of the ring of the lens flare.

Streak Color: Picks the color of the streaks in the lens flare.

Streak Intensity: Sets the intensity of the streaks. Values range from 0 to 1.

Streak Count: Sets the number of streaks in the lens flare. Values range from 1 to 100.

Streak Noise Frequency: Sets the frequency of the noise in the streaks. Values range from 1 to 100.

Streak Noise Level: Sets the level of noise in the streaks of the lens flare. Values range from 0 to 20.

Ring Radius: Sets the radius of the ring of the lens flare. Values range from 0 to 1.

Ring Width: Sets the ring's width, with values ranging from 0 to 1.

Glow Falloff: Sets how fast the glow falls off of the lens flare. Values range from 0 to 20.
**Streak Map:** An image well that displays a thumbnail of the map chosen for the streaks of the lens flare.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector, except Center.

**Line Art**
Performs an edge detection of the high-contrast borders between regions of differing brightness in an object, tracing the edges and reducing all other detail in the image to the color specified by the Paper Color parameter. The color of the resulting outline can also be customized. The result is to simulate the look of a line drawing drawn on paper.

Parameters in the Inspector

**Threshold:** Sets the threshold of edge detection. Values range from 0 to 0.2.

**Smoothness:** Sets the level of smoothness of transition between the lines and the background. Values range from 0 to 1.

**Paper Color:** Sets the color of the paper. The color picker can be expanded with the disclosure triangle to include Red, Green, Blue, and Alpha sliders to more precisely select the color.

**Paper Opacity:** Sets the opacity of the paper. Values range from 0 to 1.

**Ink Color:** Sets the color of the ink used in the line drawing.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.
**Line Screen**
This filter reduces an image to a high-contrast grayscale version of itself. It then screens it using a pattern of straight lines, simulating a sort of etched screening technique. The image is represented by varying thicknesses in the pattern of the parallel lines.

![Original image](image1) ![Line Screen applied](image2)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the hatched screen.

**Angle:** Sets the angle of the hatched screen.

**Scale:** Sets the scale of the hatched screen. Values range from 1 to 100.

**Skew:** Sets the amount of skew of the hatched screen. Values range from –3 to 3.

**Stretch:** Sets the amount of skew of the hatched screen. Values range from –2 to 2.

**Contrast:** Sets the relative amount of contrast between light and dark areas. Values range from 0 to 0.99.

**Dashboard controls**
The Dashboard contains the Angle, Scale, Skew, Stretch, and Contrast controls.
**MinMax**

This filter softly patterns an image by averaging pixels within the specified radius together by the minimum or maximum color values present in the image. The result is to erode or dilate the light or dark areas of your object into soft, blocky regions.

**Parameters in the Inspector**

**Mode**: Sets the mode of the minmax. The following modes are available: minimum and maximum.

**Radius**: Sets the radius of the minmax. Values range from 0 to 100.

**Dashboard control**

The Dashboard contains the Mode and Radius controls.

**Noise Dissolve**

Dissolves an object by adding a pattern of black noise to it. Raising the value of the Dissolve Amount parameter gradually eats away at more and more of the image. The alpha channel is set to zero within the noisy areas, so background images are revealed as the Dissolve Amount increases.
Parameters in the Inspector

Dissolve Amount: Sets the percentage of pixels dissolved by noise.

Random Seed: Sets a number to be used as a seed for noise placement. Values range from 0 to 1000.

Dashboard controls
The Dashboard contains the Dissolve Amount and Random Seed controls.

Noise Dither
Adds a small amount of noise to the pixels of an object, used to soften the banding seen on 8-bit images with subtle gradients.

Parameters in the Inspector

Noisiness: Sets the amount of noise added to the object. Values range from 0 to 1.

Movement: Toggles animation of the noise on and off.

Dashboard controls
The Dashboard contains the Noisiness control.

Pixellate
This filter turns an image into a mosaic of blocks using colors taken from an object. The scale of the blocks can be increased or decreased.

Parameters in the Inspector

Center: Sets the position of the center of the pixellation effect.

Scale: Sets the scale of the pixellation. Values range from 1 to 100.

Dashboard controls
The Dashboard contains the Scale control.
Posterize
This filter reduces the number of colors in your object to a set number per color channel, adjustable using the Levels parameter.

Parameters in the Inspector

Levels: Sets the number of levels of posterization. Values range from 2 to 255.

Dashboard controls
The Dashboard contains the Level control.

Relief
Uses the color values of an object or height map to calculate height vertices, creating a 3D height map.

Parameters in the Inspector

Front: Sets the position of the center point of the front of the height map, determining the direction to which the height vertices are projected. Values are coordinates.

Front Size: Sets the size of the front object, as a proportion of its original size. Values range from 0 to 2.

Back: Sets the position of the center point of the back of the height map, determining the direction from which the height vertices are projected. Values are coordinates.

Back Size: Sets the size of the back object, as a proportion of its original size. Values range from 0 to 2.

Fuzziness: Sets the amount of fuzziness applied to the height vertices. The higher the Fuzziness, the softer the edges of the height vertices. Values range from 0 to 1.

Height Map: An image well that displays a thumbnail of the height map chosen. If present, the height map is used to calculate the height vertices.
**Map Channel:** Sets the channel used to calculate the height vertices. If a height map is present, the channel is selected from the height map, otherwise the channel is selected from the source object. Values can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

**Dashboard controls**
The Dashboard contains the Front Size, Back Size, Fuzziness, Height Map, and Map Channel controls.

**Slit Scan**
Create an animated fly-through effect by simulating the slit scan process used to create "stargate" images in science fiction films.

![Original image Slit Scan applied](image)

**Parameters in the Inspector**

**Center:** Sets the position of the center of the slit.

**Rotation:** Sets the angle of rotation of the slit.

**Speed:** Sets the speed of the simulation. Values range from 0 to 400.

**Perspective:** Sets the angle of perspective on the object. Values range from 0 to 1.

**Glow:** Sets the amount of the glow on the slit. Values range from 0 to 1.

**Glow Color:** Picks the color of the glow of the slit. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

**Offset:** Sets the amount of offset between what is above and what is below the slit. Values range from 0 to 1.

**Dashboard controls**
The Dashboard contains the Rotation, Speed, Perspective, Glow, Glow Color, and Offset controls.
Slit Tunnel
Simulates a circular version of the slit scan process used to create “warp tunnel” images in science fiction films. This filter is automatically animated to create a fly-through effect.

Parameters in the Inspector
Center: Sets the position of the center of the tunnel.
Rotation: Sets the angle of rotation of the object during movement.
Speed: Sets the speed of the simulation. Values range from 0 to 400.
Perspective: Sets the angle of perspective on the object. Values range from 0 to 1.
Glow: Sets the amount of the glow on the slit. Values range from 0 to 1.
Glow Color: Picks the color of the glow of the slit. Use the disclosure triangle to display Red, Green, Blue, and Alpha sliders for more precise color selection.

Dashboard controls
The Dashboard contains the Rotation, Speed, Perspective, Glow, and Glow Color controls.

Texture Screen
This filter uses a source object specified by the Map Image parameter to screen the target. The source object used can be any image, movie, or shape you want.

When this filter is initially applied, Texture Screen behaves as if there were a black image applied to the Map Image well, which makes the target appear like a washed out black and white version.

To learn how to add an object to the Map Image well, see “Compound Blur” on page 716.

Parameters in the Inspector
Map Image: An image well that displays a thumbnail of the map chosen to generate the screen.
Center: Sets the position of the center of the texture screen.
Angle: Sets the angle at which the texture screen is placed.
Skew: Sets the amount of skew applied to the map image. Values range from –3 to 3.
Stretch: Sets the amount of stretch applied to the map image. Values range from –2 to 2.
Scale: Sets the scale applied to the map image. Values range from –2 to 2.
Image Contrast: Sets the amount of contrast applied to the image by the screen. Values range from 0 to 20.

Threshold: Sets the threshold of brightness of the background image used to determine the brightness of the luminance map. Values range from –2 to 2.

Noise Contrast: Sets the amount of contrast added to the noise. Values range from 0 to 20.

Noisiness: Sets the amount of noise. Values range from 0 to 20.

Dashboard controls
The Dashboard contains the same controls as the Inspector, with the exception of Center.

Vectorize Color
Makes the object appear as multicolored polygons. Four colors are substituted over the entire color range of the object.

Parameters in the Inspector

Granularity: Sets the granularity of the polygons. The smaller the value, the smaller the size of polygons in the resulting image. Values range from 3 to 64.

Smoothness: Sets the smoothness of transition between the colors that you select. Values range from 0 to 1.

Curvaceousness: Sets the number of sides of the polygons generated by the filter. The larger the number, the more sides each polygon has. Values range from 0 to 1.

First Color: Picks the first color that is substituted. The color picker can be expanded with the disclosure triangle to display Red, Green, Blue, and Alpha sliders, for more precise color selection.

Second Color: Picks the second color that is substituted.
**Third Color**: Picks the third color that is substituted.

**Fourth Color**: Picks the fourth color that is substituted.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.

**Vignette**
Simulates the light fall-off and blurring that can be seen in the corners of images as seen through some camera lenses.

Parameters in the Inspector

**Size**: Sets the size of the vignette. The larger the size, the more of the object is affected by the vignette. Values range between 0 and 1.5.

**Falloff**: Sets the amount of falloff applied to the border of the vignette. The higher the falloff, the softer the edge of the vignette. Values range from 0 to 1.

**Blur Amount**: Sets the amount of blur applied to the part of the image affected by the vignette. Values range between 0 and 16.

**Darken**: Sets the amount the affected part of image is darkened by the vignette. Values range between 0 and 1.

**Saturation**: Sets the amount of color saturation applied to the parts of the image affected by the vignette. Values range from -1 to 1.

**Dashboard controls**
The Dashboard contains the same controls as the Inspector.
Wavy Screen
This filter reduces an image to a high-contrast grayscale version of itself. It then screens it using a pattern of angled lines, simulating a sort of etched screening technique. The image is represented by varying thicknesses in the pattern of the zig-zagging lines.

Parameters in the Inspector

Amplitude: Sets the amplitude of the waves. Values range from 0 to 100.
Scale: Sets the scale of the waves. Values range from 1 to 100.
Wavelength: Sets the wavelength. Values range from 0 to 500.
Contrast: Sets the contrast of the screen. Values range from 0 to 0.99.

Dashboard controls
The Dashboard contains the Amplitude, Scale, Wavelength, and Contrast controls.

Tiling Filters
Tiling filters don't create a simple repetition of objects in a rectangular grid. Tiles can be created using many different shapes and be arranged into many new and exciting mosaics.
Kaleidoscope
This filter simulates the effect of looking at an image through a kaleidoscope. It is not automatically animated, but by animating the Offset Angle parameter you can simulate the effect of twisting the kaleidoscope’s knob to rotate the image pattern.

Parameters in the Inspector

**Center:** Sets the position of the center of the kaleidoscope.

**Segment Angle:** Sets the width of the tiles. Values range from 0 to 360.

**Offset Angle:** Sets the amount the tiles are offset from one another. Values range from 0 to 360.

**Partial Segments:** Toggles allowing partial segments to complete the radius of the kaleidoscope. When turned off, segments may be distorted in order to map them across the radius of the kaleidoscope with facets of equal size.

Dashboard controls
The Dashboard contains the Segment Angle and Offset Angle controls.
Kaleidotile
Simulates looking through a kaleidoscope with rectangular facets. It is not automatically animated, but by animating the Angle parameter you can simulate the effect of twisting the kaleidoscope to rotate the image pattern.

Parameters in the Inspector

Center: Sets the origin of the kaleidotile.

Width: Sets the width of the panels of the kaleidotile. The panels range in size from 8 to 256.

Height: Sets the height of each of the panels. The panels range in size from 8 to 256.

Angle: Sets the angle of rotation of the panels. The panels range in size from 0 to 360.

Dashboard controls
The Dashboard contains the Width, Height, and Angle controls.
**Parallelogram Tile**
Simulates looking through a kaleidoscope with facets made of parallelograms. It is not automatically animated, but by animating the Angle parameter you can simulate the effect of twisting the kaleidoscope to rotate the image pattern.

![Original image](image1) ![Parallelogram Tile applied](image2)

**Parameters in the Inspector**

**Center:** Sets the position of the origin of the parallelogram tiles.

**Acute Angle:** Sets the acute angle at which the parallelogram sides meet.

**Angle:** Sets the angle of rotation of the panels.

**Tile Size:** Sets the size of the panels. The panels range in size from 1 to 200.

**Dashboard controls**
The Dashboard contains the Acute Angle, Angle, and Tile Size controls.

**Perspective Tile**
Endlessly tiles an image, mapping it onto a grid that can be positioned in simulated 3D space. Can create an endlessly repeating video wall stretching off into the distance.

**Parameters in the Inspector**

**Top Left:** Sets the position of the top-left corner of the grid.

**Top Right:** Sets the position of the top-right corner of the grid.

**Bottom Right:** Sets the position of the bottom-right corner of the grid.

**Bottom Left:** Sets the position of the bottom-left corner of the grid.

**Dashboard controls**
The Dashboard has no controls for this filter.
Random Tile
Tiles your object in an irregular pattern with circular panels.

Parameters in the Inspector

Center: Sets the center point on the object from which the tiles are generated. Values are coordinates.

Radius: Sets the radius of each tile. Values range from 4 to 32.

Feathering: Sets the amount of feathering applied to the edges of each tile. Values range from 0 to 1.

Seed: Sets a number to be used as a seed for tile placement and stacking. Values range from 0 to 1000.

Dashboard controls
The Dashboard contains the Radius, Feathering, and Seed controls.

Tile
This filter tiles an image. The number of duplicates of the image that appear depends on the value of the Scale parameter.
Parameters in the Inspector

Center: Sets the position of the origin of the tiles.

Skew: Sets the amount of skew applied to the tiles. Values range from –3 to 3.

Scale: Sets how much the tiles are scaled. Values range from 0.05 to 20.

Stretch: Sets the amount tiles are stretched in Y. Values range from 0.1 to 10.

Angle: Sets the angle of rotation of the tiles.

Dashboard controls
The Dashboard contains the Skew, Scale, Stretch, and Angle controls.

Triangle Tile
Tiles your object with triangular shaped panels. The effect is similar to one of the kaleidoscope filters. It is not automatically animated, but by animating the Angle parameter you can simulate the effect of twisting the kaleidoscope to rotate the image pattern.

Parameters in the Inspector

Center: Sets the origin of the tile.

Angle: Sets the angle of rotation of the triangles.

Tile Size: Sets the size of the triangles. Values range from 1 to 200.

Dashboard controls
The Dashboard contains the Angle and Tile Size controls.

Time Filters
Where other filters manipulate objects in two or three dimensions, Time filters manipulate objects in the fourth dimension—time. These filters are most often used with moving footage.
Echo
Echoes an object’s motion by repeating frames. The result is that moving areas of an image leave a streaking trail behind as they move.

Parameters in the Inspector
Delay: Sets the amount of delay in frames between echoes. Values range from 0 to 1.
Number: Sets the number of echoes.
Decay: Sets the amount of time it takes for an echo to decay.
Amount: Sets the relative opacity of each echo. Values range from 0 to 1.

Dashboard controls
The Dashboard contains the Delay, Number, Decay, and Amount controls.

Scrub
Moves a virtual playhead around a clip, allowing you to change the timing of the clip without moving it in the Timeline. Additionally, it allows you to animate the offset parameter, often with interesting results. Try adding the Scrub filter to a clip, then applying the Randomize behavior to the Frame offset, with the “Offset from” parameter set to Current Frame. Also, you can create a hold frame by setting Offset to First Frame, then using “Frame offset” to find the frame you wish.

Important: Scrub does not affect clip audio.

Parameters in the Inspector
Frame offset: Sets the offset of the virtual playhead. Values range from -100 to 100.
Offset from: Sets the position from which the virtual playhead is offset. Values can be selected from First Frame or Current Frame.
Frame Blending: Toggles the blending between frames on and off.

Dashboard controls
The Dashboard contains all the same controls as the Inspector.

Strobe
Strobes the image by holding frames for a set duration. The effect is that moving images appear to skip frames as they play.

Parameters in the Inspector
Strobe Duration: Sets the number of frames of each strobe. Values range from 1 to 60.

Dashboard controls
The Dashboard contains the Strobe Duration control.
Trails
Draws light or dark trails following an object’s movement. This filter is only effective with moving images.

Parameters in the Inspector

Duration: Sets the duration of the trails. Values range from 0 to 1.00.

Echoes: Sets the number of echoes trailing behind. Values range from 1 to 30.

Decay: Toggles whether the trails decay over time or disappear at the end of the duration.

Trail On: Sets the kind of values that trigger the trails. This can be set to Light or Dark.

Dashboard controls
The Dashboard contains the same controls as the Inspector.

Widetime
Similar to the Echo filter, but Widetime holds frames both before and after the current frame to stretch the image’s motion out in time.

Parameters in the Inspector

Duration: Sets the number of frames before and after the current frame that are blended. Values range from 0 to 1.

Decay: Sets the amount of time the added frames are held. Values range from 0 to 1.

Amount: Sets the amount of opacity of the delayed object being overlaid. Values range from 0 (no reduction) to 1.0 (transparent).

Dashboard controls
The Dashboard contains the Duration, Decay, and Amount controls.
Video Filters
Video filters are more utilitarian in nature, and can be used to help prepare a project for broadcast output.

Broadcast Safe
This filter limits the range of luminance or chrominance in an image to the broadcast legal limit.

Parameters in the Inspector

Video Type: Sets the rule set to be used for filtering image data. Value can be NTSC or PAL.

Fix Method: Sets the type of fix to be made to the image. Value can be Reduce Luminance or Reduce Saturation.

Dashboard controls
The Dashboard contains the Video Type and Fix Method controls.

Deinterlace
This filter deinterlaces an interlaced object using one of several possible methods.

Parameters in the Inspector

Dominant Field: Selects the dominant field. Value can be Upper or Lower.

Method: Sets how the object is interlaced. The method can be Duplicate, Interpolate, or Blend.

• Duplicate: The non-dominant field is eliminated, and the data from the dominant field is duplicated to fill in the missing lines.

• Interpolate: The non-dominant field is eliminated, and a new field is created by averaging each pair of adjacent video lines to create new ones.

• Blend: The non-dominant field is eliminated, and new lines are created by averaging the eliminated line along with each pair of adjacent video lines.

Dashboard controls
The Dashboard contains the Dominant Field and Method controls.

Working With Third-Party Filters
Motion supports After Effects-compatible third-party plug-ins. Once you specify the location of the third-party plug-ins, they appear in the 3rd Party Filters category of the Library.

To set the path to third-party plug-ins:
1 Choose Motion > Preferences (or press Command+,).
2 Click General.
3 In the “3rd Party Plug-ins” group, click Choose (next to Search Path).

4 In the sheet, navigate to the folder that contains your third-party plug-ins, then click Choose.

   A dialog appears informing you that the path has changed and the change will take effect the next time you open Motion.

5 Quit and reopen Motion.

   The third-party plug-ins appear in the “3rd Party Filters” category and are applied in the same manner as all other filters.

   Note: If you specify an alias for the plug-ins, the plug-ins are not recognized.
Use the generators in the Motion Library to quickly add life to your project.

About Generators
Generators are objects in the Library that you add to your project to instantly create solids or patterns such as colors, bars, stripes, noise, or gradients. Some generators create animated patterns, while most create static, patterned images.

Once a generator is added to a project, you can modify its preset values as well as animate nearly all of its parameters—whether the generator is animated or static. Once you have modified a generator, you can save it to the Library for later use.

Using Generators
Generators are added to your project in the same manner as other files—you drag the generator to your project from the Library. When a generator is added to a project, it becomes an object in the Layers tab (and Timeline Layer list) and appears in the Canvas. When added to your project, the generator is set to the duration and size of your project by default. For example, if you are working on an NTSC D1 project and you add a generator to your project, the generator will have a 720 x 486 (.90) pixel aspect ratio.

Note: The duration of the generator depends on the Project settings in Motion Preferences. If Create Objects At is set to “Start of project,” the generator starts at the first project frame regardless of where the playhead is when the generator is added. If set to “Current frame,” the generator starts at the playhead's frame.

Once a generator is added to a project, you can edit its parameters in the Dashboard or Inspector. As with all objects, the generator Dashboards contain a subset of the larger group of controls located in the Inspector. Nearly all generator parameters can be keyframed, whether the default generator is an animated texture or a static image.
Like all other objects in Motion, generators can be moved, rotated, duplicated, copied and pasted, and animated. Generators can be reordered and set to different blend modes. Also, like other objects, you can apply behaviors to generators and apply Parameter behaviors to the parameters of a generator. You can also apply filters to generators, or use a generator as the source for a particle cell.

The following sections discuss adding a generator to a project, the different types of generators, modifying and animating a generator, and saving a modified generator to the Library. Applying a Parameter behavior to a generator is also discussed. Two generators are used in the following examples: the Checkerboard and the Star generators. All generators are modified, animated, and saved in the same manner. The best way to see what generators can do is to simply experiment with their various parameters.

**Adding a Generator**

This section provides a quick introduction to adding a generator to a project. For a description of each generator, see “Generator Types” on page 797.

To add a generator to a project:

1. In the Library, click the Generators category.
2. In the stack, click a generator.

The generator preview appears in the Preview area. If the generator is animated, such as Swirly, the generator plays in the Preview area. You can click the Play/Pause button to stop playback of the generator preview.

3. Drag the generator to your project. Like all other objects, you can add the generator to your project by dragging it to the Canvas, the Layers tab, or the Timeline.

The generator and its Dashboard (press D) appear in your project. The Dashboard contains a subset of the complete controls that appear in the Generator tab of the Inspector.

**Note:** Generators that are added to a project are not added to the Media tab. The Media tab only includes media files that are imported into Motion, such as image sequences, Photoshop files, and audio files.

4. Click Play (or press the Space bar).
Generator Types

There are two types of generators in the Library: animated and static. Both types of generators create images on the fly, but an animated generator creates a moving pattern by default. Although a static generator is not animated by default, you can keyframe its parameters to create an animated pattern. You can use a generator as is or modify its settings to create different effects. The following section briefly describes each generator.

Note: All generators contain Opacity and Blend Mode controls in the Dashboard. Like all objects in Motion, the Opacity and Blend Mode parameters for any generator can also be modified in the Properties tab of the Inspector.

Although the sliders in the Inspector are usually limited to a specific range, you can often manually enter values outside of that range in the value fields.

Caustics

The Caustics generator creates an animated, simulated water surface. The size, speed, refraction, brightness, and color of the Caustics pattern can be modified and animated. You can use the Caustics generator to add light patterns to a project, or as the source object for an image map.
Cellular
The Cellular generator creates an animated pattern that looks like cells moving under a microscope. You can change the color, size, and speed of the cells.

![Default Cellular generator](image1)
![Modified Cellular generator](image2)

Checkerboard
The Checkerboard generator creates a static checkerboard pattern. The contrast, color, size, and position of the checkerboard squares can be edited and keyframed.

![Default Checkerboard generator](image3)
![Modified Checkerboard generator](image4)
Clouds
The Clouds generator creates an animated cloud pattern. You can modify or animate the color, scale, speed, and strength of the cloud layers.

Parameters in the Inspector
The following section describes the Clouds generator controls, which are located in the Generator tab of the Inspector.

Width: Sets the width of the Clouds generator, in pixels. Values range from 1 to the width of your project.

Height: Sets the height of the Clouds generator, in pixels. Values range from 1 to the height of your project.

Note: Although the sliders in the Inspector are usually limited to the maximum values of Width and Height as set in your project, you can often manually enter values outside of those ranges in the value fields.

Pixel Aspect Ratio: Sets the aspect ratio of the pixels drawn by the generator. Values can be selected from the following: Square, NTSC D1/DV, NTSC D1/DV Anamorphic, PAL D1/DV, PAL D1/DV Anamorphic, Anamorphic 2:1, D4/D16, D4/D16 Anamorphic, DVCPro HD 720p/1080i5, DVCPro HD 1080i60, or Custom. When a value other than Custom is selected, the Pixel Aspect Ratio of that selection is displayed in a value field next to the pop-up menu. Enter values from 0 to 10000 in the value field, and Custom appears in the pop-up menu.

Scale: Gives the appearance of zooming in or out of the simulation by scaling the generator. Larger numbers indicate a higher level of zoom. The default slider values range from 8 to 64.

Speed: Sets the speed of movement of the clouds. Values range from 0 to 2.

Gradient: Sets the color gradient used for the clouds. For information on using gradients, see “Using the Gradient Editor” on page 485.
Method: Sets the algorithm used to generate the clouds. Values can be set to Normal (default) or Turbulent.

Offset: Sets the coordinates of the center of the clouds. Coordinates are calculated from the center of your object, which is the coordinate origin.

First Layer Strength: Sets the strength of the first layer of clouds. Values range from 0 to 1.

Second Layer Strength: Sets the strength of the second layer of clouds. Values range from 0 to 1.

Third Layer Strength: Sets the strength of the third layer of clouds. Values range from 0 to 1.

Fourth Layer Strength: Sets the strength of the fourth layer of clouds. Values range from 0 to 1.

Dashboard controls
The Dashboard contains all the same controls as the Inspector, as well as the Opacity and Blend Mode parameters (in the Properties tab).

Color Solid
The Color Solid generator creates a single-colored object. You can adjust the color of the solid, as well as keyframe the color to create an animated texture of changing colors.

Note: When you want to create and animate a small, color-filled box or shape, use the Shape tools to draw a vector-based shape rather than creating and masking a color solid. This is more efficient in terms of processor time and workflow.
Gradient
The Gradient generator initially creates a non-animated blue-and-red linear gradient. You can change the gradient from linear to radial, add and remove colors in the gradient, and change the gradient start and end points. You can save a modified gradient to the Gradient category in the Library and later apply it to shapes, text objects, or particle cells. The gradient controls can be keyframed to create a moving, color-changing gradient.

Membrane
The Membrane generator creates a sheer, animated sheet that appears to move gracefully about in 3D space. The speed, start and end points, offset, brightness, and color can be modified and animated. To expand the animation beyond the Canvas borders, increase the Width and Height parameters in the Inspector.
Noise
Where would motion graphics artists be without a noise filter or generator? To make animated noise, you can keyframe the Random Seed parameter in the Noise Dashboard or Inspector. When filters are applied to an animated Noise generator, you can create some unique textures. In the second image below, the Scrape distortion filter is applied to an animated Noise generator to create a vibrant, electric-light type texture.

Op Art
There are three Op Art generators to help confound your background-foreground senses. The Op Art generators create mathematically-oriented patterns using a repetition of simple shapes. Although some static patterns create a visual illusion of movement, you can keyframe the Op Art parameters to create actual moving moiré patterns.
Soft Gradient
The Soft Gradient generator creates a soft-edged, radial gradient. The gradient contains an alpha channel so that you can place the generator over another image in the project. You can change and keyframe the color, size, and position of the Soft Gradient.

![Default Soft Gradient generator](image1) ![Modified Soft Gradient generator over image](image2)

Star
The Star generator creates a glowing star shape that contains an alpha channel. The scale, width, angle, epsilon (which fine-tunes the size of the star spikes), and opacity of the spikes can be modified and keyframed, as well as the position, color, and radius of the star.

![Default Star generator](image3) ![Multiple modified Star generators over gradient](image4)
**Stripes**
The Stripes generator creates a default image with vertical bands of two alternating colors. You can change and keyframe the position, colors, size, and contrast of the stripes. By animating the Center parameter, you can create an animation in which the stripes continuously move across the screen without the need to resize and pan the object across the Canvas. In the second image, the generator object is rotated so the stripes are horizontal.

**Swirly**
The Swirly generator creates an animated pattern in one of three different styles called Pulse, Spiderweb Spin, and Spiky. Once you select a style, you can modify and animate the scale, rotation, persistence, radius, amplitude, and number of passes of the pattern.

**Modifying Generators**
In this section, the Checkerboard generator is used to illustrate how to edit and animate a generator using the Dashboard. Once a generator has been customized, you can save the generator to the Library for use in future projects. This section also briefly discusses applying Parameter behaviors to the parameters of a generator.
Editing Generators

In this section, the Checkerboard generator parameters are edited to modify the appearance of the default generator.

To edit the Checkerboard generator:

1. Add the Checkerboard generator to your project.

Note: For information on adding a generator to your project, see “Adding a Generator” on page 796.

The default Checkerboard generator appears in the Canvas, Layers tab, and in the Timeline, and the Dashboard appears.

The Checkerboard generator Dashboard contains controls for editing and animating the checkerboard, such as Opacity, Blend Mode, Width, Height, Color, Size (of the checkers), and Contrast. The only Checkerboard parameter that does not appear in the Dashboard is Pixel Aspect Ratio (which appears in the Inspector).
2 Click the Color 1 color well and select a new color. If you are using the color wheel, click the center point and drag the pointer to select a new color.

Color 1 is replaced with the new color.
Note: You can save a color in the swatches along the bottom of the Colors window. Click in the color bar (to the right of the color picker tool), then drag the color chip to a white swatch, and release the mouse button.

3 Click the Color 2 color well and select a new color. Color 2 is replaced with the new color.

4 Drag the Size slider to change the size of the checkers. The checker size is 80 by default. Drag the slider to the left to make smaller checkers, and to the right to make larger checkers. To scale the generator (rather than the size of the checkers), use the Width and Height parameters.
Note: You can also use the standard object scaling methods—the onscreen transform controls or the Scale parameter in the Properties tab of the Inspector. However, scaling generators in this manner has a greater impact on your system’s performance.

5 Drag the Contrast slider to adjust the contrast between Color 1 and Color 2.

Although the checkerboard pattern is not changing, adjusting the Contrast parameter creates the appearance of a different texture.

**Animating Generators**

Although most generators create static images, you can animate the parameters of a generator to create a moving texture over time. This section discusses using the Dashboard to animate the Checkerboard generator from the above example.

Note: You can also animate the parameters of an animated generator.

For information on using Parameter behaviors to animate a generator, see “Applying Behaviors to Generators” on page 811.

To animate the Checkerboard generator parameters:

1 Go to the frame where you want to begin the animation.
2 Enable Record (press A).
3 Set the initial generator parameter values:
   • Drag the Size slider to set the initial checker size.
     Once a keyframe is set for any parameter in a generator, a keyframe is set for all of
     the generator parameters. In other words, once the Size parameter is keyframed, the
     Color 1, Color 2, Contrast, and Center parameters are keyframed.
   • Click the color wells and pick the initial colors.
   • Drag the Contrast slider to set the initial contrast value.
   • Drag one of the Center parameter value sliders to set the initial Center value.
     The value slider on the left of the Center parameter is the X position of the checkers,
     and the value slider on the right is the Y position. To animate the checkers
     horizontally, use the left value slider. To animate the checkers vertically, use the right
     slider. To view the X and Y parameters, click the Center disclosure triangle.

4 Go to the frame where you want to create the next keyframe.

5 Change the generator Size, Colors, and Contrast parameter values.

6 Play the project (press the Space bar).
   The animated generator parameters create a moving, changing texture.

**Saving Modified Generators**

Once you have modified the parameters of a generator, you can save the generator to
the Library. For organizational purposes, it is recommended that you name objects that
you save back to the Library with a descriptive name. For example, if you save a
Checkerboard generator, it is named “Checkerboard 1” by default.

**To save a customized generator to the Library:**
1 To rename the modified generator, double-click the generator name in the Layers tab.

2 Type the new generator name, then press Return.
3. In the Library, navigate to the Generators category.
   
   **Note:** You can also save the modified generator in another category, such as Favorites.

4. From the Layers tab, drag the modified generator to the Library stack.

   ![Image of Generators category]

   The modified generator is saved in the Generators category and appears organized alphabetically in the stack. Custom items saved in the Library are identified with the user icon in the lower right of the icon.
Sharing Saved Generators

By default, any generator that you save in the Library is stored in your user folder: 
`home directory/Library/Application Support/Motion/Library/Generators`. To share custom 
.presets, templates, layouts, behaviors, filters, or Library content with another user, the 
other user must copy the files into his or her home directory.

Applying Behaviors to Generators

Like all other objects in Motion, you can apply Basic Motion, Parameter, or Simulation 
behaviors to a generator. This section describes applying the Randomize parameter 
behavior to the Opacity parameter of the Star generator to create a flickering star.

To apply a Parameter behavior to the Star generator:

1 Select the Star generator and display the Generator tab in the Inspector.
2 In the Generator tab, click Spike Opacity to select the parameter.
   The selected parameter appears in a darker gray than the other parameters.
3. **Control**-click the Spike Opacity parameter, then choose Randomize from the shortcut menu.

![Image of the Spike Opacity parameter with Randomize option selected](image1.png)

The Randomize parameter behavior is applied to the Spike Opacity parameter, and the Behaviors tab is automatically displayed so you can adjust the Randomize parameters.

![Image of the Randomize parameters](image2.png)

---

**Chapter 11  Working With Generators**
When a Parameter behavior is applied to a parameter, a Behaviors icon appears in the Animation menu for that parameter. In the Generator tab, the Behaviors icon appears in the Animation menu for the Spike Opacity parameter.

4 Click Play (or press the Space bar).

Since the Randomize parameter behavior is applied to the opacity of the star spikes, the star appears to flicker.

Flickering star over a background image
To increase or decrease the effect of the flicker, you can modify the Randomize parameters. To quickly jump to the Randomize parameters from the Generator tab, click the Behaviors icon, then choose Randomize from the shortcut menu.

For more information on using Parameter behaviors, see "Parameter Behaviors" on page 354.

**Using Generators as Particle Cell Sources**

Like other objects, generators can be used as a source for particle cells. The following example uses the Soft Gradient generator. It is recommended that you scale the generator down in the Generator tab of the Inspector to give your particle system more flexibility and to keep the project from taking too much processing power.
To use a generator as a particle cell source:

1. Add the Soft Gradient generator to your project.

2. In the Dashboard or Generator tab of the Inspector, lower the Radius value. This example uses a Radius value of 40.

3. Lower the Width and Height values. In this example, Width is set to 82 and Height is set to 75.

   The size of the gradient and its bounding box are scaled down.

4. With the generator still selected, do one of the following:
   - Press E.
   - In the Toolbar, click the Make Particles icon.

   Once an emitter is added to the project, the following occurs:
   - In the Layers tab, the Emitter object appears selected.
   - The generator object (the Soft Gradient) becomes an emitter source for the new particle cells.
• The original reference object (the Soft Gradient) is disabled.

• In the Canvas, the emitter bounding box appears, which can be transformed using the onscreen controls or the Inspector.
• The particle appears in the Canvas in the same location as the original object. Although it appears as if the particle is selected, it is actually the bounding box for the emitter.
• The Emitter Dashboard (press D) is displayed.

5 Play the project (press Space bar).
Soft gradient particles are emitted.
You can change the particle color, emitter shape, scale, emission angle, birth rate, and so on in the Emitter controls. For more information on working with particles, see “Working With Particles” on page 565.

Modified particles using the Soft Gradient generator as a particle cell source
Using Shapes and Masks

Motion has a flexible tool set that you can use to create both simple shapes and complex illustrations, right in your project. The same techniques you use for drawing can also be used to mask objects to produce a wide variety of transparency effects, to crop out parts of still images, and to rotoscope moving subjects.

Shapes and masks are both vector-based objects that are drawn and edited using control points that define mathematical curves. Each control point in a shape defines some sort of corner or curve, and the actual spline that makes up the shape connects these control points together like a connect-the-dots drawing. You can edit or animate any shape by moving and editing its control points.

Since shapes are mathematically defined, you can take advantage of the vector nature of shapes to resize them by any amount, without introducing unwanted artifacts. Shapes are similar to imported PDF objects in that they’re completely resolution independent.
The Difference Between Shapes and Masks

Shapes are primarily used to create all kinds of visual elements. They work like any other object, except that they are created in Motion, and are stored within your project file. A single shape can be used as a background or colored graphic in a composition, or you can use a group of shapes to create lines and fills for more complex illustrations. Each illustration below is composed of shapes created within Motion.

Masks, on the other hand, are used to create regions of transparency in other objects. While shapes work as objects by themselves, masks must be assigned to an object to have an effect. For example, if you have a picture in which you want to isolate the foreground subject, you can create a mask to cut out the background.

Shapes and masks can be animated using behaviors and keyframes, like other objects. However, you can also animate the control points used to create each shape or mask in your project. This allows you to animate the actual form of each shape, in addition to the shape's basic position, rotation, and scale parameters.

Shape and Mask Drawing Tools

Shapes and masks are both made with splines, and they're created and edited using similar tools. This section covers the two spline drawing methods that are available in Motion—Bezier splines and B-Splines. You can use Bezier shapes and B-Spline shapes interchangeably for any task.
Bezier splines are good for drawing shapes for illustration. The controls used to manipulate Bezier splines are similar to those found in many other drawing and compositing applications, so they may already be familiar to you. Bezier controls lend themselves to the creation of precise, detailed shapes. Tangent handles adjust the curvature of the shape on either side of the control point, and this defines the surface of the shape.

B-Splines can also be used to draw shapes, but unlike Bezier controls, B-Splines are manipulated using only points—there are no tangent handles. Furthermore, the points themselves do not lie on the surface of the shape. Instead, each B-Spline control point is offset from the shape’s surface, pulling that section of the shape towards itself as if it was a magnet, in order to create a curve. By combining the influence of multiple B-Spline points, you can create different curves. B-Splines are extremely smooth—by default, there are no sharp angles in B-Spline shapes, although you can create sharper curves, if necessary.

Since B-Spline controls are so simple, they’re easy to animate and manipulate. The tools you use for a particular task are largely a matter of personal preference.

**Drawing Masks and Shapes Using Bezier Splines**
This section describes how to draw a Bezier shape from scratch. These methods are identical whether you use the shape or masking tools. This section focuses on drawing shapes. For more information on drawing masks, see “Masking Objects to Create Transparency” on page 851.
To draw a Bezier shape:
1. Click the Bezier shape tool in the Toolbar (or press B).
2. Click in the Canvas to draw the first point.
3. To add additional points to further define the shape, do one of the following:
   • Click to make a linear corner point.
   • Click, then drag to make a curved Bezier point, adjusting it to the shape you want.

   Note: Press Shift while making a curved point to constrain its tangents to 45-degree angles.
4. While you're drawing a shape, you can also use any of the point-editing procedures described below to move and adjust existing control points prior to finishing the shape. You can adjust any control point except for the first one you created, since clicking the first point closes the shape.

   Tip: If you need a closer look at what you're doing, you can magnify the Canvas while you are drawing a shape. You can also scroll around by pressing the Space bar as you drag in the Canvas.
5 To finish the shape, do one of the following:

- Click the first point you drew to create a closed shape.

- Press C to close the shape, joining the first point you created to the last.
- Double-click anywhere in the Canvas to create the last point of an open shape.
- Press Return to create the last point of an open shape, creating a line with a default width of two pixels.

Note: Before a shape is closed, you can press Esc at any time to cancel the entire operation, deleting the shape.

Immediately after finishing a shape, the Adjust Control Points tool is selected, which allows you to edit the shape you’ve just created.

Note: Once you have finished drawing a closed shape, press Esc to change to Select/Transform mode. To change to Select/Transform mode for an open shape, you must manually choose the Select/Transform tool.

Drawing Masks and Shapes Using B-Splines
This section describes how to draw a B-Spline. These methods are identical whether you’re using the shape or masking tools, but this section focuses on drawing shapes. For more information on drawing masks, see “Masking Objects to Create Transparency” on page 851.

To draw a B-Spline shape:
1 Click the B-Spline shape tool in the Toolbar (or press B).
2 Click in the Canvas to draw the first point.
3 Continue clicking to draw additional points to define the shape you need.
As you create new B-Spline control points, keep the following rules in mind:

- The control points you draw influence the shape of the curve from a distance. They do not lie directly on the surface of the curve.

- To create more detailed curves, create more points. However, it's a good habit to use the fewest number of points necessary to create the amount of detail you need. Shapes with an excessive number of points can be difficult to edit later on.
• In many instances, it is easier to create a loose group of control points first, and then adjust them afterwards to create the precise curve you need in a later step.

4 While drawing a shape, you can move and adjust the control points you’ve already created prior to finishing the shape. You can adjust any control point except for the first one you created, since clicking the first point closes the shape.

Tip: If you need a closer look at what you’re doing, you can magnify the Canvas while in the middle of drawing a shape. You can also scroll around by pressing the Space bar while you drag in the Canvas.

5 When you’re ready to finish your shape, do one of the following:
• Click the first point you drew to create a closed shape.
• Press C to close the shape, joining the first point you created to the last.
• Press **Return** to finish an open shape at the last point you made.

![Image of a closed shape](image1.jpg)

• Double-click anywhere in the Canvas to define the last point of an open shape, creating a line with a default width of two pixels.

![Image of a closed shape with a line](image2.jpg)

**Note:** You can press **Esc** at any time while drawing a shape to cancel the entire operation and delete the shape.

**How to Edit Shapes**

There are two ways to edit shapes. You can edit them in their entirety like any other object using the Transform, Pivot, and Shear Canvas modes, or you can adjust them point-by-point using the Adjust Control Points tool. The shape-editing techniques in this section apply to both shapes and masks.

You perform most of your detailed editing using a shape's individual control points. The Transform, Pivot, and Shear transform modes are better for overall transformations of an entire shape.
Turning Dynamic Guides On or Off While Editing

The Canvas Dynamic Guides help you snap the selected points to one another. Use the following guidelines to turn Dynamic Guides off, so that snapping doesn’t interfere with subtle shape adjustments:

- Press N to turn off the dynamic guides. Press N again to turn the Dynamic Guides back on.
- Once you begin to move the selected control point, press Command to turn off snapping as you drag the point.

**Note:** If you press Command and then drag a control point, adjustable tangent handles are created. If you press Command and click a curved point, it turns into a corner point. For more information on editing Bezier curve control points, see “Editing Bezier Curve Control Points” on page 832.

To transform a Bezier or B-Spline shape:

1. Click the Select/Transform tool, then choose the Select tool from the pop-up menu.
2. Click a shape.
3. Move, resize, or rotate the shape.

You can also edit a shape’s anchor point and drop shadow.

**Note:** To quickly enter shape-editing mode, double-click the shape.

When you move, resize, rotate, or shear a shape, you also transform its control points to match the new orientation of the shape.

For more information about how to perform object transformations, see “Using Transforms” on page 224.
To show a shape’s control points for point-by-point editing:
1 Click the Select/Transform tool, then choose the Adjust Control Points tool from the pop-up menu.
2 Click a shape to show its control points.

Note: If Handles are turned off in the View > Overlays submenu, you cannot see a shape’s Bezier or B-Spline control points when editing. When editing shapes, make sure that Handles are turned on.

Once you display a shape’s control points, you need to select one or more control points to edit them.

Selecting and Deselecting Control Points on a Shape
The methods you can use to select and deselect points are similar to those available for selecting and deselecting shapes in the Canvas.

To select one or more control points:
1 Select the Adjust Control Points tool, then click an object to show its control points.
2 Do one of the following:
   • Click any control point.
   • Drag a selection box over one or more points.
   • Shift-click unselected control points to add them to the selection.
   • Shift-drag a selection box around unselected control points to add them to the selection.

To select every control point on a shape:
1 Select the Adjust Control Points tool, then click an object to display its control points.
2 Choose Edit > Select All (or press Command+A).

To deselect one or more selected control points, do one of the following:
• Shift-click one or more selected points.
• Shift-drag a selection box over one or more selected points.

To deselect every control point on a shape, do one of the following:
• Click the Canvas anywhere outside the selected shape.
• Choose Edit > Deselect All (or press Shift+Command+A).

Moving Control Points to Adjust a Shape
Since the control points define the shape, simply move control points to change the shape.
To move one or more control points:
- Select one or more points, then drag them to a new position.

As you drag one or more selected control points, the rest of the shape automatically stretches or curves to accommodate the change.

To constrain the movement of selected points horizontally and vertically:
1. Select one or more control points.
2. Press Shift while you drag one of the selected points either horizontally or vertically.

*Important:* Selected control points can only be moved—you cannot rotate, shear, or corner-pin them.

**Adding and Deleting Control Points**
If you did not create enough control points to make the shape you need, you can add more to the existing shape. You can also extend or close an open shape.

**To add control points to a shape:**
1. Select the Adjust Control Points tool.
2. Do one of the following:
   - Double-click or Option-click the edge of a shape to add a new control point. When you Option-click the edge of a shape, the pointer changes to show which operation is about to happen.
     *Note:* To add control points to a B-Spline shape, double-click or Option-click the B-Spline frame's edge, rather than the edge of the shape itself.
   - Option-drag the edge of the shape to add a control point to a Bezier shape and immediately adjust its curve.
Adding more control points does not immediately change a Bezier shape, unless you drag Bezier curve points as you create them.

![Before adding Bezier point](image1)
![After adding Bezier point](image2)

Adding more control points to a B-Spline shape, on the other hand, nearly always changes its shape.

![Before adding B-Spline point](image3)
![After adding B-Spline point](image4)

**Warning:** In general, do not add control points to a shape that’s already been animated. If you add points to a shape that already has keyframes applied to its Shape Animation parameter in the Keyframe Editor, the new point does not follow the currently keyframed path.

**To append control points to the end of an open shape:**

1. Select an open shape with the Adjust Control Points tool.
2. **Option**-click anywhere outside of the shape to add new control points to the end of the shape.
3. **Option**-click the first point in the shape to close it (or press C).

If a shape has more control points than are necessary, you can delete points from it to make it easier to edit. This can be helpful if you animate the shape later on.
To delete control points from a shape:
1 Select a shape with the Adjust Control Points tool.
2 Select one or more points to delete, then do one of the following:
   • Choose Edit > Delete.
   • Control-click the selected points, then choose Delete Point from the shortcut menu.
   • Press Delete.

The shape changes to adjust to the missing point. If you remove points from a closed shape, the shape remains closed.

Warning: If you delete a point from a shape that already has a keyframed Shape Animation parameter in the Keyframe Editor, that control point is removed from the entire animation.

Locking Control Points
You can lock individual control points in a shape to fix them in place and prevent them from being accidentally adjusted. A shape with locked points can still be moved. Locking a control point simply prevents it from being adjusted while you edit a shape using the Adjust Control Points tool.

To lock and unlock points:
1 Choose the Adjust Control Points tool, then select a shape.
2 Control-click a control point, then choose Lock Point from the shortcut menu.
If the point was unlocked, it becomes locked. If the point was locked, Unlock Point appears in the shortcut menu, and it becomes unlocked.

Editing Bezier Curve Control Points

The methods used to adjust Bezier shapes are similar to those used by many other applications. Bezier control points are widely used to modify curves, and allow you to easily draw any shape you may need.

Each point in a Bezier shape can be toggled to act as a hard corner or as a curve.

To toggle control points between corners and curves, do one of the following:

- **Command**-click a curved point to turn it into a corner point.
- **Command**-drag a corner point to turn it into a curved point, creating adjustable tangent handles.
- **Control**-click one or more selected points, then choose Linear or Smooth from the shortcut menu to change the control point type.

Curved Bezier control points have two tangent handles that you use to adjust the curvature of the shape on either side of the control point. These handles can be adjusted in a variety of ways to create symmetrical and asymmetrical curves. By default, these tangent handles are locked to one another at an angle of 180 degrees, although this can be overridden to allow each tangent to be independently adjusted.

**Important:** If automatic keyframing is turned on, turning a corner into a curve results in an animated effect of the corner gradually turning into the curve.
To adjust a Bezier curve using the control point's tangent handles, do one of the following:

- Drag a tangent handle to adjust its length. By default, the angle of each opposing tangent is locked to 180 degrees, and adjusting the angle of one tangent automatically adjusts the other. The length of each tangent can be independently adjusted.

- **Command**-drag either tangent to break the relationship between opposing tangents. Once this relationship is broken, adjustments to one tangent have no effect on the other, and both tangents can be rotated freely.

- **Command**-drag a free tangent to reconnect its 180-degree relationship to its opposing tangent. This locks both tangents together again.

  **Tip:** Press **Shift** while you adjust a tangent to constrain its movement to 45-degree angles.

To simultaneously modify the handles for more than one control point, **Shift**-select the points and then adjust the tangents.
Important: If automatic keyframing is enabled, curve adjustments are keyframed, creating animated shape changes.

**Editing B-Spline Control Points**

Editing the position of control points in B-Spline shapes is similar to editing Bezier shapes. In fact, the steps for selecting, moving, adding, deleting, and locking control points are almost exactly the same. The main difference in editing both types of shapes lies in how you manipulate and adjust curves.

The simplest, and usually fastest, way to manipulate B-Spline curves is to move one or more B-Spline points closer to or farther away from one another. When B-Spline points are moved closer to one another, a sharper curve is created. B-Spline points that are farther away from one another create shallower curves.

Each B-Spline control point tugs on a section of the shape, pulling it toward itself. As a result, you manipulate a shape's curve by moving its control points in the direction you want to pull the shape. For example, notice how every control point creating the S curve below is offset in the direction of the curve it influences.

Note: You can show and hide the B-Spline frame lines that enclose B-Spline control points by choosing View > Overlays > Lines.
By default, B-Spline shapes have no corners. While this is the default behavior, you can adjust the amount of curvature at each individual B-Spline control point. This allows you to create sharper curves using fewer control points, even creating corners at a single point, if necessary.

The easiest way to adjust B-Spline point curvature is by switching among three preset degrees of curvature.

To switch a B-Spline control point among three degrees of curvature:
- **Command**-click one or more selected B-Spline control points to switch them among three progressively sharper amounts of curvature.

You can also adjust B-Spline control points along a sliding scale.

To adjust the amount of curvature in a B-Spline control point:
- **Command**-drag one or more selected B-Spline control points to make their curves progressively sharper.
  - Dragging to the right makes the curve progressively sharper.
  - Dragging to the left makes the curve progressively looser.

If you later decide you don’t like the B-Spline curve adjustment you made, you can always reset the degree of curvature by **Command**-clicking the point until it’s back to the default curvature amount.

**Illustrating Using the Shape Tools**
You can use the shape tools to create anything from simple graphic elements to complex multi-shape illustrations. You can create lines or filled objects, manipulate their edge and fill characteristics, and combine and reorder the shapes into nested groups to produce complicated designs.

Although you can import vector artwork as PDF files, creating shapes and illustrations directly in your project gives you more options for integrating the result with the rest of your composition. Additionally, you can animate illustrations created directly within Motion using behaviors or keyframes, since each piece of the illustration is an individual object with its own animateable parameters. You can also apply filters directly to objects within a project for even more creative possibilities.
Additional Shape Parameters in the Dashboard
When you create and select shapes, additional parameters appear in the Dashboard along with the standard Opacity, Blend Mode, and Drop Shadow controls.

![Shape Parameters Dialog Box](image)

**Note:** To adjust the opacity of a shape (or its outline) in the Inspector, use the Properties tab.

**Fill:** Turn on this checkbox to fill the shape with the color specified with the color control next to it.

**Outline:** Turns on an outline for the shape. By default, this is off for closed shapes, and on for open shapes. When Outline is on, you can select the outline color with the color control next to it.

**Feather:** Feathers (softens) the edges of a shape. Positive feathering values soften the edge of the shape from its edge outward. Negative feathering values soften the edge of a shape inward from the edge.

**Note:** You cannot feather a shape with the outline turned on.

**Shape Parameters**
The Shape tab in the Inspector appears when you select a shape in the Canvas, Layers tab, or Timeline. This tab contains parameters that let you further customize the shape.

**Shape Type:** Use this pop-up menu to change the type of control points that are used to define the shape. For example, if you originally created a Bezier shape, you can choose B-Spline from this menu to change each Bezier control point into a B-Spline control point. Changing the shape type does not move the control points, although the shape is changed, sometimes dramatically.

- **Linear:** All control points are joined by hard angles, and the resulting shape is a polygon. The control points of a Linear shape lie directly on its edge.
- **Bezier:** Control points can be a mix of Bezier curves and hard angles, creating any sort of shape. The control points of a Bezier shape lie directly on its edge.
• **B-Spline:** Control points are all B-Spline points, with different degrees of curvature. B-Spline control points lie inside, outside, or on the edge of the shape, and are connected by the B-Spline frame.

**Note:** To toggle the display of the B-Spline frame, choose View > Overlays > Lines.

You can change a shape's type at any time. Changing a shape's type changes its form. For example, a single set of control points produces the following three shapes, depending on the selected Shape Type.

![Linear shape](image1) ![Bezier shape](image2) ![B-Spline shape](image3)

**Closed:** If you select an open shape, this checkbox is turned off. Turning this checkbox on connects the first and last points of an open shape. If you select a closed shape, this checkbox is turned on. Turning this checkbox off disconnects the first and last points, turning it into an open shape.

**Fill:** By default, this checkbox is turned on for new closed shapes, and fills the shape with the color specified in the Fill Color control.

**Fill Mode:** Defines how a shape is filled. There are two choices:

- **Color:** When this command is selected, the Fill Color parameter appears and allows you to pick a color to fill the shape.
- **Gradient:** When this command is selected, the Gradient parameter appears and allows you to select a gradient fill for the shape.

**Fill Color:** Lets you pick a color fill for the shape. Click the disclosure triangle to the left to display Red, Green, and Blue sliders that allow you to choose a color mix, or click the color well to use the Colors window to select a color.

**Gradient:** A Gradient library pop-up menu appears and lets you choose from a list of gradient presets. Click the disclosure triangle to the left to display the Gradient Editor, which you can use to create your own custom gradients. For more information on how to use the Gradient Editor, see “Using the Gradient Editor” on page 485.
The controls for the Gradient Editor are identical to the gradient controls for text, with one exception. The text gradient parameters include a dial to control the angle of the gradient. The shape gradient parameters use Start and End point controls, which are available in the Inspector or in the onscreen controls.

To change the direction of a shape’s gradient in the Inspector:
1 With the shape selected, click the Gradient disclosure triangle to show the Gradient Editor.
2 Use the Start and End value sliders to change the direction of the gradient. The left value slider is X and the right value slider is Y.

To change the direction of a shape’s gradient in the Canvas:
1 With the shape selected, Control-click the shape, then choose Edit Points from the shortcut menu.
Two small “+” onscreen controls appear above and below the shape.
2 Drag the “+” onscreen controls in the Canvas to set a new direction for the gradient.

Outline: Lets you turn on an outline for the shape. By default, this is off for closed shapes and on for open shapes. When you turn Outline on, the Outline Color, Width, Joint, and Order parameters become available.

Outline Color: Lets you pick a color to use for the outline. Click the disclosure triangle to the left to display Red, Green, and Blue sliders to choose a color mix, or click the color well to use the Colors window to select a color.

Width: A slider that changes the width of a shape’s outline.

Joint: Lets you choose how hard corners on a shape’s outline are drawn. There are three options:
• Square: All corners are squared off.
• Round: All corners are rounded.
• **Bevel**: All corners are cut at an angle.

![Round joints and Beveled joints](image)

**Order**: A pop-up menu lets you choose whether an outline is drawn over or under the fill color or gradient. The effect is more apparent with thicker outline widths.

  • **Over Fill**: Thick outlines appear on top of the selected fill of the shape. When an outline's thickness is increased, it grows both outward and inward.
  
  • **Under Fill**: Thick outlines are obscured beneath the selected fill of the shape. When an outline's thickness is increased, it only grows outward, not inward.

![Over Fill and Under Fill](image)

**Feather**: A slider that feathers (softens) the edges of a shape. Positive feathering values soften the edge of the shape from its edge outward. Negative feathering values soften the edge of a shape inward from the edge.
Note: You cannot feather an object with Outline turned on.

Creating Rectangles and Circles
The Rectangle and Circle tools create simple Bezier shapes. The resulting shapes can be edited just like any other Bezier shape, using the methods described in "How to Edit Shapes" on page 826.

To make a rectangle:
1. Click the Rectangle tool (or press R).
2. Click in the Canvas to define the first corner of the rectangle, then drag until the resulting rectangle is the size you want.
3. Release the mouse button to finish drawing.

Note: To create a perfect square, press Shift while you drag. To draw the rectangle from its anchor point, press Option while you drag.

To make a circle:
1. Click the Circle tool (or press C).
2 Click in the Canvas to define the start point of the bounding box that defines the circle, then drag until the resulting circle is the size you want.

3 Release the mouse button to finish drawing.

**Note:** To create a perfectly symmetrical circle, press *Shift* while you drag. To draw the circle from its anchor point, press *Option* while you drag.

**Tip:** If you change a circle's Shape Type to B-Spline in the Shape tab of the Inspector, you can use different methods to manipulate the circle.
Creating Freehand Shapes

Use the Bezier and B-Spline shape tools to create any kind of line or shape you need. Once you draw a shape, you can adjust the fill, outline, and feathering to suit your needs.

*Note:* You can only feather shapes that have the outline turned off.

**To make a line:**
1. Select the Bezier or B-Spline shape tool.
2. Click in the Canvas to create the necessary control points for the line you need. For more information, see “Shape and Mask Drawing Tools” on page 820.
3. To finish drawing the line, do one of the following:
   - Double-click to create the last point.
   - Press Return to finish the line at the last point you drew.

*Tip:* To draw a straight line, simply create two points.

By default, Outline is turned on for open shapes.

**To edit a shape’s outline:**
1. Select a shape, then open the Shape tab in the Inspector.
2. To manipulate the shape’s outline, do one of the following:
   - To toggle a shape’s outline on or off, click the Outline checkbox.
   - To change the color of the outline, use the Outline Color control.
   - To change the width of the outline, drag the Width slider.
   - To change how the outline’s sharp corners are drawn, choose an option from the Joint pop-up menu.
   - To change whether the outline appears over or under a shape’s fill, choose a command from the Order pop-up menu.

**To create filled or empty shapes:**
1. Click the Bezier or B-Spline shape tool.
2. Create the necessary control points for the shape you need.

For more information, see “Shape and Mask Drawing Tools” on page 820.
3. When you’re ready to close the shape, click the first point you created.
4 By default, new closed shapes are filled. To make the shape empty, select it, then turn off the Fill checkbox in the Dashboard.

To edit a shape's fill:
1 Select a shape, then open the Shape tab in the Inspector.
2 Do one of the following:
   • To toggle a shape's fill on or off, click the Fill checkbox.
   • To change a shape's fill mode from a solid color to a gradient, choose a command from the Fill Mode pop-up menu.
   • If the shape's fill mode is set to a solid color, you can choose the color using the Fill Color control.
   • If the shape's fill mode is set to a gradient, you can either choose a gradient from the gradient favorites pop-up menu, or click the Gradient parameter's disclosure triangle to display the Gradient Editor and create your own custom gradient. For more information on using the Gradient Editor, see “Using the Gradient Editor” on page 485.

To feather a shape:
1 Select the shape you want to feather.
2 If the shape's outline is turned on, turn off the Outline checkbox in the Shape tab of the Inspector.
3 Adjust the Feather slider in the Dashboard or in the Shape tab of the Inspector.
Positive values spread the feathering outward, while negative values feather the shape inward.

![Feathered in and Feathered out](image)

**Tip:** You can also blur a shape in other ways using filters. For more information, see “Applying Filters to Shapes” on page 847.

**Creating Illustrations Using Multiple Shapes**

You can use groups of shapes to create more detailed shapes, and even complete illustrations. For example, the following illustration was created using nested groups of Bezier shapes.

![Illustration created using multiple shapes](image)

It is important to understand that it’s not necessary to create every part of an illustration with a single shape. Most of the time it is easier, and sometimes essential, to use multiple overlapping shapes to create different parts of an illustration.

For example, the face in the example above uses a gradient, but the eyes are a different solid color. This is only possible using two shapes.
Organizing Objects Used in Multi-Shape Illustrations

When you create illustrations using groups of shapes, it is helpful to take advantage of the organizational tools in Motion by grouping shape objects together within nested layers. In the example above, the objects that make up the illustration are arranged into three layers—one for the hair and face, another nested layer for the facial features, and an additional layer for the body. Each of these layers is in turn nested inside a topmost layer that can be used to transform or animate the entire illustration.

Within each layer, you can use the Bring and Send commands in the Object menu to reorder objects, controlling which objects are in front of others. By nesting objects that belong on the same level within the same layer, you gain the ability to control the ordering of each shape group relative to one another. For example, all the facial features appear underneath the shape making up the hair because the Facial Features layer is underneath the Hair object.

For more information on controlling layer hierarchies, see “Reorganizing Objects in the Layers Tab” on page 200. For more information on using the Bring and Send commands, see “Layer Arrangement Commands in the Object Menu” on page 219.

Locking Layers and Shapes While Editing Illustrations

You can lock layers and shapes that are behind the shapes you’re drawing and editing in the foreground to avoid accidentally selecting and modifying the wrong one. Layers and shapes can be locked and unlocked at any time. To lock a layer or shape, use the lock icons in the Layers tab or Timeline.

Using Object Alignment

While arranging groups of shapes to create more complex illustrations, you can use the Alignment commands in the Object menu. For more information on using object alignment, see “Using Object Alignment Commands” on page 228.
Creating Holes and Transparency in Shapes

There are several ways you can create holes and transparency within shapes. You can use the Opacity, Blend Mode, and Preserve Opacity parameters in the Properties tab to modify a shape's overall transparency.

Shapes with multiple blend modes

For more information on using object blending parameters, see “Blend Modes” on page 244.

You can also use one or more masks to punch holes inside shapes using the mask drawing tools. You can also apply image masks to a shape, which allow you to use any object to define transparency. For more information on using masks and image masks, see “Masking Objects to Create Transparency” on page 851.

Original shape  Shape with a mask set to Subtract
Applying Filters to Shapes
You can apply filters to shapes, just like any other object. When you apply a filter to a shape, it remains editable, even though the filter is changing it from a vector-based object into a bitmapped object in order to perform the operation.

You can apply filters to individual shapes, or to a layer in which a number of shapes have been nested. You can use filters to stylize shapes far beyond the options that are available in the Shape tab of the Inspector. More importantly, you can use filters in conjunction with the Shape tab parameters to interactively customize a shape's look, while preserving the ability to re-edit the shape at any time.

**Important:** Once you apply a filter to a shape, you can no longer smoothly increase the size of that shape using the object's transform controls. This is because filters change shapes from vector objects to bitmapped objects. As a result, they scale like other bitmapped objects, which display artifacts if they're enlarged too much.

For more information on using filters, see “Using Filters” on page 701.

Animating Shapes
You can animate shapes using both behaviors and keyframes. Behaviors animate parameters that transform an entire shape, such as Position, Rotation, and Scale. Applying behaviors to shapes works the same as with any object in Motion, and keyframed animation of any of these parameters is stored in the Transform.Position, Transform.Rotation, and Transform.Scale animation parameters of the Keyframe Editor.
Keyframing Shape Animation
You can also keyframe a shape’s animation parameter to animate adjustments to its individual control points. This opens up powerful animation possibilities, since you can reform an entire shape using keyframe animation.

Keyframes applied to the Shape Animation parameter of an object

A series of corresponding keyframed shape changes

To keyframe a shape’s control points:
1 Use the Adjust Control Points tool to select the shape you want to animate.
   Its control points appear. In this example, the selected shape is the lower lip of the mouth illustration.

2 Enable Record (press A).
3 Move to the frame where you want to change the shape, then make any necessary changes to the shape's control points.

4 In the Keyframe Editor (and also in the Timeline, if the Show/Hide Keyframes button is turned on), a keyframe appears for each adjustment you make at a new frame.

Note: Adjusting a shape while the playhead is on an already existing keyframe adjusts the shape at that keyframe.

5 Continue advancing frames and making changes as needed. Every time you make a change to the shape at a new frame, you automatically create a keyframe in that shape's Shape Animation parameter.

5 When you are done animating the shape, disable Record.
The animated shape object interpolates between each keyframed shape. If you don't like how the interpolation is working, you can add more keyframes to force the control points to follow the path you want.

You can also create, delete, and edit the timing of Shape Animation keyframes directly in the Keyframe Editor. For simplicity, each change you make to a shape is recorded as a single keyframe, no matter how many control points are edited. The Shape Animation parameter only allows keyframes set to constant. You cannot use any other form of keyframe interpolation.

The process used to animate both shapes and masks is identical. To see an example of mask animation, see “Keyframing a Mask’s Shape for Animation and Rotoscopy” on page 862. For more information on keyframing in general, see “Keyframes and Curves” on page 401.
Masking Objects to Create Transparency
When you create a mask to define transparency within an object, you’re drawing a shape to use as that object’s alpha channel. Since an object’s alpha channel is a grayscale channel, masks are grayscale objects, where white defines solid areas, progressively darker levels of gray define decreasingly opaque areas, and black defines areas of complete transparency. If you choose View > Channels > Alpha to set the Canvas to display the alpha channel only, you can see the grayscale alpha channel directly.

Masks can be used with objects that already have an alpha channel, and can add to, subtract from, intersect, or replace the object’s original alpha channel.

Masking an Object
Use the mask tools to create different shapes with which to mask an object. There are four mask tools available that are analogous to the four shape drawing tools covered earlier in this chapter.
• Rectangle Mask
• Circle Mask
• Bezier Mask
• B-Spline Mask
Drawing and editing masks using these tools works identically to drawing and editing shapes. The main difference is that while drawing a shape creates a new object in your project, masks must be drawn on top of another object in your project. Once drawn, masks are nested within the specific objects for which they were created in the Layers tab and Timeline. Once a mask is attached to an object, a Masks icon appears to the right of the name of the object. Toggle mask display by clicking this icon.

Note: Masks created for one object can be copied or moved to other objects.

To mask an object:
1 Select an object in the Canvas.
2 Choose a mask drawing tool (the Rectangle Mask tool, the Circle Mask tool, the Bezier Mask tool, or the B-Spline Mask tool).

Note: If you haven't selected an object, the mask tools are not available.
3 Begin drawing the shape you need to mask the object. For more information about how to draw and edit shapes, see “Shape and Mask Drawing Tools” on page 820.

4 When you’re done, you can finish the mask by doing one of the following:
   • Click the first point to close the mask.
   • Press C to close the mask, joining the first point you created to the last.
   • Double-click to close the mask, joining the first point you created to the last.
   • Press Return to close the mask, joining the first point you created to the last.

Note: Unlike shapes, masks are always closed.

After you’ve finished drawing the mask, its effect is immediate, and the mask you created appears nested underneath the object to which it’s applied in the Layers tab and Timeline.
You can create multiple masks for a single object. To add additional masks, select the object again, then follow the above procedure. By default, all new masks are set to the Add blend mode. You can change the Mask Blend Mode parameter in the Inspector to combine masks for different effects. For more information about using multiple masks together, see “Combining Multiple Masks” on page 857.

Mask Parameters
A selected mask’s parameters appear in the Mask tab of the Inspector. These parameters allow you to adjust how the mask is drawn, how each mask operates upon an object, and how masks are combined with one another.

Shape Type: This pop-up menu lets you change the type of control points that are used to define the mask. For example, if you originally created a Bezier mask, you can choose B-Spline from this menu to change how the mask is drawn. You can change a mask’s shape type at any time, but changing a mask from a Bezier shape to a B-Spline shape might dramatically change its form.

- **Linear**: All of a mask’s control points are joined by hard angles, and the resulting mask is a polygon. The control points of a Linear mask lie directly on its edge.
- **Bezier**: Control points can be a mix of Bezier curves and hard angles, creating any sort of mask. The control points of a Bezier mask lie directly on its edge.
- **B-Spline**: Control points are all B-Spline points, with different degrees of curvature. B-Spline control points lie outside the surface of the mask, but are connected by the B-Spline frame.

  *Note*: You can hide the B-Spline frame by turning off Lines in the View pop-up menu above the Canvas.

Mask Blend Mode: Determines how a mask interacts with the alpha channel of the object to which it’s applied. When an object has multiple masks, each mask can have a different Mask Blend Mode. When this happens, each mask adds to, or subtracts from, the object’s alpha channel according to the selected mode. The final alpha channel is the combined result of all the masks that are applied. The four choices are:
• **Add:** This is the default selection for new masks. Each new mask adds to the existing alpha channel. This is useful for adding back regions of an image that other masks are cutting out. In this example, both the rectangle and circle masks are creating opaque regions.

![Add Example](image)

• **Subtract:** Subtracts a mask from the alpha channel. This is useful for creating holes in the middle of objects, or for masking out additional regions of an image that are untouched by other masks. In this example, both the rectangle and circle masks are creating transparent regions.

![Subtract Example](image)
• **Replace:** This setting uses the current mask to completely replace the object’s original alpha channel, as well as any other masks that are applied to the same object that appear underneath the current mask in the Layers list. You can add additional masks above, set to whatever blending mode you like. In the following example, the circle mask is overriding the rectangle, since it is at the top of the masks that are nested within the gradient object.

![Example of Replace Mask]

• **Intersect:** Masks that are set to intersect do not replace an object’s original alpha channel. Instead, they mask out all regions of the object that do not overlap the mask itself. This includes other masks applied to the same object that appear nested underneath the intersecting mask in the Layers tab. In the following example, only the overlapping areas of the rectangle and circle masks are opaque. Everything else is transparent.

![Example of Intersect Mask]

**Invert Mask:** When this checkbox is turned on, the mask is inverted—its solid and transparent areas are swapped. This is useful if you need to switch the solid and transparent areas of a mask you have already created.

**Tip:** You can apply different filters and effects to the foreground and background of an image by first masking the foreground subject, duplicating the object and its mask, then inverting the duplicate object’s mask. Effects that are applied to the background can then be completely isolated from the foreground, or vice versa.

**Note:** You can adjust the opacity of a mask in the Properties tab of the Inspector.
**Feather:** A slider that feathers (softens) the edges of a mask. Positive feathering values soften the edge of the mask from its edge outward. Negative feathering values soften the edge of a mask inward from the edge. Feathering the edge of a mask can soften a harsh rotoscoping job, making the masked object blend more easily with the background.

**Combining Multiple Masks**
Often, you may find that it is impossible to create the mask shape you need using only a single mask. For example, when masking something that has a hole in it, you need to use at least two masks—one set to Add to mask the overall object, and a second one set to Subtract to cut the necessary hole in the middle of it. In the following example, the only way to mask the space between the diver's arms and legs is to create three overlapping masks set to Subtract.

![Original object](image1)
![Three overlapping masks](image2)
![Final result](image3)

Other times, you may find that it's simply more convenient to mask a complex object using multiple masks. This is frequently the case when rotoscoping an object and animating the masks. In this example, the dog's head is masked with four different masks set to Add—one for the head, one for each ear, and a separate mask for the mouth. This makes it easier to make adjustments later on, especially when animating a mask to do rotoscoping.

![Original object](image4)
![Four overlapping masks](image5)
![End result](image6)
Whatever the reason, you can easily combine multiple masks for any object by adjusting each mask’s Mask Blend Mode parameter in the Inspector to create any combination.

Each mask’s blend mode determines whether the mask adds to, subtracts from, or replaces an object’s previously existing alpha channel. Additionally, blend modes affect how masks interact with one another. Ultimately, every mask applied to an object combines according to the specified blend modes to create that object’s final alpha channel. Mask Blend Modes can be changed at any time.

Blend mode operations are also determined by the order in which each mask appears in the Layers tab, particularly with the Replace and Intersect modes. For example, a mask set to the Intersect mode masks out all other regions of an object that do not overlap it. A mask set to Intersect affects all masks nested underneath it. Masks added above it are unaffected by this behavior.

**Masks That Add and Subtract**

New masks always default to the Add blend mode, allowing you to add to an existing alpha channel without cropping what’s already there. Once you’ve drawn the first mask, you may need to use additional masks set to Add or Subtract to refine it.

Masks set to Add create white areas in the alpha channel, making those parts of the object opaque. This can be useful when masking several unconnected subjects in a single image.
Note: To display the rest of a masked object so you can trace it to create a second mask, turn off the first mask in either the Layers tab or Timeline. The outline of the first mask remains visible, even though it's no longer affecting the object’s transparency.

Predictably, masks set to Subtract have the opposite effect, creating black areas in the object’s alpha channel and making those parts of the object transparent. This is particularly useful for cutting holes in an object.

Intersecting Masks
In many instances, you may find that you want to cut out parts of an object, while leaving the rest of the object alone. Using a mask set to Intersect is a good way to do this.

For example, if you import a TIFF file with an alpha channel and you want to cut out part of it without losing the alpha information that’s already there, the Intersect blend mode is the only way to do this. This is also true for objects with keying filters applied.

Replace Masks
A mask set to Replace completely replaces the previously existing alpha channel. It also completely replaces all other masks appearing underneath it in the Layers tab. For this reason, it is unlikely that any but the bottommost mask would be set to this blend mode.
Feathering Masks

One of the easiest ways to adjust a mask is to feather its edges. Feathering a mask by a few pixels can make the masked object blend more seamlessly with a background. Feathering a mask by larger amounts allows you to create progressively softer edges for a variety of design purposes.

You can feather mask edges either outward or inward. The direction in which you feather a mask is dictated by the subject you’re masking. When rotoscoping a subject, a combination of masks using both inward and outward feathered masks may be necessary for the best results.

To feather the edge of a mask:
1. Select a mask.
2. Open the Mask tab in the Inspector.
3 Do one of the following:
  • Drag the Feather value slider to the right for a positive value to feather the mask outward.
  • Drag the Feather value slider to the left for a negative value to feather the mask inward.

Applying Filters to Masks
Like shapes, you can apply filters to masks, which remain editable even after the fact. Although uses for this might not be immediately obvious, it’s actually an extremely powerful way to further manipulate the alpha channel created by one or more masks.

For example, you could apply the Crystallize filter to a mask to stylize its edges. This results in jagged edges that resemble facets of crystal around the edges.

![Original mask (color channel)](image1)

![Original mask (alpha channel)](image2)

![Crystallize filter applied to alpha channel (color channel)](image3)

![Crystallize filter applied to alpha channel (alpha channel)](image4)

When applying filters to masks, it’s useful to bear in mind that masks are just grayscale images. In the example above, the Crystallize filter creates patterns in the grayscale mask image, which results in a rippled translucent pattern.
To apply a filter to a mask, do one of the following:

- Drag a filter from the Library directly onto a mask in the Layers tab or Timeline.
- Select a mask in the Layers tab or Timeline, then choose a filter from the Add Filter pop-up menu in the Toolbar.

The filter appears nested underneath the mask to which it’s applied.

Applying Behaviors to Masks

You can apply behaviors directly to masks. When you apply a behavior to a mask, the mask is animated like any other object. However, since the mask only affects the transparency within an object, and not the position, rotation, or scale of the object itself, the result is similar to that of a “traveling matte,” where the mask moves within the object to which it’s applied, hiding and showing different areas of the image as it moves.

To apply a behavior to a mask, do one of the following:

- Drag a behavior from the Library directly onto a mask in the Layers tab or Timeline.
- Select a mask in the Layers tab or Timeline, then choose a behavior from the Add Behavior pop-up menu in the Toolbar.

The behavior appears nested underneath the mask to which it’s applied.

Keyframing a Mask’s Shape for Animation and Rotoscoping

You can keyframe a mask’s animation parameter to change its shape over time. This can serve many purposes. For example, you can animate a subtractive mask to change the shape of a hole in a foreground object, allowing other layers in the background to show through.

A more conventional use of animated masks is to rotoscope a foreground subject. Rotoscoping is the process of manually tracing a foreground subject in order to isolate it from the background. The end result is similar to a bluescreen or greenscreen effect. Why would you bother? In a wide variety of situations, keying is either impractical or impossible if the shot wasn’t well-planned. Even for shots where keying is possible, manual rotoscoping is often necessary to create garbage or holdout mattes to improve the effect. (For more information on creating garbage and holdout mattes using masks, see “Using Masks to Aid Keying Effects” on page 869.)

All mask animation is stored in the Shape Animation parameter. It’s worth noting that animated masks trigger the same motion blur as any other keyframed parameter in Motion. For example, if you animate an object’s position so that it moves really fast, the object is blurred when you enable motion blur. If you animate an object’s mask so that it also moves fast, the edges of the mask are blurred as well. This is important as an animated mask’s blur should ideally match any blur that’s present in the foreground subject itself.

For more information about motion blur, see “The Render Settings Tab” on page 147.
To rotoscope a subject by animating a mask:

1. Choose View > Resolution > Full to ensure that you are viewing the Canvas at full resolution.

   **Warning:** If the Canvas resolution is not set to full, the outlines of objects and images may shift slightly. As a result, masks created to trace a subject at less than full resolution may not be accurate.

2. Move to the first frame where the mask animation should begin, then draw a mask that accurately isolates the subject.

3. When you’re finished drawing the first mask, enable Record (press A).

4. Move to the first frame of the Timeline where you want to change the shape of the mask, then make any necessary changes to its control points.

   **Tip:** A good way to start rotoscoping an image is to find the frame with the most detail showing in the subject you’re masking, and use that as your starting frame. For example, if you’re masking someone walking, choose a frame where both that person’s arms and legs are out in mid-stride. This allows you to decide how many control points you need to start with. Using the minimum number of control points you can to achieve the necessary level of detail in your mask makes it much easier to animate.

   You should also bear in mind that it’s not always necessary to rotoscope an entire subject with a single mask. Motion allows you to apply multiple masks to a single object, so you can rotoscope different parts of a subject with separate masks. This can make your job much easier. For example, if you’re rotoscoping someone carrying something while walking across a room, you could use one mask for the upper part of their body which doesn’t change shape very much, and another two masks for the legs, which change shape considerably as the person walks.
In this example, the best frame to start with when rotoscoping the dolphin in the example below is the one where all the fins are showing.

When rotoscoping a moving subject, it’s a good idea to play through the clip and examine its direction and speed to get a sense of how the mask needs to be animated. In particular, you may find it helpful to place markers indicating frames where the subject or camera stops, changes direction, or changes speed, since these are likely candidates for your first pass of keyframed mask changes.

By noting these changes, you can attempt to reduce the amount of keyframing by making your first keyframed mask shape adjustments at these major changes in speed and direction. Since animated masks are automatically interpolated to change from one keyframed shape to another, you can let Motion do some of your work for you.

**Note:** If at any time the mask is deselected, you need to select the mask you’re working on in the Layers tab so that its control points become visible in the Canvas. Make sure that the Show Masks button is turned on in the Layers tab so that masks are visible.

Continue moving the playhead and making changes as needed, since the interpolated shape of the mask isn’t going to be perfect.

One imprecise rule of thumb is to move to the frame that’s halfway between any two keyframed mask shapes and make new adjustments. Continue keyframing shape changes at the halfway point between every two keyframes until the mask accurately follows the motion of the subject. For irregularly shaped objects or objects with complex motion, don’t be surprised if you need to add a large number of keyframes. Nobody ever said that rotoscoping was fast!
Every time you move the playhead to a new frame and make a change to the mask’s shape, a keyframe is automatically created in that shape's Shape Animation parameter. If you move the playhead directly on top of a previously existing keyframe, you change the mask’s shape at that point without creating a new keyframe.

Note: You can also transform and shear masks as you would any other object. If you move, rotate, scale, shear, or change the anchor point for a mask while animation recording is enabled, you add keyframes to additional channels in the Keyframe Editor.

When you’ve finished animating the mask, disable Record (press A).

You can also create, delete, and edit the timing of a mask’s Shape Animation keyframes directly in the Keyframe Editor. For simplicity, each change you make to a mask is recorded as a single keyframe, no matter how many control points you edited. The Shape Animation parameter only allows keyframes set to Constant—you cannot use any other form of keyframe interpolation.

The process used to animate both masks and shapes is identical. To see an example of shape animation, see “Animating Shapes” on page 847. For more information on keyframing in general, see “Keyframes and Curves” on page 401.

Applying Image Masks to an Object
Another way you can create transparency in an object is by using image masks. An image mask creates transparency in another object by deriving an alpha channel from another object, such as a shape, text object, movie, or still image.

Note: You can use masks and image masks together.
The power of image masks is that they do not have to be drawn or animated. Instead, you can use virtually any image or movie clip to create transparency in another object. By default, movie clips create animated image masks, but you can also set an image mask to use only a single frame.

Image masks can also be used to assign masks that were created in other applications. For example, you can import an animated mask that was created in Shake and exported as a QuickTime movie into your Motion project, and use it as an image mask.

When you use an object as an image mask, you can choose which of the object’s channels to use to create transparency from the Source Channel pop-up menu in the Image Mask tab of the Inspector. The choices include:

- Red
- Green
- Blue
- Alpha
- Luminance

Since alpha channels are basically 8-bit grayscale images, you can use any single color channel as an image mask. You can also use another object’s alpha channel. Luminance allows you to use the aggregate luminance from the red, green, and blue channels of an image to create transparency. For all these options, color is ignored.

Assigning an image mask is a two-part process. First, you create a blank image mask underneath an object. Then you assign the image you want to use to create transparency.

To add an image mask to an object:
1. Select an object.
2. Choose Object > Add Image Mask (or press Shift+Command+M).
   The image mask appears underneath the object in the Layers tab and Timeline.
3. Select the image mask in the Layers tab or Timeline.
4 Do one of the following:

- Open the Image Mask tab in the Inspector, then drag the object you want to use as the mask into the Image well.

- Drag the object you want to use as the mask into the Mask Source well in the Dashboard.

  **Important:** Be sure to click and drag in one movement to successfully drop an object in an image well. If you select the object to use as the source, and release the mouse button, you lose the selection.

  In this example, a text object is used as the mask object.

5 Choose the channel you want to use to create transparency from the Source Channel pop-up menu, as well as any other options that are necessary to create the required transparency.

**Image Mask Parameters**

Once you’ve added an image mask to an object, the following parameters become available in the Image Mask tab of the Inspector.
**Image:** An image well that assigns a shape, text object, image, movie, or numbered image sequence to use to mask an object.

**Frame:** When you use a movie or image sequence as the assigned image, this slider allows you to select the start frame for playback.

**Hold Frame:** When you use a movie or image sequence as the assigned image, turning on this checkbox freezes the frame specified in the Frame parameter. That frame is then used as the mask for the masked object’s total duration.

**Offset:** Offsets the X and Y values of the mask’s position, relative to the object it’s masking. This allows you to change which part of the object is masked.

**Wrap Mode:** If an image mask is smaller than the object to which it’s been assigned, you can increase the area it affects by selecting a wrap mode.
- **None:** The object is used as is.
- **Repeat:** The object is duplicated and tiled to fill up the full width and height of the image.
- **Mirror:** The object is duplicated, tiled, and reversed to fill up the full width and height of the image. This may create a more seamless repetition for some images.

**Source Channel:** Lets you choose which channel of the assigned image is used to create the mask. There are five choices.
- **Red:** Uses the red channel as a grayscale mask.
- **Green:** Uses the green channel as a grayscale mask.
- **Blue:** Uses the blue channel as a grayscale mask.
- **Alpha:** Uses the alpha channel from the mask object.
- **Luminance:** Uses the aggregate luminance from the red, green, and blue channels as a grayscale mask.

**Mask Blend Mode:** A pop-up menu that determines how an image mask interacts with the alpha channel of the object to which it’s applied. When an object has multiple image masks, each mask can have a different Mask Blend mode. When this happens, each mask adds to, or subtracts from, the object’s alpha channel according to the selected mode. The final alpha channel is the combined result of all the image masks that are applied. These modes are identical to the Mask Blend Mode options available for shape masks. The four options are:
- **Add:** This is the default selection for new masks. The mask is added to the alpha channel. This is useful for adding back regions of an image that other masks are cutting out.
- **Subtract:** Subtracts a mask from the alpha channel. This is useful for creating holes in the middle of objects, or for masking out additional regions of an image that are untouched by other masks.
- **Replace**: This setting uses the current mask to completely replace the object’s original alpha channel, as well as any other masks that are applied to the same object that appear underneath the current mask in the Layers list. You can add additional masks above, set to whatever blending mode you like.

- **Intersect**: Masks that are set to Intersect do not replace an object’s original alpha channel. Instead, they mask out all regions of the object that do not overlap the mask itself. This includes other masks applied to the same object that appear nested underneath the intersecting mask in the Layers tab.

**Invert Mask**: When this checkbox is turned on, the mask is inverted—its solid and transparent areas are swapped. This is useful if you need to switch the solid and transparent areas of a mask you’ve already created.

**Stencil**: With this parameter turned on, the object’s geometric transforms are respected by the mask. If you’re creating a mask with transformed Scale, Position, Rotation, or other parameters, turn on this checkbox to use the modified object.

**Stretch**: With this parameter turned on, the mask is stretched to fit the boundaries of the image, and remains centered on the object’s center point.

**Note**: Stencil and Stretch are mutually exclusive.

### Applying Filters to Image Masks
Like shape masks, you can add filters to image masks to further manipulate the transparency effect. In particular, you may be able to improve the mask that’s created by using color correction filters such as Brightness, Contrast, and Gamma to manipulate the contrast of the mask, pulling out or reducing detail to create the transparency effect you need.

Filtering image masks works identically to filtering shape masks. For more information, see “Applying Filters to Masks” on page 861.

### Applying Behaviors to Image Masks
You can also apply behaviors to image masks to create animated transparency effects. For more information, see “Applying Behaviors to Masks” on page 862.

### Using Masks to Aid Keying Effects
Keying is rarely a one-step process. Although adding a keying filter is the first step, there is usually additional work that needs to be done to create a good key that retains detail around the edge of your subject. The mask tools and alpha channel filters presented in this section can be used to turn a decent key into a great one.
Garbage Masks

The second step in most keying shots is to create a garbage mask to crop out unwanted objects in the shot that can't be keyed, such as the edge of a bluescreen stage, lighting rigs, or tape that appears in the background.

You can also use a garbage matte to mask out parts of the background that are too difficult to key without the loss of foreground detail.

To create a garbage mask:

- Select a keyed object, and use one of the mask tools to draw a mask around the foreground subject.

  Note: You may need to animate the garbage mask if the subject is moving.

By default, the mask is set to Add, and crops out everything outside the mask, while leaving the transparent areas within the mask alone.

For more information about using Motion's keying filters, see “Keying Filters” on page 760.
Holdout Masks
Sometimes, while pulling a key, you lose part of the image you’re trying to keep. This can happen when the color of the subject’s clothes is too close to the color of the background being keyed out, or when you need to use keying values that are too aggressive. In this example, the shadows on the elephant’s face are accidentally getting keyed along with the background.

In these cases, you can duplicate the original object, mask the part of the subject that’s being incorrectly keyed, and composite it over the keyed version to fill it back in.

Note: The Spill Suppression filter can modify the color of the foreground subject as well. If you’re using the Spill Suppression filter on the keyed object, you may have to apply the same filter to the holdout mask object to make sure the color matches.

To create a holdout mask:
1 Key and mask the foreground subject.
   For more information about using Motion’s keying filters, see “Keying Filters” on page 760.
2 Duplicate the keyed object, then move it so that it appears above the original object in the Layers tab or Timeline.
3 Mask the area of the foreground that is incorrectly keyed. Make sure that the mask is entirely within the subject being keyed.
Note: You may need to animate the holdout mask if the subject is moving.

4 On the newly duplicated layer, delete the original keying filters since they’re unnecessary. If you’ve used a Spill Suppression filter, don’t delete it, since it’s probably changing the color of the subject.

5 Feather the edge of the holdout mask you’ve just created, to make sure that it blends in with the object you initially keyed.

6 As an optional step, you can nest the originally keyed object along with the holdout matte you just created inside a dedicated layer so that you can manipulate the entire subject as a single object.

Performing Multiple Keys on a Single Subject
In some instances, it may be difficult to key an entire subject with a single keying filter while retaining fine details. For example, uneven lighting or background color might mean that the best settings to key a subject’s hair may not work elsewhere.

If you attempt to key the entire subject with a single keying filter, chances are that you need to use such extreme settings that a lot of edge detail is lost. In such cases, masks can be used to isolate different parts of a subject, so that you can apply different keying settings to each area.

To segment a subject into separate keying zones:
1 Create a new layer, and place the object you’re keying within the new layer.

2 Duplicate the object you’re keying until you have a separate duplicate for each part of the image you want to separately key.

3 Use one of the mask tools to mask each part of the subject in each of the duplicate objects. Make sure that all of the duplicate objects overlap, so that there are no gaps in the foreground.

Note: You may need to animate the overlapping masks if the foreground subject is moving.
4  Apply the appropriate keying filter to each of the isolated parts of the subject, and adjust each filter's settings as necessary.

Eventually, you may find you can achieve an optimal key for each part of the subject. Furthermore, with all duplicates nested within a single layer, you can continue to manipulate the subject as a single object.

**Manipulating Alpha Channels Using Filters**

In addition to using shape and image masks to create transparency within objects, there are also filters you can use to manipulate or even replace an object's alpha channel.

For example, all of the keying filters create transparency by generating an alpha channel based on colors or luminance values in that object. Keying filters are usually used on objects that have no alpha channel information, and they add a new alpha channel to the objects to which they're applied. For more information on the use of the keying filters, see “Keying Filters” on page 760.

The process of improving a keying effect, or of customizing an alpha channel created using one or more shape or image masks, may require the use of special filters. Although you can apply any filter directly to a shape or image mask to modify that particular mask's effect, the filters described in this section modify an object's entire alpha channel directly, including the sum total of all masks and other filters that have been applied to that object.

For example, if you've applied a keying filter, you can use the following filters to modify the resulting alpha channel even though no mask appears for that object in the Layers tab or Timeline.
**Channel Blur**: This filter, found in the Blur category of the Filters library, lets you selectively blur the alpha channel. You can set the amount of horizontal and vertical blur independently.

![Original (color channel)](image1) ![Original (alpha channel)](image2)

![Channel Blur (color channel)](image3) ![Channel Blur (alpha channel)](image4)

**Matte Choker**: This filter, found in the Matte subcategory of the Filters library, increases or decreases the semi-transparent area of an object’s alpha channel by performing a gamma correction (similar to the Gamma color correction filter) to all regions of the alpha channel falling between solid black and solid white. This allows you to widen or narrow the semi-transparent areas within an object, while leaving all 100 percent solid and transparent areas unaffected. Once you’ve added a Matte Choker to an object, the following parameters become available in the Filters tab of the Inspector:

- **Edge Thin**: A slider that allows you to modify the edges of the matte. Higher positive edge thin values eat into the alpha channel, eliminating fringing around the edges of translucent areas. Negative values fill in translucent values, filling in holes and widening the matte into areas of fringing.
• **Feather:** A slider that allows you to adjust edge translucence. Lower values reduce the amount of translucence in a matte, but this results in harder edges around holes and edges in the alpha channel.

![Keyed original object (color channel)](image1) ![Keyed object with holes (alpha channel)](image2)

![Keyed object with Matte Choker (color channel)](image3) ![The Matte Choker eliminates the holes (alpha channel)](image4)
Working With Audio

Sound is an integral part of many motion graphics projects. Use audio in your project for background music, dialogue, or scratch tracks.

You can add audio files to your project and use markers and keyframes to sync the audio with other events in your project. You can import several different types of audio files, including the audio tracks from QuickTime movie clips. For each audio file you add to a project, Motion creates an audio track.

You can turn audio tracks on and off, select and play individual tracks, mute and solo tracks, and control volume and pan settings for each track in the Audio tab of the Project pane.
You can add keyframes for volume and pan to an audio track and trim an audio track in the Audio Editor. You can also trim an audio track in the Timeline.

You can export audio with video, or export audio alone, in a variety of formats. See “Exporting Audio” on page 898 for a list of the audio export formats Motion supports.

If you have Soundtrack Pro installed, an audio file that exists in a Motion project can be opened and modified in Soundtrack Pro. The modified file is automatically updated in Motion. For more information, see “Using Soundtrack Pro With Motion” on page 897.

Audio Files in Motion Projects
You can add different kinds of audio files to a Motion project. In addition, Motion lets you preview files before adding them to your project and lets you view the audio files in a project in several ways.

Import File Formats
Motion supports audio in a variety of common file formats, sample rates, and bit depths. Supported import file formats include:
- AIFF
- WAV
- MP3
- AAC (except rights-protected AAC files)
- QuickTime Audio (.mov)

Note: Multi-track QuickTime movie files are also supported.

You can import audio files with sample rates up to 192 kHz, and with bit depths up to 32 bits. Mono and stereo files are supported. Multi-channel audio files are also supported.

Note: Since MP3 and AAC are compressed file formats, playback quality may not be as high as with uncompressed formats such as AIFF.
When you add an audio file to your project, Motion converts it to its own internal format. This allows you to use audio files with different formats, sample rates, and bit depths in the same project. When you export your project, the audio is exported according to the current audio settings in the Export dialog.

**Previewing an Audio File**
You can listen to, or preview, an audio file in the File Browser before adding it to a project.

To preview an audio file, do one of the following:

- In the File Browser, select the audio file.
  The file begins to play.

  **Note:** If the file does not play automatically, turn on “Play Items on a Single Click” in the General Preferences (or press `Command+`).

- In the File Browser, select the audio file, then click the Play button in the Preview area.
  While the file is playing, you can click the button again to pause playback.
Adding an Audio File
To work with audio in your project, you start by adding an audio file to the project.

**Note:** Although you can see a connected iPod in the File Browser as a hard disk, you can only browse for and import supported non-music files into Motion, such as images.

**To add an audio file from the File Browser, do one of the following:**

- Drag the file from the File Browser or the Finder into the Canvas.
- Drag the file from the File Browser or the Finder into the Project pane or Timeline Layer list.
- Drag the file from the File Browser or the Finder into the audio area of the Timeline (not the Audio Editor).

**Note:** To display audio in the Timeline, click the Show Audio button in the bottom of the Timeline Layer list.

When the black border appears around the audio section, release the mouse button.

- In the Audio tab, click the Add button (+), locate the file you want to add, then click Import.

**Note:** If you use the Add button (+) in the Media tab, the audio file is only added to that tab. To use the file in the project, drag the file from the Media tab to the Canvas.

**To add an audio file from iTunes:**

1. In the Library, select the Music category.
2. Select a playlist, then select a song in the file stack.
3. Do one of the following:
   - In the Preview area, click Apply.
   - Drag the file to the Canvas, Project pane, or Timeline Layer list.

**Note:** Rights-protected AAC files cannot be imported into Motion and do not appear in the file stack. This includes all music purchased from the iTunes store.
The audio file is added to the project, and appears in the Audio tab of the Project pane, the Audio Editor, and the Timeline (if the Show Audio button is turned on). The start point of the audio file is determined by the Create Objects At preference in the Project Preferences. If set to “Start of project,” the file starts at the beginning of the project. If set to “Current frame,” it starts at the current location of the Timeline playhead. A Dashboard for the audio appears in the Canvas.

Note: If the Dashboard does not appear, press D or F7.

When you drag a QuickTime movie into the Canvas or the Layers tab of the Project pane, the movie’s video and audio tracks are imported into your project. You can choose to add only the audio track of a QuickTime movie.

You can also drag the file directly to the Media tab. Like image files, this stores the file in the project but does not “use” the file until you actively add the file to the Timeline Layer list or Canvas. To use the file, drag the audio track from the Media tab to the Canvas or Timeline Layer list.

To add only the audio track from a QuickTime movie:

- In the File Browser or in the Finder, locate the QuickTime movie file, then drag it into the Audio tab of the Project pane.

The audio track from the movie is added to your project, without the video footage.

If the QuickTime movie contains multiple audio tracks, hold the file over the Audio tab until the drop menu is displayed. To import the file with a single audio track, select Mix To Stereo. To import the file with individual tracks, select Import All Tracks. For more information, see “Adding a Multi-Track QuickTime Movie File” on page 881.

Adding a Multi-Track QuickTime Movie File

A QuickTime movie file can contain multiple audio tracks. When importing a multi-track QuickTime movie file, you can import the audio portion of the file as a single audio track, or as individual tracks. Using the Import button (in the Preview area) results in the multi-track file being imported as a single track. To maintain the individual audio tracks, you need to use the drop menu or the File > Import command.

When you add a multi-track audio file, the file appears as an individual track that can be used independently of the video file. When the file is unlocked, the track can be individually enabled, disabled, or deleted. Deleting the source QuickTime movie file from the Media tab, however, deletes all audio and video that originated from that file.
Note: Although you can import files that contain multiple audio tracks into Motion, when you export your project, all tracks are treated equally and mixed into a single track on export.

To import a multi-track QuickTime movie file using the drop menu:

1. Drag the file from the File Browser or the Finder and hold the file over the Canvas. A drop menu appears.
2. Do one of the following:
   - To import the movie with a single audio track, select Mix To Stereo, then release the mouse button.

The file appears in the Audio tab as a single audio track and the video appears in the Canvas (and Layers tab). The link icon in the Lock column of the Audio tab indicates that the audio object has a corresponding video element.

Note: When a multi-track QuickTime file is imported without using the drop menu, Mix To Stereo is the default import method.
In the Layers tab, the link icon also appears in the Lock column for the object, indicating the object has a corresponding audio element.

- To import the movie file with a single audio track for each track, select Import All Tracks, then release the mouse button.

The file appears in the Audio tab with an individual audio track for each track in the file. The following image shows the Audio tab after importing a multi-track QuickTime movie file that contains six tracks with a single channel in each track.

By default, all tracks are enabled. In the Pan column, the left tracks are panned to the left, and the right tracks are panned to the right.

**To import a multi-track QuickTime movie file using the Import command:**

1. Choose File > Import (or press Command+I).
2. In the Import File dialog, select the QuickTime file.
3 Choose an import option from the Audio pop-up menu (located at the bottom of the Import Files dialog), then click Import.

The file is imported with your chosen option.

**Adding a Multi-Channel Audio File**

In the same manner as importing multi-track QuickTime movie files, you can import a multi-channel audio file as a single track, or as individual tracks for each channel. Using the Import button (in the Preview area) results in the multi-channel file being imported as a single track. To maintain individual audio tracks for each channel, you need to use the drop menu or the File > Import command.

**Important:** Because Soundtrack Pro does not support multi-channel audio files (it does support multi-track QuickTime files), you cannot open a multi-channel file in Soundtrack Pro from Motion. For more information on modifying audio tracks in Soundtrack Pro, see “Using Soundtrack Pro With Motion” on page 897.

**Note:** Although you can import a multi-channel audio file into Motion, when you export your project, all channels are treated equally and mixed into a single track on export.

**To import a multi-channel audio file using the drop menu:**

1 Drag the file from the File Browser or the Finder and hold the file over the Canvas. A drop menu appears.

2 Do one of the following:
   - To import the audio file as a single track, select Mix To Stereo, then release the mouse button.

The file appears in the Audio tab as a single audio track.
**Note:** When a multi-channel audio file is imported without using the drop menu, Mix To Stereo is the default import method.

- To import the audio file with a separate track for each channel, select Import All Tracks, then release the mouse button.
  
  Each channel is converted into a track in Motion. Like importing a multi-track QuickTime movie, all tracks are enabled.

**To import a multi-channel audio file using the Import command:**

1. Choose File > Import (or press Command+I).
2. In the Import File dialog, select the audio file.
3. Choose an import option from the Audio pop-up menu (located at the bottom of the Import Files dialog), then click Import.
   
   The audio file is imported with your chosen option.

**Viewing Audio Files**

You can view a listing of all the audio tracks in your project, and view the audio waveform for an individual track. You can also view information about each track, including its duration, sample rate, and file size.

**To view a listing of your project’s audio tracks:**

- In the Project pane, click the Audio tab to see the audio files in your project.

**To view the waveform of an audio track:**

- Select an audio file in the Audio tab, then do one of the following:
  
  - Click the Timeline tab in the Timing pane, then click the Show/Hide Audio button at the lower left of the pane.
    
    A bar appears, containing the waveform of the file.
  
  - Click the Keyframe Editor tab in the Timing pane, then click the “Show audio waveform” button at the lower-left corner of the pane.
    
    The waveform of the selected file appears in the Keyframe Editor, along with any keyframes.
  
  - Click the Audio Editor tab in the Timing pane.
The waveform of the selected file appears in the Audio Editor.

![Audio Editor](image)

Viewing the audio waveform can be useful in the Keyframe Editor to synchronize motion and other parameter changes with audio events such as peaks or points of silence, and in the Audio Editor to synchronize level and pan changes with audio events.

**To view information about your project’s audio files, do one of the following:**

- In the Project pane, click the Media tab.
- In the Media tab of the Project pane, select the audio file, and then display the Inspector (press `Command`+3).

The Media tab and Inspector display information about each audio file, including kind, duration, sample rate, format, file size, and other details.

### Cutting, Copying, and Pasting Audio Tracks

You can cut, copy, and paste audio tracks in the Audio tab. You can also duplicate tracks.

**To cut an audio track:**

- In the Audio tab, select the audio track, then do one of the following:
  - Choose Edit > Cut.
  - `Control`-click the track, then choose Cut from the shortcut menu.

**To copy an audio track:**

- In the Audio tab, select the audio track, then do one of the following:
  - Choose Edit > Copy.
  - `Control`-click the track, then choose Copy from the shortcut menu.

**To paste an audio track:**

- In the Audio tab, do one of the following:
  - Choose Edit > Paste.
  - `Control`-click an empty area, then choose Paste from the shortcut menu.
To duplicate an audio track:
- In the Audio tab, select the audio track, then do one of the following:
  - Choose Edit > Duplicate.
  - Control-click the track, then choose Duplicate from the shortcut menu.
The duplicate appears below the original file in the Audio tab.

Deleting an Audio File
There are two ways to remove an audio track from your project.

To delete an audio track:
- In the Audio tab, select the audio track, then do one of the following:
  - Press the Delete key.
  - Click the Delete button (⁻) at the top of the Audio tab.
  - Control-click the file you want to remove, then choose Delete from the shortcut menu.

Note: Deleting tracks from the Audio tab does not remove the associated file from the Media tab.

Working With Audio Tracks
When you add an audio file to your project, Motion creates an audio track for the file. In the Audio tab of the Project pane, you can turn audio tracks on and off, select tracks, mute and solo tracks, and control their volume and pan settings.

Any changes you make to an audio track, such as renaming or trimming it, do not affect the source audio file.

Turning Audio Tracks On or Off
When you add an audio file to your project, it becomes a track in the Audio tab and is turned on by default. You can turn individual audio tracks on or off in the Audio tab. Turning off an audio track silences it during playback, and means the track is not part of your final mix when you export the project.
To turn an audio track on or off, do one of the following:

- In the Audio tab of the Project pane, click the activation checkbox on the left side of the track. Click the checkbox again to return the track to its previous state (on or off).
- In the Timeline, with the Show/Hide Audio button turned on, click the activation checkbox (the left column). Click the checkbox again to return the track to its previous state.

Turning an audio track off removes it from the overall audio mix. If your project includes a lot of audio tracks, turning off unused tracks can free some of the computer's resources for other purposes.

Selecting Audio Tracks
To display an audio track in the mini-Timeline and in the Audio Editor, you first select it.

To select an audio track:
- Click anywhere in the row containing the track's name and controls in the Audio tab. Selected tracks are highlighted in blue.

You can select multiple tracks by Shift-clicking. However, the Audio Editor can display only one track at a time. When multiple tracks are selected, the Audio Editor appears empty.

Playing Audio Tracks
When you click the Play button in the transport controls, you hear the audio tracks in your project play in time with your visuals. You can also play an individual audio track separately from the project Timeline.

To play audio with your project:
- Click the Play button in the transport controls.

When you click the Play button, you hear all audio tracks in the project that are turned on and are not muted.

To play an individual audio track:
1. In the Audio tab, select the audio track.
2. In the Audio Editor, click the Play button.

The audio track plays, and the playhead in the Audio Editor shows the region of the track currently playing. Playback in the Audio Editor is independent of the project.

When you play audio tracks, the playback sample rate and bit depth are determined by the playback device. Built-in audio plays back at CD quality (44.1 kHz sample rate, 16-bit depth). If you are playing audio using an external device, Motion plays the audio using the output settings for the device.
Muting and Soloing Tracks
When you mute an audio track, it is silent during playback, but is still part of the mix when you export your project. When you solo an audio track, all other audio tracks are muted, which lets you hear the soloed track more clearly.

You can mute, unmute, solo, or unsolo an audio track at any time, even during playback. When you export your project, all tracks that are turned on are included in the final mix, regardless of whether they are muted or soloed.

To mute an audio track, do one of the following:
- Click the Mute button.
- Click the Mute button again to unmute the track.
- Control-click the track, then choose Mute from the shortcut menu.

To solo an audio track, do one of the following:
- Click the Solo button.
- Click the Solo button again to unsolo the track.
- Control-click the track, then choose Solo from the shortcut menu.

You can also solo multiple audio tracks. When you solo more than one track, all tracks not soloed are muted (silent) during playback.

Setting Levels
Level refers to the loudness or volume of an audio track (sometimes referred to as “gain”). You can adjust an audio track’s level using the Level slider. The available range is from –96 (minimum level) to 6 (maximum level). The default is 0 (sometimes called “unity gain”). The values correspond to the decibel scale (dB).

To set an audio track’s level:
- In the Audio tab, the Dashboard, or the Audio Track pane of the Inspector, drag the Level slider to set the level you want. In the Audio tab, the Level slider is located in the Name column under the track’s name.
- You can also type a value in the value field. You can set the level in integer increments (–1, 0, 1, and so on).
Setting Track Panning
Pan refers the left-right balance of a track in the stereo field. You can adjust a track's
pan position using the Pan slider. The available range is from –100 (hard left) to 100
(hard right). The default is 0 (center).

To set a track's pan position:
- In the Audio tab, the track's Dashboard, or the Audio Track pane of the Inspector, drag
the Pan slider to the left or right to set the pan position for the track.

You can also type a value in the value field. You can set the pan position in integer
increments (–1, 0, 1, and so on). The pan field shows numbers in a three-digit format
(000, for example).

Locking Tracks
Locking a track prevents it from being edited. When a track is locked, you cannot mute
or solo the track, change its level or pan, move or trim it, or add keyframes. You can still
play the track, and turn it on or off.

To lock a track:
- In the Audio tab, click the Lock icon on the right side of the track. Click the Lock icon
again to unlock the track.

Renaming Tracks
You can also rename a track, to give it a more useful name in the project.

To rename a track:
- In the Audio tab, double-click the track's name in the Name column, then type a new
name.

Working With The Master Track
Each project has a Master audio track. The controls for the Master track are located at
the bottom of the Audio tab, below the individual audio tracks. Using the Master track's
controls, you can make changes that affect the final mixed output of all audio tracks.
For example, you can lower the volume of all tracks at once, or pan all tracks to the left
or right. In addition, you can turn the Master track on or off, or mute it.
You select the Master track by clicking its area at the bottom of the Audio tab. When selected, the Master track area appears highlighted.

**Turning the Master Track On or Off**
The Master track is turned on by default. When it is turned off, no sound is audible when you play the project, and no audio is included when you export your project. When it is turned on, all audio tracks that are turned on are included in your export.

**To turn the Master track on or off:**
- Click the checkbox at the left side of the Master track. Click the checkbox again to return the Master track to its previous state.

When the master track is selected, a master waveform appears in the Audio Editor.

**Setting Master Level**
You can use the Master Level slider to set the overall volume level for the audio in your project.

**To set the master level:**
- Drag the Master Level slider to set the level you want.

The Master level works in conjunction with the level setting for each individual track. For example, if you set a track’s level to 0.5 and you set the master level to 0.5, the combined level is 0.25 (one-fourth) of the original.

**Note:** If you raise both an individual track’s level and the Master level so that the combined increase is greater than 2, you may cause audio distortion or “clipping.” For information about how to prevent clipping, see “Preventing Clipping” on page 891.

**Viewing the Master Level**
To the right of the Master track controls is a pair of stereo level meters that display the combined level of all the audible tracks.

If either of the two red dots above the level meters (called clipping indicators) light up during playback, this indicates that your master levels are too high, causing audio distortion or “clipping.”

**Preventing Clipping**
Typically, when working with digital audio, audio engineers set the overall volume level as high as possible without causing clipping. If the clipping indicators light up above the master level meters, you need to find where clipping is occurring and lower the level to eliminate the cause of the clipping.

If clipping occurs, play the project and observe where the clipping indicators light up. You may want to solo each audio track to determine if a particular track is causing the clipping. You can also play a track in the Audio Editor and watch the Audio Editor’s level meters, which show only the levels of the track playing.
Once you determine which track is causing the clipping, you can lower the track’s overall level, or use keyframes to lower the track’s level at the specific point in time where clipping occurs.

The clipping indicators are “sticky,” meaning that once they light up, they stay lit until you reset them or close the project. This is intended to help remind you to find and eliminate the cause of the clipping before you export your project. As you work to eliminate clipping, reset the clipping indicators and play the project again to make sure clipping no longer occurs.

To reset the clipping indicators:
- Click the clipping indicator that is lit.

Setting Master Pan
You can use the Pan slider in the Master track to set the left-right pan position for the audio.

To set the Master pan position:
- Drag the Pan slider to place the sound where you want it in the stereo field.

The Master pan slider works in conjunction with the pan setting for each individual track. For example, if you pan a track to –100 (hard left) and you pan the master to 100 (hard right), the track is inaudible.

Slipping Audio Tracks
When you add an audio file, its start point is set to the current location of the playhead. You can slip an audio track so it starts playing at a different point in time.

To slip an audio track:
1 In the Audio tab, select the track.
   The bar for the audio file appears in the mini-Timeline.
2 In the mini-Timeline, drag the track’s bar left or right. As you drag the bar, a help tag appears, showing the In and Out points for the track.
Note: You can also show and slip the timebar for an audio track in the Timeline by clicking the Audio Scrubbing button at the lower-left edge of the Audio Editor.

Trimming Audio Tracks
You can edit the start and end points of an audio track to cut down the length of the audio in the track, or to have it start or end at a specific point in time. This is called “trimming” the track. Motion lets you trim audio tracks, either visually or by entering numeric values for the In and Out points.

When you trim an audio track, the audible part of the track is highlighted in green in the Audio Editor. Trimming an audio track is non-destructive, and does not affect the original audio file.

To trim an audio track visually:
1 In the Audio tab, select the audio file you want to trim.
   The track’s bar appears in the Audio Editor and in the mini-Timeline.
2 In the Audio Editor or the mini-Timeline, position the pointer over the beginning or end of the timebar, and the Trim pointer appears.
3 Drag the beginning or end of the timebar to the point where you want to set the In or Out point for the file. The progress of your trim is displayed in the Audio Editor, and lets you see the time markers, so you can trim more precisely.

To trim an audio track numerically, do one of the following:
- In the Audio Editor, type a value in the In field where you want the track to begin, or type a value in the Out field where you want the track to end.
- Click the increment arrow at the left edge of the field to increase the value, or click the decrement arrow at the right edge of the field to decrease the value. Shift-click to move in increments of 10.
Position the pointer over the number in either the In or Out field, and the drag pointer appears. Drag left to increase the value, or drag right to decrease the value.

Scrubbing an Audio Track
You can scrub an audio track in the Audio Editor to hear a portion of the track. Use the Audio Scrubbing button to turn scrubbing on or off. Scrubbing is turned on by default in the Audio Editor (it is off by default in the Timeline).

To scrub an audio track:
1 In the Audio tab, select the track.
2 If scrubbing is turned off, click the Audio Scrubbing button, located at the lower-left corner of the Audio Editor, to turn on scrubbing.
3 Drag the playhead in the Audio Editor left or right. Keep the pointer still to loop continuously on the frames adjacent to the current frame.

Note: By default, audio scrubbing loops continuously on the 5 frames adjacent to the current frame when you keep the pointer still. You can turn off looping by choosing Motion > Preferences, clicking the Project tab, then turning off the “Loop audio while scrubbing” checkbox under Playback Control.

You can also scrub audio in the Timeline by turning on the Audio Scrubbing button, then Option-dragging in the ruler at the top of the Timeline.

Keyframing Level and Pan Changes
Each audio track has curves for both level and pan, and you can add and edit keyframes to automate level and pan changes over time. This lets you create fade-ins and fade-outs, drop audio levels for voice-overs and other sound effects, and eliminate clipping. You edit the curves directly on the audio waveform in the Audio Editor, allowing you to make accurate edits.

For more information about using keyframes and editing curves, see “Keyframes and Curves” on page 401.
Recording Keyframes
You can record keyframes for audio level and pan by clicking the Record button, then moving the sliders in the Audio tab, the Dashboard, or the Inspector. Recording keyframes for audio level and pan can be useful for trying out changes, and when you want to hear the results in real time.

Adding and Editing Keyframes
In the Audio Editor, level curves are displayed as a purple dashed line, and pan curves are displayed as a blue dashed line. Both curves appear overlaid on top of the audio waveform. The ranges of level and pan curves are:

- Level curves range from –96 to 6 with 0 equivalent to 0 dB (unity gain).
- Pan curves range from –100 to 100.

The range of values is displayed along the left side of the Audio Editor. Because level and pan curves each use a different scale, you can only see numerical values for a curve if the checkbox for that curve is turned on, and the checkbox for the other curve is turned off.

To add keyframes to a level curve:
1. Turn on the Level checkbox. You may want to turn off the Pan checkbox, so that you can see the level curve more clearly, and see its numeric values on the left.
2. Option-click the purple level curve to add a keyframe.
3. Drag the keyframe up or down to set the level you want at a specific time. Drag down to lower the level, or drag up to raise the level.
4. Add any other keyframes you need, and drag each one to set its value.

To add keyframes to a pan curve:
1. Turn on the Pan checkbox. You may want to turn off the Level checkbox, so that you can see the pan curve more clearly, and see its numeric values on the left.
2. Option-click the blue pan curve to add a keyframe.

You can use curves to create fade-ins, fade-outs, and other level changes in the Audio Editor.
3 Drag the keyframe up or down to set the pan position you want at a specific time. Drag down to pan to the left, or drag up to pan to the right.

4 Add any other keyframe you need, and drag each one to set its value.

Note: When modifying Pan values, you can Control-click a keyframe to display a shortcut menu that lets you set different interpolation methods between points on your curve. See “Modifying Curves” on page 437 for more information. Only the Linear interpolation method is available for Level.

Creating Fade-ins and Fade-outs
You can create a fade-in by setting the track level to a lower value, adding keyframes at the point you want the sound to fade in, then dragging those keyframes to a higher value.

You can create a fade-out by adding keyframes at the point you want the sound to fade out, then dragging those keyframes to a lower value.

Cross-fading Audio Tracks
In the Keyframe Editor, you can view the audio tracks in your project, along with the level and pan curves for each track.

To create a cross-fade, add keyframes to the level curve of each track at the same (or nearly the same) points in time, where you want the cross-fade to start and end. You can use the frame numbers in the ruler of the Audio Editor for reference.

Be sure to listen to the cross-fade as you work. You may find that the best-sounding results are achieved by having the level curves for the two tracks be slightly asymmetrical. This is because the perceived loudness of different sounds with the same numerical value in the Audio Editor can be different.

Syncing Audio and Video Tracks
Motion lets you determine how to handle the playback of audio if the audio tracks are not in sync with the video. You can choose to skip video frames in order to re-sync with the audio, or to pause audio playback to avoid skipping frames if the audio is out of sync.

To set audio sync preferences:
1 Choose Motion > Preferences, then click the button for the Project pane.

2 In the Playback Control section of the Project pane, click the “Skip video frames” button to skip frames, or click the “Pause audio playback” button to pause audio playback.

When you choose “Pause audio playback,” audio playback pauses when video and audio are out of sync, then begins playing when it catches up on the next loop.
Using Markers With Audio
When you add project markers to the Timeline, they appear in all three tabs of the Timing pane: the Timeline, the Keyframe Editor, and the Audio Editor. You can use project markers to designate “hit points” as you play back the project, to quickly jump to a specific point in time, or to highlight points where you want to synchronize visual and audio events.

For information on adding and deleting markers, moving markers, editing marker information, and using markers, see “Adding Markers” on page 312.

Using Soundtrack Pro With Motion
Once an audio file is imported into Motion, Soundtrack Pro can be opened from within Motion and used to modify the audio track. After the audio track has been edited and saved in Soundtrack Pro, the track is automatically updated in Motion.

To edit an audio track in Soundtrack Pro from within Motion:
1 In the Audio tab or Timeline Layer list, select the audio track you want to modify.
2 Choose Edit > Send Audio to Soundtrack Pro.

*Note:* This option is not available for multi-channel audio files.

The Save As sheet appears.

*Note:* If Soundtrack Pro is not installed on your system, Send Audio to Soundtrack Pro is not available in the menu.

3 If needed, type a name for the modified audio track and select a location in which to save the file.

*Note:* Since this process creates a modified copy of the original audio file, the source audio is not changed.

4 Click Save As Soundtrack Pro Audio.

A project that contains the audio track is opened in Soundtrack Pro.

5 In Soundtrack Pro, make your changes to the audio file and save the project (press Command+S).

*Note:* Do not choose File > Save As (from within Soundtrack Pro) and save a file with a new name. If you save a new file, the live link between the audio track and Motion is lost.

When Motion is displayed, the track and its saved name are automatically updated in the Motion Audio tab. The original file, as well as the new Soundtrack Pro file, appear in the Motion Media tab. A Soundtrack Pro file appears in the Media tab with a .stap extension.
Exporting Audio

A Motion project can be exported as an audio-only QuickTime movie (.mov), or as a QuickTime movie with both video and audio.

To export audio:
1. Choose File > Export.
2. In the Export dialog, type a name for the exported file, then browse to the location where you want to save the file.
3. Choose QuickTime Movie from the Kind pop-up menu.
4. Choose an export preset from the Export Preset pop-up menu, or click the Options button to view and select export options.
5. Choose Audio Only from the Include pop-up menu to export audio only, or choose Video and Audio to export a movie with both video and audio.
6. If you want to export only the marked play range instead of the entire project, click the “Use play range” checkbox.
7. Click Export.

Your exported file is saved to the specified location.

After you export audio as a QuickTime movie, you can convert the QuickTime movie file to another format using QuickTime Pro, or another audio application.

For more information about exporting and export options, see “Exporting Motion Projects” on page 899. This chapter includes information on exporting using Compressor, which allows you to export audio to other file formats, such as AIFF.

For a complete listing of all video, still image, and audio export formats, see Appendix B, “Video and File Formats,” on page 941.
Exporting Motion Projects

Exporting your project renders it into a movie or series of still frames, based on your export choices. You can also render out audio tracks to a sound or movie file.

When it’s time to share your project with the rest of the world (either the finished version or a draft), you export your project. When you export your project, all of your project’s media, and all edits you have made, are rendered to an export file or series of files.

In the Export sheet, you can choose the kind of export you want, and whether the export file includes video with audio, video only, or audio only.

To make exporting easier, Motion includes a variety of export presets. There are export presets for both broadcast-quality and highly compressed QuickTime movies, for image sequences, and for still images. You can customize the existing export presets, or create new presets to suit your specific needs.

You can take full control over the export process by setting export options separately, including the format of the exported project, the codec used for compression, the frame rate, and frame size.

If you have set a play range in your project, you can export the entire project, or just export the play range.

You can also export your project using the Compressor application, either from within Motion, or by opening Compressor and adding your project to the Compressor Batch window. When you export using Compressor, you can choose Compressor presets to apply to your project. You can continue working on your project in Motion, or work on another project, while your project is being exported in Compressor.
Exporting Your Project

When you export your project, you can choose the kind of export and which media to include in the exported file. You can choose an export preset, or set video, audio, and output export options individually. You can export the entire project or, if you have marked a play range, export only the play range.

To export your project:


   The Export sheet drops down from the title bar and the project name appears in the Save As field.

   2. Type a new name in the Save As field or use the existing project name.

   3. Browse to the location where you want to save the file using the pop-up menu and buttons at the top of the sheet. To show a file browser, click the arrow button to the right of the Save As field.

   4. Choose the kind of export from the Kind pop-up menu. You can export a QuickTime movie, an image sequence, or the current frame as a still image. For information about the different kinds of export files, see “Choosing the Export Type” on page 901.

   5. Choose a preset from the Export Preset pop-up menu. For information about export presets, see “Using Export Presets” on page 901.

   6. If necessary, click the Options button to set export options individually. For information about setting export options, see “Setting Export Options” on page 905.

   7. Choose the media to include in the export file from the Include pop-up menu. You can export video and audio, video only, or audio only.

   8. Turn on the “Use play range” checkbox if you want to export only the marked play range, rather than the entire project. For information about marking a play range, see “Defining the Play Range” on page 308.

   9. Click Export.

   The Export Progress window appears, and shows the time elapsed and time remaining. Depending on the size and complexity of your project, exporting may take some time. When the export is finished, the window closes.
Choosing the Export Type
You can export your project as a QuickTime movie or as a numbered sequence of images, and can also export the current frame as a still image.

QuickTime Movie
When you export your project as a QuickTime movie, the project is rendered as a movie file (.mov). Exported QuickTime movies can include both video and audio, video only, or audio only.

Image Sequence
When you export your project as an image sequence, each frame is rendered as an image file. The filename of each image file includes a sequence number that is incremented for each successive file. Exported image sequences can include video only. You can define the number of digits in the sequence number by adding a pound character (#) for each digit to the end of the filename, and enclosing the pound characters in square brackets [ ]. For example, to make the sequence number four digits long, you add [####] to the end of the filename.

Note: When you export an image sequence, Motion creates a still image for each frame of the project, which can result in a large number of files. You may want to create an empty folder to contain the image sequence files.

Current Frame
When you choose Current Frame, your project is exported as a still image (based on the current playhead position). Exported still images include video only.

For a complete listing of video, image, and audio export formats, see Appendix B, “Video and File Formats,” on page 941.

Using Export Presets
You can export your project using an export preset. Export presets let you quickly render your project using predefined groups of export settings. In many cases, using an export preset can simplify your workflow.

You can edit the existing export presets, duplicate an export preset to use as a template for creating a custom preset, or create a new export preset with the settings you choose.
Choosing an Export Preset

Motion includes export presets for many typical work situations. There are presets for QuickTime movie, image sequence, and current frame export. Available presets include:

QuickTime Movie presets
- DV NTSC Movie
- DV PAL Movie
- Lossless+Alpha Movie
- Pixlet Movie

Image Sequence presets
- PICT Sequence
- TGA Sequence

Current Frame presets
- JPEG
- Photoshop
- PICT
- PNG
- TIFF

Note: The Photoshop export preset supports only a single layer image, not multiple layers.

Exporting With Alpha Channels

To export your project with an alpha channel, use a preset that supports alpha channels, such as Lossless+Alpha Movie. Also, to export your project with a transparent background, make sure that Background is set to 0 percent in the Project Properties dialog (press Command+J).

To view export preset settings:
1. Choose Motion > Preferences, then click Presets.
2. In the Presets preferences, choose Export Presets from the Show pop-up menu.
3 Click a preset in the list, and its settings appear in the Summary field at the right, along with a brief description.

![Presets dialog](image)

The settings for the current export preset are also displayed in the Export Options dialog.

**To choose an export preset:**
- In the Export sheet, choose the preset from the Export Preset pop-up menu.

**Editing an Export Preset**
You can edit an existing preset. When you edit an existing preset, you replace the original preset settings with your changes (unless you rename the preset).

**To edit an export preset:**
1 Choose File > Export, then click the Options button in the Export sheet. The Export Options dialog appears, with the Video/Audio pane visible.
2 In the Video/Audio pane, edit the video and audio settings you want to change. Click the Advanced buttons for video and audio to edit advanced export options.
3 Click the Output tab of the Export Options dialog, turn off the “Use current project and canvas settings” checkbox, then edit the output settings you want to change.
4 When you are finished, click Save. To save a copy of the preset with a different name, type a name for the preset in the Name field, then click Save As.

**Note:** You can also edit an export preset from the Presets pane of Motion Preferences by choosing Export Presets from the Show pop-up menu, selecting an export preset, then clicking the Edit button.
Duplicating an Export Preset
You can duplicate an existing preset, and use it as the starting point for creating a new preset.

To duplicate an export preset:
1. Choose File > Export, then click the Options button in the Export sheet.
   The Export options dialog appears, with the Video/Audio pane visible.
2. In the Video/Audio pane, edit the video and audio settings you want to change. Click the Advanced buttons for video and audio to edit advanced export options.
3. Click the Output tab of the Export Options dialog, turn off the “Use current project and canvas settings” checkbox, then edit the output settings you want to change.
4. When you are finished, click Save As, then type a name for the preset.

Note: You can also duplicate an export preset from the Presets pane of Motion Preferences by choosing Export Presets from the Show pop-up menu, selecting an export preset, then clicking the Duplicate button.

Creating an Export Preset
If none of the included presets suits your needs, you can create a new export preset.

To create an export preset:
1. Choose Motion > Preferences, then click Presets.
2. Choose Export Presets from the Show pop-up menu.
3. Click the Add Preset (+) button to add a new preset.
4. Type a name for the preset in the Name field. You can optionally type a description for the preset in the Description field. (This is helpful if there are settings or other information you want to remember about the preset.)
5. Select the video and audio settings for the preset in the Video/Audio pane of the Export Options dialog. Click the Advanced buttons to change QuickTime compression or audio settings.
6. Click the Output tab of the Export Options dialog. If you want to change output settings, turn off the “Use current project and canvas settings” checkbox, then select the output settings for the preset.
7. When you are finished, click OK.

Deleting an Export Preset
If you decide you no longer need an export preset, you can delete it. You can delete only user-created export presets, but not the default export presets that come with Motion.
To delete an export preset:
1. Choose Motion > Preferences, then click Presets.
2. Choose Export Presets from the Show pop-up menu.
3. Select the export preset you want to delete.
4. Click the Delete Preset (−) button.

Setting Export Options
If no export preset meets your specific needs, you can customize the export settings for your project. You can set export options for video, audio, and output individually. You can also set advanced export options, including QuickTime compression and audio settings.

To change the video export options:
1. Choose File > Export, then click the Options button.
   The Export Options dialog appears, with the Video/Audio pane visible.
2. In the Video section of the Video/Audio pane, choose the video settings you want.

   - Choose the kind of export from the Kind pop-up menu.
   - Choose the codec used to compress the exported project from the Compressor pop-up menu. The available choices change depending on the kind of export you selected.
   - Drag the Quality slider to adjust the level of compression. You can also type a value between 1 and 100 in the field next to the slider. The lowest level of quality is 1, and the highest level of quality is 100. Some codecs may not allow you to adjust the quality level.
• If you are exporting an image sequence, type a number for the starting frame of the sequence in the “Start number” field. Turn on the “Add spaces” checkbox to add an extra space to the filename between the name and number. Some applications require the space to read the image sequence files in the correct order.
• Click the Advanced button to view and select advanced audio video options. The available options change depending on the kind of export you selected.

To change the audio export options:
1 Choose File > Export, then click the Options button.
2 In the Audio section of the Video/Audio pane, choose the audio settings you want.
   • Choose the export sample rate from the “Sample rate” pop-up menu.
   • Click the Advanced button to set the compressor, rate, bit depth, and mono/stereo settings in the Sound Settings dialog.

To change the output export options:
1 Choose File > Export, then click the Options button.
2 Click the Output tab.
3 In the Output pane, choose the output settings you want.

• Turn on the “Use current project and canvas settings” checkbox to use the current project settings as displayed in the Project Properties and the pop-up menus, or turn it off to specify different settings.

Note: Export presets are exported with “Use current project and canvas settings” turned on by default.
When this checkbox is turned on, the Color option is set to Color + Alpha, and the “Premultiply alpha” option is turned on. All other fields are disabled. When this checkbox is turned off, the export uses the settings below, which override your project settings.

- Choose one of the project preset sizes from the Resolution pop-up menu, or choose Custom and type a custom frame size in the two Resolution value fields.
- Choose whether the export file includes only color data, only alpha channel (transparency) data, or both from the Color pop-up menu.

*Note:* Some codecs do not support alpha channels.

- Turn on the “Premultiply alpha” checkbox to mix semi-transparent pixels in the exported file with the project’s background color, as set in Project Properties.
- Turn on the “Use field rendering” checkbox to render individual fields, instead of rendering whole frames.
- Turn on the “Use motion blur” checkbox to have motion blur applied to moving objects, regardless of the setting in the Canvas View menu.

**Setting Advanced Export Options**

You can select advanced export options for video and audio. The Advanced buttons in the video and audio sections of the Export Options dialog display the standard QuickTime export options.

Advanced video export options are available only when you are exporting your project as a QuickTime movie. The options available depend on the export format of your project.

**To change the advanced video export options:**

1. Choose File > Export, then click the Options button.
2. In the Video section of the Video/Audio pane, click the Advanced button.
3 In the Compression Settings dialog, choose the settings you want.

![Compression Settings dialog]

- Choose a codec from the Compression pop-up menu.
- Drag the Quality slider to adjust the level of spatial compression. Some codecs may not allow you to adjust the quality level.
- Choose the frame rate for your exported video in the “Frames per second” pop-up menu, or type a number in the field.
- If the codec you choose uses temporal compression, you can set the frequency of keyframes by turning on the “Key frame every X frames” checkbox and typing a number in the field.
- If the codec lets you set the data rate for your exported video, you can do so by turning on the “Limit data rate to X KBytes/sec” checkbox and typing a number in the field.

**To change the advanced audio export options:**
1 Choose File > Export, then click the Options button.
2 In the Audio section of the Video/Audio pane, click the Advanced button.
In the Sound Settings dialog, choose the settings you want.

- Choose a codec to compress the audio from the Compressor pop-up menu.
- Choose a sample rate for audio export from the Rate field.
- Set the size (bit depth) to 8 bit or 16 bit by clicking one of the Size buttons.
- Set audio export to use mono or stereo format by clicking one of the Use buttons.
- Some codecs have additional export options. If the Options button is not dimmed, click it to view and set additional export options.

Exporting a Play Range
If you have defined a play range for your project, you can export the entire length of the project, or export only the play range.

To export a play range:
- Choose File > Export, then turn on the “Use play range” checkbox.

For information about setting a play range, see “Defining the Play Range” on page 308.

Exporting With Compressor
You can export your project using the Apple Compressor application. When you export using Compressor, you can use the presets included with Compressor for your exported file.

There are two ways you can export a Motion project using Compressor. From within Motion, you can choose Export using Compressor from the File menu. From within Compressor, you can drag the Motion project into the Batch window.

When you export your project using Compressor, Motion saves a temporary copy of the project. You can continue working with the project while it is being exported, or work on another project in Motion.
To export a project using Compressor from within Motion:

   The Compressor Export Options dialog appears.

2. Choose an export preset from the Export Preset pop-up menu.
   To see a summary of the Compressor settings, click the Summary button.

3. Choose which media to include in the export from the Include pop-up menu.

4. In the Output section of the Compressor Export Options dialog, choose whether to use the current project settings by turning on the checkbox, or select the settings you want to use.

5. Click Export.
   Compressor opens, and your project is listed in the Batch window, along with the preset, destination, and output filename.

6. In the Batch window, choose a Compressor preset from the Preset pop-up menu. You can choose multiple presets.

7. Choose a location to save the export file from the Destination pop-up menu. You can choose Source, Desktop, or User’s Movie folder, or choose Other and browse to a different location.
   If you do not specify a destination, and you have not previously saved the project, the export file is saved in the following location:
   Desktop/Motion Batch Export files/Untitled/
   If you have previously saved and named the project, it is saved in the following location: project-name/Motion Batch Export files/project-name

8. If necessary, select the output filename and type a new name for the export file.

9. Click the Submit button.
The Batch Monitor window appears with your project listed in the upper window. A progress bar shows the progress of the export. When the export is complete, your project appears in the lower window.

10 When you are finished, choose Batch Monitor > Quit to exit Batch Monitor.

While your project is being exported, you can continue to work on the project in Motion, or work on another project. Any further changes you make are not part of the file currently being exported.

To export a project from within Compressor:

1 Open Compressor.

The Batch window appears.

2 Drag the project into the Batch window.

3 In the Batch window, choose a Compressor preset from the Preset pop-up menu. You can choose multiple presets.

4 Choose a location to save the export file from the Destination pop-up menu. You can choose Source, Desktop, or User’s Movie folder, or choose Other and browse to a different location.

5 Optionally, select the output filename and type a new name for the export file.

6 Click the Submit button.

The Batch Monitor window appears, with your project listed in the upper window. A progress bar shows the progress of the export. When the export is complete, your project appears in the lower window.

7 When you are finished, choose Batch Monitor > Quit.
Using Compressor Presets
Compressor includes a large number of presets, including video, image, and audio presets. When you export a project using Compressor, you can select a preset in the Compressor Export Options dialog. These presets cannot be edited in Motion, but you can edit them and create new presets in Compressor.

You can use multiple Compressor presets by choosing them from the Preset pop-up menu in the Compressor Batch window.

For more information on working with Compressor presets, see the Compressor User’s Manual. The manual is available from the Compressor Help menu, and is included in the Documentation folder installed with Motion.

Exporting an Audio File
You can export an audio-only QuickTime movie. When you export audio only, the exported movie includes all audio tracks in your project that are turned on and not muted.

To export an audio file:
1. Choose File > Export.
2. In the Export dialog, type a name for the exported file, then browse to the location where you want to save the file.
3. Choose “QuickTime movie” from the Kind pop-up menu.
4. Choose an export preset from the Export Preset pop-up menu, or click the Options button to view and select export options.
5. Choose Audio Only from the Include pop-up menu to export audio only, or choose Video and Audio to export a movie with both video and audio.
6. If you want to export only the marked play range instead of the entire project, turn on the “Use marked play range” checkbox.
7. Click Export.

Your exported file is saved to the specified location.

After you export audio as a QuickTime movie, you can convert the QuickTime movie file to another format using QuickTime Pro, Compressor, or another audio application.

There are no audio-only export presets. However, you can use any QuickTime movie export preset and edit the audio export options. For more information on working with audio files, see “Working With Audio” on page 877.
Keyboard Shortcuts

Use keyboard shortcuts to streamline your work in Motion. The following tables organize the keyboard shortcuts by menu, component, and task.

Some keyboard shortcuts are always active, whether or not you are working in the group that they are listed in, while other keyboard shortcuts are only active under special circumstances.

Note: Depending on the version, some shortcut keys may be used by your current operating system.

### General Interface Commands

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + O</td>
<td>Open a project.</td>
</tr>
<tr>
<td>⌘ + N</td>
<td>Create a new project.</td>
</tr>
<tr>
<td>option + ⌘ + N</td>
<td>Create a new project from a list of project presets.</td>
</tr>
<tr>
<td>shift + ⌘ + O</td>
<td>Open a template.</td>
</tr>
<tr>
<td>⌘ + J</td>
<td>Open the Project Properties dialog.</td>
</tr>
<tr>
<td>⌘ + S</td>
<td>Save a project.</td>
</tr>
<tr>
<td>shift + ⌘ + S</td>
<td>Save a project as a new project.</td>
</tr>
<tr>
<td>option + ⌘ + S</td>
<td>Save all open projects.</td>
</tr>
<tr>
<td>⌘ + W</td>
<td>Close a project.</td>
</tr>
<tr>
<td>Key command</td>
<td>Function</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td><code>command</code> + <code>option</code> + <code>W</code></td>
<td>Close all open projects.</td>
</tr>
<tr>
<td><code>option</code> + <code>I</code></td>
<td>Import a file.</td>
</tr>
<tr>
<td><code>option</code> + <code>E</code></td>
<td>Export a project.</td>
</tr>
<tr>
<td><code>shift</code> + <code>option</code> + <code>E</code></td>
<td>Export a project using Compressor.</td>
</tr>
<tr>
<td><code>option</code> + <code>P</code></td>
<td>Print the current view of the Canvas.</td>
</tr>
<tr>
<td><code>shift</code> + <code>option</code> + <code>I</code></td>
<td>Import files as a project.</td>
</tr>
<tr>
<td><code>option</code> + <code>Z</code></td>
<td>Undo the last change.</td>
</tr>
<tr>
<td><code>shift</code> + <code>option</code> + <code>Z</code></td>
<td>Redo the last change.</td>
</tr>
<tr>
<td><code>option</code> + <code>X</code></td>
<td>Cut</td>
</tr>
<tr>
<td><code>option</code> + <code>C</code></td>
<td>Copy</td>
</tr>
<tr>
<td><code>option</code> + <code>V</code></td>
<td>Paste</td>
</tr>
<tr>
<td><code>option</code> + <code>D</code></td>
<td>Duplicate</td>
</tr>
<tr>
<td><code>option</code> + <code>A</code></td>
<td>Select all items.</td>
</tr>
<tr>
<td><code>shift</code> + <code>option</code> + <code>A</code></td>
<td>Deselect all items.</td>
</tr>
<tr>
<td><code>delete</code></td>
<td>Delete</td>
</tr>
<tr>
<td><code>option</code> + <code>W</code></td>
<td>Close the active window.</td>
</tr>
<tr>
<td><code>option</code> + <code>M</code></td>
<td>Minimize the active window.</td>
</tr>
<tr>
<td><code>command</code> + <code>.</code></td>
<td>Cycle through project windows. Press repeatedly until the window you want is displayed.</td>
</tr>
<tr>
<td><code>command</code> + <code>,</code></td>
<td>Open Motion Preferences.</td>
</tr>
<tr>
<td><code>command</code> + <code>?</code></td>
<td>Open Motion Help.</td>
</tr>
</tbody>
</table>
### Motion Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + X + P</td>
<td>Display Page Setup sheet.</td>
</tr>
<tr>
<td>X + H</td>
<td>Hide Motion.</td>
</tr>
<tr>
<td>option + X + H</td>
<td>Hide other open application files.</td>
</tr>
<tr>
<td>X + D</td>
<td>Quit Motion.</td>
</tr>
<tr>
<td>space + A</td>
<td>Play/Pause a project.</td>
</tr>
<tr>
<td>A</td>
<td>Record animation.</td>
</tr>
<tr>
<td>home + end</td>
<td>Go to the start of a project.</td>
</tr>
<tr>
<td>end</td>
<td>Go to the end of a project.</td>
</tr>
</tbody>
</table>

### File Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>X + N</td>
<td>Create a new project.</td>
</tr>
<tr>
<td>X + O</td>
<td>Open a project.</td>
</tr>
<tr>
<td>shift + X + D</td>
<td>Open a template.</td>
</tr>
</tbody>
</table>
# Keyboard Shortcuts

## Edit Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + Z</td>
<td>Undo the last change.</td>
</tr>
<tr>
<td>shift + ⌘ + Z</td>
<td>Redo the last change.</td>
</tr>
<tr>
<td>⌘ + X</td>
<td>Cut</td>
</tr>
<tr>
<td>⌘ + C</td>
<td>Copy</td>
</tr>
<tr>
<td>⌘ + V</td>
<td>Paste</td>
</tr>
</tbody>
</table>

## Close Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + W</td>
<td>Close a project.</td>
</tr>
<tr>
<td>⌘ + S</td>
<td>Save a project.</td>
</tr>
<tr>
<td>shift + ⌘ + S</td>
<td>Save a project as a new project.</td>
</tr>
<tr>
<td>⌘ + I</td>
<td>Import a file.</td>
</tr>
<tr>
<td>shift + ⌘ + I</td>
<td>Import files as a project.</td>
</tr>
<tr>
<td>⌘ + E</td>
<td>Export a project.</td>
</tr>
<tr>
<td>shift + ⌘ + E</td>
<td>Export a project using Compressor.</td>
</tr>
<tr>
<td>shift + ⌘ + P</td>
<td>Display Page Setup sheet.</td>
</tr>
<tr>
<td>⌘ + P</td>
<td>Print the current view of the Canvas.</td>
</tr>
<tr>
<td>option + ⌘ + N</td>
<td>Create a new project from a list of project presets.</td>
</tr>
<tr>
<td>option + ⌘ + W</td>
<td>Close all open projects.</td>
</tr>
<tr>
<td>option + ⌘ + S</td>
<td>Save all open projects.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong> + <strong>X</strong> + <strong>V</strong></td>
<td>Paste special</td>
</tr>
<tr>
<td><strong>Option</strong> + <strong>D</strong></td>
<td>Duplicate</td>
</tr>
<tr>
<td>delete</td>
<td>Delete</td>
</tr>
<tr>
<td><strong>Shift</strong> + delete</td>
<td>Perform a ripple delete which removes the selected object and closes the gap left behind.</td>
</tr>
<tr>
<td><strong>Option</strong> + <strong>A</strong></td>
<td>Select all items.</td>
</tr>
<tr>
<td><strong>Shift</strong> + <strong>Option</strong> + <strong>A</strong></td>
<td>Deselect all items.</td>
</tr>
<tr>
<td><strong>Option</strong> + <strong>J</strong></td>
<td>Open the Project Properties dialog.</td>
</tr>
</tbody>
</table>

### Mark Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Mark In point.</td>
</tr>
<tr>
<td>O</td>
<td>Mark Out point.</td>
</tr>
<tr>
<td><strong>Shift</strong> + /</td>
<td>Move the selected object to the In point.</td>
</tr>
<tr>
<td><strong>Shift</strong> + J</td>
<td>Move the selected object to the Out point.</td>
</tr>
<tr>
<td>* or M</td>
<td>Add a project marker at the current frame.</td>
</tr>
<tr>
<td><strong>Shift</strong> + M</td>
<td>Add a global marker at the current frame.</td>
</tr>
<tr>
<td><strong>Option</strong> + <strong>X</strong> + M</td>
<td>Open the Edit Marker dialog.</td>
</tr>
<tr>
<td><strong>Option</strong> + <strong>X</strong> + I</td>
<td>Mark In point of play range.</td>
</tr>
<tr>
<td><strong>Option</strong> + <strong>X</strong> + O</td>
<td>Mark Out point of play range.</td>
</tr>
<tr>
<td><strong>Option</strong> + <strong>X</strong></td>
<td>Reset the play range by moving the In and Out points to the first and last frame of the project.</td>
</tr>
<tr>
<td>Key command</td>
<td>Function</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>space</td>
<td>Play/Pause a project.</td>
</tr>
<tr>
<td><code>+</code></td>
<td>Enable/Disable loop playback.</td>
</tr>
<tr>
<td><code>A</code></td>
<td>Record animation.</td>
</tr>
<tr>
<td><code>option</code> + <code>A</code></td>
<td>Open the Recording Options dialog.</td>
</tr>
<tr>
<td><code>home</code></td>
<td>Go to the start of project.</td>
</tr>
<tr>
<td><code>end</code></td>
<td>Go to the end of project.</td>
</tr>
<tr>
<td><code>shift</code> + <code>home</code></td>
<td>Go to the start of play range.</td>
</tr>
<tr>
<td><code>shift</code> + <code>end</code></td>
<td>Go to the end of play range.</td>
</tr>
<tr>
<td><code>←</code></td>
<td>Go to the previous frame.</td>
</tr>
<tr>
<td><code>→</code></td>
<td>Go to the next frame.</td>
</tr>
<tr>
<td><code>shift</code> + <code>←</code></td>
<td>Go backward ten frames.</td>
</tr>
<tr>
<td><code>shift</code> + <code>→</code></td>
<td>Go forward ten frames.</td>
</tr>
<tr>
<td><code>option</code> + <code>k</code></td>
<td>Go to previous keyframe.</td>
</tr>
<tr>
<td><code>shift</code> + <code>k</code></td>
<td>Go to next keyframe.</td>
</tr>
<tr>
<td><code>option</code> + <code> mower + ←</code></td>
<td>Go to the previous marker.</td>
</tr>
<tr>
<td><code>option</code> + <code> mower + →</code></td>
<td>Go to the next marker.</td>
</tr>
<tr>
<td><code>shift</code> + <code>I</code></td>
<td>Go to the In point of the selected object.</td>
</tr>
<tr>
<td><code>shift</code> + <code>O</code></td>
<td>Go to the Out point of the selected object.</td>
</tr>
<tr>
<td><code> mower</code> + <code>R</code></td>
<td>Render a RAM Preview for the play range.</td>
</tr>
</tbody>
</table>
### Object Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + option + R</td>
<td>Add a new empty layer to the project.</td>
</tr>
<tr>
<td>option + R</td>
<td>Move the selected object to the top of the Layers list.</td>
</tr>
<tr>
<td>option + K</td>
<td>Move the selected object to the bottom of the Layers list.</td>
</tr>
<tr>
<td>option + /</td>
<td>Move the selected object up the Layers list by one level.</td>
</tr>
<tr>
<td>option +</td>
<td>Move the selected object down the Layers list by one level.</td>
</tr>
<tr>
<td>shift + option + G</td>
<td>Group the selected objects into a new layer.</td>
</tr>
<tr>
<td>option + G</td>
<td>Ungroup a group of objects so you can manipulate the objects individually.</td>
</tr>
<tr>
<td>control + T</td>
<td>Make an object active or deactivate an object.</td>
</tr>
<tr>
<td>control + S</td>
<td>For an audio track, enable/disable the Solo button of the selected track. For an object, solo the object.</td>
</tr>
<tr>
<td>control + L</td>
<td>Lock/Unlock an object.</td>
</tr>
<tr>
<td>shift + control + S</td>
<td>Unsolos only the video portion of a file that contains audio and video.</td>
</tr>
<tr>
<td>shift + control + M</td>
<td>Add an image mask to the selected object.</td>
</tr>
<tr>
<td>control + K</td>
<td>Add keyframe (to the last modified parameter for the selected object).</td>
</tr>
<tr>
<td>option + K</td>
<td>Convert the applied behaviors to keyframes.</td>
</tr>
<tr>
<td>E</td>
<td>Make the selected object the cell source for a particle emitter.</td>
</tr>
</tbody>
</table>
Key command | Function
--- | ---
L | Replicate the selected object.

shift + F | Open the Media tab and Inspector to display the source and properties of media objects.

---

View Menu

Key command | Function
--- | ---
+ | Zoom in.
- | Zoom out.
option + Z | Zoom to 100 percent.
shift + Z | Zoom to fit in window.
F8 | Show/Hide the Canvas in Full Screen mode.
+ F12 | Send output to external monitor.
shift + C | Show all color channels.
shift + T | Show the transparent channel.
shift + option + T | Show the alpha channel overlay.
shift + option + C | Show the RGB channels only.
shift + R | Show the red channel.
shift + G | Show the green channel.
shift + B | Show the blue channel.
shift + A | Show the alpha channel.
shift + option + A | Show the inverted alpha channel.
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>V</td>
<td>Toggle between the current channel and alpha channels.</td>
</tr>
<tr>
<td>shift + D</td>
<td>Show the Canvas at full resolution.</td>
</tr>
<tr>
<td>option + F</td>
<td>Enable/Disable field rendering in the Canvas.</td>
</tr>
<tr>
<td>option + M</td>
<td>Enable/Disable motion blur in the Canvas.</td>
</tr>
<tr>
<td>shift + R</td>
<td>Show the rulers.</td>
</tr>
<tr>
<td>* + /</td>
<td>Show Overlays.</td>
</tr>
<tr>
<td>option + ;</td>
<td>Lock the guides.</td>
</tr>
<tr>
<td>* + '</td>
<td>Show/Hide the grid.</td>
</tr>
<tr>
<td>* + ;</td>
<td>Show/Hide the guides.</td>
</tr>
<tr>
<td>shift + * + ;</td>
<td>Show/Hide the Dynamic Guides.</td>
</tr>
<tr>
<td>*</td>
<td>Show/Hide the Safe Zones.</td>
</tr>
<tr>
<td>shift + *</td>
<td>Show/Hide the Film Zones.</td>
</tr>
<tr>
<td>* + /</td>
<td>Show the overlays.</td>
</tr>
<tr>
<td>N</td>
<td>Enable/Disable snapping to guides.</td>
</tr>
<tr>
<td>* + T</td>
<td>Show the Font dialog.</td>
</tr>
<tr>
<td>shift + * + C</td>
<td>Show the Colors window.</td>
</tr>
<tr>
<td>option + * + T</td>
<td>Show/Hide the Toolbar.</td>
</tr>
</tbody>
</table>
# Window Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ M + M</td>
<td>Minimize the active window.</td>
</tr>
<tr>
<td>⌘ + U</td>
<td>Show the project in Standard layout.</td>
</tr>
<tr>
<td>⌘ + U</td>
<td>Show the project in Alternate layout.</td>
</tr>
<tr>
<td>⌘ shift + ⌘ U</td>
<td>Show the project in Cinema layout.</td>
</tr>
<tr>
<td>⌘ option + ⌘ U</td>
<td>Show/Hide the Properties tab in Inspector.</td>
</tr>
<tr>
<td>⌘ F1</td>
<td>Show/Hide the Behaviors tab in Inspector.</td>
</tr>
<tr>
<td>⌘ F2</td>
<td>Show/Hide the Filters tab in Inspector.</td>
</tr>
<tr>
<td>⌘ F3</td>
<td>Show/Hide the Object tab in Inspector.</td>
</tr>
<tr>
<td>⌘ F4</td>
<td>Show/Hide the Project pane.</td>
</tr>
<tr>
<td>⌘ F5</td>
<td>Show/Hide the Timing pane.</td>
</tr>
<tr>
<td>⌘ F6</td>
<td>Show/Hide the Dashboard.</td>
</tr>
<tr>
<td>⌘ 1 + 1</td>
<td>Show/Hide the File Browser.</td>
</tr>
<tr>
<td>⌘ 2 + 2</td>
<td>Show/Hide the Library.</td>
</tr>
<tr>
<td>⌘ 3 + 3</td>
<td>Show/Hide the Inspector.</td>
</tr>
<tr>
<td>⌘ 4 + 4</td>
<td>Show/Hide the Layers tab.</td>
</tr>
<tr>
<td>⌘ 5 + 5</td>
<td>Show/Hide the Media tab.</td>
</tr>
<tr>
<td>⌘ 6 + 6</td>
<td>Show/Hide the Audio tab.</td>
</tr>
<tr>
<td>⌘ F6 or ⌘ 7</td>
<td>Show/Hide the Timeline.</td>
</tr>
</tbody>
</table>
### Appendix A  Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ J + ⌘</td>
<td>Show/Hide the Keyframe Editor.</td>
</tr>
<tr>
<td>⌘ J + ⌃</td>
<td>Show/Hide the Audio Editor.</td>
</tr>
</tbody>
</table>

#### Help Menu

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ J + ?</td>
<td>Open Motion Help.</td>
</tr>
<tr>
<td>⌘ J + 0</td>
<td>Show the Welcome Screen.</td>
</tr>
</tbody>
</table>

#### Audio Editor

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ J + ⌘</td>
<td>Show/Hide the Audio Editor.</td>
</tr>
<tr>
<td>space</td>
<td>Play/Pause a project.</td>
</tr>
<tr>
<td>A</td>
<td>Record animation.</td>
</tr>
<tr>
<td>* or M</td>
<td>Add a marker at the current frame.</td>
</tr>
</tbody>
</table>

#### Audio Tab

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ J + ⌘</td>
<td>Show/Hide the Audio tab.</td>
</tr>
<tr>
<td>control + T</td>
<td>Make the object active or deactivate the object.</td>
</tr>
<tr>
<td>control + L</td>
<td>Lock/Unlock an audio file.</td>
</tr>
<tr>
<td>control + S</td>
<td>Enable/disable the Solo button of a selected track.</td>
</tr>
<tr>
<td>↑</td>
<td>Move up one level in the Audio list.</td>
</tr>
</tbody>
</table>
Appendix A  Keyboard Shortcuts

### Canvas

**View Group (includes Transform modes)**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>↓</td>
<td>Move down one level in the Audio list.</td>
</tr>
<tr>
<td>⌘ + /</td>
<td>Import.</td>
</tr>
</tbody>
</table>

### Global Transform Commands

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Choose the selected transform mode.</td>
</tr>
<tr>
<td>shift + S</td>
<td>Choose the Select/Transform tool.</td>
</tr>
<tr>
<td>tab</td>
<td>Cycle through the transform modes. Press repeatedly until the transform mode you want is selected.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Constrain the movement of an object to the guidelines.</td>
</tr>
<tr>
<td>⌘ + drag</td>
<td>Override snapping while moving an object.</td>
</tr>
<tr>
<td>option + drag</td>
<td>Duplicate a selected object.</td>
</tr>
</tbody>
</table>

### Select/Transform Tool

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + drag handle</td>
<td>Scale an object proportionally.</td>
</tr>
<tr>
<td>option + drag handle</td>
<td>Scale an object from its center.</td>
</tr>
<tr>
<td>shift + option + drag handle</td>
<td>Scale an object proportionally from its center.</td>
</tr>
<tr>
<td>shift + drag rotation handle</td>
<td>Snap the rotation of an object to 45° increments.</td>
</tr>
</tbody>
</table>

### Crop Tool

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + drag handle</td>
<td>Crop an object proportionally.</td>
</tr>
<tr>
<td>option + drag handle</td>
<td>Crop an object from its center.</td>
</tr>
</tbody>
</table>
Appendix A  Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + option + drag handle</td>
<td>Crop an object proportionally from its center.</td>
</tr>
<tr>
<td>option + drag</td>
<td>Pan a cropped object within the bounding box.</td>
</tr>
<tr>
<td>option + option + drag</td>
<td>Move the bounding box around a cropped object.</td>
</tr>
</tbody>
</table>

**Control Point Tool**

Double-click or
<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a point to path.</td>
</tr>
<tr>
<td>Convert a point to linear.</td>
</tr>
<tr>
<td>Create tangents on point.</td>
</tr>
<tr>
<td>Adjust a B-Spline point bias.</td>
</tr>
<tr>
<td>Toggle a B-Spline point bias.</td>
</tr>
<tr>
<td>Break a tangent handle.</td>
</tr>
<tr>
<td>Constrain a tangent to 45° and original value.</td>
</tr>
</tbody>
</table>

**Pan & Zoom Tools**

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Pan tool.</td>
</tr>
<tr>
<td>Select the Zoom tool.</td>
</tr>
<tr>
<td>Zoom Out with the Zoom tool selected.</td>
</tr>
</tbody>
</table>

**Create Group**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
</table>

**Rectangle & Circle Tools**

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Rectangle Shape tool.</td>
</tr>
<tr>
<td>Select the Circle Shape tool.</td>
</tr>
<tr>
<td>Key command</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td><code>shift</code> + <code>drag</code></td>
</tr>
<tr>
<td><code>option</code> + <code>drag</code></td>
</tr>
<tr>
<td><code>shift</code> + <code>option</code> + <code>click</code></td>
</tr>
<tr>
<td><code>shift</code> + <code>drag rotation handle</code></td>
</tr>
<tr>
<td><strong>Bezier Tool</strong></td>
</tr>
<tr>
<td><code>B</code></td>
</tr>
<tr>
<td><code>B</code></td>
</tr>
<tr>
<td><code>C</code></td>
</tr>
<tr>
<td>Double-click or <code>option</code> + <code>click</code></td>
</tr>
<tr>
<td><code>option</code> + <code>click</code></td>
</tr>
<tr>
<td><code>x</code> + <code>click</code></td>
</tr>
<tr>
<td><code>x</code> + <code>drag</code></td>
</tr>
<tr>
<td><code>shift</code> + <code>drag</code></td>
</tr>
<tr>
<td><code>esc</code></td>
</tr>
<tr>
<td><code>return</code></td>
</tr>
<tr>
<td><strong>B-Spline Tool</strong></td>
</tr>
<tr>
<td><code>B</code></td>
</tr>
<tr>
<td><code>B</code></td>
</tr>
<tr>
<td><code>C</code></td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click or click</td>
<td>Add a point to path.</td>
</tr>
<tr>
<td>+ click</td>
<td>Adjust a B-Spline point bias.</td>
</tr>
<tr>
<td>+ drag</td>
<td>Toggle a B-Spline point bias.</td>
</tr>
<tr>
<td>+ click</td>
<td>Cancel shape drawing and delete the open shape.</td>
</tr>
<tr>
<td></td>
<td>Exit shape drawing mode.</td>
</tr>
</tbody>
</table>

### Text Tool

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Text tool.</td>
</tr>
<tr>
<td>Move the insertion point by character.</td>
</tr>
<tr>
<td>Move the insertion point by word.</td>
</tr>
<tr>
<td>Move to the beginning of a line of text.</td>
</tr>
<tr>
<td>Move to the end of a line of text.</td>
</tr>
<tr>
<td>Select one or more characters from the insertion point.</td>
</tr>
<tr>
<td>Select one or more words from the insertion point.</td>
</tr>
<tr>
<td>Select a line of text from the insertion point.</td>
</tr>
<tr>
<td>Increase kerning from the insertion point.</td>
</tr>
<tr>
<td>Decrease kerning from the insertion point.</td>
</tr>
<tr>
<td>Select All.</td>
</tr>
</tbody>
</table>
### Appendix A  Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>shift</code> + <code>esc</code> + <code>A</code></td>
<td>Deselect All.</td>
</tr>
<tr>
<td><code>esc</code></td>
<td>Exit Text tool.</td>
</tr>
</tbody>
</table>

## Mask Group

### Rectangle & Circle Mask Tools

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option</code> + <code>R</code></td>
<td>Select the Rectangle Mask tool.</td>
</tr>
<tr>
<td><code>option</code> + <code>C</code></td>
<td>Select the Circle Mask tool.</td>
</tr>
<tr>
<td><code>shift</code> + <code>drag</code></td>
<td>Draw a shape proportionally.</td>
</tr>
<tr>
<td><code>option</code> + <code>drag</code></td>
<td>Draw a shape from its center.</td>
</tr>
<tr>
<td><code>shift</code> + <code>option</code> + <code>drag</code></td>
<td>Draw a shape proportionally from its center.</td>
</tr>
<tr>
<td><code>shift</code> + <code>drag rotation handle</code></td>
<td>Snap the rotation of an object to 45° increments.</td>
</tr>
</tbody>
</table>
## Keyboard Shortcuts

### Bezier Mask Tool

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option</code> + <code>B</code></td>
<td>Select the Bezier Mask tool.</td>
</tr>
<tr>
<td><code>option</code> + <code>B</code></td>
<td>Toggle between the Bezier Mask and B-Spline Mask tools.</td>
</tr>
<tr>
<td><code>C</code></td>
<td>Close mask.</td>
</tr>
</tbody>
</table>

Double-click or `option` + click  
Add a point to path.

`-option` + click  
Convert a point to linear.

`-option` + drag  
Create tangents on point.

`-option` + drag  
Break a tangent handle.

`shift` + drag  
Constrain a tangent to 45° and original value.

`esc`  
Cancel shape drawing and delete the open shape.

`return`  
Exit shape drawing mode.

### B-Spline Mask Tool

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option</code> + <code>B</code></td>
<td>Select the B-Spline Mask tool.</td>
</tr>
<tr>
<td><code>option</code> + <code>B</code></td>
<td>Toggle between the Bezier Mask and B-Spline Mask tools.</td>
</tr>
<tr>
<td><code>C</code></td>
<td>Close mask.</td>
</tr>
</tbody>
</table>

Double-click or `option` + click  
Add a point to path.

`option` + drag  
Adjust a B-Spline point bias.

`option` + click  
Toggle a B-Spline point bias.
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>esc</code></td>
<td>Cancel shape drawing and delete the open shape.</td>
</tr>
<tr>
<td><code>return</code></td>
<td>Exit shape drawing mode.</td>
</tr>
</tbody>
</table>

### Transport Controls

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>space</code></td>
<td>Play/Pause a project.</td>
</tr>
<tr>
<td><code>A</code></td>
<td>Record an animation.</td>
</tr>
<tr>
<td><code>shift</code> + <code>L</code></td>
<td>Enable/disable loop playback.</td>
</tr>
<tr>
<td><code>home</code></td>
<td>Go to the start of a project.</td>
</tr>
<tr>
<td><code>end</code></td>
<td>Go to the end of a project.</td>
</tr>
<tr>
<td><code>shift</code> + <code>home</code></td>
<td>Go to the start of the play range.</td>
</tr>
<tr>
<td><code>shift</code> + <code>end</code></td>
<td>Go to the end of the play range.</td>
</tr>
<tr>
<td><code>left</code></td>
<td>Go to the previous frame.</td>
</tr>
<tr>
<td><code>right</code></td>
<td>Go to the next frame.</td>
</tr>
<tr>
<td><code>shift</code> + <code>left</code></td>
<td>Go backward ten frames.</td>
</tr>
<tr>
<td><code>shift</code> + <code>right</code></td>
<td>Go forward ten frames.</td>
</tr>
</tbody>
</table>

### View Options

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>+</code></td>
<td>Zoom In.</td>
</tr>
<tr>
<td><code>-</code></td>
<td>Zoom Out.</td>
</tr>
<tr>
<td><code>option</code> + <code>click</code></td>
<td>Zoom Out with the Zoom tool selected.</td>
</tr>
<tr>
<td>Key command</td>
<td>Function</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>⌘ x + drag</td>
<td>Zoom to region.</td>
</tr>
<tr>
<td>option + Z</td>
<td>Zoom to 100 percent.</td>
</tr>
<tr>
<td>shift + Z</td>
<td>Zoom to fit in the Canvas.</td>
</tr>
<tr>
<td>shift + C</td>
<td>Show all color channels.</td>
</tr>
<tr>
<td>shift + T</td>
<td>Show the transparent channel.</td>
</tr>
<tr>
<td>shift + option + T</td>
<td>Show the alpha channel overlay.</td>
</tr>
<tr>
<td>shift + option + C</td>
<td>Show the RGB channels only.</td>
</tr>
<tr>
<td>shift + R</td>
<td>Show the red channel.</td>
</tr>
<tr>
<td>shift + G</td>
<td>Show the green channel.</td>
</tr>
<tr>
<td>shift + B</td>
<td>Show the blue channel.</td>
</tr>
<tr>
<td>shift + A</td>
<td>Show the alpha channel.</td>
</tr>
<tr>
<td>shift + option + A</td>
<td>Show the inverted alpha channel.</td>
</tr>
<tr>
<td>shift + Q</td>
<td>Show the Canvas at full resolution.</td>
</tr>
<tr>
<td>option + F</td>
<td>Enable/Disable field rendering in the Canvas.</td>
</tr>
<tr>
<td>option + M</td>
<td>Enable/Disable motion blur in the Canvas.</td>
</tr>
<tr>
<td>shift + ⌘ x + r</td>
<td>Show the rulers.</td>
</tr>
<tr>
<td>option + ⌘ x + ;</td>
<td>Lock the guides.</td>
</tr>
<tr>
<td>⌘ x + ;</td>
<td>Show/Hide the grid.</td>
</tr>
<tr>
<td>⌘ x + ;</td>
<td>Show/Hide the guides.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

#### Key command | Function
--- | ---
\( \text{shift} + \text{alt} + \text{X} + \text{period} \) | Show/Hide the Dynamic Guides.
\( \text{shift} + \text{period} \) | Show/Hide the Film Zones.
\( \text{alt} + \text{slash} \) | Show the overlays.
\( \text{V} \) | Toggle between the current channel and alpha channel.
\( \text{period} \) | Show/Hide the Safe Zones.
\( \text{N} \) | Enable/Disable snapping to guides.

### Miscellaneous

#### Key command | Function
--- | ---
\( \text{E} \) | Create Particle Emitter.
\( \text{shift} + \text{alt} + \text{M} + \text{X} \) or \( \text{shift} + \text{X} \) click | Import an image mask to the selected object.
\( \uparrow \) | Select the next object above.
\( \downarrow \) | Select the next object below.
\( \text{alt} + \text{X} + \text{up}, \text{down}, \text{left}, \text{or} \text{right} \) or \( \text{alt} + \text{shift} + \text{X} + \text{up}, \text{down}, \text{left}, \text{or} \text{right} \) | Nudge the selected object(s) one pixel.
\( \text{shift} + \text{alt} + \text{X} + \uparrow, \downarrow, \leftarrow, \text{or} \rightarrow \) | Nudge the selected object(s) ten pixel.
\( \text{shift} + \text{drag} \) | Add/Remove selected objects using the region box.
\( \text{alt} + \text{X} + \text{click} \) | Select multiple objects in a group or layer.
\( \text{shift} + \text{click} \) | Add to selection.
### Dashboard

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F7</td>
<td>Show/Hide the Dashboard.</td>
</tr>
<tr>
<td>D</td>
<td>Cycle through the Dashboards from top to bottom (when more than one effect is applied to an object).</td>
</tr>
<tr>
<td>shift + D</td>
<td>Cycle through the Dashboards from bottom to top (when more than one effect is applied to an object).</td>
</tr>
</tbody>
</table>

### File Browser

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ ⌥ + I</td>
<td>Show/Hide File Browser.</td>
</tr>
<tr>
<td>⌘ ⌥ + O</td>
<td>Open project.</td>
</tr>
<tr>
<td>shift + ⌘ ⌥ + O</td>
<td>Open template.</td>
</tr>
<tr>
<td>⌘ ⌥ + N</td>
<td>New project.</td>
</tr>
<tr>
<td>F5</td>
<td>Show/Hide Project pane.</td>
</tr>
<tr>
<td>↑</td>
<td>Move up one item in the Sidebar or file stack.</td>
</tr>
<tr>
<td>↓</td>
<td>Move down one item in the Sidebar or file stack.</td>
</tr>
<tr>
<td>←</td>
<td>Move left one item in the file stack.</td>
</tr>
<tr>
<td>→</td>
<td>Move right one item in the file stack.</td>
</tr>
<tr>
<td>space</td>
<td>Select first item in the file stack.</td>
</tr>
<tr>
<td>⌘ ⌥ + ↑</td>
<td>Move up one level in the folder hierarchy of the file stack.</td>
</tr>
</tbody>
</table>
## Inspector

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + 3</td>
<td>Show/Hide the Inspector.</td>
</tr>
<tr>
<td>⌘ + ↑ or ↓</td>
<td>Increase a slider value by an increment of one.</td>
</tr>
<tr>
<td>⌘ + ← or →</td>
<td>Decrease a slider value by an increment of one.</td>
</tr>
<tr>
<td>shift + ⌘ + ↑ or ↓</td>
<td>Increase a slider value by an increment of ten.</td>
</tr>
<tr>
<td>shift + ⌘ + ← or →</td>
<td>Decrease a slider value by an increment of ten.</td>
</tr>
</tbody>
</table>

## Keyframe Editor

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ + 8</td>
<td>Show/Hide Keyframe Editor.</td>
</tr>
<tr>
<td>⌘ + K</td>
<td>Convert the applied behaviors to keyframes.</td>
</tr>
<tr>
<td>F</td>
<td>Fit visible curves.</td>
</tr>
</tbody>
</table>

## Layers

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + ⌘ + [</td>
<td>Create a new layer.</td>
</tr>
<tr>
<td>⌘ + ]</td>
<td>Bring the object to the top of the layer.</td>
</tr>
<tr>
<td>⌘ + [</td>
<td>Send the object to the bottom of the layer.</td>
</tr>
<tr>
<td>⌘ + {</td>
<td>Bring the object up one level in the Layers list.</td>
</tr>
<tr>
<td>⌘ + }</td>
<td>Send the object down one level in the Layers list.</td>
</tr>
<tr>
<td>shift + ⌘ + g</td>
<td>Group the selected objects into a new layer.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option</code> + <code>X</code> + <code>G</code></td>
<td>Ungroup a group of objects so you can manipulate the objects individually.</td>
</tr>
<tr>
<td><code>control</code> + <code>T</code></td>
<td>Make the object active or deactivate the object.</td>
</tr>
<tr>
<td><code>control</code> + <code>S</code></td>
<td>Enable/disable the Solo button of a selected track.</td>
</tr>
<tr>
<td><code>control</code> + <code>L</code></td>
<td>Lock/Unlock an object.</td>
</tr>
<tr>
<td>↑</td>
<td>Move up one level in the Layers list.</td>
</tr>
<tr>
<td>↓</td>
<td>Move down one level in the Layers list.</td>
</tr>
<tr>
<td>←</td>
<td>Open a layer in the Layers list.</td>
</tr>
<tr>
<td>→</td>
<td>Close a layer in the Layers list.</td>
</tr>
<tr>
<td><code>option</code> + <code>I</code></td>
<td>Import</td>
</tr>
<tr>
<td><code>shift</code> + <code>option</code> + <code>M</code></td>
<td>Add an image mask to the selected object.</td>
</tr>
<tr>
<td><code>option</code> + <code>K</code></td>
<td>Convert the applied behaviors to keyframes.</td>
</tr>
<tr>
<td><code>shift</code> + <code>F</code></td>
<td>Open the Media tab and Inspector to reveal the source and properties of media objects.</td>
</tr>
</tbody>
</table>

### Library

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option</code> + <code>L</code></td>
<td>Show/Hide the Library.</td>
</tr>
<tr>
<td>space</td>
<td>Select the first item in the Sidebar or file stack.</td>
</tr>
<tr>
<td>↑</td>
<td>Move up one item in the Sidebar or file stack.</td>
</tr>
<tr>
<td>↓</td>
<td>Move down one item in the Sidebar or file stack.</td>
</tr>
<tr>
<td>←</td>
<td>Move left one item in the file stack.</td>
</tr>
</tbody>
</table>
### Media Tab

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>📣 + 5</td>
<td>Show/Hide Media tab.</td>
</tr>
<tr>
<td>↑</td>
<td>Move up one level in the Media list.</td>
</tr>
<tr>
<td>↓</td>
<td>Move down one level in the Media list.</td>
</tr>
<tr>
<td>📣 + /</td>
<td>Import</td>
</tr>
</tbody>
</table>

### Timeline

**Editing and Navigating**

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>📣 + →</td>
<td>Nudge one frame forward.</td>
</tr>
<tr>
<td>📣 + ←</td>
<td>Nudge one frame backward.</td>
</tr>
<tr>
<td>shift + 📣 + →</td>
<td>Nudge ten frames forward.</td>
</tr>
<tr>
<td>shift + 📣 + ←</td>
<td>Nudge ten frames backward.</td>
</tr>
<tr>
<td>shift + /</td>
<td>Move the selected object to the In point.</td>
</tr>
<tr>
<td>shift + ]</td>
<td>Move the selected object to the Out point.</td>
</tr>
<tr>
<td>option + 📣 + /</td>
<td>Mark the In point of the play range.</td>
</tr>
<tr>
<td>option + 📣 + 0</td>
<td>Mark the Out point of the play range.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option + X</td>
<td>Reset the play range by moving the In and Out points to the first and last frames of the project.</td>
</tr>
<tr>
<td>shift + L</td>
<td>Enable/Disable loop playback.</td>
</tr>
<tr>
<td>option + A</td>
<td>Open the Recording Options dialog.</td>
</tr>
<tr>
<td>shift + home</td>
<td>Go to the start of play range.</td>
</tr>
<tr>
<td>shift + end</td>
<td>Go to the end of play range.</td>
</tr>
<tr>
<td>shift + I</td>
<td>Go to the In point of the selected object.</td>
</tr>
<tr>
<td>shift + O</td>
<td>Go to the Out point of the selected object.</td>
</tr>
<tr>
<td>←</td>
<td>Go to the previous frame.</td>
</tr>
<tr>
<td>→</td>
<td>Go to the next frame.</td>
</tr>
<tr>
<td>shift + ←</td>
<td>Go backward ten frames.</td>
</tr>
<tr>
<td>shift + →</td>
<td>Go forward ten frames.</td>
</tr>
<tr>
<td>option + ⌘ + →</td>
<td>Go to the next marker.</td>
</tr>
<tr>
<td>option + ⌘ + ←</td>
<td>Go to the previous marker.</td>
</tr>
<tr>
<td>⌘ + R</td>
<td>Render a RAM Preview for the play range.</td>
</tr>
<tr>
<td>option + ⌘ + R</td>
<td>Render a RAM Preview for the selected object.</td>
</tr>
<tr>
<td>shift + option + ⌘ + R</td>
<td>Render a RAM Preview for the entire project.</td>
</tr>
<tr>
<td>/</td>
<td>Mark an In point.</td>
</tr>
<tr>
<td>O</td>
<td>Mark an Out point.</td>
</tr>
<tr>
<td>‘ or ‘</td>
<td>Add a marker at the current frame.</td>
</tr>
</tbody>
</table>
### Keyframing Commands

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option</code> + <code>M</code></td>
<td>Open the Edit Marker dialog.</td>
</tr>
<tr>
<td><code>space</code></td>
<td>Play/Pause the project.</td>
</tr>
<tr>
<td><code>A</code></td>
<td>Record animation.</td>
</tr>
<tr>
<td><code>home</code></td>
<td>Go to the start of project.</td>
</tr>
<tr>
<td><code>end</code></td>
<td>Go to the end of project.</td>
</tr>
<tr>
<td><code>control</code> + <code>K</code></td>
<td>Convert the applied behaviors to keyframes.</td>
</tr>
<tr>
<td><code>shift</code> + <code>delete</code></td>
<td>Perform a ripple delete.</td>
</tr>
<tr>
<td><code>option</code> + <code>V</code></td>
<td>Paste special.</td>
</tr>
</tbody>
</table>

### Keyframing Commands

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>option</code> + click</td>
<td>Double-click or Add a point to path.</td>
</tr>
<tr>
<td><code>control</code> + click</td>
<td>Convert a point to linear.</td>
</tr>
<tr>
<td><code>control</code> + drag</td>
<td>Create tangents on point.</td>
</tr>
<tr>
<td><code>control</code> + drag</td>
<td>Adjust a B-Spline point bias.</td>
</tr>
<tr>
<td><code>control</code> + click</td>
<td>Toggle a B-Spline point bias.</td>
</tr>
<tr>
<td><code>control</code> + drag</td>
<td>Break a tangent handle.</td>
</tr>
<tr>
<td><code>shift</code> + drag</td>
<td>Constrain a tangent to 45° and original value.</td>
</tr>
</tbody>
</table>
Shape and Mask Commands

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift + drag</td>
<td>Draw a shape proportionally with the Rectangle, Circle Shape, and Mask tools.</td>
</tr>
<tr>
<td>option + drag</td>
<td>Draw a shape from its center with the Rectangle, Circle Shape, and Mask tools.</td>
</tr>
<tr>
<td>shift + option + drag</td>
<td>Draw a shape proportionally from its center with the Rectangle, Circle Shape, and Mask tools.</td>
</tr>
<tr>
<td>esc</td>
<td>Cancel shape drawing and delete the open shape.</td>
</tr>
<tr>
<td>return</td>
<td>Exit shape drawing mode.</td>
</tr>
<tr>
<td>Double-click or option + click</td>
<td>Add a point to path.</td>
</tr>
<tr>
<td>+ click</td>
<td>Convert a point to linear.</td>
</tr>
<tr>
<td>+ click</td>
<td>Create tangents on point.</td>
</tr>
<tr>
<td>+ drag</td>
<td>Adjust a B-Spline point bias.</td>
</tr>
<tr>
<td>+ click</td>
<td>Toggle a B-Spline point bias.</td>
</tr>
<tr>
<td>+ drag</td>
<td>Break a tangent handle.</td>
</tr>
<tr>
<td>shift + drag</td>
<td>Constrain a tangent to 45° and original value.</td>
</tr>
</tbody>
</table>

Toolbar

<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>option +  + T</td>
<td>Show/Hide the Toolbar.</td>
</tr>
<tr>
<td>S</td>
<td>Choose the selected transform mode.</td>
</tr>
<tr>
<td>shift + B</td>
<td>Choose the Select/Transform tool.</td>
</tr>
<tr>
<td>tab</td>
<td>Cycle through the transform modes. Press repeatedly until the transform mode you want is selected.</td>
</tr>
</tbody>
</table>

Appendix A  Keyboard Shortcuts
<table>
<thead>
<tr>
<th>Key command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Select the Pan tool.</td>
</tr>
<tr>
<td>Z</td>
<td>Select the Zoom tool.</td>
</tr>
<tr>
<td>R</td>
<td>Select the Rectangle Shape tool.</td>
</tr>
<tr>
<td>C</td>
<td>Select the Circle Shape tool.</td>
</tr>
<tr>
<td>B</td>
<td>Toggle between the Bezier and B-Spline tools.</td>
</tr>
<tr>
<td>T</td>
<td>Select the Text tool.</td>
</tr>
<tr>
<td>option + R</td>
<td>Select the Rectangle Mask tool.</td>
</tr>
<tr>
<td>option + C</td>
<td>Select the Circle Mask tool.</td>
</tr>
<tr>
<td>option + B</td>
<td>Toggle between the Bezier Mask and B-Spline Mask tools.</td>
</tr>
<tr>
<td>F7</td>
<td>Show/Hide the Dashboard.</td>
</tr>
<tr>
<td>⌘ + 1</td>
<td>Show/Hide the File Browser.</td>
</tr>
<tr>
<td>⌘ + 2</td>
<td>Show/Hide the Library.</td>
</tr>
<tr>
<td>⌘ + 3</td>
<td>Show/Hide the Inspector.</td>
</tr>
<tr>
<td>F5</td>
<td>Show/Hide the Project pane.</td>
</tr>
<tr>
<td>F6</td>
<td>Show/Hide the Timing pane.</td>
</tr>
<tr>
<td>⌘ + T</td>
<td>Show the Fonts dialog.</td>
</tr>
<tr>
<td>shift + ⌘ + C</td>
<td>Show the Colors window.</td>
</tr>
</tbody>
</table>
Video and File Formats

Motion supports a wide variety of media and video formats for broadcast and multimedia. This appendix covers the technical specifications for the most popular video formats in use today.

Motion allows you to create projects that integrate many media types using a wide variety of formats. This appendix provides an overview of the most popular file formats that are supported.

In addition, whether you’re using one of Motion’s project presets or creating your own, it’s important to be aware of what distinguishes one video format from another. More information is provided to explain the different characteristics of video, with explanations for the different frame sizes, how interlacing works, the difference between square and nonsquare pixels, and which frame rates correspond to which video formats.

Lastly, topics are presented explains how to create artwork that is optimized for broadcast, taking into account the benefits and limitations of broadcast video.

Supported File Formats

Motion supports the use of a wide variety of video, still image, and audio files within a single project. Since it’s a QuickTime standard application, Motion supports many of the same file formats that QuickTime does.

QuickTime video codecs

Motion supports QuickTime video files using nearly any codec installed on your computer, including, but not limited to:

- Animation
- BMP
- Cinepak
- Component Video
- DV - PAL
• DV/DVCPRO - NTSC
• DVCPRO - PAL
• DVCPRO HD 1080i50, 1080i60, and 720p60
• DVCPRO50 - NTSC
• DVCPRO50 - PAL
• Uncompressed 8- and 10-bit 4:2:2
• Graphics
  • H.261
  • HDV 1080i50, 1080i60, and 720p30
• Apple Intermediate Codec
• Motion JPEG A and JPEG B
• MPEG IMX 525/60 (30Mb/s, 40 Mb/s, 50 Mb/s)
• MPEG IMX 625/50 (30Mb/s, 40 Mb/s, 50 Mb/s)
• MPEG-4 Video
• Photo - JPEG
• Apple Pixlet Video
• Planar RGB
• PNG
• TGA
• TIFF
• VC H.264
• Video
• H.263
• H.264
• JPEG 2000
• Sorenson Video 3
• Sorenson Video

**Still image formats**

Motion supports most commonly used still image file types, including:
• SGI
• Photoshop
• BMP
• JPEG
• PICT
• PNG
• MacPaint
• TIFF
• TGA
• JPEG-2
• QuickTime Image Files
• Open EXR
Other image formats
In addition, Motion includes special support for the following image types:
- Layered Photoshop files
- PDF files

Audio formats
You can import audio files with sample rates up to 192 kHz, and with bit depths up to 32 bits. Mono and stereo files are supported. Multi-channel audio files are also supported. Motion supports the following audio file types:
- WAV
- AIFF
- .cdda
- MP3
- AAC (AAC files are listed in the Finder with the .m4p file extension.)
- QuickTime Audio, with support for the following audio codecs:
  - 8-bit
  - 8-bit Unsigned (Little Endian/WAV)
  - 16-bit Integer
  - 24-bit Integer
  - 32-bit Integer
  - 32-bit Float
  - 64-bit Float
  - ALaw 2:1
  - AMR Narrowband
  - Apple Lossless
  - IMA 4:1
  - MACE 3:1
  - MACE 6:1
  - MPEG-4 Audio

Important: You cannot import rights-managed AAC files, such as those purchased from the iTunes Music Store.

For more information about the file formats supported by Motion, go to the Motion website at: http://www.apple.com/motion.
Standard Definition vs. High Definition Video Formats

Motion is extremely flexible and can work with both highly compressed and uncompressed video.

Standard Definition Video

Despite having differing frame sizes, NTSC and PAL standard definition video share certain characteristics.
- Both signals are interlaced, although the field order depends on the video capture interface used.
- Both signals have a 4:3 aspect ratio, but a 16:9 aspect ratio can be accommodated either anamorphically or by using letterboxing.
- Both use nonsquare pixels to display the picture.

Analog standard definition formats include S-VHS, Hi-8, and Beta SP.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Frame size</th>
<th>Frame rates</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>720 x 486</td>
<td>29.97</td>
<td>Interlaced</td>
</tr>
<tr>
<td>PAL</td>
<td>720 x 576</td>
<td>25</td>
<td>Interlaced</td>
</tr>
</tbody>
</table>

Digital standard definition formats include Digital Betacam and the D-1 through D-5 formats. Due to the wide variety of compression ratios and types in the different digital standards, the table below presents more information on these formats.

<table>
<thead>
<tr>
<th>Digital format</th>
<th>Maker</th>
<th>Color sampling</th>
<th>Compression ratio</th>
<th>Compression type</th>
<th>Recorded bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Betacam</td>
<td>Sony</td>
<td>4:2:2</td>
<td>2:3:1</td>
<td>DCT</td>
<td>1.9 MB/sec.</td>
</tr>
<tr>
<td>D-1</td>
<td>Sony</td>
<td>4:2:2</td>
<td>Uncompressed</td>
<td>None</td>
<td>21.5 MB/sec.</td>
</tr>
<tr>
<td>D-2</td>
<td>Ampex</td>
<td>4:2:2</td>
<td>Uncompressed</td>
<td>None</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>D-5</td>
<td>Matsushita</td>
<td>4:2:2</td>
<td>Uncompressed</td>
<td>None</td>
<td>27.5 MB/sec.</td>
</tr>
</tbody>
</table>

Standard Definition DV

The frame size of NTSC DV and NTSC analog video differ. NTSC and PAL standard definition DV video signals are both interlaced, and share a 4:3 aspect ratio using nonsquare pixels.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Frame size</th>
<th>Frame rates</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>720 x 480</td>
<td>29.97</td>
<td>Interlaced</td>
</tr>
<tr>
<td>PAL</td>
<td>720 x 576</td>
<td>25</td>
<td>Interlaced</td>
</tr>
</tbody>
</table>
Standard definition DV formats include DV, DVCAM, DVCPRO25, and DVCPRO50.

<table>
<thead>
<tr>
<th>Digital format</th>
<th>Maker</th>
<th>Color sampling</th>
<th>Compression ratio</th>
<th>Compression type</th>
<th>Recorded bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>DV</td>
<td>Sony</td>
<td>4:1:1</td>
<td>5:1</td>
<td>DV</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td>DVCAM</td>
<td>Sony</td>
<td>4:1:1</td>
<td>5:1</td>
<td>DV</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4:2:0 (PAL)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVCPRO50</td>
<td>Panasonic</td>
<td>4:2:2</td>
<td>3:3:1</td>
<td>DV</td>
<td>7 MB/sec.</td>
</tr>
</tbody>
</table>

**High Definition Video**

All high definition formats use a nonanamorphic, 16:9 aspect ratio using square pixels, just like a computer display. Despite these similarities, there are many high definition video formats.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Frame size</th>
<th>Frame rates</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>720p</td>
<td>1280 x 720</td>
<td>23.98, 24, 25, 29.97, 59.94, 60</td>
<td>Progressive</td>
</tr>
<tr>
<td>1080p</td>
<td>1920 x 1080</td>
<td>23.98, 24, 25, 29.97, 59.94, 60</td>
<td>Progressive</td>
</tr>
<tr>
<td>1080i</td>
<td>1920 x 1080</td>
<td>25, 29.97, 59.94, 60</td>
<td>Interlaced</td>
</tr>
</tbody>
</table>

The different frame sizes, frame rates, and scanning methods serve different markets, both domestically and internationally. For example, the availability of the 720p format is a result of needing a lower resolution format, so that current standard definition programming can be blown up more easily. It is also seen as a format suitable for programming that would not benefit from additional resolution, such as local news. For broadcast, bandwidth is a critical issue, and the larger resolution of 1080 video takes up valuable room on the broadcasting spectrum as well as on the available bandwidth of cable and satellite services.

As you can see in the previous table, each high definition standard supports numerous frame rates. These can be divided into two categories:
- Frame rates for film production and post-production
- Frame rates for broadcast video applications
Frame rates intended for broadcast video use can be interlaced, similar to standard
definition video on a television, or progressive like a computer display.

<table>
<thead>
<tr>
<th>Frame rate</th>
<th>Video format</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.98</td>
<td>A progressive frame rate intended for HD video transfer to film. 23.98 is rounded up from the actual frame rate of 23.976. This frame rate is useful in post-production since it can be converted easily by hardware to the interlaced 59.94 frame rate for video viewing purposes.</td>
</tr>
<tr>
<td>24</td>
<td>A progressive frame rate intended for HD video transfer to film</td>
</tr>
<tr>
<td>25</td>
<td>Matches the frame rate of PAL video, used for broadcast.</td>
</tr>
<tr>
<td>29.97</td>
<td>Matches the frame rate of NTSC video, used for broadcast. Some manufacturers that refer to a frame rate of 30 fps are actually referring to 29.97 fps.</td>
</tr>
<tr>
<td>50</td>
<td>Doubles the frame rate of PAL, a high-quality frame rate used for broadcast.</td>
</tr>
<tr>
<td>59.94</td>
<td>Doubles the frame rate of 29.97 video. It’s easier for broadcast equipment to downconvert from 59.94 to 29.97 for purposes of standard definition broadcasting.</td>
</tr>
<tr>
<td>60</td>
<td>Doubles the 30 fps (actually 29.97) frame rate corresponding to NTSC video; a higher quality frame rate used for high definition broadcast.</td>
</tr>
</tbody>
</table>

There are two options available for shooting high definition video:
- Sony’s HDCAM format supports 29.97i and 60i. Sony also has a 24p format.
- Panasonic’s high definition format, DVCPRO100. Don’t confuse this format with DVCPRO25 and DVCPRO50, which are both standard definition formats. Panasonic also has a 24p format that offers variable speed using a variable frame rate technology.

Both of these acquisition formats have color sampling of 8 bits per channel. High
definition tape decks also exist with color sampling of 16 bits per channel, for film
scanning, mastering, and archival purposes.

<table>
<thead>
<tr>
<th>Digital format</th>
<th>Maker</th>
<th>Color sampling</th>
<th>Compression ratio</th>
<th>Compression type</th>
<th>Recorded bit rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDCAM</td>
<td>Sony</td>
<td>3:1:1</td>
<td>7:1:1</td>
<td>DCT</td>
<td>17.5 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO100</td>
<td>Panasonic</td>
<td>4:2:2</td>
<td>1:7:1</td>
<td>DCT</td>
<td>12.5 MB/sec.</td>
</tr>
</tbody>
</table>
Supported DVCPRO HD Formats
Motion natively supports the following DVCPRO HD formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Motion Easy Setup</th>
<th>Dimensions</th>
<th>Scanning method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i60</td>
<td>DVCPRO HD - 1080i60</td>
<td>1920 x 1080</td>
<td>Interlaced</td>
</tr>
<tr>
<td>720p60</td>
<td>DVCPRO HD - 720p60</td>
<td>1280 x 720</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p30</td>
<td>DVCPRO HD - 720p30</td>
<td>1280 x 720</td>
<td>Progressive</td>
</tr>
<tr>
<td>720p24</td>
<td>DVCPRO HD - 720p24</td>
<td>1280 x 720</td>
<td>Progressive</td>
</tr>
</tbody>
</table>

A Comparison of Data Rates of Common High Definition and Standard Definition Formats
The table below shows the relative data rates of some commonly used high definition formats. These data rates can be used as a reference for deciding how much hard drive space you may need for the media you want to use in your project.

<table>
<thead>
<tr>
<th>Format</th>
<th>Bits per second (video only)</th>
<th>Bytes per second</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVCPRO HD, 1080i60</td>
<td>100 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD, 1080i50</td>
<td>100 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD, 720p60</td>
<td>100 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD, 720p30</td>
<td>50 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO HD, 720p24</td>
<td>40 Mbps</td>
<td>11.75 MB/sec.</td>
</tr>
<tr>
<td>DV</td>
<td>25 Mbps</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td>DVCAM</td>
<td>25 Mbps</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO(25)</td>
<td>25 Mbps</td>
<td>3.6 MB/sec.</td>
</tr>
<tr>
<td>DVCPRO 50</td>
<td>50 Mbps</td>
<td>6.25 MB/sec.</td>
</tr>
</tbody>
</table>

Note: Motion also supports additional uncompressed high definition formats using third-party PCI cards. The table above shows only DVCPRO HD formats currently supported by Motion.
Choosing a Frame Rate
Most DVCPRO HD cameras and decks allow two types of video frame rates:
• Integer frame rates such as 60, 30, and 24 fps
• NTSC-related frame rate variants such as 59.94, 29.97, and 23.98 fps

Note: If you are outputting via Final Cut Pro, Motion only supports NTSC-related timebases such as 59.94, 29.97, and 23.98 fps when transferring video between a computer and a DVCPRO HD device via FireWire. Using tapes recorded with whole-number frame rates such as 60 fps or 30 fps is not supported in Motion.

Popular Video Codecs for File Exchange
You can use video compressed with nearly any video codecs in Motion—DV or DVCPRO, DVCPRO 50, DVCPRO HD, Uncompressed 8-bit 4:2:2, Animation, Apple M-JPEG, and other third-party codecs. Bear in mind that when you are working on a project in Motion, it is best to use high-quality codecs with a minimum of compression. Highly compressed video files, such as those compressed using the MPEG-4 or Sorenson codec, are probably going to be unsuitable for creating high-quality work.

Note: Motion works in the RGB color space. Any clips you use in Motion that were captured or recompressed using a YCrCb codec, such as DV or Uncompressed 8-bit 4:2:2, are converted to the RGB color space when used in a Motion project. Clips that are exported from Motion using a YCrCb codec are converted back into the YCrCb color space.

Uncompressed 8-bit and 10-bit 4:2:2 video
Video stored using these codecs undergoes no data compression, but some color resampling may occur depending on the source video format. Since compression usually results in video artifacts, using no compression guarantees the highest level of quality. Unfortunately, it also guarantees enormous file sizes.

Uncompressed movies can have an alpha channel. Alpha channels define levels of transparency in your movie and are useful if you’re delivering an effects shot for use in someone else’s composition.

Animation
The Animation codec was developed for computer-generated imagery, which often has large areas of uniform color and little, if any, noise. It is a lossless codec, which means it doesn’t degrade quality or add artifacts to your video when it applies compression.
Video footage, which generally has more grain, noise, and variations of texture and color than animated material, may not be compressed as much with the Animation codec as with other methods. Because some lossless compression is better than none, this codec is used more frequently than Uncompressed.

**DVCPRO 100**
A high definition video format that can be used to capture video digitally from FireWire-enabled DVCPRO100 compatible decks. Don’t confuse this format with DVCPRO 25 or DVCPRO 50, which are both standard definition formats. This format supports a number of frame sizes and frame rates, including a 24p format that offers variable speed via a variable frame rate technology. DVCPRO50 uses 4:2:2 color sampling for high color fidelity, and has a fixed data rate of 12.5 MB/sec.

**DVCPRO50**
The DVCPRO50 codec is used to capture video digitally from FireWire-enabled DVCPRO50-compatible camcorders and decks. Although it’s similar to the DV codec in that DVCPRO50 is imported as YUV encoded video, it produces considerably higher quality video since it uses less compression. (DVCPRO50 uses a 3.3:1 compression ratio, versus DV’s 5:1 compression ratio.) DVCPRO50 also uses 4:2:2 color sampling for high color fidelity, as opposed to DV’s 4:1:1 color sample rate. DVCPRO50 has a fixed data rate of 7 MB/sec.

**Apple M-JPEG**
There are two Apple M-JPEG codecs, M-JPEG A and M-JPEG B. These are variable data rate codecs similar to the ones used by video capture cards. If you need to deliver more heavily compressed material to keep files small, consider these codecs. M-JPEG is a lossy codec and results in artifacts in your final video. The severity of these artifacts depends on the data rate you choose.

Several capture and playback cards on the market can play back either M-JPEG A or M-JPEG B in real time without rerendering the material, or at most, doing minimal rerendering. This makes file interchange very fast. Before you use either M-JPEG A or B, consult the manufacturer of the capture card you’re using to find out which one you should use.

*Note:* Apple M-JPEG movies cannot have alpha channels.

**JPEG**
JPEG is similar to M-JPEG, except that the compression artifacts can be less severe at similar data rates. JPEG movies may play back in real time on your system, depending on your system’s speed and the data rate of the movie.

*Note:* JPEG movies cannot have alpha channels.
Third-party codecs
There are several manufacturers of video-editing solutions, most of whom use different variations of the M-JPEG codec. Many make software-only QuickTime codecs that you can install in your System folder, enabling you to play back movies with little or no rerendering. For more information, contact the manufacturer of the editing system.

Note: Most third-party codecs cannot have alpha channels.

What Is Field Order?
All video displays, whether analog or digital, work by breaking a single frame of video into individual lines of horizontal resolution running across the screen. Standard definition NTSC and PAL are both interlaced video formats, as opposed to high definition video, or video displayed on a computer screen, which are progressive scanned video formats. With progressive scanning, these lines are drawn one at a time, from the top of the screen to the bottom.

Interlaced video, including NTSC and PAL, works differently. When you record footage with your camcorder, each individual video frame is broken down into two fields, each containing half of the total lines of resolution in the frame. The first field is recorded, then the second, then both are laid down to tape, one after the other, so both fields constitute one frame. When you play the tape back, a television monitor displays each recorded frame in two passes, first drawing field 1, then drawing field 2.

Field order refers to the order in which video fields are recorded from your video equipment to your hard disk. If you remember that video fields come one after another in time, as if playing 60 “frames” per second, it becomes a little easier to understand.

There are two options for field order:
• Upper (Field 2 is dominant, so the second field is drawn first.)
• Lower (Field 1 is dominant, so the first field is drawn first.)

Generally, Upper is used by 640 x 480 systems, while Lower is most common in professional 720 x 486 and DV 720 x 480 systems.

It’s important to render digital video with the field order used by your hardware. Since motion continues from one field to the next, it’s crucial that each field plays in the correct order. Since different capture cards handle interlacing differently, choosing the correct field order ensures proper playback.
Using Square or Nonsquare Pixels When Creating Graphics

When you’re preparing to import graphics into Motion, it’s important to be aware of the pixel aspect ratio you’re using and whether your project requires you to work with square or nonsquare pixels.

**Nonsquare pixels:** Use this for standard definition projects in NTSC or PAL.

**Square pixels:** Use this for high definition projects, as well as multimedia video that will be played back only on computers and doesn’t use any captured video footage.

Graphics created on a computer, whether scanned, painted, or rendered, look distorted on a video monitor unless you account for the different pixel aspect ratio. Fortunately, this is easy to do, since every nonsquare video frame size has an equivalent square frame size that you can use to create your graphics.

**To create graphics that look correct when output to video:**

1. In your graphics application, create a frame size that’s the square pixel equivalent of the video frame size you’re using.

   See the chart below for equivalent sizes. For example, if you’re working in DV-PAL with a nonsquare video frame size of 720 x 576, your graphic should have a square pixel frame size of 768 x 576.

2. Create the graphic.

3. Do one of the following:
   - In your graphics program, rescale the graphic from the square frame size you created it with to the nonsquare equivalent used in Motion.
   - Save your image as is.

4. Within your Motion project, select the object in the Media tab of the project window, open the Media tab in the Inspector, then choose the correct aspect ratio from the Pixel Aspect Ratio pop-up menu.

<table>
<thead>
<tr>
<th>Video format</th>
<th>Nonsquare 4:3 pixel size (Motion)</th>
<th>Square pixel size (graphics program)</th>
</tr>
</thead>
<tbody>
<tr>
<td>601-NTSC 4:3</td>
<td>720 x 486</td>
<td>720 x 547</td>
</tr>
<tr>
<td>601-NTSC 16:9 Anamorphic</td>
<td>720 x 486</td>
<td>853 x 486</td>
</tr>
<tr>
<td>DV-NTSC 4:3</td>
<td>720 x 480</td>
<td>720 x 540</td>
</tr>
<tr>
<td>DV-NTSC 16:9 Anamorphic</td>
<td>720 x 480</td>
<td>853 x 480</td>
</tr>
<tr>
<td>601/DV-PAL 4:3</td>
<td>720 x 576</td>
<td>768 x 576</td>
</tr>
<tr>
<td>601/DV-PAL 16:9 Anamorphic</td>
<td>720 x 576</td>
<td>1024 x 576</td>
</tr>
<tr>
<td>720i/p high definition</td>
<td>NA</td>
<td>1280 x 720</td>
</tr>
<tr>
<td>1080i/p high definition</td>
<td>NA</td>
<td>1920 x 1080</td>
</tr>
</tbody>
</table>
Working With Standard Definition (SD) Video Monitors and Computer Displays

Standard definition (SD) video monitors differ from computer displays in a significant way (aside from interlacing): computer displays represent images using a grid of square pixels, while video monitors use pixels that are rectangular in shape.

SD NTSC pixels are taller than computer pixels and SD PAL pixels are wider than computer pixels. As a result, a 720 x 486 pixel image looks different on a computer display than it does on a video monitor. For example, if you capture a clip of video with a globe in the picture, export a frame, and look at this frame in a graphics application, you’ll see something like this:

The Canvas let you display nonsquare pixel video correctly on the computer’s screen using the Correct For Aspect Ratio command in the View pop-up menu above the Canvas.

Note: High definition video uses only square pixels, so it doesn’t show this discrepancy.
Differences in Color Between Computer and Video Graphics

You should also be aware that the range of colors that can be displayed on a broadcast video monitor is much smaller than that which can be displayed on your computer. For this reason, colors that appear bright and clean on NTSC or PAL video can seem duller when viewed on your computer.

If you output graphics images with colors that go outside the “legal” range for video, they will appear oversaturated, and may “bleed” into other parts of the image. This distortion can be easily avoided by controlling the palette of colors you use in your graphics program. As you create the graphics you’ll be outputting to video, resist the temptation to use the brightest and most saturated shades of color available in your paint program.

Using Fonts and Creating Line Art for Video

When creating line art or selecting a font to use for a broadcast video image, you should avoid creating horizontal single-pixel lines, or using fonts that are too thin. Since video is interlaced, single-pixel lines will flicker as the field in which they appear alternates on and off. This results in “buzzing” in your graphics, with the buzzing becoming more pronounced the closer the thin areas in your image are to horizontal.

This can be lessened by adding a bit of blur or anti-aliasing to your image, but the best thing to do is to avoid single-pixel lines altogether when creating graphics for broadcast.

Scaling Imported High-Resolution Graphics

A high-resolution image is useful if you want to pan and zoom in or out of the image, such as a scanned map or photograph. There won’t be any image degradation because you typically won’t have to zoom more than 100 percent.

Scaling video and still images more than 100 percent creates artifacts: individual pixels become noticeable, causing a “stair-stepping” artifact on high-contrast diagonal lines.

Sometimes the frame size of your imported graphic doesn’t match the frame size of your edited sequence. If the frame size of the graphic is too large, only a small part of your image appears within the Canvas. If it’s too small, the background color of the Canvas (usually black) appears behind the graphic.
To scale an imported graphic to match the frame size of a sequence, use the following:

<table>
<thead>
<tr>
<th>Frame size (pixels)</th>
<th>Type of video</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920 x 1080</td>
<td>High definition, 16:9, Square Pixel</td>
</tr>
<tr>
<td>1280 x 720</td>
<td>High definition, 16:9, Square Pixel</td>
</tr>
<tr>
<td>720 x 486</td>
<td>Standard definition, 4:3, Nonsquare Pixel for NTSC</td>
</tr>
<tr>
<td>720 x 480</td>
<td>Standard definition DV, 4:3, Nonsquare Pixel for NTSC</td>
</tr>
<tr>
<td>720 x 576</td>
<td>Standard definition, 4:3, Nonsquare Pixel for PAL</td>
</tr>
<tr>
<td>640 x 480</td>
<td>Multimedia, 4:3, Square Pixel</td>
</tr>
<tr>
<td>480 x 360</td>
<td>Multimedia, 4:3, Square Pixel</td>
</tr>
<tr>
<td>320 x 240</td>
<td>Multimedia, 4:3, Square Pixel</td>
</tr>
<tr>
<td>240 x 180</td>
<td>Multimedia, 4:3, Square Pixel</td>
</tr>
<tr>
<td>160 x 120</td>
<td>Multimedia, 4:3, Square Pixel</td>
</tr>
</tbody>
</table>

Creating Graphics for HD Projects
Creating graphics and still images for high definition video projects is the same process as for standard definition video. To determine the image dimensions for your sequence, follow the guidelines below.

<table>
<thead>
<tr>
<th>Sequence preset</th>
<th>Still image dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i</td>
<td>1920 horizontal x 1080 vertical</td>
</tr>
<tr>
<td>720p</td>
<td>1280 horizontal x 720 vertical</td>
</tr>
</tbody>
</table>

Unlike standard definition video formats, which use rectangular pixels, high definition video formats use square pixels. You don't have to worry about adjusting high definition image dimensions before importing your graphics into Motion.
Integration With Final Cut Pro

Motion graphics work is often part of a larger project being edited in Final Cut Pro. The nature of both motion graphics and editing requires you to continually refine your work, so it's important to be able to quickly and easily update the files being passed back and forth. Apple offers a clean workflow, letting you view your Motion project inside a Final Cut Pro Timeline as if it was a single clip. Then, as changes are made in Motion, they are automatically updated in Final Cut Pro.

You can also export clips and sequences from Final Cut Pro and import them into Motion. The contents of Final Cut Pro sequences are converted into Motion projects with each clip placed on its own track in the Motion Timeline. Certain effects applied in Final Cut Pro automatically appear in the Motion project, such as composite (blend) modes, opacity settings, and most motion parameters.

Motion can import audio included in a Final Cut Pro project, but audio in a Motion project does not appear in Final Cut Pro.

Note: The features described in this appendix require Final Cut Pro (version 4.5) or later.

Using a Motion Project in Final Cut Pro

It's very simple to view a Motion project in Final Cut Pro. You don't need to adjust any settings or export any files. Your Motion project file can be imported into Final Cut Pro just as if it was a video clip or Photoshop file.

To import a Motion project into Final Cut Pro, do one of the following:

- Drag the project into the Final Cut Pro Browser or Timeline.
- Choose File > Import > Files, select the Motion project in the dialog that appears, then click OK.

Note: Remember that it's not necessary to import Motion projects back into Final Cut Pro if you exported them with Embed Motion Content selected. When embedded, the Motion project that appears in Final Cut Pro automatically picks up any changes saved to it in Motion. For more information on the Embed Motion Content option, see "Embed Motion Content Option" on page 959.
What Happens When a Motion Project Is Imported or Embedded?
Although you cannot edit the actual imported or embedded Motion project in Final Cut Pro, you can scrub it, place it in your sequence, trim edit it, add transitions or titles, and apply filters to it. Once a Motion project is imported or embedded into Final Cut Pro, the following occurs:

• Final Cut Pro displays the project as a clip, with all of the layers of the Motion project composited together into one sequence. It appears in the Browser with a Motion filename extension. If embedded and already in the Timeline, it also appears in the Timeline.
• The frame size and duration of the clip are determined by the settings in the Motion project.

- The audio in Motion is not imported into Final Cut Pro.
- If project properties (such as frame width or height) were altered in Motion, those new properties are reflected in the Motion project in Final Cut Pro.

You can continue to modify the Motion project in Motion and the changes are reflected in Final Cut Pro. Each time you want to update the Final Cut Pro sequence, you must save the project in Motion.

Note: If you plan on actively moving between Motion and Final Cut Pro, use the Open In Editor command. For more information, see "Making Changes to a Motion Clip" on page 960.
**Important:** Any media clips used in the Motion project, such as movies or still images, need to be available on the same hard drive for the project to play correctly in Final Cut Pro.

**Using Alpha Channels**
If your Motion project has transparent areas, the clip imported into Final Cut Pro assigns an alpha channel representing those transparent sections. Final Cut Pro may erroneously assign the alpha type to be *straight*. This is noticeable when the edges of the transparent area appear jagged or inaccurate. You can fix this by setting the clip’s alpha channel in Final Cut Pro to *black*. For more information on working with alpha channels in Final Cut Pro, see the *Final Cut Pro User Manual*.

To correct the alpha channel on a Motion project imported into Final Cut Pro:
1. In Final Cut Pro, select the Motion project file in the Browser.
2. Choose Modify > Alpha Type > Black.

**Using Final Cut Pro Clips and Sequences in Motion**
You can convert a Final Cut Pro sequence, or a portion of a sequence, into a Motion project file. The Motion project file contains all of the clips and objects in the Final Cut Pro sequence (or just the ones you selected) arranged into tracks and layers.
This lets you start the arrangement of a composition in Final Cut Pro and then export the items (with all of their compositing-related attributes) into Motion to take advantage of the Motion specialized toolset. The file exported by Final Cut Pro is a Motion project file.

You can also export clips to Motion from the Final Cut Pro Browser. Exporting a sequence in the Browser creates a new Motion project containing all the elements in the sequence. You cannot export more than one Final Cut Pro sequence at a time.

**Note:** The media used in the Final Cut Pro project needs to be available on the same hard drive as the newly created Motion project file for those files to appear properly in Motion.

**To export a sequence or clip from Final Cut Pro to a Motion project:**

1 Select what you want to export to Motion in one of the following ways:
   - Select one or more items in the Browser. Only one of these items may be a sequence.
     **Note:** You can export one or more clips in the Final Cut Pro Browser to Motion. The clips in the Motion project appear in the Media tab, but not in the Timeline. Because the timeline of the Motion project is based on the timeline of the sequence exported from Final Cut Pro, only one sequence can be exported to a particular Motion project.
     - Select a sequence in the Browser.
     - Select items in the Timeline. (The Timeline must be active.)
   - Select items in the Timeline. (The Timeline must be active.)

2 Choose File > Export > Export to Motion Project.

3 In the dialog that appears, do the following:
   - Choose a name and location for the new Motion project.
   - Choose the Launch Motion and the Embed Motion Content options.
   - Click Save.

   A new Motion project is created. Once the project has been exported, changes made in Final Cut Pro are not reflected in the Motion project.
Note: When a clip that contains a freeze frame or time remapping in Final Cut Pro is exported, the freeze frame is not represented in Motion (the clip plays normally).

**Automatic Launch Option**
When you export from Final Cut Pro you have the option to automatically launch Motion, so you can begin working on your composition. Final Cut Pro remains open, so you can move back and forth between the two applications.

**To automatically open Motion when exporting from Final Cut Pro:**
- Click the Launch Motion checkbox in the Export Selection to Motion Project dialog.

**Embed Motion Content Option**
If you have selected objects within an existing Final Cut Pro sequence when you perform the export, you also have the option to keep a clip representing the Motion project in your Final Cut Pro Timeline. This means the changes you make in Motion are immediately viewable directly in your Final Cut Pro sequence. You can think of that clip as “live” in Final Cut Pro, meaning it updates as it is worked on in Motion.

![Before After](image)

This is equivalent to importing the Motion project file and editing it into your sequence in place of the clips that were just exported. It is also similar to using the Nest Items command in Final Cut Pro, but instead of replacing the contents with a Final Cut Pro nested sequence, you create a Motion project file.

**Note:** When Motion projects are embedded in Final Cut Pro, Final Cut Pro reflects subsequent changes made to the project in Motion, but Motion will not reflect any changes (such as filters and titles) made to the Motion project clip in Final Cut Pro. If you plan on actively moving between Motion and Final Cut Pro, use the Open In Editor command. For more information, see “Making Changes to a Motion Clip” on page 960.

**To automatically replace the exported clips with a Motion project clip:**
- Click the Embed Motion Content checkbox in the Export Selection to Motion Project dialog.

If you do not have Motion installed, or if you did not select Embed Motion Content, any items you exported from the sequence appear as a nested sequence in the Timeline.
**Note:** Whether or not the Motion project clip is embedded in the Final Cut Pro sequence, a new sequence containing the objects selected for export is added to the Browser.

**What Properties Are Exported?**
When you select clips or sequences to export to Motion, the following properties are retained with the exported project.

<table>
<thead>
<tr>
<th>Exported properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video</strong></td>
</tr>
<tr>
<td>• Media</td>
</tr>
<tr>
<td>• Any relevant timing information, such as frame rates and In and Out points</td>
</tr>
<tr>
<td>• Markers (global and clip)</td>
</tr>
<tr>
<td>• Standard motion characteristics, including scale, position, and rotation</td>
</tr>
<tr>
<td>• Composite (blend) modes and opacity</td>
</tr>
<tr>
<td>• Linear and smooth keyframing of the above parameters</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
</tr>
<tr>
<td>• Media</td>
</tr>
<tr>
<td>• Markers</td>
</tr>
<tr>
<td>• Keyframes</td>
</tr>
</tbody>
</table>

1The audio exported to Motion is not imported when you bring the Motion project back into Final Cut Pro. The audio is only intended to be used in Motion for playback and markers. For this reason, make sure that you retain the audio clips.

When exporting to Motion, Final Cut Pro *does not* export properties omitted from the list above, such as filters, generators, and transitions. Time remapping and speed changes also are not exported.

**Note:** The Export to Motion Project menu item only appears in Final Cut Pro if Motion is installed on the same computer.

**Making Changes to a Motion Clip**
While working in Final Cut Pro, you can open a Motion clip from the Browser or Timeline in order to edit it in Motion.

**To open a Motion clip in Motion, from within Final Cut Pro:**

1 Select the clip you want to open.

2 **Control**-click the clip, then choose Open in Editor from the shortcut menu.

Both the Motion video clip and the audio associated with it in Final Cut Pro open in Motion.

If you make a change to a Motion project that is embedded in the Final Cut Pro Timeline without using the Open in Editor command, you may need to reconnect the project within Final Cut Pro.

**Note:** If you use Media Manager in Final Cut Pro, be aware that Media Manager does not move the source media files referenced by a Motion clip to a new location.
Using Gestures

If you use a Wacom tablet and pen with your computer system, you can use gestures to navigate within Motion and to perform tasks such as editing, copying and pasting, and so on. Gestures are continuous, uninterrupted patterns that are drawn in the Motion user interface (using your tablet).

Note: The supported tablet for using gestures in Motion is the Wacom Intuos tablet family.

Configuring Gesture Setup
Gestures are enabled by default—but you can change the default gesture input and trigger methods in Motion Preferences. When gestures are enabled, you can choose to use a modifier key (the Control key) or a button on the pen to trigger gesturing.

Before you can use gestures, Handwriting Recognition must be enabled in Mac OS X Ink Preferences. The Ink Preferences can be accessed in Motion Gesture Preferences.

Important: To use gestures, make sure that your Wacom tablet and its current drivers are correctly installed on your computer. For more information, see your tablet’s documentation.

To set up Motion Gesture Preferences:
1 In Motion, choose Motion > Preferences (or press Command+).  
2 Click Gestures.

The Gestures Preferences pane appears.
Important: Gestures in Motion use the Inkwell technology in the Mac OS X operating system. In order to use gestures, you must first enable Handwriting Recognition in Motion Preferences. If you cannot turn gestures on at this point, or perform the following steps, click Open Ink Preferences and follow the instructions in the section, “To set up Ink Preferences” on the next page. Once you have enabled Handwriting Recognition, complete the following steps.

3 For “Gestures are,” ensure that On is selected.

4 To select a gesture input method, select an option from the Trigger pop-up menu:
   - Choose Pen Button 1 to invoke gestures by pressing the first button (the button closest to the tip) on the pen.
   - Choose Pen Button 2 to invoke gestures by pressing the second button on the pen.
   - Choose Modifier (Ctrl) to invoke gestures by pressing Control.
Gestures in the Air
You can use gestures by swiping just above the tablet, without the tip of the pen actually touching the tablet. This feature is called “Allow gestures in the air.”

Important: To use gestures in the air, you must set one of the pen buttons as the gesture trigger input method, as well as set the pen button 1 to Ignored in the Tool Buttons tab of the Wacom Tablet application. For more information, see “Wacom Settings” on page 964.

To set up Ink Preferences:
1. In the Gestures pane of Motion Preferences, click Open Ink Preferences.
   The Ink Preferences appear.
2. For “Handwriting recognition is,” click the On option.

   ![Handwriting Recognition Preferences]

   By default, a “whoosh” sound is played when gestures are drawn.
To disable the default gesture sound:
1. Click the Options button in Ink Preferences.
2. In the Ink sheet, turn off “Play sound while writing.”

Wacom Settings
In the Wacom Tablet application, you can create customized tool settings for individual applications. For example, you can disable the pen buttons for use in Motion, but have button 1 set as “Double-Click” for another application.

To customize the pen buttons for a specific application:
1. In your Applications folder, open the Wacom Tablet application.
2. In the Wacom Tablet dialog, click Add Application To List and do one of the following:
   • If Motion is currently open, select it from the “Currently running applications” list.
   • If Motion is not currently open, click the Browse button, navigate to and select Motion, then click Choose.
     Motion appears in the Selected Application field.
3. Select all applicable tablets, then click OK.
4. In the Add Tool To Application dialog, click OK.
   Motion appears in the “Applications with customized tool settings” window.
5. Click the Motion icon, then set your pen tool options in the Tool Buttons tab.

6. To set customized tool settings for another application, follow steps 2–5 for that application.

**Using Gestures**

The following illustration shows the basic gesture anatomy. The green dot represents the start of the gesture, the blue arrow is the direction of your gesture, and the red dot the end of the gesture. Draw the gesture on the tablet, with your pointer in the Motion Canvas or Timeline.

![Gesture illustration](image)

**Modifier Keys**

Many gestures have additional functionality when used in combination with a key on the keyboard. In the following tables, if a gesture has an entry in the Modifier keys column, it has additional functionality that is accessed by using a shortcut key. For example, if you have the **Control** key set as the gesture trigger, and you draw the play forward gesture, the project plays forward from the current time. If you press **Control+Shift** and draw the play forward gesture, the project plays from the start of the project.

**The Motion Gestures**

The following tables describe the available Motion gestures and their modifier keys, where applicable.

*Note:* There is no defined minimum or maximum scale for the gestural input. The tolerance is defined by the Inkwell technology. However, the size at which certain gestures are drawn may affect the result of the gesture. For example, when using the “fit to fill” zoom gesture and you draw a large circle, the zoom amount is small. If you draw a small circle, the zoom is large.
Playback Control Gestures
Use the gestures described in the following table for controlling playback.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="" /></td>
<td>Advance one frame.</td>
<td>To advance in increments of 10 frames, press Shift.</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
<td>Go back one frame.</td>
<td>To go back in increments of 10 frames, press Shift.</td>
</tr>
</tbody>
</table>
| ![](image) | Play forward at normal speed.         | • To play from start, press Shift.  
|          |                                      | • To toggle loop, press Option.    |
| ![](image) | Stop or pause playback.               |                                   |

General Navigation
Use the gestures in the following table for general navigation, such as zooming the Canvas and displaying the different panes in the Motion user interface.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
</table>
| ![](image) | Zoom in to the Canvas.                        | • To zoom to the area within the gesture, press Shift. For example, if you draw a small gesture around an area, you get a large zoom. If you draw a large gesture, you get a small zoom.  
|          |                                               | • To position the zoom in at the center of the gesture, press Option. |
| ![](image) | Zoom out of the Canvas.                       | To position the zoom out at the center of the gesture, press Option. |
Select the Zoom tool. To zoom in and out of the Canvas, move the pen left or right. The zoom is centered on the area in which the pointer is placed in the Canvas.

Select the Pan tool.

Set the Canvas to Home (100 percent).

Fit the Canvas in the window. To toggle the Canvas to full-screen mode, press Shift.

Show or hide the Timing pane.

Show or hide the Project pane.

Show or hide the Inspector.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Zoom" /></td>
<td>Select the Zoom tool. To zoom in and out of the Canvas, move the pen left or right. The zoom is centered on the area in which the pointer is placed in the Canvas.</td>
<td></td>
</tr>
<tr>
<td><img src="image2.png" alt="Pan" /></td>
<td>Select the Pan tool.</td>
<td></td>
</tr>
<tr>
<td><img src="image3.png" alt="Home" /></td>
<td>Set the Canvas to Home (100 percent).</td>
<td></td>
</tr>
<tr>
<td><img src="image4.png" alt="Fit" /></td>
<td>Fit the Canvas in the window. To toggle the Canvas to full-screen mode, press Shift.</td>
<td></td>
</tr>
<tr>
<td><img src="image5.png" alt="Timing" /></td>
<td>Show or hide the Timing pane.</td>
<td></td>
</tr>
<tr>
<td><img src="image6.png" alt="Project" /></td>
<td>Show or hide the Project pane.</td>
<td></td>
</tr>
<tr>
<td><img src="image7.png" alt="Inspector" /></td>
<td>Show or hide the Inspector.</td>
<td></td>
</tr>
</tbody>
</table>
### General Commands

The following table describes the gestures for general commands, such as undo, select, and copy and paste.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Gesture Image" /></td>
<td>Show or hide the File Browser.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gesture Image" /></td>
<td>Show or hide the Library.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gesture Image" /></td>
<td>Show and hide the Dashboard.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gesture Image" /></td>
<td>Delete the selected object.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Gesture Image" /></td>
<td>Choose the Select tool. If a Select tool mode is enabled, such as Shear, when the gesture is drawn, the Select mode is enabled.</td>
<td></td>
</tr>
</tbody>
</table>

**Appendix D  Using Gestures**
### Timeline Navigation and Editing Gestures

The following table describes the gestures used for Timeline navigation and editing.

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Gesture" /></td>
<td>Go to start of play range.</td>
<td></td>
</tr>
<tr>
<td><img src="image2.png" alt="Gesture" /></td>
<td>Go to end of play range.</td>
<td></td>
</tr>
<tr>
<td><img src="image3.png" alt="Gesture" /></td>
<td>Go to the start of the project.</td>
<td></td>
</tr>
<tr>
<td><img src="image4.png" alt="Gesture" /></td>
<td>Go to the end of the project.</td>
<td></td>
</tr>
<tr>
<td><img src="image5.png" alt="Gesture" /></td>
<td>Go to start of the currently selected object.</td>
<td></td>
</tr>
</tbody>
</table>

*Note: The Paste command may be a bit tricky to master.*

---

**Appendix D  Using Gestures**
<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Gesture" /></td>
<td>Go to end of the currently selected object.</td>
<td></td>
</tr>
<tr>
<td><img src="image2" alt="Gesture" /></td>
<td>Group</td>
<td></td>
</tr>
<tr>
<td><img src="image3" alt="Gesture" /></td>
<td>Ungroup</td>
<td></td>
</tr>
<tr>
<td><img src="image4" alt="Gesture" /></td>
<td>Set a local In point for the currently selected object.</td>
<td>To move the In point to the current playhead position, press Shift.</td>
</tr>
<tr>
<td><img src="image5" alt="Gesture" /></td>
<td>Set a local Out point for the currently selected object.</td>
<td>To move the Out point to the current playhead position, press Shift.</td>
</tr>
<tr>
<td><img src="image6" alt="Gesture" /></td>
<td>Bring the selected object forward in the stack.</td>
<td>To bring an object to the front of the stack, press Shift.</td>
</tr>
<tr>
<td><img src="image7" alt="Gesture" /></td>
<td>Send the selected object backward in the stack.</td>
<td>To send an object to the back of the stack, press Shift.</td>
</tr>
<tr>
<td><img src="image8" alt="Gesture" /></td>
<td>Add a project marker.</td>
<td>• To edit a project marker, press Shift. • To clear a project marker, press Option.</td>
</tr>
</tbody>
</table>
### Gesture Description

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Description</th>
<th>Modifier keys</th>
</tr>
</thead>
</table>
| ![Add an object marker](image) | Add an object marker. | • To edit an object marker, press **Shift**.  
• To clear an object marker, press **Option**. |
| ![Set the start of the play range](image) | Set the start of the play range. | To clear the play range, press **Option**. |
| ![Set the end of the play range](image) | Set the end of the play range. | To clear the end of the play range, press **Option**. |
Index

3D filter 737

A
AAC files 174, 878
Action Safe Region 116
Active command 61
Add blend mode 257
Adding
categories to Template Browser 214
keyframes 416, 434
layers 278
Additive Blend
for emitters 600
Add new preset 119
Adjust Anchor Point tool 28, 225
Adjust Control Points tool 28, 225
Adjust Control Point tool 28
Adjust Crop tool 28, 225
Adjust Drop Shadow tool 28, 225
Adjust Four Corner tool 28, 225
Adjust Item tool 28, 225
Adjust Shear tool 28, 225
After Last Keyframe 442
AIFF files 878
Alignment commands 130, 228
Align To Motion behavior 369
Alpha Add blend mode 268
Alpha channels
about 173
and particle systems 585
creating with masks 851
exporting projects with 902
imported into Final Cut Pro 957
manipulating with filters 873
using Blend modes with 266
video codecs and 949
Alpha Overlay 41
Amplitude
for emitters 596
Anchor point
changing 234
Angle
for emitters 599
Animated backgrounds
creating 613
Animated particles 566
Animate Image
particles 606
Animating
generators 808
on the fly 446
replicators 673
shapes 847
text parameters 559
Animation
aligning keyframes 420
basic techniques 405
deleting keyframes 422
in the Canvas 405
in the Dashboard 409
in the Keyframe Editor 424–446
in the Timeline 419–424
modifying keyframes in the Timeline 420
moving a keyframe in time 420
thinning keyframes 428
trimming keyframed effects 423
Animation codec 948
Animation menu 415
Parameter behaviors in 328
states of 418
Animation paths 409
adding keyframes 409
Bezier points 409
displaying 42
Apple M-JPEG codec 949
Apple technical support 12
Application menu 124
Archiving
projects 156
QuickTime video 157
Arranging layers 219
Artifacts
and Motion J-PEG 949
and video codecs 949–950
Aspect ratio
correcting for 42, 116
Attracted To behavior 371
Attractor behavior 373
Audio
exporting 898
exporting options 908
multi-channel files 884
showing in Keyframe Editor 445
showing in the Timeline 280
Audio/video links 279
Audio Editor 21, 82–87
Add Keyframe command 84
Animation menu 84
controls in 82
Current Frame control 83
Delete Keyframe command 84
displaying 82
icon 34
Jump to Start control 83
keyframes in 86
level controls 84
level meters 85
Next Keyframe command 84
object end time 84
object start time 83
pan controls 85
Play/Pause control 83
playback controls 83
playhead 87
playhead position 83
Previous Keyframe command 84
ruler 86
scrubbing 87
Show in Keyframe Editor command 84
Use Marked Region control 83
zooming 87
Audio files 878–887
about 173
adding to project 880
copying 886
cutting 886
deleting 887
duplicating 887
exporting 912
importing 878
listing 885
pasting 886
previewing 879
QuickTime audio track 881
viewing 885
viewing information 886
viewing the waveform 885
Audio format 62
Audio icon 33
Audio rate 62
Audio Scrubbing button 893–894
Audio tab 20, 64–66, 877
adding audio files 65
displaying 64
editing columns 65
filtering 66
Lock column 65
Mute command 66
Pan column 65
removing file 66
Reveal Source Media command 66
Status column 65
Audio tracks 887–894
clipping 891
cross-fading 896
cutting, copying, pasting 886
fade-ins and fade-outs 896
keyframing 894
keyframing levels 895
keyframing panning 895
level meters 891
locking 890
markers 897
Master track 890
Master track level 891
muting 889
muting and soloing 889
panning 890
Pan slider 892
playing 888
playing individually 888
playing with project 888
recording keyframes 895
renaming 890
resetting clipping indicators 892
scrubbing 894
selecting 888
setting levels 889
slipping 892
soloing 889
syncing with video tracks 896
trimming 893
trimming numerically 893
trim track visually 893
turning Master track on and off 891
turning on and off 887, 888
Aura filter 754
Autosave 113, 153
specifying a save location 114
Autosave vault 153
Auto scale button 81
Auto-scaling in Keyframe Editor 446
Average behavior 354
Background color 40, 199
Background opacity 146
Baking behaviors 343
Baking behaviors into keyframes 343
Basic 3D filter 737
Basic Motion behaviors 344–354
about 317
using with text objects 556
Batch window 911
Before First Keyframe 441
Behavior categories
particles 611
Behaviors
about 17, 317
Add Behavior icon 31
adjusting timing of 335
Align To Motion 369
and keyframes 319
and replicators 696
animated previews 320
animating parameters 341
applying and removing 323
applying multiple 334
applying Parameter behaviors 326
applying Parameter behaviors to 342
applying to cells 611
applying to emitters 610
applying to filter parameters 708
applying to generators 811
applying to image masks 869
applying to layers 325
applying to masks 862
applying to multiple objects 324
applying to shapes 847
applying to text objects 463
Attracted To 371
Attractor 373
Average 354
baking 343
Basic Motion behaviors 344–354
behavior paths 322
browsing for 320
categories of 95, 317
changing duration of 336
changing offset of parameter behaviors 337
combining 334
combining with keyframes 338, 413
converting to keyframes 341, 343
copying and pasting 332
Custom 355
customizing 329
customizing in the Dashboard 330
customizing in the Inspector 330
deleting 325
Drag 375
Drift Attracted To 375
Drift Attractor 377
duplicating 333
Edge Collision 378
enabling 331
examples of 392–399
Fade In/Fade Out 344
Gravity 379
Grow/Shrink 346
in the Keyframe Editor 323, 339
in the Library 189
keyframing 342, 412
Locking 331
MIDI 357
modifying duration of 336
Motion Path 348
moving across computers 344
moving from one object to another 332
moving in time 337
multiplicative behaviors 344
Negate 360
Orbit Around 380
Oscillate 360
Parameter behavior indicator in Inspector 418
Parameter behaviors 354–368
Ramp 362
Randomize 363
Random Motion 382
Rate 365
removing 325
renaming 331
reordering 334
Repel 384
Repel From 386
Reverse 366
Rotational Drag 387
saving 343–344
sharing 343–344
showing in the Timeline 280
Simulation behaviors 369–391
Snap Alignment to Motion 350
Spin 351
Spring 387
Stop 366
Stop behavior usage 335
Throw 352
trimming 336
using Stop or changing duration of 337
using with particle systems 610
using with text objects 556
versus keyframes with text 559
Vortex 389
where customized behaviors are saved 343
where Parameter behaviors appear 327
 behaviors tab 103
behind blend mode 268
bevel filters 723
bezier animation paths 409
bezier interpolation 439
bezier mask tool 30
bezier splines 821
drawing with 822
editing control points 832
bezier tool 29
birth rate (emitters) 598
birth rate range (emitters) 598
bit depth 144
black hole filter 738
blending
particle systems 582
blend modes
about 244
add 257
alpha add 268
behind 268
changing 246
color burn 256
color dodge 259
combine 250
darken 253, 254
difference 265
exclusion 266
hard light 262
hard mix 265
how they work 249
in layers tab 61
lighten 258
linear burn 256
linear dodge 260
linear light 263
multiply 255
normal 251, 253
on alpha channels 266
on layers 249
on objects 253
overlay 260
pin light 264
premultiplied mix 268
screen 258
silhouette alpha 267
silhouette luma 267
soft light 261
stencil alpha 266
stencil luma 267
subtract 253
vivid light 262
bloom filter 755
blue green screen filter 760
blur filters 714–723
blur map
adding an image to 716
border filters 723–724
brightness filter 725
broadcast safe filter 793
broadcast video 953
browse templates preference 108
browsing
files 162
media files 158
b-spline mask tool 30
b-splines 821
as masks 823
degrees of curvature 835
drawing with 823
editing control points 834
hiding the frame 837
b-spline tool 30
bulge filter 738
bump map filter 739

C
canvas 19–23, 35–53
adding guides 44
animating position in 407
animation paths 409
basic animation 405
channels pop-up menu 40
displaying color channels 40
displaying playback frame rate 38
fit in window command 40
frame rate 37
guides and safe zones 227
keyboard shortcuts 924–925
keyframing in 405
keyframing scale parameter 405
mini-timeline 20, 48
moving objects in 227
overlay options 41
pixel color status 37
play project 45
pointer position 37
project pane 20
ram preview 46
removing guides 44
resolution 40
resolution pop-up menu 40
setting background color of 115
status bar 36
swapping project pane 24
timecode fields 51
timing pane 21
Convert to Bezier 440
Copying
  behaviors 332
  filters 710
  in Layers tab 61
  in the Timeline 298
  keyframes 435
Corner-pinning objects 238
Correct for Aspect Ratio 42
Counting time 51, 53
Crawl Left text behavior 527
Crawl Right text behavior 529
Creating
  new layers 288, 289
  new templates 213
  particle systems 571
Cropping
  in Inspector vs Media tab 239
  objects 239
Cross-fading audio 896
Crystallize filter 768
Current Frame field 52, 72, 306, 427
Current pixel color 37
Curve graph 433
Curves
  About 424
  about 437
  extrapolation methods 442
  interpolation methods 439
  modifying 437, 446
Curve Set list 429
Custom behavior 355
  adding parameters to 356
  removing parameters from 356
Customize icon 33
Customizing
  behaviors 329
  File Browser 160
  particle system emitters 575
  template-based projects 211
  Toolbar 32
Custom layouts
  saving 25
  switching to 26
Custom particle effects
  saving to Library 619
Custom project settings 143
Custom Traversal parameter 542
Cutting
  in Layers tab 60
  objects 298
D
  D-1 format 944, 948
  D-2 format 944, 947
  D-5 format 944, 947
Darken blend mode 253, 254
Dashboard 105–107
  about 17
  choosing control sets 106
  controls 706
  icon 31
  Inspector icon 107
  keyboard shortcuts 933
  keyframing with 409
  modifying behaviors 330
  switching between Dashboards 106
  using 706
Data rate 62
Dazzle filter 756
Defocus filter 717
Deinterface filter 793
Deleting
  audio files 887
  behaviors 325
  categories from Template Browser 215
  in Layers tab 61
  keyframes 417, 435
  layers 278, 292
  objects 292, 297
  deleting
    keyframes 422
Depth
  in Media tab 62
Desaturate filter 730
Dials 99
Difference blend mode 265
Digital Betacam format 944, 948
Digital Cinema Desktop Preview 117
Directional blur filter 718
Disabling
  behaviors 322
  keyframes 435
Disclosure triangle 74
Disc Warp filter 740
Displace filter 740
Distortion filters 737–753
Distribute objects 228, 229
Divider 71
Divider line 281
Dock 23
Drag and drop preferences 287
Drag behavior 375
Drift Attracted To behavior 375
Drift Attractor behavior 377
Drop In From Left text behavior 549
Droplet filter 741
Drop menu
  and layered Photoshop files 177
  setting the drop delay 287
Drop Menu Delay preference 108
Drop shadows
about 269
adding to text objects 508
adjusting 237
adjusting on text objects 508
blur amount 271
Dashboard controls 270
default text shadow 508
parameters in Properties tab 271
particle systems 582
with text objects 507
Duplicate
in Layers tab 61
Duplicating
behaviors 333
export presets 904
filters 712
project presets 151
Duration
in Media tab 62
of still images 169
DVCAM format 945, 947
DVCPRO 100 format 946
DVCPRO 25 format 945, 946
DVCPRO 50 codec 949
DVCPRO 50 format 945, 946, 947
DV format 945, 947
Dynamic Guides 41
color of 115
turning on and off while editing 827
Dynamic zoom mode 39

E
Earthquake filter 742
Ease In interpolation 439
Ease Out interpolation 439
Echo filter 791
Edge Collision behavior 378
Edges filter 770
Edge Work filter 769
Editing
columns 57
export presets 903
generators 805
how to slip an object 296
how to trim an object 295
in mini-Timeline 48
in the Timeline layer track 301, 306
objects in the Timeline 293–306
project properties 157–158
Editing terminology 293
Edit menu 126
Spelling submenu 127

Effects
organizing 97
turning on and off 60
Elements
in replicators 622
Emission range 597
Emitter
Dashboard 575
shape options 590
Emitter cells
objects as 572
Emitter object tab 104
Emitter parameters 587
for single and multiple cells 588
Emitters
additive blend 600
angle 599
applying behaviors to 610
birth rate 598
birth rate range 598
creating 572
Dashboard parameters for 575–577
emit at points 595
emitter-only parameters 594
initial number 598
life 599
life range 599
modifying parameters 576
modifying properties 580–585
pattern 595
points 595
scale 602
size 595
speed 599
speed range 599
spin 600
Emitter shapes
burst 592
circle 592
geometry 594
image 594
line 591
point 590
rectangle 591
spiral 593
wave 593
Enabling and disabling tracks 277
Equalize filter 731
Exchange edit 285
how to perform 286
Exchanging
objects 212
Exchanging media 184
Exclusion blend mode 266
Exporting
- advanced options 907
- audio 898
- audio files 912
- current frame 901
- defining output type 901
- image sequences 901
- play range 909
- projects 899–912
- QuickTime movies 901
- with alpha channels 902
- with Compressor 909–912
Export options 121
Export presets 901
- creating 904
- deleting 904
- duplicating 904
- editing 903
- options 905
External Video icon 34
Extrapolation
- about 441
- about defaults 410
- Constant 442
- generating keyframes 443
- Linear 442
- Ping Pong 442
- progressive 442
- repeat 442
- table of methods 442
Extrapolation data
- converting to keyframes 443
Extrude filter 770
F
Fade In/Fade Out behavior 344
- Dashboard controls 345
- example of 392
Favorites category 193
Favorites folder 96
Favorites menu 96, 132, 192
Feathering
- masks 857, 860
- shapes 843
Field dominance 950
Field order 146, 187, 950
- defined 950
- setting in presets 120
Field rendering 42
File Browser 19, 88–93
- adding a new folder 91
- collapsing animations 92
- customizing 160
- file stack 89
- Forward and Back buttons 89
- icon 31
- icon size 92
- icon view 91
- Icon View button 89
- importing files 88
- importing image sequences 93
- keyboard shortcuts 933
- list view 91
- List View button 89
- moving files 91
- navigation controls 159
- Path pop-up menu 89
- Preview area 88
- previewing files 88
- Scale slider 161
- Search field 89
- selecting files in 175
- sorting columns 92
File Created 62
File formats
See also video formats
File menu 125
File Modified date 62
Files
- adding to existing layers 176
- adding to new layer 176
- adding to project 180
- adding to projects 176
- adding without using 177
- browsing 162
- previewing 163
- renaming 90
- searching 162
- selecting in the File Browser 175
- types supported 163
File size information 62
File stack 89, 159, 160
- browsing 162
- sorting 162
Filmstrip display 76
Film zone 42
- color of 116
Filter parameters
- applying behaviors to 708
- keyframing 707
Filters
- about 701
- Add Filter icon 31
- adjusting 706
- adjusting parameters 706
- and replicators 698
- appearance 705
- applying 703
- applying multiples to an object 704
- applying to image masks 869
applying to masks 861
applying to particle systems 612
applying to shapes 847
applying to text objects 463
Aura 754
Basic 3D 737
Bevel 723
Black Hole 738
Bloom 755
Blue Green Screen 760
Blur filters 714–723
Border 723–724
Brightness 725
Broadcast Safe 793
browsing for 702
Bulge 738
Bump Map 739
categories 95
changing duration of 713
changing timing of 713
Channel Blur 715
Channel Swap 725
Circle Blur 715
Circle Screen 767
Color Balance 726
Color Correction 725–784
Color Emboss 767
Colorize 729
Color Key 760
Color Reduce 727
Compound Blur 716
Contrast 730
copying 710
Crystallize 768
Dazzle 756
Defocus 717
Deinterlace 793
Desaturate 730
Directional Blur 718
Disc Warp 740
Displace 740
Distortion 737–753
Droplet 741
duplicating 712
Earthquake 742
Echo 791
Edges 770
Edge Work 769
enabling 710
Equalize 731
Extrude 770
Fisheye 743
Flop 743
Fun House 744
Gamma 731
Gaussian Blur 719
Glass Block 744
Glass Distortion 745
Gloom 757
Glow 757
Glow 753–759
Gradient Blur 719
Gradient Colorize 732
Halftone 772
Hatched Screen 772
Highpass 773
HSV Adjust 733
Indent 773
Insect Eye 746
in the Library 189
Invert 733
Kaleidoscope 786
Kaleidotile 787
keyframing 411
Keying 760–764
Lens Flare 774
Levels 734
Light Rays 758
Line Art 776
Line Screen 777
locking 710
Lumakey 761
manipulating alpha channels 873
Matte 765
Matte Choker 765
MinMax 778
Mirror 746
missing 193
moving 710, 711
Negative 734
Noise Dither 779
Noise Dissolve 778
onscreen controls 707
Outer Glow 758
Overdrive 759
Parallelogram Tile 788
pasting 710
Perspective Tile 788
Pixellate 779
Poke 747
Posterize 780
previewing 702
Primatte RT 761
Prism 720
Radial Blur 721
Refraction 747
Relief 780
removing 703
renaming 710
reordering 712
Ring Lens 748
Ring Warp 749
Ripple 749
Saturate 735
Scrape 730
Sepia 735
Set Matte 765
Sharpen 766
Sharpening 766
showing in the Timeline 280
Simple Border 724
slipping in time 714
Slt Scan 781
Slt Tunnel 782
Sphere 750
Spill Supressor 764
Starburst 751
Stripes 751
Strobe 791
Stylizing 767–785
Target 752
Texture Screen 782
third-party 189, 793–794
Threshold 736
Tile 789
Tiling 785–790
Time 790–792
Tint 736
Trails 792
Triange Tile 790
trimming 713
Twirl 752
types of 702
Unsharp Mask 766
Variable Blur 722
Vectorize Color 783
Video 793
Vignette 784
Wave 753
Wavy Screen 785
Widescreen 724
Widetime 792
working with 709–714
Zoom Blur 723
Filters tab 103
Final Cut Express
importing movies from 164
Final Cut Pro 301, 955, 957
clips and sequences in Motion 957
embedding Motion projects in 959
exported properties retained in Motion 960
exporting Motion projects from 958
importing movies from 164
integrating with Motion 955
Motion project alpha channels 957
using Motion projects in 955
Find a layer or object 209
Fisheye filter 743
Fit Curves button 445
Fixed resolution 206
Flexible space 32
Float bit depth 144
preview 42
Flop filter 743
Folders
adding in File Browser 91
adding to Library 97
Font Browser
icon 33
Fonts 95, 953
in the Library 190
missing 193
Frame rate 146, 187
displaying in Canvas 37
Frames
moving forward and backward 52
Frame size 157
imported graphics and 951
in Media tab 62
Freeze frames
using the Hold frame end condition 187
using the Scrub filter 791
Full resolution 40
Full Screen mode 27
normal view 27
Fun House filter 744

G
Gamma filter 731
Garbage masks 870
creating 870
Gaussian blur filter 719
General settings tab 144
Generate Keyframes dialog 444
Generating keyframes 443
Generator object tab 104
Generators 795
about 795
adding 796
animating 808
applying behaviors to 811
categories 95
Caustics 797
Cellular 798
Checkerboard 798
Clouds 799
Color Solid 800
duration of 795
editing 805
Gradient 801
in the Library 189
Membrane 801
modifying 804
Noise 802
Op Art 802
saving 809
sharing 811
Soft Gradient 803
Star 803
Stripes 804
Swirly 804
types of 797
using as particle cell sources 814
Gestures 961–971
basic usage 965
configuring 961
disabling gesture sound 964
for general navigation 966
for playback control 966
general commands 968
in the air 123, 963
in the Timeline 969
modifier keys 965
preferences 123, 961
trigger 123
Glass Block filter 744
Glass Distortion filter 745
Gloom filter 757
Glow
adding to text objects 506
default text glow 506
editing on text objects 506
with text objects 505
Glow filter 757
Glow filters 753–759
Go to end of project 45
Go to start of project 45
Gradient Blur filter 719
Gradient Colorize filter 732
Gradient Editor
adding colors 487
adding opacity tags 487
changing color opacity 488
changing colors 485
changing color spread 487
distributing gradient tags 489
modifying opacity 487
moving colors 486
removing colors 487
reversing gradient direction 489
using with text objects 485
Gradient generator 801
Gradients 100
applying parameter behaviors to 491
applying to text objects 481
categories 95
custom Library icons 490
in the Library 190
saving to Library 489

Graphics
broadcast video and 953
custom Library 953
distorted 951–952
line art 953
pixels and 951–952
video output and 951, 952
Gestures 961–971
basic usage 965
configuring 961
disabling gesture sound 964
for general navigation 966
for playback control 966
general commands 968
in the air 123, 963
in the Timeline 969
modifier keys 965
preferences 123, 961
trigger 123
Glass Block filter 744
Glass Distortion filter 745
Gloom filter 757
Glow filters 753–759
Go to end of project 45
Go to start of project 45
Gradient Blur filter 719
Gradient Colorize filter 732
Gradient Editor
adding colors 487
adding opacity tags 487
changing color opacity 488
changing colors 485
changing color spread 487
distributing gradient tags 489
modifying opacity 487
moving colors 486
removing colors 487
reversing gradient direction 489
using with text objects 485
Gradient generator 801
Gradients 100
applying parameter behaviors to 491
applying to text objects 481
categories 95
custom Library icons 490
in the Library 190
saving to Library 489

Index

Graphics
broadcast video and 953
custom Library 953
distorted 951–952
line art 953
pixels and 951–952
video output and 951, 952
Gestures 961–971
basic usage 965
configuring 961
disabling gesture sound 964
for general navigation 966
for playback control 966
general commands 968
in the air 123, 963
in the Timeline 969
modifier keys 965
preferences 123, 961
trigger 123
Glass Block filter 744
Glass Distortion filter 745
Gloom filter 757
Glow filters 753–759
Go to end of project 45
Go to start of project 45
Gradient Blur filter 719
Gradient Colorize filter 732
Gradient Editor
adding colors 487
adding opacity tags 487
changing color opacity 488
changing colors 485
changing color spread 487
distributing gradient tags 489
modifying opacity 487
moving colors 486
removing colors 487
reversing gradient direction 489
using with text objects 485
Gradient generator 801
Gradients 100
applying parameter behaviors to 491
applying to text objects 481
categories 95
custom Library icons 490
in the Library 190
saving to Library 489

H

Halftone filter 772
Handles

displaying in Canvas 42
Handwriting Recognition
in Motion Preferences 962
Hard Light blend mode 262
Hard Mix blend mode 265
Hatched Screen filter 772
HDCAM format 946
Help 9
Help menu 137
Hiding
layers 203
Toolbar 35
High definition video
formats 945–946
frame rates 945
shooting 946
High-definition video 945
Highpass filter 773
High-resolution images 165
Hold end condition 187
Hold frames 187
Holdout masks 871
Holdout mattes 871
HSV Adjust filter 733

I

Icon view 91, 160
Icon View button 89
Image masks 865
about 865
adding to an object 866
applying behaviors to 869
applying filters to 869
blend modes 868
channels 866
parameters 867
Images
adding to a blur map 716
down-res to Canvas size 167
duration of 169
high-resolution 165
pixels and 951–952
scaling to Canvas size 166
Image sequences
about 169
collapsing 169
exporting 901
importing 93
padding 169
Image wells 100
Importing
audio files 878
field dominance and 950
files 88
QuickTime files 948–950
In and Out points
setting for text behaviors 529
Indent filter 773
Initial number
for emitters 598
Ink preferences 961, 963
Insect Eye filter 746
Insert edit 284
how to perform 285
Inspector 19, 98–104
Activation checkboxes 99
adding keyframes in 416
Add Keyframe command 102
Animation menu 415
Behaviors tab 103
Color wells 100
Delete Keyframe command 102
deleting keyframes 417
dials 99
editing text in 473
Enable/Disable Animation command 102
Filters tab 103
Gradients 100
icon 31
Image wells 100
keyboard shortcuts 934
keyframing 414–418
locking 104
modifying Behaviors 330
navigating to keyframes 417
Next Keyframe command 102
Object tab 103
Parameter behaviors indicator 418
parameter Selection menu 100
pop-up menus 99
Previous Keyframe command 102
Properties tab 103
Reset button 100, 418
Reset Parameter command 102
resetting a parameter 417
Show In Keyframe Editor command 102
sliders 99
value fields 99
value lists 99
value sliders 99
Interlaced video 950
Interpolation 401
Bezier 439
Constant 439
Continuous 439
convert to Bezier 440
Ease In 439
Ease Out 439
Linear 439
methods of 439
setting 437
Inverted alpha 41
Invert filter 733
iPhoto
importing from 158
importing photos from the Library 178
iTunes
adding audio from 880
importing from 158
importing songs from the Library 178

J
JPEG codec 949
Jump to end of project 307
Jump to start of project 307
Justification (text) 514

K
Kaleidoscope filter 786
Kaleidotile filter 787
Kerning
text characters 477
text parameter 477
Keyboard shortcuts 913–940
application 913
Audio Editor 923
Audio tab 923
Canvas 924–925
Edit menu 916
File menu 915

Index
keyframes and behaviors 319

animation text parameters 559
combining with behaviors 338, 413
converting to Bezier 440
copying and pasting 435
deleting 422, 435
disabling 435
extrapolation 441
finding the values of 420
generating before first and after last 443
interpolation methods 439
locking 435
modifying curves 437, 444, 446
modifying in the Keyframe Editor 433
recording options 449
Setting interpolation for 437
shortcut for adding 416
showing in the Timeline 280
text parameters 559
thinning 428, 448
thinning example 450
versus behaviors with text 559

Keyframing

about 401–404
Adding a keyframe in the Inspector 416
aligning with other elements 420
animating on the fly 446
animation paths 409
audio tracks 894
basic techniques 405
behaviors 342, 412
curve graph 433
deleting a keyframe in the Inspector 417
extrapolation methods 442
filter parameters 707
filters 411
in the Animation menu 415
in the Canvas 405
in the Dashboard 409
in the Inspector 414–418
in the Keyframe Editor 424–446
in the Timeline 419–424
keyboard shortcuts 938
masks 862
modifying keyframes in the Timeline 420
moving a Keyframe in time 420
navigating to keyframes 417
Parameter behaviors 610
position 407
resetting a parameter 417
scaling object over time 405
Index

shape control points 848
shapes 848
thinning 428
trimming keyframed effects 423

Keying
using multiple keys 872
Keying filters 760–764

Late-Breaking News 11
Layered Photoshop files 170
Layer list
  in the Timeline 276
Layer markers 312
Layers
  and object order 219
  and particles 569
  applying behaviors to 325
  arranging object order 219
  collapsing and uncollapsing 208
  creating 72, 201
  creating new 288, 289
  fixing the size of 204
  grouping 291
  keyboard shortcuts 934
  locking 207
  nesting 194
  nesting inside other layers 202
  organizing 194
  placing inside other layers 291
  placing one layer inside another 291
  renaming 208
  searching for 209
  showing and hiding 203
  soloing 204
  sorting in Media tab 210
  transforming in Canvas 221
  ungrouping 291
Layers icon 33
Layers tab 20, 54–61
  adding layers 58
  additional columns 56
  Blend Mode column 56
  displaying 55
  Layers list 59
  Lock column 56
  Name column 55
  Opacity column 56
  Preview column 55
  removing objects 58
  reorganizing objects 200
  showing behaviors 59
  showing filters 60
  showing masks 59
Layer track 301, 306
  slipping 305
  trimming 304

Layouts 21
  Alternate 22
  Cinema 22
  deleting 26
  duplicating 26
  preset layouts 21
  renaming 26
  saving custom layouts 25
  Standard 22
  switch to saved custom layout 26
Lens Flare filter 774
Level meters 85
Levels
  for audio tracks 889
Levels filter 734
Library 19, 93–97
  adding content to 192
  adding new folders 97
  applying effects 94
  Back button 94
  Behaviors category 95
  browsing for behaviors 320
  changing fonts in 466
  custom text style icon 513
  Favorites folder 96
  Favorites menu 96
  file stack 96
  filters 702
  filters category 95
  font browser 468
  fonts category 95
  Forward button 94
  generators category 95
  gradients category 95
  icon 31
  icon size 97
  icon view 97
  Icon View button 94
  keyboard shortcuts 935
  list view 97
  List View button 94
  LiveFonts category 95
  music 96
  Particle emitters 569
  particle emitters category 95
  particles 569
  Path pop-up menu 94
  photos 96
  playing previews 94
  Preview area 93, 96
  replicators 95
saving a generator in 809
saving custom particle effects to 619
saving text styles to 512
Search field 95
Shapes category 95
Text Styles category 96
third-party filters 95
using media in 189
Library Content 95
Library gradients
applying to text objects 483
Library presets 101
Life
for emitters 599
Life range
for emitters 599
Lighten blend mode 258
Light Rays filter 758
Linear Burn blend mode 256
Linear Dodge blend mode 260
Linear extrapolation 442
Linear Interpolation 439
Linear Light blend mode 263
Line Art filter 776
Lines (showing in Canvas) 42
Line Screen filter 777
Line spacing in text 514
Linked objects 180, 188
List view 91, 160
List View button 89
LiveFonts 95
about 560
applying to text objects 561
in the Library 190
missing 193
modifying 562
previewing 560
Timing parameters 563
LiveType fonts 560
Loading presets 101
Location parameter 486
Locking
audio tracks 890
behaviors 331
keyframes 435
layers and objects 207
project presets 151
tracks 278
Loop end condition 187
Loop playback 45
Lossless codecs 948
Lumakey filter 761

M
Manage Curve Sets dialog 432

Map Animation parameter 540
Margins 471
creating and modifying 523
for text 522, 523
Markers 312, 316
about 312
adding 313
deleting 314
deleting all 314
different types 312
editing 314
for audio tracks 897
navigating 316
Mark menu 127
Go to submenu 129
Markers submenu 128
RAM Preview submenu 129
Mask Blend Mode 854
Mask object tab 104
Mask parameters
Beziers (Shape Type) 854
Masks
about 819, 851
adding and deleting control points 829
adjusting tangent handles 833
and replicators 644
applying behaviors to 862
applying filters to 861
blend modes 854
blend modes and ordering 858
B-Splines 820
closing 853
combining 857
creating alpha channels 851
differing from shapes 820
drawing a Bezier mask 821
drawing a B-Spline mask 823
drawing and editing 852
drawing methods 820
editing 826, 834
editing Bezier control points 832
editing in the Keyframe Editor 865
feathering 857, 860
finishing Bezier masks 823
finishing B-Spline masks 825
garbage masks 870
holdout masks 871
image masks 865
intersecting 859
keyboard shortcuts 939
keyframing 862
lock control points 831
mask drawing tools 851, 852
masking an object 851
modifying alpha channels 851, 858, 859
motion blur 862
moving control points 828
parameters 854–857
particle systems 582
replacing an alpha channel 859
rotoscoping 862
selecting control points 828
showing control points 828
showing in the Timeline 280
tangent handles 832
transforming (as an object) 865
turning handles on or off 828
turning snapping on or off 827
using b-splines 823
using multiple 857
using text as a mask 500
using with keying filters 869
Mask set in Toolbar 30
Master controls
for multi-cell particle systems 590
Matte Choker filter 765
Matte filters 765
Media
adding and removing 63
adding to projects 174–178
exchanging 184
in the Library 189
offline 193
online and offline 181
reconnecting 181
revealing source of 180
Media files
browsing 158
linked to objects 174
Media icon 33
Media object tab 103
Media tab 20, 61–64
displaying 61
filtering 63
filtering objects 63
parameters 185
Reconnect Media command 64
Reveal in Finder 64
revealing source objects 209
Show Columns button 62
sorting objects and layers 210
Membrane generator 801
Menus 124–137
Application menu 124
Edit menu 126
Favorites menu 132
File menu 125
Help menu 137
Mark menu 127
Object menu 130
View menu 132
Window menu 135
MIDI behavior 357
mini-Timeline 20
adding multiple objects to 49
adding objects to 49
changing object length 50
editing in 48
moving objects in time 50
slipping objects 50
MinMax filter 778
Mirror filter 746
Missing items 181
M-JPEG codec 949
Modifying
curves 437, 446
filter parameters 706
particle systems 571
Modifying curves 444
Monitor
standard definition (SD) 952
Monospaced text 478
Motion
opening automatically from Final Cut Pro 959
Motion blur 147
displaying 43
turning on and off 149
with masks 862
Motion Path behavior 348
example of 392
Motion paths
hand made 448
Move to Trash 90
Movies
uncompressed movies 948
Moving
entire layers 301
filters 710, 711
forward or backward one frame 307
objects 301
objects in time 293
overlapping objects 303
projects to other computers 156
single objects 302
MP3 files 878
Multi-channel audio files 884
Multiple cells 566
Multiple selections 292
Multiply blend mode 255
Music 96
in the Library 191
N
Name in Media tab 61
Navigating file path 162
in the Timeline 306
to keyframes 417
Negate behavior 360
Negative filter 734
Nested objects 194
Nesting layers 202
Nesting layers 194, 291
Networked disks 163
Next frame 45
Ninjas 743
Noise Dissolve filter 778
Noise Dither filter 779
Noise generator 802
Non-square pixels 951–952
Normal blend mode 251, 253
NTSC video 944
DV vs analog 944
standard definition DV video and 944
Number of Arms for replicators 647, 650, 658
Number of arms for emitters 596
O
Object blend modes 253
Object markers 312
Object menu 130
Alignment submenu 130
Blend Mode submenu 131
Unsolo submenu 131
Objects
adjusting drop shadows 237
aligning 228
and the Media tab 179
as emitter cells 572
as particle cell sources 568
cloning 228
copying to different layer 201
corner-pinning 238
cropping 239
cutting 298
deleting 183, 297
distributing 228
dropping into collapsed layers 290
exchanging 212
grouping and ungrouping 202
hints for naming 213
linked to media files 174
locking 207
managing in project 179–183
moving 290, 301
moving to different layers 201
moving to the playhead 294
offline 175
organizing 194
parameters in the Media tab 185
removing 72
renaming in the Timeline 276
reorganizing in Layers tab 200
rotating 233
scaling 230
selecting 221
selecting in Layers tab 200
setting duration preferences 456
shearing 236
shortcuts for moving 302
sorting in Media tab 210
transforming in Canvas 221
viewing relationships between 180
Object tab 103
Offline media 175, 181, 193
Offsetting text 478
Opacity
about 243
animating 410
Preserve Opacity command 247
text objects 501
Op Art generator 802
Opening projects 154
recent projects 155
Open In QuickTime Player 64, 90
Open in Viewer 63, 90
Orbit Around behavior 380
Dashboard controls 381
example of 342
Oscillate behavior 360
element of 342, 396
Outer Glow filter 758
Outlines 504
editing on text objects 504
on text objects 503
Overdrive filter 759
Overlay blend mode 260
Overlays in Canvas 41
Overwrite edit 284
how to perform 286
P
Padding
image sequences 169
PAL video 944
standard definition DV video and 944
Pan resetting in the Canvas 40
Panning
audio 890
audio tracks 890
in Audio Editor 85
Pan tool 29
Parallelogram Tile filter 788
Parameter behaviors 354–368
about 317
and replicators 695
applying 326
applying to generators 811
applying to gradients 491
applying to text 517
changing start and end offset 337
Indicator in Inspector 418
in the Animation menu 328
keyframing 610
MIDI 357
reassigning to another parameter 329
using with text objects 556
where they appear 327
Parameters
emitter 587
particle cell 597–605
particle cells 608
shapes 836
single-cell emitter 597–605
Parameter Selection menu 100
Particle cell object tab 104
Particle cell parameters 597–605, 608
Particle cells
filters applied to 568
Particle effects
adding 570
pre-made 569
Particle emitters 569
in the Library 190
Particle library 569
Particles
additive blend 600
and layer size 569
angle 599
animated 566
birth rate 598
birth rate range 598
cells 566
cell source objects 568
distribution of 582
life 599
life range 599
Make Particles icon 31
number generated per second 573
particle emitter categories 95
pre-made 569
scale 602
speed 599
speed range 599
spin 600
using behaviors with cells 611
using behaviors with emitters 610
using generators as cell sources 814
Particle systems 567
advanced controls 586–608
and looping clips 586
animating objects in 610
applying filters to 612
blending 582
creating 571
creating graphics for 585–586
customizing emitters 575
drop shadows 582
drop shadow example 584
graphics size 585
keyframes and curves 587
make 582
modifying 571
multi-cell master controls 590
multiple cells within 574
predictability of 574
timing 583
using behaviors with 610
Paste 298
in Layers tab 61
Paste Exchange 299
Paste Insert 299
Paste Overwrite 299
Paste Special 299
Pasting
behaviors 332
filters 710
keyframes 435
Path pop-up menu 89
PDF files
about 170
fixing the resolution of 171
multi-page 172
with mixed content 172
Perspective Tile filter 788
Photos 96
in the Library 191
Photoshop
adding layered files 177
incompatible effects 170
layered files 170
Ping-Pong end condition 187
Ping Pong extrapolation 442
Pin Light blend mode 264
closing 156
creating 139–149
creating from project presets 142
creating from templates 141
custom settings 143
embedding in Final Cut Pro projects 959
exporting 899–912
exporting from Final Cut Pro 958
imported or embedded in Final Cut Pro 956
In and Out points 308
managing 152–156
managing objects in 179, 183
moving 156
opening 154
opening last project automatically 140
opening multiples 156
opening recent 155
playing 45
QuickTime audio track 881
reverting 154
reverting to auto-saved 114
reverting to autosaved 154
saving 152
saving as a template 214
saving duplicates of 153
using in Final Cut Pro 955
Properties tab 103
parameters 241

Q
QuickTime
audio files 878
exporting 901
field dominance and 950
movies 164
movies in particles 606
video codecs 941
website 12
QuickTime files
mixing different types 164
QuickTime Player 64
QuickTime video
archiving 157

R
Radial Blur filter 721
Ramp behavior 362
RAM Preview 46
and float 48
clear preview 48
preview entire project 46
preview play range 47
preview selection 47
Randomize behavior 363
Random Motion behavior 382
Rate behavior 365
element of 396
Reconnecting media 182
Reconnect Media command 64
Record button 45, 402, 405
disabling while playing 450
using 405
Recording options 449
Rectangle Mask tool 30
Rectangles 840
Rectangle tool 29, 840
Reduce Keyframes 78
Refraction filter 747
Regions 309
Relief filter 780
Removable media 163
Remove Preset 119
Rename files and folders 90
Renaming
audio tracks 890
behaviors 331
layers 208
objects 276
Render order
for emitters 597
Render Settings tab 147
Reordering
columns 57
filters 712
Repeat extrapolation 442
Repel behavior 384
Repel From behavior 386
Replace Media File button 188
Replicate icon 31
Replicator behaviors
about 318
Replicator object tab 104
Replicators 621–699
animating parameters 662, 673
animation curves 680
animation examples 674
applying masks to 644
arrangement of 638
blending 641
burst and spiral shape parameters 658
cell parameters 662
cell parameters for movies 672
creating media for 627
customizing in Dashboard 636
Dashboard parameters 636
differences from particles 622
elements in 622
filters and 698
genetic shape parameters 659
Library presets 628
line and wave shape parameters 658
parameters for 647
properties 639
removing 632
removing source objects from 635
replacing source image 629
saving to Library 699
scale 641
sequence control parameters 686
Sequence Replicator behavior 681
shapes 638
shape-specific parameters 652
source objects 627
timing 642
transforming 640
Traversal option 694
using multiple source objects 633
with behaviors 696
Reset button 100
Resetting
parameters 417, 418
project In and Out points 309
Resize windows 23
Reveal in Finder 64, 90
Reveal source media 61, 66
Reveal Source Media command 180, 209
Reverse behavior 366
Reverting project 154
Ring Lens filter 748
Ring Warp filter 749
ripple 297
Ripple Delete 297
Ripple filter 749
Roll-up button 35
Rotating
objects 233
text characters 478
Rotational Drag behavior 387
Rotation handle 230
Rotoscoping
about 862
example of 863
guidelines 863, 864
Rows
for emitters 595
Ruler 74, 80, 86, 306
location of 116
Rulers 41
changing location of 44
turning on and off 43

S
Safe zones 41
color of 116
Saturate filter 735
Save All command 153
Save As command 153
Saving
behaviors 343–344
generators 809
presets 101
projects 152
Scale
for emitters 602
Scanning
keyframing example 405
objects 230
Scrape filter 750
Screen blend mode 258
Scroll Down text behavior 529
Scroll Up text behavior 529
Scrubbing
audio 894
Scrubbing audio 87
SD (standard-definition) video 952
Search field 89, 95
Searching
for files 89
for layers and objects 209
Select/Transform tool 28, 225
Selecting
audio tracks 888
objects 221
Separators 28, 32
Sepia filter 735
Sequence Replicator behavior 681
custom Traversal option 694
Parameter behaviors 695
parameters 688
Sequence Text behavior 531
applying parameters to 531
parameters 537
using 531
Sequential edit 285, 286
how to perform 287
Set Matte filter 765
Shape object tab 104
Shapes
about 819
adding and deleting control points 829
adjusting tangent handles 833
animating 847
applying behaviors to 847
applying filters to 847
Bezier splines 820
b-splines 823
categories 95
changing gradient direction 838
circles 840
creating filled or empty 842
creating illustrations 844
creating transparency in 846
Dashboard 836
differing from masks 820
drawing a Bezier shape 821
drawing a B-Spline shape 823
drawing a line 842
drawing freehand shapes 842
drawing methods 820
editing 826
editing Bezier control points 832
editing B-Spline control points 834
editing fill 843
editing in the Keyframe Editor 850
editing outlines 842
feathering 843
finishing Bezier shapes 823
finishing B-Spline shapes 825
in the Library 190
keyboard shortcuts 939
keyframing 848
keyframing control points 848
locking control points 831
locking objects while editing 845
moving control points 828
organizing objects 845
parameters 836–840
rectangles 840
selecting control points 828
showing control points 828
tangent handles 832
transforming 827
turning handles on or off 828
turning snapping on or off 827
using object alignment 845
using outlines 838
Shape tools 835
Sharing
  behaviors 343–344
  generators 811
Sharpen filter 766
Sharpen filters 766
Shearing objects 236
Show Behaviors button 332
Show Collapsed Image Sequences button 159
Showing layers 203
Show overlays 41
Shutter angle 148
Sidebar 89, 159
Silhouette Alpha blend mode 267
Silhouette Luma blend mode 267
Simple Border filter 724
Simulation behaviors 369–391
about 318
examples 369
how text is affected 558
using with text objects 556
Slanting text 478
Slipping
  audio tracks 892
  objects 296, 305
Slit Scan filter 781
Slit Tunnel filter 782
Smoke effect
  creating 577–580
Snap Alignment to Motion behavior 350
Snapping
  in the Keyframe Editor 444
Soft Gradient generator 803
  using as particle cell source 815
Soft Light blend mode 261
Softness
  of text 503
Solo
  a layer 204
  audio 66, 889
Sorting columns 58
Soundtrack Pro 897
Speed
  for emitters 599
  Speed range
    for emitters 599
Spelling
  in Text Editor 473
  Sphere filter 750
  Spill Suppressor filter 764
Spin
  for emitters 600
Spin behavior 351
  Dashboard controls 351
Splitting tracks 292
Spring behavior 387
Square pixels 951–952
Standard definition DV 945
Standard definition video
  formats 944
  NTSC video 944
  PAL video 944
  standard definition DV 945
Standard-definition video 945, 952
Starburst filter 751
Star generator 803
  applying a parameter behavior to 811
Status Bar 37
Status Bar in Canvas 36
Stencil Alpha blend mode 266
Stencil Luma blend mode 267
Still images
  about 164
Stop behavior 335, 366
Straight alpha channels 173
Stripes filter 751
Index

Stripes generator 804
Strobe filter 791
Stylize filters 767–785
Subcategories
  adding to a category 193
Subtract blend mode 253
Support 12
Swirly generator 804

T
Tabs
  detaching 24
  reattaching 24
  reordering 24
  showing and hiding 24
Target filter 752
Technical support 12
Template Browser 142
  adding categories 214
  deleting categories 215
  deleting templates from 215
  icon 34
  organizing templates in 214
Templates
  creating 213
  creating new projects from 141
  organizing in the Template Browser 214
  reusing objects from 212
  saving a project as 214
Text
  about fonts 464
  adding a drop shadow 508
  adding a glow 506
  adding in the Canvas 458
  adding in the Text Editor 471
  adding outlines 504
  adding to your project 470
  adjusting drop shadows 508
  adjusting margins in the Canvas 470
  adjusting margins in the Inspector 471
  adjusting opacity in the Properties tab 502
  adjusting softness 503
  all caps 478
  animateable parameters 473
  animating a texture 496
  animating text on a path 521
  applying a gradient 481
  applying a Library gradient 483
  applying a text style from the Inspector 511
  applying a text style from the Library 510
  applying a texture 492
  applying behaviors to 463
  applying filters to 463
  applying LiveFonts 561
  applying Parameter behaviors 517
  as an object 459
  baseline 477
  changing color 479
  changing fonts using the Library 466
  changing opacity 501
  changing path shape 519
  creating a drop shadow 507
  creating a type on effect 515
  creating text on a path 518
  creating text styles 509
  custom style icons 513
  Dashboard parameters 460
  default drop shadow 508
  default glow 506
  default outline 504
  displaying Inspector parameters 462
  editing a texture 495
  editing formats 474
  editing glows 506
  editing gradients 485
  editing in the Inspector 473
  editing in the Properties tab 459
  editing layouts 513
  editing outlines 504
  editing styles 478
  editing text on a path 520
  extending text paths 520
  family 475
  Format pane 473
  Glow parameters 505
  in motion graphics 453
  kerning 477
  layout alignment 514
  layout justification 514
  Layout pane 473
  line spacing 514
  LiveFonts 560
  LiveFont Timing parameters 563
  LiveType fonts 464
  margins 522, 523
  modifying LiveFonts 562
  monospace 478
  moving the insertion point 477
  navigating the Library font browser 468
  object duration preferences 456
  offsetting 478
  on paths 517
  Outline parameters 503
  path control points 520
  path options 517
  previewing fonts in the Canvas 475
  Previewing fonts in the Library 465
  previewing LiveFonts 560
  removing a texture 494
replacing a texture 494
resetting a parameter 473
resetting a parameter group 474
rotating characters 478
saving a custom style 512
saving gradients to the Library 489
saving styles 512
saving styles to Library 512
selecting characters 471
sequence controls 537
showing the Format pane 474
showing the Layout pane 514
showing the Style pane 478
size 476
slant 478
softness 503
Style pane 473
styles 509
supported fonts 464
Text tool 469
Texture Image well 494
texture sources with applied behaviors 499
texture sources with applied filters 499
tracking 477
Type On 515
using as a mask 500
using a texture 492
using in Motion 454
using the Dashboard 460, 464
using the Gradient Editor 485
where text styles are saved 512
Text Animation behaviors
about 525
applying from the Library 526
Scroll Up 529
Sequence Text 531
setting In and Out points 529
Tracking 544
Type On 546
using, example of 527
Text behaviors
about 318, 524
animation paths 527
previews of 526
saving to Library 555
Text Editor
adding text in 471
ing the text in 472
spelling 473
Text format parameters 475
Text layout parameters 514–524
Text object tab 103
Text Sequence behaviors
about 548
adding and removing parameters 554
changing speed of 553
example of 548
modifying guidelines 552
Text Style Face parameters 552
Text Style parameters 478–503
Text Styles
in the Library 191
Text styles 96
Text tool 30, 469
adding text 470
creating margins with 523
resizing margins with 524
Texture Image well 493
Textures
animating 496
applying to text 492
ing 495
removing from text 494
replacing in text 494
sources with applied behaviors 499
sources with applied filters 499
with text objects 492
Texture Screen filter 782
Thinning keyframes 448
example 450
Third-party filters 793–794
Threshold filter 736
Throw behavior 352
Dashboard controls 353
Tile filter 789
Tile Offset
for emitters 595
Tiling filters 785–790
Time
counting 53
Timecode
adjusting 52
displaying 74
modifying dynamically 53
showing timecode or frame numbers 53
Timecode fields 51
Current Frame 51
Duration 51
Time filters 790–792
Timeline 21, 68–76
about 273
adding and deleting layers 278
adding an object to an existing layer 288
adding markers 313
adding multiple clips 286
adding objects to 282
adjusting track height 281
aligning keyframes 420
audio/video links 279
changing an object’s In or Out point 295
collapsing and expanding layers 74
collapsing and expanding tracks 277
Composite edit 283, 285
copying and pasting 298
creating new layers 72, 288, 289
defining the play range 308
deleting all markers 314
deleting keyframes 422
deleting Layers 292
deleting markers 314
deleting objects 292, 297
disabling tracks 277
disconnecting Layer track from its contents 305
displaying 274
displaying frames 74
displaying thumbnails 76
displaying timecode 74
display options buttons 70
divider 71
ingoing in the layer track 301, 306
ingoing markers 314
ingoing objects 293–306
ingoing overlapping objects 304
ingoing terminology 293
effects controls 69
enabling tracks 277
Exchange edit 285, 286
gestures for 969
grouping layers 291
hiding video objects 71
icon mode 281
Insert edit 284, 285
jumping to end of project 307
jumping to start of project 307
keyboard shortcuts 936
keyframing 419–424
Layer list 68, 276
Layer list width 72
locking tracks 278
manipulating audio/video elements separately 279
markers 312, 316
markers, different types 312
modifying keyframes 420
moving a keyframe 420
moving an entire layer as a single object 301
moving an object 293
moving an object from one layer to another 290
moving an object to the playhead 294
moving a single object within a layer 302
moving behaviors 337
moving by one frame 307
moving by ten frames 307
moving objects in the Layer track 301
moving overlapping objects within a layer 303
multi-selecting tracks 292
navigating 306
navigating to markers 316
nesting layers 291
object colors 274
Overwrite edit 284, 286
Paste Special 299
placing one layer inside another 291
rearranging objects within a layer 289
regions 309
removing objects 72
renaming objects 276
replacing an object in an existing layer 288
resizing track height 280
Ripple Delete 297
ruler 74, 306
ruler format 74
Sequential edit 285, 286, 287
showing audio 280
showing audio files 71
showing behaviors 70, 280
showing filters 280
showing keyframes 70, 280, 419
showing layers 280
showing masks 70, 280
slipping an object 296
slipping objects in the layer track 305
splitting tracks 292
thumbnails 281
Timeline tab 68
track area 73
track display settings 281
track height 71
track order 289
track visibility 277
trimming an object 294
trimming behaviors 336
trimming keyframed effects 423
trimming multiple objects 296
trimming objects in the Layer track 304
trimming without changing effects 305
turning behaviors off 69
turning filters off 69
turning masks off 69
ungrouping 291
view options 279
Zoom/Scroll control 75, 280
zooming 75, 280
zooming to play range 75
Zoom slider 280
Timeline icon 33
Timing
of behaviors 335
particle systems 583
Timing icon 274
Timing pane 21, 67–87
Audio Editor 21, 82
displaying 67
icon 31
Keyframe Editor 21, 76
Timeline 21, 68
Tint filter 736
Title Safe Region 116
Toolbar 27–35
  Add Behavior icon 31
  Add Filter icon 31
  adding controls to 32
  Adjust Anchor Point tool 28
  Adjust Control Points tool 28
  Adjust Crop tool 28
  Adjust Drop Shadow tool 28
  Adjust Four Corner tool 28
  Adjust Item tool 28
  Adjust Shear tool 28
  Audio Editor icon 34
  Audio icon 33
  Bezier Mask 30
  Bezier tool 29
  B-Spline Mask 30
  B-Spline tool 30
  Circle Mask 30
  Circle tool 29
  Control Point tool 28
  customizing 32
  Dashboard icon 31
  External Video icon 34
  File Browser icon 31
  flexible space 32
  hiding 35
  icon and text view 35
  icon only view 35
  Inspector icon 31
  keyboard shortcuts 939
  Keyframe Editor icon 33
  Layers icon 33
  Library icon 31
  Make Particles icon 31
  Mask set 30
  Media icon 33
  Pan tool 29
  Project pane icon 31
  Rectangle Mask 30
  Rectangle tool 29
  removing controls from 32
  Replicate icon 31
  Select/Transform tool 28
  separators 28, 32
  space 32
  Template Browser icon 34
  Text 30
  text only view 35
  Text tool 469
  Timeline icon 33
  Timing pane icon 31
  tool groups 27
Zoom tool 29
Track height 71, 281
Tracking
  text parameter 462
  Tracking text behavior 544
  modifying 546
  parameters 546
  using 545
  Track order 289
Tracks
  selecting multiples 292
  splitting 292
  Trail filter 792
Transform controls 230, 581
Transforming
  layers 224
  multiple objects 223
  objects and layers 223
  Transform modes 225
  switching 226
Transforms
  about 224
  anchor point 234
  corner-pin 238
  cropping 239
  drop shadows 237
  rotating 233
  scaling 230
  shearing 236
Transform tool 225
Transport controls 20, 45
  Go to end 45
  Go to start 45
  keyboard shortcuts 930
  Loop playback 45
  Next frame 45
  Play/Mute Audio 45
  Play/Pause 45
  Play from start 45
  Previous frame 45
  Record animation 45
Triangle Tile filter 790
Trigger 123
Trimming
  audio tracks 893
  behaviors 336
  changing an object’s In or Out point 295
  filters 713
  keyframed effects 423
  multiple objects at once 296
  objects 294, 295
  Twirl filter 752
Twists
  for emitters 596
Typeface 476
Type On 515
Type On text behavior  546
  changing speed of  547
  modifying  547

U
  Uncompressed video  948
  Ungrouping
    in Layers tab  61
    objects  291
  Unsharp Mask filter  766
  Use Autosave vault  113
  Utility window  19, 87–104
    File Browser  88
    Inspector  98
    Library  93

V
  Value fields  99
  Value lists  99
  Value sliders  99
  Variable Blur filter  722
  Vectorize Color filter  783
  Video
    fonts and  953
    interlaced  950
    line art and  953
    uncompressed  948
  Video/Audio presets  121
  Video codecs
    QuickTime  941
    third-party  950
  Video filters  793
  Video formats
    high-definition video  945
    standard definition DV  945
    standard definition video  944
    supported  944–948
  Video output  118
  Vid Rate  62
  View menu  132
    Channels submenu  133
    Guides submenu  134
    Overlays submenu  134
    Resolution submenu  133
    Zoom Level submenu  132
    Zoom Time View submenu  132
  Vignette filter  784
  Vivid Light blend mode  262
  Volume
    for audio tracks  889
    Vortex behavior  389

W
  Wacom Tablet  964
  Wave filter  753
  WAV files  878
  Wavy Screen filter  785
  Welcome Screen  108, 140
  Widescreen filter  724
  Widetime filter  792
  Wind behavior  390
    Dashboard controls  390
  Window layouts  21
  Window menu  135
    Layouts submenu  136
    Show Inspector submenu  136
  Windows
    closing  23
    minimizing  23
    resizing simultaneously  23
    Wriggle behavior  367

Z
  Zoom/Scroll control  75
  Zoom Blur filter  723
  Zooming
    dynamic zoom mode  39
    in Audio Editor  87
    in Canvas  39
    in the Timeline  280
    in Timeline  75
  Zoom slider  75
  Zoom Time View button  75
  Zoom tool  29
  Zoom/Scroll control  75
  Zoom Blur filter  723
  Zooming
    dynamic zoom mode  39
    in Audio Editor  87
    in Canvas  39
    in the Timeline  280
    in Timeline  75
  Zoom slider  75
  Zoom Time View button  75
  Zoom tool  29